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Basic features
In this section, we describe the various basic features to make you familiar with your
Collibra Data Intelligence Cloud environment. You learn where you can find everything in
the user interface, how to find data, what kind of data exists in your environment and other
basic manipulations.
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Collibra functionalities
In this section, you find more information about the general functionalities of Collibra Data
Intelligence Cloud such as searching for data, using dashboards and the global Create
button.

In this chapter

Screen elements in the user interface
The Collibra Data Intelligence Cloud user interface contains a number of common
elements that appear throughout the product.

You can navigate through Collibra Data Intelligence Cloud using your mouse or keyboard.
For more information, see Accessibility.
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Page layout

No. Element name Description

Home button Open the Homepage or your default dashboard.

Navigation browser Open the Browse pane.

Search field Search for any resource in Collibra.

button Create any resource from any location.

Shopping basket Request access to data sets and reports.

Tasks indicator Check how many workflow tasks are awaiting your attention and man-
age those tasks from the My tasks page.

Activities tracker Check the Collibra activities and view the history of all the jobs you started.
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No. Element name Description

Info Get access to the product documentation, to Collibra Product Resource Center
and University, and to the Collibra support portal.

Note If you have the Sysadmin role, you can access the API
documentation.

Avatar View and modify your profile, sign out, and report a problem.

Application menu Open another application:

l Business Glossary: Manage your business terms.
l Catalog: Manage data sets.
l Policy manager: Manage your organization's policies.
l Reference Data: Manage your code values and code sets.
l Global view: See all assets in a single view.
l Data Helpdesk: Manage issues.
l Stewardship: Manage your tasks.
l Settings: Manage your data governance operating model and

your users.

Submenu Open one of the subpages of the current application.

View selector Switch between views.

View toolbar Manage the current view.

Filter pane Filter the resources in the view.

Action toolbar Perform actions on the assets that you selected in the view or start a workflow.

Content toolbar Manage the resources in the current view.

Table or set of
tiles

See the resources in the current view in a table or as tiles.

Chapter 2

4

to_business-glossary.htm
to_catalog.htm
to_policy-manager.htm
to_reference-data.htm


Chapter 2

Arranging list items
On some pages and in some dialog boxes, you can arrange list items to change the order
of their appearance on the page. For example when adding fields to a view or editing an
asset type assignment.

Example
You can have arrangeable lists in dialog boxes and on regular pages. You can
arrange the list items in the same way.

In a dialog box On a page

Moving items by dragging and dropping

The easiest way to move items up or down is typically by dragging and dropping:

1. Click in front of an item and hold down the mouse button.

2. Move your mouse to the desired location in the order.
3. Release the mouse button.
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Moving items via the drop-down menu

Each item also has a drop-down menu that allows you to quickly change the position of the
item in the list:

1. Click in front of an item.

2. Perform one of the following steps:
o Click Top to move the item to the top of the list.
o Click Bottom to move the item to the bottom of the list.
o Point to Before and click an item in the list to move the current item to the pos-
ition above the clicked item.

Accessibility
In an effort to make all Collibra applications accessible for visually or physically impaired
users, all applications are gradually being upgraded to meet accessibility requirements as
set out in the Section 508 Standards (US) and WCAG 2.0 (Worldwide).

Collibra has taken measures to ensure accessibility, for example:

l Icons and text have sufficient contrast with the background.
l Images have clear alternative text to facilitate the use of third-party assistive tech-
nology.

l Navigation on our pages is enhanced, for example, you can open a link in a new tab.
l You can navigate through most screen sections by keyboard.
l You can edit interface text to make messages less dependent on visual screen ele-
ments.

Navigating using your keyboard
As part of the accessibility goals of Collibra, you can navigate using your keyboard.

Chapter 2
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Action Description

Moving the focus
point

The focus point indicates the current focus of your navigation. If you hover your mouse
pointer over an element, you typically see the background change, or text becomes
underlined.

When you use the keyboard, the same effect takes place as when you hover your
mouse pointer. However, rather than moving your mouse, you can jump to the next
element using the tab key on your keyboard. You can also press shift + tab to jump to
the previous element.

Example

Type Unfocused element Focused element

Button

Link

Clicking and
activating screen
elements

Press enter to activate an element when it is the focus point. This allows you to press a
button or open a link, using your keyboard rather than clicking.

Opening and clos-
ing dialog boxes
and pop-ups

Click any dialog box or pop-up to open it. You can navigate in the dialog boxes and
pop-ups just as you would anywhere else. To close it, press escape.

Selecting and
clearing check-
boxes

Navigate to a checkbox and press the space bar to select it or clear it.

Selecting radio
buttons

Use the arrow keys on your keyboard to select radio buttons. Navigate to the radio
buttons using the tab key, then press ←, →, ↓ or ↑ to change which radio button is
selected.
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Action Description

Skipping repetitive
sections

Most pages in Collibra Data Intelligence Cloud contain repetitive sections at the top of
the page, such as the main menu. You can skip this section using the Skip to content
button.

This button is the first available element when you start navigating in a repetitive
section using your keyboard.

Signing in and signing out
As soon as you have a user account, you can sign in to Collibra Data Intelligence Cloud.

Sign in

1. Go to any page of your environment.» The Sign-in page opens.
2. Enter your username and password.
3. If a disclaimer is enabled, you have to agree with the disclaimer to sign in. If you don't

agree with the disclaimer, you are signed out automatically.

Chapter 2
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Tip
l If Single Sign-On (SSO) is configured for your environment, you can be signed
in automatically if you are signed in to the SSO system.

l By default, the username is case-sensitive. However, some LDAP
configurations make the username not case sensitive.

Sign out

1. Click your avatar, then Sign out.
» The Sign-in page opens.

Note Depending on your environment's configuration, you may be signed out
automatically if you are inactive for a certain period of time. Most of the changes you
have made during your session will be saved. However, if you had a text field or
dialog box open when you were signed out, that information may be lost.

Access a community, domain, asset view, or
dashboard
You can access a community, domain, asset view, or dashboard via the Browse pane.

The Browse pane provides an overview of the following:

l All communities and domains on the Organization tab.
By default, the Organization tab shows only the top-level communities. To view the
subcommunities and domains in a community, click next to the community name.

When you click a community or domain, the corresponding community or domain
page appears. This page contains the community or domain details and allows you
to make changes.
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l All pinned asset views on the Asset Views tab.
l All dashboards on the Dashboards tab.

Tip You can search for a community, domain, asset view, or dashboard by using
the search field.

The Create button
In Collibra Data Intelligence Cloud, there is a green Create button at the top of the screen.
It enables you to create any resource from any location, if you have the correct
permissions.

The following table describes the categories of resources you can create with the Create
button:

Item Description

Suggested A list of resources that you might want to create.

The resources available to you here depend on your location in Collibra:

l If you are on one of the submenu pages, for example, Business assets,
Metrics or Glossaries, the suggested resources are specific to that sub-
menu page.

l If you are on a domain page, the suggested resources are all the asset
types that are assigned to the domain.

l If you are on a community page, the suggested resources are all the asset
types that are assigned to the domains in the community.

l If you are on an asset page, the suggested resource is an asset of that
same type.

This list is not available when you click the Create button from the default dashboard.

Recent A list of recently created resources, most recent first.

Chapter 2

10



Chapter 2

Item Description

Actions A list of global workflows that have the option Show in global create enabled.

Asset A list of all the asset types that are available in your data governance model.
The list is divided into sections, according to the parent asset type, for
example, Business Asset or Data Asset.

Organization A list of organizational resources, such as a Community or a Business Asset
Domain.

To quickly find what you are looking for, you can type a search term in the Filter field. The
results are based on the category you selected.

Note You can only create assets of a certain type in a certain domain if that asset
type has been assigned to that domain.
If you try to create an asset of a type that is not assigned to the domain you are
currently in, the Domain field in the Create dialog box is not automatically filled in.

Views in Collibra
Views in Collibra Data Intelligence Cloud define how you can look at lists of assets. You
can configure views to see, for example, tables or a set of tiles. A view is also the basis for
Importing and exporting.

While you are working with a view, Collibra stores your view configuration when you
navigate to a different page and even when you sign out. You can also undo your changes.

Views
A view defines a table or set of tiles by storing the following data:

l The display mode, to specify whether assets are shown in a table or as tiles.
l Filters, to specify which assets are displayed.
l Applied sorting, to specify the order of the assets.
l Visible columns (for tables) or fields (for tiles), to specify which information about
assets is displayed.

11



l Hierarchy, to display, optionally, a hierarchy of assets instead of a flat list (not applic-
able in tile display mode).

Tip You can create as many views as you want without causing problems for
Collibra's performance.

A view is also the basis for Importing and exporting.

Example of a view in table display mode:

Example of a view in tile display mode:

Chapter 2
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When you view a table or set of tiles for the first time, you are using the Collibra DGC
default view, unless somebody already shared a custom view as default with you.

Each view has a unique URL. You can use this URL to open the view directly, without
having to navigate to the location. For example, you can embed the view URL in a text
widget on a dashboard, in an email and so on. You can simply copy the URL from the
address bar and paste it where needed.

View types

Collibra offers different types of views:

l Dashboards
l Search filters
l Diagram views
l Relation views on an asset page
l Asset views, for example in a domain or community, in the global view and in applic-
ation views.

Asset views are available in the following applications:
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Application Tabs with a view selector

Business Glossary l Business Assets
l Glossaries

Reference Data l Code Values/Sets
l Hierarchies

Data Catalog l Reports
l Data Sets
l Data Dictionary
l Technology Assets

Data Helpdesk l Issues
l Data Quality

Data Stewardship Business Dimensions

Policy Manager Governance Assets

View selector and toolbar

The view selector allows you to switch between views and the view toolbar to manage the
currently selected view.

It appears in views containing a table or a set of tiles.

The view bar has the following items:

Number Button Description

1 n/a The view selector shows the name and description of the current view, and
allows you to choose another view.

2 Button to edit the name and the description of the current view.

3 Button to save changes to the current view, or to create a new view.

Chapter 2
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Number Button Description

4 Button to share the current view.

5 Button to delete the current view.

Create a view

You can create a view, for example, if you want it to contain specific fields and display
assets based on a filter.

Tip You can create as many views as you want without causing problems for
Collibra's performance.

Steps

1. Navigate to the set of assets (in table display modes or tile display mode) for which
you want to create a view.
Example: Business Glossary
If you want to start from the configuration of an existing view, switch to that view.

2. Set the required filters.
3. Customize the table or customize the set of tiles.
4. Optionally, enable hierarchy or wrap text (not applicable in tiles display mode).
5. On the right side of the view bar, click .

6. In the view toolbar, click , then Save as.

» The Save view as dialog box appears.
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7. Enter the required information.

Option Description

Name The name of the new view.

Description Optional. The description of the new view. You can add extra information about
the view if necessary.

View sharing
options

The sharing options allow you to share the view:

o Public: All Collibra Data Intelligence Cloud users can use the new
view.

o Private: Only the creator of the view can use the new view.
o Share with specific roles, groups & users: The users with whom you
want to share the new view. You can select Roles, Groups and
Users.

Promote view You can promote the view by pinning it to the view or making it the default view:

o Default: The new view becomes the default view when you open the
table or set of tiles.

o Pin: The view is pinned to the view selector.

8. Click Save.

Edit a view

You can edit a view, for example, if you want it to change its name.

Steps

1. Navigate to the set of assets (in table display mode or tile display mode) for which
you want to edit a view.
Example: Business Glossary

2. Switch to the view that you want to edit.
3. In the view toolbar, click .

» The Edit name & description dialog box appears.

Chapter 2
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4. Enter the required information.

Option Description

Name The name of the new view.

Description Optional. The description of the new view. You can add extra information about
the view if necessary.

5. Click Save.

Edit a view's configuration

You can edit a view, for example, if you want it to change its fields and filters.

Steps

1. Navigate to the set of assets (in table display mode or tile display mode) for which
you want to edit a view.
Example: Business Glossary

2. Switch to the view that you want to edit.
3. If required, do the following:

o Edit the view's filters.
o Customize the table or customize the set of tiles.
o Enable hierarchy or wrap text.

4. In the view toolbar, click , then Save.

Share a view

You can share a view, for example, if you want to give other users access to it.

Steps

1. Navigate to the set of assets (in table display mode or tile display mode) for which
you want to edit a view.
Example: Business Glossary

2. Switch to the view that you want to edit.
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3. On the right side of the view bar, click .

» The Share view dialog box appears.
4. Enter the required information.

Option Description

View sharing
options

The sharing options allow you to share the view:

o Public: All Collibra Data Intelligence Cloud users can use the new
view.

o Private: Only the creator of the view can use the new view.
o Share with specific roles, groups & users: The users with whom you
want to share the new view. You can select Roles, Groups and
Users.

Promote view You can promote the view by pinning it to the view or making it the default view:

o Default: The new view becomes the default view when you open the
table or set of tiles.

o Pin: The view is pinned to the view selector.

5. Click Save.

Delete a view

You can delete a view, for example, if you no longer need it.

You can delete a view in several ways:

l From the view bar.
l From the overview.

Delete a view from the view bar

1. Navigate to the set of assets (in table display mode or tile display mode) for which
you want to delete a view.
Example: Business Glossary

2. Switch to the view that you want to delete.
3. In the view toolbar, click .

» The Delete view <view name> dialog box appears.
4. Click Delete view.

Chapter 2
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Delete a view from the overview

1. Navigate to the set of assets (in table display mode or tile display mode) for which
you want to delete a view.
Example: Business Glossary

2. In the view selector, click , then Show all.

3. In the table, click at the end of the row of the view you want to delete.

» The Delete view <view name> dialog box appears.
4. Click Delete view.

Pin a view to the view selector

You can pin a view to the view selector if you want to make it easier to open it.

Steps

1. Navigate to the set of assets (in table display mode or tile display mode) for which
you want to edit a view.
Example: Business Glossary

2. Click the view selector, then Show all...
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3. In the views table, click the thumbtack ( ) to the left of the views you want to pin or

unpin.

Switch between views

You can switch between views, for example, if you want to see the information of another
view.

Steps

1. Navigate to the set of assets (in table display mode or tile display mode) for which
you want to edit a view.
Example: Business Glossary

Chapter 2
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2. In the view selector, click next to the name of the current view.

3. Do one of the following:

If... then...

The view you want to dis-
play is in the list,

Click the view in the drop-down menu.

The view you want to dis-
play is not in the list,

a. Click Show all.
b. Click the name of the view you want to display.

Global views

Global views enable you to show all assets of Collibra Data Intelligence Cloud in one view,
regardless of their community, domain or application.

You can use all view features, such as:

l Change the display mode to table or tiles.
l Create views with different fields and filters.
l Import and export the assets or complex relations in the view.

Open a global view

1. On the main menu, click , and then click Global view.

2. If required, switch to another view.

Timeout period for the loading of tables and tiles

In some cases, the loading of a table or set of tiles can take a while. This can happen if the
view contains a lot of data, or if it has complex sorting and filtering applied. The timeout
period is a time limit (in seconds) after which the loading task is stopped and a timeout
error is shown.

If the timeout period expires before the view has loaded, you can try refreshing the view or,
if applicable, simplifying its configuration by:

l Removing basic or advanced asset filters.
l Removing the sorting on multiple columns (tables only).
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l Reducing the row count or tiles count.
l Reducing the number of columns (in a table) or fields (in a set of tiles).

You can configure the maximum loading time of tables.

Configure the maximum loading time of tables

In some cases, the loading of a table or set of tiles can take a while. You can configure the
maximum loading time.

Note Depending on your environment, follow this procedure either in the Services
Configuration section of the Collibra settings or in Collibra Console. This topic
contains the procedure for Collibra Console. If your Settings page has a
Configuration tab, you can follow this procedure on that tab. For more information,
go to the online documentation.

Prerequisites
l You have the ADMIN or SUPER role in Collibra Console.
l You have the SUPER role in Collibra Console.

Steps
1. Open the DGC service settings for editing:

a. Open Collibra Console.
» Collibra Console opens with the Infrastructure page.

b. In the tab pane, expand an environment to show its services.
c. In the tab pane, click the Data Governance Center service of that environment.
d. Click Configuration.
e. Click Edit configuration.

2. Go to the Table section.

Chapter 2
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3. Enter the required information:

Setting Description

Time limit for
loading data in
tables in
seconds

Enter the maximum amount of seconds to load a table. If this time is exceeded, a
timeout error is displayed.

The default value is 60.

A value of 0means that there is no time limit.

4. Click Save all.

Asset filters
Asset filters enable you to quickly find the data in Collibra Data Intelligence Cloud by
limiting the amount of assets shown in a table or a set of tiles. You can find the filter
function on almost every page containing data.

In this section, you can learn how to work with filters.

Basic and advanced filtering

Collibra Data Intelligence Cloud has two modes for filtering data:

l Basic: Filter data by creating simple filter expressions that are always combined by
the logical AND function.

l Advanced: Filter data by creating complex filter expressions. An advanced filter is a
combination of filter expressions that can be combined by using the logical AND and
OR functions.

In the filter pane, you can toggle between basic and advanced filtering:

Basic filtering: Advanced filtering:
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When you have applied a filter, you can save the view for later usage.

Basic filters

You can create basic filters by adding filter expressions. A filter expression is created by
selecting a characteristic and assigning one or more values to it. In a basic filter, you can
combine multiple expressions.

The characteristics are grouped in the following categories:

l Properties: All the asset properties in Collibra such as name, asset type, tags and so
on.

l Attributes: All the asset attributes in Collibra, such as note, definition, quality and so
on.

l Relations: All the relations in Collibra.
l Roles: All the resource roles that are defined in Collibra, such as Requester,
Assignee, Reviewer and so on.

To add characteristics to the filter, consult Create a basic filter.

Filter behavior

l Multiple values for one characteristic are treated as an OR clause.
o Example:

The example filters the assets if the asset type is Acronym or Business Term.
l All the simple expressions in a basic filter are treated as an AND clause.
l You can remove a filter characteristic by clicking next to the filter characteristic

that you want to delete, or you can remove a single value from a filter characteristic
by clicking next to its value.

Chapter 2
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Other filter aspects

l If you use filters in hierarchy views (not available in tile display mode), Collibra only
applies the filter at the 'root' (start) level of the hierarchy. Child rows are not filtered.

l In the Roles category of the filter characteristics, you can select one or more specific
users or user groups, or current user to filter on the signed-in user. This has the
advantage that it is not necessary to create a filter for every single user.

o Example: Filter assets by "current user" with Reviewer responsibility: If user A
is signed in, the table shows the assets for which User A has Reviewer respons-
ibility. If user B is signed in, the table shows the assets for which User B has
Reviewer responsibility.

l The Roles category of a basic filter does not take into account inherited respons-
ibilities. If you want to include inherited responsibilities in the filter criteria, you can
use an advanced filter.

Create a basic filter

If you want to customize a view to make sure that you only see the assets that you really
need, you can create a filter.

To create a basic filter, follow these steps:

1. Navigate to a table or set of tiles that contains the assets you want to see.
Example: Business Glossary

2. In the Filters pane, next to filters, click Edit.
Verify that you are in basic filter mode. If you aren't, click Switch to basic.

3. In the right column of the Filters pane, select the characteristics that you want to
include in your filter.
You can do this in different ways:

o By typing the name of what you are looking for in the search field at the top,
and then selecting the characteristic.
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o By going through the list while expanding or collapsing characteristics to find
what you are looking for, and then selecting the values.

27



Note
o For some characteristics, you have to select the values from a
predefined list, for example Type or Status.

o For some characteristics, you have to type one or more values, for
example Name or Definition.

o Multiple values for a characteristic are treated as an OR clause.
o All the simple expressions in a basic filter are treated as an AND clause.
o You can remove a filter characteristic by clicking next to the filter
characteristic that you want to delete, or you can remove a single value
from a filter characteristic by clicking next to its value.

4. Click Apply to activate the filter or click Cancel to close the filter characteristics pane.

Advanced filters

Advanced filters are like basic filters in that they consist of one or more filter clauses.
Advanced filters, however, use advanced logical operators. In a basic filter clause, the
logical operator is "equals". In advanced filter clauses, the operator depends on the
property, characteristic or resource role that you select as the filter criterion.

The filter criteria are grouped as follows:

l Properties: All the asset properties in Collibra, for example name, asset type and
tags.

l Attributes: All the asset attributes in Collibra, for example note, definition and quality.
l Relations: All the relations in Collibra.
l Roles: All the resource roles that are defined in Collibra, for example Business Ste-
ward, Requester and Assignee.

The following table shows some examples of operators, per filter criterion type:

Chapter 2
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Filter criterion
type

Operators

Text, for example
Name

l equals
l does not equal
l contains
l does not contain
l starts with
l does not start with
l ends with
l does not end with
l exists
l does not exist

Boolean, for
example Certified

l equals
l does not equal
l exists
l does not exist

Numeric, for
example Artic-
ulation Score

l equals
l does not equal
l less than
l less than or equals
l greater than
l greater than or equals

Date, for example
Created On

l equals
l before
l before or equal to
l after
l after or equal to
l last (...) days
l exists
l does not exist
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Filter criterion
type

Operators

Resource role, for
example Business
Steward

l contains
l does not contain
l equals
l does not equal
l starts with
l does not start with
l ends with
l does not end with
l exists
l does not exist

Note If you select the logical operator "equals", you can select the value
Current User, to find all assets for which you have been assigned the specified
resource role. This means that users might see different results in the same
view, depending on their responsibilities.

Filtering by resource role and a specific user is extended to user groups that include
the specified user, for the selected resource role.

Example John Fisher is included in a user group named The Dream Team.
There are a number of assets for which The Dream Team user group has been
assigned as the Business Steward. If you filter a view by Business Steward,
and specify the user John Fisher, all such assets will pass the filter.

You can create a combination of clauses by using the AND and OR operators and
brackets. The order of the clauses does not affect the results.

Depending on the logical operator, you can add multiple values. If you do so, the values
are treated as an OR operator.
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Example The filter below finds assets that meet these criteria: they have the asset
type Business Term OR the assets have both the domain Business Glossary and
one of these three statuses: Accepted, Approval Pending or Candidate.

Create an advanced filter

You can create an advanced filter to only see the assets that you need in your view.

Steps

1. Navigate to a table or set of tiles that contains the assets you want to see.
Example: Glossary

2. In the Filters pane, next to Filters, click Edit.
3. Ensure that you are in advanced filter mode. If you aren't, click Switch to advanced.

4. In the Filters pane, define the filter clauses.
a. Select a characteristic from the Characteristic list.
b. Select an operator.
c. Add one or more values.
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The content of the value field depends on the selected operator.
d. Click Add filter criteria to add the next filter clause.

5. In the Filter rule field, define how the filter clauses must be interpreted. See Filter
rules.

6. Click Apply to activate the filter or Cancel to discard the changes.

Tip
If you want to filter assets by relation type and use an exclusionary logic operator,
such as does not equal or does not contain, you have to introduce two filter
clauses, as shown in the following example.

A. This filter clause conveys that you only want to consider assets that have the
relation type, for example, Asset synonym of asset Asset.

B. This filter clause shows, of all assets that have the filter type that is specified in
clause A, for example, Asset synonym of asset Asset relation, only the assets for
which the acronym does not equal a specified value, in this example CRT.

Without the exists filter clause, the filter results will include assets that do not have
the Asset synonym of asset Asset relation type, which is not helpful.

Filter rules

When you create an advanced filter, you can create complex filters by combining the filter
clauses you created with Create an advanced filter. By default, the filter clauses are
combined with the AND (conjunction) operator. However, you can also combine the
clauses by using brackets and the OR (disjunction) operator.

Chapter 2
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Operator Explanation

AND A result must fit all filter clauses.

Example: A AND B AND C means that only a resource that fits all three filter clauses is
added to the results.

OR A result must fit one of the filter clauses.

Example: A OR B OR C means that whenever a resource fits one of the three filter
clauses, it is added to the results.

A filter uses the following operator precedence to filter the data:

1. Operations inside brackets.
2. AND operations.
3. OR operations.

Filter rule examples

l A OR B AND C:
o First, check the AND operation. The result must fit clause B and C.
o Second, combine it with clause A. The result must fit either A or the result of the
AND operation.

l (A OR B) AND C:
o First, check the operation between brackets. The result must fit either clause A
or clause B.

o Second, combine it with clause C. The result must fit clause C and the result of
the operation between brackets.

Reset a filter

If you have applied a filter and you want to return to the original view, follow these steps:

1. Open a view and apply a filter.
2. Click Revert to original.

3. In the Revert to original dialog box, click Revert.
You return to the originally selected view.
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Display modes
Throughout Collibra Data Intelligence Cloud, you can choose to view assets in tables
(table display mode) or as sets of tiles (tiles display mode).

When assets are viewed in table display mode, each table row represents one asset.
When they are shown in tile display mode, each tile represents one asset.

Example of a view in table display mode:

Example of a view in tile display mode:
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Table display mode

When resources are viewed in table display mode, each table row represents one
community, domain, asset or so forth. You can also switch to tile display mode.

Working with tables

All tables in DGC have some common features and actions. For some tables, you can do
additional actions.
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No. Element name Description

1 View selector The view selector shows the name and description of the current view,
and allows you to choose another view.

2 View toolbar The view bar contains buttons to save, edit, share and delete the cur-
rent view.

3 Asset filter You can use an asset filter to limit the number of assets shown.

4 Action menu The action toolbar contains a selection counter and actions that you
can perform on assets you select in the table.

5 Table menu The table menu contains buttons for actions that you can perform on
the table.
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No. Element name Description

6 Fields The fields are the column headers.

You can customize the table to determine which fields are shown and in which
order they're shown. You can also rename the field display names.

From the header, you can

l Select all visible assets.
l Sort on one or more columns, in ascending or descending order.
l Apply a column filter.
l Clear a column filter.

7 Body The body of the table shows the actual content of the table in rows.

From a table, you can do the following:

l Select a row.
l Edit the content of one, selected or all visible cells.

8 Pages The table pages. This section appears if the table contains more rows than you
are displaying.

You can do the following:

l Define the number of rows per page.
l Navigate between table pages.

9 Counter The total number of assets in the table.

If the table contains more than 10 000 rows, the counter displays 10 000 +.
Click it to see the exact count.

Switch to table display mode

If you are in tiles display mode, you can quickly convert the set of tiles to a table.

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

37



2. On the content toolbar, click → Display mode → Table.

Action toolbar
The action toolbar contains a selection counter and actions that you can perform on assets
you select in the table.

You can:

l Delete multiple assets.
l Move multiple assets to another domain.
l Validate assets.
This is only visible if a validation rule is assigned to the asset type.

l Start an asset workflow from an asset table.
Only workflows that apply to all the selected assets are available.

Table content toolbar

When you are viewing assets in table display mode, the content toolbar contains buttons
for actions that you can perform on the table.

The following table provides an overview of the possible actions:

Button Description

Import assets or complex relations.

Export assets or complex relations.
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Button Description

Display a selection of assets as a hierarchy, or tree structure, based on their relation type.

When you select only one relation type, Collibra Data Intelligence Cloud builds the hierarchy as
deeply as possible, traversing occurrences of that single relation type as often as it can.

Enable or disable hierarchies.

Refresh the table.

Manage columns and rows. You can add, remove and move columns and select the number of
rows that are displayed on one page. See Customizing tables.

You can also switch to tile display mode.

Display a preview of the selected row. You can select a row by clicking on the row itself,
not the check box.

Select or clear rows

To edit or delete multiple rows in one go, you can select multiple rows in a table.

Note Do not confuse this with highlighting a row by clicking anywhere in the row.

Steps
1. Open a view in the table display mode.
2. Perform one of the following steps:

If you want to... do...

select a single
row:

Click the checkbox in front of the row.

select all visible
rows:

Click the checkbox in the header of the column.

clear a selected
row:

Click a selected checkbox again.
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Tip In the table header, you can see how many of the available assets are
selected.

Edit cells in a table

You can edit most content in tables. You can do this for individual rows or multiple rows in
one go.

Steps
1. Open a view in the table display mode.
2. Perform one of the following steps:

o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
3. Perform one of the following steps:

o If the field is a free text field, you can edit the cell by typing.
o If the field is a drop-down list, type the new value or use the drop-down menu

.
o If the field is a date, type the new date or use the date editor .
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4. Perform one of the following steps:

If you want to
change...

do...

the current row
only:

a. Click .

all visible rows: a. Click Apply to all visible rows.
b. Click .

selected rows: a. Select one or more rows.
b. Click Apply to all selected rows.
c. Click .

Wrap the text in a cell of a table

Collibra Data Intelligence Cloud can wrap the text in cells of tables so it appears on
multiple lines inside the cell. This makes the cell content more readable.

Wrap the text of an individual cell
1. Open a view in the table display mode.
2. Hover your mouse over a cell and click .

» The height of the table row increases so the complete text in all cells in that row
becomes readable.

Note You cannot save the wrapping, so when you reload the page or open
the view later, the text is no long wrapped.

Wrap the text of all cells
1. Open a view in the table display mode.
2. On the content toolbar, click →Wrap Text.

» The pagination of the table is set to 20 rows per page.
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» The height of all table rows increases so the complete text in the cells becomes
readable.

3. Optionally, in the view toolbar, click , then Save to save the view and always wrap

the text when the view opens.

Customizing tables

If you want a table to display only the information you need about specific assets, you can
change several aspects of the table.
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Add columns to a table
In Collibra Data Intelligence Cloud, a table has a default view, displaying a default set of
columns. You can edit the asset view by adding columns to it.

Note You can also show responsibilities as a column.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. Click Select fields.

» The Select fields dialog box appears.
4. Select one or more items in the list.

Tip You can use predefined filters and the search box to quickly find columns.

5. Click Update.
» The Select fields dialog box appears.

6. If required, do the following:
l Edit a column name.
l Edit the column order.

7. Click Save.
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Show responsibilities in an asset table
An asset view can show the responsibilities of a resource, these responsibilities are shown
per role.

If you enabled inherited responsibilities in the settings, you can show the inherited
responsibilities. Inherited responsibilities have a gray background and cannot be edited in
an asset view. Direct responsibilities have a white background and can be edited.

Example

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. Click Select fields.

» The Select fields dialog box appears.
4. Select one or more roles in the list.

Tip You can find all roles in the Roles tab page.

5. Click Update.
» The Select fields dialog box appears.

Tip If you enabled inherited responsibilities in Collibra Console, you can
select Show inherited responsibilities to show inherited responsibilities.

6. Click Save.
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Edit the column order
You can edit the order in which the columns are arranged in a table.

Note If you enable hierarchies for a table, the Name column automatically appears
as the leftmost column in the table and it is frozen. More information: Freeze
columns.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.

3. Click and drag a row up or down.

4. Click Save.
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Edit a column name
You can edit the column names in a table.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. In the Display name field, type a new name.
4. Click Save.
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Remove columns from a table
You can remove columns from tables in two ways:

Remove columns from the Table Columns
dialog box
Do this if you want to remove one column.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. At the end of the line, click .

4. Click Save.

Remove columns from the Select Columns
dialog box
Do this if you want to remove several columns or add columns in one go.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. Click Select fields.

» The Select fields dialog box appears.
4. Clear the check box in front of one or more items in the list.

Tip You can use predefined filters and the search box to quickly find columns.
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5. Click Update.
6. Click Save.
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Change the number of rows per page
If a table contains a large amount of rows, they will be split across multiple pages. You can
change the number of rows that are shown per page of the table.

Steps
To change the number of rows per page, follow these steps:

1. Open a view in the table display mode.
2. On the content toolbar, click → Change Rows per Page → <number>.
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Freeze columns
Freezing columns keeps the leftmost columns in a table visible when you scroll
horizontally to the right.

Note If you enable hierarchies for a table, the Name column automatically appears
as the leftmost column in the table and it is frozen. You can still change the column
order.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.

3. Click for the Move to freeze column(s) setting, and drag it below the last column

you want to freeze.
4. Click Save.

Sort on one or more columns

Sorting the contents of a table helps you visualize your content and find the data you want.
You can sort on one or more columns.

Note
l The availability of multi-column sorting and the maximum number of columns
on which you can simultaneously sort depends on your organization's
environment settings in Collibra Console.

l Multi-column sorting is not available in tile display mode; however, you can
sort on more than one column while in table display mode and then switch to
tile display mode. The sort results will be accurately applied to the tiles. See
Sort a set of tiles.

Steps
To sort the contents of a table based on one or more columns, follow these steps:
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1. Open a view in the table display mode.
2. Click the column name of the column on which you want to sort.

appears next to the column name and the table is sorted in ascending order.

To sort in descending order, click the column name again.
3. To sort the data on a second column, click the desired column name.

» appears next to the column name and the table is sorted in ascending order.

To sort in descending order, click the column name again.
To remove sorting, click the column name a third time.

4. To sort the data on a third column, click the desired column name.
» appears next to the column name.

» The contents of the table are first sorted according to the first column you've selec-
ted. Within that sort result, the contents are further sorted according to the second
column you've selected.
To sort by additional columns, continue as above.

Tip If you start sorting on a second column, the sorting icon of the first column

changes into .

Navigate between table pages

If a table contains more rows than you are currently showing, it is split in several pages.
You can navigate between these pages.

Tip You can define the number of rows per page. More information: Change the
number of rows per page.

Steps
1. Open a view in the table display mode.
2. If the table contains more rows than those displayed, the lower left corner shows the

pages.
Do one of the following:
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To navigate
to...

click...

the previous
page

the next page

the first page the first page.

Example: 1-10

one of the 2 pre-
vious or fol-
lowing pages

the desired page.

the last page the last page.

Example: 100-110

Example

Filtering tables

You can filter tables in different ways:

l Apply a column filter.
Do this to quickly filter on a column using a simple string.
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l Asset filters.
Do this to use advanced filters.
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Apply a column filter
You can filter the content in a table using a column filter. When you apply a column filter,
only rows containing the specified string are shown.

Tip You can also use asset filters to define complex criteria. More information:
Asset filters.

Steps
To apply a column filter, follow these steps:

1. Open a table.
2. In a column header, click .

3. The column header becomes a search box.
Type the text you want to filter on.
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Clear a column filter
After you applied a column filter, you can clear it again to make more rows visible.

Steps
To clear a column filter, follow these steps:

1. Apply a column filter.
2. In the table name, click .

Working with hierarchies

A hierarchy is a visual representation of relations between assets. The hierarchy feature
for asset views enables you to display a set of assets in a table as a hierarchy or a tree
structure based on the relations between the assets. You can select which relation types to
display in the hierarchy.

Note Collibra Data Intelligence Cloud uses dotted lines to graphically depict the
relations between the assets in the hierarchy. Small carets (triangles) depict nodes
in the hierarchy that you can expand.

When enabling hierarchies, you can choose between the following types of hierarchies:

l Single-path hierarchy: For each node at a certain level in the hierarchy, there is only
one path to the nodes at the next level.
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l Multi-path hierarchy: At each junction, any relation type in the hierarchy path is tra-
versed to find more nodes. That is, all relations are traversed for any asset, at any
depth.

Note
l In a hierarchy, filters are applied only at the root level.
l You cannot export or import a hierarchy.
l In a hierarchy, you cannot use the tile mode of display.

Example
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Single-path hierarchy
Suppose that you have assets that represent Reports. Each Report asset contains Report
Attribute assets. You can depict this as a single-path hierarchy using a single relation type:

[Report] contains [Report Attribute]

The maximum depth (that is, the number of relations between a root node and a leaf node)
of the resulting hierarchy is one.

Suppose that some of those Report Attributes are represented by Business Assets via the
following relation type:

[Data Asset] represented by [Business Asset]

Note Report Attribute is a child asset type of Data Asset.

You can depict this as a single-path hierarchy using the following relation types:

l [Report] contains [Report Attribute]
l [Data Asset] represented by [Business Asset]

The maximum depth of the resulting hierarchy is two.

Suppose that those Reports are grouped into other Reports. You can depict this as a
single-path hierarchy using a single relation type:

[Report] groups [Report]

The fundamental difference between this hierarchy and the previous one is that in this
hierarchy, the target asset type of the relation (Report) is also the source asset type
(Report), which can result in a hierarchy of unlimited depth. For example:

l Report A groups Reports B and C
l Report B groups Reports D and E
l Report C groups Reports F

While this hierarchy shows the Groups relations between the Reports, it does not show the
Report Attributes contained in each Report. A single-path hierarchy does not allow two
relation types to be simultaneously depicted in a hierarchy as follows:
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l [Report] groups [Report]
l [Report] contains [Report Attribute]

In a single-path hierarchy, each Report node acts like a junction at which you can view the
instances of one relation type or the other, but not both.
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Multi-path hierarchy
Considering the example described earlier, in a multi-path hierarchy, you can
simultaneously view:

l [Report] groups [Report]
l [Report] contains [Report Attribute]
l [Data Asset] represented by [Business Asset]

Important When viewing the hierarchy for a community or domain, if the parent of a
node that is in the community or domain belongs to a different community or
domain, that node is not shown in the hierarchy.
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Enable or disable hierarchies
You can enable hierarchies to display an asset table in a tree structure, or disable
hierarchies to display a flat asset table.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click .

» The Configure Hierarchy dialog box appears.
3. Enter the required information.

Field Description

Enable
Hierarchy

Select or clear this checkbox to enable or disable hierarchies, respectively.

Single path A hierarchy in which, for each node at a certain level, there is only one
path to the nodes at the next level.

Multipath A hierarchy in which all relations are traversed for any asset, at any depth.

Define a
hierarchy using
relation types

Specify the relation types that you want to use for your hierarchy.

4. Click Apply.

Tile display mode

When resources are shown in tile display mode, each tile represents one asset. You can
also switch to table display mode.
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Working with tiles

In tile display mode, each tile represents one asset. The tiles have some common features
and actions.

No. Element name Description

1 View selector The view selector shows the name and description of the current view,
and allows you to choose another view.

2 View bar The view bar contains buttons to save, edit, share and delete the cur-
rent view.

3 Asset filter You can use an Asset filters to limit the number of tiles that are dis-
played.
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No. Element name Description

4 Tiles action
menu

The tiles action menu with a selection counter and buttons that enable you to:

l Sort the tiles in ascending or descending order, by field.
l Delete multiple assets.
l Move multiple assets to another domain.
l Validate assets.
This is only visible if a validation rule is linked to the asset type.

l Start a workflow from a table.
Only workflows that apply to all the selected assets are available.

5 Tiles menu The Tiles content toolbar contains buttons for actions that you can perform on
the set of tiles.

6 Fields and values Fields and values of the asset.

You can customize a set of tiles by adding, moving and removing fields and
selecting the number of tiles that are displayed per page.

7 Pages The tiles pages. This section appears if there are more tiles than you are
displaying on one page.

You can:

l Change the number of per page.
l Navigate between tiles pages.

8 Counter The total number of tiles.

If a set of tiles contains more than 10 000 tiles, the counter displays 10 000 +.
Click it to see the exact count.

Switch to tiles display mode

If you are in table display mode, you can quickly convert the table to a set of tiles.

Steps
1. Open a view in the table display mode.
2. On the content toolbar, click → Change Display Mode → Tiles.
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Tiles action toolbar

The tiles action toolbar contains a selection counter and actions you can perform on
selected tiles.

You can:

l Sort the tiles in ascending or descending order, by field.
l Delete multiple assets.
l Move multiple assets to another domain.
l Validate assets.
This is only visible if a validation rule is linked to the asset type.

l Start a workflow from a table.
Only workflows that apply to all the selected assets are available.

Tiles content toolbar

When you are viewing assets in tile display mode, the content toolbar contains buttons for
actions that you can perform on a set of tiles.

The following table provides an overview of the possible actions:

Button Description

Import assets or complex relations.

Export assets or complex relations.
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Button Description

Enable or disable hierarchies.

Note The hierarchy feature is only available in table display mode.

Refresh the table.

Manage fields and tiles count. You can customize a set of tiles by adding, moving and removing
fields and selecting the number of tiles that are displayed per page.

You can also switch to table display mode.

Enable or disable the preview.

Note Preview is only available in table display mode.

Customize a set of tiles

If you want a set of tiles to display only the information you need about the assets, you can
change several aspects of the tiles.
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Add fields to a set of tiles
In Collibra Data Intelligence Cloud, a set of tiles has a default view, displaying a default set
of fields. You can add, remove and rename the fields that appear in the tiles.

Note You can also show responsibilities as a field.

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. Click Select fields.

» The Select fields dialog box appears.
4. Select one or more items in the list.

Tip You can use predefined filters and the search box to quickly find fields.

5. Click Update.
6. If required, do the following:

l Change a field name.
l Change the order of the fields.

7. Click Save.
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Show responsibilities in a tile set
Tiles can show the responsibilities of a resource, these responsibilities are shown per role.

If you enabled inherited responsibilities in Collibra Console, you can show the inherited
responsibilities. Inherited responsibilities have a gray background and direct
responsibilities have a white background.

Example

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. Click Select fields.

» The Select fields dialog box appears.
4. Select one or more roles in the list.

Tip You can find all roles in the Roles tab page.

5. Click Update.
» The Select fields dialog box appears.

Tip If you enabled inherited responsibilities in Collibra Console, you can
select Show inherited responsibilities to show inherited responsibilities.

6. Click Save.
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Edit the order of the fields
You can edit the order in which the fields are arranged in a set of tiles.

Note The community-domain breadcrumb will always appear at the top of the tile,
followed by the asset name, status and report image, if an image has been
uploaded for the asset.

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.

3. Click and drag a field up or down.

4. Click Save.
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Edit a field name
You can edit the field names in a set of tiles.

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. In the Display name field, type a new name.
4. Click Save.

Chapter 2

68



Chapter 2

Remove fields from a set of tiles
You can remove fields from a set of tiles in two ways:

l Use the Fields dialog box.
Do this if you want to remove a single field.

l Use the Select fields dialog box.
Do this if you want to add or remove one or more fields in one go.

Remove fields using the Fields dialog box
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. Click for the field you want to remove.

4. Click Save.

Remove fields using the Select fields dialog
box
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
3. Click Select fields.

» The Select fields dialog box appears.
4. Clear the check box in front of one or more items in the list.

Tip You can use predefined filters and the search box to quickly find fields.

5. Click Update.
6. Click Save.
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Edit the number of tiles per page
If a view contains a large amount of tiles, they will be split across multiple pages. You can
change the number of tiles that are shown per page.

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. On the content toolbar, click → Change Rows per Page → <number>.

Select multiple tiles

When you select a single tile, all of the actions available to you appear above the tiles, in
the tiles action menu. The same is true when you select multiple tiles. For all of the tiles
you've selected, you can perform the same actions or start a workflow.

Note Only workflows that apply to all selected tiles are available.

Steps
To select multiple tiles, follow these steps:

1. Do one of the following:Open a view in tiles display mode.Open an asset page with
related assets shown in tiles display mode.

2. To select consecutive tiles, click the first tile, press and hold down the Shift key, and
then select the last tile you want.

3. To select non-consecutive tiles:
o If you're working with Windows OS, press and hold down the Ctrl key, and then
click each tile you want.

o If you're working with macOS, press and hold down the Command key, and
then click each tile you want.
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Sorting tiles

Sorting tiles helps you visualize your content and find the data you want. You can sort a set
of tiles in ascending or descending order, by the field of your choice.

Tip In tile display mode, you can only sort on one field at a time, whereas in table
display mode, you can sort on one or more columns simultaneously. However, if you
sort on more than one column in table display mode and then switch to tiles display
mode, the results of the multi-column sorting is carried over to the tiles. If you then
change the sorting while in tile display mode, the sort will be based on the single
field of your choice.
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Sort a set of tiles
You can sort a set of tiles by the field of your choice.

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

» By default, the tiles are arranged in descending alphabetical order, by name.
2. Do one of the following:

o On the left, click Name, or if sorting has been done by another field, click that
field name.

o If you or someone else sorted on more than one column in table display mode
and you then switched to tile display mode (see the note below), click .

» A drop-down menu appears, with all the fields that are currently visible for the set
of tiles.

3. Select the field by which you want to sort the tiles.
» The tiles are sorted in descending order.

4. Optionally, click to sort in ascending order.

Note If you or someone else sorted on more than one column in table display mode
and then you switch to tile display mode, the multi-column sort is carried over to
tiles. In the following example figure, the table was sorted by the Name and Domain
columns before switching to tiles display mode.

Navigate between tiles pages

If a set of tiles contains more tiles than you are currently showing, they are split across
multiple pages. You can navigate between these pages.
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Tip You can change the number of tiles per page.

Steps
1. Do one of the following:

o Open a view in tiles display mode.
o Open an asset page with related assets shown in tiles display mode.

2. If the set of tiles contains more tiles than those displayed, the lower left corner shows
the number of pages.
Do one of the following:

To navigate
to...

click...

the previous
page

the next page

the first page the first page.

Example: 1-10

one of the two
previous or fol-
lowing pages

the desired page.

the last page the last page.

Example: 261-268
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To navigate
to...

click...

Example

Filtering tiles

You can use advanced Asset filters to filter the tiles shown in tile display mode.

Searching in Collibra
You can use the Search field and the Search widget to quickly find any resource in Collibra
Data Intelligence Cloud, including assets, communities, domains, users, user groups and
more.

Both options take you to the Search page, where you can edit your search text and work
with the search results.

Search field
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The search finds resources that contain a word that begins with your search text. For
example, if you type ca, the search results could contain "California", "Lewis Carroll" or
"Meercat".

Recently viewed

When you click in the Search field, the five most recently viewed resources are shown in
the quick search panel.

If refreshed navigation is enabled for your Collibra environment, the search results are
automatically filtered by the current domain or community if you search with a domain or
community page open.

Top results

When you start typing in the Search field, the top 10 results are shown in the quick search
panel.
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Note
l In compiling the top results, the search engine searches for your text in the
Name field only. As such, these results might not appear as the top results on
the Search page, when you launch the search.

l The order of the top results takes boosting into account.

Actions

After typing something in the Search field, you can do any of the following:

l Press Enter to start the search.
» The Search page, with results matching your search text is shown.

l Click on an asset name, to go to the asset page.

Search page
The Search page consists of the following areas:
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No. Part name Description

1 Facet pane A dynamically generated collection of facets that allows you to:

l Add and remove search fields, to expand or reduce the scope of your
search.

l Navigate and refine the search results.

Note The Facet pane is only shown if your search yields results.

2 Search filters A drop-down list of all your saved search filters, with the name of the currently
applied filter shown. By default, no search filter is applied.

The buttons allow you to:

l : Create a new search filter or save a copy of an existing filter.
l : Edit the name and description of a search filter.
l : Share a search filter
l : Delete a search filter.
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No. Part name Description

3 Search
input field

Shows your search text. You can edit your search text here.

Click for examples of how wildcards and symbols work in your search text.

4 Search res-
ults

Shows:

l The results that match your search.
l The total number or results.
l The applied sorting criterion and sorting order. By default, search results
are sorted in order of descending relevance.

l The selected fields in which the search is performed. By default, all fields
are searched.

Click to:

l Add or remove fields that are shown for each search result.
l Edit the number of results shown per page.

For any result that is an asset, click the three dots ( ) to show the workflows that

are available for the asset.

Click the name of a search result to open its detailed page.

Tip In Collibra Console, you can influence the order of the search results by
editing the boost factor of resources and attribute types. See also Relevance
in search results.
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Note It's possible that you or another user created a search filter that includes a
field or facet that no longer exists in your Collibra Data Intelligence Cloud
environment. In this case, the invalid field or facet is highlighted, as shown in the
following image, so that you can easily identify it and delete it from the search filter.
Invalid fields and facets are ignored during search queries.

Wildcards and symbols for searching
If you want to find a resource, but are not quite sure of its name, you can use the follow
wildcards:

Wildcard Description

? Replaces any single character.

Example: by typing ?owie, you can find Bowie, Rowie, Mowie, and so on.

* Replaces any string of characters.

Example: by typing B*e, you can find Bowie, Badge, Byte, and so on.
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Wildcard Description

~ Represents a fuzzy search, words with spelling similar to the search query.

Example: by typing Owi~, you can find Ozi, Zowie, Bowie, and so on.

! Excludes words.

Example: by typing !David Bowie, you can find Lester Bowie, Joe Bowie and so on.

" " Represents a literal search.

Example: by typing "David Bowie", you can find David Bowie and David Bowie Songs, but
not David or Bowie.

Sort the search results
You can sort search results by the following criteria:

l Relevance
l The Name field
l The Last Modified field

Steps

1. Perform a search via the Search field or Search widget.
2. On the Search page, click next to the sort field.

3. Select the basis by which to sort the search results.
» By default, the results are sorted in descending order.

4. Optionally, click to sort in ascending order.

What's next?

l If you sorted the search results by an attribute type that is not shown in the tiles, you
can add it to the tiles, so that you can see the values that determined the sort order.

l You can create a search filter or edit an existing search filter, to save your sort set-
tings as part of the saved filter configuration.
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Relevance in search results
By default, search results are sorted in order of descending relevance.

What is relevance in the context of search results?

Relevance is a calculation of the similarity, measured across several lines of comparison,
between your search text and the content of the resources in your Collibra environment.

In a set of search results, the relevance of each resource is represented by a positive
number, or score. The higher the score, the more relevant the resource is to your search
text.

How are relevance scores derived?

To derive relevance scores, the Collibra search engine uses a combination of query
clauses and boost factors.

Query clauses

When you perform a search, the Collibra search engine queries the database, using
various query clauses. Each query clause compares the similarity between your search
text and your Collibra resources, along a different line of comparison.

The following are example objectives of different query clauses:

l Calculate the similarity between the spelling of your search term and the term found
in a field in the database.

l Calculate how frequently your search term appears in a field. The more often it
appears, the greater the relevance. A field containing five occurrences of a given
term is more likely to be relevant than a field containing one occurrence of the term.

l Calculate the occurrence percentage of a term among all words in a particular field.
For example, if your search term occurs twice in the 10-word description of an asset,
that asset will have a higher relevance score than an asset for which your search
term occurs twice in its 20-word description.
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Boosting

Search boost factors allow you to influence the order of the search results. You can edit
search boost factors to increase or decrease the importance of a resource type, field or
asset type, in the search ranking.

For more information on boosting, see Search boost settings.

What is a faceted search?
The Facet pane shows the relevant criteria by which to navigate and refine the search
results. We refer to these criteria as facets, and the concept of using facets to navigate and
refine search results as a "faceted search".

In introducing the concept of a faceted search, it may be helpful to draw the distinction
between it and a more traditional filter-based search.

Filter-based search

Filters work by analyzing the search results and excluding resources (for example, assets,
users and communities) that don't meet certain criteria.

In a filter-based search, the collection of filters that is available to you is constant. The
relevance of the filters to the search results is not considered. As such, some of the filters
available to you could either have no effect on the results, or reduce the results to a null
set.

Faceted search

Facets are dynamically generated according to the resources that make up the search
results. They allow you to narrow results by several different dimensions simultaneously.

In a faceted search, only facets that are relevant to the search results appear in the Facet
pane on the Search page. As you select facets, to navigate and refine the search results,
the Facet pane is automatically updated, again showing only facets that are relevant to the
refined set of results.
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As shown in the following image, the facets in the Facet pane at any given moment include
the number of resources that match both the search text and the value of the available
facets. This gives you a view of the composition of the search results, and helps you avoid
searches that yield no results.

Navigating and refining the search results
The Search page offers a variety of dynamically generated facets by which to navigate and
refine your search results.
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No. Part name Description

1 "Search in"
facets

These facets enable you to navigate to resources via organizational path or resource
category.

Facet Use

Organization Navigate to resources by drilling down at the organizational level and
limiting the search results to a specific community, subcommunity or
domain.

If, for example, you click on a root-level community, the results will be
refined to include only the resources (meaning subcommunities, domains
and assets) in that community that match your search text.

Category Navigate to a specific category of resources, such as assets,
communities, domains, users or user groups.
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No. Part name Description

2 "Refine"
facets

These facets act as filters to refine the search results.

The following table shows the packaged "refine" facets:

Filter cri-
teria

Use this to show only those search results...

Asset type That are of a specified asset type, such as Business Term, Acronym, Column
or Table.

This criterion is only applicable if you have selected the category Assets.

In the following example image, the search engine searches for your text only
in assets of asset type Standard, Column and Data Set.

Status That have a specified status, such as Candidate, Accepted, Deployed
or Rejected.

Last
modified

That were modified within the specified time frame; within the last 24 hours,
week, month or year.

Created by That were created by the specified users.

Created on That were created within the specified time frame; within the last 24 hours,
week, month or year.

Tags That have the specified tag(s).

You can click the tag in any of the search results, to search for all domains
and assets with that tag.

Working with facets

Click Clear, to clear all selections for a specific facet type.

At the top of the page, click Clear all, to clear all facet type selections on the search page.
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Click Show all, to show all the facets by which to refine the scope of your search for a
particular facet type. As shown in the following example image, if there are more than 15
facets, the list will open in a dialog box.

Note Adding and removing facets on the search page is not the same as:

l Filtering the search results.
l Adding or removing fields to a set of tiles.

Permissions

No particular license is needed to create and manage search filters; however, certain
global permissions are needed.

Permission With this permission, you can...

Manage and share anyone's Views,
Dashboards, Search filters

Create and manage search filters for yourself and other users,
and share with other users.

Manage your own Views, Dash-
boards, Search filters

Create and manage your own search filters.

Share your own Views, Dashboards,
Search filters

Share search filters that you created.
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Note Users are not granted permissions directly, but through global roles and
responsibilities.

Search filters
You can create a search filter from scratch. When you create a search filter, it exists only
for you. However, with the correct global permission, you can share the filter with other
users.

By default, no search filter is applied.

Create a search filter

You can create a search filter from scratch.

Note When you create a search filter, the sorting and search fields are part of the
saved configuration.

Create a search filter via the save icon

1. Perform a search via the Search field or Search widget.
» The Search page appears.

2. Optionally:
a. Navigate and refine the search results by selecting from the available facets.
b. Sort the search results.
c. Select the fields in which to search.

3. When you've achieved the desired results, click .

4. Enter a name and description of the filter.
5. Select with whom you want to share the filter.

o Select Public, to share the filter with all users.
o Select Private, to share the filter with no one. This is the default setting.
o Select Share with specific global roles, groups and users, and then enter the
relevant roles or groups.
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6. Click Save.
» The new filter is added to your list of filters.

Create a search filter via the "Add a new search filter" option

1. Perform a search via the Search field or Search widget.
» The Search page appears.

2. Click No search filter , and then select Add a new search filter.

3. Enter a name and description of the filter.
4. Select with whom you want to share the filter.

o Select Public, to share the filter with all users.
o Select Private, to share the filter with no one. This is the default setting.
o Select Share with specific global roles, groups and users, and then enter the
relevant roles or groups.

5. Click Save.
» The new filter is added to your list of filters.

Save a copy of a search filter

You can save a copy of any search filter, and then edit it to suit your needs.

Steps

1. Perform a search via the Search field or Search widget.
2. On the Search page, click on the search filter label, to expand the search filter drop-

down list, and then select the relevant filter.
3. Click , and then select Save As.

4. Enter a name and description of the filter.
5. Select with whom you want to share the filter.

o Select Public, to share the filter with all users.
o Select Private, to share the filter with no one. This is the default setting.
o Select Share with specific global roles, groups and users, and then enter the
relevant roles or groups.

6. Click Save.
» The new filter is added to your list of filters.
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Note When you save a copy of the search filter, the sorting and search fields are
part of the saved configuration, but the search text is not.

Edit a filter's name and description

You can edit the names and descriptions of the search filters you've created.

Steps

1. Perform a search via the Search field or Search widget.
2. On the Search page, click on the search filter label, to expand the search filter drop-

down list, and then select the relevant filter.
3. Click .

» The Edit name and description dialog box appears.
4. Edit the name and/or the description.
5. Click Save.

Edit a search filter

You can edit an existing search filter to suit your needs.

Steps

1. Perform a search via the Search field or Search widget.
2. On the Search page, click on the search filter label, to expand the search filter drop-

down list, and then select the relevant filter.
3. In the Facet pane, reconfigure the available facets to achieve the desired filter res-

ults.
4. Click , and then select Save.

Share a search filter

Your permissions determine whether or not you can share search filters, and if so, whether
you can share only filters you've created or also the filters that others have created and
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shared with you.

Steps

1. Perform a search via the Search field or Search widget.
2. On the Search page, click on the search filter label, to expand the search filter drop-

down list, and then select the relevant filter.
3. Click .

4. Select with whom you want to share the filter.
o Select Public, to share the filter with all users.
o Select Private, to share the filter with no one. This is the default setting.
o Select Share with specific global roles, groups and users, and then enter the
relevant roles or groups.

5. Click Save.

Delete a search filter

If you have the SysAdmin global role, you can delete your own search filters and those that
other users have created and shared with you. If you don't have the SysAdmin global role,
you can only delete search filters that you've created.

Steps

1. Perform a search via the Search field or Search widget.
2. On the Search page, click on the search filter label, to expand the search filter drop-

down list, and then select the relevant filter.
3. Click .

4. Click Delete filter to confirm.

Text editors
Text editors in Collibra Data Intelligence Cloud allow you to enter, format and edit text.

The following text editors are available throughout Collibra:
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l Standard text editor.
l Mini text editor.
l Table text editor.
l Plain text editor.

Standard text editor
The standard text editor is a rich text formatting editor. You use this editor on text widgets
and asset pages to edit text attributes such as Definition and Note. It allows HTML
formatting and styling. For advanced formatting, you can use the toolbar or enter HTML
code after clicking in the toolbar.

Warning
The standard text editor supports most HTML elements, inline CSS styling and table
(< t >) structures. However, this means an attacker could potentially execute an
XSS attack by injecting malicious HTML. However, when you save, the following
HTML elements are removed for security reasons:

l script (including JavaScript)
l svg
l frame
l frameset
l iframe
l any event handlers

Text attributes are always protected, but you can also enable this for text widgets in
Collibra Console. For more information, see the Troubleshooting section.
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Mini text editor
You use the mini text editor typically for comments, ratings and so on. The toolbar offers
basic formatting options.

Table text editor
The table text editor allows you to edit and format text in asset tables, The toolbar contains
all the editing options of the mini text editor toolbar, plus a clear formatting option.

Plain text editor
The plain text editor allows you to enter text without formatting.
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Use of text editors
The following table identifies where the various text editors and field are used.

Editor Location of use

Standard text
editor

l Dashboard Text widget
l Community, domain and asset pages

Mini text editor l Comments
l Ratings

Table text editor l Table text fields

Plain text editor l Add characteristic option of an asset

Keyboard shortcuts
For the standard text editor, you can use the following keyboard shortcuts to edit or format
your text:

Action PC Mac

Bold Ctrl + B Command + B

Italic Ctrl + I Command + I

Underline Ctrl + U Command + U

Select all Ctrl + A Command + A

Redo Ctrl + Y / Ctrl + Shift + Z Command + Y / Command + Shift + Z

Undo Ctrl + Z Command + Z

Header 1 Alt + Shift + 1 Control + Option + 1

Header 2 Alt + Shift + 2 Control + Option + 2

Header 3 Alt + Shift + 3 Control + Option + 3
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Action PC Mac

Header 4 Alt + Shift + 4 Control + Option + 4

Header 5 Alt + Shift + 5 Control + Option + 5

Header 6 Alt + Shift+6 Control + Option + 6

Paragraph Alt + Shift + 7 Control + Option + 7

Keyboard focus to toolbar Alt + F10 Option + F10

Toggle fullscreen Alt + Shift + F Command + Shift + F

Activities
An activity is a process that Collibra runs in the background. While the process is running,
you can use Collibra as usual. Activities are, for example, importing and exporting assets,
or registering a data source and profiling data.

Activities lists
Activities lists show more information about the most recent or ongoing activities in
Collibra Data Intelligence Cloud, for example the creation date and the status.

There are activities lists in different locations.

Activities list in the main menu

The activities list in the main menu only shows the most recent and ongoing activities. You
can open the activities list by clicking in the main menu. If there are activities still

running, the wheel is spinning.
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Click Show more to open the activities list on your profile page.

Activities list on your profile page

The activities list on your profile page contains a table with all your activities. It also shows
more information about each activity, for example the creation date, name, status, start,
finish and result.

You can open the activities list by clicking Show more in the activities list on the main
menu or by opening your profile page and clicking the Activities tab.
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Column Description

Created The date and time that the activity started.

Name The name of the activity.

Status The status of the activity. The following statuses can be shown:

l Canceled for canceled activities.
l Canceling for activities that are in the process of being canceled.
l Completed for completed activities.
l Error for failed activities.
l Running for activities that are still running.
l Waiting for activities that are not started yet.

Job Result Specific results of the job based on whether you selected the option to
continue on error.

l Success: All imports are completed without any errors.
l Completed with error: There are some errors but all successful imports
are completed.

l Aborted: The import was stopped after reaching the threshold of the
number of failed commands set in the import configuration setting in
Collibra Console . All successful commands before reaching the threshold
were completed.

l Failure: Something went wrong and caused the job to stop before
processing all imports or reaching the number of failed commands
threshold.

Started The date and time that the activity started.
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Column Description

Finished The date and time that the activity finished.

Results If available, a button to see detailed results of the activity. Depending on the activity,
the result can be different.

Example If you exported assets and click Results in the activities list, you
download the export results. If you registered a data source in Data Catalog, a
dialog box shows more information about the registration job.

<Column to
delete an
activity>

A button ( ) to delete the activity.

Activities list in the General section of the Collibra settings

The activities list in the General section of the Collibra settings contains a table with all
activities started by all users. It also shows more information about each activity, for
example the creation date, name, status, start, finish and result.
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Column Description

Created The date and time that the activity started.

Name The name of the activity.

Status The status of the activity. The following statuses can be shown:

l Canceled for canceled activities.
l Canceling for activities that are in the process of being canceled.
l Completed for completed activities.
l Error for failed activities.
l Running for activities that are still running.
l Waiting for activities that are not started yet.

Job Result Specific results of the job based on whether you selected the option to
continue on error.

l Success: All imports are completed without any errors.
l Completed with error: There are some errors but all successful imports
are completed.

l Aborted: The import was stopped after reaching the threshold of the
number of failed commands set in the import configuration setting in
Collibra Console . All successful commands before reaching the threshold
were completed.

l Failure: Something went wrong and caused the job to stop before
processing all imports or reaching the number of failed commands
threshold.

Started The date and time that the activity started.

Finished The date and time that the activity finished.

Results If available, a button to see detailed results of the activity. Depending on the activity,
the result can be different.

Example If you exported assets and click Results in the activities list, you
download the export results. If you registered a data source in Data Catalog, a
dialog box shows more information about the registration job.
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Column Description

<Column to
delete an
activity>

A button ( ) to delete the activity.

Profile page
The profile page of a user contains information about that user.

You can always see all information on your own profile page. On the profile pages of other
users, you see basic information such as their name and contact information. If you have a
global role with the User Administration or the System Administration global permission,
for example Sysadmin, you can see all information for all users.

Full profile page

The view bar contains important information about the user, such as the name, license
type, required license type and email address. It contains buttons to edit the user's
name and reset the password.

The profile page contains the following tab pages:

Tab page Description

Overview The overview page contains general information such as the user's
account information, mail notification settings and contact information.

Groups The groups page contains the groups of which the user is a member and,
with the right permissions, allows you to add the user to or remove the
user from groups.

Responsibilities The responsibilities page contains the responsibilities that are assigned to
the user.

History The history page contains the history of the user's actions.

99

https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0635
https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0630


Tab page Description

Activities The activities pages contains the list of your activities.

Mentions The mentions page contains a list of all comments in which you are mentioned.

Example

Basic profile page

The view bar contains some basic information about the user, such as their name and
email address.

The profile page contains the following tab pages:

Tab page Description

Overview The overview page contains the user's contact information.

Groups The groups page contains the groups of which the user is a member.

Responsibilities The responsibilities page contains the responsibilities that are assigned to
the user.
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Example

Open a profile page
As a regular user, you can open your own profile page. Administrators can open
everybody's profile page.

Prerequisites

If you want to open the profile page of another user, you have a global role with the User
Administration or the System Administration global permission, for example Sysadmin.

Open your own profile page

1. Click your avatar, then Profile.
» Your profile page appears.
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Open another user's profile page

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. Click the username of the user whose profile you want to open.

Edit the user account settings
As a regular user, you can edit the settings of your own user account on your profile page.
As an administrator, you can also edit other users' settings.

Prerequisites

If you want to edit the user account settings of another user, you have a global role with the
User Administration or the System Administration global permission, for example
Sysadmin.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the Account section, click .
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3. Enter the required information.

Field Description

Username Enter the username.

Collibra username requirements
o General requirements:

n Uniqueness: Duplicate username are not allowed, regardless of
case

Example usernamecase and UserNameCase are
considered duplicate

n No leading or trailing spaces
n No empty usernames
n Maximum of 255 characters

o Character limitations: Usernames may only contain characters in the
following Unicode categories:
n Letter
n Number
n Symbol
n Punctuation
n Non-spacing marks

Application Lan-
guage

Choose the interface language.

As an administrator, you can add or edit interface languages.

Note From version 2022.11 onwards, Collibra takes the default
language of your browser into account to select the interface text
language of some sections. Collibra now also has translations of some
interface text available out of the box. Consequently, you can no longer
edit that interface text, nor translate it into unsupported languages. This
includes the interface text of Usage Analytics, Data Marketplace and the
Homepage.

4. Click Save.

Edit the contact information
As a regular user, you can edit contact information of your own user account on your
profile page. As an administrator, you can also edit other users' contact information.
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Note You can also add new contact information.

Prerequisites

If you want to edit the contact information of another user, you have a global role with the
User Administration or the System Administration global permission, for example
Sysadmin.

Edit contact information from a profile page

1. Click your avatar, then Profile.
» Your profile page appears.

2. Perform one of the following steps:
o In the Contact section, click .

Do this to edit the existing fields.
o In the Contact section, click Add.
Do this to add a new field, or edit the existing fields.

Note If you edit the email address, a notification email is sent to the old email
address.

3. Edit the contact information.
4. Click Save.

Edit contact information from the user table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3.  Perform one of the following steps:

o Double-click a cell in the E-mail column.
o Hover your mouse over a cell in the E-mail column and click .
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Note If you edit the email address, a notification email is sent to the old email
address.

4. Click in the field and type the new email address.
5. Click .

Edit the email notification settings
You can edit the email notification settings for your own user account. As an administrator,
you can also edit other users' notification settings.

If you enable notifications, you will be notified via email whenever changes are made to
assets for which you have been assigned a responsibility.

Note Only the 20 most recent changes for a given asset are shown in the
notification email.

Prerequisites

If you want to edit the email notification settings of another user, you have a global role
with the User Administration or the System Administration global permission, for example
Sysadmin.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the Notifications section, click .
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3. Select or clear the necessary check boxes.

Field Explanation

Notify me of content
updates

Specify whether or not you want to receive email notifications.

If you select this option, email notifications will be sent to the email
address shown in the Contact section of your Profile page, at the
specified frequency.

Days of the week Receive email notifications only on the days you specify.

Monthly Receive a summary email once a month.

4. Click Save.

Edit the maintenance announcement settings
You can edit the maintenance announcement settings on your profile page.

If you enable maintenance announcements, you receive notifications in Collibra about
scheduled maintenance.

Prerequisites

Usage statistics are enabled. Contact Collibra support if this is not the case.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the Scheduled Maintenance Notifications section, click .

3. Select or clear the check box.
4. Click Save.

Edit user details
You can edit your own profile such as the application language, email notifications and
contact email address on your profile page. You can also reset your password, you receive
instructions to do so by email.

Chapter 2

106

https://support.collibra.com/


Chapter 2

Prerequisites

If you want to edit the user details of another user, you have a global role with the User
Administration or the System Administration global permission, for example Sysadmin.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the upper-right corner, click Edit.
» The Edit dialog box appears.

3. Enter the required information.

Field Description

First name Enter the first name of the user.

Last name Enter the last name of the user.

Email Enter the email address on which the user receives all communication from
Collibra, such as the registration mail and notifications.

4. Click Save.

107

https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0635
https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0630


108

Asset functionalities
In this section, you find more information about the general functionalities on asset pages
such as diagrams, relations and ratings.

In this chapter
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Asset pages
An asset page contains information about one asset. An asset is a resource that is stored
and managed in Collibra Data Intelligence Cloud and owned or controlled by the customer.
An asset is the capital building block by which to capture information (in terms of
characteristics).

Identical asset names per domain
‘Identical asset names per domain’ is a feature that allows you to specify a regular name
and a unique full name for an asset. If ‘identical asset names per domain’ is enabled for an
asset type, then multiple assets of that asset type can have an identical name in a domain.

Note All assets must have a unique full name per domain, regardless of whether or
not ‘identical asset names per domain’ is enabled.

Technically, all assets have two names:

l A name: the regular name that is used by default in most places in the UI, such as
the asset page title bar, preview panes, diagrams, search results, automatic hyper-
links and relation tables.

l A full name: the fully qualified name that must be unique within a domain. It is mainly
used for technical operations (through the API) and when you edit an asset whose
asset type allows identical names per domain.

By default, the name of an asset is the same as its full name. Collibra Data Intelligence
Cloud automatically synchronizes them, so users don't notice the difference. However, for
some asset types, it may be beneficial to allow users to edit the name and full name
independently of one another, and have multiple assets with an identical name in one
domain. This has the following benefits:

l You can use a shorter or simpler name for an asset that has a long or complex full
name. This is particularly useful in Collibra Data Catalog.
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l You can use the same name for multiple assets in one domain. Keep in mind that the
full name still has to be unique for each asset in a domain.

Affected features

l The API is backward-compatible with regard to this feature, meaning the behavior of
the API is not affected by whether or not ‘identical names per domain’ is enabled.

l Drop-down fields
o In asset drop-down fields, you can search for an asset based on the name or
the full name.
This also includes the drop-down menus to:

n Add manual hyperlinks to an asset in a text attribute.
n Add (complex) relations on an asset page and in assets table.
n Filter relations on an asset table.
n Add data to a data set.

l Tables
o The Name column contains the name. This column cannot be removed
because it is used by hierarchy.

o The Full name column is a regular column that is optional.
o The relation columns contain asset names.
o You can use both the name and full name as:

n An advanced filter.
n A sort option.
n A column filter.

o The preview pane shows the asset's name.
o Editing cells:

n If the asset type allows identical asset names per domain, you can edit
both the name and full name of an asset, independently of one another.

n If the asset type does not allow identical asset names per domain, editing
either the name or full name changes both values.

n Bulk editing the Name and Full name column is not possible.
l Tiles

o The name is used in tile header.
o Full name is a regular field. It can be moved, hidden and you can edit field
name.

o Name and full name are both available as a sort option.
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l Diagrams
o The default node name is the asset name. You can also use the full name (or
any other property) as node name.

o You can use Name and Full Name as a node overlay.
o The preview shows the name of an asset.

l Export
o The name is always exported to the Name column.
o If you select Add the characteristics needed for reimport:

n The full name is always exported (to uniquely identify each asset during
re-import).

n Relations are exported based on the full name: relation name [role/co-
role asset type] → Full Name.

o If you do not select Add the characteristics needed for reimport:
n If the Full name column is added to the view, it is exported to the Full
name column.

n Relations are exported based on the name: relation name [role/co-role
asset type] → Name.

l Import
o Full name has to be mapped, unless you map the ‘ID’ column (only available in
special view ‘All Characteristics').

o Full name will auto-map to the Full name column.
o When you import a file that was exported pre-5.4, you have to manually map
the Full name column of the view to the Name column of the import file.

o Name will auto-map to the Name column.
o Name does not have to be mapped.
o Complex relations:

n Relation asset full name auto-maps to relation name [role/co-role asset
type] → Full Name.

n When you import a file that was exported pre-5.4, you have to manually
map the Full name column of the view to the relation name [role/co-role
asset type] → co-role/role asset type column of the import file.

n Relation asset display name should not be mapped.
l Search

o Basic search: searches for assets by name.
o Advanced search: searches for assets by name, when name is in the search cri-
teria.
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o Currently, you can not define a search filter for the ‘full name’ field.
o In the search results, the Name column shows the asset name.
o The preview shows the asset name.

l Validation rules
o To refer to the name in your validation rule scripts, use displayName.
o To refer to the full name in validation rule script, use fullName.
o Validation rules are backward compatible with regard to this feature, meaning a
validation rule written prior to 5.4, will behave the same in 5.4.

Actions

l Administrators can enable or disable identical asset names per domain for an asset
type.

Note If identical asset names per domain has been enabled for an asset type
and there are multiple assets in the domain with identical names, the feature
can still be disabled. Collibra will simply show the full name of such assets,
throughout the UI.

l You can edit the asset name and full name.
l You can add the Full name field to a table or tile.

Create assets
In Collibra Data Intelligence Cloud, domain types are assigned to asset types. You can
add an asset to only that domain whose domain type is assigned to the asset type of the
asset.

Requirements and permissions

Note The requirements and permissions for creating an asset depends on the
values that you select in the Domain and Type fields when creating the asset.

l You have the Asset > Add resource permission for the domain that you select when
creating the asset.
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Tip This permission is granted through a resource role that is assigned to you
either on the domain or on the community to which the domain belongs (via
inheritance). For more information, go to Responsibilities.

l You have a global role that has the relevant global permission for the type of asset
that you are creating. For example, if you want to create a Business Term asset, you
must have a global role that has the Business Semantics Glossary global per-
mission. Similarly, if you want to create a Policy asset, you must have a global role
that has the Policy Manager global permission.

Tip To view the global permissions for all packaged (out-of-the-box) asset
types, go to Overview of packaged asset types.

Steps

1. Open the product for which you want to create an asset (for example, Business
Glossary).

2. On the main toolbar, click .

» The Create dialog box appears.
3. On the Assets tab, click an asset type from the list.

» The Create Asset dialog box appears.
4. Enter the required information.

Field Description

Type The asset type of the asset that you are creating.

Domain The domain to which the asset will belong.

Tip Ensure that the domain type of the selected domain is assigned to
the selected asset type.
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Field Description

Name A name to identify the asset.

Tip
You can simultaneously create multiple assets.
To do so, after typing the name, press Enter, and then type the next
name. Depending on the settings, asset names may need to be unique in
their domain. If you enter a name that already exists, it appears in the
strike-through style.

5. Click Create.
» A message stating that one or more assets are created appears in the upper-right
corner of the page.

Asset page overview
The asset page provides an overview of information related to an asset, based on its asset
type's assignment. The assignment determines which and how many elements are by
default added to the asset page.
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Number Section Description

Breadcrumbs The breadcrumbs of the current asset.

Asset type
representation

The icon or abbreviation of the asset type.

Tip You can edit how an asset type is represented.

Asset name The name of the asset.

Resource toolbar Additional actions, such as editing the asset and starting a
workflow.
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Number Section Description

Articulation score The articulation score of the asset.

Note If there are no articulation score rules assigned to the
asset, the asset page does not show an articulation score.

Asset validation The validation result of the validation rules assigned to the
asset.

Stewards The stewards of the asset.

You can see up to three stewards on the asset page. If there are
more, click See all <number> to see them on the Responsibilities
page.

Tab pane A collapsible pane that allows you to navigate to other pages
of the asset and add characteristics as specified in the
assignment.

Editor The currently selected page, in this case the Overview page, which
contains all the attributes, relations and complex relations that have
been defined for the asset and whose type was added to the
relevant assignment.

If a certain attribute type has been assigned as mandatory for this
asset type, this attribute is shown in the asset's Overview tab, even
if no attribute value has been defined yet.

Tip If you want to copy and paste text from other sources

into a text field, we recommend that you click , and then
paste the text into the Show source code field. This will
remove any unwanted formatting or tagging of the text. For
detailed information, see the knowledge base article on
Collibra Support Portal.
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Number Section Description

Attribute An attribute is a characteristic of an asset containing information
about the asset. This information can be in various formats,
depending on the attribute kind:

l True/False: A binary choice.
l Date: The format of the date depends on the user's locale
settings.

l Multiple selection: One or more values from a predefined
list.

l Number: If this is a fraction, the decimal separator shown
in the UI is decided by the user's locale settings, usually a
comma or a dot.

l Selection: One value from of a predefined list.
l Text: which may also include images and hyperlinks.

Note If a text attribute does not have any value, it shows
the message No value has been given yet. If a text
attribute has an empty value, it shows a message Empty
value.
Text attributes can have up to 100.000 bytes.

Relation Relations of the same type are shown in a list. You can show the list
in different display modes:

l Table: You can also choose the columns, or sort and filter
their content.

l Tiles: You can choose which fields to display and determ-
ine how many tiles to display.
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Number Section Description

Complex relation Complex relations of the same type can be shown in different ways:

l Table: You can show related assets in a table. This is the
default way. You can edit this table in the same way you
can any other table.

l Diagram: You can show complex relations as a diagram
to visualize the underlying relations. You can scroll
through the diagram and move nodes, but you cannot edit
the diagram as extensively as you can via the diagram
view.
Example

Relation views

The asset page provides an overview of information related to an asset, based on its asset
type's assignment. This includes the relations and complex relations.

Warning You only see complex relations if you have permission to view all assets
of the complex relation.

Display modes

All relations and complex relations of the same type are displayed in a separate section
with the relation type as section title. Each section can be shown in different display
modes:

l Table: By default, related assets are shown in a table. You can edit this table in the
same way you can any other table.
Example
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l Tiles: You can show the related assets as a set of tiles. You can edit this set of tiles in
the same way you can any other set of tiles.
Example

l Diagram: You can show complex relations as a diagram to visualize the underlying
relations. You can scroll through the diagram and move nodes, but you cannot edit
the diagram as extensively as you can via the diagram view.
Example

Saving and sharing the layout of relation views

For each relation type and complex relation type, there is a default layout of the relation
view. Similar to regular views, you can change most elements of the layout:
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l The fields.
l The display mode: table or tiles.
l The sorting and sort direction.
l The tiles or rows per page.
l If the assets are shown in table display mode, the width of each column.

If you make changes, Collibra automatically saves the layout.

If you have the Manage shared Views, Dashboard and Search Filter global permission,
you can also override the layout of this relation type or complex relation type for all users
by clicking → Save for all users. The previous layout of other users is lost. However, all

users can still make fresh changes.

Print an asset page or save as a PDF file

You can print an asset page or save it as a PDF file to share information about an asset
outside of Collibra Data Intelligence Cloud, for example for audit, reporting or security
purposes.

Note
Not all information is printed:

l Relations are represented by a simple list, with the relation type as the header.
Only the names of the related assets are printed in the list. The other fields of
the related assets, for example their domains and asset types, are not printed.
Additionally, only the related assets of the first page of the relation table are
printed. The other related assets are not printed.

l Complex relations are not printed.
l Comments are not printed.
l Attachments are not printed.
l Attributes that were never given a value (except for tags) are not printed.

Steps

1. Open an asset page.
2. In the resource toolbar, click .

» The print preview and the Print dialog box appear.
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3. If required, change the print settings, such as the printer or paper size.
4. Depending on your browser and print settings, click Save or Print.

Edit an asset
You can edit an asset to suit your needs.

Steps

1. Open an asset page.
2. Perform one of the following steps:

a. In the resource toolbar, click Edit.
a. In the resource toolbar, click Actions > Edit.

» The Edit <asset name> dialog box appears.
3. Enter the required information.

Field Description

Name The name of the asset.

If identical asset names per domain is disabled for this asset type, the name of an
asset must be unique in its domain. If it is disabled and you type an existing
name, an error message will appear below this field.

Full name The full name of the asset. The full name of an asset must always be unique in its
domain.

This field is only available if identical asset names per domain is enabled for this
asset type.

Warning Do not edit the full name of assets needed to synchronize or
refresh data sources. This may cause unexpected results and break the
synchronization or refresh process.

Type The asset type.

Status The status of the asset.

4. Click Save.
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Edit the name of an asset
You can edit the name of an asset in different ways:

l From the asset page.
l By editing the name cell in an asset view.

Tip If Identical asset names per domain is enabled for the relevant asset type, you
can also edit the asset's full name.

Edit the name of an asset from the asset page

1. Open an asset page.
2. In the resource toolbar, click Edit.

» The Edit <asset name> dialog box appears.
3. Enter the required information.

Field Description

Name The name of the asset.

If identical asset names per domain is disabled for this asset type, the name of an
asset must be unique in its domain. If it is disabled and you type an existing
name, an error message will appear below this field.

Full name The full name of the asset. The full name of an asset must always be unique in its
domain.

This field is only available if identical asset names per domain is enabled for this
asset type.

Warning Do not edit the full name of assets needed to synchronize or
refresh data sources. This may cause unexpected results and break the
synchronization or refresh process.

4. Click Save.
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Identical asset names per domain
‘Identical asset names per domain’ is a feature that allows you to specify a regular name
and a unique full name for an asset. If ‘identical asset names per domain’ is enabled for an
asset type, then multiple assets of that asset type can have an identical name in a domain.

Note All assets must have a unique full name per domain, regardless of whether or
not ‘identical asset names per domain’ is enabled.

Technically, all assets have two names:

l A name: the regular name that is used by default in most places in the UI, such as
the asset page title bar, preview panes, diagrams, search results, automatic hyper-
links and relation tables.

l A full name: the fully qualified name that must be unique within a domain. It is mainly
used for technical operations (through the API) and when you edit an asset whose
asset type allows identical names per domain.

By default, the name of an asset is the same as its full name. Collibra Data Intelligence
Cloud automatically synchronizes them, so users don't notice the difference. However, for
some asset types, it may be beneficial to allow users to edit the name and full name
independently of one another, and have multiple assets with an identical name in one
domain. This has the following benefits:

l You can use a shorter or simpler name for an asset that has a long or complex full
name. This is particularly useful in Collibra Data Catalog.

l You can use the same name for multiple assets in one domain. Keep in mind that the
full name still has to be unique for each asset in a domain.

Affected features

l The API is backward-compatible with regard to this feature, meaning the behavior of
the API is not affected by whether or not ‘identical names per domain’ is enabled.

l Drop-down fields
o In asset drop-down fields, you can search for an asset based on the name or
the full name.
This also includes the drop-down menus to:
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n Add manual hyperlinks to an asset in a text attribute.
n Add (complex) relations on an asset page and in assets table.
n Filter relations on an asset table.
n Add data to a data set.

l Tables
o The Name column contains the name. This column cannot be removed
because it is used by hierarchy.

o The Full name column is a regular column that is optional.
o The relation columns contain asset names.
o You can use both the name and full name as:

n An advanced filter.
n A sort option.
n A column filter.

o The preview pane shows the asset's name.
o Editing cells:

n If the asset type allows identical asset names per domain, you can edit
both the name and full name of an asset, independently of one another.

n If the asset type does not allow identical asset names per domain, editing
either the name or full name changes both values.

n Bulk editing the Name and Full name column is not possible.
l Tiles

o The name is used in tile header.
o Full name is a regular field. It can be moved, hidden and you can edit field
name.

o Name and full name are both available as a sort option.
l Diagrams

o The default node name is the asset name. You can also use the full name (or
any other property) as node name.

o You can use Name and Full Name as a node overlay.
o The preview shows the name of an asset.

l Export
o The name is always exported to the Name column.
o If you select Add the characteristics needed for reimport:

n The full name is always exported (to uniquely identify each asset during
re-import).
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n Relations are exported based on the full name: relation name [role/co-
role asset type] → Full Name.

o If you do not select Add the characteristics needed for reimport:
n If the Full name column is added to the view, it is exported to the Full
name column.

n Relations are exported based on the name: relation name [role/co-role
asset type] → Name.

l Import
o Full name has to be mapped, unless you map the ‘ID’ column (only available in
special view ‘All Characteristics').

o Full name will auto-map to the Full name column.
o When you import a file that was exported pre-5.4, you have to manually map
the Full name column of the view to the Name column of the import file.

o Name will auto-map to the Name column.
o Name does not have to be mapped.
o Complex relations:

n Relation asset full name auto-maps to relation name [role/co-role asset
type] → Full Name.

n When you import a file that was exported pre-5.4, you have to manually
map the Full name column of the view to the relation name [role/co-role
asset type] → co-role/role asset type column of the import file.

n Relation asset display name should not be mapped.
l Search

o Basic search: searches for assets by name.
o Advanced search: searches for assets by name, when name is in the search cri-
teria.

o Currently, you can not define a search filter for the ‘full name’ field.
o In the search results, the Name column shows the asset name.
o The preview shows the asset name.

l Validation rules
o To refer to the name in your validation rule scripts, use displayName.
o To refer to the full name in validation rule script, use fullName.
o Validation rules are backward compatible with regard to this feature, meaning a
validation rule written prior to 5.4, will behave the same in 5.4.
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Actions

l Administrators can enable or disable identical asset names per domain for an asset
type.

Note If identical asset names per domain has been enabled for an asset type
and there are multiple assets in the domain with identical names, the feature
can still be disabled. Collibra will simply show the full name of such assets,
throughout the UI.

l You can edit the asset name and full name.
l You can add the Full name field to a table or tile.

Move an asset to another domain
You can move a single asset to a different domain.

Note If an asset is moved to a domain in another scope, its assignment of its assets
may change.

Prerequisites

l You have a resource role with the Asset > Remove resource permission for the asset
you want to move.

l You have a resource role with the Asset > Add resource permission for the domain to
which you want to move the asset.

Move a single asset from the asset page

1. Open an asset page.
2. Perform one of the following steps:

a. In the resource toolbar, click Move.
» If you cannot see the Move button then click More →Move.

b. In the resource toolbar, click Actions > Move.
» The Move <asset name> dialog box appears.
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3. In the Move dialog box, click the new domain.
4. Click Save.

Move multiple assets from a domain page

1. Open a domain page.
2. In the tab pane, click Assets.
3. Select the assets you want to move.
4. In the action toolbar, click Move.
5. In the Move selected assets dialog box, select the new domain.
6. Click Save.

Move multiple assets from the global view

1. Open the global view.
2. Select the check boxes in front of the assets you want to move.
3. In the action toolbar, click Move.
4. In the Move selected assets dialog box, click the new domain.
5. Click Save.

Delete an asset
This section describes how to delete an asset in table display mode and tile display mode.

Tip You can also delete multiple assets at once.

Warning Deletion is permanent, you cannot undo it. If you delete a configuration
asset of a data source, you also delete its configuration. Register your data source
again to create a new configuration asset or contact support for more information.
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Via an asset page

1. Open an asset page.
2. Perform one of the following steps:

o In the resource toolbar, click More > Delete.
o In the resource toolbar, click Actions > Delete.

3. Click Delete..

Delete an asset from a view

In table display mode

1. Open a view in table display mode.
2. If necessary, filter using a table filter or a column filter to easily find the asset.
3. Select the check box in front of the asset you want to delete.
4. In the action toolbar, click Delete.

» The Delete assets dialog box appears.
5. Click Delete.

In tile display mode

1. Open a view in tile display mode.
2. If necessary, filter using a tile filter or a field filter to easily find the asset.
3. Select the tile you want to delete.
4. In the action toolbar, click Delete.

» The Delete assets dialog box appears.
5. Click Delete..

Delete multiple assets
This section describes how to delete multiple assets at once, in table display mode and tile
display mode.

Note Deletion is permanent, you cannot undo it.
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Delete multiple assets in table display mode

1. Open a table.
2. If necessary, filter the table using a table filter or a column filter.
3. Select the check boxes in front of the assets you want to delete.

Tip You can select all the visible assets at once by clicking the check box
next to the Name column header.

4. In the action toolbar, click Delete.
» The Delete assets dialog box appears.

5. Click Delete.

Delete multiple assets in tile display mode

1. Open a set of tiles.
2. If necessary, filter the tiles using a tile filter or a field filter.
3. Select the tiles you want to delete.
4. In the action toolbar, click Delete.

» The Delete assets dialog box appears.
5. Click Delete.

Characteristics
Characteristics is a generic term for attributes, relations and complex relations.

Add characteristics to an asset
You can add a characteristic to an asset to add additional information about it.

Prerequisite

You have assigned the characteristic type to the relevant assignment of the asset's type.
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Steps

1. Open an asset page.
2. In the tab pane, click Add Characteristic.

» The Add a characteristic dialog box appears.

3. In the Add a Characteristic dialog box, do one of the following:

If ... then ...

You want to add an attribute: Click Attributes.

You want to add a relation: Click Relations.

You want to filter the char-
acteristics:

a. Click All.
b. Click in the Search field.
c. Start typing the name of the characteristic that you

want to add.

Note If the characteristic type is not in the list, it is not in the asset type's
assignment.

4. Enter the required information.

Note The required information depends on the characteristic that you are
adding.

5. Click Save.
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Edit asset characteristics
You can edit characteristics of an asset. The procedure you should follow depends on the
type of characteristic you want to edit.

If ... then ...

you want to edit an attribute: 1. Open an asset page.
2. Double-click the attribute or click .
3. Edit the attribute.
4. Click Save.

you want to edit a relation: 1. Delete the existing relation.
2. Create a new relation.

you want to edit a complex relation: 1. Open an asset page.
2. Go to the complex relation you want to edit.
3. Click to change one of more relations.

» The Edit Complex Relation dialog box is shown.
4. Edit the content of the complex relation, to meet your

needs.

Note On the right, the minimum and maximum
amount of items that are required are shown.

5. Click Next and then Finish.

Note If the characteristic type is not in the list, it is not in the asset type's assignment.

Remove asset characteristics
You can remove an asset characteristic as long as the minimum number of occurrences in
the assignment has not been reached.

1. Open an asset page.
2. At the end of the line, click .

» A dialog box appears.
3. Click Delete.
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Note These steps can be used to remove attributes, relations or complex relations

Attributes
An attribute is a characteristic that describes an asset by means of an individual field. The
attribute's kind defines the class of information that the attribute contains.You can add an
attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.

About attributes

An attribute is a characteristic that describes an asset by means of an individual field. The
attribute's kind defines the class of information that the attribute contains.You can add an
attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.

Examples of attributes

The following table contains attribute types and a description of the attribute that can be
added to an asset.

Attribute type Description of the attribute Example of an attribute

Definition The description with background
information on the asset

Asset: Customer Definition: A
person, company or
organization that purchases a
commodity or service.

Last Review Date The date on which the asset was
reviewed.

02/05/2020

Frequency The rate at which an asset changes over a
particular period of time.

Daily

Rows Failed The number of rows that failed a rule. 15

Personally Identifiable
Information

A boolean field to indicate whether an
asset contains personally identifiable
information.

True

Chapter 3

132



Chapter 3

Note An attribute can contain up to 100.000 bytes, which corresponds to roughly
up to 100 000 characters in the source code of the attribute.

Add an attribute

You can add attributes to an asset to describe that asset.

Prerequisites

The attribute's type is in the relevant assignment of the asset's type.

Tip If the minimum cardinality of the relevant attribute type is greater than 0, or if an
attribute of that type already exists, the asset page always contains an attribute field
for the attribute type.

Add an attribute from an asset page

1. Open an asset page.
2. In the tab pane, click Add Characteristic.

» The Add a characteristic dialog box appears.
3. In the Add a Characteristic dialog box, click the Attributes tab.

» The Add <attribute type> dialog box appears.
4. Enter the value of the attribute.

Example If you want to add a Description attribute, enter the description that
you want to add to the asset.

5. Click Save.

Add an attribute from a table

1. Open a view in the table display mode.
2. If required, add the column of the attribute type to the table:

a. Above the table, to the right, click → Fields.

b. Click Select fields → Attributes.
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c. Select the relevant attribute types.
d. Click Update.
e. Click Save.

3. Perform one of the following steps:
o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
4. Enter the required information.
5. Perform one of the following steps:

If you want to
change...

do...

the current row
only:

a. Click .

all visible rows: a. Click Apply to all visible rows.
b. Click .

selected rows: a. Select one or more rows.
b. Click Apply to all selected rows.
c. Click .

Edit an attribute

You can edit the value of an attribute.

Example You can edit the definition of an asset.

If you delete an attribute value from an attribute type of the Selection or Multiple Selection
kind, then you can no longer edit the values of the attributes of that type without removing
those invalid values. We recommend that you remove invalid attribute values from the
attributes before removing them from the attribute type.
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Edit an attribute from the asset page

1. Open an asset page.
2. Double-click the attribute or click .

3. Edit the attribute.
4. Click Save.

Edit an attribute from a table

1. Open a view in the table display mode.
2. If required, add the column of the attribute type to the table:

a. Above the table, to the right, click → Fields.

b. Click Select fields → Attributes.
c. Select the relevant attribute types.
d. Click Update.
e. Click Save.

3. Perform one of the following steps:
o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
4. Enter the required information.
5. Perform one of the following steps:

If you want to
change...

do...

the current row
only:

a. Click .

all visible rows: a. Click Apply to all visible rows.
b. Click .

selected rows: a. Select one or more rows.
b. Click Apply to all selected rows.
c. Click .
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Delete an attribute

You can delete attributes as long as the minimum number of occurrences has not been
reached.

If you delete an attribute value from an attribute type of the Selection or Multiple Selection
kind, then you can no longer edit the values of the attributes of that type without removing
those invalid values. We recommend that you remove invalid attribute values from the
attributes before removing them from the attribute type.

Delete an attribute from an asset page

1. Open an asset page.
2. At the end of the line, click .

» A dialog box appears.
3. Click Delete.

Delete an attribute from a table

1. Open a view in the table display mode.
2. If you don't see the column of the attribute type, add it to the table:

a. Above the table, to the right, click → Fields.

b. Click Select fields → Attributes.
c. Select the relevant attributes.
d. Click Update.
e. Click Save.

3. Click next to the attribute that you want to delete.

» The Delete <attribute> dialog box appears.
4. Click Yes.

» The attribute field is now empty.

Relations
A relation is a characteristic that describes how two assets relate to each other. The
relation's type defines the relation and determines which assets can be related.
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About relations

A relation is a characteristic that describes how two assets relate to each other. The
relation's type defines the relation and determines which assets can be related.

You can add a relation between assets if the relation's type is in the relevant assignment of
the asset's type.

Add a relation

You can add a relation to link two assets.

Prerequisites

The relation's type is in the relevant assignment of the asset's type.

Tip If the minimum cardinality of the relevant relation type is greater than 0, or if a
relation of that type already exists, the asset page always contains a relation table
for the relation type.

Add a relation from the asset page

1. Open an asset page.
2. In the tab pane, click Add Characteristic.

» The Add a characteristic dialog box appears.
3. Click Relations.
4. Search for and click <the relation type that you want to create>.

» The Add relation type <asset type> dialog box appears.
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5. Enter the required information.

Option Description

Assets The name of the related asset.

Filter suggested
assets by
organization

Option to filter the suggestions based on selected communities and domains.

If this option is selected, the organization tree appears. You can then filter and
select domains and communities.

Start date Optionally enter the date on which the relation between the assets
becomes applicable.

End date Optionally enter the date on which the relation between the assets is no
longer applicable. Leave this field empty to create a permanent relation.

6. Click Save.

Add relations from a table

1. Open a view in the table display mode.
2. If you don't see the column of the relation type, add it to the table:

a. Above the table, to the right, click → Fields.

b. Click Select fields → Relations.
c. Select the relevant relation types.
d. Click Update.
e. Click Save.

3. Perform one of the following steps:
o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
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4. Enter one or more assets.
5. Perform one of the following steps:

If you want to
change...

do...

the current row
only:

a. Click .

all visible rows: a. Click Apply to all visible rows.
b. Click .

selected rows: a. Select one or more rows.
b. Click Apply to all selected rows.
c. Click .

Edit a relation

You cannot edit a relation, but you can delete the existing relation and create a new one.

Edit a relation from an asset page

1. Delete the existing relation.
a. Open an asset page.
b. At the end of the line, click .

» A dialog box appears.
c. Click Delete.

2. Add a new relation.
1. Open an asset page.
2. In the tab pane, click Add Characteristic.

» The Add a characteristic dialog box appears.
3. Click Relations.
4. Search for and click <the relation type that you want to create>.

» The Add relation type <asset type> dialog box appears.
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5. Enter the required information.

Option Description

Assets The name of the related asset.

Filter suggested
assets by
organization

Option to filter the suggestions based on selected communities and
domains.

If this option is selected, the organization tree appears. You can then filter
and select domains and communities.

Start date Optionally enter the date on which the relation between the assets
becomes applicable.

End date Optionally enter the date on which the relation between the assets is
no longer applicable. Leave this field empty to create a permanent
relation.

6. Click Save.

Edit a relation from a table

1. Open a view in the table display mode.
2. If required, add the column of the relation type to the table:

a. Above the table, to the right, click → Fields.

b. Click Select fields → Relations.
c. Select the relevant relation types.
d. Click Update.
e. Click Save.

3. Perform one of the following steps:
o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
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4. Remove or add one or more assets.
5. Perform one of the following steps:

If you want to
change...

do...

the current row
only:

a. Click .

all visible rows: a. Click Apply to all visible rows.
b. Click .

selected rows: a. Select one or more rows.
b. Click Apply to all selected rows.
c. Click .

Delete a relation

You can delete relations between two assets as long as the minimum number of
occurrences in the assignment has not been reached.

Delete a relation from an asset page

1. Open an asset page.
2. At the end of the line, click .

» A dialog box appears.
3. Click Delete.

Note If view your relation in tile display mode, the is in the upper-right corner.

Delete a relation from a table

1. Open a view in the table display mode.
2. If you don't see the column of the relation type, add it to the table:

a. On the content toolbar, click → Edit Fields.

» The Fields dialog box appears.
b. Click Select fields → Relations.
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c. Select the relevant relation types.
d. Click Update.
e. Click Save.

3. Perform one of the following steps:
o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
4. Remove one or more assets from the cell.
5. Perform one of the following steps:

If you want to
change...

do...

the current row
only:

a. Click .

all visible rows: a. Click Apply to all visible rows.
b. Click .

selected rows: a. Select one or more rows.
b. Click Apply to all selected rows.
c. Click .

Complex relations
A complex relation is a characteristic that describes how two or more assets relate to each
other. It can also have attributes of its own, for example, Description and Priority.
Technically, they are objectified associations: simplified assets that cannot exist
independently. The complex relation's type defines the relations and attributes the
complex relation can have.

About complex relations

A complex relation is a characteristic that describes how two or more assets relate to each
other. It can also have attributes of its own, for example, Description and Priority.
Technically, they are objectified associations: simplified assets that cannot exist
independently. The complex relation's type defines the relations and attributes the
complex relation can have.
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You can add a complex relation between assets if the complex relation's type is in the
relevant assignment of the asset's type.

Note A complex relation cannot have more than 32,767 relations to assets.

Example

When you add a complex relation, you add one or more relations between the assets and
the complex relation itself. The assets of those relations are always the head of the
relation, while the complex relation is always the tail.

The following example creates a complex relation type called Code Mapping, with
three relation types (source, target and crosswalk) and two attribute types (Description and
Transformation Logic).
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For each relation type in the complex relation type, you can select head assets. Above the
fields, you can see the minimum and maximum occurrences for each relation type. For
each selected head asset, a relation of the relevant type is created between the head
asset and the complex relation. You can also add attributes to the complex relation.

Add a complex relation to an asset

You can add a complex relation to an asset, to create a link between two or more assets
and add attributes.

Tip If you want to add many complex relations, you can also import them.

Prerequisites

The complex relation's type is in the relevant assignment of the asset's type.

Tip If the minimum cardinality of the relevant complex relation type is greater than
0, or if a complex relation of that type already exists, the asset page always contains
a complex relation table for the complex relation type.
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Steps

1. Open an asset page.
2. In the tab pane, click Add Characteristic.

» The Add a characteristic dialog box appears.
3. In the Add a Characteristic dialog box, click the Relations tab.
4. Select a relation of the type Complex Relation, for example, Field Mapping Target.

» The Add <complex relation type> dialog box appears.
5. Enter the required information.

The available fields depend on the configuration of the complex relation type.
See an example.1

Tip The minimum and maximum amount of assets that you can add is
displayed in the right upper corner of every relation field. If there is no
maximum amount, the maximum amount of assets to add in the relation was
not set.

6. Click Finish.

Edit a complex relation

You can edit a complex relation, for example if you want to edit its legs or attributes.

Steps

1. Open an asset page.
2. Find the complex relation you want to edit.

1
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3. Click to change one of more relations or attributes.

» The Edit Complex Relation dialog box appears.
4. Enter the required information.

The required fields depend on the configuration of the complex relation type.
5. Click Save.

Delete a complex relation

You can delete a complex relation between two or more assets as long as the minimum
number of occurrences in the assignment has not been reached.

Steps

1. Open an asset page.
2. At the end of the line, click .

» A dialog box appears.
3. Click Delete.

» The complex relation is deleted.

Hyperlinking
In Collibra Data Intelligence Cloud, you can manually create hyperlinks in text attributes or
enable automatic hyperlinking to easily navigate from asset to asset or from an asset to a
website.

Automatic hyperlinking
In Collibra, every asset is a potential "target" of a hyperlink. If the name of an asset is
mentioned somewhere in a text attribute of another asset, that mention automatically gets
a hyperlink to the corresponding asset. Collibra keeps all hyperlinks up to date when you
edit your data.

You can enable or disable automatic hyperlinking at the different levels:
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l Environment: Contact Collibra support if you want to enable or disable automatic
hyperlinking in your entire environment.

l Domain: If automatic hyperlinking is enabled in Collibra Console, you can enable or
disable it on the domain level. Because every asset is a possible target, automatic
hyperlinking can lead to an excessive amount of hyperlinks, which can negatively
affect performance. Therefore, by default, automatic hyperlinking is disabled for all
domains. However, you can enable it.

l Individual assets: An asset may have a common word as its name, for example, "is",
"a", "or" or "and". When that happens, you don't want hyperlinks to this asset
because it would lead to a lot of useless hyperlinks. Therefore, you can exclude such
assets from automatic hyperlinking.

Note If there are assets with identical names, they are all shown in a pop-up when
you click the link. Then, you can click one to open its asset page.

After importing data or after a backup has been restored, Collibra triggers a rebuild of the
automatic hyperlinks. You can also rebuild the hyperlinks manually.

Tip By default, automatic hyperlinking is not case sensitive. For example, an asset
'Nato' will also be hyperlinked if it is mentioned as 'NATO', and vice versa.
Contact Collibra support to change case-sensitivity for automatic hyperlinking.

Manual hyperlinking
You can use manual hyperlink if you want a hyperlink to or from a specific asset. This is
particularly useful if automatic hyperlinking is disabled, or if the link text does not match the
name of the target asset.

Tip You can also manually create hyperlinks to web addresses.

147

https://support.collibra.com/
https://support.collibra.com/


Disable automatic hyperlinking to a specific asset
You can disable automatic hyperlinking at domain level and asset level.

Contact Collibra support if you want to enable or disable automatic hyperlinking for your
entire environment.

An asset may have a common word as its name, for example, "is", "a", "or" or "and". When
that happens, you don't want hyperlinks to this asset because it would lead to a lot of
useless hyperlinks.

You can still manually create hyperlinks that target the asset.

Steps

1. Open an asset page.
2. In the toolbar, click, Auto hyperlinks.

» The Auto hyperlinks dialog box appears.
3. Enter the required information.

Field Description

No Automatic
Hyperlink

Collibra Data Intelligence Cloud will not create automatic hyperlinks to this asset.

4. Click to close the dialog box.

What's next?

All automatic hyperlinks to the asset are removed and Collibra Data Intelligence Cloud no
longer creates automatic hyperlinks to the asset.

If you enable automatic hyperlinking to the specific asset again, you have to rebuild the
hyperlinks.

Enable automatic hyperlinking in a domain
Automatic hyperlinking is especially useful for linking to Business Term assets. But as
every asset is a possible target, automatic hyperlinking can lead to an excessive amount
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of hyperlinks, which can negatively affect performance. Therefore, by default, automatic
hyperlinking is disabled for all domains.

Nevertheless, you can enable automatic hyperlinking at the domain level.

Tip You can use the Manage auto hyperlinks workflow to enable or disable
automatic hyperlinking in bulk.

Prerequisites

Automatic hyperlinking is enabled. Contact Collibra support if this is not the case.

Steps

1. Go to the domain page of the domain for which you want to enable automatic hyper-
linking.

2. In the resource toolbar, click Actions → Auto hyperlinks.
» The Auto hyperlinks dialog box appears.

3. Enter the required information.

Field Description

No Automatic
Hyperlink

Collibra will not create automatic hyperlinks to assets in this domain when its
name occurs in a text attribute of another asset. You can use this option when the
asset name is a common word like ‘and’, ‘or’, ‘it', etc. You can still create manual
hyperlinks to this asset.

Once you make a change the dialogue box closes automatically.

What's next?

Rebuild the hyperlinks to automatically create the hyperlinks to all the assets in the
domain.
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Delete an automatic hyperlink
Collibra Data Intelligence Cloud can automatically create hyperlinks to assets. However,
you can delete some or all of the hyperlinks without touching other potential automatic
hyperlinks to the destination asset.

Steps

1. Open an asset page.
2. Click in the text field with an automatic hyperlink.

3. Select the text.
4. In the Edit toolbar, click (Remove autohyperlink).

» The hyperlink is removed.
5. Click Save, to save the content of the text field.

What's next?

The automatic hyperlink is removed, but if you edit the text field again and you add the
same text, the automatic hyperlink will again be created. If the hyperlinks are rebuilt, for
example after restoring a backup, the hyperlinks may reappear.

Tip To prevent an automatic hyperlink to a specific asset, you have to disable
automatic hyperlinking for the target asset or the domain of the target asset.

Create a hyperlink to an asset
You can manually create hyperlinks to assets.

Tip Collibra Data Intelligence Cloud can also create hyperlinks automatically.

Steps

1. Open an asset page.
2. Double-click a text attribute, for example the definition, to edit the text.
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3. Select the text to transform into a hyperlink.
4. On the Edit toolbar, click (Insert/edit link) → Link to asset.

5. In the Assets field, start typing the name of the asset to which you want to link.
The assets are filtered as you type.

Tip To help you identify the correct asset, the domain of each asset is shown
below the asset name.

6. Click the asset to which you want to link.

Note You can link to multiple assets, in which case, all links are shown when
you click the link. You can then select which one to follow.

7. Click Save, to save the hyperlink.
8. Click Save, to save the content of the text field.

Create a hyperlink to a web address
In addition to creating hyperlinks to other assets in your environment, you can also create
hyperlinks to web addresses. When you click the hyperlink, it will automatically open in a
new tab.

Steps

1. Open an asset page.
2. Double-click a text attribute or click to edit the text.

3. Select the text to transform into a hyperlink.
4. On the Edit toolbar, click (Insert/edit link) → Link to URL.
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5. Enter the required information.

Setting Description

URL The target website of the hyperlink.

If you don't start the URL with http:// or https://, the system will ask if it has to add
http://. If you don't add either prefix, Collibra Data Intelligence Cloud will consider
the URL content an asset.

Note You will only see this field if the hyperlink you edit is a link to a
URL.

Text to display The display text that will be visible in the attribute. By default, this is the
text that you selected.

6. Click Save, to save the hyperlink.
7. Optionally, edit the source code so that the hyperlink automatically opens in a new

tab when you click it.
a. Click Source code ( ).

b. Type target ="_blank" after the href attribute.

Example Click <a xml="lang"
href="https://productresources.collibra.com/" target="_
blank">here</a> for more information.

c. Click Save.
8. Click Save.

Edit a manually created hyperlink
After you have created a hyperlink, you can always edit it afterwards.

Note Automatic hyperlinks cannot be edited.
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Steps

1. Open an asset page.
2. Double-click a text attribute or click in the text field that contains the hyperlink that

you want to edit.
3. Click anywhere on the hyperlinked text and click Edit.
4. Update the link:

a. Enter the required information.

Field Description

URL The target website of the hyperlink.

If you don't start the URL with http:// or https://, the system will ask if it has to add
http://. If you don't add either prefix, Collibra Data Intelligence Cloud will consider
the URL content an asset.

Note You will only see this field if the hyperlink you edit is a link to a URL.

Assets The target assets of the hyperlink.

The assets are filtered as you type. Click the asset to which you want to link.

Note You will only see this field if the hyperlink edit is a link to an asset.

Text to
display

The display text that will be visible in the attribute. By default, this is the
text that you selected.

b. Click Save.
5. Click Save.

Remove a manually created hyperlink
You can remove manually created hyperlinks in text attributes.

Steps

1. Open an asset page.
2. Click in the text field that contains the hyperlink that you want to remove.
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3. Click anywhere on the hyperlinked text and click Unlink.
» The hyperlink is removed. If the hyperlink pointed to many assets, all links are
removed.

4. Click Save, to save the content of the text field.

Ratings
Ratings enable users to subjectively rate the quality of an asset, using a five-star rating
system, and write a free-text review of the asset, in support of the rating provided.

Unlike objective parameters such as data quality, certifications and articulation scores,
ratings are purely subjective assessments of data quality.

Enabling ratings
Ratings are enabled by asset type. When ratings are enabled for a particular asset type,
users can rate any asset of that asset type.

Permissions
No particular license is needed to rate assets or to edit or delete ratings; however, certain
resource permissions are needed.

Permission With this resource permission, you can...

Rating > Add l Rate any asset of an asset type for which the feature is enabled.
l Edit or delete your own ratings.

Rating > Modify l Edit other users' ratings.

Rating > Remove l Delete other users' ratings.
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Note
l Users are not granted permissions directly, but through global roles and
responsibilities.

l Guest users can see all ratings and reviews, but cannot provide ratings or
reviews of their own.

l Adding, editing and removing ratings doesn't change assets, so their last
modified date will not be updated.

Actions
l View ratings.
l Enable or disable ratings.
l Rate an asset.
l Edit a ratings.
l Delete a rating.
l Delete all ratings of assets of a specific type.

Enable or disable ratings
You can enable and disable ratings via the asset type pages, in Settings.

Enabling ratings for a particular asset type is not inherited by children asset types. The
feature has to be manually enabled for each child asset type.

By default, ratings are enabled for asset types Data Set and Report and their children
asset types. Ratings are disabled, by default, for all other packaged asset types and any
asset types you create.

Warning Ratings cannot be disabled for a specific asset type if user ratings exist for
any assets of that asset type. In other words, all user ratings for all assets of a
specific asset type must be manually deleted before ratings can be disabled for that
asset type.

Prerequisites

You have a global role that has the System administration global permission.
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Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the upper-right corner, click Edit.

» The Edit <asset type> dialog box appears.
3. Enter the required information.

Field Description

Enable ratings Select to allow users to rate assets.

Ratings enable users to subjectively rate the quality of an asset, using a five-star
rating system, and write a free-text review of the asset, in support of the rating
provided.

4. Click Save.

View ratings
If ratings are enabled for an asset type and one or more ratings has been provided for an
asset of that type, the associated ratings activity appears in several places in the UI.

On an asset page

Ratings information appears on the asset page of any asset with one or more ratings.
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No. Description

1 The average of all user ratings for that asset.

2 The total number of ratings.

3 A horizontal bar chart showing the distribution of ratings.

4 The percentage of total votes per number of stars.

5 Your rating and review.

6 Other users' ratings and reviews, ordered from newest to oldest.

In the History tab

User ratings and any edits to, or deletions of, ratings are shown in the History tab page of
the relevant:

l Asset pages.
l User profiles.
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l Community pages.
l Domain pages.

In an asset table or set of tiles

There are two fields related to ratings that can be shown in an asset table or set of tiles:

l Average rating: The average of all user ratings for each asset.
l Number of ratings: The total number of ratings for each asset.

You can sort on these two fields and filter them.

Rate an asset
You can rate any asset of an asset type for which ratings have been enabled.

Ratings can only be given via asset pages.

You can edit or delete your ratings at any time.
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Steps

1. Open an asset page.
2. In the My rating section, click the star that corresponds most closely to your opinion

of the quality level of the asset.
The rating range is from one to five stars, with five representing the highest level of
quality and one representing the lowest.

3. Optionally, enter a review of the asset in the text field.

Tip This collaborative feature is intended to help an organization improve the
quality of its data and help users trust the quality of the data. As such, if you
provide a rating of three stars or fewer, we strongly encourage you to provide
a review, to help the owner understand how the quality of the asset might be
improved.

4. Click Save.
» The average user rating is recalculated.

Edit a rating
If, for any reason, your opinion of the quality of an asset changes, you can edit or delete
the ratings you've given, at any time. With the correct resource permissions, you can also
edit other users' ratings.

Steps

1. Open an asset page.
2. If required, edit your own :

a. In the My rating section, click .

b. Make the necessary changes:
o Click the star that corresponds most closely to your opinion of the quality
level of the asset.

o Edit your review, if relevant.
c. Click Save.

» The average user rating is recalculated.
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3. If required, edit another user's rating:
a. In the Rating section, click next to the rating you want to edit.

b. Make the necessary changes:
o Click the star that corresponds most closely to the other user's opinion of
the quality level of the asset.

o Edit the review, if relevant.
c. Click Save.

» The average user rating is recalculated.

Delete a rating
If, for any reason, your opinion of the quality of an asset changes, you can edit or delete
the ratings you've given, at any time. With the correct resource permissions, you can also
delete other users' ratings. This can be helpful if one or more previous ratings and reviews
are no longer relevant.

Steps

1. Open an asset page.
2. If required, delete your own rating:

a. In the My rating section, click .

b. Click Delete, to confirm.
» The average user rating is recalculated.

3. If required, delete another user's rating:
a. In the Ratings section, click next to the rating you want to delete.

b. Click Delete, to confirm.
» The average user rating is recalculated.

Delete all ratings
You can delete all ratings of all assets of an asset type in one go. This is mainly helpful if
you want to disable ratings for that asset type.
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Prerequisites

You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the upper-right corner, click Delete ratings.

» The Confirm deletion dialog box appears.
3. Click Delete ratings.

Tags
In addition to strictly governed metadata, you can use tags to categorize assets. A tag is a
piece of metadata that is used to label an asset, to help categorize the asset. You can use
the same tag for all the assets that belong to the same category of a business (for
example, finance). Although the tags are stored in the Collibra Data Intelligence Cloud
database, they are not strictly governed by Collibra.

Note
l Tags can be added to only assets.
l Adding, editing, or deleting a tag from an asset does not change the last
modified date of the asset.

Benefits
Some of the benefits of tags are as follows:

l You can search for assets with a specific tag by clicking the tag on an asset page or
on the tags overview page.
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l You can select the Tag facet on the Search page to navigate search results.
l You can use tags in filter clauses.
l You can import and export tags.

Tag name characteristics
The characteristics of tag names are as follows:

l Tag names are case sensitive.
For example, you can enter the following tag names: Car, car. However, tag sug-
gestions are not case sensitive. For example, typing car can provide the following
suggestions: Car, car.

l Tag names cannot contain spaces.
l Tag names can contain underscores (_).
l The maximum length of the tag name is 250 characters.

Permissions
The following table contains the permissions that you need to manage tags on the asset
and tags overview pages.

Page Permission

Asset Resource Asset > Tags > Update: Add, edit, and delete tags.
For information about how to grant this permission to a role, go to
Enable permission to use tags.

Note You can grant this permission to only the role that
has the relevant global permission for the associated asset
type and has at least the view access to the associated
community or domain. For more information, go to
Responsibilities.

Tags overview Global  l Tags > Manage tags: Edit, merge, and delete tags.
This permission allows admin and super users to manage
all tags.

l Tags > View tags: View the tags overview page.
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Tags overview page
The tags overview page provides an overview of all the tags in Collibra Data Intelligence
Cloud.

With the right permissions, you can view, delete, edit, and merge tags.

By default, the tags table shows the Name column and the Created By column. You can
add more columns. The following table describes all available columns.

Column Description

Assets Count Total number of assets to which a specific tag has been applied.

Created By The user who created the tag.

Created On The date on which the tag was created.

Last Modified The date and time when the tag was last modified.

Last Modified By The user who last modified the tag.

Name Name of the tag. Tag names cannot contain spaces and the maximum length
is 250 characters. The underscore ( _ ) character is allowed.
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Search by tags

You can search for all assets for which a specific tag has been applied, by clicking the tag
on an asset page or the tags overview page. The search results are shown on the Search
page.

Edit a tag on the tags overview page

If you have the correct resource permission, you can edit an existing tag on the tags
overview page.

Steps

1. On the main menu, click , and then click Stewardship.

2. In the submenu, click Tags.
» The Tags overview page opens.

3. Hover your mouse over the name of a tag.
4. Click edit to the right of the tag name.

5. Edit the name.
6. Click .

Merge tags on the tags overview page

You can merge tags on the tags overview page. You merge tags by changing the name of
a tag to that of another existing tag.

Steps

1. On the main menu, click , and then click Stewardship.

2. In the submenu, click Tags.
» The Tags overview page opens.

3. Hover your mouse over the name of a tag.
4. Click edit to the right of the tag name.

5. Change the name of the tag to that of another existing tag.
6. Click to the right of the tag.
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» The Merge tags confirmation dialog box appears.
7. Click Merge.

Delete a tag from the tags overview page

You can delete one or more tags from the tags overview page.

Steps

1. On the main menu, click , and then click Stewardship.

2. In the submenu, click Tags.
» The Tags overview page opens.

3. Select the checkboxes to the left of the tags you want to delete.
4. In the resource toolbar, click More > Delete.

Add a tag to an asset on an asset page
You can add a tag to an asset on an asset page.

Steps

1. Open an asset page.
2. Double-click in the Tags section, or click on the right-hand side of the section.

3. Type the text for your tag and press Enter.

Tip
o As you type, already existing tags that match what you are typing are
suggested. If you want to use a suggested tag, you can click on it.
Otherwise, you can ignore the suggestions.

o You can add as many tags as you want.

4. Click Save.

Add a tag to an asset in an asset table or set of tiles
You can add a tag to an asset in a table.
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Steps

1. Open any set of assets in table display mode.
2. Double-click in the Tags column, or click on the right-hand side of that column.

If you do not see the Tags column, add it to the table. See Customizing tables.
3. Type the text for your tag and press Enter.

Tip
o As you type, already existing tags that match what you are typing are
suggested. If you want to use a suggested tag, you can click on it.
Otherwise, you can ignore the suggestions.

o You can add as many tags as you want.

4. Click .

Delete a tag from an asset on an asset page
You can delete a tag from an asset on an asset page.

Steps

1. Open an asset page.
2. Double-click in the Tags section, or click on the right-hand side of the section.

3. Click next to the tags that you want to delete.

4. Click Save.

Delete a tag from an asset in an asset table
You can delete a tag from an asset in an asset table.
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Steps

1. Open any set of assets in table display mode.
2. Double-click in the Tags column, or click on the right-hand side of that column.

If you do not see the Tags column, add it to the table. See Customizing tables.
3. Click next to the tags that you want to delete.

If you want to delete the tags from all assets that are visible on the page, select the
Apply to all visible rows check box.

4. Click .

Attachments
You can add attachments to communities, domains and assets. Examples of attachments
are reference materials or other documents that are related to the resource.

Attachments
An attachment is a file that you upload via an asset page, domain page or community
page. You can use this to add reference materials or other documents that are related to
the resource.

You can find attachments on the community, asset or domain page→ Files.
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Note
l Adding and removing attachments doesn't modify assets, so their last
modified date will not be updated.

l Uploading attachments is restricted by the file upload settings, which
determine the maximum file size, allowed file extensions and maximum
amount of uploads and downloads per day. Contact Collibra support if you
want to change the file upload settings.

Add attachments
You can add files to an asset, domain or community as attachments.

Note

l Adding and removing attachments doesn't change assets, so their last
modified date will not be updated.

l Uploading attachments is restricted by the file upload settings, which
determine the maximum file size, allowed file extensions and maximum
amount of uploads and downloads per day. Contact Collibra support if you
want to change the file upload settings.

Steps

1. Open a community, domain, or asset page.
2. In the tab pane, click Files.

3. Upload a file in one of the following ways:
o Drag and drop the file in the upload area.
o Click Upload a file, browse to the location of the file and click Open.

» The file is displayed in the table.

Comments
You can discuss a community, domain, or asset via comments. For example, if you want to
discuss the attributes of an asset or propose related assets, you can do so via comments.
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Comments are shown on the Overview or Details tab of a community, asset, or domain
page. Depending on your permissions, you can add a comment, reply to a comment ( ),

edit your comment ( ), and delete your comment ( ).

Note
l To add a comment, you must have the following resource permission:
Comment > Add

l To edit your comment, you must have the following resource permission:
Comment > Update

l To delete your comment, you must have the following resource per-
mission: Comment > Remove

l Adding, editing, or deleting a comment does not change the last mod-
ified date of the community, domain, or asset.

Add comments
You can add comments to communities, domains, and assets. For example, if you want to
discuss the description of an asset, you can do so via comments.
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Requirements and permissions

You have the Comment > Add resource permission for the community, domain, or asset to
which you want to add comments.

Steps

1. Open a community, domain, or asset page.
2. In the left pane, click either Overview → Comments or Details → Comments.
3. In the Comments field, enter your comment.

Tip You can use the toolbar to:
o Modify the appearance of the comment.
o Add links and images in the comment.
o Mention other users in the comment.

4. Click Save.
» Your comment is saved.

User mentions
You can draw a user's attention to a comment, community, domain, or asset via the User
mention option.

Mention a user

To mention a user in a comment, select or enter @, and then type the user's first name,
last name, or username. As you type a name, matching names appear, even if the typed
character is not the first character in a name.
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In a user mention, the user is addressed by their first and last names. If the first and last
names for a user are not available, their username is used. If, however, the profile of the
user is deleted, their name in the mention is replaced with @Deleted User.

List of user mentions

To view all the comments in which you are mentioned, go to your profile page, and then, in
the tab pane, click Mentions.

Item Description

The name of the user who mentioned you in a comment. This can be the full
name, first name, last name, or username of the user, depending on which
information is available.

The name of the resource to which the comment was added.

The time when the comment was added.

The link to the comment. When you click the link, the resource page is shown with the
comment highlighted.
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Email notification

When you mention a user, they receive an email message that contains the content of the
comment in which they are mentioned and a link to the page containing the comment.

Item Description

The name of the user who mentioned you in a comment. This can be the full name, first
name, last name, or username of the user, depending on which information is
available. If you click the name, their profile page in Collibra is shown. You are,
however, first prompted to sign in to Collibra.

The name of the resource (that is, community, domain, or asset) to which the comment
was added. If you click the name, the resource page in Collibra is shown.

The content of the comment. If you click your name, your profile page in Collibra is
shown.

The button to open the comment in Collibra.

The button to open the list of all comments in which you are mentioned, in
Collibra.
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View permission

If you mention a user who does not have the permission to view the resource, a message
indicating so appears.

If you are the mentioned user who does not have the permission to view the resource, and
if you click the resource link in the email notification, the following message is shown: Not
authorized.

Responsibilities
Responsibilities are used to assign a resource role to one or more users and/or user
groups. Based on their responsibilities, users can act on the permissions conveyed to
them via the resource role.

Responsibilities
A responsibility is the assignment of one or more users and/or user groups to a resource
role for a resource.

Based on their responsibilities, users can act on the permissions conveyed to them via the
resource role.

Child resources always inherit the responsibilities from their parent resources:

l If the resource is a community, the responsibilities are inherited by subcommunities,
domains and assets in the community. For example, if you are a Business Steward
for a certain community, you are a Business Steward for all the subcommunities,
domains and assets inside that community.

l If the resource is a domain, the responsibilities are inherited by the assets in the
domain.
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l If the resource is an asset, the responsibilities only apply to the asset itself, because
assets never have children.

Example
Suppose the following setup:

l Anita Morrison is assigned the Community Manager resource role for a
community called "Enterprise".

l John Fisher is assigned the Business Steward resource role for a domain
called "Critical Data Elements" in the "Enterprise" community.

l Joanna Zhou is assigned the Owner resource role for a domain called "Critical
Data Elements" in the "Enterprise" community.

l William Parker is assigned the Owner resource role for an asset called
"Customer Revenue" in the "Critical Data Elements" domain.

This leads to the following responsibilities:

Resource Direct responsibilities Inherited responsibilities

Enterprise
community

l Anita Morrison as Community
Manager

l None

Critical Data
Elements domain

l John Fisher as Business
Steward

l Joanna Zhou as Owner

l Anita Morrison as Community
Manager

Customer Revenue
asset

l William Parker as Owner l Anita Morrison as Community
Manager

l John Fisher as Business
Steward

l Joanna Zhou as Owner

Note You can view direct and inherited responsibilities of a resource in different
places.

View responsibilities for a resource
You can view the responsibilities for a resource in the following locations:
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l In the Responsibilities tab of a resource.
l In any view that displays communities, domains or assets, in the specific column or
field for that role.
a. Open any view in table or tiles mode.
b. Perform one of the following steps:

n In tile mode: add the required fields.
n In table mode, add the required column.

Note
o Each role has its own field or column.
o Depending on the settings in Collibra Console, you may also see the
inherited responsibilities.

l In the Responsibilities tab of a user's profile page.

Tip You can also view your own responsibilities.

a. Open a profile page.
b. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
l In the Responsibilities tab of a user group page.

a. Open a group page.
i. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
ii. Click Users and groups.

» The users and groups settings appear on the Users tab page.
iii. In the tab pane, click Users → Groups.

» The user group table appears.
b. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
l In the Preview pane of an asset, for example on an asset page.

Note The preview pane only shows the direct responsibilities.
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The Responsibilities page
The Responsibilities page shows the view permissions and the responsibilities of a
resource.

The background colors of the responsibilities show where the responsibility comes from.

Color Description

Gray The user or group inherited the role.

White The user or group was directly assigned to this role for the resource.

If a user or group has a responsibility but not the required view permissions, a warning
appears in the box. For example, a user was assigned the Steward role for a resource but
does not have view permissions for it.

For information on view permissions, see the Collibra Data Intelligence Cloud
Administration Guide.

Create a responsibility
You can create a responsibility:

l By assigning a resource role to a user or user group on the responsibilities page of a
resource.

l By adding a user in the table column of a role.
l By editing an existing responsibility.
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Important For optimal performance and ease of use, we recommend that you
create responsibilities mainly on domains and communities and not directly on
assets. Creating responsibilities directly on large amounts of assets may lead to
decreased performance.

Assign a resource role to a user or user group on the
responsibilities page

1. Open a community, domain, or asset page.
2. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
3. Above the table, to the right, click Add.

» The Add responsibilitiy dialog box appears.
4. Enter the required information.

Option Description

Role Enter the role that you want to assign to a user or group for this resource.

People Enter the users and user groups to which you want to assign a role for
this resource.

5. Click Add.
» The users or groups with the assigned role are now displayed in the Respons-
ibilities table.

Tip
l If you want to assign a user or user group a resource role that other users or
groups already have for this resource, you can click and add them in the
People field in the Assign role box.

l If there are only inherited roles, is not available.

Assign a role to a user or user group for a resource from a table

1. Open a table that displays communities, domains or assets.
2. If required, add the column of the role that you want to assign to the user.
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3.  Perform one of the following steps:
o Double-click a cell in the column of the role.
o Hover your mouse pointer over a cell in the column and click .

4. Click in the field and enter the user or user group.
5. If required, select Apply to visible rows.

This will create the responsibilities for all visible users.

Tip You can filter the columns first, to assign a role to a user for specific
resources in one go.

6. Click .

Edit a responsibility
You can edit a responsibility:

l by deleting it and creating a new one.
l in an asset table.

Note You cannot edit inherited responsibilities.

Edit a responsibility in a table

1. Open a table that displays communities, domains or assets.
2. If required, add the column of the role that you want to edit.

Warning Depending on the settings in Collibra Console, you may also see
the inherited responsibilities. You cannot edit these inherited responsibilities.

3.  Perform one of the following steps:
o Double-click a cell in the column of the role.
o Hover your mouse over a cell in the column and click .

4. Edit the responsibility:
o Click in the field and enter a new user or user group.
o Click next to the user or user group to remove the user or user group.
o If required, select Apply to visible rows.
This will edit the responsibilities of all visible users.
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Tip You can filter the columns first to assign a user to specific resources
in one go.

5. Click .

Delete a responsibility
You can delete a responsibility:

l From the responsibilities page of a resource.
l From a table.

Note You cannot delete inherited assignments.

Delete a responsibility from the responsibilities page of a resource

1. Open a community, domain, or asset page.
2. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
3. In the Responsibilities table, click next to the name of the user or group that you

want to remove.

4. Click Delete to confirm.
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Delete responsibilities for a resource from a table

1. Open a table that displays communities, domains or assets.
2. If required, add the column of the role that you want to edit.

Warning Depending on the settings in Collibra Console, you may also see
the inherited responsibilities. You cannot delete these inherited
responsibilities.

3.  Perform one of the following steps:
o Double-click a cell in the column of the role.
o Hover your mouse over a cell in the column and click .

4. In the cell editor, click next to the user or user group.

5. If required, select Apply to visible rows.
This will delete the responsibilities from all visible users.

Tip You can filter the columns first to assign a user to specific resources in
one go.

6. Click .
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View permissions
A view permission is the right to see a resource and its children. It determines which users
can see and work with which resources. You assign a view permission to users or user
groups on domain or community level. Consequently, only these users can see the
resources and their children, including the assets. This also includes relations to assets: if
you do not have view permissions for an asset, you don't see the relations to that asset, for
example in views or on the asset page of the related assets.

Understanding view permissions

By default, all users can see all resources. You can tell that there are no view permissions
if Unrestricted view permissions is in the View permissions section of the resource's
Responsibilities page.

If you add users or user groups to the view permissions of a resource, only those users or
groups can view the resource and its children.

All child resources inherit the view permissions from parent resources. Once you have
added users or user groups to the view permissions of a resource, you cannot create view
permissions for any of its child or parent resources.
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You can recognize inherited view permissions by their gray background.

Note
l A user with the System Administration global permission, for example via the
Sysadmin global role can see all views in Collibra, even if they are not shared.

l A user with the Manage all views permission can see only views that are
shared.

Impact of view permissions on responsibilities

View permissions affect responsibilities. If a user has a responsibility for a certain
resource, but does not have view permission, that user cannot act upon that responsibility.
The responsibility becomes inactive, due to the lacking view permission.

To activate the responsibility, you have to create the view permission for this resource or a
parent resource.
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Example
In the example below, Luke O'Reilly is the Owner of the SCPM Glossary domain,
but he does not have the view permission to see the domain. As a consequence, he
cannot see the assets or act on his responsibility. On the Responsibilities page, his
responsibility shows an error message to clearly show that there is a problem. You
can solve the problem in one of the following ways:

l Create a view permission for Luke.
l Add Luke to the user group that has a view permission.
l Delete all view permissions, so that everyone can see the assets.
l Delete Luke's responsibility as Owner and pick another person for that role.

Create a view permission

You can create a view permission if you don't want all users to see certain resources.

Prerequisites

l You have a resource role with the Edit View Permissions resource permission, for
example Community Manager.
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l None of the parent communities or children of the current resource have a view per-
mission.

Steps

1. Open a community or domain page.
2. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
3. Above the table, to the right, click Add.

» The Add view permissions dialog box appears.
4. In the Users or Groups field, start typing the name of the user or user group.
5. Select a user or user group from the suggestions.
6. Click Add.

Delete a view permission

You can delete a view permission if you want to change which users are allowed to see
certain resources.

Prerequisites

l You have a resource role with the Edit View Permissions resource permission, for
example Community Manager.

l One or more users or user groups have a view permission on the resource.

Steps

1. Open a community or domain page.
2. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
3. In the View Permissions section, click next to the name of the user or group that

you want to remove.

» A confirmation message appears.
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4. Click Delete.
» One view permission is deleted, so only the remaining users or user groups can
see this resource and its children.
» If you deleted the last view permission, all users can now see this resource and its
children.

Asset data quality
The Quality page of an asset makes data quality results of an asset available to the
business stakeholders. The dashboard aggregates the following values:

l Collected over time on attributes.
l Aggregated from different assets along a number of predefined relations.

The assets for which these data quality dashboards are available and how the values are
aggregated are defined in data quality rules, which can be edited on the Data Quality Rule
tab on the Settings page. For the following examples, a data quality rule exists on

business terms, aggregating values from data quality rules related to these business
terms.

Asset quality
The assets for which the quality dashboard is available have an extra option in their tab
menu, namely Quality. The dashboard displays the aggregated passing fraction (quality
score) for the asset in the form of ring charts.

Each ring chart shows the quality score in the form of:

l A quality score as a percentage.
l A color code indicating the quality of this passing fraction:

o Red: 0-50%
o Orange: 50-85%
o Green: 85 - 100%
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l An arrow indicating the trend of the score compared to the previous measurement.

The first ring chart shows the general score of the asset. The ring charts next to it show
subscores for a specific dimension, such as Accuracy, Conformity, Completeness and
Consistency. Only values that belong to that specific dimension are then taken into
account. The dimensions to use are configured in the metric group. In this example, it is
the relation: Data Quality Rule is Classified By Data Quality Dimension.

Underneath the top pane, three selection boxes are available. They display an extra
overview, details and history pane, respectively.

To close a pane, click in the upper-right corner of the pane.

Data quality overview pane
The Overview pane shows more information about each level in the aggregation path for
the selected general score or dimension. For each level, it shows the number of involved
assets of a certain type and what their results are: failing (red) or passing (gray). It also
shows the total number of rows, the number of failing rows (red) and the number of
passing rows (gray) that resulted in the given scores.

In the following example, the Conformity dimension consists of a total of 38 070 rows, 26
575 of which were failing. Two Data Quality Rules were involved, one of which was failing.
And these Data Quality Rules were used by one Data Entity, which has an aggregated
failing result.

Asset quality details pane
The Details pane shows more information about all the assets involved in a table format.

For each asset, a row with the following default columns is shown:
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l Data Asset: The data asset signifier
l Rows Passed: The number of passing rows, aggregated as a sum of the passing
rows of the underlying assets

l Rows Failed: The number of failing rows, aggregated as a sum of the failing rows of
the underlying assets

l Quality Score: The score aggregated as an average of the quality scores of the
underlying assets

l Result (failing or passing): The aggregated result as a logical conjunction of the res-
ults of the underlying assets.

Some extra columns can be displayed in this table by clicking → Columns.

These include:

l Full name: The unique full name of the asset.
l Domain: The domain to which the asset belongs.
l Type: The type of the asset.
l Dimension: The dimension that applies to these assets, if any. Dimensions are used
to calculate the subscores, as mentioned earlier.
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Asset quality history
The History pane shows the evolution of the quality score over time, for up to one month in
the past.

You can display the date and the score for a specific period at the top right of the pane by
hovering your pointer over that period.

When you select a period by clicking on it, the top left corner of the pane shows a trend of
the score compared to the period before it.

Validation rules
Validation rules are special assets of the type Validation Rule. They allow you to verify
whether assets meet certain criteria. They have a special attribute Validation Script,
which contains a validation script that evaluates assets of the types to which the validation
rule is assigned.
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Administrator actions
l Create a domain of the type Validation rule domain.
l Create a validation rule.
l Edit a validation rule.
l Delete a validation rule.
l Assign a validation rule to an asset type.
l Change the order of validation rules.
l Unassign a validation rule from an asset type.

User actions
l Validate assets.
l View the validation result.
l Revalidate an asset.

Executing validation rules
You can execute validation rules in many ways:

l Validate assets
Do this to manually validate assets.

l Revalidate an asset
Do this after editing an invalid asset.

l Automatically.
You can configure a workflow to start a validation on given events. For example
when a asset is added or an attribute is edited.
To configure triggers on certain events, see Getting started with workflows.

Validation logging

Collibra Data Governance Center can write extensive log messages from the execution of
validation rules. These messages are written to the dgc.log file.

If the execution of a validation rule fails, analyzing the log is probably the most thorough
approach.

For more information on how to configure validation logging, see Logging.
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Tip When contacting support regarding a problem with validation, attach the log file
to the ticket.

Validate assets

Validating an asset executes all validation rules assigned to the asset type. If an asset
does not meet all validation rules, the asset is invalid.

You can see the validation result on:

l An asset page’s title bar.
l As a column, when viewing assets in table display mode.
l As a field, when viewing assets in tiles display mode.
l As an overlay in a traceability diagram.

After validation, the dgc.log file will also contain more extensive messages. For more
information on how to configure validation logging, see Logging.

Note By default, validation is not automatically triggered when an asset is edited,
so you have to revalidate it after editing an asset. However, you can create a
workflow for this. To configure validation on certain events, see Getting started with
workflows.

Prerequisites

l Either of the following:
o You have a resource role with the Validation Execution resource permission,
for example Community Manager.

o You have a global role that has the Manage all resources global permission.
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Validate an asset from the asset page

1. Open an asset page.
2. In the resource toolbar, click (validate).

Validate one or more assets from an asset table

1. Open a set of assets in table display mode.
2. Select checkboxes in front of the assets you want to validate.
3. In the action toolbar, click Validate.

Validate one or more assets from a set of tiles

1. Open a set of assets in tile display mode.
2. Select the assets you want to validate.
3. In the action toolbar, click Validate.

Revalidate an asset

You can revalidate assets that were previously validated to see whether they meet the
validation rules that are assigned to the asset type.

Validating an asset executes all validation rules that are assigned to the asset types. If an
asset does not meet all validation rules, the asset is invalid.

You can see the validation result:

l An asset page’s title bar.
l As a column, when viewing assets in table display mode.
l As a field, when viewing assets in tiles display mode.
l As an overlay in a diagram.
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Note You can create a workflow to automatically revalidate assets. To configure
validation on certain events, see Getting started with workflows.

Prerequisites

l Either of the following:
o You have a resource role with the Validation Execution resource permission,
for example Community Manager.

o You have a global role that has the Manage all resources global permission.

Revalidate an asset from the asset page

1. Open an asset.
2. In the upper right corner, click valid or invalid.

3. Click Revalidate.

Revalidate one or more assets from an asset view

1. Open an asset table.
2. Select checkboxes in front of one or more assets.
3. In the action toolbar, click Validate.

Revalidate an asset from an asset view

1. Open an asset table.
2. If you don't see the Validation Result column, add it to the table.

More info on adding columns to a table: Customizing tables.
3. Click or .

You can see the validation result of each validation rule.
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4. Click Revalidate.

View the validation result
After validating or revalidating assets, you can view the result and make changes where
necessary.

View the validation result from the activities list

1. Open the activities list.
» In the table, you see the validations.

2. In the results column, click Result.
» The Validation results dialog box appears.
Example
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3. The results column shows or to indicate whether they are respectively valid or

invalid.

Tip If you want to fix invalid assets, you can open them by clicking them.

View the validation result on the asset page

1. Open an asset page.
2. In the upper right corner, you see valid or invalid.

View the validation result in an asset table

1. Open an asset table.
2. If you don't see the Validation Result column, add it to the table.

More info on adding columns to a table: Customizing tables.
3. Click or .

» You can see the validation result of each validation rule.
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History in Collibra
Collibra Data Intelligence Cloud automatically keeps a history of users and resources such
as assets, domain and communities. This history keeps track of most changes to that
resource and its children, as well as who made the changes.

Example
Users can provide a definition of a business term, edit its name, move it to a new
domain, and change the status. These changes are in the history of the affected
assets, their parent domain, all parent communities and the history of the users
themselves.

You can view the history of any resource in the History tab of the resource's page, as
shown in the following image.
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History page
The History page provides an overview of the history of a user or a resource and its
children. For examples, it contains all actions related to the following:

l Creating, editing and deleting resources.

Note
In some cases, an edit is logged as a delete plus a create.
For example, if you edit a Description attribute of a Data Usage complex
relation, the original Description attribute is deleted, and a new Description
attribute is created with the new content.

l Moving assets to a different domain.
l Adding, editing and removing characteristics.
l Changes to the asset status.
l Social features such as comments, tags and ratings.
l Uploading and deleting attachments.
l Workflows and the resulting changes.
l Creating, editing and deleting responsibilities.

Note
o The history does not show changes to inherited responsibilities.
o The history does not show changes to the view permissions.

l In the case of the user history, adding and removing the user to or from user groups.

Tip Some actions do not change the last modification date of an asset. See here for
actions that do change the last modification date and actions that don't.
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Column Content

1 The filter that allows you to filter the history based on the type of action, the user or a time
period.

2 The icon that represents the type of action that was applied to the resource:

l : Added information.
l : Edited information.
l : Deleted information.
l : Multiple changes in one go. Click the icon to expand and show the individual

changes

3 The summary of the action.

4 The name of the affected resource.

5 The user who applied the action.

6 The date and time when the action was applied.
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View the history of a resource
You can view the change history of an asset, domain or community.

Steps

1. Open an asset page.
2. In the tab pane, click History.

» The history is shown in a table.

Note By default, the filter only shows the 10 latest changes in the last month.

3. If required, do one of the following:
a. Click Load More below the table to load more history items.
b. Edit the filter criteria above the table to see only specific history items.

Criterion Description

Action Choose one of the actions:

n Add
n Edit
n Delete

The effect of this filter criterion depends on the resource:

n For assets, this includes action that affect an attribute.
n For domains, this includes actions affecting the domain itself, but

also actions affecting assets in the domain.
n For communities, this includes actions affecting the community

itself, but also actions affecting assets, domains and sub-
communities of the community.

Who Choose a user whose actions you want to see.

from Choose the start date of the period of which you want to see the actions.

The default value of this criterion is one month before the current date.

to Choose the end date of the period of which you want to see the actions.

The default value of this criterion is the current date.
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c. Remove the Action or Who filter criteria by deleting the value in the filter box
using the Delete key of your keyboard.

About the last modification date
The last modification date shows the date of the last modification to an asset. Not all
modifications to an asset will change this date. On this page, you see an overview of
actions that change the last modification date and actions that don't.

Actions that change the last modification date

l Asset property changes:
o Asset (full) name
o Asset display name
o Asset status
o Move asset to another domain
o Exclude or include asset from auto-hyperlinking

l Asset attribute changes:
o Add new attribute
o Edit attribute value
o Delete an attribute

l Other:
o Articulation score

Actions that don't change the last modification date

l Asset relations:
o Add a relation to an asset
o Remove a relation from an asset

l Asset responsibilities:
o Grant a new role to a user or user group
o Remove a user or user group

l Collaborative actions:
o Add or remove tags
o Add or remove ratings
o Start workflows
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o Task completion
o Add, edit or remove comments

l Other:
o Add attachment
o Take diagram picture
o Validation result

References tab of an asset page
The References tab of an asset page shows a table with assets that have at least one
string attribute or comment containing the name of the asset that you have currently
opened.

By default, the table shows the Asset, Reference Type, and Reference Value columns.
You can, however, add more columns.

The following table describes the available columns.

Column Description

Asset The full name of the asset that references the opened asset.

Reference Type The type of the attribute that references the opened asset.
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Column Description

Reference Value The text of the attribute that references the opened asset.

Status The status of the asset that references the opened asset.

Type The type of the asset that references the opened asset.

Asset recommender
The asset recommender suggests relevant assets based on the assets that were visited in
the past.
The provided recommendations can be based on the overall asset popularity across the
organization or targeted for a specific user. Depending on where the recommendations are
shown, they can also be categorized and filtered by asset type, domain or community.
To ensure the recommendations are based on up-to-date information, the asset
recommender is retrained every day. For more information, go to Asset recommender
strategy.

Asset recommendations are shown in Collibra for Desktop, Home page, and Data
Marketplace. In the following example, the asset recommender is used to display popular
data and recommended data in Data Marketplace.

Important
l The asset recommender is a Cloud-only feature. The asset recommender also
requires that application usage data is collected for the environment.

201

ref_landing-page.htm
ref_landing-page.htm


l Recommendations are not available in environments with instance names that
contain one of the following strings: -qa, beta, -poc, ie-, infra-, docker, training,
sandbox, or :.

l Recommendations in new environments will be empty or less meaningful for
some time until the asset recommender collected enough user behavior data.

l If you just started using Collibra as a user, you won't receive any
recommendations. You'll receive recommendations after using Collibra and
after the daily retraining of the asset recommender.

Asset recommender strategy

The asset recommender is trained on asset visit data. It roughly follows these steps:

1. Data on asset visits, like which users visited which assets, when, and how often, is
collected and processed to assign a score to all asset and visitor combinations. The
score reflects the interest of a user in the asset.

Note
Asset visits in Collibra platform, Collibra for Desktop, Collibra for Mobile, and
Data Marketplace are taken into account.
Visits to the following instance names are not taken into account:

o Instance names that contain the following strings: -qa, beta, -poc, ie-,
infra-, docker, training, sandbox, and :.

o Instance names that do not contain .collibra.com

2. A model is trained to predict all user-asset interest scores. The model learns to gen-
erate informative recommendations for assets and users based on the collected
data.

Note Certain asset visits are filtered out when the asset recommender is
retrained, for example, assets visited by only one user, assets that are only
visited once, and asset visits that take less than six seconds.

3. The data collection and model training are triggered daily to ensure that asset recom-
mendations are based on up-to-date information.
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Troubleshooting asset recommender

Issue: You do not receive any recommendations where you expect them.

Possible reasons:

l If you just started using Collibra as a user, you won't receive any recommendations.
You'll receive recommendations after using Collibra and after the daily retraining of
the asset recommender.

l You visited assets, but the visits were filtered out during retraining. In this case, the
asset recommender cannot provide recommendations.

l It is possible that no relevant assets can be suggested because of applied asset
type, community or domain filters where the recommendations are shown. For
example, assets outside the Data Marketplace scope will not be recommended in the
context of Data Marketplace.

l It is possible that no relevant assets can be suggested in the instance.
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Homepage
The Collibra Homepage is the default page that appears when you sign in to Collibra Data
Intelligence Cloud or when you click on any page in Collibra. The Homepage guides

you within Collibra by showing information that is relevant to you, such as your
dashboards, the most viewed assets, and the recommended assets. The Homepage also
allows you to perform a search, for example, for a community, domain, or asset.

The Homepage changes how you find or access your dashboards. You can access all
your dashboards on the Dashboards card on the Homepage or on the Dashboards tab in
the Browse pane.

If you are an administrator, you can define the headings and the content shown in each
section of the Homepage and thus create a Homepage that can meet user needs.

Note
l In Collibra 2022.11 or newer, the Homepage is enabled by default.
l In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer,
the Homepage is available but disabled by default.

l In Collibra environments upgraded from 2022.11 to a newer version, the
previous status of the Homepage (enabled or disabled) is retained.

l For information about how to enable or disable the Homepage, go to Enable or
disable the Homepage.

l If you are an administrator, the Edit Page button is shown on the Homepage
to enable you to customize the Homepage.
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Enable or disable the Homepage

Note
l In Collibra 2022.11 or newer, the Homepage is enabled by default.
l In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer,
the Homepage is available but disabled by default.

l In Collibra environments upgraded from 2022.11 to a newer version, the
previous status of the Homepage (enabled or disabled) is retained.

Note Depending on your environment, follow this procedure either in the Services
Configuration section of the Collibra settings or in Collibra Console. This topic
contains the procedure for Collibra Console. If your Settings page has a
Configuration tab, you can follow this procedure on that tab. For more information,
go to the online documentation.

Requirements and permissions
l You have the ADMIN or SUPER role in Collibra Console.
l You have the SUPER role in Collibra Console.
l The Frontend enabled setting is enabled.

Steps

1. Open the DGC service settings for editing:
a. Open Collibra Console.

» Collibra Console opens with the Infrastructure page.
b. In the tab pane, expand an environment to show its services.
c. In the tab pane, click the Data Governance Center service of that environment.
d. Click Configuration.
e. Click Edit configuration.

2. Go to the Homepage section.
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3. Select the required value.

Value Description

True Enables the Homepage. When you sign in to Collibra, the Homepage is
shown. The Homepage replaces your default dashboard.

False

(default)

Disables the Homepage. When you sign in to Collibra, your default dash-
board is shown, instead of the Homepage.

4. Click Save all.

Homepage overview
The following table describes the sections shown on the Homepage.
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No. Description

Contains the title.

Contains an introduction.

Allows you to perform a search, directing you to the global search results page.
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No. Description

Helps you to find content and perform your daily activities. Depending on how the
Homepage is customized, this section can contain any three of the following cards:

l Dashboards: A list of dashboards that you can access.
l My Quick Links: A list of links to the pages that you can quickly access. You can add,
edit, rearrange, and delete quick links.

l My Tasks: A list of tasks that are assigned to you.
l Most Viewed Assets: A list of assets that your colleagues viewed the most in the last
30 days.

l Recommended Assets: A list of assets that you might like based on your search his-
tory and the assets that you previously viewed.

Edit the Homepage
You can customize the Homepage for the users of Collibra by providing relevant and
contextual content.

This topic describes how to edit the Homepage, including how to preview and publish it.

Note When you edit the Homepage, your changes are automatically saved each
time that you click outside the section where you made the changes.

Requirements and permissions
You have a global role that has the System administration global permission.

Steps

1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. In the upper-right corner of the page, click Edit Page.
» The Homepage opens in the editor mode.
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Tip If another administrator has edited or is editing the Homepage, a
message indicating so is shown on the Homepage. For example, Draft saved
8 minutes ago by John. You can, however, still edit the Homepage.

3. Edit the sections as needed.
How to edit the sections
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No. Description

Enter a title for the Homepage.
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No. Description

o In the first box, enter a greeting.
If you want the first name of a user to be shown in the greeting, enter
{Name}. For example, if you enter Hello {Name}, when a user named
Jane Doe signs in, the following greeting is shown to her: Hello Jane.
If the user does not have a first name, the username is shown.

o In the second box, enter an introduction.
o Add an image.

How to add an image
i.  Hover your pointer over the current image, and then click Add

Content.
» The Add Content dialog box appears.

ii. Enter the required information.
n Add Image by Link: The link to the image that you want to be

shown. If you leave this field blank, the default Collibra
Homepage image will be shown.

n Alt text: A meaningful description of the image. If the image
fails to load, this description is shown in place of the image. The
description also helps screen-reading tools to describe the
image.

iii. Click Save.

o In the first box, enter a heading that indicates that users can perform a
search, for example, What are you looking for?.

o In the second box, enter the text that you want to be shown in the
search field to guide users, for example, Search Collibra.

o In the box, enter a heading that indicates that users can find content,
for example, Where would you like to go?.

o The top subsection that is located below the box contains the selected
cards, which will be shown to users. The bottom subsection contains
the available cards, which you can choose to show to users. To move
a card from one subsection to another, drag the card and drop it to
where you want it in the subsection.
While a total of five cards are available, a maximum of three cards can
be shown to users.

Tip On the My Quick Links card, you can add, edit, rearrange, and
delete quick links.
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Tip
o If you want to pause editing the Homepage or want to publish the edited
Homepage later, click Close Editor. This action saves all the changes
that you made to the Homepage and shows the last published
Homepage in the view mode.

o If you want to discard all the changes that you made to the Homepage,
click , and then click Delete Draft. You can then continue to make new
changes to the Homepage.

o If you want to restore the Collibra version of the Homepage, which is the
original version, click Restore Collibra Version, and then click Publish.

4. Optional: Click Preview.
» A preview of the Homepage is shown.

Tip If you want to make more changes to the Homepage, click Back to
Editor.

5. To publish the Homepage, click Publish.
» The edited Homepage is published to all the users.

Add a quick link
You can add up to six links to the My Quick Links card on the Homepage. The links that
you add to the card are shown only to you.

Steps

1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Add a Quick Link.
» The Add a Quick Link dialog box appears.
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3. Enter the required information.

Field Description

URL Enter the address of the web page that you want to be able to quickly
access from the My Quick Links card.

Text to Display Enter the text that you want to show in place of the address on the My
Quick Links card.

Open in New
Tab

o If you want the web page to open in the same browser tab, clear the
checkbox.

o If you want the web page to open in a new browser tab, select the
checkbox.

4. Click Save.
» The link is shown on the My Quick Links card.

Tip You can edit, rearrange, or delete the quick link.

Edit a quick link
You can edit the links on the My Quick Links card on the Homepage.

Steps

1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Edit.
3. Click next to the link that you want to edit.

» The Edit Quick Link dialog box appears.
4. Enter the required information.

Field Description

URL Enter the address of the web page that you want to be able to quickly
access from the My Quick Links card.
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Field Description

Text to Display Enter the text that you want to show in place of the address on the My
Quick Links card.

Open in New
Tab

o If you want the web page to open in the same browser tab, clear the
checkbox.

o If you want the web page to open in a new browser tab, select the
checkbox.

5. Click Save.
6. On the My Quick Links card, click Save.

» The edited link is shown on the My Quick Links card.

Tip You can rearrange or delete the quick link.

Rearrange a quick link
You can change the position of the links on the My Quick Links card on the Homepage.

Steps

1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Edit.
3. Hover your pointer over the link whose position you want to change.
4. Drag to the position where you want the link to be shown.

5. Click Save.
» The link is rearranged.

Delete a quick link
You can delete the links on the My Quick Links card on the Homepage.
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Steps

1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Edit.
3. Click next to the links that you want to delete.

4. Click Save.
» The links are no longer shown on the My Quick Links card.

Importing and exporting
The import and export functionality in Collibra Data Intelligence Cloud are useful to
respectively quickly add or update content and to transfer data to an external file or
system.

Importing
The import functionality allows you to create or edit data in bulk in Collibra Data
Intelligence Cloud.

By importing, you can create and edit communities, domains, assets, mappings or
complex relations and their characteristics such as attributes, relations and tags from a
view.
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Tip
l For importing complex relations using an Excel file, see the knowledge base
on the Collibra Support Portal.

l If you want to edit a lot of assets in one go, you can perform the so-called
export/import roundtrip. First create a view that contains all the assets and
characteristics that you want to edit, then export the assets from that view.
You can then edit the exported file, and import the assets back into the same
view. Collibra will automatically map the characteristics during the import,
implementing your changes.

l You can also use the import functionality for integrations and synchronization
with external systems. Instead of manually importing and exporting assets,
you can use the Import REST API to automate the workflow. Visit the
Developer Portal to learn more.

For example, you can use the import functionality to do the following:

l Create assets in a new or existing domain.
l Add and edit characteristics of existing assets.
l Edit the display name or full name of existing assets.
l Move assets to a new or existing domain.

Note
l Importing assets and complex relations is restricted by the file upload settings,
which define the maximum file size, allowed file extensions and maximum
amount of uploads and downloads per day. Contact Collibra support if you
want to change the file upload settings. The default maximum file size is 512
MB.

l When importing a very large Excel file, you may encounter an error with the
file being too large. If this is the case you will need to split the file into multiple
smaller files or use CSV.

l Importing data from a large Excel file can consume a lot of memory. We
advise you to import from CSV instead of Excel, or to limit the Excel file to only
contain the data you really need.

Import responsibilities

You can import responsibilities along with your assets. To do so, you map table headers in
your import files to the applicable role in the same way as you map attributes. You will
need to map your responsibilities during the import process for them to be included.
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If you wish to import responsibilities then you will need Asset responsibilities support
setting enabled.

You will also need to add the required user IDs or group IDs to the corresponding role in
the file (one ID per row) and save it.

If you want to ensure you have the right format for import then you can export the asset
table, ensuring you add the required role column to the view first.

Tip You can find the required IDs from the relevant table, e.g. the user IDs from the
Users table and the group IDs from the Groups table. These will be labeled on their
respective tables as Resource ID.

Difference between the old and new import process
There are a number of differences and improvements between the old (v1) and new (v2)
import process.

Scenario Old (v1) import process New (v2) import process

You don’t provide an
asset type for the
import.

The asset type defaults
to Business Asset on
import.

There is no default. You'll see an error mes-
sage and the import is canceled.

You start the import
from a domain page
but do not specify the
domain in the import
file.

The import defaults to
the current domain.

No default domain is assumed, and the import
will be unable top proceed. This is to prevent
unintentional and incorrect domain imports.

Multiple relations are
imported, but they do
not all contain the full
relation information.

Any partial information is
ignored and the import
continues successfully.

An error notifies you that there is missing
information for the relations and the import is
canceled.

Your file contains
ambiguous relations,
that have no clear path
to mapping.

Relations with no clear
match are auto-mapped
to the first matching rela-
tion.

Only relations that are uniquely identified get
auto-mapped. If the is no unique identifier
then auto-mapping will not happen and you
will need to manually map the relation.
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Scenario Old (v1) import process New (v2) import process

You want to import
responsibilities with
your assets.

You cannot import
responsibilities.

You can import responsibilities if you enable
the Asset responsibilities support setting.

Your file contains
whitespace around the
content.

The content of cells is
are trimmed, so the
whitespace before and
after the content is
removed.

There is no trimming of content.

Import assets
You can import assets with the import functionality. For example, this is useful if you have
a list of business terms in Excel and you want to manage them in Collibra Data Intelligence
Cloud.

Prerequisites

l You have prepared an Excel or CSV file for upload:
o Only the essential sheets, columns and rows remain.
o Numbers that have to be interpreted as text are preceded by a single quotation
mark.

o Dates are formatted as yyyy-mm-dd.
o If you want to import responsibilities, Asset responsibilities support is
enabled.

Import using the new wizard

Tip You can import responsibilities along with your assets.
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1. Open a view.
2. Above the table, to the right, click → Assets.

» The Import dialog box appears.
3. Drag and drop the file or click Upload a file and choose the appropriate Excel or

CSV file for upload.
4. If you chose a CSV file:

a. Enter the required information.

Field Description

Column
Separator

The character used to delimit the columns in the CSV file.

Quote The character before and after a string to capture the entire cell.

Escape
Character

The character that is used to use the column separator or quote
character as plain text.

5. Click Next.
6. Manage the mapping of the fields of the import file and your Collibra resources:

a. The Import mapping dialog box appears and Collibra tries to map the table
headers in your import file to Collibra resources, based on the names of the
fields and columns.
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Number Field Description

1 Automap Button to let Collibra automatically map all table headers
in the import file to Collibra resources, based on their
names.

2 Clear Button to remove all mappings.
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Number Field Description

3 Mapping table This table enables you to map table headers in the import
file to Collibra resources.

Each row in the table has a background color to indicate
whether the table header is mapped or not.

n Green: When the table header from the import
file is mapped to a Collibra resource the row will
be highlighted in green.

n Red: After clicking the warning about unmapped
items these rows will be highlighted in red and
moved to a separate section at the bottom of the
table.

Once a table header in the unmapped section has a
mapping selected it will be moved to the green mapped
section.

You can use the Automap button to automatically map a
table header, unless you have already manually changed
the mapping. If you manually change a mapping then
auto-mapping will not longer override this selection.

An individual mapping can be cleared by using the cross
icon in the Table Headers column.

If a relation type in your file matches with multiple relation
types in Collibra then it will not be auto-mapped, meaning
you will be required to map this relation type manually.
This is to avoid any incorrect mapping.

4 Table
Headers

This column contains the field name of the table
headers in your file.

5 Collibra
 Resources

This column shows to which Collibra resource the file field
is mapped. If the field is unmapped then there is a drop
down list with the available Collibraresources . For
relations, a hierarchy is displayed.
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b. Click Automap to let Collibra map all previously unmapped columns
automatically.

c. If required, manually map columns to another resource.
d. Click Next.

» The Import options appear.
7. Enter the required information.

Setting Result

Create new assets if they
don't yet exist

If assets do not exist, Collibra creates them.

Collibra creates a new domain and top-level community if the
following conditions are met:

o You mapped columns of the import file to the domain,
domain type and community characteristics of the view.

o The columns contain a domain and/ or community name
that doesn't exist yet.

How do you want to
handle existing assets?

Choose to either:

o Delete existing assets and recreate them again based
on the file.

o Update existing assets with any new values from the
file.

How do you want to
handle existing attributes,
relations and
responsibilities that were
mapped?

Choose to either:

o Replace all existing values with the ones provided in the
file.

o Only add new values.

Delete existing assets
from the domain that are
not in the file.

Collibra deletes existing assets from a domain if they are
not in the import file. If an existing domain is referenced in
the import file, then any assets from that domain not
included in the file are also deleted. This applies to all
domains defined for relations as well.
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Setting Result

Test import Collibra first simulates an import without affecting the data
to give you an overview of how the actual import would
affect the data. After the overview, you can proceed with
the import, go back to change the options or cancel the
import.

8. Click the Test Import button.
» The test results appear.

9. If everything looks okay, click Import.
If it doesn't, click Back to change the mapping or import options.
» The import results appear.

10. Click Close.

Import using the old wizard

Note For the original import wizard, the max file size is restricted to 100 MB.

1. Open a view.
2. Above the table, to the right, click → Assets.

» The Import dialog box appears.
3. Click Select File and choose the appropriate Excel or CSV file for upload.
4. Click Next.
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5. If you chose a CSV file, do the following:
a. Enter the required information.

Field Description

Column
Separator

The character used to delimit the columns in the CSV file.

Quote The character before and after a string to capture the entire cell.

Escape
Character

The character that is used to use the column separator or quote
character as plain text.

b. Click Next.
6. Manage the mapping of the columns of the import file and the view's fields.

a. The Import mapping dialog box appears and Collibra tries to map the
columns from the import file with the Collibra resources, based on the
names of the columns and resources.

Number Field Description

1 View selector The view selector allows you to choose a view
whose characteristics will appear in the list.

Tip You can also choose All
characteristics to show all characteristics.
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Number Field Description

2 Automap Button to let Collibra automatically map all
columns from the file to Collibra resources based
on their names.

3 Clear Button to clear all mapped characteristics in the
Import Column.

4 Mapping table This table enables you to map characteristics of
the view to columns of the import file.

Each row has a background color to indicate
whether a characteristics is mapped or not.

n Dark green: The characteristic is mapped
to a column in the import file.

n Light green: The relation is mapped
partially. This means not all underlying
fields are mapped.

n White: The characteristic is not mapped.

5 Characteristic This column contains the available
characteristics. Depending on the selection in
the view selector, it contains either the
characteristics of the selected view, or all
characteristics. For relations, a hierarchy is
displayed.

6 Import Column This column should contain fields in which you can
choose columns of the import file to map to a
characteristic of the view.

b. If required, choose another view in the view selector.

Tip Choose All characteristics to show all characteristics. In most
cases, this makes it easier to map all characteristics.

c. Click Automap to let Collibra map all visible columns automatically.
d. If required, manually map columns to another characteristic.
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7. Click Next.
» The Import options appear.

8. Enter the required information.

Setting Result

Create new assets and
domains if non-existent.

If assets or domains do not exist, Collibra creates them.

Collibra creates a new domain and top-level community if the
following conditions are met:

o You mapped columns of the import file to the domain,
domain type and community characteristics of the view.

o The columns contain a domain and/or community name
that doesn't exist yet.

How do you want to
handle existing assets?

Replace them with
the new assets. (=>
delete + create)

If assets exist, Collibra deletes them first and creates them
again based on the import file.

Update the name,
properties and
attributes.

If assets exist, Collibra compares the attributes and updates
them if necessary.

How do you want to
handle mapped
attributes?

Replace them with
new attributes. (=>
delete + create)

If attributes exist, Collibra deletes them and creates them again
based on the import file.

Select this option if you want to update existing, or add new
attributes, such as a definition.
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Setting Result

Create as new
attributes.

If attributes exist, Collibra creates another instance of the
attributes based on the import file.

Select this option if you do not want to edit the existing attributes,
but always want to create new attributes. This could result in
multiple instances of the same attributes, such as a definition.

Delete existing assets
from the domain that are
not in the file.

Collibra deletes existing assets from a domain if they are
not in the import file. If an existing domain is referenced in
the import file, then any assets from that domain not
included in the file are also deleted. This applies to all
domains defined for relations as well.

Test Import Collibra first simulates an import without affecting the data
to give you an overview of how the actual import would
affect the data. After the overview, you can proceed with the
import, go back to change the options or cancel the import.

9. Click the Test Import button.
» The test results appear.

10. If everything looks okay, click Import.
If it doesn't, close the dialog box to cancel the import or click Back to change the
mapping or import options.
» The import results appear.

11. Click Close.

Import complex relations
You can import complex relations with the import functionality. For example, this is useful if
you want to create a lot of complex relations in one go.
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Prerequisites

l You have prepared an Excel file for upload:
o Only the essential sheets, columns and rows remain.
o Numbers that have to be interpreted as text are preceded by a single quotation
mark.

o Dates are formatted as yyyy-mm-dd.
o The related assets to connect for a single complex relation must be specified in
a single cell.

o Your import file has the correct structure to import complex relations.

Import using the new wizard

1. Open a view.
2. Above the table, to the right, click → Complex Relations.

» The Import dialog box appears.
3. Drag and drop the file or click Upload a file and choose the appropriate Excel file

for upload.
4. Click Next.
5. Select the Complex Relation Type from the drop down list.
6. Manage the mapping of the fields of the import file and your Collibra resources:

a. The Import mapping dialog box appears and Collibra tries to map the table
headers in your import file to Collibra resources, based on the names of the
fields and columns.
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Field Description

Automap Button to let Collibra automatically map all table headers in the import
file to Collibra resources, based on their names.

Clear Button to remove all mappings.
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Field Description

Mapping table This table enables you to map table headers in the import file to
Collibra resources.

Each row in the table has a background color to indicate whether the
table header is mapped or not.

n Green: When the table header from the import file is
mapped to a Collibra resource the row will be highlighted in
green.

n Red: After clicking the warning about unmapped items these
rows will be highlighted in red and moved to a separate
section at the bottom of the table.

Once a table header in the unmapped section has a mapping selected
it will be moved to the green mapped section.

You can use the Automap button to automatically map a table header,
unless you have already manually changed the mapping. If you
manually change a mapping then auto-mapping will not longer
override this selection.

An individual mapping can be cleared by using the cross icon in the
Table Headers column.

If a relation type in your file matches with multiple relation types in
Collibra then it will not be auto-mapped, meaning you will be required
to map this relation type manually. This is to avoid any incorrect
mapping.

Table Headers This column contains the field name of the table headers in
your file.

Collibra
 Resources

This column shows to which Collibra resource the file field is mapped.
If the field is unmapped then there is a drop down list with the available
Collibraresources . For relations, a hierarchy is displayed.

Complex
Relation Type

Select the complex relation type you want to use for mapping.

b. Click Automap to let Collibra map all previously unmapped columns
automatically.
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c. If required, manually map columns to another resource.
d. Click Next.

» The Import options appear.
7. Enter the required information.

Setting Result

Test import Collibra first simulates an import without affecting the data to
give you an overview of how the actual import would affect
the data. After the overview, you can proceed with the
import, go back to change the options or cancel the import.

8. Click the Test Import button.
» The test results appear.

9. If everything looks okay, click Import.
If it doesn't, click Back to change the mapping or import options.
» The import results appear.

10. Click Close.

Import using the old wizard

Note For the original import wizard, the max file size is restricted to 100 MB.

1. Open a view.
2. Above the table, to the right, click → Complex Relations.

» The Import dialog box appears.
3. Click Select File and choose the appropriate Excel file for upload.
4. Click Next.
5. Select the complex relation type that you want to import.
6. Click Next.
7. Manage the mapping of the columns of the import file and the view's fields.

a. The Import mapping dialog box appears and Collibra tries to map the
columns from the import file with the Collibra resources, based on the
names of the columns and resources.
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Number Field Description

1 Automap Button to let Collibra automatically map all columns
from the file to Collibra resources based on their
names.

2 Clear Button to clear all mapped characteristics in the
Import Column.

3 Mapping table This table enables you to map characteristics of the
view to columns of the import file.

Each row has a background color to indicate
whether a characteristics is mapped or not.

n Dark green: The characteristic is mapped
to a column in the import file.

n Light green: The relation is mapped
partially. This means not all underlying
fields are mapped.

n White: The characteristic is not mapped.
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Number Field Description

4 Characteristic This column contains the available
characteristics. Depending on the selection in
the view selector, it contains either the
characteristics of the selected view, or all
characteristics. For relations, a hierarchy is
displayed.

5 Import Column This column should contain fields in which you can
choose columns of the import file to map to a
characteristic of the view.

b. If required, choose another view in the view selector.

Tip Choose All characteristics to show all characteristics. In most
cases, this makes it easier to map all characteristics.

c. Click Automap to let Collibra map all visible columns automatically.
d. If required, manually map columns to another characteristic.

8. Click Next.
» The Import options appear.

9. Enter the required information.

Setting Result

Test Import Collibra first simulates an import without affecting the data to
give you an overview of how the actual import would affect
the data. After the overview, you can proceed with the
import, go back to change the options or cancel the import.

10. Click the Test Import button.
» The test results appear.

11. If everything looks okay, click Import.
If it doesn't, close the dialog box to cancel the import or click Back to change the
mapping or import options.
» The import results appear.
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12. Click Close.

Import file structure of a complex relation
You can define multiple relations with the same role.

The different assets to relate to are formatted as a comma-separated list in a single cell.

This means that:

l For every role in the complex relation type, you have to specify the Asset column. Fill
in a comma-separated list of the asset names to connect to the complex relation with
that role. If there is an asset in the import file that does not exist, it is created auto-
matically.

l If an asset name contains a comma, you can use double quotes around the asset
names to ignore the comma as a separator.
For example, to refer to an asset named last name, first name, the name has to be
written as "last name, first name".

l If your asset names have commas as well as double quotes, you can change the
standard behavior of the double quote by using a backslash (\).
For example, to refer to an asset called last name "," first name, the name has to be
written as "last name \",\" first name".

l If you specify the domain names for mapped assets, you also have to use a comma-
separated list in the Domain column, even if the domain is the same for all the
assets.

l If you have to specify the domain and community for the relation assets as well, it is
important that the size and order of the comma-separated lists for all three aspects
(asset name, domain, community) is the same.

l If the referred assets are not all in the current domain, you can specify one or more
domains to search in, by mapping the Domain characteristic to a column containing
a comma-separated list of domain names. If there is a domain in the import file that
does not exist, it is created automatically.

l If the referred domains are not all in the current community, you can specify one or
more communities to search in, by mapping the Community characteristic to a
column containing a comma-separated list of community names.
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Exporting
The export functionality makes it easy to transfer data from Collibra to an external file or
system.

You can export assets or complex relations to a CSV or XLSX file. The exported file is very
similar to the data you view in the table on the screen.

All relevant properties of a table are taken into account in an export:

l Filters: Determine which assets are exported.
l Columns: Determine which information about assets is exported.
l Sorting: Determine the order in which the assets are exported.

Export assets
You can export assets from a view. For example, this is useful if you want to create an
overview in Excel.

Steps

1. Navigate to the asset table that you want to export.
Example: Business Glossary

2. Above the table, to the right, click > Assets.

» The Export dialog box appears.
3. Enter the required information.

Field Description

View Choose the view that you want to export.

By default, your current view is filled in as view to export.

Add the char-
acteristic
needed for reim-
port. (ID,
Domain, Com-
munity, ...)

Select this option if you want to reimport the export file later.

By default, the export file only contains the characteristics that are displayed in
the view. If you select this field, the export file will contain additional columns that
are needed for the reimport.
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Field Description

Remove text
formatting

Select this option to remove any formatting of attributes in the export file.

Important When you reimport a file with this option selected, the columns are not
automatically mapped to prevent overwriting formatted text. If you manually map
the columns, you lose the text formatting

File name Type the name of the export file.

By default, the name of the export file is set to the name of the view.

File type Choose the file type of the export.

By default, the exported file type is Excel, but you can change it to CSV.

Sheet name Type the name of the sheet in the export file.

This option only appears if you select Excel as the File type.

Character
selector

Select the characters you want to use as the Separator, Quote and Escape.

This option only appears if you select Excel as the File type.

4. Click Export.
» A progress message is displayed. You can send this message to the background
by closing it.
» When the export is finished, the export file is downloaded according to the set-
tings of your web browser.

5. Close the progress message.

Note You can access the export file after finishing the export process by going to Settings
→ Activities and then clicking Results alongside the export action.

Export complex relations
You can export complex relations. They have to be represented differently in a table
structure than assets. For that reason, the export of complex relations is handled
differently.

Steps

1. Navigate to the asset table that you want to export.
Example: Business Glossary
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2. Above the table, to the right, click > Complex Relations.

» The Export dialog box appears.
3. Enter the required information.

Field Description

Complex Relation
Type

Choose the type of the complex relations that you want to export.

Add the char-
acteristic
needed for reim-
port. (ID,
Domain, Com-
munity, ...)

Select this option if you want to reimport the export file later.

By default, the export file only contains the characteristics that are displayed in
the view. If you select this field, the export file will contain additional columns that
are needed for the reimport.

Remove text
formatting

Select this option to remove any formatting of attributes in the export file.

Important When you reimport a file with this option selected, the columns are not
automatically mapped to prevent overwriting formatted text. If you manually map
the columns, you lose the text formatting

File name Type the name of the export file.

By default, the name of the export file is set to the name of the view.

File type Choose the file type of the export.

By default, the exported file type is Excel, but you can change it to CSV.

Sheet name Type the name of the sheet in the export file.

This option only appears if you select Excel as the File type.

Character
selector

Select the characters you want to use as the Separator, Quote and Escape.

This option only appears if you select Excel as the File type.

4. Click Export.
» A progress message is displayed. You can send this message to the background
by closing it.
» When the export is finished, the export file is downloaded according to the set-
tings of your web browser.

5. Close the progress message.
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Note You can access the export file after finishing the export process by going to Settings
→ Activities and then clicking Results alongside the export action.

Export dialog box for complex relations

Field Description

Complex Relation Type The complex relation type that you want to export.

Add the characteristic
needed for reimport. (ID,
Domain, Community, ...)

By default, the export file only contains the characteristics that are
displayed in the view. By selecting this check box, you can add a
column for ID characteristics. These characteristics help to identify
specific resources during an import.

Remove text formatting. By default, the export file contains the raw content of text attributes,
including text markup. By selecting this check box, you can remove most of
the text formatting from exported attributes.

If you choose to remove text formatting, it is better not to import the
unformatted text. To prevent the overwriting of formatted text, Collibra
ensures that the column names are not automatically mapped while you are
importing a file that was exported without text formatting.

File name By default, the name of the export file is set to the name of the view.
You can give the file any name you like, however.

File type By default, the exported file type is .xls, but you can change it to .csv
if you prefer.

Sheet name Name of one of the sheets in an Excel or CSV file.

Update complex relations in bulk
If you want to make changes to multiple complex relations of the same type at once, follow
these steps:

1. Export complex relations.
2. In the exported file, make the necessary changes.

Warning Do not change the ID values.
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3. Save and close the file.
4. Import the complex relations.

In the mapping step, also map the ID field to the Business Term Mapping - id
column in your exported file.

Diagrams
Diagrams allow you to show and interact with many assets and relations in an easy-to-
read way. A diagram helps you to quickly see to which other assets a specific asset is
related. Two assets are related if you can navigate from one to the other by traversing one
or more relations.

You can find a diagram in the tab pane of every asset page.

You can work with diagrams in the diagram editor, to determine how a diagram is shown.
Collibra Data Intelligence Cloud comes with several packaged diagram views for common
use cases. You can also create and share your own diagram views.

For complete information on diagrams, see the Documentation Center.

Example
The image below shows a diagram with assets, relations and complex relations.
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In this chapter

Diagram and diagram view terminology
To work with diagrams and diagram views, you have to understand the following concepts.

Concept Description

Diagram The diagram that results from applying a diagram view to a given asset. It
sometimes also called "result diagram".

Diagram view A kind of query that determines which nodes and edges have to be shown in a diagram
for a given asset.

The diagram view also determines how the nodes and edges are shown.

You can define multiple diagram views for the same asset type.

Loop A diagram view that contains a path that revisits the same node. For example,
[Business Asset] groups [Business Asset], or [Data Element] sources [Field Mapping],
[Field Mapping] targets [Data Element].

A diagram view with a loop can lead to a diagram that has very long paths.

Node In a diagram, a node is an asset or a complex relation.

Note
l The node for an asset is depicted by a rectangle.
l The node for a complex relation is depicted by a circle or a
rectangle with rounded corners.

Boxed node A node that is contained inside a boxing node. For example, a Column asset
can be boxed by a Table asset.

Boxing node A node that contains one or more boxed nodes. If it is expanded, you can see the
boxed nodes. If it is collapsed, you cannot see the boxed nodes.

For example, a Table asset can box multiple Column assets.

Locked node A collapsed boxing node that cannot be expanded.
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Concept Description

Incoming relation An incoming relation of a node is when the selected node is the tail side of the relation
type, in other words, an edge for which this node is the 'to' node.

For example, the relation [Business Term] has code / is code for [Code Value] is
incoming for a Code Value.

Outgoing relation An outgoing relation of a node is when the selected node is the head side of the
relation type, in other words, an edge for which this node is the 'from' node.

For example, the relation [Business Term] has code / is code for [Code Value] is
outgoing for a Business Term.

Edge In a diagram, an edge is a directed relation between two nodes. The word 'directed'
indicates that the direction in which the relation is used is relevant for the diagram.

An edge is normally depicted by an arrow between two nodes. The arrow points to the
'to' node. It can also be represented by means of boxing and boxed nodes, in which
one node contains the other.

Flow The entire course of nodes and edges from the start node to the end node.

Context A collection of nodes that does not belong in the flow. The nodes have an
incoming edge from a flow node. For example, nodes that represent a System
asset can be context nodes.

Overlay An overlay is a characteristic of a node that is shown in the diagram. Overlays are
added in a diagram view and can be shown or hidden via the diagram toolbar.

Traversal
strategy

The logic that describes which relations and assets are included in the dia-
gram.

Nodes and edges
Nodes and edges are the fundamental building blocks of diagrams and diagram views:

l In diagrams, nodes are rectangles or circles that represent, respectively, assets or
complex relations. Edges represent relations between assets or between assets and
complex relations.
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l In diagram views, nodes are rectangles or circles that represent, respectively, asset
types or complex relation types. Edges represent relation types between asset types
or between asset types and complex relation types.

Both nodes and edges can be represented in different ways in diagrams and diagram
views.

Relations connect assets, or assets and complex relations. In diagrams, this is
represented by edges that connect nodes. Each node can have incoming and outgoing
edges:

l An edge of a node is incoming if that node is the 'to' node of the edge. This depends
on the relation type and the direction of the edge:

o The node is the tail side of the relation type, and the edge has the role dir-
ection.

o The node is the head side of the relation type, and the edge has the co-role dir-
ection.

l An edge of a node is outgoing if that node is the 'from' node of the edge. This
depends on the relation type and the direction of the edge:

o The node is the head side of the relation type, and the edge has the role dir-
ection.

o The node is the tail side of the relation type, and the edge has the co-role dir-
ection.

Example
Consider the diagram below:

l The red node represents a Tableau Data Source asset.
l The blue node represents a Tableau Workbook asset.
l The arrow edge between the nodes represents a relation of the type "Tableau
Data Source is source of / is source for Tableau Workbook".

o The edge is outgoing for the Tableau Data Source node.
o The edge is incoming for the Tableau Workbook node.
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Node and edge styles

Edges represent relations, which in turn describe a link between assets. To represent the
meaning of those links in a diagram, edges can be represented in different ways.
Depending on the meaning of the relation, you can choose which edge style suits best.

l Arrow: The most basic way to represent an edge is by means of an arrow. This rep-
resentation is ideal for visualizing flows and causal relations.

Example

l Boxed and boxing: Many relation types are used to describe a part-whole relation,
such as "Tableau Project groups / is grouped by Report". For that reason, you can
also represent the relation between those assets as boxing nodes and boxed nodes.

A node that has an outgoing edge of the boxing style, becomes a boxing node. For
the boxed node, the same edge is an incoming edge of the boxed style. Additionally,
one boxing node could contain several boxed nodes, which have edges of their own.

Boxing nodes can be expanded or collapsed:

o An expanded boxing node shows its boxed nodes.
You can collapse them by clicking in the upper right corner of the node.

o A collapsed boxing node does not show its boxed nodes. As a consequence, if
the hidden boxed nodes have arrow edges to nodes that are not contained by
the boxing nodes, the diagram shows them as arrow edges of the boxing node.
You can expand them by clicking in the upper right corner of the node.

o A locked node is a collapsed node that cannot be expanded.
You can recognize locked boxing nodes by the in the upper right corner. You

can still explore the nodes to see the edges.
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Example

Duplicate nodes

In some cases, the same asset might be represented by more than one node. In other
words, there are two nodes representing the same asset, on the same diagram. This can
be caused by several of reasons, but the most common reason is that an asset matches
more than one node of the diagram view.

A node in a diagram view represents an asset type or a complex relation type. In the result
diagram, this node represents an asset of that asset type or an asset of a child asset type.
As a result, if a diagram view contains a node for an asset type and a node for its child
asset types, the result diagram may contain an asset of the child asset type that matches
both nodes of the diagram view. Therefore, the asset node is duplicated.
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Example
Suppose the following situation;

l The Business Process asset type has two child asset types: Business Phase
and Milestone.

l You have the following assets:
o Business Process asset: Define Strategy
o Business Phase asset: Plan
o Milestone asset: Validate Strategy

l Your assets have the following relations:
o Plan Business Phase has subprocess Define Strategy Business
Process

o Plan Business Phase has Milestone: Validate Strategy Milestone
o Define Strategy Business Process Next: Validate Strategy Milestone

l The diagram view configuration is the following:
o The Business Process node has a boxing edge: Business Process has
subprocess Business Phase.

o The Business Phase node has two boxing edges:
n Business Phase has subprocess Business Process 2
n Business Phase has Milestone

o Business Process 2 node has an arrow edge: Business Process 2 Next
Business Process 2.

This leads to the following diagram view:

Because the Business Process asset type has two child asset types that are also on
the diagram view, the result diagram can have duplicate nodes. In the example
below, the Validate Strategy asset, of the Milestone asset type, is represented by
two separate nodes.

Because Milestone is a child asset type of Business Process, Milestone assets can
match both Milestone nodes and Business Process nodes. Furthermore, the
Validate Strategy Milestone asset has two separate incoming edges:

l The Plan Business Phase has Validate Strategy Milestone, with the boxing
style.
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l The Define Strategy Business Phase asset Next Validate Strategy, with the
arrow style.

Therefore, the Validate Release Strategy Milestone node is duplicated:

Diagram layouts
Diagram layouts determine the location of nodes and edges in a diagram, but do not
change which nodes and edges are shown.

You can select a diagram layout in the diagram toolbar.

Diagram layout Description

Flow / Context Nodes and edges are shown in a flow and a context region.

In the flow region, nodes are shown mostly from left to right.

The context region is shown above the flow region. The edges that begin or end with a
node in the context region are shown with less emphasis (thinner and light gray). You
can choose which nodes are in the context region by selecting the Context checkbox in
the node properties form.

If there are no nodes in the context region, this layout produces the same result as
Hierarchy left -> right.

Note For an edge between a flow node and a context node, the 'from' node
must be in the flow region and the 'to' node in the context region.

Hierarchy left -
right

Nodes and edges are shown in a flow, predominantly from left to right. This is
the default layout.

Hierarchy top -
down

Nodes and edges are shown in a flow, from top to bottom.

247



Diagram layout Description

Hierarchy bot-
tom - up

Nodes and edges are shown in a flow, from bottom to top.

Circular Nodes and edges are arranged in a circular fashion.

Boxing nodes are not supported in this layout, therefore:

l The diagram is completely redrawn.
l The explored nodes are removed from the diagram.
l The nodes expand or collapse to their initial state.
l Returning to a layout that supports boxing nodes completely redraws the
diagram.

Radial Nodes and edges are shown in a radial fashion, with no overlaps, few edge crossings
and few bends.

Boxing nodes are not supported in this layout. This has the same consequences as
described for the Circular layout.

Smart Organic Nodes and edges are distributed in a well-balanced manner, with few edge
crossings.

Traversal strategies
A traversal strategy determines which nodes and edges are traversed and displayed in a
diagram.

The diagram view determines the initial traversal strategy, but you can select another one
in the diagram toolbar.

Chapter 4
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Traversal
strategy

Description

End-to-end For the start node, Collibra Data Intelligence Cloud traverses the relations of the types
that occur in the diagram in all directions, incoming and outgoing, and adds all the
nodes and edges that it encounters to the diagram.

For each encountered node, Collibra traverses the relations only in the same direction
as that in which they were encountered. If a node was encountered while traversing an
outgoing relation, Collibra looks for outgoing relations of that node and vice versa. This
behavior is like traversing a hierarchy.

This is the default traversal strategy.

Upstream For the start node, only the incoming edges are traversed and shown.

For each node encountered, only the incoming edges are traversed.

Downstream For the start node, only the outgoing edges are traversed and shown.

For each node encountered, only the outgoing edges are traversed.

Complete For the start node, the relations are traversed in both directions. All encountered nodes
and edges are added to the diagram.

For each encountered node, both incoming and outgoing edges are traversed.
Essentially, this means that each encountered node is treated as a start node.

Warning This strategy can result in a very large diagram that can take a long
time to load.

Diagram editor
The diagram editor allows you to view and edit diagrams.

249



Chapter 4

250



Chapter 4

No Name Description

1 View title The name and description of the current diagram view.

You can select a different view from a list of pinned and applicable views for an
asset of this type. You can open the list of views when you click the view name
and then Show all.

2 Diagram toolbar The toolbar to work with the diagram.

3 View bar menu The buttons to manage the diagram view.

4 The button to create a new diagram view, starting from the selected
node.

5 The button to edit the current diagram view.

6 The button to edit the name and description of the current diagram
view.

7 The button to save the diagram view as a new view.

8 The button to share the diagram view.

9 The button to delete the diagram view.

10 Diagram This is the actual depiction of the traceability of the current asset,
according to the selected diagram view.

11 Overview ( ) The box to zoom and navigate a diagram that is too large to fit the screen.

You can move it to anywhere in the diagram.

251



No Name Description

12 Legend The legend explains the color codes and symbols of the items in the diagram.
You can move it to anywhere in the diagram.

For each asset type and complex relation type that is visible on the diagram,
the legend shows the color and symbol, followed by the name of the type.

If all occurrences of a given type are boxed inside collapsed boxing nodes,
that type is not visible and therefore, not shown in the legend.

Tip Click a row in the legend to select all occurrences of that type in
the diagram. You can use this to expand or collapse all nodes of the
same type.

13 Preview panel The preview panel with information about the selected node.

Diagram toolbar
The toolbar of the diagram editor helps you to edit settings that apply to the entire diagram.

Button Name Description

Layout Select a layout. The layout determines the location of nodes and
edges, but does not change which nodes and edges are shown.

Traversal
strategy

Select a traversal strategy to change which nodes and edges are
shown in the diagram.

Flow depth Specify the flow depth, meaning the flow relation path length
from the start flow node set to any other flow node.

Business
qualifier

Filter a diagram to contain only assets that are qualified by a chosen
business qualifier.

Zoom in Zoom in on the diagram.

Zoom out Zoom out of the diagram.
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Button Name Description

Zoom to
readable
value

Zoom the diagram to a size that is readable.

Shrink to fit Zoom the diagram to a size that fits the screen.

Overview Show or hide the overview inset that enables you to zoom and
navigate.

Labels Show or hide the labels of the edges and complex relations.

Overlays Show or hide overlays for all nodes in the diagram.

If the view does not have any defined overlays, the button is grayed
out.

Export Export the diagram as a PDF or SVG file to your default down-
loads folder.

Redraw Discard all the changes that you made to the diagram and
restore it to the initial state.

Legend Show or hide the legend panel containing the explanation of the
nodes.

The legend explains the color codes and symbols of the items in the
diagram. You can move it to anywhere in the diagram.

For each asset type and complex relation type that is visible on the
diagram, the legend shows the color and symbol, followed by the
name of the type.

If all occurrences of a given type are boxed inside collapsed boxing
nodes, that type is not visible and therefore, not shown in the legend.

Tip Click a row in the legend to select all occurrences of that
type in the diagram. You can use this to expand or collapse all
nodes of the same type.
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Button Name Description

Preview Show or hide the preview panel on the right side of the screen.
It contains information about the characteristics of the currently
selected node (asset or complex relation).

Filter Enable or disable all filters in the diagram view.

If the view does not have any defined filters, the button is grayed out.

Picture Create a picture based on the diagram.

Find Find a node in the diagram.

Fullscreen Show the current diagram in full-screen mode. The button
changes to , to exit full-screen mode.

The diagram preview panel
The preview panel offers a quick overview of the node that you select in the diagram. The
content of the preview panel depends on the type of node that you select in the diagram:

Assets Complex relations

l Breadcrumbs
l Name of the asset
l Asset type code or icon, as described in Edit
an asset type's representation.

Tip You can hover over the code or
icon to view the asset type.

l Status
l Created on
l Last modified
l All assigned characteristics
l Tags

l All assigned characteristics
l Last modified by (user), with date and time
l Created by (user)
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To open or close the diagram preview panel

1. Open a diagram.
2. On the diagram toolbar, click .

3. Optionally, click the node that you want to preview.
» The preview panel appears or disappears.

Working with diagrams
The diagram is a feature to show and interact with many assets and relations in an easy-
to-read diagram. The diagram helps you to quickly see to which other assets a specific
asset is related. Two assets are related if you can navigate from one asset to another by
traversing one or more relations.

Summary diagrams
Depending on the diagram view, diagrams can contain a large number of nodes and
edges. Opening a diagram with many nodes can take a long time. All nodes and edges are
important to render the diagram correctly, but you don't always need to see every single
node. Often, the diagram is only used to show the high-level outcome.

Summary diagrams contain high-level nodes that are locked. Locked nodes are boxing
nodes that cannot be expanded. The low-level boxed nodes and their edges are taken into
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account to show the edges of the locked nodes, but the diagram requires less loading
time.

Example
The following example shows a summary diagram that contains two locked nodes,
representing System assets. These System assets can have a lot of relations. In a
regular diagram this would take a lot of time to load. However, because these nodes
are locked on this summary diagram, it loads faster.

Open a diagram
You can open a diagram of an asset to visualize its relations.

Steps

1. Open an asset page.
2. In the tab pane, click Diagram.

» The diagram appears in the default diagram view.
3. If necessary, select a different diagram view.

Tip If a diagram exceeds the size or time limit set by your administrator, an error
notification is shown. In this case, you can try to edit the diagram view to reduce the
number of nodes and edges or ask your administrator to increase the diagram limits.
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Open another node's diagram
You can open a diagram for another node in the diagram you have currently open. This
action also opens the asset page of the selected node.

Tip You can return to the initial diagram by using the back button of your browser.

Steps

1. Open a diagram.
2. Select a node.
3. In the context menu, point to Start here.

» The available diagram views appear.
4. Click one of the diagram views.

Clicking Start here opens another node's diagram in the same diagram view.
» The diagram view of selected node's asset page appears.

Open a business qualifier diagram
You can open a business qualifier diagram, meaning a diagram that contains only assets
or complex relations that are qualified by a chosen Business Qualifier asset.

Prerequisites

l The Diagrams Business Qualifier Filter is enabled in Collibra Console.
l A Filtering by business qualifier option (either Optional or Mandatory) is selected for
at least one node in the selected diagram view.

l Either the start node is a Business Qualifier asset, or both of the following are true:
o The start node matches a view node that has a Filtering by business qualifier
option (either Optional or Mandatory) selected.

o The start node has at least one Business Qualifier path.
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Steps

1. Open the asset page of a Business Qualifier asset.
2. In the tab pane, click Diagram.

» The diagram appears in the default diagram view.
3. If necessary, select a different diagram view.

» The diagram view must be a business qualifier view, meaning a view with at least
one node for which a Filtering by business qualifier option is selected.

4. In the Diagram toolbar, click , to enable all filters in the diagram view.

5. In the Business Qualifier drop-down list, select the relevant Business Qualifier asset.
» The diagram is filtered to contain only the assets or complex relations that are
qualified by the selected Business Qualifier asset.

Open an asset page from a diagram
You can open an asset page while you are viewing a diagram without closing it.

Steps

1. Open a diagram.
2. Right-click the node of which you want to view the asset page.
3. In the context menu, click Open in new tab.

» The asset page opens on the diagram page.

Find node in a diagram
You can search a diagram for a specific node.

Steps

1. Open a diagram.
2. On the toolbar, click .

» The search box appears.

3. Start typing in the search box.
» The counter next to the search box indicates how many matches are found.
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» The first match is selected in the diagram.

Tip You can use the arrows to navigate between the matches.

Export a diagram
You can export a diagram to a PDF or SVG file.

Steps

1. Open a diagram.
2. Make the necessary changes to the diagram.

a. Select a view.
b. Select a layout.
c. Select a traversal strategy.
d. Filter by business qualifier. See Work with filters in a diagram view.
e. Adjust the flow depth.
f. Zoom in or out.
g. Explore nodes.
h. Expand or collapse nodes.
i. Trace a path between nodes.
j. Move nodes, enable or disable labels, the legend, and so on.

3. On the toolbar, click and select PDF or SVG.

» The resulting file is automatically downloaded to your default downloads folder.
» The default file name is diagram.pdf or diagram.svg.

Start a workflow for a node in the diagram
You can start a workflow from nodes in a diagram, if the workflow is assigned to the
relevant asset type.
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Steps

1. Open a diagram.
2. Select a node.
3. In the context menu, point to Actions.

» A submenu appears with the available workflows.
4. Click the workflow that you want to start.

Note
o Workflows that have already been started are not listed.
o If there are no workflows available, Actions is grayed out.

Edit a diagram
You can edit a diagram to represent the nodes as clearly as possible.

Steps

1. Open a diagram.
2. Make the necessary changes to the diagram.

a. Select a view.
b. Select a layout.
c. Select a traversal strategy.
d. Filter by business qualifier. See Work with filters in a diagram view.
e. Adjust the flow depth.
f. Zoom in or out.
g. Explore nodes.
h. Expand or collapse nodes.
i. Trace a path between nodes.
j. Move nodes, enable or disable labels, the legend, and so on.

Select a diagram layout

You can select a diagram layout to change the way nodes are shown in a diagram.
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Steps

1. Open a diagram.
2. On the toolbar, click the layout box and select a layout.

Diagram layout Description

Flow / Context Nodes and edges are shown in a flow and a context region.

In the flow region, nodes are shown mostly from left to right.

The context region is shown above the flow region. The edges that begin or end
with a node in the context region are shown with less emphasis (thinner and light
gray). You can choose which nodes are in the context region by selecting the
Context checkbox in the node properties form.

If there are no nodes in the context region, this layout produces the same result
as Hierarchy left -> right.

Note For an edge between a flow node and a context node, the 'from'
node must be in the flow region and the 'to' node in the context region.

Hierarchy left -
right

Nodes and edges are shown in a flow, predominantly from left to right.
This is the default layout.

Hierarchy top -
down

Nodes and edges are shown in a flow, from top to bottom.

Hierarchy bot-
tom - up

Nodes and edges are shown in a flow, from bottom to top.

Circular Nodes and edges are arranged in a circular fashion.

Boxing nodes are not supported in this layout, therefore:

o The diagram is completely redrawn.
o The explored nodes are removed from the diagram.
o The nodes expand or collapse to their initial state.
o Returning to a layout that supports boxing nodes completely redraws
the diagram.
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Diagram layout Description

Radial Nodes and edges are shown in a radial fashion, with no overlaps, few edge
crossings and few bends.

Boxing nodes are not supported in this layout. This has the same consequences
as described for the Circular layout.

Smart Organic Nodes and edges are distributed in a well-balanced manner, with few
edge crossings.

Tip You can go back to the initial diagram by clicking . Keep in mind that all your
changes are discarded if you do this.

Select a traversal strategy

You can select a traversal strategy to determine which nodes and edges are traversed and
displayed in a diagram.

Note If you change the traversal strategy, the diagram is completely redrawn and
explored nodes are removed.

Steps

1. Open a diagram.
2. On the diagram toolbar, click the traversal strategy box and select a traversal

strategy.
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Traversal
strategy

Description

End-to-end For the start node, Collibra Data Intelligence Cloud traverses the relations of the
types that occur in the diagram in all directions, incoming and outgoing, and adds
all the nodes and edges that it encounters to the diagram.

For each encountered node, Collibra traverses the relations only in the same
direction as that in which they were encountered. If a node was encountered
while traversing an outgoing relation, Collibra looks for outgoing relations of that
node and vice versa. This behavior is like traversing a hierarchy.

This is the default traversal strategy.

Upstream For the start node, only the incoming edges are traversed and shown.

For each node encountered, only the incoming edges are traversed.

Downstream For the start node, only the outgoing edges are traversed and shown.

For each node encountered, only the outgoing edges are traversed.

Complete For the start node, the relations are traversed in both directions. All encountered
nodes and edges are added to the diagram.

For each encountered node, both incoming and outgoing edges are traversed.
Essentially, this means that each encountered node is treated as a start node.

Warning This strategy can result in a very large diagram that can take a
long time to load.

Adjust the flow depth in a diagram

To help you control the size of business diagrams, you can adjust the flow depth, the flow
relation path length from the start flow node set to any other flow node.

Tip You can also:

l Contact Collibra support to edit system-wide maximum flow depth.
l Specify the maximum flow depth in a diagram view.
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For complete information on related terminology and functionality, see Maximum flow
depth.

Steps

1. Open a diagram view.
2. In the Flow depth field of the diagram toolbar, enter a value between 0 and 99.
3. Click Save.

Working with the diagram overview inset

The overview inset of the diagram editor allows you to keep an overview of the complete
diagram, while the main screen is showing only a section of it.

Steps

1. Open a diagram.
2. On the toolbar, click the to show or hide the overview inset.

» The overview inset is shown over the diagram. You can still see the diagram
underneath.

3. Perform one of the following steps:

Action Descriptions

Zoom in or out
by scaling:

a. Move your mouse pointer over the lower right corner of the blue
square, until it turns into a sleek slanted arrow.

b. Click and hold, then drag the pointer to zoom in or out.
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Action Descriptions

Navigate in the
diagram:

a. Move your mouse pointer over the blue square. The pointer turns into
a four-way arrow.

b. Click and hold, then drag the pointer to move the square to what you want to
see.

Zoom in or out in the diagram editor

When working with diagrams, you can zoom in or out in different ways.

Steps

1. Open a diagram.
2. Perform one of the following steps:

Strategy Description

Zoom in or out with but-
tons.

On the toolbar, click (Zoom in) or (Zoom out) as needed.

Zoom in or out by
scrolling with your mouse.

Move your mouse pointer to anywhere on the diagram and use
your mouse wheel to zoom. The zoom is centered at the mouse
pointer.
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Strategy Description

Zoom in or out by scaling. a. On the toolbar, click the button (Overview).

An overview inset with a miniature version of the entire dia-
gram is shown in the top right corner. The section of the dia-
gram that is shown on the screen is visible as a blue
rectangle on the overview.

b. Move your mouse pointer over the lower right corner of the
blue rectangle, until it turns into a sleek slanted arrow.

c. Click and hold, then drag the pointer to zoom in or out.

Zoom to readable value. On the toolbar, click .

Adapt the diagram to fit in
the view.

On the toolbar, click .

Explore nodes in a diagram

For each node in a diagram, there might be relations that are not depicted in the diagram.
This is the case if the type of relation is not in the diagram view or the relation is not
traversed due to the selected traversal strategy.

You can still add these relations and their nodes to the diagram, by 'exploring' the node.

Tip To remove the relations that you added to a node by using the explore mode,
right-click the node and click Remove explored.
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Steps

1. Open a diagram.
2. Select a node.
3. In the context menu, point to Explore.

» A submenu appears with the available relation types, and a count of how many
relations exists for this type.

4. Click one of the relation types or group of relation types:

Mode Description

All Explore all relation types of the selected node.

Clicking Explore in the context menu has the same result.

Incoming Explore all incoming relations of the selected node.

A relation is considered incoming when the selected node is the tail side of the
relation type.

For example, the relation [Business Term] has code / is code for [Code Value] is
incoming for a Code Value.

Outgoing Explore all outgoing relations of the selected node.

A relation is considered outgoing when the selected node is the head side of the
relation type.

For example, the relation [Business Term] has code / is code for [Code Value] is
outgoing for a Business Term.

Any specific
relation type

Explores the relations of the selected relation type.

Expand or collapse nodes

If a node has an outgoing edge with the boxing style, it becomes a boxing node. Your
diagram view determines whether boxing nodes are expanded or collapsed by default.
Your diagram view can also lock collapsed nodes, which means that you cannot expand
the collapsed boxing node.
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Tip Though you cannot expand locked nodes, you can explore them to see their
boxed nodes.

Steps

1. Open a diagram.
2. Do one of the following:

o Select a node.
o Select multiple nodes by holding down the select key and clicking nodes.

On a macOS system On a Windows system

Click the first one and then hold down
cmd while clicking on the next ones.

Click the first one and then hold down
ctrl while clicking on the next ones.

o In the legend, click the asset type or complex relation type that you want to
expand or collapse. You have now selected all nodes of this type.

3. Do one of the following:
o In the node, click or .
o In the context menu of a node, click Expand/Collapse selected.

Trace all paths between nodes in the diagram

You can trace all paths between any number of nodes on the diagram, which means you
can show the relations between the nodes.

You can trace a path between nodes in the following ways:

l The highlight mode: Keep the whole diagram and highlight the nodes and edges on
the path.

l The crop mode: Remove any node or edge that is not on the path.

Chapter 4

268



Chapter 4

Steps

1. Open a diagram.
2. Select one, two or more nodes in the diagram:

On a macOS system On a Windows system

Click the first one and then hold down cmd
while clicking on the next ones.

Click the first one and then hold down ctrl
while clicking on the next ones.

3. Do one of the following:
o To keep the whole diagram and highlight the path, right-click one of the selec-
ted nodes and click Trace path → Highlight.

o To remove anything that is not part of the path between the two selected
nodes, right-click one of the nodes and click Trace path → Crop.

» If you selected a single node, all relations are traced.
» If you selected multiple nodes, the path between the selected nodes is traced.
» If there is no path between the nodes, a message is displayed.

Move a node in the diagram

If you want a node to be in a different location in the diagram, you can easily move it
around.

Steps

1. Open a diagram.
2. Click a node and hold down your mouse button. To select multiple nodes, do the

same but select multiple nodes.

On a macOS system On a Windows system

Click the first one and then hold down cmd
while clicking on the next ones.

Click the first one and then hold down ctrl
while clicking on the next ones.

3. Move the node to where you want it and release the mouse button.

Note You cannot save the these changes, but you can create a picture or export
the diagram with these changes.
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Diagram views
In this section, you can find more information about what you can do with diagram views.

Create a diagram view
You can create your own diagram views:

l From scratch.
l From an existing view.

Create a diagram view from scratch

1. Open an asset page.
2. In the tab pane, click Diagram.

» The diagram appears in the default diagram view.
3. Click to add a new view.

4. Edit the diagram view.

Create a diagram view from an existing view

1. Open an asset page.
2. In the tab pane, click Diagram.

» The diagram appears in the default diagram view.
3. If required, select another diagram view.
4. Click .

» The Save view as dialog box appears.
5. Enter the required information.

Field Description

Name* Type a name for the diagram view.

Description Type a description for the diagram view.
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Field Description

Sharing options This section determines who has access to this diagram view.

Public Select to share this diagram view with all users.

Private Select to share this diagram view with no one.

Share with
specific
roles,
groups &
users

Select to choose with whom to share the diagram view.

Roles Select or type the roles whose users you want to give access.

Groups Select or type the groups whose users you want to give access.

Users Select or type the users to whom you want to give access.

Promote

Default Select to use this diagram view as the default view when you open the
diagram editor.

Pin Select to pin the diagram view.
Pinned diagram views appear in the view selection drop-down list.

Fields marked with a * are mandatory.

6. Edit the diagram view.

Open a diagram view
You can open a diagram view to view the diagram of an asset.
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Steps

1. Open an asset page.
2. In the tab pane, click Diagram.

» The diagram appears in the default diagram view.
3. If necessary, select a different diagram view.

Tip If a diagram exceeds the size or time limit set by your administrator, an error
notification is shown. In this case, you can try to edit the diagram view to reduce the
number of nodes and edges or ask your administrator to increase the diagram limits.

Note
l If the diagram depth is limited by a specified maximum flow depth value, a
notification informs you that the diagram is incomplete.

l It’s possible that an asset type or characteristic that is referenced in a diagram
view was deleted from your Collibra environment by another user. In this case,
an error message appears and the invalid asset type or characteristic is
amended with the word “Invalid”, so that you can easily identify it and edit the
diagram view as necessary.

Select a diagram view
To select to a different diagram view, follow these steps:
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1. Open a diagram view.
2. Do one of the following:

Select a pinned
view:

Click the current view name and select a view from the list of pinned views.

Show me where to click.

Select an
unpinned view:

a. Click the current view name and click Show all... at the bottom.
b. Click on a view in the list of views that apply to an asset of this type.

Note It’s possible that an asset type or characteristic that is referenced in a
diagram view was deleted from your Collibra environment by another user. In this
case, an error message appears and the invalid asset type or characteristic is
amended with the word “Invalid”, so that you can easily identify it and edit the
diagram view as necessary.

Edit the name and description of a diagram view
You can edit the name and the description of a diagram view.

Steps

1. Open a diagram view.
2. Click .

» The Edit name and description dialog box appears.
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3. Enter the required information.

Field Description

Name Type a name for the diagram view.

The default name is the name of the diagram view and a date stamp.

Description Type a description for the diagram view.

4. Click Save.

Edit a diagram view
You can edit a diagram view.

Steps

1. Open a diagram view.
2. Click .

» The General properties form appears.
3. Edit the general properties as required.
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Field Description

Layout Select the layout of your diagram view.

Diagram lay-
out

Description

Flow / Con-
text

Nodes and edges are shown in a flow and a context region.

In the flow region, nodes are shown mostly from left to right.

The context region is shown above the flow region. The edges that
begin or end with a node in the context region are shown with less
emphasis (thinner and light gray). You can choose which nodes are in
the context region by selecting the Context checkbox in the node
properties form.

If there are no nodes in the context region, this layout produces the
same result as Hierarchy left -> right.

Note For an edge between a flow node and a context node,
the 'from' node must be in the flow region and the 'to' node in
the context region.

Hierarchy left
- right

Nodes and edges are shown in a flow, predominantly from left
to right. This is the default layout.

Hierarchy top
- down

Nodes and edges are shown in a flow, from top to bottom.

Hierarchy bot-
tom - up

Nodes and edges are shown in a flow, from bottom to top.

Circular Nodes and edges are arranged in a circular fashion.

Boxing nodes are not supported in this layout, therefore:

o The diagrampicture is completely redrawn.
o The explored nodes are removed from the diagrampicture.
o The nodes expand or collapse to their initial state.
o Returning to a layout that supports boxing nodes com-

pletely redraws the diagrampicture.
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Field Description

Diagram lay-
out

Description

Radial Nodes and edges are shown in a radial fashion, with no overlaps, few
edge crossings and few bends.

Boxing nodes are not supported in this layout. This has the same
consequences as described for the Circular layout.

Smart
Organic

Nodes and edges are distributed in a well-balanced manner,
with few edge crossings.
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Field Description

Traversal
strategy

Indicates which nodes and edges have to be traversed and displayed.

Traversal
strategy

Description

End-to-end For the start node, Collibra Data Intelligence Cloud traverses the
relations of the types that occur in the diagram in all directions,
incoming and outgoing, and adds all the nodes and edges that it
encounters to the diagram.

For each encountered node, Collibra traverses the relations only in
the same direction as that in which they were encountered. If a node
was encountered while traversing an outgoing relation, Collibra looks
for outgoing relations of that node and vice versa. This behavior is
like traversing a hierarchy.

This is the default traversal strategy.

Upstream For the start node, only the incoming edges are traversed and
shown.

For each node encountered, only the incoming edges are traversed.

Downstream For the start node, only the outgoing edges are traversed and shown.

For each node encountered, only the outgoing edges are traversed.

Complete For the start node, the relations are traversed in both directions. All
encountered nodes and edges are added to the diagram.

For each encountered node, both incoming and outgoing edges are
traversed. Essentially, this means that each encountered node is
treated as a start node.

Warning This strategy can result in a very large diagram
that can take a long time to load.

Overview Select to show the overview inset in the initial diagram.

Labels Select to show the edge and node labels in the initial diagram.

Legend Select to show the legend in the initial diagram.

Preview Select to show the preview in the initial diagram.
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Max node label
length

Type the maximum number of characters for node labels. If a label is longer than
this value, it is truncated.

Type 0 if you always want to show the entire label.

The default setting is 50.

Max edge label
length

Type the maximum number of characters for edge labels. If a label is longer than
this value, it is truncated.

Type 0 if you always want to show the entire label.

The default setting is 30.

4. Select a node.
» The Node properties form appears.

5. Edit the node properties as required.

Field Description

General This section allows you to edit the general properties of the selected node.

Tip Click it to collapse and expand this section.

Name Type a name for the selected node.

Tip By default, this is the name of the asset type or complex relation
type. For readability, it is recommended to use the name of the asset
type or complex relation type.

You can refer to this node by using its ID in the from and to fields of the edge
properties form.

This ID must be unique in the current diagram view.

Type Choose an asset type.

By default, this is the asset type of the selected node.
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Field Description

Display name Choose the characteristic to use as the display name of the node in the
diagram.

If you leave this field empty, the node shows the name of the asset or the
name of the complex relation. You can also choose a characteristic, for
example, attribute or relation.

The drop-down displays all the characteristics that apply.

Tip You can filter the list by starting to type.

Overlays Choose fields that you want to show on the node. For example, you can show
characteristics, the status or the parent domain.

The drop-down displays all the fields that you can show.

Tip You can filter the list by starting to type.

Context Select to place the node in the context region of the diagram.

If not selected, the node is placed in the flow region.

Note This influences the traversal strategy: an edge from a flow node
to a context node is always included in the diagram. This edge has to
be outgoing from the flow node and incoming to the context node. This
means that, when you switch a node from flow to context, you have to
flip any edge that is outgoing from this context node and incoming to a
flow node. For more information about the traversal strategy, see
Which nodes and edges are included in a diagram?.

Boxing nodes
options

The options to determine how you want to show boxed nodes by default.

Tip The start node is always visible in the diagram, even when it is
boxed inside of a collapsed or locked node.

Expanded Select to show boxing nodes and their boxed nodes.

Collapsed Select to show boxing nodes, but not their boxed nodes. In the resulting
diagram, you can expand these boxing nodes.
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Collapsed
(hide boxed
nodes)

Select to show boxing nodes, but not their boxed nodes. In the resulting
diagram, these nodes are locked, so you cannot expand them.

Tip
o Diagrams with locked nodes are also called summary
diagrams.

o The boxed nodes of a locked node are not loaded when you
open the diagram. As a consequence, opening the diagram
may be a lot faster if some of the boxing nodes are locked.

o You can still explore locked nodes to see the boxed nodes.

Edges This section allows you to add, edit and delete the edges.

Tip Click it to collapse and expand this section.

Outgoing

<outgoing
edges>

The outgoing edges that currently exist.

Add Click to add an outgoing edge.

Incoming

<incoming
edges>

The incoming edges that currently exist.

Add Click to add an incoming edge.

Filters This section allows you to work with filters.

Tip Click it to collapse and expand this section.

Filtering by
business
qualifier

Enable users to filter diagrams by a chosen Business Qualifier asset.

This feature is only available if it is enabled in Collibra Console.
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<existing
filters>

The filter criteria that currently exist.

Add filter
criteria

Click to create a filter.

6. Select an edge.
» The Edge properties form appears.

7. Edit the edge properties as required.

Field Description

Relation type Select a relation type to define the relation type of the currently selected edge.

The drop-down list shows all available directed relation types.

Role direction Indicates the direction in which instances of this relation type are traversed.

o Selected: The edge is traversed from head to tail. The edge label is
the role of the relation type.

o Cleared: The edge is traversed from tail to head. The edge label is the
co-role of the relation type.

from Select the node from which the edge starts.

In the drop-down list of nodes, the nodes that match the current type of edge are
shown first (under Matching types). Nodes that do not match the current type are
shown after the matching types (under All types). It is also indicated if the node is
already in the diagram (on diagram).

A matching node is (a parent of) the head asset type of the current relation type
(when Role direction is selected) or (a parent of) the tail asset type of the relation
type (when Role direction is cleared).

Selecting a node that is already in the diagram view adds this edge to that node.

Selecting a node that is not yet in the diagram view adds this node to the view.
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to Select the node in which the edge ends.

You must select an ID from the drop-down list of nodes. The list contains nodes
that match the current type of edge.

A matching node is (a parent of) the tail asset type of the current relation type
(when Role direction is selected) or (a parent of) the head asset type of the
relation type (when Role direction is cleared).

Selecting a node that is already in the diagram view adds this edge to that node.

Selecting a node that is not yet in the diagram view adds this node to the view.
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Field Description

Style Select the style of the edge.

o Arrow: An arrow from the outgoing side to the incoming side. The
pointer is on the incoming side of the arrow. This is the default setting.
Example
Business Asset is the selected node.

o Boxed: The node on the outgoing side is enclosed by the node on the
incoming side.
Example
Business Asset is the selected node. It is boxed by Employee.

o Boxing: The node on the outgoing side encloses the node on the
incoming side.
Example
Business Asset is the selected node. It is boxing Employee.

Label Type a label for the edge.

If you do not specify a label, either the role or co-role name of the relation type
from the operating model is used in both the diagram view and the diagram.

If the Role direction check box is selected, the label is the role of the relation. If it
is cleared, it uses the co-role.

8. Click Save.
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The General properties form

The General properties form is used to define the overall look and feel of your diagram.

This pane appears when you edit a diagram view and you have not selected a node or
edge.
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Field Description

Layout Select the layout of your diagram view.

Diagram lay-
out

Description

Flow / Context Nodes and edges are shown in a flow and a context region.

In the flow region, nodes are shown mostly from left to right.

The context region is shown above the flow region. The edges that begin or
end with a node in the context region are shown with less emphasis
(thinner and light gray). You can choose which nodes are in the context
region by selecting the Context checkbox in the node properties form.

If there are no nodes in the context region, this layout produces the same
result as Hierarchy left -> right.

Note For an edge between a flow node and a context node, the
'from' node must be in the flow region and the 'to' node in the
context region.

Hierarchy left -
right

Nodes and edges are shown in a flow, predominantly from left to
right. This is the default layout.

Hierarchy top
- down

Nodes and edges are shown in a flow, from top to bottom.

Hierarchy bot-
tom - up

Nodes and edges are shown in a flow, from bottom to top.

Circular Nodes and edges are arranged in a circular fashion.

Boxing nodes are not supported in this layout, therefore:

l The diagrampicture is completely redrawn.
l The explored nodes are removed from the diagrampicture.
l The nodes expand or collapse to their initial state.
l Returning to a layout that supports boxing nodes completely
redraws the diagrampicture.

Radial Nodes and edges are shown in a radial fashion, with no overlaps, few edge
crossings and few bends.

Boxing nodes are not supported in this layout. This has the same
consequences as described for the Circular layout.
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Diagram lay-
out

Description

Smart Organic Nodes and edges are distributed in a well-balanced manner, with
few edge crossings.

Traversal
strategy

Indicates which nodes and edges have to be traversed and displayed.

Traversal
strategy

Description

End-to-end For the start node, Collibra Data Intelligence Cloud traverses the relations
of the types that occur in the diagram in all directions, incoming and
outgoing, and adds all the nodes and edges that it encounters to the
diagram.

For each encountered node, Collibra traverses the relations only in the
same direction as that in which they were encountered. If a node was
encountered while traversing an outgoing relation, Collibra looks for
outgoing relations of that node and vice versa. This behavior is like
traversing a hierarchy.

This is the default traversal strategy.

Upstream For the start node, only the incoming edges are traversed and shown.

For each node encountered, only the incoming edges are traversed.

Downstream For the start node, only the outgoing edges are traversed and shown.

For each node encountered, only the outgoing edges are traversed.

Complete For the start node, the relations are traversed in both directions. All
encountered nodes and edges are added to the diagram.

For each encountered node, both incoming and outgoing edges are
traversed. Essentially, this means that each encountered node is treated
as a start node.

Warning This strategy can result in a very large diagram that can
take a long time to load.

Overview Select to show the overview inset in the initial diagram.
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Field Description

Labels Select to show the edge and node labels in the initial diagram.

Legend Select to show the legend in the initial diagram.

Preview Select to show the preview in the initial diagram.

Max node label
length

Type the maximum number of characters for node labels. If a label is longer than this
value, it is truncated.

Type 0 if you always want to show the entire label.

The default setting is 50.

Max edge label
length

Type the maximum number of characters for edge labels. If a label is longer than this
value, it is truncated.

Type 0 if you always want to show the entire label.

The default setting is 30.

The Node properties form

The Node properties form is used to define a node in the diagram view and the edges that
are connected to it.

This pane appears when you edit a diagram view and you have selected a node.

Field Description

General This section allows you to edit the general properties of the selected node.

Tip Click it to collapse and expand this section.
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Name Type a name for the selected node.

Tip By default, this is the name of the asset type or complex relation type.
For readability, it is recommended to use the name of the asset type or
complex relation type.

You can refer to this node by using its ID in the from and to fields of the edge
properties form.

This ID must be unique in the current diagram view.

Type Choose an asset type.

By default, this is the asset type of the selected node.

Display name Choose the characteristic to use as the display name of the node in the diagram.

If you leave this field empty, the node shows the name of the asset or the name of the
complex relation. You can also choose a characteristic, for example, attribute or
relation.

The drop-down displays all the characteristics that apply.

Tip You can filter the list by starting to type.

Overlays Choose fields that you want to show on the node. For example, you can show
characteristics, the status or the parent domain.

The drop-down displays all the fields that you can show.

Tip You can filter the list by starting to type.

Chapter 4

288



Chapter 4

Field Description

Context Select to place the node in the context region of the diagram.

If not selected, the node is placed in the flow region.

Note This influences the traversal strategy: an edge from a flow node to a
context node is always included in the diagram. This edge has to be outgoing
from the flow node and incoming to the context node. This means that, when
you switch a node from flow to context, you have to flip any edge that is
outgoing from this context node and incoming to a flow node. For more
information about the traversal strategy, see Which nodes and edges are
included in a diagram?.

Boxing nodes
options

The options to determine how you want to show boxed nodes by default.

Tip The start node is always visible in the diagram, even when it is boxed
inside of a collapsed or locked node.

Expanded Select to show boxing nodes and their boxed nodes.

Collapsed Select to show boxing nodes, but not their boxed nodes. In the resulting diagram, you
can expand these boxing nodes.

Collapsed
(hide boxed
nodes)

Select to show boxing nodes, but not their boxed nodes. In the resulting diagram,
these nodes are locked, so you cannot expand them.

Tip
l Diagrams with locked nodes are also called summary diagrams.
l The boxed nodes of a locked node are not loaded when you open
the diagram. As a consequence, opening the diagram may be a lot
faster if some of the boxing nodes are locked.

l You can still explore locked nodes to see the boxed nodes.

Edges This section allows you to add, edit and delete the edges.

Tip Click it to collapse and expand this section.

Outgoing
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<outgoing
edges>

The outgoing edges that currently exist.

Add Click to add an outgoing edge.

Incoming

<incoming
edges>

The incoming edges that currently exist.

Add Click to add an incoming edge.

Filters This section allows you to work with filters.

Tip Click it to collapse and expand this section.

Filtering by
business
qualifier

Enable users to filter diagrams by a chosen Business Qualifier asset.

This feature is only available if it is enabled in Collibra Console.

<existing
filters>

The filter criteria that currently exist.

Add filter
criteria

Click to create a filter.

The Edge properties form

The Edge properties form is used to define edges in the diagram view.

This pane appears when you edit a diagram view and select an edge.

Field Description

Relation type Select a relation type to define the relation type of the currently selected edge.

The drop-down list shows all available directed relation types.
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290



Chapter 4

Field Description

Role direction Indicates the direction in which instances of this relation type are traversed.

l Selected: The edge is traversed from head to tail. The edge label is the role
of the relation type.

l Cleared: The edge is traversed from tail to head. The edge label is the co-
role of the relation type.

from Select the node from which the edge starts.

In the drop-down list of nodes, the nodes that match the current type of edge are shown
first (under Matching types). Nodes that do not match the current type are shown after
the matching types (under All types). It is also indicated if the node is already in the
diagram (on diagram).

A matching node is (a parent of) the head asset type of the current relation type (when
Role direction is selected) or (a parent of) the tail asset type of the relation type (when
Role direction is cleared).

Selecting a node that is already in the diagram view adds this edge to that node.

Selecting a node that is not yet in the diagram view adds this node to the view.

to Select the node in which the edge ends.

You must select an ID from the drop-down list of nodes. The list contains nodes that
match the current type of edge.

A matching node is (a parent of) the tail asset type of the current relation type (when
Role direction is selected) or (a parent of) the head asset type of the relation type
(when Role direction is cleared).

Selecting a node that is already in the diagram view adds this edge to that node.

Selecting a node that is not yet in the diagram view adds this node to the view.
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Style Select the style of the edge.

l Arrow: An arrow from the outgoing side to the incoming side. The pointer is
on the incoming side of the arrow. This is the default setting.
Example
Business Asset is the selected node.

l Boxed: The node on the outgoing side is enclosed by the node on the
incoming side.
Example
Business Asset is the selected node. It is boxed by Employee.

l Boxing: The node on the outgoing side encloses the node on the incoming
side.
Example
Business Asset is the selected node. It is boxing Employee.

Label Type a label for the edge.

If you do not specify a label, either the role or co-role name of the relation type from the
operating model is used in both the diagram view and the diagram.

If the Role direction check box is selected, the label is the role of the relation. If it is
cleared, it uses the co-role.
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Edges

In a diagram, an edge is a directed relation between two nodes. The word 'directed'
indicates that the direction in which the relation is used is relevant for the diagram.

An edge is normally depicted by an arrow between two nodes. The arrow points to the 'to'
node. It can also be represented by means of boxing and boxed nodes, in which one node
contains the other.

Actions

l Add an edge to a node.
l Edit an edge.
l Remove an edge of a node.

Add an edge in a diagram view

You can add an edge to a node in a diagram view.

Steps

1. Open a diagram view.
2. Click .

» The General properties form appears.
3. Select a node in the diagram.

» The Node properties form appears.
4. In the Node properties form, go to the Edges section.
5. Perform one of the following steps:

o Under Outgoing, click Add.
This adds an edge starting from the selected node.

o Under Incoming, click Add.
This adds an edge ending in the selected node.
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6. Define the edge characteristics:

Edge char-
acteristic

Description

Relation Type Choose a relation type from the list of applicable types.
Start typing to reduce the list.

Role direction Choose in which direction to traverse a relation.
For example, [Business asset] groups/is grouped by [Business Asset], if you
select the Role direction option, you traverse in the role direction, meaning from
parent to child. If you don't select this option, you traverse in the co-role direction,
meaning from child to parent.

to Choose the type of node (asset or complex relation) from the list of types. The
dropdown first shows node types that match the relation type, but also allows you
to choose a node whose type does not match the relation type. You can select a
new node, or a node that already exists on the diagram.
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Edge char-
acteristic

Description

Style Select the style of the edge.

o Arrow: An arrow from the outgoing side to the incoming side. The
pointer is on the incoming side of the arrow. This is the default setting.
Example
Business Asset is the selected node.

o Boxed: The node on the outgoing side is enclosed by the node on the
incoming side.
Example
Business Asset is the selected node. It is boxed by Employee.

o Boxing: The node on the outgoing side encloses the node on the
incoming side.
Example
Business Asset is the selected node. It is boxing Employee.

7. Click Add.
8. Optionally, edit the edge.

Tip This allows you to edit the label of the edge.

9. Above the diagram, to the right, click Save.
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Edit an edge in a diagram view

You can edit an edge of a node in a diagram view.

Steps

1. Open a diagram view.
2. Click .

» The General properties form appears.
3. Perform one of the following steps:

o Select an edge in the diagram.
o Select a node in the diagram and click next to an incoming or outgoing edge

in the edge section.
» The Edge properties form appears.

4. Enter the required information.

Field Description

Relation type Select a relation type to define the relation type of the currently selected edge.

The drop-down list shows all available directed relation types.

Role direction Indicates the direction in which instances of this relation type are traversed.

o Selected: The edge is traversed from head to tail. The edge label is
the role of the relation type.

o Cleared: The edge is traversed from tail to head. The edge label is the
co-role of the relation type.

from Select the node from which the edge starts.

In the drop-down list of nodes, the nodes that match the current type of edge are
shown first (under Matching types). Nodes that do not match the current type are
shown after the matching types (under All types). It is also indicated if the node is
already in the diagram (on diagram).

A matching node is (a parent of) the head asset type of the current relation type
(when Role direction is selected) or (a parent of) the tail asset type of the relation
type (when Role direction is cleared).

Selecting a node that is already in the diagram view adds this edge to that node.

Selecting a node that is not yet in the diagram view adds this node to the view.
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to Select the node in which the edge ends.

You must select an ID from the drop-down list of nodes. The list contains nodes
that match the current type of edge.

A matching node is (a parent of) the tail asset type of the current relation type
(when Role direction is selected) or (a parent of) the head asset type of the
relation type (when Role direction is cleared).

Selecting a node that is already in the diagram view adds this edge to that node.

Selecting a node that is not yet in the diagram view adds this node to the view.
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Style Select the style of the edge.

o Arrow: An arrow from the outgoing side to the incoming side. The
pointer is on the incoming side of the arrow. This is the default setting.
Example
Business Asset is the selected node.

o Boxed: The node on the outgoing side is enclosed by the node on the
incoming side.
Example
Business Asset is the selected node. It is boxed by Employee.

o Boxing: The node on the outgoing side encloses the node on the
incoming side.
Example
Business Asset is the selected node. It is boxing Employee.

Label Type a label for the edge.

If you do not specify a label, either the role or co-role name of the relation type
from the operating model is used in both the diagram view and the diagram.

If the Role direction check box is selected, the label is the role of the relation. If it
is cleared, it uses the co-role.

5. Above the diagram, to the right, click Save.
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Remove an edge in a diagram view

You can remove an edge of a node in a diagram view.

Steps

1. Open a diagram view.
2. Click .

» The General properties form appears.
3. Select a node in the diagram.

» The Node properties form appears.
4. Perform one of the following steps:

o Click next to an incoming or outgoing edge in the edge section.
o Select an edge in the diagram and click in the upper right corner.

5. Above the diagram, to the right, click Save.

Maximum flow depth

Big diagrams can have very long paths, or chains of edges. They can take a long time to
build, and are canceled if they exceed specified time and size limits for fetching data.

To help you control the size of diagrams, you can specify the maximum flow depth,
meaning the flow relation path length from the start flow node set to any other flow node.
This aims to improve readability and performance, and reduce the potential for diagrams
that are too big to build.

Terminology and details

Terminology Description

Flow node A diagram node that matches a diagram view node that is not marked as context.

This means that the "context" checkbox is not selected and, therefore, the node is
situated in the flow region of the diagram.

When the start node is a flow node, the start flow node set is only the start asset.
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Context node A diagram node that matches a diagram view node that is marked as context.

This means that the "context" checkbox is selected and, therefore, the node is situated
in the context region of the diagram.

When the start node is a context node, the start flow node set is all assets and complex
relations that are reachable from the start node by traversing only "flow-context" and
"context-context" edges.

Start flow node set The merge of all start node sets of each diagram view node that it matches.

When the start node matches multiple diagram view nodes, the start flow node set is
the merge of all start node sets of each view node that it matches.

Flow depth The flow relation path length from the start flow node set to any other flow node.

Flow edge An edge for which both nodes are flow nodes.

Note Maximum flow depth is ignored when traversing edges that are not flow
edges. "Flow-context" edges and "context-context" edges are ignored in order to
maximize context, which reduces diagram size and improves readability.

Specifying the maximum flow depth

You do not have to enable this feature. You can, however, edit the system-wide maximum
flow depth in Collibra Console. This establishes a maximum flow depth for all diagrams.
The default value is 50.

You can also specify the maximum flow depth at the diagram view level. If you specify a
value in a diagram view, that value supersedes the system-wide value in Collibra Console.

Adjusting flow depth in a diagram

We refer to a result diagram whose depth is limited by a specified maximum flow depth
value as an "incomplete diagram". When an incomplete diagram is opened, a notification
informs you that the diagram is incomplete. You can manually adjust the flow depth in the
diagram, to view nodes that are hidden at greater depths.
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Note When you open a diagram, the value shown in the diagram toolbar is the
value that was set for the selected diagram view? If no value is set at the diagram
view level, the value shown is the value that is set in Collibra Console.

Limitations

It bears mentioning that limiting flow depth does not prevent all diagrams from becoming
too big to build. It can be that a single node has a large number of related assets, for
example a Schema asset that contains 10,000 Table assets. In this case, the flow depth is
only "1", but the diagram will "fan out" and might become too big to build.

Specify maximum flow depth

To help you control the size of business diagrams, you can specify the maximum flow
depth in a diagram view.

There are two ways to do so:

l Via the diagram editor
l Via the JSON text editor

Tip You can also adjust the flow depth in a result diagram.

Note The value that you specify in the diagram view supersedes the value in
Collibra Console. The default value in the Collibra Console configuration setting is
50.

Via the diagram editor
1. Open a diagram view.
2. In the View bar menu, click .

» The General properties form appears.
3. In the Flow depth field, enter a value between 0 and 99.
4. Click Save.
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Via the JSON text editor
1. Open a diagram view.
2. In the View bar menu, click .

» The General properties form appears.
3. Click the Text tab, to switch to the diagram view text editor.
4. Scroll down and add "flowDepth": x, where "x" is the maximum flow depth.

5. Click Save.

Tip For more information on working with the diagram view text editor see:

l JSON syntax: Nodes section
l Tips for creating correct diagram views with the JSON text editor

Detailed description of JSON syntax for diagram views

A diagram view can be described by a file in a specific JavaScript Object Notation (JSON)
format.

To design diagram views in JSON text format, it is important that you know the information
in this section.

The examples of JSON code in the following sections are key-value pairs that you can use
to create a diagram view.
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JSON syntax: Diagram section

These settings determine general display settings for the diagram.
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JSON syntax Description

"visitStrategy": "directed", "dir-

ectedIncoming",

"directedOutgoing","completeGraph"

l Indicates which nodes and edges have to
be traversed and displayed.

l This setting is optional.
l You can choose one of the following val-
ues:
l "directed": For the start node,

Collibra traverses the relations in all
directions and adds all the nodes that
it finds. For the encountered nodes,
Collibra traverses relations only in the
same direction as how they are
encountered: if a node was
encountered by traversing an out-
going relation, Collibra looks for out-
going relations, and vice versa. This
behavior is similar to traversing a hier-
archy.
This is the default setting.

For a refinement to this strategy, see also

the setting for layoutRegion.

l "completeGraph": All nodes and

edges related to the current asset are
displayed, irrespective of the direction
in which they were encountered.

l "directedIncoming":For the

start node, Collibra only traverses the
incoming relations and adds all the
nodes that it encounters. For the
encountered nodes, Collibra traverses
relations only in the same direction as
how they are encountered: incoming
relations only.

l "directedOutgoing": For the

start node, Collibra only traverses the
outgoing relations and adds all the
nodes that it encounters. For the
encountered nodes, Collibra traverses
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relations only in the same direction as
how they are encountered: outgoing
relations only.

Be careful with using completeGraph, this

setting can lead to very large diagrams.

"resultNodeUnicityStrategy": "mul-

tipleNodesPerAssetId",

"singleNodePerAssetId"

l Indicates the number of times a node is
displayed if it matches multiple nodes in
the diagram view.

l This setting is optional.
l You can pick one of the following values:

l

"multipleNodesPerAssetId":

If an asset is encountered more than
once for different nodes in the dia-
gram view, it is represented by mul-
tiple nodes in the diagram, one per
matching view node.
This is the default setting.

l "singleNodePerAssetId": If

an asset is encountered more than
once for different nodes in the dia-
gram view, it is represented by a
single node in the diagram.

Note If one asset is encountered
multiple times for the same node in the
diagram view, it is always displayed only
once in the diagram. In that situation,
there is a loop for that node.
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"layout": "HierarchyLeftRight",

"HierarchyTopBottom", "Hier-

archyBottomTop", "Circular",

"SmartOrganic", "Radial", "Flow/Con-

text"

l Indicates the layout style of the diagram.
l This setting is optional.
l You can pick one of the following values:

l "HierarchyLeftRight":

Nodes and edges are displayed in a
flow mostly from left to right. This is
the default setting.

l "HierarchyTopBottom":

Nodes and edges are displayed in a
flow mostly from top to bottom.

l "HierarchyBottomTop": Nodes

and edges are displayed in a flow
mostly from bottom to top.

l "Circular": Nodes and edges are

arranged in a radial tree, where all
nodes with the same number of edges
to a given node are drawn in a circle.

l "SmartOrganic": Nodes and

edges are distributed in a well-bal-
anced manner, there are minimal
edge crossings.

l "Radial": Nodes and edges are

displayed with no overlaps, few edge
crossings and few bends.

l "Flow/Context": Layout style for

diagrams with a flow and a context
region. See also layoutRegion in

the nodes section. Nodes and edges
in the flow region are displayed mostly
from left to right. The nodes and
edges in the context region are dis-
played above the flow region. An edge
that begins or ends with a context
node, is shown with less emphasis
(thinner and in light gray) than an
edge between two flow nodes. If you
specify this layout, keep in mind that
for an edge between a flow node and
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a context node, the from node has to
be in the flow region and the to node
has to be in the context region.

"showOverview": false, true l Indicates if the overview is displayed.
l This setting is optional.
l You can pick one of the following values:

l false: The overview is not dis-

played. This is the default setting.
l true: The overview is displayed.

"showLabels": false, true l Indicates if the edge and node labels are
displayed.

l This setting is optional.
l You can pick one of the following values:

l false: The overlays are not dis-

played. This is the default setting.
l true: The overlays are displayed.

"showLegend": false, true l Indicates if the diagram legend is dis-
played. The legend shows all asset types
and complex relation types that occur in
the diagram.

l This setting is optional.
l You can pick one of the following values:

l false: The legend is not displayed.
l true: The legend is displayed. This

is the default setting.

"showPreview": false, true l Indicate if the preview pane is displayed
by default. The preview pane shows
information about the selected node or
edge.

l This setting is optional.
l You can pick one of the following values:

o false: The legend is not displayed.
o true: The legend is displayed. This

is the default setting.
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"showFields": false, true l Indicates if the overlays are displayed.
l This setting is optional.
l You can pick one of the following values:

l false: The labels are not displayed.
l true: The labels are displayed. This

is the default setting.

"maxNodeLabelLength": 0, <positive

integer number>

l Indicates the maximum length of the
node labels (whether they should be trun-
cated when they are too long).

l This setting is optional.
l You can provide 0 or a positive integer
number as the value:
l 0: Node labels are not truncated, they
are displayed in full length.

l The default setting is 50.

"maxEdgeLabelLength": 0, <positive

integer number>

l Indicates the maximum length of the
edge labels. Edge labels are truncated
when they are longer.

l This setting is optional.
l You can provide 0 or a positive integer
number as the value:
l 0: Edge labels are not truncated, they
are displayed in full length.

l The default value is 30.

"edgeBundling": false, true l Indicates whether edges of the same
type are bundled to reduce clutter.

l This setting is optional.
l You can pick one of the following values:

o false: Edges are not bundled.
o true: Edges are bundled. This is the

default setting.
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"webworkersEnabled": false, true l Indicates whether the layout-related cal-
culations can be moved to a separate
DGC service thread. This is useful for lar-
ger diagrams, so that your browser does
not freeze while rendering the diagram.

l This setting is optional.
l You can pick one of the following values:

o false: Layout-related calculations

are not moved to a separate DGC
thread of your processor.

o true: For large diagrams, layout-

related calculations are moved to a
separate DGC thread of your pro-
cessor. This is the default setting.

JSON syntax: Layout options

These options determine the layout of hierarchical diagrams.

l Flow / Context
l Hierarchy left - right
l Hierarchy top - down
l Hierarchy bottom - up
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Example

"layoutOptions": {
"compactGroups": false,
"componentArrangementPolicy": "topmost",
"edgeBends": true,
"edgeBundling": true,
"edgeToEdgeDistance": 5,
"minimumLayerDistance": "auto",
"nodeToEdgeDistance": 5,
"orthogonalRouting": true,

"preciseNodeHeightCalculation": true,
"recursiveGroupLayering": true,

"separateLayers": true,
"webWorkers": true,
"nodePlacer": {

"barycenterMode": "auto",
"breakLongSegments": "auto",
"groupCompactionStrategy": "none",
"nodeCompaction": "auto",
"straightenEdges": "auto"

}
}
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"compactGroups": true // false Group compaction reduces the number of node layers
without reversing edge directions.

The resulting layering tries to keep the layer span of a
boxing node at a minimum, while minimizing the
overall vertical space.

You can choose one of the following values:

l true: The diagram view uses as few node

layers as possible. The layers of a diagram
are also used inside a boxing node.
Example

l false: The diagram view does not try to

reduce the number of node layers. This res-
ults in separate layers inside a boxing node.
Example

Note
l This option is only applicable when
recursiveGroupLayering is set
to true.

l This option is optional.
l The default value is false.
l This option does not affect the loading
time of the diagram.
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"componentArrangementPolicy":

"topmost" // "compact"

Choose how to arrange boxed nodes that are not
connected by the arrow edge with other nodes.

This is only applicable to boxed and boxing edges.

You can choose one of the following values:

l "topmost": Vertically align the boxed

nodes with their topmost boxed node inside
the boxing node.

l Example

l "compact": Put the boxed nodes in dif-

ferent layers to reduce the size of the boxing
node. This reduces the overall diagram size.
If the diagram layout is Hierarchy left - right
or Flow / Context, the height of the diagram
will be minimized.
If the diagram layout is Hierarchy bottom - up
or Hierarchy top - down, the width will be min-
imized.

l Example
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Note
l This option is optional.
l The default value is topmost.
l This option does not affect the loading
time of the diagram.
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"edgeBends": true // false Choose whether edges can be curved and can
contain bends.

Warning When this option is false, the
edgeBundling and
orthogonalRouting options are
automatically ignored.

You can choose one of the following values:

l true: Enables edge bends.

Example

l false: Disables edge bends, edgeBund-

ling and orthogonalRouting.

Edges without bends go in a straight line from
source node to target node, and may cross
other nodes. They don’t reserve space for
edge labels.
Example
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Note
l This option is optional.
l The default value is true. 
l Choosing truemay lead to an
increased loading time of the diagram.
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"edgeBundling": true // false Choose whether arrow edges can be bundled at the
source or target node when they represent the same
incoming or outgoing relation.

Note Only one edge label is displayed for a
bundled edge.

You can choose one of the following values:

l true: Enable edge bundling.

Example

l false: Disable edge bundling.

Example

Note
l This option is optional.
l The default value is true.
l Choosing truemay lead to an
increased loading time of the diagram.
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"edgeToEdgeDistance": 5 //

"auto"

Set the minimum distance (in pixels) between two
adjacent edges in one layer.

This affects the horizontal distance if the diagram
layout is:

l Hierarchy left - right
l Flow / Context, but only for nodes in the flow

This affects the vertical distance if the diagram layout
is:

l Hierarchy top - down
l Hierarchy bottom - up
l Flow / Context, but only for nodes in the con-
text

You can choose one of the following values:

l [Any positive integer value]: Use this amount
of pixels.

l "auto": Let a layouting algorithm auto-

matically set the value.

Note
l This option is optional.
l The default value is 5.
l This option does not affect the loading
time of the diagram.
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"minimumLayerDistance":

5 // "auto"

Set the minimum distance (in pixels) between two
adjacent layers.

This affects the horizontal distance if the diagram
layout is:

l Hierarchy left - right
l Flow / Context, but only for nodes in the flow

This affects the vertical distance if the diagram layout
is:

l Hierarchy top - down
l Hierarchy bottom - up
l Flow / Context, but only for nodes in the con-
text

You can choose one of the following values:

l [Any positive integer value]: Use this amount
of pixels.

l "auto": Let a layouting algorithm auto-

matically set the value.

Note
l This option is optional.
l The default value is auto.
l This option does not affect the loading
time of the diagram.
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"nodeToEdgeDistance": 5 //

"auto"

Set the minimum distance (in pixels) between an edge
and an adjacent node in the same layer.

This affects the horizontal distance if the diagram
layout is:

l Hierarchy left - right
l Flow / Context, but only for nodes in the flow

This affects the vertical distance if the diagram layout
is:

l Hierarchy top - down
l Hierarchy bottom - up
l Flow / Context, but only for nodes in the con-
text

You can choose one of the following values:

l [Any positive integer value]: Use this amount
of pixels.

l "auto": Let a layouting algorithm auto-

matically set the value.

Note
l This option is optional.
l The default value is 5.
l This option does not affect the loading
time of the diagram.
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"orthogonalRouting": true //

false

Choose whether or not edges can be routed
orthogonally.

You can choose one of the following values:

l true: All edge segments are horizontal or

vertical.
Example

l false: Edge segments can be diagonal.

Example

Note
l This option is optional.
l The default value is true.
l This option does not affect the loading
time of the diagram.
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"preciseNodeHeightCalculation":

true // false

Determines the precision with which node heights are
rendered to visually accommodate diagram text.

l true: Each node is correctly sized to fit its

label text. For extremely large diagrams, this
can result in significantly longer loading
times.

l false: Loading times are vastly improved,

but label text might not always fit in the
nodes. When label text doesn't fit, the text is
truncated by an ellipsis. For example: "ABC_
Finance_Freq...".

Note
l This option is optional.
l The default value is true.
l Choosing truemay lead to an
increased loading time of the diagram.
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"recursiveGroupLayering": true

// false

Choose whether boxing edges are respected during
layering.

This option is ignored when the diagram does not
contain boxing nodes.

Warning Enabling this option may change
the diagram flow. Some arrow edges may go
in the opposite direction. Otherwise occupying
only adjacent layers by boxing nodes wouldn’t
be possible in some cases.

You can choose one of the following values:

l true: Boxing nodes are layered recursively:

Boxed nodes in the same boxing node always
occupy adjacent layers.
Example

l false: Group information is ignored during

the layering.
Example

Note
l This option is optional.
l The default value is true.
l Choosing truemay lead to an
increased loading time of the diagram.
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"separateLayers": true // false Strictly separate nodes of different layers. In other
words, nodes are placed below each other. This
prevents big nodes from extending into an adjacent
layer.

You can choose one of the following values:

l true: Layers are separated.

Example

l false: Layers are not separated.

Example

Note
l This option is optional.
l The default value is true.
l This option does not affect the loading
time of the diagram.
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"webWorkers": true // false Choose whether big diagrams should be built in the
background thread.

You can choose one of the following values:

l true: Enables multi-thread support for dia-

gram building.

Note This makes layout processing faster
and less likely to freeze the browser.

l false: All diagrams are built in the main

thread.

Note
l This option is optional.
l The default value is true.
l Choosing falsemay lead to an
increased loading time of the diagram.

"nodeplacer" Use additional options for placing the nodes.
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"barycenterMode": true //

false // "auto"

Choose whether the diagram should be as symmetric
as possible. This may result in more edge bends.

You can choose one of the following values:

l true: The diagram is more symmetric but

may have more edge bends.
Example

l false: The diagram is less symmetric but

may have fewer edge bends.
Example

l "auto": The layouting algorithm decides

whether this option is set to true or false,

depending on the diagram data.

Note
l This option is optional.
l The default value is auto.
l Choosing truemay lead to an
increased loading time of the diagram.
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"breakLongSegments": true

// false // "auto"

Choose whether the diagram should break long arrow
edges in favor of a more compact layout.

You can choose one of the following values:

l true: Long edges are broken, for a more

compact diagram.
Example

l false: Long edges are not broken.

Example

l "auto": The layouting algorithm decides

whether this option is set to true or false,

depending on the diagram data.

Note
l This option is optional.
l The default value is auto.
l Choosing truemay lead to an
increased loading time of the diagram.
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"groupCompactionStrategy":

"none" // "maximum"

Choose the strategy for controlling the horizontal
compactness of boxing nodes.

You can choose one of the following values:

l "none": Do not use horizontal group com-

paction. The contents of a boxing node will
occupy nearly the same horizontal positions
as when not grouped at all.
Example

l "maximum": Make boxing nodes as narrow

as possible.
Example

Note
l This option is optional.
l The default value is none.
l Choosing nonemay lead to an
increased loading time of the diagram.
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"nodeCompaction": true //

false // "auto"

Choose whether to reduce the height of the diagram
as much as possible. This places the nodes of a layer
in a stacked style (horizontally interleaving), which
reduces the width of the layer.

You can choose one of the following values:

l true: Nodes are placed in a compact style.

Note This may result in an increased
width.

Example

l false: Nodes are not placed in a compact

style.
Example

l "auto": The layouting algorithm decides

whether this option is set to true or false,

depending on the diagram data.

Note
l This option is optional.
l The default value is auto.
l This option does not affect the loading
time of the diagram.

Chapter 4

328



Chapter 4

JSON syntax with all default values Description

"straightenEdges": true

// false // "auto"

Apply a post-processing step to reduce edge bends.

You can choose one of the following values:

l true: The post-processing step is applied to

reduce edge bends.
Example

Warning This may violate some minimum
distances specified by the user and the
edge distribution may no longer be
uniform.

l false: Post-processing step is not applied.

Example

l "auto": The layouting algorithm decides

whether this option is set to true or false,

depending on the diagram data.
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Note
l This option is optional.
l The default value is auto.
l Choosing truemay lead to an
increased loading time of the diagram.

JSON syntax: Nodes section

These settings determine the display settings for nodes. You must add a node for each
asset type and complex relation type that you want to include in the diagram.

Note The JSON representation of a diagram is always automatically generated.
The JSON syntax allows you to update the diagram layout. Keep in mind that it is
much easier to add and edit overlays through the graphical diagram view editor.
See Edit a diagram view and The Node properties form.

JSON syntax Description

"id": "Business Asset" l Determines the name of the node.
l This setting is mandatory.
l You can type any string here, but it must be unique in
this view. For readability, we recommend using the
name of the asset type or complex relation type as the
ID.

l You can refer to this node by using its ID in the
"from" and "to" key-value pairs of the edges sec-

tion.
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"type": {"id": "00000000-

0000-0000-0000-

000000011001"}

l Determines the resource ID of the asset type or the
complex relation type.

l This setting is mandatory.
l You can have multiple nodes with the same Type in

one diagram view.
l The value must be a valid resource ID of an asset type
or complex relation type. See Find a resource ID of an
asset type and Find the resource ID of a complex rela-
tion.

"layoutRegion": "flow",

"context"

l Determine if the node is treated as a flow node or a con-
text node. This influences the traversal strategy. An
edge from a flow node to a context node is always
included in the diagram. An edge between two flow
nodes FN1 and FN2 is only included in the diagram if
the edge from FN1 to FN2 is traversed in the same dir-
ection as the edge that brought FN1 into the diagram.

l This setting is optional.
l You can choose one of the following values:

l "flow": The node is part of the flow. This is the

default setting.
l "context": The node is part of the context.

When you select the Flow/Context layout for a dia-
gram, the edges between flow nodes are rendered
horizontally, mostly from left to right (the from node
is to the left of the to node). The edges from flow to
context nodes are rendered vertically, from bottom
to top.

"label": "Term" l Determines the name that is displayed on the node in
the diagram design view. For a node that represents a
complex relation type, the label is used in the diagram
as well.

l This setting is optional.
l You can provide any string as the value. If you do not
specify a label, the name of the asset type or the com-
plex relation type is used.
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JSON syntax Description

"collapsed": false, true l Indicates if the selected node is collapsed in the initial
diagram.

l This setting is optional.
l You can choose one of the following values:

o false: The selected node is a boxing node and

the boxed nodes are displayed.
o true: The selected node is a boxing node and the

boxed nodes are hidden.

"name": l Defines the name that has to be displayed on the node.
By default, this is the asset's name, but you can specify
any characteristic. Use the same syntax as for
"fields".
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"fields": l Defines which characteristics are shown in the node's
overlay. The order of the fields determines the order of
the characteristics in the overlay.

l This setting is optional.
l You can pick one or more of the following values:

o "name": The asset's name, as defined in the
"name": setting.

o "status": The asset's status value.
o "domain": The domain in which the asset is located.
o "community": The lowest-level community in which
the asset is located.

o "assetType": The asset's type.

Note When filtering a diagram by asset
type, keep in mind that all subtypes are
included, meaning they pass the filter along
with the specified asset type.

o "tags": Any tags that were created for the asset.
o “responsibility_<ID>": The overlay is a resource role
type with the ID that you type here. The diagram
shows the avatars of users and user groups that
have this role for this asset.

o "createdOn": The date when the asset was created.
o "createdBy": The name of the user who created the
asset.

o "lastModifiedOn": The date and time when the
asset was last modified.

o "lastModifiedBy": The name of the user who last
modified the asset.

o "stringAttribute_<ID>": The overlay is a string attrib-
ute type with the ID that you type here. Example:
"stringAttribute_00000000-0000-0000-0000-
000000000001"

o "dateAttribute_<ID>": The overlay is a date attribute
with the ID that you type here.

o "numericAttribute_<ID>": The overlay is a date
attribute with the ID that you type here.

o "booleanAttribute_<ID>": The overlay is a boolean
attribute with the ID that you type here.
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o "singleValueListAttribute_<ID>": The overlay is a
single-selection attribute with the ID that you type
here.

o "multiValueListattribute_<ID>": The overlay is a
multi-selection attribute with the ID that you type
here.

o "dataQualityRule_<ID>": The overlay is the per-
centage score of a data quality metric group with
the ID that you type here. The score overlay shows
the percentage, the color (red/amber/green) and
trend (up/down/flat).

o "sourceRelation_<ID>": The overlay is a relation
type where the node is a tail asset and has the ID
that you type here.

o "targetRelation_<ID>": The overlay is a relation
type where the node is a head asset and has the ID
that you type here.

JSON syntax: Edges section

The edges settings determine which directed relations should be traversed, and how they
should be depicted on the diagram. Each edge represents a relation type between two
nodes (asset types or complex relation types) in the view.

You have to ensure that the diagram view is a connected graph: each node in the diagram
view is reachable from any other node.

JSON syntax Description

"from": "Business Asset" l Indicates which node is the head asset.
l This setting is mandatory.
l You must fill in a node ID ("id") from the nodes section.

"to": "Table Column1" l Indicates which node is the tail asset.
l This setting is mandatory.
l You must fill in a node ID ("id") from the nodes section.
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"type": "00000000-0000-

0000-0000-000000007038"

l Indicates the ID of the relation type.
l This setting is mandatory.
l You have to fill in the resource ID of the relevant rela-
tion type. You can copy and paste these resource IDs
from the Settings UI:
l Attribute type.
l Relation type.
l Complex relation type.

"roleDirection": true,

false

l Determines the direction of the edge; is it the role or
co-role.

l This setting is mandatory.
l You can pick one of the following values:

l true: The edge is traversed from head to tail.
l false: The edge is traversed from tail to head.

"style": "arrow", "boxed",

"boxing"

l Determines how edges are displayed.
l This setting is optional.
l You can pick one of the following values:

l "arrow": The edge is represented by an arrow.

The arrow starts at the 'from' node and ends at the
'to' node. This is the default setting.

l "boxing": The edge is represented as a 'from'

asset that boxes one or more 'to' assets. In other
words, a head asset contains one or more tail
assets.

l "boxed": The edge is represented as a 'from'

asset that is boxed by a 'to' asset. In other words, a
tail asset contains one or more head assets.

"label": "Groups" l Determines the name that is displayed on edges in the
diagram.

l This setting is optional.
l If you do not specify a label, the role or co-role of the
relation type from the operating model is used, in both
the diagram view and the diagram.
If "roleDirection" is true, Collibra uses the role,
if it is false, it uses the co-role.

335

ta_find-resource-id-attribute-type.htm
ta_find-resource-id-relation-type.htm
ta_find-resource-id-complex-relation-type.htm


Tips for creating correct diagram views with the diagram view text editor

Although you can create and edit diagram views via the text editor, we recommend that
you use the graphical view editor when possible. However, if you want to configure
advanced filter expressions for a diagram, you have to complete the configuration via the
diagram view text editor.

Each change that you make via the graphical view editor is reflected in the text editor and
vice versa.

Tips
l Collibra Data Intelligence Cloud checks the full syntax of your JavaScript Object
Notation (JSON) as you type. If the JSON code is incorrect, Collibra detects this
immediately and the Save button remains inactive.

For example:
o If you omit the required comma between two key-value pairs, Collibra shows
an error message, and highlights the offending line.

o If you make a typo in a value, Collibra shows an error and displays the allowed
values.

l JSON is a case-sensitive language. This means that you must use the exact key-
value pairs as they are described in this guide.
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l The code must contain a nodes section and an edges section. The order of the sec-
tions is irrelevant. Layout to improve readability (spaces, tabs, empty lines), is irrel-
evant.

l Collibra checks if each resource ID (conceptTypeId, binaryFactTypeId,
attributetypeID) that you specified, exists in the operating model. If a resource ID
does not exist, it is removed from the diagram view and a warning and an error are
displayed. Collibra does not save your view unless you correct the error.

l Collibra checks if the diagram view is a connected graph.
A diagram view is a connected graph when every node can be reached from any
other node by traversing the edges. If the diagram is not connected, a warning is dis-
played. Collibra does not save your view unless you correct the error.

l You can create key-value pairs with a key name that is not listed in this guide. These
key-value pairs are allowed in the code but are ignored. As such, typos in the key
names do not trigger Collibra to show a warning or error. You can use this to your
advantage, for example, to add comments to the JSON view.
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Pin a diagram view
You can pin a diagram view in the dropdown of the view selection field:

l While creating it.
l From the diagram editor.
l From the diagram view list.

Pin a view from the diagram editor

1. Open a diagram view.
2. Click .

» The Share view dialog box appears.
3. Select the Pin check box.
4. Click Save.

Pin a view from the diagram view list.

1. Open a diagram view.
2. Click the current view name and click Show all... at the bottom.

» The available views appear.
3. Click in front of the views you want to pin.

Unpin a diagram view
You can unpin a diagram view to remove it from the dropdown of the view selection field:

l In the diagram editor.
l In the diagram view list.

Unpin a view in the diagram editor

1. Open a diagram view.
2. Click .

» The Share view dialog box appears.
3. Clear the Pin check box.
4. Click Save.
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Unpin a view in the diagram view list.

1. Open a diagram view.
2. Click the current view name and click Show all... at the bottom.

» The available views appear.
3. Click in front of the views you want to pin.

Set a diagram view as default
Setting a diagram view as default for an asset means that you indicate that this diagram
view is the one to be used initially, when the users with whom you shared this diagram
view display a diagram for an instance of this asset type and all its child asset types.

Steps

1. Open a diagram view.
2. Click .

» The Share view dialog box appears.
3. Select the Default check box.
4. Click Save.

Share a diagram view
You can share a diagram view with other users or make it private.

Users with whom the diagram view is shared can only edit the diagram view if they also
have the Manage and share anyone's Views, Dashboards, Search filters permission.

Note By default, diagram views are public.

Steps

1. Open a diagram view.
2. Click .

» The Share view dialog box appears.
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3. Enter the required information.

Field Description

Sharing options This section determines who has access to this diagram view.

Public Select to share this diagram view with all users.

Private Select to share this diagram view with no one.

Share with
specific
roles,
groups &
users

Select to choose with whom to share the diagram view.

Roles Select or type the roles whose users you want to give access.

Groups Select or type the groups whose users you want to give access.

Users Select or type the users to whom you want to give access.

Promote

Default Select to use this diagram view as the default view when you open the
diagram editor.

Pin Select to pin the diagram view.

Pinned diagram views appear in the view selection drop-down list.

4. Click Save.

Work with filters in a diagram view
When you create a diagram view, you can configure filters to only keep the nodes that you
are interested in or to limit the number of nodes that are shown in a diagram.

Note Users can enable or disable all filters in the diagram toolbar.
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Steps

1. Open a diagram view.
2. Click .

» The General properties form appears.
3. Select a node in the diagram.

» The Node properties form appears.
4. In the Node properties form, go to the Filters section.
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5. Perform one of the following steps:

Action Description

Filtering by
business qualifier

Collibra versi-
on

Action

2021.01 Select the Filtering by business qualifier checkbox to filter a di-
agram to contain only the assets or complex relations that are
qualified by the chosen business qualifier.

2021.02 or ne-
wer

In the Filtering by business qualifier drop-down list, select one of the
following settings:

o Mandatory: The diagram only contains assets or complex r-
elations that match this view node and are qualified by the c-
hosen business qualifier.

o Optional: The diagram includes:
n Assets or complex relations that match this view node a-

nd are qualified by the chosen business qualifier.
n Assets or complex relations that match this view node a-

nd are not qualified by any business qualifier.

Note
o This feature is only available if it is enabled in Collibra
Console.

o You can apply filtering by business qualifier to view nodes that
represent asset types or complex relation types.
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Action Description

Add a simple fil-
ter

Select a characteristic and enter one or more values. Click Add filter criteria to
add more filter criteria.

Tip
o You can add multiple values for a characteristic. If you select
multiple values, the filter clause uses the IN operator. In other
words, any of the values is accepted.
Example:

reads Domain IN (BA Domain, Data Quality Dimensions)

o You cannot use wildcards in the value of a filter clause.
o If you use multiple filter clauses, they are always combined
with the logical AND operator. In other words, all filter clauses
have to be met.

Configure
advanced filter
expressions

See Configure an advanced filter expression in a diagram view.

Edit a filter Edit the filter criteria to match your needs.

Delete a filter Click to delete a filter criterion.

6. Above the diagram, to the right, click Save.

Configure an advanced filter expression in a diagram view

To configure advanced filter expressions for diagrams, you have to complete the
configuration via the diagram view JSON text editor.

Steps

1. Add a simple filter, as described in Work with filters in a diagram view.
2. Click the Text tab, to switch to the diagram view text editor.
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3. Find the node on which you created the simple filter and change the IN operator to
one of the following operators:
Operators for attributes kinds "text" and "plain text"

o IN
o NOT_IN
o CONTAINS
o NOT_CONTAINS
o STARTS_WITH
o NOT_STARTS_WITH
o ENDS_WITH
o NOT_ENDS_WITH

Note The operators EXISTS and NOT_EXISTS do not work in
advanced filter expressions for diagrams.

Operators for attribute kinds "date" and "number"
o IN
o NOT_IN
o LESS
o LESS_OR_EQUALS
o GREATER
o GREATER_OR_EQUALS

4. Above the diagram, to the right, click Save.

Examples and additional information

Example of a node with a filter on the Report Attribute asset type
Filtering by asset type is particularly useful for diagrams. When filtering a diagram by asset
type, keep in mind that all subtypes are included, meaning they pass the filter along with
the specified asset type.

{
"layoutRegion": "flow",
"id": "Report Attribute",
"type": {
"id": "00000000-0000-0000-0000-000000031027"

},
"filters": [
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{
"operator": "IN",
"values": [
"00000000-0000-0000-0000-000000031027"

],
"field": "assetType"

}
]

},

Example of a node with a filter on a data attribute
You have to provide the value in Unix Epoch datetime, in milliseconds. This example is for
a custom date attribute to be greater than 2020-okt-1.

{
"operator": "GREATER",
"values": [
"1601483854000"

],
"field": "dateAttribute_7ff7f6af-33d3-4fdf-8ac5-bf918606315f"

}

For more information on configuring advanced filter expressions in the diagram view text
editor, see:

l JSON syntax: Nodes section
l Tips for creating correct diagram views with the JSON text editor

Filtering by business qualifier
Filtering by business qualifier allows you to filter a diagram to contain only assets or
complex relations that are qualified by a chosen business qualifier. The difference from
traditional filtering is that the filter value is not fixed in the diagram view; instead, the user
can choose the business qualifier to filter by in the result diagram, without having to
change the view. This is a form of dynamic filtering. We refer to such a diagram as a
business qualifier diagram.

Business qualifier diagrams are smaller and load faster than "unqualified" diagrams, and
their focused qualifier makes them easier to understand.
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The following is true of every asset in a business qualifier diagram:

l Every asset matches a node in the business qualifier view.
l Every asset can be reached from the start asset by selecting the view and applying
the normal traversal strategy. In other words, the asset would be included in an ordin-
ary diagram.

l Every asset has a business qualifier path to the selected business qualifier.

For descriptions of these terms, see Terminology.

Enabling business qualifier diagrams

To view Business Qualifier diagrams, the feature has to be enabled in Collibra Console.

If enabled in Collibra Console, the Filtering by business qualifier option is shown in the
Filters section of the Node properties form, when editing a diagram view. The filter icon
appears on the nodes for which the option is selected, like on any other node for which a
filter is applied.

Note To make the feature available to users, a Filtering by business qualifier
option (either Optional or Mandatory) has to be selected for at least one view node.

Key asset type and relation types

The various business qualifiers that can "qualify" assets and complex relations in a
business qualifier diagram are represented by Business Qualifier assets.

When filtering by business qualifier, the start node can be a Business Qualifier asset, a
Column asset or a complex relation.

Business Qualifier assets

Business Qualifier assets relate to other assets by the following packaged relation type:

Head Role Co-role Tail

Business Qualifier qualifies is qualified by Asset
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Column assets

Column assets relate to Business Attribute assets that are related to Business Qualifier
assets. The packaged relation types are the following:

Head Role Co-role Tail

Business Qualifier qualifies is qualified by Data Attribute

Data Attribute groups is grouped by Column

Complex relations

When configuring business qualifier filtering for complex relations, you need to edit the
relevant complex relation type and add a relation leg pertaining to the Business Qualifier
asset.
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Terminology

Term Description

Business qualifier
view

A diagram view with at least one node for which a Filtering by business qual-
ifier option is selected.
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Term Description

Business qualifier
diagram

A diagram for which all of the following conditions are met:

l The selected diagram view is a business qualifier view.
l Filters are enabled in the diagram toolbar.
l Either the start node is a Business Qualifier asset, or both of the following
are true:
o The start node matches a view node that has a Filtering by business
qualifier option (either Optional or Mandatory) selected.

o The start node has at least one Business Qualifier path.

Business qualifier
path

An asset has a business qualifier path if either of the following is true:

l The asset has at least one relation asset qualified by a Business Qualifier
asset.

l The asset is a Column, and both:
o The Column asset is grouped by a Data Attribute asset.
o That Data Attribute asset is qualified by a Business Qualifier asset.

Configure business qualifier filtering for a complex relation

You can configure business qualifier filtering for a complex relation.

Prerequisites

l To edit a complex relation type, you need a global role that has the System admin-
istration global permission.

l The Diagrams Business Qualifier Filter is enabled in Collibra Console.

Steps

Tip See the following example for detailed instruction on how to carry out each step
in this procedure.

1. Edit the relevant complex relation type, for example Field Mapping. Specifically, you
need to add a relation leg pertaining to the Business Qualifier asset.
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2. If not already done, create the Business Qualifier asset that you will use to filter a dia-
gram.

3. Specify the Business Qualifier asset in the complex relation type.
4. Add a relation between the relevant assets.

Tip We are referring here to assets that are the head or tail of the complex
relation type legs, for example Column assets and the Business Qualifier
asset.

5. In the relevant diagram view, enable the Filtering by Business Qualifier option for
both the Column asset node and the Field Mapping complex relation node.

Show me an example
In this example, we are working with the commonly used Field Mapping complex relation
type that comes packaged with Collibra Data Intelligence Cloud. As the Field Mapping
complex relation type is often used to track the flow of metadata from source column to
target column, we also refer in this example to the Data Element asset type, which is a
parent of the Column asset type. Lastly, the Field Mapping complex relation type is, by
default, included the global role of the Data Element asset type.

1. Start by editing the Field Mapping complex relation type. Specifically, you need to
add a relation leg pertaining to a Business Qualifier asset.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. In the Operating model section, click Complex relations.
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c. In the table, find the Field Mapping row and click at the end of the row.

» The Edit Field Mapping dialog box appears.

d. At the bottom of the Relations section, click Add relation.
e. Enter the required information.

o Role: We recommend the value is qualified by, but you can enter any text
value that suits your needs.

o Asset type: Business Qualifier.
Leave the default values for the other fields as they are.

f. Click Save.
2. Let's assume that no appropriate Business Qualifier asset exists. Therefore, you

need to create one.
a. On the main toolbar, click .

» The Create dialog box appears.
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b. Click the Assets tab.

c. In the list of asset types, click Business Qualifier.
» The Create Asset dialog box appears.

d. Enter the required information.

Field Description

Type The asset type of the asset that you are creating. In this case, Business
Qualifier.

Domain The domain to which the new assets will belong. You can only create a
asset type in any domain of a domain type that is assigned to a selected
asset type.

Name The name of the new Business Qualifier asset. For our example, let's use:
BQ1.

e. Click Create.
» A message at the top-right of your screen confirms that one or more assets
are created.

3. Specify the Business Qualifier asset in the complex relation type.
a. Open one of the relevant leg assets. Let's choose one of the Column assets.
b. In the tab pane, click Details.
c. In the Field Mapping section, hover your pointer over any of the assets, and

then click .
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» The Edit Field Mapping dialog box appears. Notice that the "is qualified by"
relation leg is empty.

d. In the is qualified by field, add the Business Qualifier asset. In this example,
BQ1.

e. Click Next.
f. If necessary, add a description of the Field Mapping complex relation.
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g. Click Finish.
4. Now add a relation between a Column asset and the Business Qualifier asset.

a. Open one of the relevant Column assets.
b. In the tab pane, click Add Characteristic.

» The Add a characteristic dialog box appears.
c. Click Relations.
d. Search for and click is qualified by Business Qualifier.

» The Add is qualified by Business Qualifier dialog box appears.
e. Enter the required information.

Option Description

Assets The name of the Business Qualifier asset. In this example, BQ1.

Start date Optionally enter the date on which the relation between the assets
becomes applicable.

End date Optionally enter the date on which the relation between the assets is
no longer applicable. Leave this field empty to create a permanent
relation.

f. Click Save.
5. In the relevant diagram view, enable the Filtering by Business Qualifier option for

both the Column asset node and the Field Mapping complex relation node.
a. Open a relevant Column asset page.
b. In the tab pane, click Diagram.

» The diagram appears in the default diagram view.
c. If necessary, select a different diagram view.
d. Click .

» The General properties form appears.
e. Select a node in the diagram.

» The Node properties form appears.

Tip You need to carry out steps e-h for both the Column asset node and
the Field Mapping complex relation node.

f. In the Node properties form, go to the Filters section.
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g. Enable business qualifier filtering:

Your Collibra
version

Action

2021.01 Click the Filtering by business qualifier checkbox.

2021.02 or
newer

In the Filtering by business qualifier drop-down list, select Mandatory, so
that the diagram will only contain assets matching this view node that are
qualified by the chosen business qualifier.

h. Above the diagram, to the right, click Save.
i. In the diagram toolbar, click the Business qualifier drop-down menu and select
BQ1.

Delete a diagram view
You can delete a diagram view.

Steps

1. Open an asset page.
2. In the tab pane, click Diagrams.
3. Select the diagram view that you want to delete.
4. In the view bar, click .

5. Click Delete view.

Pictures
A picture is a copy of a diagram that is stored separately from the original. You can edit the
pictures in the same way you edit diagrams, but there are fewer options available.

Pictures are an easy way to save a diagram after you configured it. You can then reuse it
later.
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Available actions
l Create a picture.
l Open a picture.
l Edit a picture.

a. Select a layout.
b. Zoom in or out.
c. Expand or collapse nodes.
d. Trace a path between nodes.
e. Move nodes, enable or disable labels, the legend, and so on.

l Export a picture.
l Delete a picture.

Picture editor
The picture editor allows you to view and edit pictures. You can access the picture editor
by opening a picture.
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No Name Description

1 Picture name The name of the picture.

2 Picture toolbar The toolbar to work in the picture.
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No Name Description

3 View bar menu The buttons to edit the picture's name, share it or delete it.

4 Picture This is the actual depiction of the traceability of the current asset,
according to the picture you opened.

5 Overview ( ) Zoom and navigate a picture that is too large to fit the screen.

You can move it to anywhere in the diagram.

6 Legend The legend explains the color codes and symbols of the items in the picture.
You can move it to anywhere in the picture.

For each asset type and complex relation type that is visible on the picture, the
legend shows the color and symbol, followed by the name of the type.

If all occurrences of a given type are boxed inside collapsed boxing nodes,
that type is not visible and therefore, not shown in the legend.

Tip Click a row in the legend to select all occurrences of that type in
the picture. You can use this to expand or collapse all nodes of the
same type.

7 Preview panel The preview panel with information about the selected node.

8 Time stamp The date and time on which the picture was created.

Picture toolbar

The toolbar of the picture editor helps you to edit settings that apply to the entire picture.

Button Name Description

Layout Select a layout. The layout determines the location of nodes and
edges, but does not change which nodes and edges are shown.

Zoom in Zoom in on the picture.
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Button Name Description

Zoom out Zoom out from the picture.

Zoom to
readable
value

Zoom the picture to a size that is readable.

Shrink to fit Zoom the picture to a size that fits the screen.

Overview Show or hide the overview inset that enables you to zoom and
navigate.

Labels Show or hide the labels of the edges and complex relations.

Overlays Show or hide overlays for all nodes in the picture.

If the view does not have any defined overlays, the button is grayed
out.

Export Export the picture as a PDF or SVG file to your default down-
loads folder.

Redraw Discard all the changes that you made to the picture and
restore it to the initial state.

Legend Show or hide the legend panel containing the explanation of the
nodes.

The legend explains the color codes and symbols of the items in the
picture. You can move it to anywhere in the picture.

For each asset type and complex relation type that is visible on the
picture, the legend shows the color and symbol, followed by the name
of the type.

If all occurrences of a given type are boxed inside collapsed boxing
nodes, that type is not visible and therefore, not shown in the legend.

Tip Click a row in the legend to select all occurrences of that
type in the picture. You can use this to expand or collapse all
nodes of the same type.
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Button Name Description

Preview Show or hide the preview panel on the right side of the screen.
It contains information about the characteristics of the currently
selected node (asset or complex relation).

Picture Create a picture based on the picture.

Find Find a node in the picture.

Fullscreen Show the current picture in full-screen mode. The button
changes to , to exit full-screen mode.

Create a picture
You can create a picture based on a diagram.

Steps

1. Open a diagram or a picture.
2. Make the necessary changes.

a. Select a layout.
b. Zoom in or out.
c. Expand or collapse nodes.
d. Trace a path between nodes.
e. Move nodes, enable or disable labels, the legend, and so on.

3. On the toolbar, click .

» The Save diagram as picture dialog box appears.
4. Enter the required information.

Field Description

Name* Type a name for the picture.
The default name is the name of the diagram view and a date stamp.

Description Type a description for the picture.

Sharing options This section determines who has access to this picture.
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Field Description

Public Select to share this picture with all users.

Private Select to share this picture with no one.

Share with
specific
roles,
groups &
users

Select to choose with whom to share the picture.

Roles Select or type the roles whose users you want to give access.

Groups Select or type the groups whose users you want to give access.

Users Select or type the users to whom you want to give access.

Promote

Pin Select to pin the picture.
Pinned pictures appear in the view selection drop-down list.

Fields marked with a * are mandatory.

5. Click Save.
» The resulting picture appears in the Pictures section of the tab pane.

Pin a picture
You can pin a picture in the drop-down of the view selection field

l while creating it.
l from the picture editor.

Pin a view from the picture editor

1. Open a picture.
2. Click .

» The Share picture dialog box appears.
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3. Select the Pin check box.
4. Click Save.

Unpin a picture
You can unpin a picture to remove it from the drop-down of the view selection field

Unpin a picture in the picture editor

1. Open a diagram view.
2. Click .

» The Share view dialog box appears.
3. Clear the Pin check box.
4. Click Save.

Share a picture
You can share a picture with other users or keep it private.

Steps

1. Open a picture.
2. Click .

» The Share picture dialog box appears.
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3. Enter the required information.

Field Description

Sharing options This section determines who has access to this picture.

Public Select to share this picture with all users.

Private Select to share this picture with no one.

Share with s-
pecific roles-
, groups & u-
sers

Select to choose with whom to share the picture.

Roles Select or type the roles whose users you want to give access.

Groups Select or type the groups whose users you want to give access.

Users Select or type the users to whom you want to give access.

Promote

Pin Select to pin the picture.

Pinned pictures appear in the view selection drop-down list.

4. Click Save.

Open a picture
You can open a picture of a diagram of an asset to visualize its relations in the picture
editor.

Steps

1. Open an asset page.
2. In the tab pane, click Pictures.

» The picture list appears.
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3. Click a picture in the list.
» The picture is opened in the picture editor.

What's next?

You can now edit or export the picture.

Find node in a picture
You can search a picture for a specific node.

Steps

1. Open a picture.
2. On the toolbar, click .

» The search box appears.

3. Start typing in the search box.
» The counter next to the search box indicates how many matches are found.
» The first match is selected in the picture.

Tip You can use the arrows to navigate between the matches.

Edit the name and description of a picture
You can edit the name and the description of a picture.

Steps

1. Open a picture.
2. Click .

» The Edit name and description dialog box appears.
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3. Enter the required information.

Field Description

Name Type a name for the picture.
The default name is the name of the original diagram view and a date stamp.

Description Type a description for the picture.

4. Click Save.

Edit a picture
You can edit a picture to represent the nodes as clearly as possible.

Steps

1. Open a picture.
2. Make the necessary changes to the picture.

a. Select a layout.
b. Zoom in or out.
c. Expand or collapse nodes.
d. Trace a path between nodes.
e. Move nodes, enable or disable labels, the legend, and so on.

Select a picture layout

You can select a picture layout to change the way nodes are shown in a picture.

Steps

1. Open a picture.
2. On the toolbar, click the layout box and select a layout.
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Diagram layout Description

Flow / Context Nodes and edges are shown in a flow and a context region.

In the flow region, nodes are shown mostly from left to right.

The context region is shown above the flow region. The edges that begin or end
with a node in the context region are shown with less emphasis (thinner and light
gray). You can choose which nodes are in the context region by selecting the
Context checkbox in the node properties form.

If there are no nodes in the context region, this layout produces the same result
as Hierarchy left -> right.

Note For an edge between a flow node and a context node, the 'from'
node must be in the flow region and the 'to' node in the context region.

Hierarchy left -
right

Nodes and edges are shown in a flow, predominantly from left to right.
This is the default layout.

Hierarchy top -
down

Nodes and edges are shown in a flow, from top to bottom.

Hierarchy bot-
tom - up

Nodes and edges are shown in a flow, from bottom to top.

Circular Nodes and edges are arranged in a circular fashion.

Boxing nodes are not supported in this layout, therefore:

o The picture is completely redrawn.
o The explored nodes are removed from the picture.
o The nodes expand or collapse to their initial state.
o Returning to a layout that supports boxing nodes completely redraws
the picture.

Radial Nodes and edges are shown in a radial fashion, with no overlaps, few edge
crossings and few bends.

Boxing nodes are not supported in this layout. This has the same consequences
as described for the Circular layout.

Smart Organic Nodes and edges are distributed in a well-balanced manner, with few
edge crossings.

Chapter 4

366



Chapter 4

Picture layouts

Picture layouts determine the location of nodes and edges of a picture, but do not change
which nodes and edges are displayed.

You can select a picture layout in the toolbar of the picture editor.

Diagram layout Description

Flow / Context Nodes and edges are shown in a flow and a context region.

In the flow region, nodes are shown mostly from left to right.

The context region is shown above the flow region. The edges that begin or end with a
node in the context region are shown with less emphasis (thinner and light gray). You
can choose which nodes are in the context region by selecting the Context checkbox in
the node properties form.

If there are no nodes in the context region, this layout produces the same result as
Hierarchy left -> right.

Note For an edge between a flow node and a context node, the 'from' node
must be in the flow region and the 'to' node in the context region.

Hierarchy left -
right

Nodes and edges are shown in a flow, predominantly from left to right. This is
the default layout.

Hierarchy top -
down

Nodes and edges are shown in a flow, from top to bottom.

Hierarchy bot-
tom - up

Nodes and edges are shown in a flow, from bottom to top.

Circular Nodes and edges are arranged in a circular fashion.

Boxing nodes are not supported in this layout, therefore:

l The picture is completely redrawn.
l The explored nodes are removed from the picture.
l The nodes expand or collapse to their initial state.
l Returning to a layout that supports boxing nodes completely redraws the
picture.
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Diagram layout Description

Radial Nodes and edges are shown in a radial fashion, with no overlaps, few edge crossings
and few bends.

Boxing nodes are not supported in this layout. This has the same consequences as
described for the Circular layout.

Smart Organic Nodes and edges are distributed in a well-balanced manner, with few edge
crossings.

Working with the picture overview inset

The overview inset of the picture editor allows you to keep an overview of the complete
picture, while the main screen is showing only a section of it.

Steps

1. Open a picture.
2. On the toolbar, click the to show or hide the overview inset.

» The overview inset is shown over the picture. You can still see the picture under-
neath.

3. Perform one of the following steps:

Action Descriptions

Zoom in or out
by scaling:

a. Move your mouse pointer over the lower right corner of the blue
square, until it turns into a sleek slanted arrow.

b. Click and hold, then drag the pointer to zoom in or out.
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Action Descriptions

Navigate in the
picture:

a. Move your mouse pointer over the blue square. The pointer turns into
a four-way arrow.

b. Click and hold, then drag the pointer to move the square to what you want to
see.

Zoom in or out in the picture editor

When working with pictures, you can zoom in or out in different ways.

Steps

1. Open a picture.
2. Perform one of the following steps:

Strategy Description

Zoom in or out with but-
tons.

On the toolbar, click (Zoom in) or (Zoom out) as needed.

Zoom in or out by
scrolling with your mouse.

Move your mouse pointer to anywhere on the picture and use
your mouse wheel to zoom. The zoom is centered at the mouse
pointer.
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Strategy Description

Zoom in or out by scaling. a. On the toolbar, click the button (Overview).

An overview inset with a miniature version of the entire pic-
ture is shown in the top right corner. The section of the pic-
ture that is shown on the screen is visible as a blue rectangle
on the overview.

b. Move your mouse pointer over the lower right corner of the
blue rectangle, until it turns into a sleek slanted arrow.

c. Click and hold, then drag the pointer to zoom in or out.

Zoom to readable value. On the toolbar, click .

Adapt the diagram to fit in
the view.

On the toolbar, click .

Trace all paths between nodes in a picture

You can trace all paths between any number of nodes on the picture, which means you
can show the relations between the nodes.

You can trace a path between nodes in the following ways:

l The highlight mode: Keep the whole picture and highlight the nodes and edges on
the path.

l The crop mode: Remove any node or edge that is not on the path.
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Steps

1. Open a picture.
2. Select one, two or more nodes in the picture:

On a macOS system On a Windows system

Click the first one and then hold down cmd
while clicking on the next ones.

Click the first one and then hold down ctrl
while clicking on the next ones.

3. Do one of the following:
o To keep the whole picture and highlight the path, right-click one of the selected
nodes and click Trace path → Highlight.

o To remove anything that is not part of the path between the two selected
nodes, right-click one of the nodes and click Trace path → Crop.

» If you selected a single node, all relations are traced.
» If you selected multiple nodes, the path between the selected nodes is traced.
» If there is no path between the nodes, a message is displayed.

Move a node in the picture

If you want a node to be in a different location in the picture, you can easily move it around.

Steps

1. Open a picture.
2. Click a node and hold down your mouse button. To select multiple nodes, do the

same but select multiple nodes.

On a macOS system On a Windows system

Click the first one and then hold down cmd
while clicking on the next ones.

Click the first one and then hold down ctrl
while clicking on the next ones.

3. Move the node to where you want it and release the mouse button.

Note You cannot save the these changes, but you can create a picture or export
the picture with these changes.
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Expand or collapse picture nodes

If a node has an outgoing edge with the boxing style, it becomes a boxing node. Your
diagram view determines whether boxing nodes are expanded or collapsed by default.
Your diagram view can also lock collapsed nodes, which means that you cannot expand
the collapsed boxing node.

Steps

1. Open a picture.
2. Do one of the following:

o Select a node.
o Select multiple nodes by holding down the select key and clicking nodes.

On a macOS system On a Windows system

Click the first one and then hold down
cmd while clicking on the next ones.

Click the first one and then hold down
ctrl while clicking on the next ones.

o In the legend, click the asset type or complex relation type that you want to
expand or collapse. You have now selected all nodes of this type.

3. Do one of the following:
o In the node, click or .
o In the context menu of a node, click Expand/Collapse selected.

Export a picture
You can export a picture to a PDF or SVG file.

Steps

1. Open a picture.
2. Make the necessary changes to the picture.

a. Select a layout.
b. Zoom in or out.
c. Expand or collapse nodes.
d. Trace a path between nodes.
e. Move nodes, enable or disable labels, the legend, and so on.
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3. On the toolbar, click and select PDF or SVG.

» The resulting file is automatically downloaded to your default downloads folder.
» The default file name is diagram.pdf or diagram.svg.

Delete a picture
You can delete a picture

l from the picture list.
l from the picture editor.

Delete a picture from the picture list.

1. Open an asset page.
2. In the tab pane, click Pictures.

» The picture list appears.
3. At the end of a line, click .

» The Delete picture dialog box appears.
4. Click Delete picture.

Delete a picture from the picture editor

1. Open a picture.
2. In the upper right corner, click .

» The Delete picture dialog box appears.
3. Click Delete picture.

Diagram FAQ

Which nodes and edges are included in a diagram?
Collibra Data Intelligence Cloud only adds relevant relations and nodes to the diagram by
using a specific traversal strategy. The traversal strategy is the logic that describes which
relations and assets have to be included in the diagram. To understand the traversal
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strategy, it is important that you know the difference between incoming and outgoing
edges and between flow and context nodes.

From a start node, Collibra adds all the relations (both incoming and outgoing) and the
relation's node whose relation type is mentioned in the view.

When traversing further downstream from a node that is downstream from the start node,
Collibra adds all the relations and nodes that are downstream, but not the ones that are
upstream.

When traversing further upstream, Collibra adds all relations and nodes that are upstream
of that node, but not the ones that are downstream.

For the following example diagram, the view contains the Groups relation type and Four
Wheel Vehicle is the start node.

Any downstream relation of an upstream node (Vehicle, Vehicle on Wheels, ...) is
irrelevant for the diagram and thus not shown. The same traversal strategy is applied to
any node that is on the upstream side of a node that is downstream of the start node.

If you jump to Vehicle, you see that the diagram has changed for the Vehicle on Wheels
node. This node no longer has the upstream relation to object with wheels, but the relation
to Two Wheel Vehicle is added.
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Can I set a different traversal strategy for my diagram view?
All examples in this chapter, unless mentioned otherwise, use the default traversal
strategy. We call this the 'directed' traversal strategy. It can be paraphrased as 'keep on
walking and don't look back'.

You can also switch the traversal strategy to complete graph, by always looking in all
directions. Depending on your data, this could obviously lead to a much bigger diagram,
with many more nodes and edges.

Going back to the example given in the FAQWhich nodes and edges are included in a
diagram?, and applying that strategy results in the following diagram:
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Note the new upstream branch of Wheeled vehicle, which is downstream from the start
node. An upstream node in that branch, Wheeled object, has a downstream branch:
Ferris wheel.

You can switch the traversal strategy in the JSON form of the diagram view by adding the
following key-value pair to the top-level diagram section

"visitStrategy": "completeGraph".

For more information, see Diagram views.

When editing a diagram view, I can assign each node to
either the 'Flow' or 'Context' layout region. What does that
do?
The default traversal strategy ('directed') gives the required results when you depict a set
of assets that are related through some kind of (data) flow or dependency. For nodes in the
flow section, and the edges between them, you can paraphrase the ‘directed’ traversal
strategy as "keep on walking and don't look back". But when the relation represents a link
to context rather than flow, the edge between two nodes should always be traversed, even
if the related node is upstream of a downstream node, or vice versa. You can also regard
an edge between a flow node and a context node as bidirectional: it should always be
traversed.

This notion becomes clearer when you look at the following example.
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When the flow depicts transformations of table columns, the tables that contain the
columns, and the business terms that are related to them, provide context to the columns.
The context nodes are always relevant, regardless of whether the column was
encountered while going upstream or downstream. The context nodes are always added
to the diagram.

For this traversal strategy, you can assign a node in the diagram view to be a context
node.

Consider the following example diagram view:

This view contains flow only.

An example diagram for this view is below:

We started from the Order amount USD asset.

Now assume that you also want to see to which tables these columns belong.

You could add a relation from column to table to the view (in other words, a downstream
edge), but this relation would only be considered on the downstream side, and if we add
the column/table relation in the reverse direction, it would only be considered on the
upstream side. To solve this problem, we designate the Table as a context node, so that
the relation from Column to Table is always traversed, both for Columns that are
upstream as well as downstream.
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Resulting in the diagram below:
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Both upstream and downstream Columns show the Table that contains them. The edge
from Column to Table was always traversed.

What is special about the flow/context layout?
The Flow/Context layout is special because it has a specific behavior.

If you set the diagram layout to Flow/Context, the nodes that are in the Flow layout region,
also known as flow nodes, are depicted as a left-to-right hierarchy in the lower half of the
diagram. The context nodes are all in the top half of the diagram.

Note Flagging your nodes as flow or context nodes is always relevant, even when
the diagram layout is not Flow/Context. For more information about how this is
relevant, see When editing a diagram view, I can assign each node to either the
'Flow' or 'Context' layout region. What does that do? .
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Can I change the node colors and symbols that are used for
an asset type or complex relation type?
You can view and edit the color and symbol of each asset type and complex relation type
in Settings. However, you need a role that can access the Settings and the

permission to make changes to the operating model.

All assets and complex relations of the same type have the same color and symbol across
all diagrams.
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Data modeling
In this section, we describe the structure of the Collibra Data Intelligence Cloud data
model, how data is related and how you can organize your data.
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Collibra building blocks
To be able to create a decent data governance model, it is important that you understand
the basic building blocks of Collibra Data Intelligence Cloud and how they relate to each
other.

The following table lists the concepts and explains how Collibra captures information.

Concept Icon Description

Community A community is a grouping of subcommunities and domains. It often
corresponds to functional divisions in a company and works best if it is
aligned with the company's governance organization.

Domain type None A domain type defines the semantics of a domain, as a kind of template.
It defines which assets types users can create in the domain.

Domain A domain is a logical grouping of assets and belongs to exactly one community. It
has a domain type that specifies which asset types can be created in the domain.

A domain has a unique name within its community.

A domain is the instance of exactly one domain type.

Scope None A scope is a selection of communities and domains that you can assign to one or
more asset types.

In a scope, you can define amongst others a domain type, attribute types and
relation types.

Asset type None An asset type defines the semantics of an asset, as a kind of template. It defines
which attribute types and relation types the asset can have.

Scopes are assigned to asset types.
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Concept Icon Description

Asset An asset is the fundamental building block or resource for which you want to
capture information.

An asset belongs to exactly one domain and has a unique name within that
domain.

An asset is the instance of exactly one asset type.

Attribute type None An attribute type defines the class of information that an attribute
contains. It is assigned to an asset type through a scope.

Attribute None An attribute is a specific piece of information that captures information
about an asset. One asset can contain many attributes.

Relation type None A relation type specifies the type of relation between two asset types.

A relation type is bidirectional, going from a head asset type to a tail asset type
and the other way around.

Relation None A relation is a link between exactly two assets. It captures how two assets are
related to each other. One asset can have many relations.

A relation is the instance of exactly one relation type.

Complex
Relation
Type

None A complex relation type specifies the characteristics of a complex relation
instance. A complex relation is a type of relation that helps you to create
many-to-many relations, as well as capture attributes (description,
priority, ...) on top of the many-to-many relation. They can be regarded as
'objectified associations'. A complex relation type is specified by its
name, description, a collection of relation types and a collection of
attribute types.

The following diagram explains how the concepts from the table are related to each other.
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Communities
A community is a grouping of other communities and domains. It often corresponds to
functional divisions in a company and works best if it is aligned with the company's
governance organization.

Each community can contain any number of subcommunities.

You can recognize a community by the following icon: .

Note
Collibra uses some packaged communities. You can edit them, but you cannot
delete them. If required, you can hide them by restricting their view permissions.

Community name ID URL

Business Analysts
Community

00000000-0000-0000-0001-
000100000001

<your
environment>/community/00000000-
0000-0000-0001-000100000001

Data Governance Council bc40c085-352c-4a8c-8ee7-
494fe821308e

<your
environment>/community/bc40c085-
352c-4a8c-8ee7-494fe821308e

Schemas 00000000-0000-0000-0001-
000100000002

<your
environment>/community/00000000-
0000-0000-0001-000100000002

Actions
l Create a community
l Add domains to a community by creating a new domain or moving an existing
domain.

l Create a responsibility to assign a resource role to a user or group for a community.
l Edit the name of a community.
l Move a community to another parent community.
l Delete a community.
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Community page overview
The community page provides a complete overview of all information related to a
community.

Number Section Description

Breadcrumbs The breadcrumbs of the current community.

Community rep-
resentation

The icon or abbreviation of the community.

Community name The name of the community.

Resource toolbar Additional actions, such as editing the community and start-
ing a workflow.

Stewards The stewards of the community.

You can see up to three stewards on the community page. If there
are more, click See all <number> to see them on the
Responsibilities page.

Tab pane A collapsible pane that allows you to navigate to other pages of the
community and add characteristics.

Chapter 6
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Number Section Description

Editor The currently selected page, in this case the Overview page, which
contains all the attributes that have been defined for the community.

The Organization section contains a simple asset view with all the
assets in the domains of the community.

Tip If you want to copy and paste text from other sources

into a text field, we recommend that you click , and then
paste the text into the Show source code field. This will
remove any unwanted formatting or tagging of the text. For
detailed information, see the knowledge base article on
Collibra Support Portal.

Create a community
You can create a new community at the top level of your organization, or under another
community.

Steps

1. On the main toolbar, click .

» The Create dialog box appears.
2. Click the Organization tab.
3. In the Community section, click Community.

» The Create Community dialog box appears.
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4. Enter the required information.

Field Description

Community The community under which the new communities will be located.

If you leave this field empty, the communities will be located at the top level of
your organization.

Name The names of the new communities.

Tip
You can simultaneously create multiple communities.
To do so, after typing the name, press Enter, and then type the next
name. Community names must be globally unique. If you enter a name
that already exists, it appears in the strike-through style.

5. Click Create.

Edit the name of a community
You can edit the name of a community:

l From the community page.
l From an organization table.

Edit the name of a community from the community page

1. Open a community page.
2. In the resource toolbar, click Actions → Edit.

» The Edit <community name> dialog box appears.
3. Enter the required information.

Field Description

Name The name of the community.

Community names have to be globally unique.

4. Click Save.
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Edit the name of a community from an organization table

1. Open an asset page that contains an organization table, for example a community
page.

2. In the Name column, do one of the following:
o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
3. Edit the name.
4. Click .

Move a community
You can move a community to another parent community.

Note If a community is moved to a community in another scope, the assignment of
its assets may change. If moving a community causes a conflict of scopes, the
moved domain is removed from its original scope.

Steps

1. Open a community page.
2. In the resource toolbar, click Actions →Move.

» The Move <community name> dialog box appears.
3. Enter the required information.

Field Description

Community Enter the name of the new parent community.

Community names have to be unique in their parent community. If you try to
move this community to a parent community that already contains a community
with the same name, an error message will appear after clicking Save.

4. Click Save.
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Delete a community
You can delete a community.

Warning When you delete a community, you will also delete its contained views,
domains and assets.

Steps

1. Open a community page.
2. In the resource toolbar, click Actions → Delete.

» The Delete Confirmation dialog box appears.
3. Click Delete <community name>.

Domains
A domain is a logical grouping of assets. It always has a domain type and belongs to
exactly one community.

You can recognize a domain by the following icon: .

Chapter 6

390



Chapter 6

Note
Collibra uses some packaged domains. You can edit them, but you cannot delete
them. If required, you can hide them by restricting their view permissions.

Domain name Domain type ID URL

New Data Sets Data Usage
Registry

00000000-0000-0000-
0001-000200000001

<your
environment>/domain/00000000-
0000-0000-0001-000200000001

Data Quality
Dimensions

Business Asset
Domain

00000000-0000-0000-
0000-000000006019

<your
environment>/domain/00000000-
0000-0000-0000-000000006019

Issue
Classification

Issue
Classification

00000000-0000-0000-
0000-000000006011

<your
environment>/domain/00000000-
0000-0000-0000-000000006011

New
Applications

Technology
Asset Domain

00000000-0000-0000-
0000-000000006018

<your
environment>/domain/00000000-
0000-0000-0000-000000006018

New Business
Terms

Glossary 00000000-0000-0000-
0000-000000006013

<your
environment>/domain/00000000-
0000-0000-0000-000000006013

New Data
Assets

Data Asset
Domain

00000000-0000-0000-
0000-000000006015

<your
environment>/domain/00000000-
0000-0000-0000-000000006015

New Policies &
Business Rules

Governance
Asset Domain

00000000-0000-0000-
0000-000000006016

<your
environment>/domain/00000000-
0000-0000-0000-000000006016

New Processes Business Asset
Domain

00000000-0000-0000-
0000-000000006017

domain/00000000-0000-0000-
0000-000000006017

New Reference
Data

Codelist 00000000-0000-0000-
0000-000000006014

<your
environment>/domain/00000000-
0000-0000-0000-000000006014

Actions
l Create a domain.
l Edit a domain.
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l Move a domain.
l Create a responsibility to assign a resource role to a user or group for a community.
l Delete a domain.

Domain page overview
The domain page provides a complete overview of all information related to a domain.

Number Section Description

Breadcrumbs The breadcrumbs of the current domain.

Domain type rep-
resentation

The icon or abbreviation of the domain type.

Domain name The name of the domain.

Resource menu Additional actions, such as editing the domain and starting a
workflow.

Stewards The stewards of the domain.

You can see up to three stewards on the domain page. If there are
more, click See all <number> to see them on the Responsibilities
page.
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Number Section Description

Tab pane A collapsible pane that allows you to navigate to other pages of the
domain and add characteristics.

l Overview: Contains the description of and comments
about a domain.

l Assets: Displays the assets in the domain.
l Responsibilities: Displays the view permissions and the
responsibilities for a domain.

l History: Displays which user has done what with this
domain.

l Files: Contains attachments.

Editor The currently selected page, in this case the Overview page, which
contains all the attributes that have been defined for the domain.

Tip If you want to copy and paste text from other sources

into a text field, we recommend that you click , and then
paste the text into the Show source code field. This will
remove any unwanted formatting or tagging of the text. For
detailed information, see the knowledge base article on
Collibra Support Portal.

Create a domain
You can create a new domain in a community.

Steps

1. On the main toolbar, click .

» The Create dialog box appears.
2. Click the Organization tab.
3. Click a domain type from the list. To create a Process Register domain, use the Pro-

cess Register domain type.
If you selected the wrong domain type here, you can still change it in the Type field in
the next screen.
» The Create Domain dialog box appears.
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4. Enter the required information.

Field Description

Type The domain type of the domain you are creating.

This field contains the domain type that you clicked in the previous step. You can
change it if needed.

Community The community under which the domain will be located.

Name The name of the new domain.

Tip
You can simultaneously create multiple domains.
To do so, after typing the name, press Enter, and then type the next
name. Domain names must be unique in their parent community. If you
enter a name that already exists, it appears in the strike-through style.

Example

5. Click Create.

Edit a domain
You can edit the name and domain type of a domain:

l From the domain page.
l From an organization table.

Edit a domain from the domain page

1. Open a domain page.
2. In the resource toolbar, click Actions → Edit.

» The Edit <domain name> dialog box appears.
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3. Enter the required information.

Field Description

Name The name of the domain.

Domain names have to be unique in their community.

Type The domain type.

4. Click Save.

Edit a domain from an organization table.

1. Open an asset page that contains an organization table, for example, a community
page.

2. In the Name or Domain Type column, do one of the following:
o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
3. Edit the name or domain type.
4. Click .

Move a domain
You can move a domain to another community.

Note If a domain is moved to a community in another scope, the assignment of its
assets may change. If moving a domain causes a conflict of scopes, the moved
domain is removed from its original scope.

Steps

1. Open a domain page.
2. In the resource toolbar, click Actions →Move.

» The Move <domain name> dialog box appears.

395



3. Enter the required information.

Field Description

Community Enter the name of the new parent community.

Domain names have to be unique in the community. If you try to move this
domain to a community that already contains a domain with the same name, an
error message will appear after clicking Save.

4. Click Save.

Delete a domain
You can delete a domain.

Warning When you delete a domain, you will also delete its contained views and
assets.

Steps

1. Open a domain page.
2. In the resource toolbar, click Actions → Delete.

» The Delete Confirmation dialog box appears.
3. Click Delete <domain name>.
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Asset types
An asset type defines the semantics of an asset, as a kind of template. Via its assignment,
it defines which attribute types, relation types and statuses the asset can have. It also
determines which articulation rules, data quality rules and validation rules are applied, and
the domain types in which it can be created.

Some asset types can only be created in a specific Collibra application and in a specific
domain type. For example, you can only create assets of the Validation Rule type in a
domain of the Validation Rule Domain type. You can see the required domain type in the
assignment of the asset type.
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Overview of packaged asset types
An asset type defines the semantics of an asset, as a kind of template. Via its assignment,
it defines which attribute types, relation types and statuses the asset can have. It also
determines which articulation rules, data quality rules and validation rules are applied, and
the domain types in which it can be created.

Note If you want to create an asset of a specific type, you need access to one or
more domains of the required type. For example, you can only create KPI assets in
a Report Catalog domain. As an admin, you can see and edit the required domain
types in the assignment.

Listed below are the five main asset types and their default icons. All other asset types are
descend from these:

l Business Asset
l Data Asset
l Governance Asset
l Issue
l Technology Asset

The table below contains all packaged asset types and their description.

Tip For an interactive overview of all packaged asset types, including the relevant
domain types and applications, see the online version of this guide.

Asset type Description

Business Asset A type of asset that is exclusively used and governed by the business
user community. Its instance assets, and all instances instantiating its
subtypes, pertain to the business organization. Business assets typically
include business concepts like Business Term, Business Process, Line of
Business, etc. that help to build the semantics of any organization with
insufficient details to build an actual business application.
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Asset type Description

Business Dimension A set of reference information that categorizes and describes business
terms in a way that provides context and meaningful answers to business
questions.

Examples: business process, line of business, region

BI Folder A collection of BI content

Looker Folder A container that stores Looker Looks, Dashboards and other folders.

MicroStrategy
Folder

A collection of MicroStrategy reports and data models.

MicroStrategy
Project

A collection of MicroStrategy visualizations, report attributes and tables.

Power BI Capacity A resource that hosts Power BI Workspaces.

Power BI Folder A collection of Power BI Report Server Dashboards, Reports and Data
Models.

Power BI
Workspace

A collection of Power BI Dashboards, Reports and Data Models.

SSRS Folder A collection of SQL Server Reporting Services and Power BI Report
Server Reports and Data Sets.

Tableau Project Collection of Tableau workbooks and data sources.

Tableau Site Collection of content (workbooks, data sources, users, …) that's walled off
from any other content on that instance of Tableau Server.

Business Process A set of activities and tasks that, once completed, produces value to the
business.

Examples: campaign management, talent recruitment

Data Category A container for all the business definitions that encompass associated
terminology and definitions that an organization is trying to govern.

Examples: master data, reference data, transactional data

Chapter 7

399



Chapter 7

Asset type Description

Data Concept A data concept is a high level theoretical representation of the most
common data properties of a data domain. A data concept is the business
counterpart of a data attribute in a logical data dictionary, just as a data
attribute is the logical counterpart of a field or column in the physical data
dictionary. (Example: an address is a data concept of the data domain
customer or organisation).

Data Domain Also known as Data Category or Subject area, this is a container of all the
business data domains and data concepts that encompass associated
terminology and definitions that an organization is trying to govern.
Examples: Master Data (Customer, Product), Reference Data. Business
Data Domains group Data Concepts (Year, Date, Address, Name, etc.)

Line of Business A logical element or segment of an organization that serves a particular
business need. Line of business is also known as business unit or
business area.

Examples: retail, e-commerce, investment management

Business Qualifier Business Qualifiers qualify certain assets. This can be used as filters in
Business Qualifier Diagrams.

Business Term A word or phrase that describes a concept that is used in a particular
branch of business.

Examples: customer, person purchase count, loan amount

Acronym An abbreviation of a business term that forms a word or a name. It is
formed by stringing the initial components of a business term together. It
is often pronounced as a word.

Examples: ERP, EDW, EAD

Measure An asset type that is used for calculations, such as sum, count, average,
minimum or maximum.

Examples: net sales, top customers, on-hand inventory

KPI Key Performance Indicator, an indicator to periodically measure the
success of or the progress towards a strategic goal of a particular activity
or of an organization.

Examples: employee turnover, customer attrition, claims denial rate
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Asset type Description

Report A document containing information that is organized in a narrative,
graphic, or tabular form. The document is prepared on an ad hoc,
periodic, recurring, regular or as-required basis.

Reports can refer to specific periods, events, occurrences or subjects.

BI Report A visual representation of data or a collection of visualizations.

Looker Dashboard A collection of Looker tiles with metrics from one or more Looker Looks.

Looker Look A detailed view of a Looker Data Set, with visualizations of findings and
insights.

Looker Query A query that creates a simple report in a Looker Tile or Looker Look.

Looker Tile An element that represents data on the Looker Dashboard.

MicroStrategy
Dossier

A collection of MicroStrategy chapters and pages.

MicroStrategy
Report

A detailed view of a MicroStrategy data model, with visualizations of
findings and insights.

Power BI
Dashboard

A collection of Power BI tiles with metrics from one or more Reports and
Data Models.

Power BI Report A detailed view of a Power BI Data Model, with visualizations of findings
and insights.

Power BI Tile An element representing data on the Power BI Dashboard.

SSRS KPI A key performance indicator of SQL Server Reporting Services.

SSRS Report A detailed view of an SQL Server Reporting Services Data Set, with
visualizations of findings and insights.

Tableau
Dashboard

A collection of several worksheets and supporting information, shown on
a single screen, so that you can simultaneously compare and monitor a
variety of data.
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Asset type Description

Tableau
Worksheet

A worksheet is a single sheet on which you can build views of your data.

Tableau Workbook Collection of sheets. A sheet can be a worksheet, a dashboard or a story.

Data Asset A type of asset that represents details of organizational data in two
layers. One layer is independent of any particular technology for
non-technical stakeholder communication. The other one is taking
the implementation system for technical stakeholder
communication into account. Examples: Data Element, Table

Code Set An enumerated list of valid code values for a specific topic, where the
code set is the whole and the code values are parts of that whole. It is a
data asset that defines the set of permissible values to be used by other
data assets.

Examples: Product Code Set, Person Gender Code, ISO 3166 Country
Code

Code Value A valid form of representation for an asset, shortened or covert.

Examples:

l In the Person Gender Code, “male”, “female”, “not known” and
"not specified" are represented by the valid code values "1",
"2", "0" and "9".

l “US” is part of the "ISO 3166 code set" and refers to The United
States of America.

Crosswalk Mapping between two or more code sets.

Data Element A construct that documents aspects of something abstract, especially one
that is essential for business.

Examples: person birth date, person address

Column An atomic unit of data that can be stored in a database table.

Examples: FST_NM, EMPID

Data Attribute A specification that defines a property of a data entity.

Examples: CustomerBirthDate, EmployeeFirstName
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BI Data Attribute An atomic unit of data that represents a BI report.

Looker Data
Set Column

An atomic unit of data that is used in a Looker Look or Looker Tile. It
represents a column in a Looker Data Set.

MicroStrategy
Column

A column in a MicroStrategy data model.

Power BI
Column

A column in a Power BI Data Model.

SSRS Column A column in an SQL Server Reporting Services Report Data Set.

Tableau Data
Attribute

A specification that defines a property of a Tableau data entity.

Examples: CustomerBirthDate, EmployeeFirstName.

Field An atomic unit of data that can be stored in a file.

Examples: FirstName, EmpID

Report Attribute An atomic unit of data that represents a report.

BI Report Attribute An atomic unit of data that represents a BI report.

Looker Report
Attribute

An atomic unit of data that is used in a Looker Look or Looker Tile. It
represents the actual use a Looker Data Set Column.

MicroStrategy
Report Attribute

A detailed view of a MicroStrategy visualization, with findings and
insights.

SSRS
Parameter

A column that is part of an SQL Server Reporting Services Data Set and
that is used in a KPI.

Tableau Report
Attribute

An atomic unit of data that represents a Tableau report.

Examples: ExpenseAmount, RiskAmount

Data Set A collection of related sets of data assets that are data elements or
composed of data elements.

Example: Customer Contact information
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Asset type Description

BI Data Set A collection of data that is used for BI report creation

Looker Data Set A collection of data that is used to define Looker Dimensions and
Measures.

SSRS Data Model A collection of data that is used to create an SQL Server Reporting
Services Report.

Data structure A logical grouping (through whole-part relation) of data elements.

Example: cfPerson is a data structure that contains the cfBirthDate,
cfPersonFullName data elements.

Data Entity A unit of data that can be classified and can have a stated relationship to
other units of data.

Examples: Customer, Employee

BI Data Entity A unit of data in a BI data source that can be classified and can have a
stated relationship to other units of data.

Power BI Table A table in a Power BI Data Model.

SSRS Table A table in an SQL Server Reporting Services Report Data Set.

Tableau Data
Entity

An abstraction from the physical implementation of database tables, used
for Tableau report creation.

Data Model Organizes data elements and standardizes how the data elements relate
to one another. The data model often facilitates the communication
between business and technology.

Examples: customer subject area model, event subject area model

BI Data Model A diagram that organizes data elements and standardizes how the data
elements relate to one another. The Data Model is often used as a
communication aid between business and technology.

Examples: Customer Subject area model, Event Subject area model

MicroStrategy
Data Model

A collection of data that is used to create MicroStrategy reports.
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Asset type Description

Power BI Data
Flow

A collection of tables that are created and managed in workspaces in the
Power BI service.

Power BI Data
Model

A collection of data that is used to create a Power BI report.

Tableau Data
Model

An abstraction from the physical implementation of database, schema,
file, etc., used for Tableau report creation.

Schema An asset that contains the location of specific data. It provides all the
details that are required for setting up a connection to a database or
server.

Table An implementation of data entities in columns and rows, in a given
database system. It is the basic structure of a relational database.

Examples: Account_tbl, CUST_ADDR

Database View A Database View is a virtual table based on the result-set of an SQL
statement.

Data Usage An asset that clearly documents how the data can be used between data
produces and consumers for specific purpose

Example: Sales growth information that is available to share for read-only
requirements

Foreign Key Asset type used to model the Primary key - Foreign key relations in
relational databases.

Mapping Specification Mapping between two or more data structures.

Governance Asset A type of asset that is used to monitor and advocates to maximize
performance or utilization of other Business and Data assets while
minimizing the risk factors in alignment with Organisational/Business
goals.

Assessment Review An asset of this type is created when an assessment is conducted on an
asset and submitted for review.
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Asset type Description

Data Quality Dimension Represents criteria that are relevant for assessing quality and categorizes
different aspects of how data quality is measured.

Examples: accuracy, completeness, consistency

Data Sharing Agreement An agreement between data producers and consumers with terms and
conditions including provisions concerning access and dissemination to
'pool' a set of data for specific purposes.

Examples: Sales growth information that is available only to the Risk team
for generating internal reports.

Issue Category Allows you to categorize Issue type assets to help with organization and
reporting.

Example: You want to differentiate between types of issues, such as a
Duplication issue or a Completeness issue.

Policy A statement of intent that is set by a council and is implemented by a set
of standards.

Example: Personal information must be adequately protected.

Standard Consists of specific low-level mandatory controls that help enforce and
support the policy.

Example: All personal information is encrypted with a specific encryption
type.

Rule Defines or constrains some aspect of specific business data categories. It
is intended to control or influence the behavior of the business.

Example: Every customer must have a unique identifier.

Business Rule Defines or constrains some aspect of specific business data. It is intended
to control or influence the behavior of business data.

Example: Customer numbers have to be unique.

Data Quality Metric An implementation of data quality rules in a selected physical database
system using a particular data quality tool.

Example: CRM.ACT.Tx_ID cannot be null, must be a 9-digit number and
has to take the 999-99-9999 format in the CRM system, and
ERP.Cust.SSN has to take the 999999999 format in the ERP system.
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Data Quality Rule A specification that defines which actions are required to measure the
quality level of a data element for its intended use.

Example: SSN must be a unique 9-digit identification number for 100% of
US personal accounts for tax processing.

Validation Rule A rule that describes a criterion to which content in DGC has to comply.

Issue The parent asset type of all issues.

Data Issue A problem related to issue management, also referred to as "issue".

Technology Asset A piece of information technology (hardware, software, database,
software platform) that helps an organization to run a business
application.

Examples: Database, File

Database A collection of data that is systematically organized or structured, to make
it is easy to create, update and query the information.

Examples: Ora_DGC_V45, SalesDB2020

File Container An asset type that represents Cloud File Container.

Directory A collection of data that is treated by a computer as a unit, for the
purposes of input and output.

Examples: businessGlossary.xls, dataDictionary05220.csv,
datacatalogv25.txt

GCS Bucket An asset type that represents an Google Cloud Storage bucket which is a
logical unit of storage containing Google Cloud Storage objects.

S3 Bucket An asset type that represents an Amazon S3 Bucket, which is a logical
unit of storage containing Amazon S3 Objects.

File Group A collection of physical files which together represent a single logical file.

Server A computer program or device that supports other computer programs
and their users

BI Server A visual analytics platform for creating and storing visualizations.
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Asset type Description

Looker Tenant A platform to create Looker Dashboards and rich visualizations.

MicroStrategy
Server

A visual analytics platform for creating and storing MicroStrategy reports
and data models.

Power BI Server A visual analytics platform for creating and storing Power BI Reports and
Data Models.

SSRS Server A visual analytics platform for creating and storing SQL Server Reporting
Services and Power BI Report Server Reports and Data Sets.

Tableau Server A visual analytics platform for creating interactive dashboards and rich
visualisations

System Executable software that you can buy commercially off the shelf (COTS),
or build internally, to automate one or more business functions that help
run a business smoothly and efficiently.

Examples: CRM, ERP, EDW

BI Data Source The link between a BI System and an external system.

Tableau Data
Source

The link between Tableau and an external system. A Tableau data source
contains the information to connect to external data, table names, the
table relationships, and any customizations that you make.

File Storage An asset type that represents a Cloud File Storage bucket.

GCS File System An asset type that represents Google Cloud Storage file system.

S3 File System Amazon S3 (Simple Storage Service) file system abstraction.

Create an asset type
You can create an asset type. For example, you can do this if the packaged asset types do
not suffice.

Prerequisites
You have a global role that has the System administration global permission.
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Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. Above the table, to the right, click Add.

» The Asset Type Creation dialog box appears.
4. Enter the required information.

Field Description

Name The name of the asset type.

You can add more than one type by pressing Enter.

Note The name of the asset type must be globally unique.

Parent Asset
Type

The parent asset type from which the new asset type inherits all properties.

5. Click Save.

Warning If you create an asset type and hierarchically nest the new asset type
under, for example, a Catalog asset type, you may encounter asset page rendering
issues. This is due to a difference in the required characteristics of the asset type
you created and the Catalog asset type. Likewise, if you remove a required
characteristic from an asset type, you may encounter page rendering issues for
asset pages of that asset type.

What's next?
If necessary, edit the asset type, for example by doing one of the following:

l Enable or disable ratings and reviews.
l Enable or disable non-unique naming.
l Edit the representation in Collibra Data Intelligence Cloud.
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Edit an asset type
You can edit an asset type. For example you can do this if you want to give it another
name.

Prerequisites
You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the upper-right corner, click Edit.

» The Edit <asset type> dialog box appears.
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3. Enter the required information.

Field Description

Name Enter the name of the asset type.

Note The name of the asset type must be unique.

Allow identical
asset names per
domain

Select to enable identical asset names per domain.

Clear to disable identical asset names per domain.

Enable ratings Select to allow users to rate assets.

Ratings enable users to subjectively rate the quality of an asset, using a five-star
rating system, and write a free-text review of the asset, in support of the rating
provided.

Display options These fields allow you to edit how assets of this type are represented on
the asset page and in diagrams.

Colors

The default colors that you can use for the complex relation nodes of this
type.

Color hex v-
alue

The hexadecimal value of the color that you want for assets of this type.

For a list of colors and their hexadecimal values, see ColorHexa.

Symbol A graphical representation for assets of this type.

You can choose one of the following values:

o None: No graphical representation is used for assets of this type.
o Code: Assets of this type are represented with a code in front of them.
You can specify the code that you want in the Code field.

o Icon: Assets of this type are represented with an icon in front of them.
You can select the icon that you want in the Icon reference field.
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Field Description

Code The code that is displayed in front of assets of this type. This code is also
displayed in the legend of diagrams. By default, this field contains the initials of
the selected asset type.

This field is only displayed if you have selected Code in the Symbol field.

Icon ref-
erence

The icon that is displayed in front of assets of this type. This icon is also displayed
in the legend of diagrams.

This field is only displayed if you have selected Icon in the Symbol field.

Preview Displays two previews of your asset type configuration.

o The left preview is the title bar on an asset page.
o The right preview is a diagram node.

4. Click Save.

Edit an asset type's representation
You can change the color and icon by which an asset is represented in Collibra Data
Intelligence Cloud. This can be handy to quickly spot a specific asset type in a diagram.

Prerequisites
You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the upper-right corner, click Edit.

» The Edit <asset type> dialog box appears.
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3. Enter the required information.

Field Description

Display options These fields allow you to edit how assets of this type are represented on
the asset page and in diagrams.

Colors

The default colors that you can use for the complex relation nodes of this
type.

Color hex
value

The hexadecimal value of the color that you want for assets of this type.

For a list of colors and their hexadecimal values, see ColorHexa.

Symbol A graphical representation for assets of this type.

You can choose one of the following values:

o None: No graphical representation is used for assets of this type.
o Code: Assets of this type are represented with a code in front of them.
You can specify the code that you want in the Code field.

o Icon: Assets of this type are represented with an icon in front of them.
You can select the icon that you want in the Icon reference field.

Code The code that is displayed in front of assets of this type. This code is also
displayed in the legend of diagrams. By default, this field contains the initials of
the selected asset type.

This field is only displayed if you have selected Code in the Symbol field.

Icon ref-
erence

The icon that is displayed in front of assets of this type. This icon is also displayed
in the legend of diagrams.

This field is only displayed if you have selected Icon in the Symbol field.

Preview Displays two previews of your asset type configuration.

o The left preview is the title bar on an asset page.
o The right preview is a diagram node.

4. Click Save.

Enable or disable ratings
You can enable and disable ratings via the asset type pages, in Settings.
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Enabling ratings for a particular asset type is not inherited by children asset types. The
feature has to be manually enabled for each child asset type.

By default, ratings are enabled for asset types Data Set and Report and their children
asset types. Ratings are disabled, by default, for all other packaged asset types and any
asset types you create.

Warning Ratings cannot be disabled for a specific asset type if user ratings exist for
any assets of that asset type. In other words, all user ratings for all assets of a
specific asset type must be manually deleted before ratings can be disabled for that
asset type.

Prerequisites
You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the upper-right corner, click Edit.

» The Edit <asset type> dialog box appears.
3. Enter the required information.

Field Description

Enable ratings Select to allow users to rate assets.

Ratings enable users to subjectively rate the quality of an asset, using a five-star
rating system, and write a free-text review of the asset, in support of the rating
provided.

4. Click Save.
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Enable or disable identical asset names per
domain
You can enable and disable Identical asset names per domain, by asset type.

Prerequisites
You have a new or existing asset type.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the upper-right corner, click Edit.

» The Edit <asset type> dialog box appears.
3. Enter the required information.

Field Description

Allow identical
asset names per
domain

Select to enable identical asset names per domain.

Clear to disable identical asset names per domain.

4. Click Save.

Move an asset type
You can move an asset type to another parent asset type. As a consequence, the asset
type may inherit the assignment of the new asset type, which may impact, amongst others,
the possible characteristics.
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Prerequisites
You have a global role that has the System administration global permission.

Move an asset type from the asset type table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the row of the asset type that you want to move, click .

» The Select Parent Asset Type dialog box appears.
4. Enter the required information.

Field Description

Parent Choose the parent asset type.

5. Click Save.

Move an asset type from the asset type page

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. Above the table, to the right, click Move.

» The Select Parent Asset Type dialog box appears.
3. Enter the required information.

Field Description

Parent Choose the parent asset type.

4. Click Save.
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Delete an asset type
You can delete an asset type. For example, you can do this if you no longer need an asset
type that you created earlier.

Prerequisites
l You have a global role that has the System administration global permission.
l It is not a packaged asset type.
l There are no assets of that asset type. If assets of that asset type exist, either edit
their asset type or delete them.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the row of the asset type that you want to delete, click .

» The Delete Asset Type dialog box appears.
4. Click Yes.
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Assignments
An assignment is a collection of components that is assigned to an asset type and
optionally to its child asset types.

In this section, we provide more information about the assignments in Collibra Data
Intelligence Cloud.
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Assignments
An assignment is a collection of components, such as characteristics and statuses,
assigned to an asset type and optionally to its child asset types.

Assignments determine what you can do with assets in the user interface of Collibra Data
Intelligence Cloud, but they do not limit the possibilities of the API or import feature.

Assignments and scopes
An assignment can apply globally, in which case it is called the global assignment, or to a
scope, in which case it is called a scoped assignment.

The global assignment applies to all assets that are not in a scope. A scoped assignment
only applies to assets that are located in a domain or community that belongs to the scope.
An asset type can only have one global assignment, but many scoped assignments.

Before adding a scoped assignment, an asset type must have a global assignment. You
can add the global assignment by going to the Asset Type page and clicking the Add
Global Assignment button.

Note Self-relation types are now divided in the assignment table with the head and
tail appearing on separate lines.

For an interactive overview of asset type whose assignments have changed visit the
online documentation.

Components
You can assign the following components to an asset type.

Characteristics

The Characteristics page contains a list of all attribute types, relation types and complex
relation types that can be added to an asset of this type, if the asset is in the scope of the
assignment.
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An assignment line consists of the following:

l One characteristic type, including its description and kind.
l The minimum and maximum cardinality.
The cardinality of an assignment line determines how many characteristics of this
type can be added to an asset.

Number Minimum Maximum

not filled in This is not possible. The minimum
number of occurrences must at least
be 0.

You can add as many characteristics of
this characteristic type as you want.

0 The characteristic doesn't auto-
matically appear on the asset
page, but you can add it via Add
characteristics.

If the maximum cardinality is 0, you
cannot add this characteristic to the
asset.

1 or greater The characteristic's type is
automatically visualized on the asset
page of the asset, even if the
characteristic doesn't exist yet.

You can add characteristics of this type
until you reach this maximum.

l The asset type filter, if the characteristic is a relation type.
You can use the asset type filter to restrict the asset types that you can use as the tar-
get of this relation type.

Example The MicroStrategy Report Attribute asset type has an assignment
line containing the "Report Attribute contained in / contains Report" relation
type. Instead of allowing any asset of the Report type or its children, you can
use the asset type filter to restrict it to only assets of the MicroStrategy Report
type.

Domain types

The Domain types page contains the hierarchy of domain types. You can select domain
types to allow assets of this type to be put in domains of this type. Assets of this asset type
can then be created in the domains of the selected types.
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Statuses

The Statuses page contains a list of statuses with their description. When you create a
new asset of the asset type for which you have an assignment, the asset gets the first
status from this list.

Articulation

The Articulation page shows the articulation score calculator

Data quality rules

The Data quality rules page contains a list of data quality rules with their description.

Validation rules

The Validation rules page contains a list of validation rules with their description.

Inheritance
If an asset type does not have an assignment, then the asset type inherits all assignments
of its parent asset type. If an asset type has one or more assignments, it does not inherit
any assignments of its parent asset type.

Create an assignment
You can create an assignment for an asset type if you want to change the behavior of
assets of this type in Collibra Data Intelligence Cloud. For example, you do this if you want
to make a specific attribute type available only for assets of a certain type.

Prerequisites
l You have a global role that has the System administration global permission.
l If you want to create a scoped assignment, you have created the scope.
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Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. Create a global or scoped assignment:

Assignment type Steps

Global
assignment

a. In the tab pane, click Add global assignment.
» The Add Global Assignment dialog box appears.

b. Click Add global assignment.
» The asset type no longer inherits the assignments of its parent
asset types.

Note Each asset type can only have one global assignment.

Scoped
assignment

a. In the tab pane, click Add assignment.
» The Select scope for this assignment dialog box appears.

b. Select a scope.

Note You can only add one scope at a time.

c. Click Add assignment.
» The settings of the global assignment are copied into the selected
scope.

Note You can only create scoped assignments if the asset type has a
global assignment.

What's next?
You can now edit the assignment.
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Edit an assignment
You can edit an assignment. For example, you do this if you want to add a specific attribute
type to assets of a certain type.

Prerequisites
l You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
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2. In the tab pane, click the name of the assignment.
3. Perform one of the following steps:

Component Steps

Characteristics Assign one or more characteristic types to the asset type.
a. Above the table, to the right, click Edit.
b. Above the table, to the right, click Add characteristic.

» The Add a Characteristic dialog box appears.
c. Click the characteristic type that you want to add.

Tip You can use the filter to search for a specific
characteristic type.

» The characteristic type appears at the bottom of the table.
d. If required, set the Asset Type Filter to restrict the relation type target

available to a sub-set of assets.
e. If required, edit the minimum or maximum number of occurrences of

the characteristic.

Option Description

Min. The minimum number of occurrences of the characteristic.

Set this option to 1 or greater to make the characteristic appear
automatically on the asset page.

Max. The maximum number of occurrences that you can assign to an
asset type.

Leave this option empty if you don't want a limit to the maximum
number of occurrences.

f. Above the table, to the right, click Save.
» You can now add the characteristic to the assets of this type.

Domain types Assign one or more domain types to the asset type.
a. In the tab pane, click Domain Types.

» The domain type table appears.
b. Above the table, to the right, click Edit.
c. In the domain types overview, select the domain types to assign the

selected asset type to.
d. Click Save.
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Component Steps

Statuses Assign one or more statuses to the asset type.
a. In the tab pane, click Statuses.
b. Above the table, to the right, click Edit.
c. Above the table, to the right, click Add.
d. In the Add status dialog box, click the status to add to the asset type.

Statuses in gray are already assigned to the asset type.
Repeat this step for every status that you want to assign.

e. Click Save.

Articulation Assign one or more articulation rules.

Data quality rules Assign one or more data quality rules.
a. In the tab pane, click Data quality rules.
b. Above the table, to the right, click Edit.
c. Above the table, to the right, click Add.

» The Add data quality rule dialog box appears.
d. Click a data quality rule.

» The data quality rule appears at the bottom of the list of data quality
rules.
If required, change the order.

e. Click Save.

Validation rules Assign one or more validation rules to the asset type.
a. In the tab pane, click Validation rules.

» The Asset type - Validation rules editor appears.
b. Above the table, to the right, click Edit.
c. Above the table, to the right, click Add.

» The Add validation rule dialog box appears.
d. Click a validation rule.

» The validation rule appears at the bottom of the list of validation
rules.
If required, change the order.

e. Click Save.

Delete an assignment
You can delete an assignment. For example, you do this if you no longer want assets to
have specific attribute types.
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Note For some asset types, you cannot delete the global assignment because it is
required for the proper functioning of Collibra Data Intelligence Cloud.

Prerequisites
l You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. In the tab pane, click .

Note If you want to delete the global assignment, you first have to delete all
scoped assignments.

4. Click Yes.

Note If you deleted the global assignment, the asset type inherits all
assignments of its parent asset type.

Restrict relations for an assignment
You can restrict the target asset types that are available for an assigned relation type to
one of its child asset types This allows you to limit the possible assets available for
relations of that type to assets of the selected type and its descendants. By reducing the
list of available asset types, you can reduce potential confusion and incorrect relations,
without having to create new relation types with more restrictive heads and tails.
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Important When selecting an asset in the Asset Type Filter, the available relations are
restricted to assets of that type and any of its descendants.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. Above the table, to the right, click Edit.
4. In the Asset Type Filter field, select the asset type from which you want to start the

restriction.
5. Above the table, to the right, click Save.

Assign a characteristic type to an asset type
You can assign a characteristic type to an asset type by adding it to the asset type's
assignment. As a result, you can see and add characteristics of this type to assets of this
type on the asset page, if the asset is in the scope of the assignment.

Note
l Via the import API, the import functionality or a workflow, you can add
characteristic types that are not in the assignment.

l The asset page only shows characteristics whose type is in the asset type's
assignment.

Prerequisites
You have a global role that has the System administration global permission.
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Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. Above the table, to the right, click Edit.
4. Above the table, to the right, click Add characteristic.

» The Add a Characteristic dialog box appears.
5. Click the characteristic type that you want to add.

Tip You can use the filter to search for a specific characteristic type.

» The characteristic type appears at the bottom of the table.
6. If required, set the Asset Type Filter to restrict the relation type target available to a

sub-set of assets.
7. If required, edit the minimum or maximum number of occurrences of the char-

acteristic.

Option Description

Min. The minimum number of occurrences of the characteristic.

Set this option to 1 or greater to make the characteristic appear automatically on
the asset page.

Max. The maximum number of occurrences that you can assign to an asset type.

Leave this option empty if you don't want a limit to the maximum number of
occurrences.

8. Above the table, to the right, click Save.
» You can now add the characteristic to the assets of this type.
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Assign a domain type to an asset type
You can assign a domain type to an asset type by adding it to the asset type's assignment.
As a result, you can create assets of this type in domains of this type, if the domain is in the
scope of the assignment.

Prerequisites
You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. In the tab pane, click Domain Types.

» The domain type table appears.
4. Above the table, to the right, click Edit.
5. In the domain types overview, select the domain types to assign the selected asset

type to.
6. Click Save.

Assigning a status to an asset type
You can assign a status to an asset type by adding it to the asset type's assignment. As a
result, you can give assets of this type this status on the asset page, if the asset is in the
scope of the assignment.

Prerequisites
You have a global role that has the System administration global permission.
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Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. In the tab pane, click Statuses.
4. Above the table, to the right, click Edit.
5. Above the table, to the right, click Add.
6. In the Add status dialog box, click the status to add to the asset type.

Statuses in gray are already assigned to the asset type.
Repeat this step for every status that you want to assign.

7. Click Save.

Assign a validation rule to an asset type
You can assign a validation rule to an asset type by adding it to the asset type's
assignment. As a result, you can validate assets of this type against this validation rule, if
the asset is in the scope of the assignment.

Prerequisites
l You have a global role that has the System administration global permission.
l You have created a Validation Rule asset.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.
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» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. In the tab pane, click Validation rules.

» The Asset type - Validation rules editor appears.
4. Above the table, to the right, click Edit.
5. Above the table, to the right, click Add.

» The Add validation rule dialog box appears.
6. Click a validation rule.

» The validation rule appears at the bottom of the list of validation rules.
If required, change the order.

7. Click Save.

Assign a data quality rule to an asset type
You can assign a data quality rule to an asset type by adding it to the asset type's
assignment. As a result, the data quality dashboard is available for assets of this type if the
asset is in the scope of the assignment.

Prerequisites
l You have a global role that has the System administration global permission.
l You have created a data quality rule.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. In the tab pane, click Data quality rules.
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4. Above the table, to the right, click Edit.
5. Above the table, to the right, click Add.

» The Add data quality rule dialog box appears.
6. Click a data quality rule.

» The data quality rule appears at the bottom of the list of data quality rules.
If required, change the order.

7. Click Save.

What's next?
If the asset has all relations as defined in the aggregation path, you can go to the relevant
asset pages and open the Quality tab page to see the data quality results.
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Overview of characteristic types
Characteristic types is a generic term for attribute types, relation types and complex
relation types.

Attribute types
An attribute type defines the class of information that an attribute contains.

You can add an attribute to an asset if the attribute's type is in the relevant assignment of
the asset's type.

About attribute types
An attribute type defines the class of information that an attribute contains.

You can add an attribute to an asset if the attribute's type is in the relevant assignment of
the asset's type.

Examples of attributes and attribute types

The following table contains attribute types and a description of the attribute that can be
added to an asset.

Attribute type Description of the attribute Example of an attribute

Definition The description with background
information on the asset

Asset: Customer Definition: A
person, company or
organization that purchases a
commodity or service.

Last Review Date The date on which the asset was
reviewed.

02/05/2020
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Attribute type Description of the attribute Example of an attribute

Frequency The rate at which an asset changes over a
particular period of time.

Daily

Rows Failed The number of rows that failed a rule. 15

Personally Identifiable
Information

A boolean field to indicate whether an
asset contains personally identifiable
information.

True

Kinds of attribute types

Attribute types can contain different kinds of information, for example, free text, dates and
numbers.

Field Description

Date A date value. If you edit attributes of this type, you can pick a date using the date
selector.

Note The date format that is displayed in the UI, can be different depending on
the language settings in your user profile. For example, dd/mm/yyyy or
yyyy/mm/dd.

Multiple
Selection

A field that allows multiple values that you can select from a predefined list.

with
values

The values from which you can select one or more.

Number A number, or a number with a fraction.

Only
integers.
(..., -2, -1,
0, 1, 2, ...)

Checkbox to only allow integer numbers.Numeric values are stored as Floating Point
values (IEEE 754 standard), which are not able to represent all numbers accurately.
Due to this technical constraint, rounding issues occur for both negative and positive
numbers.
The bigger the number, the more noticeable the rounding issue.
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Field Description

Metric Checkbox to make this attribute type a metric. This allows you to assign this attribute
type as a metric when you create a data quality rule.

Selection A field that allows a single value that you can select from a predefined list.

with
values

The values from which you can select one.

Text Textual input which may contain formatting.

Plain Text Checkbox to disable formatting.

True/False A binary option that allows you to indicate whether something is true or false.

Metric Checkbox to make this attribute type a metric. This allows you to assign this attribute
type as a metric when you create a data quality rule.

Note An attribute can contain up to 100.000 bytes, which corresponds to roughly
up to 100.000 characters in the source code of the attribute.

Overview of packaged attribute types
An attribute is a characteristic that describes an asset by means of an individual field. The
attribute's kind defines the class of information that the attribute contains.You can add an
attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.

The table below contains all packaged attribute types. You can also create new attribute
types.

Type Description Assigned to asset type Kind

1st Decile The data 1st decile value. Column Text

1st Percentile The data 1st percentile value. Column Text

1st Quartile The data 1st quartile value. Column Text

3rd Quartile The data 3rd quartile value. Column Text
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Type Description Assigned to asset type Kind

5th Percentile The data 5th percentile value. Column Text

95th Percentile The data 95th percentile value. Column Text

99th Percentile The 99th percentile value. Column Text

9th Decile The data 9th decile value. Column Text

Abbreviation A shorthand signifier for an asset. Report Text

Analysis The analysis of this issue. Issue Text

Application
Regulation

Any regulations that apply to the
application. For example, for certain
applications that consumes data,
there is a regulation about how to
handle that.

Directory, System, Tech-
nology Asset

Text

Application
Standards

Any standards applied to the busi-
ness application.

Directory, System, Tech-
nology Asset

Text

Approval Date The date on which the assessment
was approved.

Assessment Review Date

Assessment
Link

The link to the submitted assess-
ment.

Assessment Review String

Background Background information on the asset. Text

Calculation Rule The rule that specifies how the KPI or
metric is calculated.

KPI, Tableau Report
Attribute

Text

Categorical Data Data is considered categorical if it can
only take a limited set of different values.

Column True/False

Category A possible value for Categorical Data. Column Text
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Type Description Assigned to asset type Kind

Certified Indicates whether or not a report asset
meets the set standards.

Data Set, Looker
Dashboard, Looker Data
Set, Looker Look, Looker
Tile, Power BI Dashboard,
Power BI Data Model,
Power BI Report, Power BI
Tile, Tableau Data Source,
Tableau View, Tableau
Workbook

True/False

Char octet Length For character types, the maximum
number of bytes in the column.

Column Numeric

Column Position The index of the column in the table. Column Numeric

Conformity Score The amount of rows that passed the rule. Business Rule, Data
Quality Metric

Numeric

Co-role Relationship name from tail to head. - Text

Criticality
Indicator

Indicate the criticality of an asset. - True/False

Data Source The data source of an asset. It spe-
cifies where the data corresponding
to this asset is coming from.

Database, Tableau Data
Model, Schema

Text

Data Source Type The type of the registered data source. Schema, Database Text

Data Type The logical Data type detected by Col-
libra profiling.

Column Text

Data Type Pre-
cision

The precision of the data type. For
example how many characters it can
contain.

Data Attribute, Data Ele-
ment, Report Attribute

Numeric

Date and/or Time
Pattern

The pattern used to encode a time, date
or both. Format must be compatible with
a java DateTimeFormatter. Example:
yyyy-MM-dd HH:mm:ss.

Column Text
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Type Description Assigned to asset type Kind

Default Value The default value for the column. Column Text

Definition The definition of the business asset.
This is the shortest possible descrip-
tion that clearly defines the business
asset.

Business Asset, Busi-
ness Process, Business
Term, Data Category,
KPI, Line of Business,
Measure, Report, Report
Attribute

Text
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Type Description Assigned to asset type Kind

Description The description of the asset. This is
typically a more verbose way to
describe what the asset means.

Asset, Business
Dimension, Business Rule,
Code Set, Code Value,
Column, Crosswalk, Data
Asset, Data Attribute,
Database, Data Element,
Data Entity, Data Model,
Data Quality Dimension,
Data Quality Metric, Data
Quality Rule, Data Set,
Data Sharing Agreement,
Data Structure, Data
Usage, Directory, File, File
Group, Governance Asset,
Issue, Issue Category,
Looker Dashboard, Looker
Data Set, Looker Data Set
Column, Looker Folder,
Looker Look, Looker
Query, Looker Report
Attribute, Looker Tenant,
Looker Tile, Mapping
Specification, Policy,
Power BI Capacity, Power
BI Dashboard, Power BI
Data Model, Power BI
Table, Power BI Column,
Power BI Report, Power BI
Server, Power BI Tile,
Power BI Workspace,
Report, Report Attribute,
Role Type, Rule, S3
Bucket, S3 File System,
Schema, Standard,
System, Table, Tableau
Data Source, Tableau
Project, Tableau Report
Attribute, Tableau Server,
Tableau Site, Tableau
View, Tableau Workbook,

Text
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Type Description Assigned to asset type Kind

Technology Asset,
Validation Rule, Workflow
Definition

Description
From Source
System

The description from the source sys-
tem of the asset.

Table, Column String

Descriptive
Example

An example of the asset. Asset, Business Asset,
Business Process, Busi-
ness Rule, Business
Term, Code Set, Code
Value, Data Asset, Data
Attribute, Data Category,
Data Element, Data
Entity, Data Model, Data
Quality Metric, Data
Quality Rule, Data Struc-
ture, Directory,
Governance Asset,
Issue Category, KPI,
Line of Business, Meas-
ure, Policy, Report, Role
Type, Rule, Standard,
System, Technology
Asset

Text

Document
creation date

Date the document was created. Looker Dashboard, Looker
Folder, Looker Look,
Tableau Data Source,
Tableau View, Tableau
Workbook

Date

Document last
accessed date

Date the document was last accessed. Looker Dashboard, Looker
Look

Date

Document last
viewed data

Date the document was last viewed. Looker Dashboard, Looker
Look

Date
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Type Description Assigned to asset type Kind

Document
modification date

Date the document was last edited. Looker Look, Tableau Data
Source, Tableau View,
Tableau Workbook

Date

Document size Size of the document in megabytes. File, File Group, Tableau
Workbook

Numeric

Effective End
Date

Date as of which an asset is sched-
uled to end.

Business Rule, Code
Set, Code Value, Data
Quality Metric, Data
Quality Rule, Data
Usage, Governance
Asset, Issue Category,
Policy, Rule

Date

Effective Start
Date

Date on which asset takes effect. Business Rule, Code Set,
Code Value, Data Quality
Metric, Data Quality Rule,
Data Usage, Governance
Asset, Issue Category,
Policy, Rule

Date

Empty Values
Count

The number of empty values for that
column

Column Numeric

Empty values
definition override

Overrides the default list of values to
consider as empty or missing values
during data profiling. It must be a comma
separated list of text values with each
value enclosed in double quotes.

Column, Schema, Table Text

Entity Load
Date

The load date of the entities from the
external system.

Data Quality Metric Text

Exception Scen-
ario

The exception scenario. Business Rule, Data
Quality Metric, Data Quality
Rule, Data Sharing
Agreement, Governance
Asset, Issue Category,
Policy, Rule, Standard

Text
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Type Description Assigned to asset type Kind

External System
Label

The label from external system. File, GCS Bucket, File
Container

String

Favorites count The number of Looker Looks and Looker
Dashboards that are marked as favorite.

Looker Dashboard, Looker
Look

Number

File Location The location of the original source file. File, Schema Text

File Type The type of a File, which may constrain
its format, its content or both.

File, File Group Text

Foreign Key
Delete Rule

What happens to the foreign key when
primary is deleted.

Foreign Key Text

Foreign Key
Evaluation
Deferrability

Can the evaluation of the foreign key
constraints be deferred until commit.

Foreign Key Text

Foreign Key
Update Rule

What happens to foreign key when
primary is updated.

Foreign Key Text

Frequency Rate at which an asset changes over a
particular period of time.

Report, Report Attribute Text

Glue Database
Name

The name of the AWS Glue database
in which this data is referenced and
described.

Table String

Glue Table
Name

The name of the AWS Glue table in
which this data is referenced and
described.

Table String

Inclusion
Scenario

The inclusion scenario Business Rule, Data
Quality Metric, Data Quality
Rule, Data Usage,
Governance Asset, Issue
Category, Policy, Report,
Report Attribute, Rule,
Standard

Text
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Type Description Assigned to asset type Kind

Inferred Data
Type

The data type of a data asset that
was automatically inferred by pro-
filing corresponding instance data.

Text

Is Auto
Incremented

Indicates whether this column is auto
incremented.

Column True/False

Is Generated Indicates whether this is a generated
column.

Column True/False

Is Mandatory Is the asset mandatory or not. Data Attribute True/False

Is Nullable Determines if the column can store NULL
values.

Column True/False

Is Primary Key Indicates if the column is a primary
key.

Column True/False

Is Unique If the asset is unique or not. Data Attribute True/False

IT Require-
ments

Describes the requirements from an
IT perspective for the asset.

Crosswalk, Mapping
Specification

Text

Key sequence Key Sequence of an element in a for-
eign key

Numeric

Last Review Date Date on which asset was last reviewed. Code Set, Data Usage,
Report, Report Attribute,
Standard

Date

Last Sync Date Date on which asset was synchronized
with external system.

Code Set, Code Value,
Database, Data Quality
Metric, File

Date

License The current license. Data Set Text

Loaded Rows The number of rows that were loaded. Business Rule, Data
Quality Metric

Numeric

Loaded Values The number of values that were loaded. Numeric
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Type Description Assigned to asset type Kind

Load Sample A sample. Text

Location The location where the actual asset
is stored or can be found.

Asset, Code Set, Code
Value, Data Asset, Data
Attribute, Database,
Data Element, Data
Entity, Data Model, Data
Structure, Directory,
Report, Report Attribute,
Role Type, S3 Bucket,
System, Technology
Asset

Text

Materiality The materiality. Data Usage Text

Maximum Text
Length

The length of the longest text value in this
column

Column Numeric

Maximum Value The maximum value, using alphabetical
order for text

Column Text

Max Length The maximum length of any value
corresponding to the data asset.

Numeric

Mean The mean of values (numeric only),
excluding missing values

Column Numeric

Measurement The measurement of the asset. Business Rule, Data
Quality Rule,
Governance Asset,
Issue Category, Policy,
Rule

Numeric

Median The data median value Column Text

Minimum Text
Length

The length of the shortest text value in
this column

Column Numeric

Minimum Value The minimum value, using alphabetical
order for text

Column Text
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Type Description Assigned to asset type Kind

Min Length The minimum length of any value cor-
responding to the data asset.

Numeric

Mode The value with the highest frequency for
a categorical feature.

Column Text

Non Conformity
Score

The amount of rows that failed the rule. Business Rule, Data
Quality Metric

Numeric

Note A note. Asset, Business Asset,
Business Process,
Business Rule, Business
Term, Code Set, Code
Value, Data Asset, Data
Attribute, Database, Data
Category, Data Element,
Data Entity, Data Model,
Data Quality Rule, Data
Structure, Directory, File,
KPI, Line of Business,
Measure, Policy, Report
Attribute, Role Type,
Standard, System,
Technology Asset

Text

Null Count The number of null values in the data
corresponding to the data asset.

Numeric

Number of Attrib-
utes

The number of attributes of the data
entity.

Numeric

Number of distinct
values

The number of different values stored in
this column

Column Numeric

Number of Files The number of files in a File Group. File Group Numeric

Number Of
Fractional Digits

The number of fractional digits. Column Numeric
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Type Description Assigned to asset type Kind

Number of Val-
ues

The number of distinct instance val-
ues in the data corresponding to the
data asset.

Numeric

Original Name Name of this object in its source
environment. The 'Original Name' may
differ from the asset's name in Data
Governance Center.

Column, Tableau Data
Source, Tableau Project,
Tableau Report Attribute,
Tableau Site, Tableau
View, Tableau Workbook

Text

Owner in source The email address of the owner of
the data objects in a data source, rep-
resented in Collibra by the asset
types mentioned here.

Looker Dashboard,
Looker Folder, Looker
Look, Power BI Data
Model, Power BI Report,
Power BI Workspace,
Tableau Project,
Tableau Data Model,
Tableau Workbook,
Tableau Dashboard

Text

Passing Frac-
tion

The % of rows or entities that have
passed the rule.

Business Rule, Data
Quality Metric

Numeric

Personally
Identifiable
Information

An indicator to flag an asset that could
potentially be used to identify a specific
individual.

Column True/False

Predicate The logical formula that will be
executed to implement the rule.

Data Quality Rule Text

Primary Key
Name

The name of the primary key composed
by the column.

Column Text

Priority The priority of this issue. Issue Text

Profiled Row
Count

The number of rows from the data set
that were selected for profiling.

Numeric

Profiling
Information

Provides additional information related to
the status of the profiling results.

Table Text
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Type Description Assigned to asset type Kind

Purpose The reason why the asset exists. Business Rule, Data
Sharing Agreement,
Data Usage, File,
Governance Asset,
Issue Category, Policy,
Rule, Standard

Text

Rating The current rating. Numeric

Refresh Conflict Provides the information about the
conflict detected on the Data Asset during
a Schema refresh if any.

Column, Table Text

Refresh
Frequency

The frequency of refresh. Text

Report Image Image of the report view Looker Look, Tableau
View, Tableau Workbook

Text

Resolution The solution of how this issue can or
is resolved.

Issue Text

Result The result. Business Rule, Data
Quality Metric

True/False

Role Relationship name from head to tail. Text

Role in Report The use of Report Attribute in Report (for
example, measure or dimension)

Tableau Report Attribute Text

Row Count The number of rows inside the data set,
possibly including duplicated or missing
values

Column Numeric

Rows Failed The amount of rows that failed the rule. Data Quality Metric Numeric

Rows Passed The amount of rows that passed the
rule.

Data Quality Metric Numeric

Rule The description of the rule. Text
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Type Description Assigned to asset type Kind

Schema Name The name of the schema. Text

Scope The scope of applications that
correspond to this policy.

Crosswalk, Database, Data
Usage, Directory, Mapping
Specification, Policy,
Report, Report Attribute,
System, Technology Asset

Text

Security Clas-
sification

Classification of assets based on
sensitivity.

Column, Data Usage,
Report, Report Attribute

Text

Sequence Num-
ber

The sequence number of the asset.
Often used to order assets in a spe-
cific way.

Data Attribute Numeric

Size The size of the column in the table. Column Numeric

Source Type The source type of an asset. Text

Source Tags The tags assigned to the asset in the
source system. For more information,
go to Register a data source via
Edge.

Schema, Table, Data-
base View, Column

Text

Standard
Deviation

The statistical standard deviation of
values (numeric only)

Column Numeric

Start Date The date on which the assessment
was started.

Assessment Review Date

State The current state. Text

State Changed
by

The cause of the state change. Power BI Workspace Text

State Changed
Date

The date the state was changed. Data Sharing Agreement Text

Submission
Date

The date on which the assessment
was submitted.

Assessment Review Date
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Type Description Assigned to asset type Kind

Synchronization
Status

Provides information about the status of
the Schema synchronization.

Schema Text

Table Type The table type that is declared in the data
source. For example: TABLE, VIEW, ...

Table Text

Technical Data
Type

The Data Type of a data asset as it is
declared by the data source. For
example: String, Integer, Varchar, Blob,
Boolean, ...

Column, Data Attribute,
Data Element, Report
Attribute, Power
BI Column, Tableau Report
Attribute

Text

Threshold The minimum percentage of all rows
or entities that must pass the rule.

Data Quality Metric Numeric

Transformation
Logic

The transformation logic. Text

URL Uniform Resource Locator, also
colloquially known as web address.

Directory, File, File Group,
Looker Look, S3 Bucket,
Tableau Server, Tableau
Site, Tableau View

Text

Validation Res-
ult

The results of validation. True/False

Validation Script Contains the validation logic to eval-
uate the content of an asset.

Validation Rule Script

Value Dis-
tribution

The distribution percentage of the val-
ues

Numeric

Variance The statistical variance of values
(numeric only)

Column Numeric

Visible on server Worksheet is uploaded to Tableau
server.

Tableau View True/False

Visits count Number of visits on Tableau report Looker Dashboard, Looker
Look, Tableau View

Numeric
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Type Description Assigned to asset type Kind

Weighting Factor A factor by which some quantity is
multiplied in order to make it comparable
with others.

Numeric

Create an attribute type
You can create an attribute type. For example, if the packaged attributes types do not meet
your needs.

Prerequisites

You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. In the tab pane, click Characteristics → Attributes.
3. Above the table, to the right, click Add.

» The Create Attribute Type dialog box appears.
4. Enter the required information.

Field Description

Name The name of the object.

The name of the attribute type must be globally unique.

Tip
You can simultaneously create multiple objects. To do so, after typing
the name, press Enter, and then type the next name. If you enter a
name that already exists, it appears in the strike-through style.

Description The description of the object. This field is optional.
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Field Description

Kind The kind of information that attribute of this type can contain, for example, date,
number or selection.

Date A date value. If you edit attributes of this type, you can pick a date using the date
selector.

Note The date format that is displayed in the UI, can be different
depending on the language settings in your user profile. For example,
dd/mm/yyyy or yyyy/mm/dd.

Multiple
Selection

A field that allows multiple values that you can select from a predefined list.

with
values

The values from which you can select one or more.

Number A number, or a number with a fraction.

Only
integers.
(..., -2, -1,
0, 1, 2, ...)

Checkbox to only allow integer numbers.

Note Numeric values are stored as Floating Point values (IEEE 754
standard), which are not able to represent all numbers accurately. Due
to this technical constraint, rounding issues occur for both negative and
positive numbers.
The bigger the number, the more noticeable the rounding issue.

Metric Checkbox to make this attribute type a metric. This allows you to assign this
attribute type as a metric when you create a data quality rule.

Selection A field that allows a single value that you can select from a predefined list.

with
values

The values from which you can select one.

Text Textual input which may contain formatting.

Plain Text Checkbox to disable formatting.
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Field Description

True/False A binary option that allows you to indicate whether something is true or false.

Metric Checkbox to make this attribute type a metric. This allows you to assign this
attribute type as a metric when you create a data quality rule.

5. Click Save.

What's next?

You can now assign the attribute type to an asset type.

Edit an attribute type
You can edit the name and description of an attribute type. You can't edit the attribute
type's kind.

Tip If you want to edit an attribute type's kind, you have to delete the attribute type
first and then create a new one. Keep in mind that the new attribute type will have a
new ID.

Prerequisites

You have a global role that has the System administration global permission.

If you delete an attribute value from an attribute type of the Selection or Multiple Selection
kind, then you can no longer edit the values of the attributes of that type without removing
those invalid values. We recommend that you remove invalid attribute values from the
attributes before removing them from the attribute type.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
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3. In the tab pane, click Characteristics → Attributes.
» The table with attribute types appears.

4. In the table, double-click a name or description field.
5. Type the new name or description.
6. Click .

Delete an attribute type
You can delete custom attribute types. You cannot delete packaged attribute types.

Prerequisites

l You have a global role that has the System administration global permission.
l The attribute type is not a packaged attribute type.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Characteristics → Attributes.

» The table with attribute types appears.
4. At the end of the row of the attribute type that you want to delete, click .

» The Delete <attribute type> dialog box appears.
5. Click Yes.

Relation types
A relation is a characteristic that describes how two assets relate to each other. The
relation's type defines the relation and determines which assets can be related.
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About relation types
A relation is a characteristic that describes how two assets relate to each other. The
relation's type defines the relation and determines which assets can be related.

You can add a relation between assets if the relation's type is in the relevant assignment of
the asset's type.

Elements in a relation type

A relation type has four elements:

Element Description

Head Asset type of assets that can be the head of the relation.

Tail Asset type of assets that can be the tail of the relation.

Role The description of the relation type going from the head asset to the tail asset.

Co-role The description of the relation type going from the tail asset to the head asset.

Note Relations are bidirectional. For example, in the relation type "Table is part
of/contains Database", the Table asset is part of the Database asset, and the
Database asset contains the Table asset.

Overview of packaged relation types
A relation is a characteristic that describes how two assets relate to each other. The
relation's type defines the relation and determines which assets can be related.

The following table shows packaged relation types. You can also create new relation
types.
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Note
l role is the description of the relation type going from the head asset type to the
tail asset type.

l co-role is the description of the relation type going from the tail asset type to
the head asset type.

This is a table of all packaged relation types. For a sortable overview of all packaged
relation types, see the online version of this information in the Documentation Center.

Head Role Co-role Tail

Asset complies to applies to Governance Asset

Asset governed by governs Governance Asset

Asset is essential for requires Data Usage

Asset related to impacted by Asset

Asset specializes generalizes Asset

Asset uses used in Asset

Business Asset groups grouped by Business Asset

Business Asset has acronym is acronym for Acronym

Business Asset represents represented by Data Asset

Business Dimension classifies is classified by Asset

Business Dimension groups is grouped into Report

Business Dimension source is source of System

Business Process consumes is consumed by Business Asset

Business Process produces is produced by Business Asset

Business Term allowed value allowed value of Business Term
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Head Role Co-role Tail

Business Term has code is code for Code Value

Business Term synonym synonym of Business Term

Code Set source of source Crosswalk

Code Set target of target Crosswalk

Code Value groups grouped by Code Value

Code Value is part of contains Code Set

Column is part of contains Table

Data Asset groups is grouped by Data Asset

Data Asset implemented in implements Technology Asset

Data Asset is essential for is constrained by Data Usage

Data Element allowed value allowed value for Code Value

Data Element allowed value set applies to Code Set

Data Element is part of contains Data Structure

Data Entity contains is part of Data Attribute

Data Entity is part of contains Data Model

Data Quality Rule allowed value allowed value for Code Value

Data Quality Rule allowed value set allowed value set for Code Set

Data Quality Rule classified by classifies Data Quality Dimension

Data Quality Rule executed by executes Data Quality Metric

Data Quality Rule governs is governed by Data Element

Data Set contains is part of Data Element
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Head Role Co-role Tail

Data Set related to impacted by Business Asset

Data Sharing Agreement is requested by requests Business Dimension

Data Structure source of source Mapping Specification

Data Structure target of target Mapping Specification

Data Usage is required by requires Data Sharing Agreement

Directory contains is part of Directory

Directory contains is part of File Group

File contains is part of Table

File Container contains is contained in File

File Container contains is part of File Container

File Group contains is part of Table

File Storage contains is part of File Container

Governance Asset groups is grouped by Governance Asset

Governance Asset resolves resolved by Issue

Governance Asset violated by violates Issue

Issue categorized by categorizes Issue Category

Issue has duplicate is duplicate for Issue

Issue impacts impacted by Asset

Line of Business associates is associated with Business Asset

Policy is enforced by enforces Rule

Report groups is grouped into Report
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Head Role Co-role Tail

Report related to is impacted by Business Asset

Report uses used in Report

Report Attribute contained in contains Report

Report Attribute is source for is target of Report Attribute

Role Type is responsible for is responsibility of Asset

Rule is implemented by implements Business Rule

Schema contains is part of Table

Server hosts is hosted in Business Dimension

Standard is included in includes Policy

System implements is implemented in Data Set

Table is input for has input Transformation Rule

Table is part of contains Database

Tableau Site assembles is assembled in Tableau Project

Technology Asset groups is grouped by Technology Asset

Technology Asset has belongs to Schema

Technology Asset source system for source system Business Term

Technology Asset source system for source system Data Asset

Technology Asset system of record for system of record Business Term

Technology Asset system of record for system of record Data Asset

Technology Asset system of use for system of use Business Term

Technology Asset system of use for system of use Data Asset
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Head Role Co-role Tail

Transformation Rule is input for has input Transformation Rule

Transformation Rule produces is produced by Table

Create a relation type
You can create a new relation type if, for example, the packaged relation types do not
meet your needs.

Prerequisites

You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Characteristics → Relations.
4. Above the table, to the right, click Add.

» The Create relation type dialog box appears.
5. Enter the required information.

Element Description

Head Asset type of assets that can be the head of the relation.

Tail Asset type of assets that can be the tail of the relation.

Role The description of the relation type going from the head asset to the tail asset.

Co-role The description of the relation type going from the tail asset to the head
asset.

Chapter 9

459



Chapter 9

Note The combination of the relation type's head, tail, role, and co-role has to
be globally unique.

6. Click Create.

Example

The following example creates a part-whole relation type between two assets: Data
Element is part of / contains Data Structure.

What's next?

You can now assign the relation type to an asset type and after that add a relation to an
asset.

Edit relation types
You can edit a relation type by changing the role or co-role of a relation type or its
description.

Prerequisites

You have a global role that has the System administration global permission.
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Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Characteristics → Relations.
4. In the row of the relation type that you want to edit, click at the end of the Role or

Co-role column.
5. Enter the required information and click .

» The relation type is edited.

Note The combination of the relation type's head, tail, role, and co-role has to be
globally unique.

Delete a relation type
You can delete a relation type that you created yourself. However, you can't delete
packaged complex relation types.

Prerequisites

l You have a global role that has the System administration global permission.
l The relation type is not a packaged relation type.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Characteristics → Relations.
4. In the row of the relation type that you want to delete, click .

» The Delete <relation type> dialog box is shown.
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5. If a dialog box appears, click Yes.
» The relation type is deleted.

Complex relation types
A complex relation is a characteristic that describes how two or more assets relate to each
other. It can also have attributes of its own, for example, Description and Priority.
Technically, they are objectified associations: simplified assets that cannot exist
independently. The complex relation's type defines the relations and attributes the
complex relation can have.

About complex relation types
A complex relation is a characteristic that describes how two or more assets relate to each
other. It can also have attributes of its own, for example, Description and Priority.
Technically, they are objectified associations: simplified assets that cannot exist
independently. The complex relation's type defines the relations and attributes the
complex relation can have.

You can add a complex relation between assets if the complex relation's type is in the
relevant assignment of the asset's type.

Note A complex relation cannot have more than 32,767 relations to assets.

Example

When you add a complex relation, you add one or more relations between the assets and
the complex relation itself. The assets of those relations are always the head of the
relation, while the complex relation is always the tail.
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The following example creates a complex relation type called Code Mapping, with
three relation types (source, target and crosswalk) and two attribute types (Description and
Transformation Logic).

For each relation type in the complex relation type, you can select head assets. Above the
fields, you can see the minimum and maximum occurrences for each relation type. For
each selected head asset, a relation of the relevant type is created between the head
asset and the complex relation. You can also add attributes to the complex relation.

Cardinality of relation types and attribute types in complex relation
types

With complex relations, you can associate two or more assets in a relation and add
attributes to the complex relation. When you create a complex relation type, you set the
cardinality of the relation types and attribute types to determine how many relations and
attributes you can or must provide when you create a complex relation of that type.

Chapter 9

463



Chapter 9

Tip For every complex relation type, at least one relation type must have a
minimum cardinality of 1 or greater.

Overview of packaged complex relation types
A complex relation is a characteristic that describes how two or more assets relate to each
other. It can also have attributes of its own, for example, Description and Priority.
Technically, they are objectified associations: simplified assets that cannot exist
independently. The complex relation's type defines the relations and attributes the
complex relation can have.

The table below contains all packaged complex relation types. You can also create new
complex relation types.

Name Description Relation types Attribute types Assigned asset
types

Code Map-
ping

Complex mapping
between two or
more code values

Source - Code Value
(1:-)

l Description (0:1)
l Transformation
Logic (0:1)

l Code Value
l Crosswalk

Target - Code Value
(1:-)

Crosswalk - Cross-
walk (1: 1)

Data
Usage

Data Usage Uses - Data Asset
(1:-)

l Description (0:1)
l Materiality (0:1)

Used in - Business
Asset (1:-)

Governed by - Rule
(1:-)

Fact Type Head - Asset (1: 1) l Role (1:-)
l Co-role (1:-)

Tail - Asset (1: 1)
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Name Description Relation types Attribute types Assigned asset
types

Field Map-
ping

Complex mapping
between two or
more data fields

Source - Data Ele-
ment (1:-)

l Description (0:1)
l Transformation
Logic (0:1)

l Column
l Data Attribute
l Data Element
l Field
l Mapping Spe-
cification

l Report Attrib-
ute

Target - Data Ele-
ment (1:-)

Mapping spe-
cification - Mapping
Specification (1: 1)

Foreign
Key Map-
ping

Complex mapping
between two
columns rep-
resenting a
primary key and a
foreign key

Constrains - Column
(1: 1)

l Key sequence
(1:1)

l Column
l Foreign Key

References -
Column (1: 1)

Is part of - Foreign
Key (1: 1)

Create a complex relation type
You can create a complex relation type. For example, if the packaged complex relation
types do not meet your needs.

Prerequisites

You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Characteristics → Complex Relations.
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4. Above the table, to the right, click Add.
» The Create complex relation type dialog box appears.

5. Enter the required information.

Field Description

Name The name of the complex relation type.

Note The name of the complex relation type must be globally unique.

Description The description of the complex relation type.

Display options These fields allow you to edit how complex relations of this type are rep-
resented in diagrams.

Color The default colors that you can use for the complex relation nodes of this
type.

Color hex
value

The hexadecimal value of the color that you want for complex relations of this
type.

For a list of colors and their hexadecimal values, see ColorHexa.

Symbol A graphical representation for complex relations of this type.

You can choose one of the following values:

o None: No graphical representation is used for complex relations of
this type.

o Code: Complex relations of this type are represented with a code in
front of them. You can specify the code that you want in the Code
field.

o Icon: Complex relations of this type are represented with an icon in
front of them. You can select the icon that you want in the Icon ref-
erence field.

Code The code that is displayed in front of complex relations of this type. This code is
also displayed in the legend of diagrams.

This field is only displayed if you have selected Code in the Symbol field.
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Field Description

Icon
reference

The icon that is displayed in front of complex relations of this type. This icon is
also displayed in the legend of diagrams.

This field is only displayed if you have selected Icon in the Symbol field.

Preview Two previews of the representation of complex relations of this type:

o The left preview is the title bar on a complex relation page.
o The right preview is a diagram node.

Relations The relation types of the complex relation type.

At least one relation type is required.

Role The description of the relation type going from the head asset to the tail asset.

Co-role The description of the relation type going from the tail asset to the head asset.

Asset type The asset type of the head of the relation. The complex relation type can only be
used by assets of this asset type or its children if the complex relation type is in
the asset type's assignment.

The complex relation is always the tail of the complex relation type.

Min. The minimum amount of relations of this type.

You must have at least one relation with a minimum cardinality of 1 or greater.

Max. The maximum amount of relations of this type.

Attributes The attribute types of the complex relation type.

Attribute
Type

The attribute type used by this complex relation type.

Min. The minimum amount of attributes of this type.

Max. The maximum amount of attributes of this type.

6. Click Save.
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What's next?

You can now assign the complex relation type to an asset type and after that add a
complex relation to an asset.

Edit a complex relation type
You can edit the name, description and display options of a complex relation type. You
can't edit existing relations and attributes in the complex relation, but you can add relations
and attributes to the complex relation type.

Tip If you want to edit the relations or attributes of a complex relation type, you
have to delete the complex relation type first and then create a new one. Keep in
mind that the new complex relation type will have a new ID.

Prerequisites

You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Characteristics → Complex Relations.
4. In the row of the complex relation type that you want to edit, click .

» The Edit complex relation dialog box appears.
5. Enter the required information.

Field Description

Name The name of the complex relation type.

Note The name of the complex relation type must be globally unique.
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Field Description

Description The description of the complex relation type.

Display options These fields allow you to edit how complex relations of this type are rep-
resented in diagrams.

Color The default colors that you can use for the complex relation nodes of this
type.

Color hex
value

The hexadecimal value of the color that you want for complex relations of this
type.

For a list of colors and their hexadecimal values, see ColorHexa.

Symbol A graphical representation for complex relations of this type.

You can choose one of the following values:

o None: No graphical representation is used for complex relations of
this type.

o Code: Complex relations of this type are represented with a code in
front of them. You can specify the code that you want in the Code
field.

o Icon: Complex relations of this type are represented with an icon in
front of them. You can select the icon that you want in the Icon ref-
erence field.

Code The code that is displayed in front of complex relations of this type. This code is
also displayed in the legend of diagrams.

This field is only displayed if you have selected Code in the Symbol field.

Icon
reference

The icon that is displayed in front of complex relations of this type. This icon is
also displayed in the legend of diagrams.

This field is only displayed if you have selected Icon in the Symbol field.

Preview Two previews of the representation of complex relations of this type:

o The left preview is the title bar on a complex relation page.
o The right preview is a diagram node.
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Field Description

Relations The relation types of the complex relation type.

At least one relation type is required.

Role The description of the relation type going from the head asset to the tail asset.

Co-role The description of the relation type going from the tail asset to the head asset.

Asset type The asset type of the head of the relation. The complex relation type can only be
used by assets of this asset type or its children if the complex relation type is in
the asset type's assignment.

The complex relation is always the tail of the complex relation type.

Min. The minimum amount of relations of this type.

You must have at least one relation with a minimum cardinality of 1 or greater.

Max. The maximum amount of relations of this type.

Attributes The attribute types of the complex relation type.

Attribute
Type

The attribute type used by this complex relation type.

Min. The minimum amount of attributes of this type.

Max. The maximum amount of attributes of this type.

6. Click Save.

Delete a complex relation type
You can delete custom complex relation types. However, you can't delete packaged
complex relation types.

Prerequisites

l You have a global role that has the System administration global permission.
l The complex relation type is not a packaged complex relation type.
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Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Characteristics → Complex Relations.
4. In the row of the complex relation type that you want to delete, click .

» The Delete <complex relation type> dialog appears.
5. Click Yes.

» The complex relation type is deleted.
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Domain types
A domain type is a property of a domain that determines which assets can be included in
the domain, based the asset's type.

Some asset types can only be created in a specific Collibra application and in a specific
domain type. For example, you can only create assets of the Validation Rule type in a
domain of the Validation Rule Domain type. You can see the required domain type in the
assignment of the asset type.
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Overview of packaged domain types
A domain type is a property of a domain that determines which assets can be included in
the domain, based the asset's type.

The table below contains all packaged domain types and their description. You can find
out about domain types that are not packaged on their dedicated pages, such as Process
Register, which is part of Data Privacy.

Tip For an interactive overview of all packaged domain types, including the
relevant asset types and applications, see the online version of this documentation.

Type Type Description

BI Catalog BI Catalog A collection of Tableau assets with the list of related
attributes.

Business Asset
Domain

Business Asset
Domain

Business
Dimensions

Business
Asset Domain
Business
Dimensions

A set of business dimensions that categorize and
describe business terms.

Report Catalog Business
Asset Domain
Report Catalog

A collection of reports and their definitions with the
list of related report characteristics.

Codelist Codelist Any kind of data that is used solely to categorize other
data found in a database, or solely for relating data in a
database to information beyond the boundaries of the
enterprise.

Hierarchies Codelist
Hierarchies

A Code list with a hierarchical structure in its Code
Values
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Type Type Description

Data Asset Domain Data Asset Domain

Data Usage
Registry

Data Asset
Domain
Data Usage Registry

A collection of data usage agreements and related
data structures.

Logical Data
Dictionary

Data Asset
Domain
Logical Data
Dictionary

Represents details of organizational data,
independent of any particular technology, and
uses vocabulary of a business area to
communicate with non-technical stakeholders.

Mapping Domain Data Asset
Domain
Mapping Domain

Groups data assets of the crosswalk type (to map
between code sets) and mapping specification
(used to map between data structures).

Physical Data
Dictionary

Data Asset
Domain
Physical Data
Dictionary

A collection of physical objects, such as tables,
columns, file fields, views and APIs, to describe
how data is stored, arranged and related to each
other in a data storage technology/location.

Glossary Glossary A prioritized list of business terms and acronyms,
and their meanings.

Governance Asset
Domain

Governance Asset
Domain

Assessment
Review Register

Data
Governance
Domain
Assessment Review
Register

Domain type for Assessment Review assets,
which are created when an assessment is
conducted on an asset and submitted for review.
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Type Type Description

Policy Domain Data
Governance
Domain
Policy Domain

A set of polices and standards related to an
organization.

Rulebook Data
Governance
Domain
Rulebook

A set of rules that are used as a basis for making
decisions and governing programs or policies.

Issue Classification Issue Classification

Storage Catalog Storage Catalog A domain type that contains assets of the asset type S3
File System or GCS File System.

Technology Asset
Domain

Technology Asset
Domain

An inventory of all technology assets and their
business benefits.

Validation Rule
Domain

Validation Rule
Domain

A domain type for domains containing validation
rules.

Create a domain type
You can create new domain types.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Domain Types.

» The domain type table appears.
4. Above the table, to the right, click Add.

» The Domain Type Creation dialog box appears.
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5. Enter the required information.

Option Description

Name Type a name for the domain type.

You can enter more than one value at a time. To do this, press Enter after typing
a value and then type the next.

Parent Type Select the parent domain type.

6. Click Create.

Edit a domain type
You can edit the name and the description of a domain type in the domain type table.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Domain Types.

» The domain type table appears.
4. In the Name or Description column, do one of the following:

o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
5. Edit the name or description.
6. Click .

Move a domain type
You can move a domain type to another parent domain type in the domain type table.
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Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Domain Types.

» The domain type table appears.
4. At the end of a row, click .

» The Select Parent Domain Type dialog box appears.
5. Enter the required information.

Field Description

Parent type Select the new parent type of the domain type.

6. Click Save.

Delete a domain type
You can delete a domain type in the domain type table.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Domain Types.

» The domain type table appears.
4. At the end of a row, click .

» The Delete <domain type> dialog box appears.
5. Click Yes.
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Asset statuses
The status indicates the condition of an asset or workflow.
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Overview of packaged statuses
Use statuses to reflect the life cycle of resources. The following statuses can be used out
of the box in your workflows.

Status Description Use

Accepted The stewards approved an asset
definition.

The technical stewards are granting the
requested access.

The reviewer is appointing an assignee to
resolve an issue.

An asset is accepted at the end of the
Approval and Simple Approval workflows.

A data usage asset is accepted when the
approvers, who are the owners of the
resources that are part of an access
request, have approved the request in the
Request Assets Access workflow.

An issue is accepted after the stewards
approved its proposed solution. At this
stage of the Issue Management workflow,
the reviewer either appoints an assignee
or marks the issue as resolved.

Access Granted The requester has been granted
access to the requested resources.

The requester is assigned a Data Ana-
lyst Level 2 role for the newly granted
resources, as the final step in the
Request Assets Access workflow.

Approval Pending The approvers are voting for the
approval of a data usage request.

A data usage asset has this status dur-
ing the voting sub-process of the
Request Assets Access workflow.

Approved Currently not in use.

Candidate The initial status of an asset. Newly created assets receive this
status.

Deployed The initial status of a workflow. Refers to workflow definitions.

Disabled The workflow is currently not in use. Refers to workflow definitions.

Enabled The workflow is currently active. Refers to workflow definitions.
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Status Description Use

Implemented Currently not in use.

In Progress The assignee is solving the issue. The status is used in the Issue Man-
agement workflow.

Invalid The reviewer rejected an issue.

The initial status of a data usage asset.

Reviewers can reject invalid issues during
the Issue Management workflow.

Newly created data usage requests
receive this status in the Request Assets
Access workflow.

Monitored Currently not in use.

New The initial status of an issue. Newly created issues receive this
status.

Obsolete Currently not in use.

Pending The requester is providing more
information about an issue.

The status is used in the Issue Man-
agement workflow.

Rejected The approvers rejected the data
usage request.

The status is used in the Request
Assets Access workflow.

Resolution Pend-
ing

The reviewer is validating the
asignee's solution to an issue.

Resolved The issue is resolved. The status is used in the Issue Man-
agement workflow.

Reviewed Currently not in use.

Submitted for
Approval

The stakeholders are verifying the pro-
posed solution to an issue.

The status is used in the Issue Man-
agement workflow.
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Status Description Use

Under Review The stakeholders are reviewing an asset.

The reviewer is analyzing an issue and
proposing a solution.

An asset is under review from the
moment the subject matter experts have
approved its definition until it is accepted
in the Approval workflow. There is no
intermediary status in the Simple Approval
workflow.

After being submitted or after being
rejected by the stakeholders, an issue is
under review while a reviewer analyzes it,
in the Issue Management workflow.

Create a status
Collibra Data Intelligence Cloud comes out of the box with a large number of statuses for
all the resources, for example assets and workflow tasks.

Prerequisites
You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Statuses.
4. Above the table, to the right, click Add.
5. Type the name for the status.

You can create multiple statuses at once by pressing Enter and type another name.
Statuses that already exist appear in strike-through format.

6. Click Create.
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Edit a status
You can edit the name and the description of a status.

Tip If you enter a description, it appears as a tooltip next the status on asset pages.
You can use this to give more details about the status to other users.

Prerequisites
You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Statuses.
4. Do one of the following in the Name or Description column:

o Double-click a cell.
o Hover your mouse over a cell and click .

» The cell editor appears.
5. Enter the new name or description.
6. Click .

Delete a status
You can delete a status if is no longer used in any kind of workflow.

Note Enabled, Disabled and Deployed are system resources. They are specific to
describe workflows and cannot be deleted.
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Prerequisites
l You have a global role that has the System administration global permission.
l The status that you want to delete is not used by any asset.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
3. In the tab pane, click Statuses.
4. On the right of the status you want to delete, click .

» The Delete dialog box appears.
5. Click Yes.

»  The status is deleted.
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Articulation score
The articulation score of an asset is a percentage that indicates how complete the asset is
according to the articulation score rules. It is typically used to give you a quick estimation
of the status of the asset and whether the most important characteristics are present.

The score is shown in the title bar of the asset page, a column in a table or as a field on a
tile.

In this section you will learn more about how the articulation score is calculated and how
you can manage the articulation score rules.
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Articulation scores
The articulation score of an asset is a percentage that indicates how complete the asset is
according to the articulation score rules. It is typically used to give you a quick estimation
of the status of the asset and whether the most important characteristics are present.

You can configure an articulation score calculator that contains your own rules. Whenever
an asset is edited, either manually or via a workflow, the articulation score is reset to 0 and
the articulation score rules are executed in their specific order.

The score is shown in the title bar of the asset page, a column in a table or as a field on a
tile.

Note
l You may have to refresh the page after you edited the asset to see the new
score.

l If you edited the articulation rules or their assignment, the articulation score of
the assets to which it is assigned does not recalculate. You still need to edit
each asset to trigger recalculation of the articulation score.

Articulation score rules
An articulation rule consists of a number of fields that determine when a rule applies and
what the result is.

l The Condition field and the subsequent Status or Characteristic field determine
when a rule applies. These fields allow your rule to look for a specific status or a spe-
cific characteristic. Having multiple instances of the same characteristic, for
example, two notes, does not apply the rule more than once.

l The Score and Value fields determine what the effect of the articulation rule is. You
can either increase the score, or set the score to a specific value.
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Note
l 'Increasing the score' means that the value will be added to the percentage
that was received from the other rules. It does not increase the score of the
asset before it was edited.

l If a rule sets the score to a specific value, all previous rules effectively become
useless.

Example

Suppose this is the articulation score calculator:

1 Condition

Characteristic added

Characteristic

Definition

Score

Increase score by

Value

33

2 Condition

Status set to

Status

Candidate

Score

Sets score to

Value

0

3 Condition

Status set to

Status

In progress

Score

Sets score to

Value

10

4 Condition

Status set to

Status

Under review

Score

Sets score to

Value

50

5 Condition

Status set to

Status

Reviewed

Score

Sets score to

Value

80

6 Condition

Status set to

Status

Accepted

Score

Sets score to

Value

100

7 Condition

Characteristic added

Characteristic

Note

Score

Increase score by

Value

22

A business term has the following attributes:

l Status: In progress
l A definition
l A note
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l Articulation score: 32%
a. Articulation score rule 1 matches and adds 33%.

» Current score: 33%
b. Articulation score rule 2 does not match.
c. Articulation score rule 3 matches and sets the score to 10%.

» Current score: 10%
d. Articulation score rule 4 does not match.
e. Articulation score rule 5 does not match.
f. Articulation score rule 6 does not match.
g. Articulation score rule 7 matches and adds 22%

» Final articulation score: 32%

A second note is added, the definition is deleted and the status of the business term is
changed to Reviewed. It now has the following attributes:

l Status: Reviewed
l Two notes
l Articulation score: 100%

a. Articulation score rule 1 does not match.
b. Articulation score rule 2 does not match.
c. Articulation score rule 3 does not match.
d. Articulation score rule 4 does not match.
e. Articulation score rule 5 matches and adds 80%.

» Current score: 80%
f. Articulation score rule 6 does not match.
g. Articulation score rule 7 matches and adds 22%

» Final articulation score: 100%

Create an articulation score rule
You can create a new articulation score rule. For example, you can do this if you want to
give users a quick indication about the completeness of an asset.
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Steps

1. Open the scope of an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. Click the name of an asset type.

2. In the tab pane, click <name of the scope>, then click Articulation.
The default scope is Global assignment.

3. Above the table, to the right, click Edit.

4. Above the table, to the right, click Add rule.
» A new row for an articulation rule appears at the bottom of the list.
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5. Enter the required information.

Field Description

Condition The condition of the articulation rule that determines when the rule applies.

o Status set to: The score depends on a specific status of an asset.
o Characteristic added: The score depends on a specific characteristic
of an asset.

Status The specific status that an asset must have for the rule to apply.

This field only appears if the Condition is Status set to.

Characteristic The specific characteristic that an asset must have for the rule to apply.

This field only appears if the Condition is Characteristic added.

Score The impact on the score if an asset meets the condition and status or
characteristic.

o increase score by: Adds a value to the articulation score
o sets score to: Sets the articulation score to a specific value. As a con-
sequence, the previous score and the previous rules are discarded.

Value The value that is used by the rule.

6. Click Save.

Example
To specify that adding an attribute adds 20 % to the calculation score, configure the
following:

Result: The articulation calculator is added to the articulation table and is assigned to the
given asset types.

Edit an articulation score rule
You can delete an articulation score rule. For example, you can do this if you want to
increase the importance of a certain attribute type on the articulation score.
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Steps

1. Open the scope of an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. Click the name of an asset type.

2. In the tab pane, click <name of the scope>, then click Articulation.
3. Above the table, to the right, click Edit.
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4. Enter the required information.

Field Description

Condition The condition of the articulation rule that determines when the rule applies.

o Status set to: The score depends on a specific status of an asset.
o Characteristic added: The score depends on a specific characteristic
of an asset.

Status The specific status that an asset must have for the rule to apply.

This field only appears if the Condition is Status set to.

Characteristic The specific characteristic that an asset must have for the rule to apply.

This field only appears if the Condition is Characteristic added.

Score The impact on the score if an asset meets the condition and status or
characteristic.

o increase score by: Adds a value to the articulation score
o sets score to: Sets the articulation score to a specific value. As a con-
sequence, the previous score and the previous rules are discarded.

Value The value that is used by the rule.

5. Click Save.

Delete an articulation score rule
You can delete an articulation score rule. For example, you can do this if you no longer
need an existing articulation score rule.

Steps

1. Open the scope of an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. Click the name of an asset type.

2. In the tab pane, click <name of the scope>, then click Articulation.
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3. Above the table, to the right, click Edit.

4. Click next to the rule that you want to delete.

5. Click Save.
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Asset data quality
The Quality page of an asset makes data quality results of an asset available to the
business stakeholders. The dashboard aggregates the following values:

l Collected over time on attributes.
l Aggregated from different assets along a number of predefined relations.

The assets for which these data quality dashboards are available and how the values are
aggregated are defined in data quality rules, which can be edited on the Data Quality Rule
tab on the Settings page. For the following examples, a data quality rule exists on

business terms, aggregating values from data quality rules related to these business
terms.

Asset quality
The assets for which the quality dashboard is available have an extra option in their tab
menu, namely Quality. The dashboard displays the aggregated passing fraction (quality
score) for the asset in the form of ring charts.

Each ring chart shows the quality score in the form of:

l A quality score as a percentage.
l A color code indicating the quality of this passing fraction:

o Red: 0-50%
o Orange: 50-85%
o Green: 85 - 100%

l An arrow indicating the trend of the score compared to the previous measurement.

The first ring chart shows the general score of the asset. The ring charts next to it show
subscores for a specific dimension, such as Accuracy, Conformity, Completeness and
Consistency. Only values that belong to that specific dimension are then taken into
account. The dimensions to use are configured in the metric group. In this example, it is
the relation: Data Quality Rule is Classified By Data Quality Dimension.
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Underneath the top pane, three selection boxes are available. They display an extra
overview, details and history pane, respectively.

To close a pane, click in the upper-right corner of the pane.

Data quality overview pane
The Overview pane shows more information about each level in the aggregation path for
the selected general score or dimension. For each level, it shows the number of involved
assets of a certain type and what their results are: failing (red) or passing (gray). It also
shows the total number of rows, the number of failing rows (red) and the number of
passing rows (gray) that resulted in the given scores.

In the following example, the Conformity dimension consists of a total of 38 070 rows, 26
575 of which were failing. Two Data Quality Rules were involved, one of which was failing.
And these Data Quality Rules were used by one Data Entity, which has an aggregated
failing result.

Asset quality details pane
The Details pane shows more information about all the assets involved in a table format.

For each asset, a row with the following default columns is shown:

l Data Asset: The data asset signifier
l Rows Passed: The number of passing rows, aggregated as a sum of the passing
rows of the underlying assets

l Rows Failed: The number of failing rows, aggregated as a sum of the failing rows of
the underlying assets

l Quality Score: The score aggregated as an average of the quality scores of the
underlying assets
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l Result (failing or passing): The aggregated result as a logical conjunction of the res-
ults of the underlying assets.

Some extra columns can be displayed in this table by clicking → Columns.

These include:

l Full name: The unique full name of the asset.
l Domain: The domain to which the asset belongs.
l Type: The type of the asset.
l Dimension: The dimension that applies to these assets, if any. Dimensions are used
to calculate the subscores, as mentioned earlier.
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Asset quality history
The History pane shows the evolution of the quality score over time, for up to one month in
the past.

You can display the date and the score for a specific period at the top right of the pane by
hovering your pointer over that period.

When you select a period by clicking on it, the top left corner of the pane shows a trend of
the score compared to the period before it.

Data quality rules
Data quality rules are rules that calculate the quality of a certain asset based on a
predefined aggregation path and metrics. The results of a data quality rule are available in
a data quality dashboard on the asset page of assets of the type to which you assigned the
data quality rule.

Data quality and report certification
Data quality is an important aspect of report certification. However, we understand that not
all organizations are at a stage in their governance program where data quality is fully
enabled.

When you are certifying a report, the last step of the Certify Report workflow involves a
data quality check to ensure:
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l The report contains data attributes.
l All columns have positive data quality metrics.

Important Data quality is a mandatory criterion for attaining the Gold certification
level. If you don't have data quality configured, the highest certification level a report
can attain is Silver.

About data quality rules
Data quality rules are rules that calculate the quality of a certain asset based on a
predefined aggregation path and metrics.

The results of a data quality rule are available in a data quality dashboard via the Quality
tab on the asset page of the asset for which you calculated its data quality. Data quality
rules define for which assets the data quality dashboard is created and how the data
quality values are aggregated. A data quality result aggregates values that have been
collected over time on attributes and that are aggregated from different assets along a
number of predefined relations.

Example
The example shows the data quality rule Default Insurance data quality rule for
business term and is explained in more detail in the following sections.
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Fields

Name and Description

The data quality rule consists of a unique name and a description that is shown in the Data
quality rules table in the DGC Settings and in the assignments of an asset type.

Path

The data quality rule aggregates values that are collected through a defined aggregation
path. An aggregation path consists of a chain of relations that is to be followed from the
asset to which the data quality rule is assigned, to the asset containing the actual values.

In the example above, values from 'Governance Assets' are aggregated for 'Business
Assets' by looking up:

l The 'Data Assets' that these business assets are represented by.
l The 'Governance Assets' that these data assets are governed by.

Categorization

Select a relation in the categorization field to create subscores for assets at the end of the
aggregation path that have this relation. The data quality dashboard on the asset's page
then shows these subscores. These subscores are attributes belonging to the asset that
has a relation to the asset at the end of the aggregation path.

The data quality dashboard also shows subscores limited to certain dimensions, such as
'Accuracy'. The values of an asset at the end of the aggregation path are only taken into
account for these subscores if the asset 'belongs' to the given dimension. An asset
'belongs' to a dimension when it has a relation of the type defined in the Categorization to
that dimension. In the given example, the 'Data Quality Rule' should have a relation
Classified by to, for example, the 'Accuracy' Data Quality Dimension.

Metrics

The metrics of a data quality rule define the values that are displayed in the data quality
dashboard and which operation should be used when aggregating the value. These values
are attributes that are available on the last asset of the aggregation path, in this example
the 'Governance Asset'.

This section contains a couple of metrics that are fixed for each metrics group:
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Name Operation Description

Rows Passed Total The aggregated sum of passing rows.

Rows Failed Total The aggregated sum of failing rows.

Result Logical AND The aggregated logical and of the result: failing or passing.

Passing Fraction Average The aggregated average of the passing fraction (quality score).

You can add extra metrics and their corresponding operation by clicking Add Metric.

Create a data quality rule
You can create a new data quality rule.

Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. In the tab pane, click Data quality rules.
3. Above the table, to the right, click Add.
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4. Enter the required information.

Field Description

Name The name of the data quality rule.

Description The description of the data quality rule.

Path The chain of relations to follow from the asset to which the data quality rule is
assigned, to the asset containing the actual values.

Categorization The relation type that determines to which subscore the metric belongs.

The values of an asset at the end of the aggregation path are only taken into
account for these subscores if the asset has the relation that you enter here.

Metrics The metrics of a data quality rule define the values that are displayed in the data
quality dashboard and which operation should be used when aggregating the
value. These values are attributes that are available on the last asset of the
aggregation path.

This section contains a couple of metrics that are fixed for each metrics group:

o 'Rows Failed', operation 'Total': aggregated sum of failing rows
o 'Rows Passed', operation 'Total' aggregated sum of passing rows
o 'Passing Fraction', operation 'Average': aggregated average of the
passing fraction (quality score)

o 'Result', operation 'Logical AND': aggregated logical and of the result:
failing or passing

You can add extra metrics and their corresponding operation by clicking Add
Metric.

5. Click Save.
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Validation rules
Validation rules are special assets of the type Validation Rule. They allow you to verify
whether assets meet certain criteria. They have a special attribute Validation Script,
which contains a validation script that evaluates assets of the types to which the validation
rule is assigned.

Administrator actions
l Create a domain of the type Validation rule domain.
l Create a validation rule.
l Edit a validation rule.
l Delete a validation rule.
l Assign a validation rule to an asset type.
l Change the order of validation rules.
l Unassign a validation rule from an asset type.

User actions
l Validate assets.
l View the validation result.
l Revalidate an asset.
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Create a validation rule
You can create validation rules to verify whether assets meet certain criteria.

Prerequisites
l You have a domain of the type Validation Rule Domain.
l You have a global role that has the System administration global permission.

Steps

1. Open the product for which you want to create an asset (for example, Business
Glossary).

2. On the main toolbar, click .

» The Create dialog box appears.
3. On the Assets tab, click Validation Rule.

» The Create Asset dialog box appears.
4. Enter the required information.

Field Description

Type The asset type of the asset that you are creating.

Domain The domain to which the asset will belong.

Tip Ensure that the domain type of the selected domain is assigned to
the selected asset type.

Name A name to identify the asset.

Tip
You can simultaneously create multiple assets.
To do so, after typing the name, press Enter, and then type the next
name. Depending on the settings, asset names may need to be unique in
their domain. If you enter a name that already exists, it appears in the
strike-through style.
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5. Click Create.
» A message stating that one or more assets are created appears in the upper-right
corner of the page.

What's next?
l You can now open and edit the validation rule asset, for example to add a validation
script.

l Assign the validation rule to an asset type.

Edit a validation rule
You can edit validation rules.

Prerequisites
l You have a global role that has the System administration global permission.

Steps

1. Open a validation rule asset.
» The asset page appears.

2. Double-click any attribute.
3. Fill in the required information.

Note Learn more about the validation script attribute here: Validation scripts.

4. Click Save.

Delete a validation rule
You can delete validation rules in the same way as normal assets.

You cannot delete a validation rule if it is assigned to an asset type.
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Prerequisites
l You have unassigned the validation rule from asset types.
l You have a global role that has the System administration global permission.

Steps

1. Open the validation rule domain to which the validation rule belongs.
2. In the first row of the validation rule table, select one or more checkboxes.
3. In the action toolbar, click Delete.

» The Delete assets dialog box appears.
4. Click Yes.

Assign a validation rule to an asset type
You can assign a validation rule to an asset type by adding it to the asset type's
assignment. As a result, you can validate assets of this type against this validation rule, if
the asset is in the scope of the assignment.

Prerequisites
l You have a global role that has the System administration global permission.
l You have created a Validation Rule asset.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. In the tab pane, click Validation rules.

» The Asset type - Validation rules editor appears.
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4. Above the table, to the right, click Edit.
5. Above the table, to the right, click Add.

» The Add validation rule dialog box appears.
6. Click a validation rule.

» The validation rule appears at the bottom of the list of validation rules.
If required, change the order.

7. Click Save.

Change the order of validation rules
You can change the order of validation rules that are assigned to an asset type.

The order of the validation rules will determine the order in which they are executed and
shown on the asset page.

Prerequisites
l You have an asset type that has multiple validation rules assigned to it.
l You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click the name of the assignment.
3. In the tab pane, click Validation rules.

» The Asset type - Validation rules editor appears.
4. Above the table, to the right, click Edit.
5. Click in front of a validation rule and hold down the mouse button.

6. Move your mouse to the desired location in the order.
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7. Release the mouse button.
8. Click Save.

Unassign a validation rule from an asset type
You can unassign a validation rule from an asset type via its assignment.

Prerequisites
l A validation rule that is assigned to an asset type.
l You have a global role that has the System administration global permission.

Steps

1. Open an asset type.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. Click Operating Model.

» The operating model settings appear on the Asset types tab page.
c. In the overview of asset types, click an asset type.

» The Asset type editor opens.
2. In the tab pane, click Global assignment or the scope to which you want to add the

validation rule.
3. In the tab pane, click Validation rules.

» The Asset type - Validation rules editor appears.
4. Above the table, to the right, click Edit.
5. In the validation rule table, click at the end of the line of a validation rule.

6. Click Save.

Executing validation rules
You can execute validation rules in many ways:

l Validate assets
Do this to manually validate assets.

l Revalidate an asset
Do this after editing an invalid asset.
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l Automatically.
You can configure a workflow to start a validation on given events. For example
when a asset is added or an attribute is edited.
To configure triggers on certain events, see Getting started with workflows.

Validation logging
Collibra Data Governance Center can write extensive log messages from the execution of
validation rules. These messages are written to the dgc.log file.

If the execution of a validation rule fails, analyzing the log is probably the most thorough
approach.

For more information on how to configure validation logging, see Logging.

Tip When contacting support regarding a problem with validation, attach the log file
to the ticket.

Validate assets
Validating an asset executes all validation rules assigned to the asset type. If an asset
does not meet all validation rules, the asset is invalid.

You can see the validation result on:

l An asset page’s title bar.
l As a column, when viewing assets in table display mode.
l As a field, when viewing assets in tiles display mode.
l As an overlay in a traceability diagram.

After validation, the dgc.log file will also contain more extensive messages. For more
information on how to configure validation logging, see Logging.

Note By default, validation is not automatically triggered when an asset is edited,
so you have to revalidate it after editing an asset. However, you can create a
workflow for this. To configure validation on certain events, see Getting started with
workflows.
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Prerequisites

l Either of the following:
o You have a resource role with the Validation Execution resource permission,
for example Community Manager.

o You have a global role that has the Manage all resources global permission.

Validate an asset from the asset page

1. Open an asset page.
2. In the resource toolbar, click (validate).

Validate one or more assets from an asset table

1. Open a set of assets in table display mode.
2. Select checkboxes in front of the assets you want to validate.
3. In the action toolbar, click Validate.

Validate one or more assets from a set of tiles

1. Open a set of assets in tile display mode.
2. Select the assets you want to validate.
3. In the action toolbar, click Validate.

Revalidate an asset
You can revalidate assets that were previously validated to see whether they meet the
validation rules that are assigned to the asset type.
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Validating an asset executes all validation rules that are assigned to the asset types. If an
asset does not meet all validation rules, the asset is invalid.

You can see the validation result:

l An asset page’s title bar.
l As a column, when viewing assets in table display mode.
l As a field, when viewing assets in tiles display mode.
l As an overlay in a diagram.

Note You can create a workflow to automatically revalidate assets. To configure
validation on certain events, see Getting started with workflows.

Prerequisites

l Either of the following:
o You have a resource role with the Validation Execution resource permission,
for example Community Manager.

o You have a global role that has the Manage all resources global permission.

Revalidate an asset from the asset page

1. Open an asset.
2. In the upper right corner, click valid or invalid.

3. Click Revalidate.

Revalidate one or more assets from an asset view

1. Open an asset table.
2. Select checkboxes in front of one or more assets.
3. In the action toolbar, click Validate.
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Revalidate an asset from an asset view

1. Open an asset table.
2. If you don't see the Validation Result column, add it to the table.

More info on adding columns to a table: Customizing tables.
3. Click or .

You can see the validation result of each validation rule.
4. Click Revalidate.

View the validation result
After validating or revalidating assets, you can view the result and make changes where
necessary.

View the validation result from the activities list

1. Open the activities list.
» In the table, you see the validations.

2. In the results column, click Result.
» The Validation results dialog box appears.
Example
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3. The results column shows or to indicate whether they are respectively valid or

invalid.

Tip If you want to fix invalid assets, you can open them by clicking them.

View the validation result on the asset page

1. Open an asset page.
2. In the upper right corner, you see valid or invalid.

View the validation result in an asset table

1. Open an asset table.
2. If you don't see the Validation Result column, add it to the table.

More info on adding columns to a table: Customizing tables.
3. Click or .

» You can see the validation result of each validation rule.
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Validation scripts
A validation script is an attribute of a validation rule asset. It contains the validation logic,
which expresses a single condition to evaluate assets.

The outcome of the evaluation is binary:

l valid: The validated asset meets the condition.
l invalid: The validated asset does not meet the condition.

Depending on the result, it can also show a custom message.

Validation scripts are written using a syntax that is based on Groovy, but enhanced
specifically for validation rules in Collibra Data Intelligence Cloud.

Tip For general syntax-related questions, you can always refer to the Groovy
syntax.

Within the validation script, you can use the following features:

l Aggregate functions
l Validation functions
l Multi-line boolean expressions
l Collections
l Closures

Validation script structure
The structure of validation scripts can be basic or advanced. More information:

l Basic script structure
l Advanced validation script structure

Basic script structure

The basic script structure only contains the pure validation logic in a rule. More
information: Validation logic.
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rule {

}  

Example
The following script checks that the asset name is not empty and contains more than two
characters.

rule {
isNotEmpty(name, message: "Name cannot be empty") &&
isLengthMore( name, 2, message: "Name should have more
than 2 characters")

}

Advanced validation script structure

The advanced script structure contains up to three sections, which are all contained in a
rule.

rule {
given {
}
when { 
}
then {
}

}

Example

rule {
given {

definitions = attributes['Definition']
}
when {

isEqual(type.id,\
'00000000-0000-0000-0000-000000011001')

}
then {

isNotEmpty(definitions, \
message: "The asset ${name} \

in domain ${vocabulary.name} must have
at least one definition")

}
}
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Given-section
You can use this optional section to define variables that you can re-use in the rest of the
script. Variables can make the rest of the validation script more readable. It allows you to
separate data creation from the actual constraint-checking validation logic.

Each line of the given-section contains a variable name, an equal sign and an asset
property. More info: Asset model.

Example
The following given-section creates the variable definitions , which contains a list of the
values of the Definition attributes.

given {
definitions = attributes['Definition']

}

When-section
You can use this optional section if certain conditions have to be met before the rule is
executed. If you do not use this section, the validation logic is applied to all assets.

If an asset does not meet these conditions, the validation logic is not executed and the
outcome of the rule is valid.

If the conditions are met, the validation logic is executed. The outcome of the rule will then
depend on the actual validation logic in the then-section.

Each line of the when-section typically contains:

1. A validation function. More info: Validation functions.
2. An attribute from the given-section, an asset property or a constant value that you

entered in the script.

Example
The following when-section only allows assets to be validated if they are of a specific asset
type.

when {
isEqual(type.id,'00000000-0000-0000-0000-000000011001')

}
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Then-section
The then-section contains the pure validation logic. More information: Validation logic.

Asset model
The asset model is the technical structure of assets. You can use the asset model to refer
to specific fields of assets: its attributes and properties. This is required for optimal use of
validation rules.

Note This information does not apply to worfklows and APIs.

Graphical representation

The asset model can be represented graphically. Further below you can find explanations
on each individual field.
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General

Field Explanation

articulationScore The articulation score of the asset.

id The resource ID. Every resource that can be retrieved using the
asset model has this property.

name The full name of an asset. All resources have this property (community,
vocabulary and asset).

signifier Identical to name but only available for the BasicAssetModel.

Note This field is deprecated.

displayName The name of the resource. All resources have this property (com-
munity, vocabulary and asset).

status The status of the asset.

status.id The resource id of the status.

status.name The name of the status.

status.signifier Identical to status.name.

Note This field is deprecated.

type The asset type.

type.id The resource ID of the asset type.

type.name The name of the asset type.

type.signifier Identical to type.name.

vocabulary The domain of the asset.

vocabulary.id The ID of the vocabulary.
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Field Explanation

vocabulary.name The name of the vocabulary.

vocabulary.community.id The ID of the community of the asset.

vocabulary.community.name The name of the community of the asset.

generalConcept The general concept of the asset.

Note This field is deprecated.

generalConcept.id The ID of the general concept.

Note This field is deprecated.

generalConcept.name The name of the general concept.

Note This field is deprecated.

generalConcept.signifier Identical to generalConcept.name.

Note This field is deprecated.

Attributes

Attributes is a dictionary that contains all attribute values. You can retrieve the list for a
given attribute type name or attribute type ID.

There are several possibilities to navigate the attributes of an asset.

Field Explanation

attributes.'Definition' The list of all Definition attribute values.

attributes['Definition'] Identical to attributes.'Definition'.
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Field Explanation

attributes['00000000-0000-
0000-0000-
000000000202']

Identical to attributes.'Definition', but using the resource ID of the
Definition attribute type.

attributes.'00000000-0000-
0000-0000-
000000000202'.first()

The first attribute value within the list of all the Definition attributes.

attributes.'00000000-0000-
0000-0000-
000000000202'?.first()

Identical to attributes.'00000000-0000-0000-0000-000000000202'.first(),
but null-safe.

Tip ?. is the null-safe getter of Groovy. You cannot combine the
?. with the [ ... ] notation. This means that if the referenced
attribute is not present, the result is null, whereas the expression
without the question mark fails to execute.

attributes['Definition'][1] The second Definition attribute value of the asset.

Note This uses index-based navigation of the list, and the first
element has index 0.

Relations

Relations allow you to retrieve the list of target assets through a given relation, and each
target is an asset model in itself. Navigation is done in a similar way as for attributes.

Note (Complex) Relations are only available one level deep. This means that when
your script refers to a target asset through a (complex) relation, that referred asset
will contain all the aspects of the asset that are mentioned above (name, attributes,
etc), but without the (complex) relations of the referred asset.

Field Explanation

relations['Related To'] The list of target assets of all Related To relations.
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Field Explanation

relations['Related To']?.first
().name

The name of the first target asset using the Related To relation in a null-
safe way.

Tip ?. is the null-safe getter of Groovy. You cannot combine the
?. with the [ ... ] notation. This means that if the referenced
attribute is not present, the result is null, whereas the expression
without the question mark fails to execute.

Complex relations

Complex relations are a type of relation. However, because they are less predictable, not
all possible relations can be listed here.

Field Explanation

complexRelations.<complexRelationType
(Name/Id)>.<firstrelationname>.<secondrelationname>

Similar to the relations, the end result will
be an asset model.

Example

If you have a complex relation type

l with name CRT and id 1,
l containing four relation types up, down, left and right,
l all sides referencing a business term.

These are the complex relations:

Field Explanation

complexRelations.CRT.up.right The list of the complex relations from up to right.

complexRelations['CRT']['up']['right'] Identical to complexRelations.CRT.up.right.
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Field Explanation

complexRelations.'CRT'?.'up'?.'right' Identical to complexRelations.CRT.up.right, but does not fail
in case the list of CRT is empty, nor if the up side is empty.

Tip ?. is the null-safe getter of Groovy. You cannot
combine the ?. with the [ ... ] notation. This
means that if the referenced attribute is not present, the
result is null, whereas the expression without the
question mark fails to execute.

complexRelations['1'].down.up The list of the complex relations from down to up.

Asset type model

Field Description

name The full name of the asset type.

displayEnabled Parameter that determines whether the Identical asset names per
domain feature is enabled for the asset type.

ratingEnabled Parameter that determines whether ratings are enabled for the
asset type.

id The resource id.

signifier Identical to name but only available for the BasicAssetModel.

Note This field is deprecated.

Validation logic
The validation logic of a validation rule expresses the condition that is checked by the
validation rule. In a basic validation script, it is contained directly in the rule. In an
advanced validation script, it is contained in the then-section. More information: Validation
scripts.
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Structure

Each line typically consists of:

1. A validation function. More info: Validation functions.
2. An attribute from the given-section, an asset property or a constant value.
3. A message for when assets do not meet the condition of the validation function.
4. Other syntactic elements:

o Aggregate functions
o Validation functions
o Multi-line boolean expressions
o Collections
o Closures

What's next?

If an asset does not meet the validation logic, the outcome of the rule is invalid.
If the asset meets the validation logic, the outcome of the rule is valid.

Example

then {
isNotEmpty(attributes['Definition'],

message: "The asset ${name} in domain ${vocabulary.name} \
must have at least one definition")

}

Validation functions
Validation functions are the functions in a validation script that check for a condition. The
result is a boolean: true or false.

To make the validation script more readable, there are many packaged validation
functions. The built-in validation functions not only handle the validation, but they also
provide a way to produce meaningful error messages. For more advanced functions, you
need a closure, more information: Closures.
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General functions

The function... checks whether...

isEmpty (value) A value is empty, null or does not contain any element.

isNotEmpty (value) A value is not empty.

isEqual (value1, value2) A value is the same as a second value.

isNotEqual (value1, value2) A value is not the same as a second value.

isIn (value, Collection) A value is part of a collection.

areIn (Collection values,
Collection collection)

A collection is part of another collection.

isAny (Collection, Closure) Any value of a collection meets the criteria of a validation closure.

isEvery (Collection, Clos-
ure)

All values of a collection meet the criteria of a validation closure.

isFalse (value) A value is false, empty or null according to the Groovy truth.

Examples:

l isFalse (something): returns true if something is false.
l isFalse (something): returns false is something is true.
l isFalse (false): returns true.
l isFalse (null): returns true.

isTrue (value) A value is true, empty or null according to the Groovy truth.

Examples:

l isTrue (something): returns false if something is false.
l isTrue (something): returns true is something is true.
l isTrue (false): returns false.
l isTrue (null): returns true.
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The function... checks whether...

isUnique (Collection, Clos-
ure)

All values in a collection are unique.

Examples:

l isUnique ([1,2,3]): will evaluate to true.
l isUnique ([1,2,3,1]): will evaluate to false.

Examples:

The closure {it % 2} allows only one even and one odd element in the

list.

l isUnique ([3, 4], {it % 2}): will evaluate to true.
l isUnique ([1, 3, 4], {it % 2}): will evaluate to

false, because both 1 and 3 are odd.

validate (value) A value is a valid function, accepting any closure that is capable of
returning true or false.

Tip Validate (value) is a general validation function used to check
another function.

Error messages

If you add a message parameter in a validation function, a message appears if the result is
false.

You can add the message parameter anywhere in the list of function parameters.

Example

isEmpty (value, message: "this value is not empty") is equivalent to
isEmpty (message: "this value is not empty", value).

You can also include parameters in your message by using ${<asset property>}.
More info on asset properties: Asset model.

Example:

message: "The description of the ${name} asset in domain ${vocab-
ulary.name} is empty.".
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When this message appears, name and vocabulary.name are automatically replaced by
its value.

Note Message parameters entered in the when-clause will not be taken into
account.

String functions

The function... checks whether the value...

isEmpty (value) Is empty or null.

isNotEmpty (value) Is not empty.

startsWith (value, prefix) Starts with prefix.

contains (value, substring) Contains the given substring.

endsWith (value, suffix) Ends with the given suffix.

isLengthBetween (value,
minLength, maxLength)

Has a length between the specified range.

Note The range is inclusive. For example isLengthBetween
('Hello', 2, 6) is true.

isLengthLess (value,
maxLength)

Has a length less than the specified length.

isLengthMore (value,
minLength)

Has a length longer than the specified length.

isLengthEq (value, length) Has the specified string length.

isAlpha (value) Contains only alphabetical characters.

Note This is done through the regular expression [a-zA-Z]+ .

isAlphaSpace (value) Contains only alphabetical characters and spaces.
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The function... checks whether the value...

isAlphanum (value) Contains only alphabetical characters and digits.

isAlphanumSpace (value) Contains only alphabetical characters, digits, and spaces.

matches (value, regular
expression)

Matches the specified regular expression.

A regular expression has to be placed between two forward slashes (/).

Examples:

l matches ("stream", /str.*/) checks whether

streammatches the pattern str.*, which will result to true.
l matches ("stream", /srl.*/): checks whether stream

matches the pattern srl.* which results to false.

Number functions

The function... checks whether a number...

isEven (number) Is even.

isOdd (number) Is odd.

isGreater (number1, num-
ber2)

Is greater than the second number.

isGreaterEq (number1,
number2)

Is greater than or equal to the second number.

isLess (number1, number2) Is smaller than the second number.

isLessEq (number1, num-
ber2)

Is smaller than or equal to the second number.

isPositive (number) Is greater than zero.

isNonnegative (number) Is greater than or equal to zero.

isNegative (number) Is smaller than zero.
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The function... checks whether a number...

isBetween (number1, num-
ber2, number3)

Is greater than the second but smaller than the third number.

Date conversion functions

You can use the date conversion functions to convert the date or time from one format to
another.

Implementation Purpose

Long toTimestamp(String dateConstant) {
LocalDateTime.of(

LocalDate.from(DateTimeFormatter.ISO_LOCAL_
DATE.parse(dateConstant)),

LocalTime.of(0, 0, 0)
).atOffset(ZoneOffset.UTC).toInstant().toE-

pochMilli()
}

Converts a date constant to a
timestamp.

l @param dateCon-

stant: the date in

yyyy-MM-dd format .
l @return: the

timestamp of the
dateConstant.

String toDateConstant(Long timestamp) {
Instant.ofEpochMilli(timestamp).atOffset

(ZoneOffset.UTC)
.format(DateTimeFormatter.ISO_LOCAL_DATE)

}

Converts a timestamp to a date

string in yyyy-MM-dd

format.

l @param timestamp:

the timestamp to con-
vert.

l @return: the string rep-

resentation of the
timestamp.
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Implementation Purpose

String toDateConstant(Long timestamp, String
pattern) {

Instant.ofEpochMilli(timestamp).atOffset
(ZoneOffset.UTC)

.format(DateTimeFormatter.ofPattern(pat-
tern, ValidationConfig.getInstance
().getLocale()))
}

Converts a timestamp to a
string using the given pattern.

l @param timestamp:

the timestamp to con-
vert.

l @param pattern: the

pattern to use for con-
version. For example:
yyyy-MM-dd.

l @return: the string rep-

resentation of the
timestamp in the given
pattern representation.

String now() {
Instant.now().atOffset(ZoneOff-

set.UTC).format(DateTimeFormatter.ISO_LOCAL_
DATE)
}

Returns the current date string

in yyyy-MM-dd format.

l @return: the current

date in yyyy-MM-dd

format.

Date functions

The functions for attributes with datatype Date, require a long value as timestamp, in the
UNIX Epoch time format 1234567890000, and a string value as calendar date, in the ISO
extended format YYYY-MM-DD.

The function... checks whether a timestamp is...

now() Returns the current date.

isPast (Timestamp) In the past (before the system date).

isFuture (Timestamp) In the future (after the system date).

isEqual (Timestamp, Date) The same as the date.
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The function... checks whether a timestamp is...

isLess (Timestamp, Date) Smaller than the date.

isLessEq (Timestamp,
Date)

Smaller than or equal to the date.

isGreater (Timestamp,
Date)

Greater than the date.

isGreaterEq (Timestamp,
Date)

Greater than or equal to the date

isBetween(Timestamp,
Date1, Date2)

Greater than the first but smaller than the second date.

Aggregate functions
Aggregate functions allow you to extract a value from a collection. More information on
collections: Collections.

They are not validation functions in itself, but can help you in retrieving data you want to
refer to more easily in the rest of your validation script.

Function Result

max (Collection) The maximum of the given collection of values.

min (Collection) The minimum of the given collection of values.

avg (Collection) The average of the given collection of number values.

sum (Collection) The sum of the given collection of number values.

Multi-line boolean expressions
The validation script of a validation rule may consist of multiple boolean expressions. To
increase legibility, you can use specific constructs.
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Using the constructs makes your rule a little more verbose, but more readable in most
cases.

Constructions

Expression Purpose

allOf All the conditions have to be valid (= AND).

anyOf One or more of the conditions have to be valid (= OR).

condition Capture the result of a boolean to re-use in other constructs.

Examples

The examples below give the same result but are formulated in a single line, multi-line or in
a hybrid construct.

Single-line expression:

rule {
((isNotEmpty (name) && isEqual (name, 'doesnotequal2', message:
'shouldfail')\
|| isEqual (name, 'doesnotequal')) && isNotEmpty (id)

}

Multi-line expression:

rule {
allOf {

anyOf {
allOf {
condition { isNotEmpty (name) }
condition { isEqual (name, 'doesnotequal2', message:\

'shouldfail') }
}
condition { isEqual (name, 'doesnotequal') }

}
condition { isNotEmpty (id) }
}

}

Hybrid expression:
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rule {
allOf {

anyOf {
condition { isNotEmpty (name) && isEqual (name,\

'doesnotequal2', message: 'shouldfail') }
condition { isEqual (name, 'doesnotequal') }

}
condition { isNotEmpty (id) }
}

}

Closures
A closure is a function that you can pass as an argument to another function.

It is contained by curly brackets, {<closure>}.

You can also define variables before the arrow ->

Tip For more extensive documentation about closures, please refer to the Groovy
closure documentation.

Examples

Closure Purpose

{a, b -> a + b} 1. Define two variables of an undefined type.
2. Add them up.
3. Show the result.

{String a -> isNotEmpty (a) } 1. Define a variable of the type String.
2. Apply the validation function isNotEmpty on it.

More info: isNotEmpty (value).

{isNotEmpty (it)} 1. Apply the validation function isNotEmpty on any variable that

has it as its name.

More info: isNotEmpty (value).

Tip Naming an argument is not necessary when there is only one.
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Collections
A collection is a list of data. Usually you create it when retrieving attributes or relations.

You can refer to a specific element in the collection in multiple ways.

Note If a reference points to a value that doesn't exist, the rule will crash. For
example, retrieving the fifth value of a list that only contains four values causes a
crash.

Reference Result

mylist.first() The first value in the list mylist.

mylist.last() The last value from the list mylist.

mylist[1] The second element from the list mylist. The number is the index of the

value you want to retrieve from the list.

Note The first element has index zero. As a consequence, mylist.first
() is equivalent to mylist.[0].

mylist.get(1) The second element from the list my list. It is very similar to the example
above.

mylist?.get(1) The second element from the list. However, this syntax is null-safe. ?. is the

null-safe getter of Groovy. You cannot combine the ?. with the [ ... ]

notation. This means that if the referenced attribute is not present, the result is
null, whereas the expression without the question mark fails to execute.

Using the *. operator in collections

When using relations, you sometimes only need to have one value of the target assets,
such as the name. You can use the *. operator for this.
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Script Purpose

isIn ('expec-
tedTargetName', relations
['Is Related To']*.name)

Check whether expectedTargetName is in the list of all names

of the target assets. The *. operator applies the .name on every

target asset and creates a new list.

isEvery (relations['Is
Related To']*.name, {tar-
getName -> startsWith (tar-
getName, 'S')})

This will check that every target asset related to the current asset
has a name that starts with S.

Validate the first element of a collection

In many situations, the first element is the only element you actually want to validate. For
example, if you want to check if the first Description attribute is equal to a certain value,
you can do this:

Script Purpose

isEqual (attributes['Descrip-
tion'].first(), 'myvalue')

Retrieve the first element from list of Descriptions and compare

this to myvalue.

isEqual (attributes['Descrip-
tion'], ['myvalue'])

Check wether the list of Descriptions is equal to the given list

['myvalue']. This is identical to the first example, but has as a

side effect that if there is more than one occurrence of the Descrip-

tion attribute, the comparison will return false. As a consequence,

it validates that there is exactly one Description attribute.

Validation script examples
These are examples of real validation scripts of validation rules.

l An asset must have at least one definition.

rule {
isNotEmpty (attributes.'Definition'?.first(), \

message:"The Asset ${name} in domain ${vocabulary.name}
\
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must have at least one Definition")
}

l An attribute must comply to a given pattern (defined using a regular expression).

rule {
given {
codes = attributes.'Code'
}
when {
isNotEmpty (codes)
}
then {
matches (codes.first(), /S\d\d\d\d\d000/,\
message: "The asset ${name} in domain \

${vocabulary.name} Code must start with\
an S, then 5 digits, then 000")

}
}

l All assets with a related to relation must have at least one uses relation.

rule {
given {
relatedTo = relations.'Related To'
uses  = relations.'Uses'
}
when {
isNotEmpty (relatedTo)
}
then {
isNotEmpty (uses, message: "Asset ${name}\

has Related To relation, so it must \
also have a Uses relation")

}
}

l An asset must comply to the following naming rule, defined by a regular expression:
starts with T, followed by 4 digits, 2 zeroes and exactly one 0, 1 or 2.

rule {
matches (name, /T(\d{4})0{2}[0,1,2]/, \

message: "Asset ${name} does not comply to naming
rule")
}

l An asset name must consist of one or more words in capitals.

rule {
matches(name, /(\p{Upper}+|\p{Space}*)*/, \
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message: "Name ${name} should be words in capitals")
}

l All codes for a given asset must be in a different code list.

rule {
given {
code_domains = \

relations.'Code'?.vocabulary?.name
}
then {
isUnique (code_domains)
}

}

l A code must be related to only one business term.

rule {
given { terms = relations.'Business Term'
}
when { isNotEmpty (terms)
}
then { isEmpty (terms[1] )
}

}

l All target assets using the Transform complex relation following the from and to
branch, must have the same name as the current asset.

rule {
isEvery (\

complexRelations.'Transform'.from.to.name, \
{isEqual(name, it)}, \
message: "Not all From and To names of the \

Transform relation are equal")
}

l The total score of each asset related to the current asset through an Impacted By

relation may not exceed 100.

rule {
given {
impacted = relations.'Impacted By'.
totalScoresForEachRelatedAsset = impacted?.collect\

{it.attributes['Score'].sum {it.toIteger()}}
}
when {
isNotEmpty (totalScoresForEachRelatedAsset)
}
then {
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isEvery (totalScoresForEachRelatedAsset, \
{ isLessEq (it, 100)}, \
message: 'Not all related assets have a \
total score smaller or equal to 100')

}
}

l When the first target asset of the current asset using the Is Grouped By relation is
inactive, then the current asset must be inactive. Whether or not the current asset is
active or not, is based on the boolean attribute Active.

rule {
given {
reference = relations.'Is Grouped By'?.first()
active = reference.attributes.'Active'?.first()
}
when {
isNotEmpty (reference) && isFalse (active)
}
then {
isFalse (active, message: "The node '${name}' in\

'${vocabulary.name}' should also be inactive, \
since it parent is inactive.")

}
}
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Scopes
A scope in Collibra Data Intelligence Cloud is a selection of communities and domains that
you can refer to in an assignment of an asset type. Each community or domain belongs to
exactly one scope.

Default scope and custom scopes
Collibra always has a default scope. Initially, all communities and domains are part of the
default scope.

Depending on your requirements, you can create custom scopes and add specific
communities and domains to it. If you add a community or domain to a custom scope, it is
no longer part of the default scope. If you delete a custom scope, or remove communities
and domains from a custom scope, the affected communities and domains revert to the
default scope.

For more information about scopes after an upgrade from version 4.x to 5.x, see Collibra
Support Portal.

Delete a scope
You can delete a scope, for example, if you want an asset type to use the default
assignment.

When you delete a scope, the asset types that used this scope, revert to other custom
scopes or, if there are no other custom scopes, to the default assignment.
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Prerequisites
l You have a global role that has the System administration global permission.

Steps

1. Open the Scopes page.
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. In the Operating model section, click Scopes.

» The Scopes page opens.

2. In the scope's tile, click .

» The Delete <scope name> dialog box appears.
3. Click Delete.
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Workflows
You can find this section on the Collibra Developer Portal.
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Homepage
The Collibra Homepage is the default page that appears when you sign in to Collibra Data
Intelligence Cloud or when you click on any page in Collibra. The Homepage guides

you within Collibra by showing information that is relevant to you, such as your
dashboards, the most viewed assets, and the recommended assets. The Homepage also
allows you to perform a search, for example, for a community, domain, or asset.

The Homepage changes how you find or access your dashboards. You can access all
your dashboards on the Dashboards card on the Homepage or on the Dashboards tab in
the Browse pane.

If you are an administrator, you can define the headings and the content shown in each
section of the Homepage and thus create a Homepage that can meet user needs.

Note
l In Collibra 2022.11 or newer, the Homepage is enabled by default.
l In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer,
the Homepage is available but disabled by default.

l In Collibra environments upgraded from 2022.11 to a newer version, the
previous status of the Homepage (enabled or disabled) is retained.

l For information about how to enable or disable the Homepage, go to Enable or
disable the Homepage.

l If you are an administrator, the Edit Page button is shown on the Homepage
to enable you to customize the Homepage.
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Enable or disable the Homepage

Note
l In Collibra 2022.11 or newer, the Homepage is enabled by default.
l In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer,
the Homepage is available but disabled by default.

l In Collibra environments upgraded from 2022.11 to a newer version, the
previous status of the Homepage (enabled or disabled) is retained.

Note Depending on your environment, follow this procedure either in the Services
Configuration section of the Collibra settings or in Collibra Console. This topic
contains the procedure for Collibra Console. If your Settings page has a
Configuration tab, you can follow this procedure on that tab. For more information,
go to the online documentation.

Requirements and permissions
l You have the ADMIN or SUPER role in Collibra Console.
l You have the SUPER role in Collibra Console.
l The Frontend enabled setting is enabled.

Steps
1. Open the DGC service settings for editing:

a. Open Collibra Console.
» Collibra Console opens with the Infrastructure page.

b. In the tab pane, expand an environment to show its services.
c. In the tab pane, click the Data Governance Center service of that environment.
d. Click Configuration.
e. Click Edit configuration.

2. Go to the Homepage section.
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3. Select the required value.

Value Description

True Enables the Homepage. When you sign in to Collibra, the Homepage is
shown. The Homepage replaces your default dashboard.

False

(default)

Disables the Homepage. When you sign in to Collibra, your default dash-
board is shown, instead of the Homepage.

4. Click Save all.

Homepage overview
The following table describes the sections shown on the Homepage.
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No. Description

Contains the title.

Contains an introduction.

Allows you to perform a search, directing you to the global search results page.

Chapter 17

544



Chapter 17

No. Description

Helps you to find content and perform your daily activities. Depending on how the
Homepage is customized, this section can contain any three of the following cards:

l Dashboards: A list of dashboards that you can access.
l My Quick Links: A list of links to the pages that you can quickly access. You can add,
edit, rearrange, and delete quick links.

l My Tasks: A list of tasks that are assigned to you.
l Most Viewed Assets: A list of assets that your colleagues viewed the most in the last
30 days.

l Recommended Assets: A list of assets that you might like based on your search his-
tory and the assets that you previously viewed.

Edit the Homepage
You can customize the Homepage for the users of Collibra by providing relevant and
contextual content.

This topic describes how to edit the Homepage, including how to preview and publish it.

Note When you edit the Homepage, your changes are automatically saved each
time that you click outside the section where you made the changes.

Requirements and permissions
You have a global role that has the System administration global permission.

Steps
1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. In the upper-right corner of the page, click Edit Page.
» The Homepage opens in the editor mode.
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Tip If another administrator has edited or is editing the Homepage, a
message indicating so is shown on the Homepage. For example, Draft saved
8 minutes ago by John. You can, however, still edit the Homepage.

3. Edit the sections as needed.
How to edit the sections

Chapter 17

546



Chapter 17

No. Description

Enter a title for the Homepage.
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No. Description

o In the first box, enter a greeting.
If you want the first name of a user to be shown in the greeting, enter
{Name}. For example, if you enter Hello {Name}, when a user named
Jane Doe signs in, the following greeting is shown to her: Hello Jane.
If the user does not have a first name, the username is shown.

o In the second box, enter an introduction.
o Add an image.

How to add an image
i.  Hover your pointer over the current image, and then click Add

Content.
» The Add Content dialog box appears.

ii. Enter the required information.
n Add Image by Link: The link to the image that you want to be

shown. If you leave this field blank, the default Collibra
Homepage image will be shown.

n Alt text: A meaningful description of the image. If the image
fails to load, this description is shown in place of the image. The
description also helps screen-reading tools to describe the
image.

iii. Click Save.

o In the first box, enter a heading that indicates that users can perform a
search, for example, What are you looking for?.

o In the second box, enter the text that you want to be shown in the
search field to guide users, for example, Search Collibra.

o In the box, enter a heading that indicates that users can find content,
for example, Where would you like to go?.

o The top subsection that is located below the box contains the selected
cards, which will be shown to users. The bottom subsection contains
the available cards, which you can choose to show to users. To move
a card from one subsection to another, drag the card and drop it to
where you want it in the subsection.
While a total of five cards are available, a maximum of three cards can
be shown to users.

Tip On the My Quick Links card, you can add, edit, rearrange, and
delete quick links.
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Tip
o If you want to pause editing the Homepage or want to publish the edited
Homepage later, click Close Editor. This action saves all the changes
that you made to the Homepage and shows the last published
Homepage in the view mode.

o If you want to discard all the changes that you made to the Homepage,
click , and then click Delete Draft. You can then continue to make new
changes to the Homepage.

o If you want to restore the Collibra version of the Homepage, which is the
original version, click Restore Collibra Version, and then click Publish.

4. Optional: Click Preview.
» A preview of the Homepage is shown.

Tip If you want to make more changes to the Homepage, click Back to
Editor.

5. To publish the Homepage, click Publish.
» The edited Homepage is published to all the users.

Add a quick link
You can add up to six links to the My Quick Links card on the Homepage. The links that
you add to the card are shown only to you.

Steps
1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Add a Quick Link.
» The Add a Quick Link dialog box appears.
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3. Enter the required information.

Field Description

URL Enter the address of the web page that you want to be able to quickly
access from the My Quick Links card.

Text to Display Enter the text that you want to show in place of the address on the My
Quick Links card.

Open in New
Tab

o If you want the web page to open in the same browser tab, clear the
checkbox.

o If you want the web page to open in a new browser tab, select the
checkbox.

4. Click Save.
» The link is shown on the My Quick Links card.

Tip You can edit, rearrange, or delete the quick link.

Edit a quick link
You can edit the links on the My Quick Links card on the Homepage.

Steps
1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Edit.
3. Click next to the link that you want to edit.

» The Edit Quick Link dialog box appears.
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4. Enter the required information.

Field Description

URL Enter the address of the web page that you want to be able to quickly
access from the My Quick Links card.

Text to Display Enter the text that you want to show in place of the address on the My
Quick Links card.

Open in New
Tab

o If you want the web page to open in the same browser tab, clear the
checkbox.

o If you want the web page to open in a new browser tab, select the
checkbox.

5. Click Save.
6. On the My Quick Links card, click Save.

» The edited link is shown on the My Quick Links card.

Tip You can rearrange or delete the quick link.

Rearrange a quick link
You can change the position of the links on the My Quick Links card on the Homepage.

Steps
1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Edit.
3. Hover your pointer over the link whose position you want to change.
4. Drag to the position where you want the link to be shown.

5. Click Save.
» The link is rearranged.
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Delete a quick link
You can delete the links on the My Quick Links card on the Homepage.

Steps
1. Go to the Homepage.

Tip The Homepage appears when you sign in to Collibra Data Intelligence
Cloud. You can also go to the Homepage from any page by clicking .

2. On the My Quick Links card, click Edit.
3. Click next to the links that you want to delete.

4. Click Save.
» The links are no longer shown on the My Quick Links card.
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Usage Analytics
Usage Analytics is a usage-focused dashboard that provides a snapshot of who is using your
Collibra Data Intelligence Cloud environment and how they are using and engaging with it. Usage
Analytics shows you the behavioral data of your users and associated analytics within Collibra.

The Usage Analytics dashboard contains various sections with trend line charts to help you gain
insights into the adoption and usage of your Collibra environment. You can use the dashboard to
monitor user activity, understand the total asset coverage, and identify popular communities or
assets.

About Usage Analytics 554

Open the Usage Analytics dashboard 555

Usage Analytics dashboard overview 556

Usage Analytics detailed data 558
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About Usage Analytics
The Usage Analytics dashboard shows you data on users and products. You can use the
data shown on the dashboard to view the usage over time, observe trends, measure
success, allocate efforts, and maximize your investment and recharge costs.

Who can benefit from the data
The data on the Usage Analytics dashboard can benefit the following users:

l Administrators who manage or renew licenses.
l Business stewards who want to know if the content that they curate is useful.
l Community managers who want to know which subcommunities are active and
which need more exposure.

l End users who want to see better recommendations on their content feed.

How you can use the data
With the data on the Usage Analytics dashboard, you can:

554



l Improve the usage of your Collibra environment by gaining insights into who is using
Collibra and which communities, domains, and assets they are using.

l Improve the visibility and effectiveness of your adoption efforts by identifying how
many users can access Collibra but have not done so and how many new users
have signed in to Collibra.

Example
Suppose that you have trained some users on how to use Collibra and have run a
campaign within your organization to help drive the usage of Collibra. If you want to
measure the effectiveness of your campaign, you can view the New section on the Usage
Analytics dashboard to check if those trained users signed in to the Collibra environment in
a given period. Additionally, you can view the Inactive section to check which users did not
sign in to the Collibra environment in a given period or when they were last active on the
Collibra Platform.

When and how the data is captured
All the data shown on the Usage Analytics dashboard is refreshed every hour. Usage
Analytics captures data based on when users sign in to Collibra Data Intelligence Cloud
and when users visit the assets within a community or domain. These events are captured
in Collibra and sent every hour to a database built for Usage Analytics.

Privacy
Usage Analytics leverages a process based on event capture, storage, and analytics, built
and managed by Collibra. The Usage Analytics data is stored within the Collibra database,
in accordance with the regional requirements for customer instances. The Usage Analytics
data is made available only to customers—no third party systems can access this data.

Open the Usage Analytics dashboard

Requirements and permissions
l You have either the Sysadmin global role or one of the following global permissions:

o Insights > View Usage Analytics reports
With this permission, you can view detailed data by clicking the cards on the
Usage Analytics dashboard. In addition, you can download the data.
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o Insights > View Usage Analytics Summary
With this permission, you can view only a summary of the data on the Usage
Analytics dashboard.

Note The View Usage Analytics Summary permission affects only the
view of the Usage Analytics dashboard. All the Usage Analytics events
and detailed data will still be captured and stored.

l The Frontend enabled setting is enabled.

Note
l Collibra Data Intelligence Cloud is packaged with the Insights global role.
l If you have both the View Usage Analytics Summary permission and the
View Usage Analytics reports permission, the latter permission takes
precedence.

Steps
On the main menu, click , and then click Usage Analytics.

» The Usage Analytics dashboard opens.

Usage Analytics dashboard overview
The Usage Analytics dashboard shows key data related to the adoption and engagement
of your Collibra environment within your organization over a given time period. The
following table describes the sections shown on the dashboard.
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No. Section Description

Usage Period Allows you to select the period for which you want to view the data.
You can view the data for the last 1, 7 (default), 30, 60, 90, 180, or
365 days.

The Current Period field shows the date range for the length of
time selected in the Usage Period field. The Previous Period field
shows the date range for the same length of time, but for the period
before the current period. For example, if the Current Period field
shows Oct. 1, 2022 - Oct. 7, 2022, then the Previous Period field
shows Sep. 24, 2022 - Sep. 30, 2022.

Visitors Shows how many users in your organization used Collibra in
the current period.

Visits Shows how users in your organization used Collibra and
which resources they visited the most in the current period.
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Usage Analytics detailed data
If you have the Sysadmin global role or the Insights > View Usage Analytics reports
global permission, you can view more usage data by clicking the cards in the Visitors or
Visits section.

Visitors section overview
The Visitors section on the Usage Analytics dashboard shows data related to the user
engagement over a given period of time. The following table describes the cards shown in
the section.

Card Description

Active Active visitors are users who signed in to Collibra in the current period.

New New visitors are users who signed in to Collibra either for the very first time in the
current period or for the first time in the current period after having been inactive in
the previous period.

Inactive Inactive visitors are users who did not sign in to Collibra in the current period.

Understanding the data in the Visitors section
This topic describes the data that appears when you click a card in the Visitors section.
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Active
The Active card shows the number of users who signed in to Collibra in the current period.

Depending on your permission, when you click the card, the following subsections appear:

l Active Standard Users: The number and evolution of active visitors who have the
Standard User license, in the current and previous periods.

l Active Read-only Users: The number and evolution of active visitors who have the
Read-only User license, in the current and previous periods.

l Active Visitors: The names and other attributes, such as the required license and
the number of current visits, of all active visitors in the current period.
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Tip On the Active Standard Users and Active Read-only Users subsections, you
can hover your pointer over the solid (current period) or dotted (previous period)
lines in the charts to compare the data between two corresponding days in the
current and previous periods.

What the number and text on the Active card indicates
The following table describes what the number and the text on the Active card indicates.
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No. Description

The number on the Active card considers all users who signed in to Collibra in the
current period. These include not only standard and read-only visitors but also visitors
whose profiles were deleted in the meantime.

Suppose that the number on the Active card is 20, the number on the Active Standard
Users is 10, and the number on the Active Read-only Users card is 8. This indicates
that the remaining two users are deleted.

The text on the Active card indicates the approximate percentage of active users in the
current period in comparison with the previous period.

Suppose that for a period of 30 days, the number on the Active card is 20 and the text
on the Active card is 50.00% over previous period. The text means that there is
approximately a 50% increase in the number of active users in the current period
compared to the previous period, indicating that there were about 13 active users in the
previous period.

Tip
The arrow next to the number indicates the trend of the number of visitors compared
with the previous period.

l An up arrow indicates that the number of visitors in the current period is more
than that in the previous period.

l A down arrow indicates that the number of visitors in the current period is less
than that in the previous period.

l A left arrow indicates that the number of visitors in the current period is the
same as that in the previous period.
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Understanding the data in the Active Visitors subsection
The following table describes the columns that are available in the Active Visitors
subsection, including hidden columns and columns that appear only in the downloaded
version of the subsection.

Note Columns that are shown only in the downloaded version of the subsection are
indicated by (*) next to them in the following table.

Column Description

Name The name of the visitor.

User Name The username of the visitor.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

User ID (*) The user ID of the visitor.

Required License The license that the visitor requires for the assigned roles and
responsibilities.

Note If this data is unavailable, - is shown in the column.

Effective License The actual license that the visitor is assigned. If this data is unavailable, - is
shown in the column.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

Participated in
workflows

l Yes: If the visitor started or stopped workflows or completed workflow
tasks.

l No: If the visitor did not start or stop workflows or complete any workflow
tasks.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

Current Visits The number of times that the visitor signed in to Collibra in the current period.
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Column Description

Previous Visits The number of times that the visitor signed in to Collibra in the previous
period.

Days Active The number of days that the visitor signed in to Collibra.

Last Active The UTC (Coordinated Universal Time) date when the visitor last signed in to
Collibra.

Tip In the downloaded file, this column additionally shows the time in
milliseconds.

Deleted User Flag
(*)

l 0: The visitor profile is not deleted.
l 1: The visitor profile was deleted since they last signed in to Collibra.

Disabled User
Flag (*)

l 0: The visitor profile is enabled.
l 1: The visitor profile was disabled since they last signed in to Collibra.

Is New in Period
(*)

l 0: The visitor signed in to Collibra in the previous period.
l 1: The visitor signed in to Collibra either for the very first time in the current
period or for the first time in the current period after having been inactive in
the previous period.

New
The New card shows the number of users who signed in to Collibra either for the very first
time in the current period or for the first time in the current period after having been inactive
in the previous period.
Example
Suppose that the current period is October 1, 2022-October 7, 2022 and the previous
period is September 24, 2022-September 30, 2022. Consider a user named Jane who
signed in to Collibra before the previous period (for example, on September 20th) but did
not sign in to Collibra in the previous period. If Jane signs in to Collibra in the current
period, Jane is considered a new user because she was inactive in the previous period.

Depending on your permission, when you click the card, the following subsections appear:

l New Standard Users: The number and evolution of new visitors who have the
Standard User license, in the current and previous periods.
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l New Read-only Users: The number and evolution of new visitors who have the
Read-only User license, in the current and previous periods.

l New Visitors: The names and other attributes, such as the required license and the
number of current visits, of all new visitors in the current period.

Tip On the New Standard Users and New Read-only Users subsections, you can
hover your pointer over the solid (current period) or dotted (previous period) lines in
the charts to compare the data between two corresponding days in the current and
previous periods.

What the number and text on the New card indicates
The following table describes what the number and the text on the New card indicates.

No. Description

The number on the New card considers all users who signed in to Collibra in the
current period. These include not only standard and read-only visitors but also visitors
whose profiles were deleted in the meantime.

Suppose that the number on the New card is 20, the number on the New Standard
Users is 10, and the number on the New Read-only Users card is 8. This indicates
that the remaining two users are deleted.
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No. Description

The text on the New card indicates the approximate percentage of new users in the
current period in comparison with the previous period.

Suppose that for a period of 30 days, the number on the New card is 20 and the text on
the New card is 50.00% over previous period. The text means that there is
approximately a 50% increase in the number of new users in the current period
compared to the previous period, indicating that there were about 13 new users in the
previous period.

Tip
The arrow next to the number indicates the trend of the number of visitors compared
with the previous period.

l An up arrow indicates that the number of visitors in the current period is more
than that in the previous period.

l A down arrow indicates that the number of visitors in the current period is less
than that in the previous period.

l A left arrow indicates that the number of visitors in the current period is the
same as that in the previous period.

Understanding the data in the New Visitors subsection
The following table describes the columns that are available in the New Visitors
subsection, including hidden columns and columns that appear only in the downloaded
version of the subsection.

Tip
In the New Visitors subsection, users who signed in to Collibra for the first time
since the time that the Usage Analytics dashboard was enabled are identified by the
label NEW .

Note Columns that are shown only in the downloaded version of the subsection are
indicated by (*) next to them in the following table.
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Column Description

Name The name of the visitor.

User Name The username of the visitor.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

User ID (*) The user ID of the visitor.

Required License The license that the visitor requires for the assigned roles and
responsibilities.

Note If this data is unavailable, - is shown in the column.

Effective License The actual license that the visitor is assigned. If this data is unavailable, - is
shown in the column.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

Participated in
workflows

l Yes: If the visitor started or stopped workflows or completed workflow
tasks.

l No: If the visitor did not start or stop workflows or complete any workflow
tasks.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

Current Visits The number of times that the visitor signed in to Collibra in the current period.

Days Active The number of days that the visitor signed in to Collibra.

First Active The date when the visitors first signed in to Collibra, represented in
Coordinated Universal Time (UTC).

Tip In the downloaded file, this column additionally shows the time in
milliseconds.
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Column Description

Last Active The UTC (Coordinated Universal Time) date when the visitor last signed in to
Collibra.

Tip In the downloaded file, this column additionally shows the time in
milliseconds.

Deleted User Flag
(*)

l 0: The visitor profile is not deleted.
l 1: The visitor profile was deleted since they last signed in to Collibra.

Disabled User
Flag (*)

l 0: The visitor profile is enabled.
l 1: The visitor profile was disabled since they last signed in to Collibra.

Is New in Period
(*)

l 0: The visitor signed in to Collibra in the previous period.
l 1: The visitor signed in to Collibra either for the very first time in the current
period or for the first time in the current period after having been inactive in
the previous period.

Inactive
The Inactive card shows the number of users who did not sign in to Collibra in the current
period.

Depending on your permission, when you click the card, the following subsections appear:

l Inactive Standard Users: The number and evolution of inactive visitors who have
the Standard User license, in the current and previous periods.

l Inactive Read-only Users: The number and evolution of inactive visitors who have
the Read-only User license, in the current and previous periods.

l Inactive Visitors: The names and other attributes, such as the required license and
the number of previous visits, of all inactive visitors in the current period.

Tip On the Inactive Standard Users and Inactive Read-only Users subsections,
you can hover your pointer over the solid (current period) or dotted (previous period)
lines in the charts to compare the data between two corresponding days in the
current and previous periods.

What the number and text on the Inactive card indicates
The following table describes what the number and the text on the Inactive card indicates.
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No. Description

The number on the Inactive card considers all users who signed in to Collibra in the
current period. These include not only standard and read-only visitors but also visitors
whose profiles were deleted in the meantime.

Suppose that the number on the Inactive card is 20, the number on the Inactive
Standard Users is 10, and the number on the Inactive Read-only Users card is 8. This
indicates that the remaining two users are deleted.

The text on the Inactive card indicates the approximate percentage of inactive users in
the current period in comparison with the previous period.

Suppose that for a period of 30 days, the number on the Inactive card is 20 and the text
on the Inactive card is 50.00% over previous period. The text means that there is
approximately a 50% increase in the number of inactive users in the current period
compared to the previous period, indicating that there were about 13 inactive users in
the previous period.

Tip
The arrow next to the number indicates the trend of the number of visitors compared
with the previous period.

l An up arrow indicates that the number of visitors in the current period is more
than that in the previous period.

l A down arrow indicates that the number of visitors in the current period is less
than that in the previous period.

l A left arrow indicates that the number of visitors in the current period is the
same as that in the previous period.
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Understanding the data in the Inactive Visitors subsection
The following table describes the columns that are available in the Inactive Visitors
subsection, including hidden columns and columns that appear only in the downloaded
version of the subsection.

Note Columns that are shown only in the downloaded version of the subsection are
indicated by (*) next to them in the following table.

Column Description

Name The name of the visitor.

User Name The username of the visitor.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

User ID (*) The user ID of the visitor.

Required License The license that the visitor requires for the assigned roles and
responsibilities.

Note If this data is unavailable, - is shown in the column.

Effective License The actual license that the visitor is assigned. If this data is unavailable, - is
shown in the column.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.

Participated in
workflows

l Yes: If the visitor started or stopped workflows or completed workflow
tasks.

l No: If the visitor did not start or stop workflows or complete any workflow
tasks.

Note This column is hidden by default. For information about how to show a
column, go to Customize a table.
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Column Description

Previous Visits The number of times that the visitor signed in to Collibra in the previous
period.

Last Active The UTC (Coordinated Universal Time) date when the visitor last signed in to
Collibra.

Tip In the downloaded file, this column additionally shows the time in
milliseconds.

Deleted User Flag
(*)

l 0: The visitor profile is not deleted.
l 1: The visitor profile was deleted since they last signed in to Collibra.

Disabled User
Flag (*)

l 0: The visitor profile is enabled.
l 1: The visitor profile was disabled since they last signed in to Collibra.

Is New in Period
(*)

l 0: The visitor signed in to Collibra in the previous period.
l 1: The visitor signed in to Collibra either for the very first time in the current
period or for the first time in the current period after having been inactive in
the previous period.

Visits section overview
The Visits section on the Usage Analytics dashboard shows data related to the platform
adoption and usage over a given period of time. The following table describes the cards
shown in the section.

Card Description

Community The community names and the number of times that the assets in those communities are
visited in the current period.

Domain Type The domain type names and the number of times that the assets associated with those
domain types are visited in the current period.

Asset Type The asset type names and the number of times that the assets of those asset types are
visited in the current period.
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Understanding the data in the Visits section
This topic describes the data that appears when you click a card in the Visits section.

Community
The Community card shows the five communities whose assets are visited the most in the
current period. Depending on your permission, when you click the card, the Community
subsection appears with the following tabs:

l Visits: The number of times that the users visited the assets by communities in the
current period.

l Visitors: The number of users who visited the assets by communities in the current
period.
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The left pane on the Visits or Visitors tab shows a list of all communities and domains in
hierarchical order. You can search for a specific community or domain by using the
Search Communities and Domains search box.

When you click a community in the left pane, it expands to show its subcommunities and
domains. In addition, the data for the community that you clicked is shown in the table next
to the left pane. You can also click a subcommunity or domain in the left pane to view the
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data for that subcommunity or domain in the table. You can identify the community or
domain for which the data is shown in the table by the label above the table.

Tip After having clicked a community or domain in the left pane, if you want to go
back to viewing the data for all communities, click the same community or domain in
the left pane again. When you view the data for all communities, the label All
appears above the table.

Community: Understanding the data on the Visits tab

On the Visits tab, in the left pane, the number that appears next to each community or
domain indicates how many times the users visited the assets within that community or
domain in the current period. The arrow next to each number indicates the trend of the
number of visits compared with the previous period.

Tip
l An up arrow indicates that the number of visits in the current period is
more than that in the previous period.

l A down arrow indicates that the number of visits in the current period is
less than that in the previous period.

l A left arrow indicates that the number of visits in the current period is the
same as that in the previous period.

Above the table, Current Period shows the number of times that the users visited the
assets within the selected community or domain in the current period, and Previous
Period shows the corresponding number in the previous period. This data is also
graphically represented as a trend line chart. You can hover your pointer over the solid
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(current period) or dotted (previous period) lines in the chart to compare the data
between two corresponding days in the current and previous periods.

The table contains the following columns.

Column Description

Asset Name The name of the asset that belongs to the selected community or domain.

Domain Name The name of the domain to which the asset belongs.

Current Visits The number of times that the asset was visited in the current period.

Previous Visits The number of times that the asset was visited in the previous period.

Community: Understanding the data on the Visitors tab

On the Visitors tab, in the left pane, the number that appears next to each community
or domain indicates how many users visited the assets within that community or
domain in the current period. The arrow next to each number indicates the trend of the
number of visitors compared with the previous period.

Tip
l An up arrow indicates that the number of visitors in the current period is
more than that in the previous period.

l A down arrow indicates that the number of visitors in the current period is
less than that in the previous period.

l A left arrow indicates that the number of visitors in the current period is the
same as that in the previous period.
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Above the table, Current Period shows the number of users who visited the assets
within the selected community or domain in the current period, and Previous Period
shows the corresponding number in the previous period. This data is also graphically
represented as a trend line chart. You can hover your pointer over the solid (current
period) or dotted (previous period) lines in the chart to compare the data between two
corresponding days in the current and previous periods.

The table contains the following columns.

Column Description

Asset Name The name of the asset that belongs to the selected community or domain.

Domain Name The name of the domain to which the asset belongs.

Current Visitors The number of users who visited the asset in the current period.

Previous Visitors The number of users who visited the asset in the previous period.

Domain Type
The Domain Type card shows five domain types of the domains whose assets are visited
the most in the current period. Depending on your permission, when you click the card, the
Domain Type subsection appears with the following tabs:

l Visits: The number of times that the users visited the assets by domain types in the
current period.

l Visitors: The number of users who visited the assets by domain types in the current
period.
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The left pane on the Visits or Visitors tab shows a list of domain types for all communities
in a hierarchical order. Only the domain types that contain at least one domain are shown
in the left pane. You can view the domain types for a specific community by selecting that
community in the drop-down list box. You can search for a specific domain type or domain
by using the Search Domain Types and Domains search box.

When you click a domain type in the left pane, it expands to show all the domains of that
type. In addition, the data for the domain type that you clicked is shown in the table next to
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the left pane. You can also click a domain in the left pane to view the data for that domain
in the table. You can identify the domain type or domain for which the data is shown in the
table by the label above the table.

Tip After having clicked a domain type or domain in the left pane, if you want to go
back to viewing the data for all domain types within the selected community, click
the same domain type or domain in the left pane again. When you view the data for
all domain types, the label All appears above the table.

Domain Type: Understanding the data on the Visits tab

On the Visits tab, in the left pane, the number that appears next to each domain type or
domain indicates how many times the users visited the assets within that domain type
or domain in the current period. The arrow next to each number indicates the trend of
the number of visits compared with the previous period.

Tip
l An up arrow indicates that the number of visits in the current period is
more than that in the previous period.

l A down arrow indicates that the number of visits in the current period is
less than that in the previous period.

l A left arrow indicates that the number of visits in the current period is the
same as that in the previous period.

Above the table, Current Period shows the number of times that the users visited the
assets within the selected domain type or domain in the current period, and Previous
Period shows the corresponding number in the previous period. This data is also
graphically represented as a trend line chart. You can hover your pointer over the solid
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(current period) or dotted (previous period) lines in the chart to compare the data
between two corresponding days in the current and previous periods.

The table contains the following columns.

Column Description

Asset Name The name of the asset that belongs to the selected domain type or
domain.

Domain Name The name of the domain to which the asset belongs.

Current Visits The number of times that the asset was visited in the current period.

Previous Visits The number of times that the asset was visited in the previous period.

Domain Type: Understanding the data on the Visitors tab

On the Visitors tab, in the left pane, the number that appears next to each domain type
or domain indicates how many users visited the assets within that domain type or
domain in the current period. The arrow next to each number indicates the trend of the
number of visitors compared with the previous period.

Tip
l An up arrow indicates that the number of visitors in the current period is
more than that in the previous period.

l A down arrow indicates that the number of visitors in the current period is
less than that in the previous period.

l A left arrow indicates that the number of visitors in the current period is the
same as that in the previous period.

Above the table, Current Period shows the number of users who visited the assets
within the selected domain type or domain in the current period, and Previous Period
shows the corresponding number in the previous period. This data is also graphically
represented as a trend line chart. You can hover your pointer over the solid (current
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period) or dotted (previous period) lines in the chart to compare the data between two
corresponding days in the current and previous periods.

The table contains the following columns.

Column Description

Asset Name The name of the asset that belongs to the selected domain type or
domain.

Domain Name The name of the domain to which the asset belongs.

Current Visitors The number of users who visited the asset in the current period.

Previous Visitors The number of users who visited the asset in the previous period.

Asset Type
The Asset Type card shows five asset types of the assets that are visited the most in the
current period. Depending on your permission, when you click the card, the Asset Type
subsection appears with the following tabs:

l Visits: The number of times that the users visited the assets by asset types in the
current period.

l Visitors: The number of users who visited the assets by asset types in the current
period.
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The left pane on the Visits or Visitors tab shows a list of asset types for all communities in
hierarchical order. Only the asset types that contain at least one asset are shown in the left
pane. You can view the asset types for a specific community by selecting that community
in the drop-down list box. You can search for a specific asset type by using the Search
Asset Types search box.

580



Tip After having clicked an asset type in the left pane, if you want to go back to
viewing the data for all asset types within the selected community, click the same
asset type in the left pane again. When you view the data for all asset types, the
label All appears above the table.

Asset Type: Understanding the data on the Visits tab

On the Visits tab, in the left pane, the number that appears next to each asset type
indicates how many times the users visited the assets within that asset type in the
current period. The arrow next to each number indicates the trend of the number of
visits compared with the previous period.

Tip
l An up arrow indicates that the number of visits in the current period is
more than that in the previous period.

l A down arrow indicates that the number of visits in the current period is
less than that in the previous period.

l A left arrow indicates that the number of visits in the current period is the
same as that in the previous period.

Above the table, Current Period shows the number of times that the users visited the
assets within the selected asset type in the current period, and Previous Period shows
the corresponding number in the previous period. This data is also graphically
represented as a trend line chart. You can hover your pointer over the solid (current
period) or dotted (previous period) lines in the chart to compare the data between two
corresponding days in the current and previous periods.

The table contains the following columns.

Column Description

Asset Name The name of the asset that belongs to the selected asset type.

Domain Name The name of the domain to which the asset belongs.
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Column Description

Current Visits The number of times that the asset was visited in the current period.

Previous Visits The number of times that the asset was visited in the previous period.

Asset Type: Understanding the data on the Visitors tab

On the Visitors tab, in the left pane, the number that appears next to each asset type
indicates how many users visited the assets within that asset type in the current
period. The arrow next to each number indicates the trend of the number of visitors
compared with the previous period.

Tip
l An up arrow indicates that the number of visitors in the current period is
more than that in the previous period.

l A down arrow indicates that the number of visitors in the current period is
less than that in the previous period.

l A left arrow indicates that the number of visitors in the current period is the
same as that in the previous period.

Above the table, Current Period shows the number of users who visited the assets
within the selected asset type in the current period, and Previous Period shows the
corresponding number in the previous period. This data is also graphically represented
as a trend line chart. You can hover your pointer over the solid (current period) or
dotted (previous period) lines in the chart to compare the data between two
corresponding days in the current and previous periods.

The table contains the following columns.

Column Description

Asset Name The name of the asset that belongs to the selected asset type.

582



Column Description

Domain Name The name of the domain to which the asset belongs.

Current Visitors The number of users who visited the asset in the current period.

Previous Visitors The number of users who visited the asset in the previous period.

Download the Usage Analytics data
You can download the data shown on any of the expanded cards on the Usage Analytics
dashboard as a comma-separated values (CSV) file. The downloaded file contains only
the first 50,000 rows of the table.

Requirements and permissions
You have either the Sysadmin global role or the Insights > View Usage Analytics reports
global permission.

Steps

1. Open the Usage Analytics dashboard.
2. Click the card whose data you want to download.

» The card expands to show a table with the detailed data.
3. Click .

» The first 50,000 rows of the table are downloaded as a CSV file on your computer.

Customize a table
You can customize the table that is shown when you click a card in the Visitors or Visits
section. For example, you can choose to show or hide certain columns or sort the table in
ascending or descending order.
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Tip You can sort the table by the column values in ascending, descending, or
original order by clicking the column heading.

Steps

1. In the table, hover your pointer over any column heading.

Note If you want to hide a column or sort the values in a column, you must
hover your pointer over that column heading.

2. Click .

3. Select one of the following options.

Option Description

Sort by ASC Sorts the values in the column in ascending order.

Sort by DESC Sorts the values in the column in descending order.

Hide Hides the column from the table.

Show columns Enables you to select the columns that you want to be shown in the table.
If you want to show all available columns, click Show all.
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Insights Data Access
The objective of Insights Data Access is to make reporting easier for you. It captures all
your reporting data from Collibra and enables you to build reports to visualize the data.

Insights Data Access can retrieve vast amounts of data while retaining history and without
jeopardizing the Collibra front-end performance. You can then use the Collibra Insights
widget to show Tableau reports or any report that can be shown as an iframe on your
Collibra dashboard. If you are not using Tableau, you can still leverage the definition of the
SQL view.

Tip
l For information about how the different Insights Data Access tables can be
linked, go to Insights Data Access entity relationship diagram.

l For some example reports showing how you can leverage the power of
Insights Data Access, go to Dashboard reports.

Working with your reporting data 586

Chapter 19



Chapter 19

Working with your reporting data

Storing your reporting data
Each night, Collibra stores a copy of your reporting data—all assets, attributes, relations,
and responsibilities, for all domains and communities, including your operating model
customizations—in Collibra Data Intelligence Cloud. The copy includes both real and delta
data values.

Each data record includes the date on which the data was copied. These timestamped
data records are copied each day and stored for a rolling period of 31 days. A copy of the
data is also taken on the last day of each month, and these monthly snapshots are stored
in Collibra Data Intelligence Cloud indefinitely.

Processing and availability of the previous day's reporting
data
Reporting data is processed in the Coordinated Universal Time (UTC) time zone.

Note
l The time at which the reporting data is ready (as identified in the last column of
the following table) can vary depending on the amount of data.

l In the following table, "local time" refers to the time (daylight saving time, if
applicable) in the relevant region. For example, when considering the time for
London, "02:00 local time" means 02:00 in London.

Cloud pro-
vider

Location Data dump (UTC) Processing begins
(UTC)

Reporting data is ready
(UTC)

AWS Singapore 14:00

(22:00 local time)

16:00

(00:00 (midnight) local
time)

20:00

(04:00 local time)
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Cloud pro-
vider

Location Data dump (UTC) Processing begins
(UTC)

Reporting data is ready
(UTC)

AWS Sydney 14:00

(00:00 (midnight) local
time)

16:00

(02:00 local time)

20:00

(06:00 local time)

AWS Frankfurt 00:00 (midnight)

(02:00 local time)

02:00

(04:00 local time)

06:00

(08:00 local time)

AWS Ireland 00:00 (midnight)

(00:00 local time)

02:00

(02:00 local time)

06:00

(06:00 local time)

AWS London 00:00 (midnight)

(01:00 local time)

02:00

(03:00 local time)

06:00

(07:00 local time)

AWS Central
Canada

05:00

(01:00 local time)

06:00

(02:00 local time)

10:00

(06:00 local time)

AWS Northern Vir-
ginia

05:00

(01:00 local time)

06:00

(02:00 local time)

10:00

(06:00 local time)

AWS Northern
California

08:00

(01:00 local time)

09:00

(02:00 local time)

13:00

(06:00 local time)

GCP Tokyo 05:00

(14:00 local time)

05:00

(14:00 local time)

10:00

(19:00 local time)

GCP Singapore 07:00

(15:00 local time)

07:00

(15:00 local time)

12:00 (noon)

(20:00 local time)

GCP Sydney 14:00

(00:00 (midnight) local
time)

14:00

(00:00 (midnight) local
time)

19:00

(05:00 local time)

GCP Belgium 00:00 (midnight)

(02:00 local time)

00:00 (midnight)

(02:00 local time)

05:00

(07:00 local time)
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Cloud pro-
vider

Location Data dump (UTC) Processing begins
(UTC)

Reporting data is ready
(UTC)

GCP London 00:00 (midnight)

(01:00 local time)

00:00 (midnight)

(01:00 local time)

05:00

(06:00 local time)

GCP Quebec 05:00

(01:00 local time)

05:00

(01:00 local time)

10:00

(06:00 local time)

GCP South Caro-
lina

05:00

(01:00 local time)

05:00

(01:00 local time)

10:00

(06:00 local time)

GCP Virginia 05:00

(01:00 local time)

05:00

(01:00 local time)

10:00

(06:00 local time)

GCP Iowa 06:00

(01:00 local time)

06:00

(01:00 local time)

11:00

(06:00 local time)

Downloading your data
Due to security considerations, you cannot access the data directly on Collibra Data
Intelligence Cloud. A REST API is created to enable you to download your reporting data
to a local server or your computer. If you specify the snapshot date that you want in the
REST API, a ZIP file of your reporting data for the specified date is downloaded to your
hard disk.

Connecting your data with your business
intelligence tool
After you have downloaded your reporting data, you must establish a connection between
your data and your organization's business intelligence tool. This guide describes the
procedures to do so via Amazon Web Services and Google Cloud Platform.

588



Tip If you need assistance, contact your internal IT infrastructure team, who can
advise you as to where to store the downloaded files and how to establish the
connection with your organization's business intelligence tool.
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Dashboard reports
You can configure three different dashboard reports.

Data Maturity
The Data Maturity report helps you track the completeness of critical assets, based on the
business dimensions used in an organization.

Privacy & Risk Readiness
The Privacy & Risk Readiness helps you track the development of your organization's data
and progress towards compliance with the relevant regulation.
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You can drill down, to view the details relative to a specific regulation, for a specific
community, and select the process registers you want to monitor.
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Drilling down further, you can monitor the process registers of specific lines of business,
including the business processes, data sets and third-parties related to a specific process
register.
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Process Register
The Process Register report shows the important information of every Business Process
asset of every Process Register domain in your Collibra environment. You can download
the report as a printable PDF.
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Insights Data Access tables
Insights Data Access contains the following tables, which reflect the data that can be
accessed through the Collibra user interface:

l The community hierarchy.
l All domains.
l All assets, including assets of custom asset types.
l All asset tags.
l All attributes related to these assets, such as Definition, Description, and custom
attributes types.

l All relations related to these assets, such as categorizes and is categorized by,
including custom relation types.

l All complex relations.
l Responsibilities, such as Owner and Stakeholder, for a given resource.

Note Only responsibilities that are directly assigned at the asset level or
domain level are included in Insights Data Access; inherited responsibilities
from the community level are excluded.
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This is the reporting data that is copied and stored in Collibra Data Intelligence Cloud on a
daily basis.

Creating Insights Data Access on AWS and
generating reports
Before configuring the dashboard reports, you must set up Insights Data Access on
Amazon Web Services (AWS). You can then create your dashboard reports via Collibra
Console or URL.

Set up Insights Data Access on AWS
This section describes how to set up Insights Data Access on Amazon Web Services
(AWS) with S3 bucket storage and AWS Athena query service. You can, however, use
alternative software.

Tip For information about how to set up Insights Data Access on the Google Cloud
Platform, go to Set up Insights Data Access on GCP.

Requirements and permissions
l Collibra Data Intelligence Cloud 5.7 or newer.
l License for Collibra Insights.
l Software for working with Parquet files.

Steps

1. Download a data snapshot from your Collibra environment.
2. Upload the data to an S3 bucket.
3. Download Insights Data Access from Collibra Marketplace.
4. Set up the Insights Data Access model in AWS Athena.
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Step 1: Download a data snapshot from your Collibra DGC
environment

1. Enter the following URL in your browser:
<your-DGC-environment-URL>/rest/2.0/re-

porting/insights/download?snapshotDate=<snapshot_date>&-

format=zip

where, <snapshot date> is the date from which you want the data, formatted as
YYYY-MM-DD, for example 2019-07-23.
» A ZIP file of the data from your Collibra environment, for the specified date, is
downloaded to your hard disk.

2. Extract the ZIP files on your local computer.
» A folder with the name of the ZIP file is created.

Step 2: Upload the data to an S3 bucket

Note This only needs to be done once for the collection Tableau workbook files.
After that, you only need to carry out this step If the data layer model changes.

1. Sign in to your AWS account.
2. In the main menu, expand the Services page, and then select S3.
3. On the Buckets tab, click Create bucket.

» The Create bucket dialog box appears.
4. In the Bucket name field, enter a name for the bucket you are creating, for example

collibra-insights.
5. Click Next.
6. Click Next to bypass the configuration options.
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7. Clear the Block all public access check box to allow access to Tableau.

8. Click Next.
9. Click Create bucket.

» The bucket is created.
10. On the Buckets tab, search for your newly created bucket, and then click it.

» The bucket details page opens.
11. Click Upload to upload the data you downloaded from your Collibra environment.

» The Upload dialog box appears.
12. Click Add files, or drag all of the folders in the ZIP file you downloaded from your Col-

libra environment into the dialog box.

» The folders appear in the Upload dialog box.
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13. Click Upload.
» The folders are added to the newly created bucket.

Step 3: Download the Insights Data Access package from Collibra
Marketplace

1. Go to Collibra Marketplace.
2. Download the Insights Data Access package.

» A ZIP file is downloaded to your hard disk.
3. Extract the ZIP file on your local computer.

» A folder with the name of the ZIP file is created.

Step 4: Create the Insights Data Access model in AWS Athena

1. On the AWSmain menu, expand the Services page, and then select Athena.
2. On the New query tab, enter CREATE DATABASE <name-of-the-database>;.

As shown in the following image (example), a database named collibra_rpt is
already created.

3. Click Run query.
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4. On the Database drop-down menu, select the database you created.

5. Click + to add another query.

In the Insights Data Access ZIP file you downloaded from the Marketplace, drag the
first SQL file into a new query tab.
» The code appears in the query tab.

6. Change the location to the recently created bucket.
In this example, {{customer_data_location}} is replaced with collibra-insights.

7. Click Run query.
8. Repeat Steps 5 through 7 for each of the SQL files in the Insights Data Access ZIP

file.
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» When all the steps are completed, all table definitions are shown and Insights Data
Access is fully configured.

Generate dashboard reports via AWS
After setting up Insights Data Access on Amazon Web Services (AWS), you can generate
dashboard reports configured in Collibra Console.

Tip You can also generate dashboard reports via URL.

Before you begin
Set up Insights Data Access on AWSGCP.

Requirements and permissions
l The Insights global role, to be able to view a report in Collibra Data Intelligence
Cloud.

l A license for Tableau Desktop 2018.3.
l A Tableau Server or Tableau Online account.
l The athena:GetQueryResultsStream AWS permission, to be able to get the
reporting data from AWS.
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Steps

1. Download the report templates from Collibra Marketplace
2. Install the SQL views associated with the Tableau workbook files
3. Publish the workbook files to your Tableau Server or Tableau Online account and

configure a database extract refresh schedule event
4. Configure the reporting options in Collibra Settings
5. Add a dashboard in Collibra and configure the Insights widget

Step 1: Download the report templates from Collibra Marketplace

1. Go to Collibra Marketplace.
2. Download the following three report template packages:

o Process Register Report Template
o Privacy and Risk Readiness Report Template
o Data Maturity Report Template

» The three ZIP files are downloaded to your hard disk.
3. Extract the ZIP files on your local computer.

» Folders with the names of the ZIP files are created. Each folder contains a SQL
file and a TWBX file.

Step 2: Install the SQL views associated with the Tableau workbook
files

Note
l If this is the first time you are installing the SQL views, you must perform this
step for each of the Tableau workbook files.

l If you have previously installed the SQL views but are now installing a new
version of a report, you must install the new SQL view, if one was provided
with the new report.
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1. On the AWSmain menu, expand the Services page, and then select Athena.
2. On the Database menu, select the relevant database.

3. Click + to add another query.

4. In one of the report template package ZIP files you downloaded from Collibra Mar-
ketplace, drag the SQL file to a new query tab.

» The code appears in the query tab.

5. Click Run query.
6. Repeat Steps 3 through 5 for the SQL files in the other two report template pack-

ages.
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Step 3: Publish the workbook files to your Tableau Server or Online
account and configure a refresh schedule event

1. On your hard drive, go to the folder of one of the report templates you downloaded
from Collibra Marketplace (for example, DataMaturity).

2. Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).
3. If the following dialog box appears, click Yes.

4. Perform one of the following steps:
o If the following dialog box appears, click Edit connection.
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o If the Tableau dashboard is shown, click the Data Source tab in the lower-left
corner of the page.

5. Enter the information specific to your AWS server.

6. Click Sign in.

Note If you now receive an error, it may be an indication that the data source
"collibra_rpt" is not configured. In this case, consider editing the connection
details to point to the data source you have created.

7. In the upper-right corner of the page, select an Extract connection.

8. In the lower-left corner of the page, click the Dashboard tab.
9. In the Save As dialog box, enter a name for the database extract file.
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10. Click Save.
» The extract file is saved and a database extract is cached. This can take several
minutes to complete.

11. When the dashboard is loaded, click or File > Save to save the database extract.

12. On the main menu, click Server, and then click Sign In.

13. In the Tableau Server Sign in dialog box, click Connect.

14. Enter your Tableau sign in credentials.
15. Select the site to which you want to publish the Tableau workbook.
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16. Click Server, and then select Publish Workbook.
» The following dialog box appears.

17. Enter the required information.
For the current task, the following fields are of interest.

Property Description

Project The project to which you want to publish.

Name The name of the workbook.

Refresh Schedule
(Full Extract)

The frequency with which the currently cached database extract is purged and a
new extract is cached.

Tip Collibra recommends scheduling a daily refresh.

Sheets Allows you to specify which sheets to include in the publication. You can hide
sheets if you want to publish a dashboard without showing all the worksheets that
were used to create it.

Tip To avoid clutter, consider clicking Edit and then clicking Only
Dashboards.
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Property Description

Data Sources Determines:

o Whether the data is embedded in the workbook or published sep-
arately.

o How users authenticate with data sources.

Tip Collibra recommends the following settings: Click Edit, and
then:
o In the Publish Type drop-down menu, select Embedded in
workbook.
This enables users to view the report without having to
authenticate themselves every time.

o In the Authentication drop-down menu, select Allow refresh
access.
This automatically refreshes the extract of the database. The
frequency with which the cache is refreshed is determined by
the value you enter in the Refresh Schedule field.

More options Additional publication options. Include external files determines whether or not
external files are included in the publication.

Note
o Only the DataMaturityDashboard.twbx file refers to external files.

The Include external files option is not available for the other
Tableau workbook files.

o Ensure that Include external files is selected, so that the images
included with the Tableau workbook files are included in the
publication.

18. Click Publish.
» The report is published to your Tableau Server or Online account.
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Tip On the Refresh Schedules tab, the refresh schedule event you
configured is shown.

Step 4: Configure the reporting options in Collibra Settings

1. On the Workbooks tab in Tableau, click one of the workbook files, for example Pri-
vacy & Risk Readiness.

608



2. Click Dashboard.

3. Click Share.
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4. In the Share dialog box, copy the URL in the Link field.

5. Open Collibra Console with a user profile that has at least the ADMIN role.
» Collibra Console opens with the Infrastructure page.

6. In the tab pane, click the Data Governance Center service of a Collibra environment.
» The details of the DGC service are shown.

7. Click Configuration.
8. Click Edit configuration.
9. Scroll down the list of configuration options and click Reporting.
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10. In field Tableau report URL pattern, paste the URL that you copied from the Link
field in Tableau.

11. In the URL, replace the actual report name (such as DataMaturityDashboard) by
{reportName}, for example:
https://tableau-dev2.<your-Collibra-Data-Intelligence-Cloud-environment-
URL>/t/Insights/views/{reportName}/iframeSizedToWindow=true&...

12. Under Reports definitions, click Add.

Note You must perform this step for all three reports.

o In a Report view name, enter the name of a report, as you want it to appear on
the report button in the Insights widget, for example:

n Data Maturity Dashboard
n Privacy & Risk Readiness
n Process Register

o ln b Report name, enter the report name, for example:
n DataMaturityDashboard
n PrivacyRiskReadiness
n ProcessRegister
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Tip Use the name as it appears in the URL of the Tableau report, for
example "DataMaturityDashboard".

The settings in Console should look similar to the following example image:

o Click Add, and then add the report definitions for the remaining two reports.

13. Click Save all.
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Step 5: Add a dashboard in Collibra and configure the Insights
widget

Tip To facilitate the viewing of each report, we recommend that you add and
configure a separate dashboard for each report. To do so, you have to complete this
step for each report.

1. In the Collibra main menu, click → Dashboards.

2. In the view bar, click → Add Dashboard.

3. Enter the required information.

Property Description

Name The name of your new dashboard.

Description A description of the dashboard (optional).

Layout The number of columns in the layout of the dashboard.

Tip Ensure that 1 column is selected.

Always visible in
the toolbar.

Option to always show the dashboard in the toolbar.

4. Click Save.
5. In the view bar, click → Edit widgets.

6. Find the Insights widget and drag it onto the dashboard.
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» The three reports that you configured in Collibra Settings are shown:

7. Select the report you want to show on the dashboard.
8. Click Save.

» The report is shown on the dashboard you created.

What's next?
Optionally, you can:

l Remove non-applicable regulation placeholder.
l Improve the visual output of the Data Maturity report.

Generate a dashboard report via URL on AWS
After setting up Insights Data Access on Amazon Web Services, you can generate a
dashboard report via a URL, from tools such as Tableau Online, Power BI, Qlik, or
ThoughtSpot.

Requirements and permissions
l The Insights global role, to be able to view a report in Collibra Data Intelligence
Cloud.

l A license for Tableau Desktop 2018.3.
l A Tableau Server or Tableau Online account.
l The athena:GetQueryResultsStream AWS permission, to be able to get the
reporting data from AWS.
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Steps

1. Download the report templates from Collibra Marketplace
2. Install the SQL views associated with the Tableau workbook files
3. Publish the workbook files to your Tableau Server or Tableau Online account and

configure a database extract refresh schedule event
4. Obtain the shareable link
5. Add a dashboard in Collibra and add your report via URL

Step 1: Download the report templates from Collibra Marketplace

1. Go to Collibra Marketplace.
2. Download the following three report template packages:

o Process Register Report Template
o Privacy and Risk Readiness Report Template
o Data Maturity Report Template

» The three ZIP files are downloaded to your hard disk.
3. Extract the ZIP files on your local computer.

» Folders with the names of the ZIP files are created. Each folder contains a SQL
file and a TWBX file.

Step 2: Install the SQL views associated with the Tableau workbook
files

Note
l If this is the first time you are installing the SQL views, you must perform this
step for each of the Tableau workbook files.

l If you have previously installed the SQL views but are now installing a new
version of a report, you must install the new SQL view, if one was provided
with the new report.
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1. On the AWSmain menu, expand the Services page, and then select Athena.
2. On the Database menu, select the relevant database.

3. Click + to add another query.

4. In one of the report template package ZIP files you downloaded from Collibra Mar-
ketplace, drag the SQL file to a new query tab.

» The code appears in the query tab.

5. Click Run query.
6. Repeat Steps 3 through 5 for the SQL files in the other two report template pack-

ages.
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Step 3: Publish the workbook files to your Tableau Server or Online
account and configure a refresh schedule event

1. On your hard drive, go to the folder of one of the report templates you downloaded
from Collibra Marketplace (for example, DataMaturity).

2. Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).
3. If the following dialog box appears, click Yes.

4. Perform one of the following steps:
o If the following dialog box appears, click Edit connection.

Chapter 20

617



Chapter 20

o If the Tableau dashboard is shown, click the Data Source tab in the lower-left
corner of the page.

5. Enter the information specific to your AWS server.

6. Click Sign in.

Note If you now receive an error, it may be an indication that the data source
"collibra_rpt" is not configured. In this case, consider editing the connection
details to point to the data source you have created.

7. In the upper-right corner of the page, select an Extract connection.

8. In the lower-left corner of the page, click the Dashboard tab.
9. In the Save As dialog box, enter a name for the database extract file.
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10. Click Save.
» The extract file is saved and a database extract is cached. This can take several
minutes to complete.

11. When the dashboard is loaded, click or File > Save to save the database extract.

12. On the main menu, click Server, and then click Sign In.

13. In the Tableau Server Sign in dialog box, click Connect.

14. Enter your Tableau sign in credentials.
15. Select the site to which you want to publish the Tableau workbook.
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16. Click Server, and then select Publish Workbook.
» The following dialog box appears.

17. Enter the required information.
For the current task, the following fields are of interest.

Property Description

Project The project to which you want to publish.

Name The name of the workbook.

Refresh Schedule
(Full Extract)

The frequency with which the currently cached database extract is purged and a
new extract is cached.

Tip Collibra recommends scheduling a daily refresh.

Sheets Allows you to specify which sheets to include in the publication. You can hide
sheets if you want to publish a dashboard without showing all the worksheets that
were used to create it.

Tip To avoid clutter, consider clicking Edit and then clicking Only
Dashboards.
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Property Description

Data Sources Determines:

o Whether the data is embedded in the workbook or published sep-
arately.

o How users authenticate with data sources.

Tip Collibra recommends the following settings: Click Edit, and
then:
o In the Publish Type drop-down menu, select Embedded in
workbook.
This enables users to view the report without having to
authenticate themselves every time.

o In the Authentication drop-down menu, select Allow refresh
access.
This automatically refreshes the extract of the database. The
frequency with which the cache is refreshed is determined by
the value you enter in the Refresh Schedule field.

More options Additional publication options. Include external files determines whether or not
external files are included in the publication.

Note
o Only the DataMaturityDashboard.twbx file refers to external files.

The Include external files option is not available for the other
Tableau workbook files.

o Ensure that Include external files is selected, so that the images
included with the Tableau workbook files are included in the
publication.

18. Click Publish.
» The report is published to your Tableau Server or Online account.

Chapter 20

621



Chapter 20

Tip On the Refresh Schedules tab, the refresh schedule event you
configured is shown.

Step 4: Obtain the shareable link

1. On the Workbooks tab in Tableau, click one of the workbook files, for example Pri-
vacy & Risk Readiness.
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2. Click Dashboard.

3. Click Share.
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4. In the Share dialog box, copy the URL in the Link field.

Step 5: Add a dashboard in Collibra and then add your report via
URL

Tip To facilitate the viewing of each report, consider adding and configuring a
separate dashboard for each report. To do so, you must complete this step for each
report.

1. On the Collibra main menu, click → Dashboards.

2. In the view bar, click → Add Dashboard.

3. Enter the required information.

Property Description

Name The name of your new dashboard.

Description
(optional)

A description of the dashboard.

Layout The number of columns in the layout of the dashboard.

Tip Ensure that 1 column is selected.
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Property Description

Always visible in
the toolbar.

Option to always show the dashboard in the toolbar.

4. Click Save.
5. In the view bar, click → Edit widgets.

6. Find the Insights widget, and then drag it to the dashboard.

7. Click Enter a URL, and then enter the relevant URL.

8. Click Save.
» The report is shown on the dashboard you created.

What's next?
Optionally, you can:

l Remove non-applicable regulation placeholder.
l Improve the visual output of the Data Maturity report.
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Creating Insights Data Access on GCP and
generating reports
Before configuring the dashboard reports, you must set up Insights Data Access on
Google Cloud Platform (GCP). You can then create your dashboard reports via Collibra
Console or URL.

Set up Insights Data Access on GCP
This section describes how to set up Insights Data Access on the Google Cloud Platform
(GCP) with Google Cloud Storage and Google BigQuery. You can, however, use
alternative software.

Tip For information about how to set up Insights Data Access on Amazon Web
Services, go to Set up Insights Data Access on AWS.

Requirements and permissions
l Collibra Data Intelligence Cloud 5.7 or newer.
l License for Collibra Insights.
l Software for working with Parquet files.

Steps

1. Download a data snapshot from your Collibra environment.
2. Upload the data to a Google Cloud Storage bucket.
3. Create the Insights Data Access model in Google BigQuery.

Step 1: Download a data snapshot from your Collibra DGC
environment

1. Enter the following URL in your browser:
<your-DGC-environment-
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URL>/rest/2.0/re-

porting/insights/download?snapshotDate=<snapshot_date>&-

format=zip

where, <snapshot date> is the date from which you want the data, formatted as
YYYY-MM-DD, for example 2019-07-23.
» A ZIP file of the data from your Collibra environment, for the specified date, is
downloaded to your hard disk.

2. Extract the ZIP files on your local computer.
» A folder with the name of the ZIP file is created.

Step 2: Upload the data to a Google Cloud Storage bucket

Note This only needs to be done once for the collection Tableau workbook files.
After that, you only need to carry out this step If the data layer model changes.

1. Sign in to your GCP account and choose your working project for Insights deploy-
ment.

Tip We recommend that you create a separate project for Insights
deployment.

2. On the tab menu, click the Storage tab and then click Cloud Storage.
3. On the Browser tab, click Create bucket.

» The Create a bucket dialog box appears.
4. In the Name your bucket field, enter a name for the bucket you are creating, for

example collibra-insights.
5. Click Continue.
6. In the Choose where to store your data section, enter the relevant values, for

example:
o Location type: Multi-region
o Location: Your geographic location

Chapter 20

627



Chapter 20

Tip Consult your IT department for help with the correct values for your
Collibra environment configuration and to ensure compliance with your
company policies.

7. Click Continue.
8. In the Choose a default storage class for your data section, click Standard.
9. Click Continue.
10. in the Choose how to control access to objects section, enter the relevant values,

for example:
o Access control: Uniform

Tip Consult your IT department for help with the correct values for your
Collibra environment configuration and to ensure compliance with your
company policies.

11. Click Continue.
12. In the Choose how to protect object data section, enter the relevant values, for

example:
o Protection tool: None

Tip Consult your IT department for help with the correct values for your
Collibra environment configuration and to ensure compliance with your
company policies.

13. Click Create.
» The bucket is created.

14. On the Browse tab, search for your newly created bucket, and then click it.

» The bucket details page opens.
15. Click Upload Folder to upload the data you downloaded from your Collibra envir-

onment.
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» The Upload dialog box appears.
16. In the Upload dialog box, find the unpacked folders of the ZIP file you downloaded

from your Collibra environment. As shown in the following image, there are eight
folders to be uploaded.

17. Select a folder, for example complex_relation, and then click Upload.

Note You can only select one folder at a time.

18. Repeat Steps 15 through 17 until you have uploaded all eight folders.
» The folders are added to the newly created bucket.
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Step 3: Create the Insights Data Access model in Google BigQuery

Tip The objective of Steps 6 through 8 in the following procedure can also be
achieved by using a Cloud shell command.

1. On the left tab menu, in the BIG DATA section, click BigQuery.
2. On the Explorer page, find your Insights project, and then click > Create dataset.
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3. In the Create dataset side panel, enter the relevant information.

Field Description

Dataset ID A unique name for your dataset.

Data location The geographical region of your data.

Tip Consult your IT department for help with the correct value for
your Collibra environment configuration and to ensure compliance
with your company policies.

4. Click Create dataset.
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5. In the Explorer page, find your newly created dataset, and then click > Open.

» The dataset view page opens.

6. In the dataset view page, click Create table.

» The Create table side panel opens.
7. In the Create table section, enter the relevant information.
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Field Description

Create table
from

Select Google Cloud Storage.

Select file from
GCS bucket

Enter <your-data-bucket-name>/<data type>/*.parquet

The bucket name is the one you created in Step 2.4 and the data type, for
example asset, is the sub-directory location.

Tip Step 9 of this procedure prompts you to repeat Steps 6 through 8, for
each data type, for example, asset, attributes, relation, responsibility, and
so on.

File format Select Parquet.

Source Data
Partitioning

This checkbox must be cleared.

Search for a pro-
ject / Enter a pro-
ject name

Select the Search for a project option.

Project name Select the project you are using for Insights deployment.

Dataset name Select the database name you entered in Step 3.3.

Table type Select Native table.

Table name Enter the data type. This must match the data type entered for the sub-directory
location in the Select file from GCS bucket field.

Tip Step 9 of this procedure prompts you to repeat Steps 6 through 8, for
each data type, for example, asset, attribute, relation, responsibility, and
so on.

8. Click Create table.
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9. Repeat Steps 6 through 8 for each data type in the file you downloaded in Step 1.1,
for example, asset, relation, responsibility, and so on.

» When all the steps are completed, all table definitions are shown and Insights Data
Access is fully configured.
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Use a Cloud shell command
The objective of Steps 6 through 8 in the previous procedure can also be achieved by
using a Cloud shell command.

Run the following command, where <customer-dataset-name> and <customer-data-
bucket> are replaced with the relevant values.

bq load \
--noreplace \
--source_format=PARQUET \
<customer-dataset-name>.asset \
gs://<customer-data-bucket>/asset/*.parquet

bq load \
--noreplace \
--source_format=PARQUET \
<customer-dataset-name>.asset_tag \
gs://<customer-data-bucket>/asset_tag/*.parquet

bq load \
--noreplace \
--source_format=PARQUET \
customer-dataset-name>.attribute \
gs://<customer-data-bucket>/attribute/*.parquet

bq load \
--noreplace \
--source_format=PARQUET \
<customer-dataset-name>.community \
gs://<customer-data-bucket>/community/*.parquet

bq load \
--noreplace \
--source_format=PARQUET \
<customer-dataset-name>.complex_relation \
gs://<customer-data-bucket>/complex_relation/*.parquet

bq load \
--noreplace \
--source_format=PARQUET \
<customer-dataset-name>.domain \
gs://<customer-data-bucket>/domain/*.parquet

bq load \
--noreplace \
--source_format=PARQUET \
<customer-dataset-name>.relation \
gs://<customer-data-bucket>/relation/*.parquet
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bq load \
--noreplace \
--source_format=PARQUET \
<customer-dataset-name>.responsibility \
gs://<customer-data-bucket>/responsibility/*.parquet

Generate dashboard reports via GCP
After setting up Insights Data Access on Google Cloud Platform (GCP), you can generate
dashboard reports configured in Collibra Console.

Tip You can also generate dashboard reports via URL.

Before you begin
Create Insights Data Access on AWSGCP.

Requirements and permissions
l The Insights global role, to be able to view a report in Collibra Data Intelligence
Cloud.

l A license for Tableau Desktop 2018.3.
l A Tableau Server or Tableau Online account.
l The athena:GetQueryResultsStream AWS permission, to be able to get the
reporting data from AWS.

Steps

1. Download the report templates from Collibra Marketplace
2. Install the SQL views associated with the Tableau workbook files
3. Publish the workbook files to your Tableau Server or Tableau Online account and

configure a database extract refresh schedule event
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4. Configure the reporting options in Collibra Settings
5. Add a dashboard in Collibra and configure the Insights widget

Step 1: Download the report templates from Collibra Marketplace

1. Go to Collibra Marketplace.
2. Download the following three report template packages:

o Process Register Report Template
o Privacy and Risk Readiness Report Template
o Data Maturity Report Template

» The three ZIP files are downloaded to your hard disk.
3. Extract the ZIP files on your local computer.

» Folders with the names of the ZIP files are created. Each folder contains a SQL
file and a TWBX file.

Step 2: Install the SQL views associated with the Tableau workbook
files

Note
l If this is the first time you are installing the SQL views, you must perform this
step for each of the Tableau workbook files.

l If you have previously installed the SQL views but are now installing a new
version of a report, you must install the new SQL view, if one was provided
with the new report.

1. In the BIG DATA section of the GCP left-hand menu, click BigQuery.
2. In the Explorer page, click COMPOSE NEW QUERY.

3. From one of the report template packages you downloaded from Collibra Mar-
ketplace, drag one of the SQL files to a new query tab.
» The code appears on the query tab.
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4. In the code, change any occurrences of "<customer_dataset>" to "<the-name-of-
your-Insights-dataset>".

Tip The dataset name is the value you entered in the Dataset ID field in Step
3 of the Create the Reporting Data Layer on Google Cloud Platform
procedure.

5. Click Save > Save View.

» The Save view dialog box appears.
6. In the Save view dialog box, enter the relevant information:

Field Description

Project The project you are using for Insights deployment.

Dataset ID The value you entered in the Dataset ID field in Step 3 of the Create the
Reporting Data Layer on Google Cloud Platform procedure.

Table name The name of the report SQL file, for example data_maturity.

7. Repeat Steps 3 through 5 for the SQL files in the other two report template pack-
ages.
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Step 3: Publish the workbook files to your Tableau Server or Online
account and configure a refresh schedule event

1. On your hard drive, go to the folder of one of the report templates you downloaded
from Collibra Marketplace (for example, DataMaturity).

2. Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).
» The Google sign in page appears.

3. Select the relevant Google account.
» You are prompted to allow Tableau to access your Google account.

4. Ensure that both access options are selected, and then click Allow.
5. In the Tableau DataMaturityDashboard, click Edit Connection in the Dashboard

Unavailable notification.
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» The Data Source tab opens.
6. Specify the following information.

Field Description

Project The project you are using for Insights deployment.

Dataset What the user should choose.
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7. In the Table section, double-click the data_maturity view.
» The view appears in the main frame, indicating that a link to the data is made.

8. In the upper-right corner of the page, select an Extract connection.

9. In the lower-left corner of the page, click the Dashboard tab.
10. In the Save As dialog box, enter a name for the database extract file.
11. Click Save.

» The extract file is saved and a database extract is cached. This can take several
minutes to complete.

12. When the dashboard is loaded, click or File > Save, to save the database extract.

13. On the main menu, click Server, and then click Sign In.

14. In the Tableau Server Sign in dialog box, click Connect.

15. Enter your Tableau sign in credentials.
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16. Select the site to which you want to publish the Tableau workbook.

17. Click Server, and then select Publish Workbook.
» The following dialog box appears.

18. Enter the required information.
For this task, the following fields are of interest.

Property Description

Project The project to which you want to publish.

Name The name of the workbook.

Refresh Schedule
(Full Extract)

The frequency with which the currently cached database extract is purged and a
new extract is cached.

Tip Collibra recommends that you schedule a daily refresh.
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Property Description

Sheets Allows you to specify which sheets to include in the publication. You can hide
sheets if you want to publish a dashboard without showing all the worksheets that
were used to create it.

Tip To avoid clutter, Collibra recommends that you click Edit and then
click Only Dashboards.

Data Sources Determines:

o Whether the data is embedded in the workbook or published sep-
arately.

o How users authenticate with data sources.

Tip Collibra strongly recommends the following settings: Click
Edit and then:
o In the Publish Type drop-down menu, select Embedded in
workbook.
This enables users to view the report without having to
authenticate themselves every time.

o In the Authentication drop-down menu, select Allow refresh
access.
This automatically refreshes the extract of the database. The
frequency with which the cache is refreshed is determined by
the value you enter in the Refresh Schedule field.

More options Additional publication options. Include external files determines whether or not
external files are included in the publication.

Note
o Only the DataMaturityDashboard.twbx file refers to external files.

The Include external files option is not available for the other
Tableau workbook files.

o Ensure that the Include external files is selected, so that the images
included with the Tableau workbook files are included in the
publication.

19. Click Publish.
» The report is published to your Tableau Server or Online account.
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Tip On the Refresh Schedules tab, the refresh schedule event you
configured is shown.

Step 4: Configure the reporting options in Collibra Settings

1. On the Workbooks tab in Tableau, click one of the workbook files, for example Pri-
vacy & Risk Readiness.
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2. Click Dashboard.

3. Click Share.
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4. In the Share dialog box, copy the URL in the Link field.

5. Open Collibra Console with a user profile that has at least the ADMIN role.
» Collibra Console opens with the Infrastructure page.

6. In the tab pane, click the Data Governance Center service of a Collibra environment.
» The details of the DGC service are shown.

7. Click Configuration.
8. Click Edit configuration.
9. Scroll down the list of configuration options and click Reporting.
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10. In field Tableau report URL pattern, paste the URL that you copied from the Link
field in Tableau.

11. In the URL, replace the actual report name (such as DataMaturityDashboard) by
{reportName}, for example:
https://tableau-dev2.<your-Collibra-Data-Intelligence-Cloud-environment-
URL>/t/Insights/views/{reportName}/iframeSizedToWindow=true&...

12. Under Reports definitions, click Add.

Note You must perform this step for all three reports.

o In a Report view name, enter the name of a report, as you want it to appear on
the report button in the Insights widget, for example:

n Data Maturity Dashboard
n Privacy & Risk Readiness
n Process Register

o ln b Report name, enter the report name, for example:
n DataMaturityDashboard
n PrivacyRiskReadiness
n ProcessRegister
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Tip Use the name as it appears in the URL of the Tableau report, for
example "DataMaturityDashboard".

The settings in Console should look similar to the following example image:

o Click Add, and then add the report definitions for the remaining two reports.

13. Click Save all.

648



Step 5: Add a dashboard in Collibra and configure the Insights
widget

Tip To facilitate the viewing of each report, we recommend that you add and
configure a separate dashboard for each report. To do so, you have to complete this
step for each report.

1. In the Collibra main menu, click → Dashboards.

2. In the view bar, click → Add Dashboard.

3. Enter the required information.

Property Description

Name The name of your new dashboard.

Description A description of the dashboard (optional).

Layout The number of columns in the layout of the dashboard.

Tip Ensure that 1 column is selected.

Always visible in
the toolbar.

Option to always show the dashboard in the toolbar.

4. Click Save.
5. In the view bar, click → Edit widgets.

6. Find the Insights widget and drag it onto the dashboard.
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» The three reports that you configured in Collibra Settings are shown:

7. Select the report you want to show on the dashboard.
8. Click Save.

» The report is shown on the dashboard you created.

What's next?
Optionally, you can:

l Remove non-applicable regulation placeholder.
l Improve the visual output of the Data Maturity report.

Generate a dashboard report via URL on GCP
After setting up Insights Data Access on Google Cloud Platform, you can generate a
dashboard report via a URL, from tools such as Tableau Online, Power BI, Qlik, or
ThoughtSpot.

Requirements and permissions
l The Insights global role, to be able to view a report in Collibra Data Intelligence
Cloud.

l A license for Tableau Desktop 2018.3.
l A Tableau Server or Tableau Online account.
l The athena:GetQueryResultsStream AWS permission, to be able to get the
reporting data from AWS.

650



Steps

1. Download the report templates from Collibra Marketplace
2. Install the SQL views associated with the Tableau workbook files
3. Publish the workbook files to your Tableau Server or Tableau Online account and

configure a database extract refresh schedule event
4. Obtain the shareable link
5. Add a dashboard in Collibra and add your report via URL

Step 1: Download the report templates from Collibra Marketplace

1. Go to Collibra Marketplace.
2. Download the following three report template packages:

o Process Register Report Template
o Privacy and Risk Readiness Report Template
o Data Maturity Report Template

» The three ZIP files are downloaded to your hard disk.
3. Extract the ZIP files on your local computer.

» Folders with the names of the ZIP files are created. Each folder contains a SQL
file and a TWBX file.

Step 2: Install the SQL views associated with the Tableau workbook
files

Note
l If this is the first time you are installing the SQL views, you must perform this
step for each of the Tableau workbook files.

l If you have previously installed the SQL views but are now installing a new
version of a report, you must install the new SQL view, if one was provided
with the new report.
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1. In the BIG DATA section of the GCP left-hand menu, click BigQuery.
2. In the Explorer page, click COMPOSE NEW QUERY.

3. From one of the report template packages you downloaded from Collibra Mar-
ketplace, drag one of the SQL files to a new query tab.
» The code appears on the query tab.

4. In the code, change any occurrences of "<customer_dataset>" to "<the-name-of-
your-Insights-dataset>".

Tip The dataset name is the value you entered in the Dataset ID field in Step
3 of the Create the Reporting Data Layer on Google Cloud Platform
procedure.

5. Click Save > Save View.

» The Save view dialog box appears.
6. In the Save view dialog box, enter the relevant information:
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Field Description

Project The project you are using for Insights deployment.

Dataset ID The value you entered in the Dataset ID field in Step 3 of the Create the
Reporting Data Layer on Google Cloud Platform procedure.

Table name The name of the report SQL file, for example data_maturity.

7. Repeat Steps 3 through 5 for the SQL files in the other two report template pack-
ages.

Step 3: Publish the workbook files to your Tableau Server or Online
account and configure a refresh schedule event

1. On your hard drive, go to the folder of one of the report templates you downloaded
from Collibra Marketplace (for example, DataMaturity).

2. Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).
» The Google sign in page appears.

3. Select the relevant Google account.
» You are prompted to allow Tableau to access your Google account.

4. Ensure that both access options are selected, and then click Allow.
5. In the Tableau DataMaturityDashboard, click Edit Connection in the Dashboard

Unavailable notification.
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» The Data Source tab opens.
6. Specify the following information.

Field Description

Project The project you are using for Insights deployment.

Dataset What the user should choose.
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7. In the Table section, double-click the data_maturity view.
» The view appears in the main frame, indicating that a link to the data is made.

8. In the upper-right corner of the page, select an Extract connection.

9. In the lower-left corner of the page, click the Dashboard tab.
10. In the Save As dialog box, enter a name for the database extract file.
11. Click Save.

» The extract file is saved and a database extract is cached. This can take several
minutes to complete.

12. When the dashboard is loaded, click or File > Save, to save the database extract.

13. On the main menu, click Server, and then click Sign In.

14. In the Tableau Server Sign in dialog box, click Connect.

15. Enter your Tableau sign in credentials.

Chapter 20

655



Chapter 20

16. Select the site to which you want to publish the Tableau workbook.

17. Click Server, and then select Publish Workbook.
» The following dialog box appears.

18. Enter the required information.
For this task, the following fields are of interest.

Property Description

Project The project to which you want to publish.

Name The name of the workbook.

Refresh Schedule
(Full Extract)

The frequency with which the currently cached database extract is purged and a
new extract is cached.

Tip Collibra recommends that you schedule a daily refresh.
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Property Description

Sheets Allows you to specify which sheets to include in the publication. You can hide
sheets if you want to publish a dashboard without showing all the worksheets that
were used to create it.

Tip To avoid clutter, Collibra recommends that you click Edit and then
click Only Dashboards.

Data Sources Determines:

o Whether the data is embedded in the workbook or published sep-
arately.

o How users authenticate with data sources.

Tip Collibra strongly recommends the following settings: Click
Edit and then:
o In the Publish Type drop-down menu, select Embedded in
workbook.
This enables users to view the report without having to
authenticate themselves every time.

o In the Authentication drop-down menu, select Allow refresh
access.
This automatically refreshes the extract of the database. The
frequency with which the cache is refreshed is determined by
the value you enter in the Refresh Schedule field.

More options Additional publication options. Include external files determines whether or not
external files are included in the publication.

Note
o Only the DataMaturityDashboard.twbx file refers to external files.

The Include external files option is not available for the other
Tableau workbook files.

o Ensure that the Include external files is selected, so that the images
included with the Tableau workbook files are included in the
publication.

19. Click Publish.
» The report is published to your Tableau Server or Online account.
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Tip On the Refresh Schedules tab, the refresh schedule event you
configured is shown.

Step 4: Obtain the shareable link

1. On the Workbooks tab in Tableau, click one of the workbook files, for example Pri-
vacy & Risk Readiness.
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2. Click Dashboard.

3. Click Share.
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4. In the Share dialog box, copy the URL in the Link field.

Step 5: Add a dashboard in Collibra and then add your report via
URL

Tip To facilitate the viewing of each report, consider adding and configuring a
separate dashboard for each report. To do so, you must complete this step for each
report.

1. On the Collibra main menu, click → Dashboards.

2. In the view bar, click → Add Dashboard.

3. Enter the required information.

Property Description

Name The name of your new dashboard.

Description
(optional)

A description of the dashboard.

Layout The number of columns in the layout of the dashboard.

Tip Ensure that 1 column is selected.
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Property Description

Always visible in
the toolbar.

Option to always show the dashboard in the toolbar.

4. Click Save.
5. In the view bar, click → Edit widgets.

6. Find the Insights widget, and then drag it to the dashboard.

7. Click Enter a URL, and then enter the relevant URL.

8. Click Save.
» The report is shown on the dashboard you created.

What's next?
Optionally, you can:

l Remove non-applicable regulation placeholder.
l Improve the visual output of the Data Maturity report.
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Improve the visual output of the Data
Maturity report
A well configured Data Maturity report will look something like the following image.

However, it's possible that you correctly configured the Data Maturity report, but it looks
more like the following image.
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Common scenarios and tips
Here are some common scenarios, explanations and tips for improving the visual output of
the report.

The progress circle charts show 0%
In the following example image, the Ownership progress circle chart shows 0%.

If you go to the Ownership Metrics tab, you see that there are many Business Term assets
for inclusion in the report. One might expect that the presence of these assets would be
reflected in the circle chart. However, the formula for calculating the percentage entails a
division operation involving the number of assets with the status Approved. In this
example, there are no assets that have the status Approved, and this "0" value results in
an Ownership percentage of 0%.
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Tip Keep in mind that progress circle charts are reliant on approved assets. In
other words, the more mature the data set, the more meaningful the progress circle
chart will be.

No progress circle chart is shown
In the following example image, no progress circle chart is shown for the Data Model
metric.

Tip Ensure that the relevant asset types are selected for the Data Model metric.
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1. At the bottom of the page, click the Data Model Metrics tab.

2. In the Data tab, select Data Models Asset Types, and then select Edit Set.

» The Edit Set dialog box appears; however, no asset types are selected.

3. Select the asset types that you want to monitor, for example Data Model, Data Entity
and Data Attribute.

4. Click OK.
» The data is now shown, in accordance with the selected asset types.
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Note Keep in mind that the formula for calculating the percentage entails a
division operation involving the number of assets with the status Approved.

5. On the Dashboard tab, the progress circle chart is now shown for the Data Model
metric.

The report includes non-applicable metrics
In this example image, we are not interested in the Data Structure, Reference Data,
Authoritative Source and Distribution Source metrics, and want to remove them from the
report.

Remove a single metric

1. Select a single metric.
You might have to first select the section, for example Enterprise, and drag the
frame so that you can click an individual metric.
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2. Click the Remove from dashboard icon .

Remove several metrics at once

1. Click in the Community section, so that the entire section is highlighted.
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2. Click the "go to sheet" icon .

» The Community data sheet opens.

3. In the Measure Values section, select the metrics that you want to remove.
In this example, we selected Data Structure, Reference Data, Authoritative Source
and Distribution Source.
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4. Right-click on the selected metrics and select Remove.
» The metrics at the Community level are deleted.

Assets you expected to see in the report are not shown
If assets that you expected to see in the report are not shown, it could be that the status of
the assets are not correctly reflected in the relevant measures. By default, the reports are
configured to show only assets with the status Approved. Assets with other statuses will
not be shown in the reports.

The report templates, however, are fully configurable. You can edit the relevant measures,
to include other statuses, such as Accepted.

Chapter 21

669



Chapter 21

1. Click in the Community section, so that the entire section is highlighted.

2. Click the "go to sheet" icon .

» The Community data sheet opens.

3. In the Measure Values section, select the measure that you want to edit.
In this example, we selected Approved Definition Assets.

4. Right-click on the selected measure and select Edit.
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5. In the calculation logic, change the asset status from "Approved" to the status you
want, for example "Accepted".

6. Click OK.
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Insights Data Access entity relationship
diagram
The following Entity Relationship Diagram image shows how the different Insights Data
Access tables can be linked. All tables contain both packaged variants and custom
variants of the concept.

Note Nested communities can be identified via the parent-child relation.
Subcommunities also have the ID of the community stored next to them.

To combine data for a given date, each table link clause must include snapshot_date.
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Tables

table_name Description

Asset Contains all of the assets in your Collibra Data Intelligence Cloud environment, including
each asset's type and current status.

Asset_tag Contains all of the tags attached to the assets in your Collibra environment.

Attribute Contains all of the asset attributes in your Collibra environment.

Community Contains all of the communities in your Collibra environment, including subcommunities
and domains.

Complex_
relation

Contains all of the relation legs for all of the complex relations in your Collibra environment.

Domain Contains all of the domains in your Collibra environment that contain assets.

Relation Contains all of the relations in your Collibra environment, from head to tail and vice versa.

Responsibility Contains all of the responsibilities in your Collibra environment that are directly assigned at
the asset level or domain level.

Note Inherited responsibilities from the community level are not included in
Insights Data Access.

Asset

column_name ordinal_
position

data_type Description

snapshot_date 1 date The date on which the snapshot was created.
This is synchronized with the snapshot table.

asset_id 2 character varying The resource UUID of the asset. This is a
unique identifier.

asset_full_name 3 character varying The full name of the asset.
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column_name ordinal_
position

data_type Description

asset_display_
name

4 character varying The display name of the asset.

domain_id 5 character varying The resource UUID of the domain. This is a
unique identifier.

asset_type_id 6 character varying The resource UUID of the asset type. This is a
unique identifier.

asset_type_
name

7 character varying The name of the asset type.

status_id 8 character varying The resource UUID of the status.

status_name 9 character varying The name of the status.

articulation 10 double precision The articulation score of the asset.

ratings_average 11 double precision The aggregated average of the ratings of the
asset.

ratings_count 12 integer The number of ratings of the asset.

is_asset_system 13 boolean An indicator of whether the asset is a system
asset.

creator_user_id 14 character varying The UUID of the user who created the asset.

creator_user-
name

15 character varying The username of the user who created the
asset.

creation_date 16 timestamp with
time zone

The date on which the asset was created.

editor_user_id 17 character varying The UUID of the user who last edited the
asset.

editor_username 18 character varying The username of the user who last edited the
asset.
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column_name ordinal_
position

data_type Description

edited_date 19 timestamp with
time zone

The date on which the asset was last edited.

Asset_tag

column_name ordinal_
position

data_type Description

snapshot_date 1 date The date on which the snapshot was created.

tag_id 2 character vary-
ing

The resource UUID of the tag attached to the
asset.

asset_id 3 character vary-
ing

The resource UUID of the asset to which the
tag is attached.

tag_name 4 character vary-
ing

The display name of the tag attached to the
asset.

creator_user_id 5 character vary-
ing

The UUID of the user who created the tag.

creator_user-
name

6 character vary-
ing

The username of the user who created the tag.

creation_date 7 timestamp with
time zone

The date on which the tag was created.

editor_user_id 8 character vary-
ing

The UUID of the user who last edited the tag.

editor_username 9 character vary-
ing

The username of the user who last edited the
tag.

edited_date 10 timestamp with
time zone

The date on which the tag was last edited.

is_tag_system 11 boolean An indicator of whether the tag is a system tag.
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Attribute

column_name ordinal_
position

data_type Description

snapshot_date 1 datetime The date on which the snapshot was created.
This is synchronized with the snapshot table.

attribute_id 2 character varying The UUID of the attribute.

asset_id 3 character varying The UUID of the related asset

asset_type_
name

4 character varying The name of the asset type of the relation
asset.

attribute_type_id 5 character varying The UUID of the attribute type.

attribute_type_
name

6 character varying The name of the attribute type.

attribute_type_
description

7 character varying The description of the attribute type.

kind 8 character varying The kind of attribute.

is_attribute_
integer

9 boolean An indicator of whether the attribute is an
integer.

expression_long 10 character varying The value of the attribute.

boolean_value 11 boolean The value of the attribute converted to a
Boolean value.

datetime_value 12 datetime The value of the attribute converted to a date_
time value.

numeric_value 13 numeric The value of the attribute converted to a
numeric value.

creator_user_id 14 character varying The UUID of the user who created the attrib-
ute.
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column_name ordinal_
position

data_type Description

creator_user-
name

15 character varying The username of the user who created the
attribute.

creation_date 16 timestamp with
time zone

The date on which the attribute was created.

editor_user_id 17 character varying The UUID of the user who last edited the attrib-
ute.

editor_username 18 character varying The username of the user who last edited the
attribute.

edited_date 19 timestamp with
time zone

The date on which the attribute was last
edited.

complex_relation_
id

20 character varying The UUID of the complex relation for which the
attribute is defined.

Community

column_
name

ordinal_position data_type Description

snapshot_
date

1 date The date on which the snapshot was
created. This is synchronized with
the snapshot table.

community_id 2 character vary-
ing

The UUID of the community.

community_
name

3 character vary-
ing

The name of the community.

community_
description

4 text The description of the community.
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column_
name

ordinal_position data_type Description

is_com-
munity_sys-
tem

5 boolean An indicator of whether the com-
munity is a system community.

uri 6 character vary-
ing

The URI of the community.

parent_com-
munity_id

7 character vary-
ing

The UUID of the community con-
taining this community.

level 8 integer The level of the community con-
taining this community. The top level
starts at 1.

level_com-
munity_id

9 character vary-
ing

The UUID of the community con-
taining this community at a certain
level.

level_com-
munity_name

10 character vary-
ing

The name of the community con-
taining this community at a certain
level.

level_com-
munity_
description

11 text The description of the community con-
taining this community at a certain
level.

level_com-
munity_uri

12 character vary-
ing

The URI of the community containing
this community at a certain level.

creator_user_
id

13 character vary-
ing

The UUID of the user who created
the community.

creator_user-
name

14 character vary-
ing

The username of the user who cre-
ated the community.

creation_date 15 timestamp
with time zone

The date on which the relation was
edited.
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column_
name

ordinal_position data_type Description

editor_user_
id

16 character vary-
ing

The UUID of the user who last edited
the community.

editor_user-
name

17 character vary-
ing

The username of the user who last
edited the community.

edited_date 18 timestamp
with time zone

The date on which the community
was last edited.

Complex_relation

column_name ordinal_
position

data_type Description

snapshot_date 1 date The date on which the snapshot was created.
This is synchronized with the snapshot table.

complex_rela-
tion_type_id

2 character varying The UUID of the complex relation type.

complex_rela-
tion_type_name

3 character varying The name of the complex relation type.

complex_rela-
tion_type_
description

4 character varying The description of the complex relation type.

complex_rela-
tion_id

5 character varying The UUID of the complex relation.

relation_type_id 6 character varying The UUID of the relation leg type.

relation_role 7 character varying The role of the relation leg.

asset_id 8 character varying The UUID of the related asset.
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column_name ordinal_
position

data_type Description

creator_user_id 9 character varying The UUID of the user who created the complex
relation.

creator_user-
name

10 character varying The username of the user who created the
complex relation.

creation_date 11 timestamp with
time zone

The date on which the complex relation was
created.

editor_user_id 12 character varying The UUID of the user who last edited the com-
plex relation.

editor_username 13 character varying The username of the user who last edited the
complex relation.

edited_date 14 timestamp with
time zone

The date on which the complex relation was
last edited.

Domain

column_name ordinal_
position

data_type Description

snapshot_date 1 date The date on which the snapshot was created.
This is synchronized with the snapshot table.

domain_id 2 character varying The UUID of the domain.

domain_name 3 character varying The name of the domain.

domain_descrip-
tion

4 text The description of the domain.
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column_name ordinal_
position

data_type Description

domain_uri 5 character varying The URI of the domain.

Note If you create a community or domain
in a development environment and you
restore a backup of the development
environment on your production
environment, the URI for the community or
domain in the report will reflect that of the
development environment, not the
production environment.

is_domain_sys-
tem

6 boolean An indicator of whether the domain is a sys-
tem domain.

domain_type_id 7 character varying The UUID of the domain type.

domain_type_
name

8 character varying The name of the domain type.

domain_type_
description

9 character varying The description of the domain type.

community_id 10 character varying The UUID of the community.

creator_user_id 11 character varying The UUID of the user who created the
domain.

creator_user-
name

12 character varying The username of the user who created the
domain.

creation_date 13 timestamp with
time zone

The date on which the domain was created.

editor_user_id 14 character varying The UUID of the user who last edited the
domain.

editor_username 15 character varying The username of the user who last edited the
domain.
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column_name ordinal_
position

data_type Description

editor_date 16 timestamp with
time zone

The date on which the domain was last
edited.

Relation

column_name ordinal_
position

data_type Description

snapshot_date 1 date The date on which the snapshot was created.
This is synchronized with the snapshot table.

relation_id 2 character varying The UUID of the relation. This column, in com-
bination with the direction column, is a unique
identifier and can be used to uniquely identify
each row.

reation_type_id 3 character varying The UUID of the relation type.

role_or_corole 4 character varying The role of the relation in the direction from
head to tail, co-role of the relation in the dir-
ection from head to tail.

direction 5 character varying The direction of the relation, which can be either:

l Head-to-tail, in which the first asset is the
head and the second asset is the tail.

l Tail-to-head, in which the first asset is the
tail and the second asset is the head.

asset_id1 6 character varying The UUID of the first asset in the relation.

asset_type_id1 7 character varying The UUID of the asset type of the first asset in
the relation.

asset_type_
name1

8 character varying The name of the asset type of the first asset in
the relation.

asset_id2 9 character varying The UUID of the second asset in the relation.
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column_name ordinal_
position

data_type Description

asset_type_id2 10 character varying The UUID of the asset type of the second
asset in the relation.

asset_type_
name2

11 character varying The name of the asset type of the second
asset in the relation.

is_relation_gen-
erated

12 boolean An indicator of whether the relation is gen-
erated.

creator_user_id 13 character varying The UUID of the user who created the rela-
tion.

creator_user-
name

14 character varying The username of the user who created the
relation.

creation_date 15 timestamp with
time zone

The date on which the relation was created.

editor_user_id 16 character varying The UUID of the user who last edited the rela-
tion.

editor_username 17 character varying The username of the user who last edited the
relation.

edited_date 18 timestamp with
time zone

The date on which the relation was last edited.

Responsibility

column_name ordinal_
position

data_type Description

snapshot_date 1 date The date on which the snapshot was created.
This is synchronized with the snapshot table.

role_id 2 character varying The UUID of the role of the responsible user or
user group.
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column_name ordinal_
position

data_type Description

role_name 3 character varying The name of the resource role of the respons-
ible user or user group.

asset_id 4 character varying The UUID of the asset.

user_id 5 character varying The UUID of the responsible user. This field is
used only if the responsibility is assigned to a
user.

username 6 character varying The username of the responsible user. This
field is used only if the responsibility is
assigned to a user.

user_firstname 7 character varying The first name of the responsible user. This
field is used only if the responsibility is
assigned to a user.

user_lastname 8 character varying The last name of the responsible user. This
field is used only if the responsibility is
assigned to a user.

user_email 9 character varying The username of the responsible user. This
field is used only if the responsibility is
assigned to a user.

user_language 10 character varying The language of the responsible user. This
field is used only if the responsibility is
assigned to a user.

is_user_guest 12 boolean An indicator of whether the responsible user is
a guest user.

is_user_api 13 boolean An indicator of whether the responsible user is
an API user.

is_user_activ-
ated

14 boolean An indicator of whether the responsible user's
account is activated.
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column_name ordinal_
position

data_type Description

is_user_enabled 15 boolean An indicator of whether the responsible user's
account is enabled.

is_responsibility_
system

16 boolean An indicator of whether the responsibility is a
system responsibility.

creator_user_id 17 character varying The UUID of the user who created the respons-
ibility.

creator_user-
name

18 character varying The username of the user who created the
responsibility.

creation_date 19 timestamp with
time zone

The date on which the responsibility was cre-
ated.

editor_user_id 20 character varying The UUID of the user who last edited the
responsibility.

editor_username 21 character varying The username of the user who last edited the
responsibility.

edited_date 22 timestamp with
time zone

The date on which the responsibility was last
edited.

group_id 23 character varying The UUID of the user group to which the
responsibility is assigned.

group_name 24 character varying The name of the user group to which the
responsibility is assigned.
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Remove non-applicable regulation
placeholder from Privacy & Risk Readiness
report
If you have purchased only one of the Collibra Data Privacy modules, CCPA or GDPR, you
can remove the non-applicable placeholder from the report, as there will be no data to
visualize.

Example In this example, the GDPRmodule was not purchased. Therefore, no
GDPR-specific data is available.

Steps

1. Click on the non-applicable regulation, so that the entire section is highlighted.
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2. Click .

3. Click Delete Containers, to confirm the deletion.
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Dashboards
A dashboard is a page that provides a high-level overview on the different areas of the
product. It contains one or several configurable dashboard widgets that can show text, a
shortcut to the search, the organization browser, buttons to start a workflow, and more.

You can create as many dashboards as you want, each with a particular purpose.
Dashboards cannot be assigned to a community or any other resource.

Important
l The topics in this section assume that the Homepage is disabled. For more
information, go to Access a dashboard.

l In Collibra 2022.11 or newer, the Homepage is enabled by default.In Collibra
environments upgraded from 2022.10 or older to 2022.11 or newer, the
Homepage is available but disabled by default.In Collibra environments
upgraded from 2022.11 to a newer version, the previous status of the
Homepage (enabled or disabled) is retained.

Permissions
No particular license is needed to manage and share your own dashboards; however,
certain global permissions are needed.

Permission With this global permission, you can

Manage your own Views, Dash-
boards, Search filters

Create dashboards or copy existing ones.

Share your own Views, Dashboards,
Search filters

Share any of the dashboards that you copied or created.
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Permission With this global permission, you can

Manage and share anyone's Views,
Dashboards, Search filters

l Create dashboards or copy existing ones.
l Edit the properties of any dashboard.
l Share any dashboard.
l Delete any dashboard.

Access a dashboard
The way in which you can access a dashboard depends on if the Homepage is enabled or
disabled.

With the Homepage disabled
If the Homepage is disabled, you can access a dashboard on the page that appears when
you sign in to Collibra or when you click , via:

l The dashboard tab bar, which shows up to five pinned dashboards in alphabetical
order.

l The More menu.
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Note The default dashboard is opened by default.

With the Homepage enabled
If the Homepage is enabled, you can access a dashboard via:

l The Dashboards card on the Homepage.

l The Dashboards tab in the Browse pane.

Create a dashboard
You can create a dashboard, and then add and edit widgets to suit your needs.

Tip You can create as many dashboards as you want without affecting the
performance of Collibra.

Requirements and permissions
You have a global role with the Manage your own Views, Dashboards, Search filters
global permission; for example, Sysadmin.
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Steps
1. On the main menu, click .

2. On the dashboard bar, click → Add Dashboard.

3. Enter the required information.

Field Description

Name The name of the dashboard.

Description A description of the dashboard.

Layout The layout of the dashboard.

Select the number of columns for the dashboard.

Pin Select this checkbox if you want to pin the dashboard.

Tip Up to five pinned dashboards are shown on the dashboard tab bar in
alphabetical order.

4. Click Save.

What's next?
Add widgets to the dashboard.

Copy a dashboard
If, for example, you want to reconfigure one of the widgets of a certain dashboard
according to your needs, you can copy that dashboard, instead of creating one.

Tip You can create as many dashboards as you want without affecting the
performance of Collibra.
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Prerequisites
You have a global role with the Manage your own Views, Dashboards, Search filters
global permission; for example, Sysadmin.

Steps
1. On the main menu, click .

2. On the dashboard bar, click → Save as.

3. Enter the required information.

Field Description

Name The name of the dashboard.

Description The description of the dashboard.

Sharing options Options that determine who can view the dashboard:

o Public: All users.
o Private: Only you.
o Share with specific roles, groups & users:

n Roles: Only the selected roles.
n Groups: Only the selected groups.
n Users: Only the selected users.

Promote Options that determine how and where the dashboard appears:

o Default: As the first page when you sign in to Collibra.
o Pin: As a tab on the dashboard bar when you sign in to Collibra.

4. Click Save.

What's next?
You can now edit the dashboard properties and widgets according to your needs.

Edit the properties of a dashboard
You can edit the properties of a dashboard, including the name, description and layout.
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Prerequisites
l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps
1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit properties.

4. Enter the required information.

Field Description

Name The name of the dashboard.

Description A description of the dashboard.

Layout The layout of the dashboard.

Select the number of columns for the dashboard.

Pin Select this checkbox if you want to pin the dashboard.

Tip Up to five pinned dashboards are shown on the dashboard tab bar in
alphabetical order.

5. Click Save.

Switch to another dashboard
You can switch from one dashboard to another.
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Steps
1. On the main menu, click .

2. In the dashboard toolbar, click the name of dashboard.

Share a dashboard
You can share a dashboard with other users if the widgets provide information that is
useful to them.

Prerequisites
l If you want to share your own dashboard, you have a global role with the Share your
own Views, Dashboards, Search filters global permission, for example Sysadmin.

l If you want to share another user's dashboards, you have Manage shared Views,
Dashboard and Search Filter global permission.

Steps
1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Share.

4. Select with whom you want to share the dashboard.
5. Specify whether or not you want to make the dashboard the default dashboard for

the users with whom you are sharing it.
6. Click Save.

Delete a dashboard
If a dashboard is no longer useful, you can delete it.
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Prerequisites
l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps
1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Delete.

4. Click Yes.

Dashboard widgets
A dashboard widget is an individual pane in a dashboarddashboard. Depending on its
type, it has a different purpose. For example, it can contain quick links to important or
useful information, statistics in a bar chart or a button to quickly start a workflow.

Widgets
Collibra Data Intelligence Cloud comes with the following widgets:

Widget Description

Bar Chart Asset or task metrics depicted in a bar chart.

Search A search field by which users can search for resources.

Text A block of text, or message.
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Widget Description

Counters Asset or task metrics depicted by a graphic element with the total count.

Workflow A collection of workflow buttons by which users can start workflows.

To Do An overview of open tasks and issues.

Browser A hierarchical tree-structure of all communities, subcommunities and
domains.

Most Viewed A list of the ten most viewed assets over the last week, month or year.

Recent A list of your ten most recently viewed assets.

For complete information on adding and editing dashboard widgets, see the
Documentation Center.

The Widgets tab
All widgets have:

l A specific tab for configuring and editing the widget.
l The Widget tab, which is common to all widgets and contains the common con-
figuration options.

Field Explanation

Show title above the
widget

l True: A title is shown above the widget.
In this case, specify a title.

l False: No title is shown above the widget.

Show description
above the widget

l True: A description is shown above the widget.
In this case, the packaged description is shown.

l False: No description is shown above the widget.

Refresh every l True: The counter is refreshed according to the refresh rate you specify.
In this case, specify the refresh rate. Possible values are: 5, 10, 25, 50 or
100 minutes.

l False: The counter is not automatically refreshed.
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Example

Bar chart widget
The Bar Chart widget enables you to display advanced metrics in the form of a bar chart.

Configure a bar chart
You can add many different bar charts to the dashboard and configure them to suit your
needs.

Prerequisites

l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.
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l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps

1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. If required, add a Bar Chart widget to a dashboard.
5. In the widget, click .

6. On the Graph tab, click Create Template.
7. In the Bar Chart Configuration wizard, click the type of data that you want to use.

l Assets: If you want to display metric information about assets.
l Tasks: If you want to display metric information about tasks.

8. In the by field, select how the data is grouped.

Note If you group by Attribute Value, you can only select "Boolean" or
"Selection" characteristic types.

This setting defines how the bars in the bar chart, also known as groups, are con-
structed. Depending on what you select, additional fields are shown.

9. Optionally, add up to 25 sets of filtered data:
a. Click Add Data Set.
b. In the Filter Label field, fill in a label name for the bar chart legend.

This field is mandatory.
Example: Business terms

c. In the row under the Filter Label field, specify a filter.
Example: Asset Type equals Business Term.

d. Click Save.
e. To add more data filters, repeat steps a - d.

10. Click Next.
11. Provide a template name.
12. Select how the items in the bar chart are ordered:

o Alphabetical.
o Numerical, meaning that the groups are sorted by their value (the length of the
bar).

If necessary, select a graph type.
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13. Click Save & Apply.

Search widget
The Search widget on the dashboard is similar to the Search field in the main menu. If you
type something and press Enter, the same search page is shown as if you searched via
the Search field, and the search results are the same. The difference is that the Search
widget does not show the most recently viewed resources or, while you are typing, the top
results, as does the Search field.

If the Search widget is not included on your dashboard, you can add it.

Text widget
The Text widget is a free-text field that allows you to add text to the dashboard. You can
use it, for example, to inform users your latest data governance news, point users to
certain pages with hyperlinks to a specific view and so on.

When you add content to a Text widget, you can:

l Use the rich text editor in the Content tab, to format your text.
l Click , to edit the HTML source code.

Warning
The text editor supports most HTML elements, inline CSS styling and table (< t >)
structures. However, this means an attacker could potentially execute an XSS
attack by injecting malicious HTML. However, you can automatically remove the
following HTML elements to improve security:

l script
l svg
l frame
l frameset
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l iframe
l any event handlers
l any JavaScript

You can enable this in Collibra Console. For more information, see the
Troubleshooting section.

Configure the Text widget
You can configure the Text widget to post a free-text message on the dashboard.

Prerequisites

l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps

1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. If required, add a Text widget to a dashboard.
5. In the widget, click .
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6. Type or cut and paste your text in the field and, optionally, format it using the rich text
editor.

Tip If you want to copy and paste text from other sources into a text field, we
recommend that you click , and then paste the text into the Show source
code field. This will remove any unwanted formatting or tagging of the text. For
detailed information, see the knowledge base article on Collibra Support
Portal.

7. Click Save.

Supported HTML tags
The following table shows the HTML tags you can use to format your text in the Text
widget:

Supported HTML tags

meta option small font dl input

head textarea big a dt select

title h1 pre map em strong

script h2 code style table col

noscript h3 cite span td br

svg h4 samp div th tfoot

iframe h5 sub img tr thead
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Supported HTML tags

frameset h6 sup link colgroup tbody

frame p strike ul col

label i center ol fieldset

form b blockquote li legend

button u hr dd no-hyperlink

Counters widget
The Counters widget shows count statistics on your dashboard and the Metrics pages of
the Collibra applications, for example the number of total assets in your environment or the
number of open tasks or issues.

When configuring a Counter widget, you choose from a fixed list of templates that
determine the count statistics that are computed. The following table describes the
computation for each template:

Template name Description

Applications Number of Technology Assets.

Approved Assets Number of assets with the status "Accepted".

Assets Number of assets.

Assets Created
Past Day

Number of assets created in the past day (24 hours).

Assets Created
Past Month

Number of assets created in the past month (28 days).

Assets Created
Past Week

Number of assets created in the past week (7 days).

Business Terms Number of Business Term assets.
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Template name Description

Code Values Number of Code Value assets.

Columns Number of Column assets.

Communities Number of communities.

Data Assets Number of Data Assets.

Domains Number of domains.

File Groups Number of File Group assets.

Files Number of File assets.

Governance
Assets

Number of Governance Assets.

Issues resolved
past day

Number of Issue assets for which the status became "Resolved" within the past day (24
hours).

Note This counter does not show how many Issue assets were set to
"Resolved" in the past 24 hours. Rather, it shows the total number of Issue
assets that had the "Resolved" status at a specific point in time. By default, the
Issue assets are counted once every 24 hours. The counting interval can be
edited in Collibra Console. Keep in mind that increasing the frequency of the
counts may negatively impact performance.

Issues resolved
past week

Number of Issue assets for which the status became "Resolved" within the past week
(7 days).

Note This counter does not show how many Issue assets were set to
"Resolved" in the past 7 days. Rather, it shows the total number of Issue assets
that had the "Resolved" status at a specific point in time. By default, the Issue
assets are counted once every 7 days. The counting interval can be edited in
Collibra Console. Keep in mind that increasing the frequency of the counts may
negatively impact performance.

KPIs Number of Key Performance Indicators.
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Template name Description

My Open Tasks Total number of unfinished tasks for the user.

Note "Unfinished" is the status of the task, as documented in the workflow.

New Issues Number of Issue assets with the status "New".

Open Issues Number of unresolved Issue assets. Unresolved Issue assets can have the following
statuses:

l New
l Under Review
l Accepted
l Invalid
l In Progress
l Resolution Pending
l Pending

Open Tasks Number of unfinished tasks for all users.

Note "Unfinished" is the status of the task, as documented in the workflow.

Processes Number of Business Process assets.

Reference Data
Domains

Number of Code-list domains.

Reports Number of Report assets.

S3 Buckets Number of S3 Bucket assets.

S3 File Systems Number of S3 File System assets.

Schemas Number of Schema assets.

Tableau
Dashboards

Number of Tableau Dashboard assets.

Tableau Projects Number of Tableau Project assets.

Tableau Servers Number of Tableau Server assets.
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Template name Description

Tableau Sites Number of Tableau Site assets.

Tableau Stories Number Tableau Story assets.

Tableau Views Number of Tableau View assets.

Tableau
Workbooks

Number Tableau Workbook assets.

Tables Number of Table assets.

Task Duration Sum of all task durations.

Users Number of users currently signed in to the environment.

Configure the Counters widget
You can add many different counters to the dashboard and configure them to suit your
needs.

Prerequisites

l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps

1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. If required, add a Counters widget to a dashboard.
5. In the widget, click .
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6. Enter the required information.

Tab Field Description

Counters Existing counter
or Add Counter

Do one of the following:
o Click Add Counter, to add a new counter.
o Expand the section of an existing counter, to edit its current

configuration.

Template Select the template of the count statistic you want to show.

Warning Level
and Danger Level

Optionally, enter the values that represent your warning and
danger thresholds, respectively.

Note The threshold settings are designed for use
with the following issue-related templates:
o New Issues
o Open Issues
o Issues resolved past day
o Issues resolved pas week

URL Optionally, specify a URL to be accessed if a user clicks the
counter. The URL must lead to a page in your Collibra
environment. The webpage will open in the active browser window.

7. Click Save.
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Warning and danger thresholds
The warning and danger thresholds are optional settings that allow you to visually
communicate certain risk or tolerance levels for Issue assets.

The two threshold settings, "Warning level" and "Danger level", can be configured:

l Per counter.
l Alone or in combination with one another.

Note The threshold settings are designed for use with the following issue-related
templates:

l New Issues
l Open Issues
l Issues resolved past day
l Issues resolved pas week

Example
Let's say that your organization has established that 20 open issues (meaning Issue
assets with a status other than "Resolved") exceeds its risk appetite. To give this visibility
within the appropriate community of Collibra users, you add the Counters widget to the
dashboard, and configure a counter to show the number of open issues, of which there are
currently 13.

In accordance with your organization's risk appetite, and to give more meaning to the
number of open issues, you set Warning Level to 10 and Danger Level to 20.

The following example image shows the resulting Counters widget and, specifically, the
Open Issues counter:
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Understanding the color bands

When values are given to one or both of the threshold settings, the band around the
counter will be green, orange or red. The colors have the following meanings:

Circle color Meaning

Entirely gray No value has been set for either the warning or danger thresholds.

Green The issue count is lower than both threshold values, or if only one threshold has been set,
lower than that value.

Orange The issue count is higher than the warning threshold value, but lower than the danger
threshold value (if the danger threshold has been set).

Red The issue count is higher than the warning threshold value (if no danger threshold has been
set) or higher than the danger threshold value, if it has been set.

Workflow widget
The Workflow widget adds one or more buttons to the dashboard, allowing users to start
global workflows from the dashboard.

When you customize this widget, there is a Buttons tab instead of a Content tab. You can
specify which workflows have to be available and how they are displayed.
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You can specify the following parameters for each button:

1. The label to display on the button
2. The global workflow that is started by clicking the button
3. The styling of the button

Configure the Workflow widget
You can add and configure buttons for any enabled workflow.

Prerequisites

l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps

1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. If required, add a Workflow widget to a dashboard.
5. In the widget, click .

6. Enter the required information.
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Tab Field Description

Buttons 1 The button text.

2 The workflow that will be started when a user clicks the button.

3 The color of the button, based on the type of workflow. Possible values and
their associated colors are as follows:

o Default: gray
o Danger: red
o Info: gray
o Success: green
o Warning: yellow

Note This field only determines the color of the button. It has no
bearing on the workflow.

7. Click Save.

To Do widget
The To Do widget provides a quick overview of open tasks and issues. You can:

l Click the Tasks and Issues buttons, to switch between tasks and issues.
l Click in the drop-down list, to sort the tasks by due date, asset and title.
l Click Show All, to go to the My Tasks page, where all tasks are shown.
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Tip If there are several tasks or issues shown in the widget, you can vertically
resize the widget, to see more items without having to scroll as much in the widget.
To resize the widget, click the gray, bi-directional arrow at the bottom of the widget
and drag it to size.

Note Issues with the following statuses are not included in the list of open issues:

l Resolved
l Invalid
l Obsolete
l Disabled

You cannot add to, or remove, these excluded statuses. This means that if you
create your own statuses, you cannot add them to the excluded statuses.
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Configure the To Do widget
You can configure the widget to show either:

l Only tasks that are assigned to you and open issues that you have created.
l All open tasks and issues across your Collibra environment.

Prerequisites

l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps

1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. If required, add a To Do widget to a dashboard.
5. In the widget, click .

6. Enter the required information.
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Tab Field Explanation

Tasks Show tasks o True: Show tasks in the widget.
In this case, specify whether to show all tasks or only tasks
assigned to you.

o False: Tasks are not shown in the widget.

Show
maximum

o True: Limit the number of tasks shown in the widget.
In this case, specify the maximum number of tasks that can be
shown. Possible values are: 5, 10, 15, 20, 25, 50 or 100.

o False: There is no limit to the number of tasks that can be
shown.

Issues Show issues o True: Show issues in the widget.
In this case, specify whether to show all open issues or only
open issues that you created.

o False: Issues are not shown in the widget.

Show
maximum

o True: Limit the number of issues shown in the widget.
In this case, specify the maximum number of issues that can be
shown. Possible values are: 5, 10, 15, 20, 25, 50 or 100.

o False: There is no limit to the number of issues that can be
shown.

7. Click Save.
8. Click Close & save edits.

Browser widget
The Browser widget enables you to browse through the available communities and
domains, via the dashboard.

You can use the search field at the top of the widget, to quickly find communities and
domains.
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This widget has no specific configuration settings. Like all other widgets, common
configuration settings are available via the Widgets tab.

Tip You can also click the company logo at the top left-hand corner, to Access a
community, domain, asset view, or dashboard via the Organization Browser.

Most Viewed widget
The Most Viewed widget shows the ten most viewed assets over a specified time range.

The domain for each asset is shown under the asset name. You can:

l Click an asset name to go to that asset page.
l Click a domain name to go to that domain page.
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Configure the Most Viewed widget
You can configure the widget to show the ten most viewed assets over the last week,
month or year.

Prerequisites

l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps

1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. If required, add a Most Viewed widget to a dashboard.

715



5. In the widget, click .

6. Select the time range over which to show the most viewed assets: last week, last
month or last year.

7. Click Save.
8. Click Close & save edits.

Recent widget
The Recent widget shows your ten most recently viewed assets.

The domain for each asset is shown under the asset name. You can:

l Click an asset name to go to that asset page.
l Click a domain name to go to that domain page.

This widget has no specific configuration settings. Like all other widgets, common
configuration settings are available via the Widgets tab.
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Add a widget to a dashboard
You can add widgets to curate information-rich dashboards.

Prerequisites
l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps
1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. Click a widget and drag it onto the dashboard.
You can browse through the widgets by using the page numbers below them.

5. Edit a widget as required.
6. Click Close & save edits.

Move a widget
You can move a widget if you feel like a widget belongs in a different location on the
dashboard.
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Prerequisites
l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps
1. On the main menu, click .

2. In the view bar, select the dashboard that you want to change. See Switch to another
dashboard.

3. On the dashboard bar, click → Edit widgets.

4. Click and hold the button (move) on the widget that you want to move.

5. Drag the widget to where you want it on the dashboard and release the mouse but-
ton.

6. Click Close & save edits.

Edit a widget
You can edit the dashboard widgets to curate the information shown on the dashboard.

Prerequisites
l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.

l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.
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Steps
1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. Edit the content of the widget, to meet your needs.

Note
l Not every widget has the same tabs.
l The Widget tab is the same for each widget. Your configuration of the
Widget tab defines how the widget is displayed on the dashboard.

Tip You can vertically resize any dashboard widget, by clicking and dragging
the gray, bi-directional arrow at the bottom of the widget.

5. Click Save.

Tip For complete information on working with dashboards and widgets, see the
Collibra Documentation Center.

Delete a widget from a dashboard
If a specific widget is no longer useful on a certain dashboard, you can delete it from that
dashboard.

Prerequisites
l If you want to manage your own dashboard, you have a global role with the Manage
your own Views, Dashboards, Search filters global permission, for example Sysad-
min.
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l If you want to manage another user's dashboard, you have a global role with the Man-
age shared Views, Dashboard and Search Filter global permission, for example
Sysadmin.

Steps
1. On the main menu, click .

2. If required, switch to the relevant dashboard.
3. On the dashboard bar, click → Edit widgets.

4. In the widget, click .

5. Click Delete to confirm.
6. Click Close & save edits.
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Data Helpdesk
With the Data Helpdesk application of Collibra Data Intelligence Cloud, you can:

l Manage data issues1 efficiently.
l Quickly view newly created issues.
l Process issues assigned to a given user.
l Track the progress of the issues.
l View the data quality dimensions (accuracy, completeness, conformity, consistency,
integrity are available out of the box) and the data quality rules.

The following sections describe the issue roles, how to log issues and how to use the
default 'Issue Management' workflow. Note that since administrators can change and
customize the workflow, the actual behavior of your Collibra may be different than
described.

Data Helpdesk submenu pages
Page Description

Issues Contains a table with Issue assets in Collibra.

Data Quality Contains tables with Data Quality and Data Quality Dimension assets.

Metrics Contains a variety of statistics related to how the assets of the Data Helpdesk are
used.

In this chapter

1A problem related to issue management; also referred to as issue.
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Packaged metamodel for the Data Helpdesk
The Data Helpdesk has specific asset types and domain types.

Asset types
The table below contains the packaged asset types that are relevant for the Data
Helpdesk.

Domain types
The table below contains the packaged domain types that are relevant for the Data
Helpdesk.

Workflows
The table below contains the packaged workflows that are relevant for the Data Helpdesk.

Name Description

Assessments This process notifies the Business Steward (by default) that an Assessment Review
asset is ready for review and prompts the Business Steward to approve or reject the
asset.

Cancel Process This process notifies the concerned users of a workflow cancellation.

Escalation Process This process is the default mechanism for the escalation of user tasks in workflows.

Issue Creation This process facilitates issue creation.

Issue Management This process is used to route and resolve issues.

Issue Move The Issue Move workflow is a process that changes the responsible community of
an issue.

Propose New
Governance Asset

This process facilitates the creation of new Governance Assets in the Data
Governance Council community.
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Name Description

Simple Approval The Simple Approval workflow is a single-step process that allows you to approve
an asset in Collibra Data Intelligence Cloud.

Voting Sub-Process The Voting Sub-Process is a workflow that can be called by other workflows when
users need to vote. It is used within other packaged workflows such as the Approval
Process, the Simple Approval or the Issue Management workflow.

You can use this sub-process in new custom workflows. The result is a true or false
boolean that is provided to the parent workflow.
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Issue roles
There are several roles involved in the issue management workflow. Some of the roles are
assigned automatically by the workflow and others have to be configured or assigned
while tasks of the workflow are being executed. Predefined variables can determine which
users to select for a given situation. To learn more about configuring variables for
workflows, see the Workflow Documentation in the Collibra Developer Portal.

The following table contains the different roles in an issue.

Role Description

Requester The requester is the user who has logged an issue, which means that there
can only be one requester per issue. The requester is kept up to date on the
issue resolution progress and can be asked to provide more information.

Reviewer The reviewer analyzes the created issue and proposes a solution for it but does not
implement the solution. The reviewer is responsible to ensure that all the information is
available for solving the issue. This user can also mark an issue as invalid.

Which user is assigned as reviewer, depends on the issue management workflow
configuration. The reviewerUserExpression variable of the workflow determines which
users are able to assign themselves as reviewer for the issue. By default this is the
steward. After the workflow has started, the issue manager or the current reviewer can
assign a different user as reviewer.

Stakeholder The stakeholders of an issue are responsible for accepting or rejecting the
analysis and solution that was proposed by the reviewer. The stakeholders of
an issue can be configured through a variable called the stake-
holderUserExpression in the workflow. By default, this is the steward. It is not
possible to change the stakeholders after the workflow has started.

Assignee The assignee is responsible for the actual implementation of the solution. It is the
requester's responsibility to appoint assignees. The assignee receives a task for the
implementation of the solution.

Assignees are suggested by the workflow. The suggested assignees can be
configured through the assigneeUserExpression variable of the workflow. Assignees
can also assign another assignee after the workflow has started.
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Create a data issue
By creating a new data issue, you start a workflow to resolve data issues. The workflow
behavior varies per company.

Steps
To create a data issue, follow these steps:

1. On the main toolbar, click .

» The Create dialog box appears.
2. In the Create dialog box, click the Actions tab.
3. Click Issue Creation.

If you don't see Issue Creation, you have to add the Issue Creation workflow to the
global create, see I don't see a workflow in the global create.
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4. Complete the Log Issue dialog box.

o Title (mandatory): The name and a short descriptive title for the issue.
o Description (mandatory): A full description to explain the details of the issue.
o Priority: The priority of the issue. Possible values are (in order of importance
from high to low):

n Blocking
n Critical
n Urgent
n Normal
n Minor

o Responsible Community: The community that is, according to you, respons-
ible for solving the issue. By default, this is the Data Governance Council com-
munity, which is responsible for taking in all new types of assets and assigning
them to the right community.

o Relevant Assets: A list of assets that are impacted by the issue. When you
start typing in this field, suggestions appear. Click a suggestion to add the
asset to the issue. You can add multiple relevant assets.

Click next to a related asset to remove it from the list.

5. Click Create Issue.

Example:
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What's next?
The data issue is created and the proper workflow is automatically started. On the
Diagram page of the created Data Issue asset page, you can find the assets that are
related to the issue.

Create issue: options
Option Description

Title Mandatory.

The name and a short descriptive title for the issue.

Description Mandatory.

A full description to explain the details of the issue.

Priority The priority of the issue. Possible values are (in order of importance from high to low):

l Blocking
l Critical
l Urgent
l Normal
l Minor
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Option Description

Responsible
Community

The community that is, according to the reporter, responsible for solving the
issue. By default, this is the Data Governance Council community, which is
responsible for taking in all new types of assets and assigning them to the
right community.

Relevant Asset A list of assets that are impacted by the issue or that are subject of the issue.
When you start typing in this field, suggestions appear. Click a suggestion to
add the asset to the issue. You can add multiple relevant assets.

Click next to a related asset to remove it from the list.

Issue Clas-
sification

The classification of the issue, indicating what the issue type is.

Tasks in the Issue Management workflow
In this section you can find more information about the various tasks in the Issue
Management workflow. For more information about workflows, go to the Managing
workflows section.

Note It is possible that your Collibra Data Intelligence Cloud administrator has
renamed the Issue Management workflow.

Accepting or rejecting a data issue
When the issue management workflow is started, tasks are assigned to the users that are
defined in the workflow. These are by default the issue stewards. This workflow task has to
be completed before a predefined deadline, if not, the issue is escalated to the issue
manager who will set a reviewer manually.

The stewards can accept or reject an issue. When one steward accepts the issue, its
status becomes Under Review.
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Only when all stewards reject an issue, the issue is marked as invalid and the requester is
notified.

You can check if you have issues to accept or reject if you click the Tasks button in the
main menu. Issues that have passed the due date, appear in red.

Click on the task row to select it. You can accept or reject the task from the sidebar.

When you click the name of the task or the related resource, the issue page opens.

You can accept or reject the issue from the sidebar.

When you accept the issue, the workflow automatically advances to the next step.

Tip You can also access the issues via Data Helpdesk → Issues and apply a filter
to find the issues that require an action from you.

Analyzing and proposing a solution
When the status of a task is Under Review, you can perform the following actions:
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l Reassign Reviewer: Choose this action if you find that an other user is more suited
to analyze the issue. The status of the task becomes Reassign Reviewer. Click Sub-
mit to assign a new user, role or group as the new reviewer for the issue.

l More Information: Choose this action if you need more information from the issue
requester. The status of the issue becomes Pending. This action creates a task for
the requester to provide more information about the issue.
When the requester has completed this task, the workflow returns to you with a task
with the same four options.

l Invalid Issue: Choose this action to mark the issue as invalid. The requester is noti-
fied and the issue management workflow is finished. Note that this is an irreversible
action.

l Request Approval: Choose this action to request an approval for your analysis and
solution proposal. You can only click this action when you have provided a detailed
analysis of the issue in the issue's Analysis attribute. In the Resolution attribute, you
can propose a solution to the issue. When you request an approval, the contents of
the Analysis and Resolution attributes can be evaluated and approved. The issue is
marked as Submitted for approval.

Approve or reject a solution
In the approve/reject step, each stakeholder assigned to the issue is requested to accept
or reject the analysis and solution proposed by the reviewer. All the stakeholders have to

730



accept, otherwise the solution is not approved. If one stakeholder rejects the solution, the
workflow creates a new task for the reviewer to update the analysis and solution, taking
into account the comments given by the stakeholder who rejected the proposed solution. If
approved, the issue is marked as Accepted.

1. In the sidebar, provide a reason for your action.
2. Click the Approve or Reject button.

1. In the task bar, click the Approve/Reject button.

» The Approval dialog box appears.

2. In the dialog box, provide a reason for your action.

3. Click the Approve or Reject button.
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When all the stakeholders have approved the solution, the status of the issue becomes
Approved.

If the last stakeholder is a reviewer, the user can immediately appoint an assignee to solve
the issue or close the issue if no further action is required.

Appoint assignee or resolve the issue
When all the stakeholders have accepted the proposed solution, it does not necessarily
mean that the issue is resolved. It is possible that the solution still has to be implemented.

When the solution is approved, the reviewer can decide to appoint an assignee who can
implement the actual solution to resolve the issue, or mark the issue as resolved if there is
no need for a specific implementation.

After appointing an assignee, the issue is marked as 'In Progress'.

You can appoint an assignee in the following ways:

l Fill in a list of users in the User field.
l Add groups in the Group field.
l Specify a role, in the Role field, that the selected user has to have on the current
issue. If you also fill in the in community field, all the users with the specified role for
the given community become the assignee of the issue.

Depending on the issue management workflow configuration, a user can already be
proposed to you in the User field.
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Provide a solution
In the step to provide a solution, the assignee resolves an issue and provides an
implementation.

l The assignee can reassign the task to someone else if that user is more suited to per-
form the task. When reassigning the task, a similar form is presented as described in
the earlier step where the new assignee can be appointed, see Appoint assignee or
resolve the issue.

l The assignee can also mark the issue as Solved. This ends the task and the work-
flow afterwards asks the reviewer to check if the solution matches the expectations.
In this case, the issue is marked as Resolution Pending.

This task has to be completed within a predefined period, if not, the workflow returns to the
previous step and presents a new task to the reviewer to appoint a new assignee to
perform the task.

Instead of resolving the issue by implementing the proposed solution, it is possible that the
issue can be resolved by linking it to a governance asset. For example, by forcing all
assets to comply to a business rule so that the problem described in the issue can not
happen again.

To resolve an issue with a related asset, you need the correct rights in the community as
assignee.

You can link the issue with a governance asset as follows:

1. On the issue page, click Characteristic.
2. Click the Relations tab.
3. Choose the Resolved by relation.
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4. Enter the resolving governance assets in the dialog box, optionally set a Start Date
and End Date.

5. Click Save.
6. The relation appears in the resolved by Governance Asset table on the issue page.
7. Click Solved in the green bar to mark the issue as resolved.

Review a solution
In the last step of the 'Issue Management' workflow, the reviewer can review the provided
solution:

l Click Accept to accept the solution and mark the issue as Resolved and the
requester is notified. This action ends the issue management workflow.
If there are multiple reviewers, there is only one reviewer who has to accept the solu-
tion.

l Click Reject to reject the solution and mark the issue as Under review. The workflow
returns to the Analyze and Propose Solution step, see Analyzing and proposing a
solution.

l Click View relevant changes to view the history of the issue.

l Click Other → Reassign to assign the review step to an other user.
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Metrics pages
The Metrics pages contain a variety of statistics related to how an application is used.
They pages consist of one or more graphs, their legends and some counters.

For each graph, you can edit the data set and the time range shown.

Note On the Metrics page, the lines that are shown on a given graph are called
data sets. Do not confuse these with data sets in the true context of CollibraData
Catalog. On this page, when you click Add data set, it simply means that you want
to add another line to the graph.

Components
The Metrics page consists of one or more graphs, their legend and some counters.

Number Element Description

1 Color-coded bars The color-coded bars give a quick overview of the graph.

The vertical line leading from the color-coded bar indicates the difference
between the minimum and maximum values.
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Number Element Description

2 Data set details More details about the graph.

Hover your pointer over the color-coded bars to the left of each line of
graph to view them.

Number of
elements

The amount of days in the time range.

Minimum The lowest count on any day in the data set.

Q1 The first quartile, meaning the lowest 25% of the data set.

Median The median, meaning the middle value of the data set.

Q3 The third quartile, meaning the lowest 75% of the data set.

Maximum The highest count on any day in the time range.

3 Graph The actual graph. What it shows exactly, depends on the data set. For
example, it can show the number of assets viewed over the last month, or
the number of licenses used.

Tip You can edit the time range of the graph.

4 Counts by day The counts for a specific day for each data set, by moving your mouse
over the graph. The vertical red line identifies the day. The exact count for
that day for each data set, is shown above the graph.

5 Legend The legend of the graph, which also allows you to add, edit and delete the
data sets.
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Add a data set to a metrics graph
You can add a data set to a graph on the Metrics pages, for example if you want to
compare the amount of new assets of different types.

Steps

1. Open the product for which you want to see the metrics, for example Business Gloss-
ary.

2. In the submenu, click Metrics.
» The Metrics page appears.

3. Under the relevant graph, to the right, click Add data set.
» The filter settings appear.

4. Enter the required information:

Filter setting Description

Filter Type The type of data that will be counted.

Depending on the filter type that you select, different fields become available.

Active Users A daily count of the active users to have viewed the relevant assets.

You can restrict the count results via the following additional filters:

o License: Limit the results to active users with a specific license type.
o Community: Limit the results to a specific community.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Product: Limit the results to active users within a specific Collibra
Data Intelligence Cloud application.

o Role: Limit the results to active users that have been assigned a spe-
cific role.
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Filter setting Description

Asset Count A daily count of the relevant assets (either data or technology assets) that have
been viewed.

You can restrict the count results via the following additional filters:

o Type: Limit the results to a specific type.
o Domain: Limit the results to assets from a specific domain.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Status: Limit the results to assets with a specific status.
o Community: Limit the results to a specific community.

Changed
Task Count

A daily count of workflow tasks that have been changed.

You can restrict the count results via the following additional filters:

o Workflow: Limit the results to a task in a specific workflow.
o Task Type: Limit the results to tasks of a specific type.
o Task: Limit the results to a specific task.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.
o Task Status: Limit the results to tasks that have a specific status 
(Completed, Deleted or Unfinished).

o User: Limit the results to a specific user.

Domain
Count

A daily count of the domains with relevant assets (either data or technology
assets) that have been viewed.

You can restrict the count results via the following additional filters:

o Type: Limit the results to a specific type.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.
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Filter setting Description

License
Available

A daily count of Collibra licenses that have been available to users.

This is calculated by subtracting the licenses in use from the total licenses your
organization has.

You can restrict the count results via the following additional filters:

o License: Limit the results to a specific type.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

License
Usage

A daily count of Collibra licenses in use by all users in your organization.

You can restrict the count results via the following additional filters:

o License: Limit the results to active users with a specific license type.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

Page Hits A daily count of Collibra asset page hits.

You can restrict the count results via the following additional filters:

o Community: Limit the results to a specific community.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Domain: Limit the results to assets from a specific domain.

Task Count A daily count of workflow tasks carried out.

o Workflow: Limit the results to a task in a specific workflow.
o Task Type: Limit the results to tasks of a specific type.
o Task: Limit the results to a specific task.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.
o Task Status: Limit the results to tasks that have a specific status 
(Completed, Deleted or Unfinished).

o User: Limit the results to a specific user.
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Filter setting Description

Task
Duration

A daily count of workflow task duration.

You can restrict the count results via the following additional filters:

o Workflow: Limit the results to a task in a specific workflow.
o Task Type: Limit the results to tasks of a specific type.
o User: Limit the results to a specific user.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.
o Task: Limit the results to a specific task.

5. Click Save data set.

Edit a data set of a metrics graph
You can edit the data set that is shown in a graph on the Metrics pages.

Steps

1. Open the product for which you want to create an asset (for example, Business
Glossary).

2. In the submenu, click Metrics.
» The Metrics page appears.

3. In the legend under the relevant graph, click the data set you want to edit.

» The filter configuration for the data set appears.
4. Enter the required information.

Filter setting Description

Filter Type The type of data that will be counted.

Depending on the filter type that you select, different fields become available.
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Filter setting Description

Active Users A daily count of the active users to have viewed the relevant assets.

You can restrict the count results via the following additional filters:

o License: Limit the results to active users with a specific license type.
o Community: Limit the results to a specific community.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Product: Limit the results to active users within a specific Collibra
Data Intelligence Cloud application.

o Role: Limit the results to active users that have been assigned a spe-
cific role.

Asset Count A daily count of the relevant assets (either data or technology assets) that have
been viewed.

You can restrict the count results via the following additional filters:

o Type: Limit the results to a specific type.
o Domain: Limit the results to assets from a specific domain.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Status: Limit the results to assets with a specific status.
o Community: Limit the results to a specific community.

Changed
Task Count

A daily count of workflow tasks that have been changed.

You can restrict the count results via the following additional filters:

o Workflow: Limit the results to a task in a specific workflow.
o Task Type: Limit the results to tasks of a specific type.
o Task: Limit the results to a specific task.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.
o Task Status: Limit the results to tasks that have a specific status 
(Completed, Deleted or Unfinished).

o User: Limit the results to a specific user.
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Filter setting Description

Domain
Count

A daily count of the domains with relevant assets (either data or technology
assets) that have been viewed.

You can restrict the count results via the following additional filters:

o Type: Limit the results to a specific type.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.

License
Available

A daily count of Collibra licenses that have been available to users.

This is calculated by subtracting the licenses in use from the total licenses your
organization has.

You can restrict the count results via the following additional filters:

o License: Limit the results to a specific type.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

License
Usage

A daily count of Collibra licenses in use by all users in your organization.

You can restrict the count results via the following additional filters:

o License: Limit the results to active users with a specific license type.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

Page Hits A daily count of Collibra asset page hits.

You can restrict the count results via the following additional filters:

o Community: Limit the results to a specific community.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Domain: Limit the results to assets from a specific domain.
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Filter setting Description

Task Count A daily count of workflow tasks carried out.

o Workflow: Limit the results to a task in a specific workflow.
o Task Type: Limit the results to tasks of a specific type.
o Task: Limit the results to a specific task.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.
o Task Status: Limit the results to tasks that have a specific status 
(Completed, Deleted or Unfinished).

o User: Limit the results to a specific user.

Task
Duration

A daily count of workflow task duration.

You can restrict the count results via the following additional filters:

o Workflow: Limit the results to a task in a specific workflow.
o Task Type: Limit the results to tasks of a specific type.
o User: Limit the results to a specific user.
o Count Operation: Select the operation by which the results are shown
in the template. For example, the sum of all values, the highest value
or the lowest value each day over the last month.

o Community: Limit the results to a specific community.
o Task: Limit the results to a specific task.

5. Click Save data set.
» The updated data set is shown in the graph.

Edit the time range of a metrics graph
By default, the graphs on the Metrics pages are shown in daily increments, over a time
range of one month. However, you can edit the time range to suit your needs.

There are two ways to edit the time range:

l Click and drag in the graph.
l Select the dates for the graph.
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Click and drag in the graph

1. Open the product for which you want to create an asset (for example, Business
Glossary).

2. In the submenu, click Metrics.
» The Metrics page appears.

3. Optionally, Add a data set to a metrics graph a data set to a graph.
4. In the relevant graph, click at (or near) the first date in your desired range, and drag

to the right, toward the last date in your desired range.
» While you are dragging, the color changes in the graph, indicating the resulting
time range.

5. Release the mouse button.
» The graph is adjusted to the new time range.

Select the dates for the graph

1. Open the product for which you want to create an asset (for example, Business
Glossary).

2. In the submenu, click Metrics.
» The Metrics page appears.

3. Optionally, Add a data set to a metrics graph a data set to a graph.
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4. On the left-hand side of the graph, click the date.
» A date picker appears.

5. Click the first day of your desired time range, and then click Apply.
» The graph is adjusted to the date you selected.

6. On the right-hand side of the graph, click on the date.
» A date picker appears.

7. Click the last day of your desired time range, and then click Apply.
» The graph is adjusted to the date you selected.

Remove a data set from a metrics graph
You can remove a data set that is shown in a graph on the Metrics pages if you don't want
to see, for example, if you think there is too much information in a graph.

Note Each graph will always show at least one data set. If it only contains one data
set and you want to remove it, you first have to Add a data set to a metrics graph
another data set. You can then remove the other one.

Steps

1. Open the product for which you want to create an asset (for example, Business
Glossary).

2. In the submenu, click Metrics.
» The Metrics page appears.

3. In the legend under the relevant graph, click on next to the data set you want to

delete.
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» The graph is updated.
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Data Stewardship
The Collibra Data Stewardship application helps data stewards manage their daily tasks. It
also helps the administrators manage their stewards.
Stewards can monitor and maintain their own space in the company's data governance
ecosystem. This gives them a clear picture of their responsibilities inside the data
governance structure.

Data Stewardship submenu pages
Page Description

Organization Contains a view with the hierarchical overview of communities and
domains.

Business Dimensions Contains views for Business Process assets, Data Category assets and Line of
Business assets.

Tags Provides an overview of all tags in Collibra Data Intelligence Cloud.

Physical Data Connector Contains a table with high-level database information.
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Page Description

Metrics Contains a variety of statistics related to how the assets of the Stewardship
application are used.

Data Classification Shows the available data classes in your Collibra environment.
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Using workflows
Workflows in Collibra Data Intelligence Cloud allow you to define process steps, in BPMN
standards, to get work done from initiation until completion, while at the same time defining
ownership of every individual step. They allow users to complete tasks in a strictly guided
and controlled way.

You can see a detailed explanation of the out-of-the-box workflows that are included with
Collibra Data Intelligence Cloud in the Workflows documentation.

Start a global workflow 750

Start an asset workflow from an asset page 750

Start an asset workflow from an asset table or set of tiles 750

My Tasks page 751

Viewing workflow tasks 753

Working with tasks 754
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Start a global workflow
If you want to start a workflow that is not linked to an asset, follow these steps:

1. Go to a dashboard.
o If the dashboard does not have the workflow widget and you have the right per-
missions, you can add it yourself, see Add a widget to a dashboard.

o If you are not logged in and the guest user access is enabled for the workflow,
you have to provide some identification and click Continue.

2. In the workflow widget, click on the button of the workflow that you want to start.
3. Fill in the required information in the dialog box and click the button at the bottom to

confirm.

Note The button's label depends on the workflow, for example, "Propose" for
the Propose Business Term workflow or "Create" for the New Data Set
workflow.

Start an asset workflow from an asset page
If you are on an asset page and you want to start a workflow for that asset, follow these
steps:

1. In the title bar, click the workflow that you want to start.

2. If necessary, fill in the form.
3. Click Submit at the bottom, to confirm.

If you do not see the Submit button, you have to scroll to the bottom in the dialog
box.

Start an asset workflow from an asset table
or set of tiles
You can start a workflow for one or more specific assets.
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Steps

1. Navigate to a table or set of tiles.
2. If you are:

l in table display mode, select the check boxes in front of the assets for which
you want to start a workflow.

l in tile display mode, select the tiles for which you want to start a workflow. More
information: Select multiple tiles.

3. In the menu above the selected assets, click the name of the workflow you want to
start.
Only workflows that can be started for all selected assets at once are available.
If necessary, fill in the form that is displayed.

4. Click Submit.

Tip On the search page, you can also start an asset workflow by clicking for the
relevant asset.

My Tasks page
The following image shows the different parts of the Tasks page:
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Element Name Description

Tasks submenu Contains the following pages:

l All Tasks: Shows all the tasks for which you have permission to
view.

l My Tasks: Shows all the tasks that have been assigned to you.
l My Overdue Tasks: Shows the tasks that have been assigned
to you that are past their due date.

Select button Allows you to select one or multiple tasks for bulk operations.

Tasks table Shows a list of tasks.

Table menu Contains refresh and display options for tasks table.

Sidebar Contains all the elements that allow you to complete the task.

752



Viewing workflow tasks
Workflows create tasks that ask users to provide input or to perform certain actions. You
can view the tasks that are currently assigned to you in different locations, in different
contexts.

If a task is part of a workflow that has been started for a specific resource, you can consult
the task on the resource page.

It is displayed in the sidebar:

You can also view all the tasks that have been assigned to you per resource. On the main
menu bar, click the Tasks button.

A page with a list of your tasks is displayed by default. You can order the tasks
alphabetically by clicking the column headers.

With the correct permission, you can do the following:

l Consult all other open tasks, on the All Tasks page. This view shows all your tasks
and tasks for other users, for which you have permission to view.

l Cancel or reassign the tasks on the All Tasks page. When you cancel a task, you
have to provide a reason in the dialog box that is displayed. After you have
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confirmed, the reason is shown as a comment on the corresponding asset page. You
must not, in any way, complete tasks of other users.

An Error column displays an error message if the workflow task encountered an
unexpected error.

Working with tasks
Each task asks you to perform some kind of action. This can be something external to the
application, provide input or change something in the application directly. When a task
requires input, you are presented with a form to fill in the required information. You can
complete tasks on the asset page or on the tasks pages.

If you have more than one consecutive task assigned to you, each subsequent task is
displayed immediately after the previous one is completed. This is especially useful in
situations where a workflow is designed with multiple forms, one after the other, or a when
you have more than one role for a resource.

An example of this behavior is shown in the asset page screenshots in this section, where
the user is assigned to Subject Matter Expert, Stakeholder, and Steward.

For an example of a complete workflow, see Tasks in the Issue Management workflow.

Completing a task on the asset page
On asset pages, all task-related data is shown in the sidebar. You can complete all tasks
actions from the sidebar.
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If the sidebar is not open, a task button indicates the number of active tasks.

Completing a task from My Tasks page
On the My Tasks page, all your tasks are listed in a table.

To complete tasks from here you can use one of the following options:

l In the preview panel on the right of a selected task, you get information about the
task and the step in the workflow diagram. Click on one of the buttons to complete
the task.
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l When you select a check box in front of a task, the actions that are possible for that
task are displayed above the table. Click on one of the buttons to complete the task.

l When you select the check boxes of multiple tasks, the actions that are possible for
that task are also displayed above the table. Click on one of the buttons to complete
multiple tasks at once.

l If there is a form to fill in, it contains the names of all the assets for which you are com-
pleting a task.
Even when you select different types of tasks, all the different options to complete a
task are displayed. However, only the tasks for which the action is possible are com-
pleted and you cannot complete all of the tasks at once.
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Cancel a task
With the correct permissions, you can cancel a task.

1. On the main menu, click Tasks.
2. Click in the row of task that you want to cancel. Do not click the task name or

resource name as that will open respectively the task details or asset page.
» The row is highlighted and the preview pane on the right is updated.

3. At the bottom of the preview pane, click Cancel.
4. Fill in an optional reason to cancel the task and click Cancel Task.

Note Canceling a task means that the entire workflow is canceled and an event is
created. It is possible that other workflows are listening for this event and are started
automatically when this event occurs.

Reassign a task
With the correct permissions, you can reassign a task. To do so, follow these steps:

1. On the main menu, click Tasks.
2. Click in the row of task that you want to cancel. Do not click the task name or

resource name as that will open respectively the task details or asset page.
» The row is highlighted and the preview pane on the right is updated.

3. At the bottom of the preview pane, click Reassign.
4. Fill in the Reassign task dialog box.

» The workflow continues with the new set of users as candidates for the task. Keep
in mind that if the task expects, for example, an attribute to be changed by one of the
newly assigned users, that user needs the permission to do so.

5. Click Reassign.

View a workflow diagram
Each task is part of a workflow. With the correct permissions, you can open the full
workflow diagram. This allows you to see in which stage of the workflow the task is
located.
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1. On the main menu, click Tasks.
2. Click the row of task that you want to cancel. Do not click the task name or resource

name as that will open respectively the task details or asset page.
» The row is highlighted and the sidebar displays the task.

3. In the sidebar, click the ellipses → View in workflow diagram.

» A rendering of the current position of the task in the workflow is displayed.
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Collibra settings
The settings of Collibra Data Intelligence Cloud allow you to customize the operating
model of your environment to your needs.

By default, the settings open on a landing page that allows you to navigate to each of the
sections. Contact Collibra support if you want to enable or disable this Settings landing
page.
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General settings page
On the General settings page of the Collibra settings, you can view and edit general
settings. For example, you can see technical information and all activities. You can also
add additional interface languages and manage banners.

Tab pages
The General settings page of the Collibra settings is split in several tab pages:

Tab page Description

System This tab page contains information about the installation of your Collibra environment.
You can also do the following:

l Rebuild the search index.
l Rebuild automatic hyperlinks.
l Upgrade the activity history.

Activities This tab page contains a table with all activities started by all users. It also
shows more information about each activity, for example the creation date,
name, status, start, finish and result.

Language This tab page allows you to edit or translate the interface text of Collibra.

Banners This tab page allows you to create, edit or delete banners.

Rebuild hyperlinks
Collibra Data Intelligence Cloud can automatically create hyperlinks between assets.
However, if those hyperlinks are outdated, you can rebuild them.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.

760

ta_rebuild-search-index.htm


2. Click General.
» The general settings appear on the Activities tab page.

3. In the Automatic Hyperlinks section, click Rebuild automatic hyperlinks.

Upgrade the activity history after an upgrade to
2020.11/5.7.7
After an upgrade to 2020.11/5.7.7, the activity history of assets is not automatically visible
in Collibra Data Intelligence Cloud. To view the activity history, you have to upgrade the
history.

Note
l The backup you restore needs to contain history data. This is one of the
options when creating a backup.

l This is a one-time only action, subsequent upgrades don't require this extra
step.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click General.

» The general settings appear on the Activities tab page.
3. At the bottom of the page, click Upgrade History.

What's next?
The history in the backup is converted to the new environment. The conversion time
depends on the size of the history in the backup.

You can see the status of the history upgrade by viewing your activities.
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Interface text languages
The interface text of Collibra Data Intelligence Cloud is available in several languages. The
default language is English, but you can download French, German and Spanish
translations from the Downloads section of the Collibra Product Resource Center.

You can choose the interface language in your profile page. As an administrator, you can
also edit and translate the interface text.

Note From version 2022.11 onwards, Collibra takes the default language of your
browser into account to select the interface text language of some sections. Collibra
now also has translations of some interface text available out of the box.
Consequently, you can no longer edit that interface text, nor translate it into
unsupported languages. This includes the interface text of Usage Analytics, Data
Marketplace and the Homepage.

Supported languages
Collibra supports the following languages:

l English
l French
l German
l Spanish

Important Collibra does not support other languages for the interface text and your
instance data. For example, there are known issues with sorting and filtering non-
Latin characters, and the Search feature might not return the right search results.

Limitations
Most of the text in the interface of Collibra is translatable, including buttons, messages,
tooltips, dialog boxes. However, there are some important limitations:

l The operating model is not translatable:
o Asset types
o Domain types

762

https://productresources.collibra.com/downloads/2023-02
to_dm.htm
to_dm.htm


o Statuses
o Characteristic types
o Roles
o Scopes

l Instance data is not translatable:
o Asset names
o Characteristics
o Tags and comments
o Names of views and filters
o Text in dashboards and widgets

l From version 2022.11 onwards, Collibra already has translations of some interface
text strings available out of the box. Consequently, you can no longer edit those inter-
face text strings, nor translate them into unsupported languages.

Structure of the interface text
The interface text is divided in translation messages, which consist of the following
elements:

Element Description

Message key The message key is a unique identifier that Collibra uses to retrieve the correct
interface text.

Example Activities.ActivitiesTable.status.error = Error

Equal sign An equal sign between spaces ( = ).

Example TextEditor.edit = Edit

A piece of interface
text

The interface text is the actual piece of text in the user interface.

Example COMMENT_ADDED = Comment Added
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Element Description

Variables
(optional)

Interface text may contains variables, which are placeholders for a piece of
information. They are filled in when the text appears on the screen. They are
represented by a number between curly brackets ({0}).

Example PASSWORD_TOO_SHORT = The password must be at least {0}
characters long.

Markup
(optional)

Interface text may contain HTML tags to format text or to create hyperlinks in a piece of
interface text.

Example core.header.expired = Your password has expired!<br>Please
change your password <a href="{0}" >here</a>.

Edit or translate interface text
You can edit or translate the interface text of the Collibra Data Intelligence Cloud to meet
your company's needs.

You can work directly in the editor of Collibra, or you can copy the translation messages to
a text file. You can then send the file to qualified translators, who probably don't have the
required permissions to work in Collibra.

Tip You can download files containing the translation of the Collibra interface into
French, German and Spanish from the Downloads page of the Collibra website.

Note
l Message keys are not always backwards compatible with other Collibra ver-
sions. When you upgrade to a newer version, there might be new keys,
renamed keys or keys that have been deleted.

l From version 2022.11 onwards, Collibra takes the default language of your
browser into account to select the interface text language of some sections.
Collibra now also has translations of some interface text available out of the
box. Consequently, you can no longer edit that interface text, nor translate it
into unsupported languages. This includes the interface text of Usage Ana-
lytics, Data Marketplace and the Homepage.
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Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click General.

» The general settings appear on the Activities tab page.
3. In the tab pane, click General → Language.
4. At the top of the editor, choose the interface language.

Note Languages that contain previously edited text are shown at the top of
the drop-down menu.

» If you chose a previously edited language ( ), the editor contains the list of trans-

lation messages.

» If you chose a new language ( ), click Load Defaults to fill the editor with the

default English UI text.

Warning Clicking Load Defaults multiple times inserts multiple copies of the inter-
face text, so only click it once.
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5. Edit or translate the interface text, or paste the content from your translation file.
6. Click Save.

Reset interface text

To restore defaults from the language settings page you will need to override your
changes with the default interface text.

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click General.

» The general settings appear on the Activities tab page.
3. In the tab pane, click General → Language.
4. Click Load Defaults.
5. Click Save.

What's next?

You can choose the interface language in your account settings.

Banners
Banners are messages that are visible for all users, on all pages of Collibra Data
Intelligence Cloud.

If you have a global role with the System Administration global permission, you can create,
edit and delete banners in the Banners page of the General section of the Collibra
settings.

Top Banner
The top banner appears at the top of the page. It can contain up to 500 characters of rich
text, including line breaks, but no images. You can dismiss it, after which it no longer
appears until the message is updated. This is typically a good place to make company-
wide announcements.
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Bottom Banner
The bottom banner appears at the bottom of the page. It can contain up to 250 characters
of rich text, but no line breaks or images. You cannot dismiss the bottom banner and it is
always visible, even in printed output. We recommend that you only use the bottom banner
to display important information, such as disclaimers and legal information.

Example

Create a banner
You can create a banner to post messages to all Collibra users.

Tip You can dismiss the top banner, so use it to post temporary announcements.
You cannot dismiss the bottom banner, so use it to post important information, such
as disclaimers and legal information.

Prerequisites

You have a global role that has the System administration global permission.
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Steps

1. Open the Banners page of the General section of the Collibra settings:
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. In the General section, click Banners.

» The Banners page opens.
2. In the Top Banner or Bottom Banner section, double-click or click .

3. Enter the content of the banner.
4. Click Publish.

» The Publish Banner dialog box appears.
5. Click Publish.

» The banner is now visible on all pages for all users.

Edit a banner
You can edit a banner to update the message to all Collibra users.

Prerequisites

You have a global role that has the System administration global permission.

Steps

1. Open the Banners page of the General section of the Collibra settings:
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. In the General section, click Banners.

» The Banners page opens.
2. In the Top Banner or Bottom Banner section, double-click or click .

3. Edit the content of the banner.
4. Click Publish.

» The Publish Banner dialog box appears.
5. Click Publish.

» The updated banner appears on all pages for all users.
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Delete a banner
You can delete a banner if it's no longer needed.

Prerequisites

You have a global role that has the System administration global permission.

Steps

1. Open the Banners page of the General section of the Collibra settings:
a. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
b. In the General section, click Banners.

» The Banners page opens.
2. In the Top Banner or Bottom Banner section, double-click or click .

» The Remove Banner dialog box appears.
3. Click Remove.

» The banner is no longer visible on any page.

Operating model settings page
On the Operating model settings page of the Collibra settings, you can view and edit the
operating model, which defines the structure of the instance data, for example asset types,
domain types, characteristic types and statuses.

Tab pages
The Operating model settings page of the Collibra settings is split in several tab pages:

Tab page What you can do

Asset types View and edit asset types and their assignments.

Domain types View and edit domain types
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Tab page What you can do

Characteristics View and edit characteristic types.

Attributes View and edit attribute types.

Relations View and edit relation types.

Complex
relations

View and edit complex relation types.

Statuses View and edit statuses.

Data quality rules View and edit data quality rules.

Scopes View and edit scopes.

Roles and permissions settings page
On the Roles and permissions settings page of the Collibra settings, you can view and
edit the permissions and roles to define which actions users can do.

Tab pages
The Roles and permissions settings page of the Collibra settings is split in several tab
pages:

Tab page Description

Global roles This tab page allows you to view and edit global roles, and add or remove users.

Resource roles This tab page allows you to view and edit resource roles, and add or remove users.

Global per-
missions

This tab page allows you to view global permissions, and add or remove global
permissions to or from global roles.

Resource per-
missions

This tab page allows you to view resource permissions, and add or remove resource
permissions to or from resource roles.
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Permissions
A permission is an authorization to access an application of Collibra Data Intelligence
Cloud, or to view or edit a resource.

Users are not granted permissions directly, but through global roles and responsibilities.

Collibra provides a set of permissions that are included in the default roles.

Permission types
Collibra has two types of permissions:

l Global permissions
l Resource permissions

Required license type of permissions
Collibra has several types of permissions, based on the license type that a user needs to
act on the permission.

Resource per-
mission type

Description

Read-only
permission

A read-only permission is a permission for which a read-only license or higher is
required.

Standard
permission

A standard permission is a permission for which a standard license is required.

Actions
l Determine which global permissions are included in global roles.
l Determine which resource permissions are included in resource roles.
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Global permissions
A global permission is a permission that applies across all Collibra applications. It can be
added to a global role.

For an overview of the permissions in each packaged global role, see the online version of
this documentation.

Global permission Description Required
license

Asset grid The Asset grid global permission contains global permissions that
allow users to configure asset grids.

Administration The Asset grid > Administration global permission allows users to
create and manage asset grids.

Note This global permission is only visible if Asset Grid
Permission is enabled in Collibra Console.

Read-only

Catalog The Catalog global permission contains global permissions that allow
users to use advanced features of Data Catalog.

Advanced Data
Type

The Catalog > Advanced Data Type permission group contains global
permissions that allow users to manage advanced data types.

Add The Catalog > Advanced Data Type > Add global permission allows
users to create advanced data types.

Standard

Remove The Catalog > Advanced Data Type > Remove global permission
allows users to delete advanced data types.

Standard

Update The Catalog > Advanced Data Type > Update global permission
allows users to edit advance data types.

Standard

Register
Profiling
Information

The Catalog > Register Profiling Information global permission allows
API users to enable data profiling when registering a data source. Standard

Technical
Lineage

The Catalog > Technical Lineage global permission allows users to
see the technical lineage of a data source.

Read-only
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Global permission Description Required
license

Edge The Edge global permission contains global permissions that allow
users to install and manage Edge sites.

Note Currently, Edge is an on-demand cloud service. It will
only become the default service once the migration from
Jobserver to Edge is complete.

Insights The Insights global permission contains global permissions related to
Insights Data Access and Usage Analytics.

Download the
Insights
reporting data

The Insights > Download the Insights reporting data global
permission allows users to download the data from the Insights Data
Access API (formerly called Reporting Data Layer).

Standard

View Insights
reports

The Insights > View Insights reports global permission allows users to
access the dashboard widgets.

Read-only

View Usage
Analytics
Summary

The Insights > View Usage Analytics Summary global permission
allows users to access the Usage Analytics dashboard, excluding the
detailed usage data.

Read-only

View Usage
Analytics
reports

The Insights > View Usage Analytics reports global permission
allows users to access the Usage Analytics dashboard,
including the detailed usage data, and also download the data.

Read-only

Product Rights The Product Rights permission group contains global permissions
that allow users to access Collibra applications.

Assessments The Product Rights > Assessments global permission allows users to
access the Assessments application.

Read-only

Business
Semantics
Glossary

The Product Rights > Business Semantics Glossary global
permission allows users to access the Business Glossary application. Read-only

Catalog The Product Rights > Catalog global permission allows users to
access the Data Catalog application.

Read-only
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Global permission Description Required
license

Data Dictionary The Product Rights > Data Dictionary global permission allows users
to access the Data Dictionary application.

Read-only

Data Helpdesk The Product Rights > Data Helpdesk global permission allows users
to access the Data Helpdesk application.

Read-only

Data
Stewardship
Manager

The Product Rights > Data Stewardship Manager global permission
allows users to access the Data Stewardship application. Read-only

Policy Manager The Product Rights > Policy Manager global permission allows users
to access the Policy Manager application.

Read-only

Privacy The Product Rights > Privacy global permission allows users
to access the Privacy landing page.

Read-only

Reference Data
Manager

The Product Rights > Reference Data Manager global permission
allows users to access the Reference Data application.

Read-only

System
Administration

The Product Rights > System Administration global permission allows
users to manage all sections of the Collibra Settings, including the
general settings, the operating model , roles, permissions, users,
groups and workflows.

Standard

User
Administration

The Product Rights > User Administration global permission allows
users to manage users and groups.

Standard

Workflow
Administration

The Product Rights > Workflow Administration global permission
allows users to access the Workflow tab page of the Collibra
Settings.

Standard

Workflow
Designer
access

The Product Rights > Workflow Designer access global permission
allows users to access the Workflow Designer application from the
Collibra menu.

Note This permission becomes available after you enable
the Allow access to the Workflow Designer Collibra
configuration setting.

Read-only
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Global permission Description Required
license

Resources The Resources permission group contains global permissions
that allow users to see and manage assets, domains and
communities.

Manage all
resources

The Resources > Manage all resources global permission allows
users to see and manage all communities and domains, and assets
whose type belongs to a product whose Product Right the user has,
regardless of responsibilities.

Standard

Tags The Tags permission group contains global permissions that
allow users to see and manage tags in the Data Stewardship
application.

Manage tags The Tags > Manage tags global permission allows users to
edit and delete tags on the tags page in the Data Stewardship
application.

Standard

View tags The Tags > View tags global permission allows users to see
the Tags Overview page in the Data Stewardship application.

Read-only

View Permissions The View Permissions permission group contains global permissions
that allow users to see all views, which includes dashboards, diagram
views, asset views, search filters and relation views on an asset page.

View All The View Permissions > View All global permission allows users to
see all communities, domains and the assets within them, thus
ignoring view permissions.

Read-only

Views, Dashboards,
Search filters

The Views, Dashboards, Search filters permission group contains
global permissions that allow users to manage and share views,
dashboards and search filters.

Manage shared
Views,
Dashboards,
Search filters

The Views, Dashboards, Search filters > Manage shared Views,
Dashboards, Search filters global permission allows users to share,
edit and delete views, dashboards and search filters that are shared. Standard

Chapter 28

775



Chapter 28

Global permission Description Required
license

Manage your
own Views,
Dashboards,
Search filters

The Views, Dashboards, Search filters > Manage your own Views,
Dashboards, Search filters global permission allows users to edit and
delete your own views, dashboards and search filters. Read-only

Share your own
Views,
Dashboards,
Search filters

The Views, Dashboards, Search filters > Share you own Views,
Dashboards, Search filters global permission allows users to share
your own views, dashboards and search filters. Read-only

Workflow The Workflow permission group contains global permissions that
allow users to manage workflows.

Use workflow
message
events

The Workflow > Use workflow message events global permission
allows users to pass message events to the workflow engine via an
API call.

Note This is used for API users.

Read-only

View all running
tasks

The Workflow > View all running tasks global permission allows users
to see ongoing tasks that are assigned to other users in the All Tasks
tab on the tasks page.

Standard

Resource permissions
A resource permission is a permission that applies to a resource and its children. They are
combined into resource roles to create responsibilities.

For an overview of the permissions in each packaged resource role, see the online version
of this documentation.

Resource
permission

Description Required
license

Asset The Asset permission group allow users to work with assets.

Add The Asset > Add resource permission allows users to create assets. Standard
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Resource
permission

Description Required
license

Remove The Asset > Remove resource permission allows users to delete
assets.

Standard

Update The Asset > Update resource permission allows users to edit
assets.

Note This only refers to the asset name and automatic
hyperlinking.

Standard

Update Status The Asset > Update Status resource permission allows users to
change the status of assets.

Standard

Update Type The Asset > Update Type resource permission allows users to
change the asset type of assets.

Standard

Attribute The Asset > Attribute permission group allow users to work with
attributes of assets.

Add The Asset > Attribute > Add resource permission allows users to
add characteristics to assets.

Tip If you want to use images and attachments in attributes
of assets, you also need the Attachment > Add permission.

Standard

Remove The Asset > Attribute > Remove resource permission allows users
to remove characteristics from assets.

Standard

Update The Asset > Attribute > Update resource permission allows users to
edit characteristics of assets.

Tip If you want to use images and attachments in attributes
of assets, you also need the Attachment > Add permission.

Standard

Data The Asset > Data permission group allow users to work with data
from data sources.

Access Data The Asset > Data > Access Data resource permission allows users
to create Tableau provision files.

Read-only

Chapter 28

777



Chapter 28

Resource
permission

Description Required
license

View Samples The Asset > Data > View Samples resource permission allows
users to see sample data of data sources.

Read-only

Responsibilities The Asset > Responsibilities permission group allow users to
manage the responsibilities of assets.

Add The Asset > Responsibilities > Add resource permission allows
users to create responsibilities for assets.

Standard

Remove The Asset > Responsibilities > Remove resource permission allows
users to delete responsibilities from assets.

Standard

Update The Asset > Responsibilities > Update resource permission allows
users to edit responsibilities of assets.

Standard

Tags The Asset > Tags permission group allow users to work with tags.

Update The Asset > Tags > Update resource permission allows users to edit
and delete tags on asset pages and asset tables.

Read-only

Attachment The Attachment permission group allow users to manage
attachments.

Add The Attachment > Add resource permission allows users to add
attachments to resources.

Read-only

Remove The Attachment > Remove resource permission allows users to
remove attachments from resources.

Read-only

Update The Attachment > Update resource permission allows users to edit
attachments of resources.

Read-only

Comment The Comment permission group allow users to work with
comments.
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Resource
permission

Description Required
license

Add The Comment > Add resource permission allows users to add
comments to resources.

Tip If you want to use images and attachments in
comments, you also need the Attachment > Add
permission.

Read-only

Remove The Comment > Remove resource permission allows users to
delete comments from resources.

Standard

Update The Comment > Update resource permission allows users to edit
comments of resources.

Tip If you want to use images and attachments in
comments, you also need the Attachment > Add
permission.

Standard

Community The Community permission group allow users to manage
communities.

Add The Community > Add resource permission allows users to create
and edit communities.

Tip If you want to use images and attachments in the
description of communities, you also need the Attachment >
Add permission.

Standard

Configure
external system

The Community > Add resource permission allows users to set up
connections to external data sources.

Standard

Remove The Community > Remove resource permission allows users to
delete communities.

Standard
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Resource
permission

Description Required
license

Update The Community > Update resource permission allows users to edit
communities.

Tip If you want to use images and attachments in the
description of communities, you also need the Attachment >
Add permission.

Standard

Responsibilities The Community > Responsibilities permission group allow users to
manage the responsibilities of communities.

Add The Community > Responsibilities > Add resource permission
allows users to create responsibilities for communities.

Standard

Remove The Community > Responsibilities > Remove resource permission
allows users to delete responsibilities from communities.

Standard

Update The Community > Responsibilities > Update resource permission
allows users to edit responsibilities of communities.

Standard

Domain The Domain permission group allow users to manage domains.

Add The Domain > Add resource permission allows users to create and
edit domains.

Tip If you want to use images and attachments in the
description of domains, you also need the Attachment > Add
permission.

Standard

Remove The Domain > Remove resource permission allows users to delete
domains.

Standard

Update The Domain > Update resource permission allows users to edit
domains.

Tip If you want to use images and attachments in the
description of domains, you also need the Attachment > Add
permission.

Standard
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permission

Description Required
license

Responsibilities The Domain > Responsibilities permission group allow users to
manage the responsibilities of domains.

Add The Domain > Responsibilities > Add resource permission allows
users to create responsibilities for domains.

Standard

Remove The Domain > Responsibilities > Remove resource permission
allows users to delete responsibilities from domains.

Standard

Update The Domain > Responsibilities > Update resource permission
allows users to edit responsibilities of domains.

Standard

Rating The Ratings permission group allow users to work with ratings.

Add The Rating > Add resource permission allows users to rate assets,
edit and delete your own ratings.

Read-only

Remove The Rating > Remove resource permission allows users to delete
other users' ratings.

Standard

Update The Rating > Update resource permission allows users to edit other
users' ratings

Standard

Validation The Validation permission group allow users to validate assets.

Validation
execution

The Validation > Validation Execution resource permission allows
users to manually start validation of an asset from the asset page or
an asset table.

Standard

View Permissions The View Permissions permission group allow users to manage the
view permissions of domains and communities.

Edit View
Permissions

The View Permissions > Edit View Permissions resource
permission allows users to edit the view permissions of domains
and communities.

Standard

Workflow The Workflow permission group allow users to manage workflows
tasks.
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Resource
permission

Description Required
license

Manage
Workflows

The Workflows > Manage Workflows resource permission allows
users to see all running workflow tasks for the related asset.

Note It does not give you permission to cancel or reassign
tasks, as this is determined by the workflow definition.

Standard

Enable permission to use tags
To enable the permission to use tags, follow these steps:

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
3. In the tab pane, click Permissions → Resource.

» The matrix of resource permissions and roles appears.
4. In the table, look up Tags.
5. In the role column, click to enable the permission.

If you see , that role is permitted to use tags.

A user with one of the selected resource roles on an asset can use (add, update and
delete) tags on that asset.

Disable the permission to use tags
To disable the permission to use tags, follow these steps:

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
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3. In the tab pane, click Permissions → Resource.
» The matrix of resource permissions and roles appears.

4. In the table, look up Tags.
5. In the role column, click to disable the permission for the role.

If you see , that role is not permitted to use tags.

Roles
A role is a collection of permissions that can be assigned to users and user groups.

Role types
The role type determines whether the permissions in the role apply to resources or the
Collibra Data Intelligence Cloud applications.

Collibra has two types of roles:

l Global roles
l Resource roles

Global roles
A global role is a role that consists of global permissions. You assign a user to a global role
to determine which Collibra applications the user can use.

Global roles

The following table contains the packaged global roles.
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Global role Description

Assessments A user who can access Assessments.

Asset Grid Admin A user who can access Asset Grid.

Catalog A user who can access Data Catalog. The global permissions in this role only require a
consumer license.

Catalog Author A user who can access Data Catalog. Users with this role can also create, edit and
delete advanced data types.

Data Dictionary A user who can access the Data Dictionary application, which contains all the
technical metadata of the physical data sources and other data assets.

DataSteward A user who can access the Data Stewardship application for viewing tags, Business
Dimensions and the organization structure, including the responsibilities of the
communities and domains.

DataSteward
Author

A user who can access the Data Stewardship application to see tags, Business
Dimensions and the organization structure, including the responsibilities of the
communities and domains. Users with this role can also manage tags on the tags
overview page.

Edge integration
engineer

A user who can add, edit and delete Edge connections and capabilities.

Edge manager A user who can create, edit and delete Edge sites.

Edge site A user who can create a connection between itself, as an Edge site, and Collibra Data
Intelligence Cloud.

Note The user is not a person, but an Edge site. The user is automatically
created when you install an Edge site.

Edge site admin-
istrator

A user who can download the download and installer files to install an Edge site.
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Global role Description

Glossary A user who can access the Business Glossary application.

Users with this role can access all business semantics glossary functionality and
workflows concerning business term proposal and approval, data element usage,
structure and glossary alignment.

Data Helpdesk A user who can access the Data Helpdesk application, where users can log
issues and check issue statuses and assignees.

Insights A user who can access Insights Data Access and Usage Analytics.

Policy Manager A user who can access the Policy Manager application, which is a collection of
all governance assets.

Privacy User A user who can access the Privacy landing page.

Note Collibra Data Privacy is a paid product.

Protect Admin A user who has the same permissions as a Protect Author. In addition, this user can
edit the data access rules and data protection standards of other users and also
access additional APIs.

Note Collibra Protect is a paid product.

Protect Author A user who can create data protection standards and data access rules, view
imported policies, view groups, and generate audits as an individual con-
tributor.

Note Collibra Protect is a paid product.

Protect Manager This role is intended for the Collibra Protect system user to manage back-
ground processes and configure Collibra Protect.

Note Collibra Protect is a paid product.

Protect Reader A user who can view Collibra Protect with read-only access to the content.

Note Collibra Protect is a paid product.
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Global role Description

ReferenceData A user who can access the reference data accelerator.

Users with this role are typically allowed to:

l Access all reference data functionality and workflows concerning code pro-
posal, code approval and code mapping.

l Define and manage the crosswalk, code value and codes set asset types
and their subtypes.

l Define and manage complex relation types such as code mapping.

Sysadmin A user who can configure and manage the Collibra Data Intelligence Cloud.

Users with this role are typically allowed to:

l Access and modify the Settings.
l Define and manage the operating model.

Create a global role

You can create a new global role. For example, you can do this if the packaged roles don't
meet your specific needs.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
3. In the tab pane, click Roles.

» The overview of global roles appears.
4. Above the table, to the right, click Add.

» The Global Role Creation dialog box appears.
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5. Enter the required information.

Field Description

Name Type a name for the role.

Description Type a description for the role.

Users Enter the users or user group that are granted this role.

Note You can still assign a global role to a user later.

6. Click Save.

What's next?

l Determine which global permissions are included in this role.
l Assign users to the role.

Edit a global role

You can edit a global role. You can do so, for example, if you want to edit the name or the
description of a role.

Note Do not confuse this with adding or removing global permissions.

Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
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3. Double-click a cell.
» The cell editor appears.

4. Edit the cell.
5. Click .

Add or remove global permissions to a global role

You can determine which global permissions are included in a global role.

Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
3. In the tab pane, click Permissions .

» The matrix of global permissions and roles appears.
4. If required, add or remove columns:

a. On the content toolbar, click → <the name of the role>.

5. Above the table, to the right, click Edit.
» You can now edit the matrix of permissions and roles.

6. Select or clear the checkboxes to add permissions to, or remove them from a role.
7. Above the table, to the right, click Save.

Assign a global role to a user or a user group

You can assign a global role to a user or user group.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
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2. Click Roles and permissions.
» The roles and permissions settings appear on the Global roles tab page.

3. In the row of the role to which you want to assign users or user groups, double-click
the Members column.

4. Start typing in the field and click the user or user group that you want to assign.
Press Enter to assign multiple users or groups at once.

5. Click Save.

Delete a global role

You can delete a global role. For example, you can do this if you no longer need a specific
role.

Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
3. In the row of the role, click .

» The Delete dialog box appears.
4. Click Delete.

Resource roles and permissions
A resource role is a role that consists of resource permissions and applies to a resource
and its children. For example, if you assign a resource role to a domain, it also applies to
all assets in the domain. If you assign a resource role to a community, it also applies to all
its subcommunities, domains and assets in the community. The purpose of resource roles
is to grant resource permissions to users through a responsibility. For example, they
determine which users can edit assets via the asset page or in a workflow.
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In this chapter

Resource roles

The following table shows the packaged resource roles.

Resource role Description

Assignee A user who is assigned to complete a task.

Business Ste-
ward

A user who is involved in daily, business-related decisions about the best
ways to turn policy into practice.

Chief Data Officer A high-level decision maker who is responsible for enterprise-wide data gov-
ernance and the utilization of information as an asset.

Community Man-
ager

A user who acts as liaison between all the different roles and groups. This
user can also analyze and pack up issues, so that the data governance coun-
cil can make decisions. Assigning and removing roles and responsibilities are
also among this user's duties.

Council Member A user who represents business and technical data stakeholder functional groups.

Data Analyst
Level 1

This role is assigned to a user on a date element level when this user is
allowed to see a data sample of this data element.

Data Analyst
Level 2

This role is assigned to a user on a date element level when this user has full
access to the data.

Data Category
Manager

Data Custodian A user who collects and holds information on behalf of a data provider or
requester and who is responsible for managing the use, disclosure and pro-
tection of data.
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Resource role Description

Issue Manager A user who identifies and prioritizes issues with business impact, directs
resources to the most urgent issues and reassigns tasks to different users in
the absence of the assigned user.

Normal A user who does not have any assigned responsibilities.

Owner A user who is responsible for accuracy, integrity, and timeliness of an inform-
ation asset and for establishing the controls for its generation, collection, pro-
cessing, access, dissemination and disposal.

Requester A user who makes a request related to an information asset.

Reviewer A user who is assigned to review an outcome of a user task.

Stakeholder A user who can use, affect or be affected by an asset under discussion. This
user wants to be involved or notified, but can only provide comments and
reviews.

Subject Matter
Expert

A user who performs specific data-related tasks and is consulted to provide
guidance and feedback to individuals with stewardship responsibilities.

Technical Ste-
ward

A user who is involved in daily, data-related decisions, executes business
decisions and implements business requirements in a technology platform.

Create a resource role

You can create a new resource role. You can do so, for example, if the packaged resource
roles don't meet your specific needs.

Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
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2. Click Roles and permissions.
» The roles and permissions settings appear on the Global roles tab page.

3. In the tab pane, click Roles→ Resource.
» The overview of resource roles appears.

4. Above the table, to the right, click Add.
» The Resource Role Creation dialog box appears.

5. Enter the required information.

Field Description

Name Type a name for the role.

Description Type a description for the role.

6. Click Save.

What's next?

As new resource roles are created with no resource permissions included, you have to add
them for the new resource role.

l As new resource roles are created with no resource permissions included, you have
to add them for the new resource role.

l Create a responsibility to assign users to the roles for a resource.

Edit a resource role

You can edit a resource role. You can do so, for example, if you want to edit the name or
the description of a role.

Note Do not confuse this with adding or removing resource permissions.

Prerequisites

l You have a global role that has the System administration global permission.
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Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
3. In the tab pane, click Roles→ Resource.

» The overview of resource roles appears.
4. Double-click a cell.

» The cell editor appears.
5. Edit the cell.
6. Click .

Add or remove resource permissions for a resource role

You can determine which resource permissions are included in a resource role.

Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
3. In the tab pane, click Permissions → Resource.

» The matrix of resource permissions and roles appears.
4. If required, add or remove columns:

a. On the content toolbar, click → <the name of the role>.

5. Above the table, to the right, click Edit.
» You can now edit the matrix of permissions and roles.

6. Select or clear the checkboxes to add permissions to, or remove them from a role.
7. Above the table, to the right, click Save.
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Delete a resource role

You can delete a resource role. For example, you can do this if you no longer need a
specific role.

Prerequisites

l You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
3. In the tab pane, click Roles→ Resource.

» The overview of resource roles appears.
4. In the row of the role, click .

» The Delete dialog box appears.
5. Click Delete.

Responsibilities
Responsibilities are used to assign a resource role to one or more users and/or user
groups. Based on their responsibilities, users can act on the permissions conveyed to
them via the resource role.

Responsibilities
A responsibility is the assignment of one or more users and/or user groups to a resource
role for a resource.

Based on their responsibilities, users can act on the permissions conveyed to them via the
resource role.

Child resources always inherit the responsibilities from their parent resources:

794



l If the resource is a community, the responsibilities are inherited by subcommunities,
domains and assets in the community. For example, if you are a Business Steward
for a certain community, you are a Business Steward for all the subcommunities,
domains and assets inside that community.

l If the resource is a domain, the responsibilities are inherited by the assets in the
domain.

l If the resource is an asset, the responsibilities only apply to the asset itself, because
assets never have children.

Example
Suppose the following setup:

l Anita Morrison is assigned the Community Manager resource role for a
community called "Enterprise".

l John Fisher is assigned the Business Steward resource role for a domain
called "Critical Data Elements" in the "Enterprise" community.

l Joanna Zhou is assigned the Owner resource role for a domain called "Critical
Data Elements" in the "Enterprise" community.

l William Parker is assigned the Owner resource role for an asset called
"Customer Revenue" in the "Critical Data Elements" domain.

This leads to the following responsibilities:

Resource Direct responsibilities Inherited responsibilities

Enterprise
community

l Anita Morrison as Community
Manager

l None

Critical Data
Elements domain

l John Fisher as Business
Steward

l Joanna Zhou as Owner

l Anita Morrison as Community
Manager

Customer Revenue
asset

l William Parker as Owner l Anita Morrison as Community
Manager

l John Fisher as Business
Steward

l Joanna Zhou as Owner

Note You can view direct and inherited responsibilities of a resource in different
places.
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View responsibilities for a resource
You can view the responsibilities for a resource in the following locations:

l In the Responsibilities tab of a resource.
l In any view that displays communities, domains or assets, in the specific column or
field for that role.
a. Open any view in table or tiles mode.
b. Perform one of the following steps:

n In tile mode: add the required fields.
n In table mode, add the required column.

Note
o Each role has its own field or column.
o Depending on the settings in Collibra Console, you may also see the
inherited responsibilities.

l In the Responsibilities tab of a user's profile page.

Tip You can also view your own responsibilities.

a. Open a profile page.
b. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
l In the Responsibilities tab of a user group page.

a. Open a group page.
i. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
ii. Click Users and groups.

» The users and groups settings appear on the Users tab page.
iii. In the tab pane, click Users → Groups.

» The user group table appears.
b. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
l In the Preview pane of an asset, for example on an asset page.

Note The preview pane only shows the direct responsibilities.
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The Responsibilities page
The Responsibilities page shows the view permissions and the responsibilities of a
resource.

The background colors of the responsibilities show where the responsibility comes from.

Color Description

Gray The user or group inherited the role.

White The user or group was directly assigned to this role for the resource.

If a user or group has a responsibility but not the required view permissions, a warning
appears in the box. For example, a user was assigned the Steward role for a resource but
does not have view permissions for it.

For information on view permissions, see the Collibra Data Intelligence Cloud
Administration Guide.

Create a responsibility
You can create a responsibility:

l By assigning a resource role to a user or user group on the responsibilities page of a
resource.

l By adding a user in the table column of a role.
l By editing an existing responsibility.
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Important For optimal performance and ease of use, we recommend that you
create responsibilities mainly on domains and communities and not directly on
assets. Creating responsibilities directly on large amounts of assets may lead to
decreased performance.

Assign a resource role to a user or user group on the
responsibilities page

1. Open a community, domain, or asset page.
2. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
3. Above the table, to the right, click Add.

» The Add responsibilitiy dialog box appears.
4. Enter the required information.

Option Description

Role Enter the role that you want to assign to a user or group for this resource.

People Enter the users and user groups to which you want to assign a role for
this resource.

5. Click Add.
» The users or groups with the assigned role are now displayed in the Respons-
ibilities table.

Tip
l If you want to assign a user or user group a resource role that other users or
groups already have for this resource, you can click and add them in the
People field in the Assign role box.

l If there are only inherited roles, is not available.

Assign a role to a user or user group for a resource from a table

1. Open a table that displays communities, domains or assets.
2. If required, add the column of the role that you want to assign to the user.
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3.  Perform one of the following steps:
o Double-click a cell in the column of the role.
o Hover your mouse pointer over a cell in the column and click .

4. Click in the field and enter the user or user group.
5. If required, select Apply to visible rows.

This will create the responsibilities for all visible users.

Tip You can filter the columns first, to assign a role to a user for specific
resources in one go.

6. Click .

Edit a responsibility
You can edit a responsibility:

l by deleting it and creating a new one.
l in an asset table.

Note You cannot edit inherited responsibilities.

Edit a responsibility in a table

1. Open a table that displays communities, domains or assets.
2. If required, add the column of the role that you want to edit.

Warning Depending on the settings in Collibra Console, you may also see
the inherited responsibilities. You cannot edit these inherited responsibilities.

3.  Perform one of the following steps:
o Double-click a cell in the column of the role.
o Hover your mouse over a cell in the column and click .

4. Edit the responsibility:
o Click in the field and enter a new user or user group.
o Click next to the user or user group to remove the user or user group.
o If required, select Apply to visible rows.
This will edit the responsibilities of all visible users.
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Tip You can filter the columns first to assign a user to specific resources
in one go.

5. Click .

Delete a responsibility
You can delete a responsibility:

l From the responsibilities page of a resource.
l From a table.

Note You cannot delete inherited assignments.

Delete a responsibility from the responsibilities page of a resource

1. Open a community, domain, or asset page.
2. In the tab pane, click Responsibilities.

» The Responsibilities page appears.
3. In the Responsibilities table, click next to the name of the user or group that you

want to remove.

4. Click Delete to confirm.
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Delete responsibilities for a resource from a table

1. Open a table that displays communities, domains or assets.
2. If required, add the column of the role that you want to edit.

Warning Depending on the settings in Collibra Console, you may also see
the inherited responsibilities. You cannot delete these inherited
responsibilities.

3.  Perform one of the following steps:
o Double-click a cell in the column of the role.
o Hover your mouse over a cell in the column and click .

4. In the cell editor, click next to the user or user group.

5. If required, select Apply to visible rows.
This will delete the responsibilities from all visible users.

Tip You can filter the columns first to assign a user to specific resources in
one go.

6. Click .

Managing workflows in Collibra
A workflow in Collibra Data Intelligence Cloud is used to automate processes. Collibra
comes with many out-of-the-box workflows, and you can always add new ones.

When you decide how to configure your Collibra workflows, consider that the workflow
events mechanism is not designed for mass import. Avoid triggering workflows as a result
of an import operation because it has the potential of impacting the performance of your
environment. If you must use workflows after importing large amounts of data, you should:

l Configure all script tasks to run asynchronously to prevent slowing down the import.
l Keep the number of start events to a minimum.
l Restrict the scope of the workflow as much as possible.
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Tab pages
The Workflows settings page of the Collibra settings is split in several tab pages:

Tab page Description

Definitions This tab page allows you to view and edit workflow definitions.

Instances This tab page allows you to view and edit instances of running workflows.

Out-of-the-box workflow deployments
In general, when you start your Collibra Data Intelligence Cloud environment, all missing
out-of-the-box (OOTB) workflows are deployed, enabled and configured with the default
settings.

Note OOTB workflows are not automatically updated after an upgrade.

The following list of rules applies to OOTB workflow deployments in version 5.1 or newer
when you (re)start an environment:

l OOTB workflows that are missing (deleted or never deployed), are deployed,
enabled and configured with the default settings.

l Deployed OOTB workflows are not automatically updated, even if they are not cus-
tomized. To install a new version of an OOTB workflow, do either of the following:

o Remove the existing workflow and then restart the environment.
o Download the updated workflows from the Community Downloads page, cus-
tomize them if necessary, and deploy them to your environment.

l If you created a workflow with the name of an OOTB workflow and the actual OOTB
workflow is not deployed, the actual OOTB workflow is deployed, enabled and con-
figured with a name having an OOTB_ prefix, for example OOTB_Approval Process.

Tip Disable the OTTB workflows you do not want to use. If you delete them, they
are redeployed when the environment is restarted.
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Workflow engine upgrade
In Collibra Data Intelligence Cloud 5.6 or newer, the workflow engine uses Flowable
instead of Activiti because of the lack of development and support for Activiti.

The upgrade has the following impact:

l When you upgrade from version 5.5 or older to Collibra Data Intelligence Cloud 5.6
or newer, all workflows in your environment are redeployed for the new workflow
engine. Running instances of workflows continue to use the old workflow engine until
their completion, while new instances run with the new workflow engine.

l The upgrade to Flowable ensures the out-of-the-box workflows remain functional.

Tip Test your custom workflows thoroughly, even if they seem to work as
expected.

Note Your workflows could show unexpected behavior, especially after
upgrading from version 4.6.x.

l When you reference the API v2 name space (http://www.collibra.com/apiv2), the
workflow is validated against V2 methods and deprecated V1 methods trigger a
method does not exist error when called.

View and edit workflows
You can view both the XML schema and a visual representation of the workflow definition
in Collibra Data Intelligence Cloud.

You must have the Sysadmin global role or a global role that has at least the Workflow
Administration global permission to access this page:

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Workflows.

» The Workflows settings page appears on the Definitions tab page.
3. Select a workflow.
4. In the tab pane, click Flow.
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Tip To view large diagrams, drag the image or click to enter full screen.

The lower part of the page contains the raw workflow definition:

To edit workflows, follow the procedures described in the Edit an out-of-the-box workflow
section of the Workflows documentation. For minor updates, you can edit the XML schema
directly :

1. Click to edit the XML.

2. Click the Save button in the lower-right part of the page to save your changes and
exit edit mode.

Note The changes you make are not reflected in currently running instances of the
workflow.
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Deploy a workflow
You deploy a workflow when you upload the workflow definition or exported workflow
designer app to Collibra Data Intelligence Cloud.

You can upload a workflow in *.bpmn, *.bpmn20.xml and zip format.

Prerequisites
You have a global role with the Workflow Administration or the System Administration
global permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. In the tab pane, click Workflows → Definitions.
3. Click Upload a file and select the workflow definition you want to deploy or drag

and drop your workflow in the upload section.
» An Activity Queue window displays the upload progress. In case the update fails,
you see an error message.

Warning Uploading a workflow with the same process ID as an existing workflow in
Collibra replaces the existing workflow.

Note Collibra does not accept two workflows with the same display name.

What's next
After a successful workflow deployment, edit the workflow definition settings in Collibra.
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Enable or disable workflows
You can enable or disable workflows from the workflow definitions table or from the
individual workflow definition pages.

You must have the Sysadmin global role or a global role that has at least the Workflow
Administration global permission to perform this action.

Enable or disable a workflow from the workflow definitions
table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. In the tab pane, click Workflows → Definitions.
3. At the end of the row, click or to respectively enable or disable a workflow.

Enable or disable a workflow from the workflow definition
page

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
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2. In the tab pane, click Workflows → Definitions.
3. Click the workflow you want to enable or disable.
4. At the right of the title bar, click or to respectively enable or disable a workflow.

Workflow configuration options in Collibra
After you have successfully deployed a workflow, the default settings are applied to it. You
can change the default settings and the workflow behavior to your organization's needs.

In the overview of a workflow, you can change the header bar and some general workflow
settings.

Workflows title bar

The title bar of workflow definition pages contains the name and status of the workflow and
allows you to:

1. Enable or disable the workflow.
2. Edit the display name or status of the workflow.
3. Delete the workflow.

Note Collibra does not accept two workflows with the same display name.

Workflow statuses description:

l Deployed A new workflow has been uploaded to Collibra Data Intelligence Cloud.
l Enabled: The workflow is active and can be used.
l Disabled: The workflow cannot be used. If the workflow is a step in another work-
flow, that step fails.
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Note Once a workflow has been enabled, you cannot change the status back to
Deployed.

View and edit workflow definition settings
The workflow definition settings are additional parameters that help you manage the
workflow behavior and accessibility inside Collibra Data Intelligence Cloud.

When you decide how to configure your Collibra workflows, consider that the workflow
events mechanism is not designed for mass import. Avoid triggering workflows as a result
of an import operation because it has the potential of impacting the performance of your
environment. If you must use workflows after importing large amounts of data, you should:

l Configure all script tasks to run asynchronously to prevent slowing down the import.
l Keep the number of start events to a minimum.
l Restrict the scope of the workflow as much as possible.

You must have the Sysadmin global role or a global role that has at least the Workflow
Administration global permission to access this page:

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Workflows.

» The Workflows settings page appears on the Definitions tab page.
3. Select a workflow to view the definition settings.
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Description

The description is a brief overview of the workflow. You can edit the description by:

l Changing the diagram process properties.
l Editing the workflow XML directly in Collibra Data Intelligence Cloud

Applies To

This section defines the scope of the workflow. This includes the type of resource the
workflow applies to, optional restriction rules and where you can start the workflow from.

Click Edit to change the scope to any of the following:

l Asset
l Community
l Domain
l Global

Chapter 28
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Note When you change the scope, the rules are removed. If you are changing
from or to the Global scope, the roles are also removed.

A global workflow is not restricted to any particular resource and can be added to
dashboards.

When you defined the resource that the workflow applies to, you can add restriction rules
to finetune the scope of the workflow.

Show me how

1. Click Add.
» A dialog box appears.

Note The available options depend on the selected scope.

2. Select the Type.

Tip Select Asset to associate the workflow with all asset types.

3. Select an optional domain or community the resource belongs to.
4. Select an optional status of the resource the workflow applies to.
5. Click Save.

» The restriction is added to the list. The workflow is restricted to the resources that
meet the listed conditions.

Note If you select multiple restrictions, they use the logical OR function.
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Variables

These are configuration variables, a list of process variables that you can edit here.

Click Edit to edit the variables.

Note You can only edit configuration variables that have the Writable property set
to true (default).

Note If you redeploy a workflow, the configured variables remain the same. If you
delete a workflow and then deploy it again, the variables revert to the default values.

Start Label

The start label is the name of the workflow when it is visible as a button on a resource page
or in the drop-down list when you add it as a button on a dashboard. Click Edit to edit the
label.

Start Event

A start event is an event that triggers the workflow, for example starting the workflow when
an asset is created. Click Edit to edit the start event list.

Combine the Start Event with Applies To settings to refine when the workflow is triggered.

Setting Description

Asset Added The workflow starts when a new asset is created.

Asset Removed The workflow starts when an asset is deleted.

Asset Status Changed The workflow starts when the status of an asset is changed.

Asset Domain
Changed

The workflow starts when an asset is moved to another domain.

Asset Type Changed The workflow starts when the type of an asset is changed.
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Setting Description

Asset Attribute
Changed

The workflow starts when an attribute of an assets is changed.

Asset Name Changed The workflow starts when the full name of an asset is changed. This is
the fully qualified name that must be unique within a domain. To learn
more, see Identical asset names per domain.

Asset Display Name
Changed

The workflow starts when the name of an asset is changed. This is the
regular name that is used by default in most places in the user interface.

Asset Attribute Added The workflow starts when an attribute is added to an asset.

Asset Attribute
Removed

The workflow starts when an attribute is removed from an asset.

Domain Added The workflow starts when a domain is added to a community.

Domain Removed The workflow starts when a domain is removed from a community.

Role Granted The workflow starts when a user or a user group is assigned a resource
or a global role.

Role Revoked The workflow starts when a user or a user group is removed from a
resource or a global role.

Workflow Started The workflow starts when a workflow is manually started.

Note Manually starting a workflow configured with this option also
triggers the workflow.

Workflow Canceled The workflow starts when a workflow is manually canceled.

Note Manually canceling a workflow configured with this option also
triggers the workflow.

Workflow Escalation The workflow starts when a workflow user task is escalated.

Note The packaged Escalation Process workflow is configured to start
with this option.
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Setting Description

Workflow task com-
pleted

The workflow starts when a workflow user task is completed.

User Added The workflow starts when a new user account is created.

User Removed The workflow starts when a user account is removed.

User Disabled The workflow starts when a user account is disabled.

Commend Added The workflow starts when a new comment is added to a resource.

Comment Removed The workflow starts when a comment is removed from a resource.

Comment Changed The workflow starts when a comment is edited.

Relation was added on
an asset as head

The workflow starts when an asset becomes the head of a relation.

Relation was removed
from an asset as head

The workflow starts when an asset is no longer the head of a relation.

Relation was added on
an asset as tail

The workflow starts when an asset becomes the tail of a relation.

Relation was removed
from an asset as tail

The workflow starts when an asset is no longer the tail of a relation.

Asset Tag Event The workflow starts when a tag is either added to or removed from an
asset.

Data Classification
Accepted

The workflow starts when a result of the data classification process is
accepted.

Data Classification
Rejected

The workflow starts when a result of the data classification process is
rejected.

Data Classification
Added

The workflow starts when a new data class is added to a column asset.
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Setting Description

Data Classification
Removed

The workflow starts when a data class is removed from a column asset,
for example when the data class entry is deleted.

Data Classification
Updated

The workflow starts when a data classification changes, for example
when the confidence of a suggested match changes value.

Database Registration
Completed

The workflow starts when a database is successfully registered.

Database Registration
Failed

The workflow starts when the registration process of a database fails.

Note If you select multiple start events, they use the logical OR function.

Roles

The roles define the permissions to manage the workflow. For example, if a certain tasks
must be urgently executed but the responsible person is on sick leave, a user with the
defined role can reassign that task to somebody else.

You can enter roles for starting and stopping workflows or reassigning workflow user
tasks. The roles you can enter depend on the Applies To settings:

l If the scope is Global, you can only specify global roles in these fields.
l In all other cases, only resource roles are allowed.

Note When specifying resource roles, only users that have the role for the specific
resource can start and stop the workflow or reassign tasks.

Click to edit the roles:

l Start Workflow: The button with the start label is available to users with these roles.
l Stop Workflow: The option to cancel the workflow is available to users with these
roles.

l Reassign Tasks: The option to reassign the task is available to users with these
roles.
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Note The roles are removed when you are changing from or to the Global workflow
scope.

Other

The section contains additional settings that determine who can start the workflow, how
the workflow behaves in relation to the resource it applies to and if the workflow can be
started from the global Create button.

Setting Description

Any guest user can
start the workflow.

Indicates if guest users can start the workflow.

If selected, users who are not signed in can start the workflow. When guest users
start a workflow, some basic information, such as first name, last name and email
address, is requested of them. That information can then be used to contact the
user again, if needed.

Note This check box overrides any roles that are specified in the Roles
section.

If you select this check box, you cannot select the Any signed in user can start
the workflow check box.

Any signed in user can
start the workflow.

Indicates that any user who is signed in can start the workflow.

Note This check box overrides any roles that are specified in the Roles
section.

If you select this check box, you cannot select the Any guest user can start the
workflow check box.

Perform candidate
user check on work-
flow start.

Checks if all workflow user tasks have a candidate user expression that can be
resolved to at least one Collibra Data Intelligence Cloud user. If the check fails,
you see an error message when the workflow starts.
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Setting Description

This workflow can only
run once at the same
time on a specific
resource.

Determines if you can start a workflow multiple times, simultaneously for the
same resource.

If selected the workflow can only be started once for a given resource. If any user
tries to start the same workflow for the same resource, an error message is
displayed. However, users can still start the same workflow for a different
resource or another workflow for the same resource

If Lock resource is also selected, no other workflow can start on the same
resource while this workflow is running neither can this workflow start if any other
workflow is running on the same resource.

Show in global create. Only valid for workflows where the scope is set to Global, allows users to
start the workflow from the global Create button.

Duration variables
Both the escalationDuration and escalationType variables are only generated if there is
no timer boundary event attached to the user task. In case there is one attached, it
assumes that you will handle the escalation manually and no escalation variables are
generated.

For more information about specifying a duration for the variables, please read about the
ISO 8601 standard. Also note that we support business day durations. You can denote a
business day duration by using a B instead of a P. If you use a business day duration,
weekends are not taken into account. If a business day duration ends at a weekend, the
first weekday after the weekend is used. You can use the business day duration just like a
normal duration.

Other configuration settings
The following table contains a description of the Other configuration settings in Collibra.
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Setting Description

Any guest user can
start the workflow.

Indicates if guest users can start the workflow.

If selected, users who are not signed in can start the workflow. When guest users
start a workflow, some basic information, such as first name, last name and email
address, is requested of them. That information can then be used to contact the
user again, if needed.

Note This check box overrides any roles that are specified in the Roles
section.

If you select this check box, you cannot select the Any signed in user can start
the workflow check box.

Any signed in user can
start the workflow.

Indicates that any user who is signed in can start the workflow.

Note This check box overrides any roles that are specified in the Roles
section.

If you select this check box, you cannot select the Any guest user can start the
workflow check box.

Perform candidate
user check on work-
flow start.

Checks if all workflow user tasks have a candidate user expression that can be
resolved to at least one Collibra Data Intelligence Cloud user. If the check fails,
you see an error message when the workflow starts.

This workflow can only
run once at the same
time on a specific
resource.

Determines if you can start a workflow multiple times, simultaneously for the
same resource.

If selected the workflow can only be started once for a given resource. If any user
tries to start the same workflow for the same resource, an error message is
displayed. However, users can still start the same workflow for a different
resource or another workflow for the same resource

If Lock resource is also selected, no other workflow can start on the same
resource while this workflow is running neither can this workflow start if any other
workflow is running on the same resource.

Show in global create. Only valid for workflows where the scope is set to Global, allows users to
start the workflow from the global Create button.
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Out-of-the-box variables for workflows
Below is a list of variables that you can use in workflows.

Variable Description

address_commentsDueDate Due date as duration for the address_comments task.

address_com-
mentsTaskNotification

Indicates if a notification email for the address_comments task
has to be sent.

address_com-
mentsEscalationDuration

Time before the address_comments task is escalated.

address_com-
mentsEscalationType

Type of escalation for the address_comments task.

comment_provideDueDate Due date as duration for the comment_provide task.

comment_provideEs-
calationDuration

Time before the comment_provide task is escalated.

comment_provideEs-
calationType

Type of escalation for the comment_provide task.

comment_provideTaskNo-
tification

Indicates if a notification email for the comment_provide task
has to be sent.

commentTimeoutDuration Time before the comment_provide task times out.

correct_definitionDueDate Due date as duration for the correct_definition task.

correct_defin-
itionEscalationDuration

Time before the correct_definition task is escalated.

correct_defin-
itionEscalationType

Type of escalation for the correct_definition task.

correct_defin-
itionTaskNotification

Indicates if a notification email for the correct_definition task
has to be sent.
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Variable Description

reviewCompletionPercentage Percentage of user candidates that is required to review the
definition before the task is completed.

reviewTimeoutDuration Time before the review process is forced to continue.

reviewWarningTimeDuration Time before a reminder for the review definition task is sent.

sendVotingActionEmails Indicates if an action email has to be sent to candidate users,
users that are required to vote.

smeUserExpression The user expression for subject matter experts.

stakeholderUserExpression The user expression for stakeholders.

stewardUserExpression The user expression for stewards.

voteCompletionPercentage Percentage of user candidates that is required to vote before
the task is completed.

voteTimeoutDuration Time before the voting process is forced to continue.

voteWarningTimeDuration Time before a voting reminder is sent.

Edit the workflow configuration options

Warning For Collibra Data Privacy customers: Collibra Data Privacy comes with
workflows for approving data privacy-specific assets. The Collibra packaged
approval workflows (Approval Process, Asset Approval Process and Simple
Approval Process) should not be used to approve data privacy-specific assets. As
such, ensure that your Collibra approval workflows are not associated with data
privacy-specific asset types, such as DPIA, PIA, Legitimate Interest Assessment
and Compliance Self Assessment.

Prerequisites
You have a global role with the Workflow Administration or the System Administration
global permission, for example Sysadmin.
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Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Workflows.

» The Workflows settings page appears on the Definitions tab page.
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3. Click the workflow that you want to configure.
4. Configure the available options:

To add a
restriction rule:

The following example associates the asset type Business Rule with the workflow
you selected in the previous step. For example, if you selected the Approval
workflow, you will be able to use the Approval workflow to approve Business Rule
assets.

Note When you change the scope of the workflow, the restriction rules
are removed.

a. Click Add.
» A dialog box appears.

b. Provide one or more Types.
In this example, you enter the Business Rule asset type.

Tip Select Asset to associate the workflow with all asset
types.

c. Click domain or community, and then provide the domains or
communities to which the asset types belong.

d. Select the status of the assets to which the workflow will apply.
This setting is not applicable when you are applying the workflow to
communities, domains or global.

e. Click Save.
» The asset type is added to the Applies To list. The workflow
applies to any assets of this asset type, with the status you selected,
in the domains or communities you selected.

Note The restrictions use the logical OR function.
In the example figure above, the workflow applies to Business Term
assets that have the status New OR Data Asset assets that are in the
Business Analysts Community and have the status Candidate.
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To modify the
Variables, Start
Label, Start
Event and
Roles:

a. Click .
b. Change the option.
c. Click Save.

To modify the
Other options:

Select or clear the check boxes.

View the running instances of a workflow
You can view the currently running instances of your workflows.

Prerequisites
You have a global role with the Workflow Administration or the System Administration
global permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Workflows.

» The Workflows settings page appears on the Definitions tab page.
3. In the tab pane, click Workflows → Instances.

» The overview of workflow instances appears.

For more information about the table, see View running workflow instances.

Note You cannot view running workflows that contain only script tasks on the
workflows instances page.
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View running workflow instances
The workflows instances page displays details about running workflows that contain active
user tasks. If the user task is part of a sub-process, you can see details about both the
main process and the sub-process. You cannot see running workflows that contain only
script tasks or that do not contain anymore user tasks.

You must have the Sysadmin global role or a global role that has at least the Workflow
Administration global permission to access this page:

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Workflows.

» The Workflows settings page appears on the Definitions tab page.
3. In the tab pane, click Workflows → Instances.

» The overview of workflow instances appears.

Column Description

Workflow The name of the running workflow.

Resource The resource the workflow is associated with. Click the resource name to go to
the resource page.
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Column Description

Task The name of the active user task.

Users The users the active task is assigned to. Click the user name to go to the user
profile page.

Starting Date The start date of the process.

Error Possible error message if the workflow instance encountered an error.

Button to delete the workflow instance.

Back up workflows
You can create backups for individual workflows. This comes in handy if you have
modified a packaged workflow definition and want to upgrade to a newer version of
Collibra that contains newer workflow definitions.

You must have the Sysadmin global role or a global role that has at least the Workflow
Administration global permission to perform this action:

1. Open a workflow. See View and edit workflows.
Below the diagram of the flow, you can find the raw workflow definition (XML).

2. Select all the raw workflow definition text and copy it.
You don't have to go into the edit mode.

3. Paste the text in a plain text file editor such as Notepad, Notepad++ or Vim and not
an advanced text editor such as Word.

4. Save the text file as a new file on your local file system.

Delete workflows
You can delete workflows from the workflow definitions table or from the individual
workflow definition pages.

You must have the Sysadmin global role or a global role that has at least the Workflow
Administration global permission to perform this action.
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Delete a workflow from the workflow definitions table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. In the tab pane, click Workflows → Definitions.
3. At the end of the row, click to delete the workflow.

Delete a workflow from the workflow definition page

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. In the tab pane, click Workflows → Definitions.
3. Click the workflow you want to delete.
4. At the right of the title bar, click to delete the workflow.

Note Currently running instances of a deleted workflow continue to run until their
completion. Use the Collibra Command Line Interface to cancel workflow instances
in bulk.

Restore a workflow
You can restore a workflow.

Prerequisites
You have a global role with the Workflow Administration or the System Administration
global permission, for example Sysadmin.

Steps

1. On your computer, open a workflow that you have previously backed up. See Back
up workflows.
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2. Copy the XML text from the file.
If necessary, create a workflow in Eclipse - Flowable and then close all open win-
dows.

3. In the Flowable Explorer pane, right-click your workflow and click Open With → XML
Editor.

4. Click the Source tab.
5. Paste the copied XML text in the blank pane.
6. Click Save.
7. Close the XML editor.
8. In Collibra, deploy your workflow, see Deploy a workflow.

Users and groups settings page
On the Users and groups settings settings page of the Collibra settings, you can define
users and what they are allowed to do in which part of Collibra Data Intelligence Cloud.

Collibra Data Intelligence Cloud uses a standard user-group-role model. This means that
you can create groups and add users to them. Subsequently, you can assign roles to
individual users or groups.

Assigning roles to users or groups is important:

l You provide or restrict permissions to do certain actions in Collibra, such as editing
asset attributes or deleting domains.

l You define the responsibilities of the user. These responsibilities are mostly used in
workflows to assign tasks to the correct users.

You can manage users in the following ways:

l Manually: Create users and groups within Collibra.
l LDAP: Connect Collibra to your company's LDAP server to import users and groups.

Tab pages
The Users and groups settings page of the Collibra settings is split in several tab pages:
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Tab page Description

Users This tab page allows you to view and edit user accounts.

Groups This tab page allows you to view and edit groups.

User and group management overview
For handling user management, Collibra Data Intelligence Cloud uses a standard user-
group-role model. This means that you can create user groups and add users to them.
Subsequently, you can assign roles to individual users or user groups.

Assigning roles to users or user groups is important:

l You provide or restrict permissions to do certain actions in Collibra, such as editing
asset attributes or deleting domains.

l You define the responsibilities of the user. These responsibilities are mostly used in
workflows to assign tasks to the correct users.

You can manage users in the following ways:

l Manually: Create users and user groups within Collibra.
l LDAP: Connect Collibra to your company's LDAP server to import users and groups.

Users
A user is an individual who has access to Collibra Data Intelligence Cloud through a user
account.

What the user can actually do in Collibra, depends on the license type, the global roles and
the responsibilities assigned to the user.

Tip Users can be added to user groups to easily assign roles and responsibilities to
multiple users at once.

Username requirements

All usernames within Collibra need to comply with our username requirements.
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Collibra username requirements

l General requirements:
o Uniqueness: Duplicate username are not allowed, regardless of case

Example usernamecase and UserNameCase are considered duplicate

o No leading or trailing spaces
o No empty usernames
o Maximum of 255 characters

l Character limitations: Usernames may only contain characters in the following
Unicode categories:

o Letter
o Number
o Symbol
o Punctuation
o Non-spacing marks

User types

The user type of a user depends on the license type they have.

User type Description

Read-only user A read-only user is a user with a read-only license.

Standard user A standard user is a user with a standard license.

User statuses

The user status of a user determines whether a user can log in or not.

User status Description

Enabled A user with the enabled status can log in to Collibra. The license of this user
counts towards the maximum number of licenses, if the user has the active
password status.
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User status Description

Disabled A user with the disabled status cannot log in to Collibra.The license of this
user does not count towards the maximum number of licenses.

Password statuses

Password status Description

Active A user with the active password status is a user that has a password.

Inactive A user with the inactive password status is a user that does not have a pass-
word. This is typically a temporary status that only occurs right after creating a
user. When a password is created for the user, the password status becomes
active. It cannot revert to inactive.

Out-of-the-box users

Collibra contains a number of out-of-the-box users. They are used to manage various
aspects of Collibra.

Default name UUID Purpose

SYSTEM_USER "00000000-0000-0000-
0000-000000900001";

The system user is used, amongst others,
during the installation of Collibra. It is
hidden in Collibra.

ADMIN_USER "00000000-0000-0000-
0000-000000900002";

The admin user is the default
administrator used to configure Collibra
when it is installed.

COLLIBRIAN_USER "00000000-0000-0000-
0000-000000900000";

The Collibrian user is a user that can be
used by Collibra, for example to provide
support. It is hidden in Collibra DGC and
should not be used for anything else.
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Default name UUID Purpose

WORKFLOW_USER "00000000-0000-0000-
0000-000000900003";

The workflow user is used when changes
are made through a workflow. It is hidden
in Collibra DGC and should not be used
for anything else.

Create a user

You can create one or more users in one go. At the same time, you can add the user(s) to
user groups.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. Above the table, to the right, click Add.

» The Create Users dialog box appears.
4. Enter the required information.

Field Description

User details Enter the user details of the new users.
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Field Description

Username* Type the username of the user to sign in to Collibra Data Intelligence Cloud.

Collibra username requirements
o General requirements:

n Uniqueness: Duplicate username are not allowed, regardless of
case

Example usernamecase and UserNameCase are
considered duplicate

n No leading or trailing spaces
n No empty usernames
n Maximum of 255 characters

o Character limitations: Usernames may only contain characters in the
following Unicode categories:
n Letter
n Number
n Symbol
n Punctuation
n Non-spacing marks

Email* Type the email address to which Collibra sends emails, such as the registration
email and notifications.

First Name Type the first name of the user.

Last name Type the last name of the user.

Click to remove a user.

Add another
user

Click to add another user.
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Field Description

Add to user
groups

Enter user groups to add the new users to them. You can also add users to, or
remove users from groups afterwards.

Note
A user needs access to at least one of the basic Collibra applications:
Business Glossary, Reference Data, Data Stewardship or System
administration.
You can grant access by assigning one of the global roles that provide
the required permissions to the users.

Fields marked with * are mandatory

5. Click Create.
» The newly created users are enabled, but inactive.
» The newly created users receive an email to set a password. As an administrator,
you can also manually set or reset it. When the password is set, the user is active.

Edit a user

You can edit a user.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. Open a user's profile page.
2. Perform one of the following steps:

o Edit the account settings.
o Edit the contact information.
o Edit the email notifications.
o Edit the user details.
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Set or reset a user password

You can set or reset the password of a user:

l From the user table.
l From the user's profile page.
Do this to reset your own password.

Note You can only reset the password of users that were created manually.

The default password requirements are outlined in the Password section of our Security
configuration: options article.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Set or reset a user password from the user table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. In the row of the user whose password you want to reset, click .

» The Password Reset dialog box appears.
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4. Choose how you want to reset the password.

Option Description

Email a link to the
user.

Send an email to the user and let the user set a new password.

Note The link to reset the password is by default valid for 60 minutes.
You can edit the length of the validity in Collibra Console.

Generate a new
password
automatically.

Automatically generate a password.

Specify a new
password.

Set a password yourself.

5. Click Reset Password.

Set or reset a user password from the user profile page

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the upper-right corner, click Reset Password.
» An email is sent to the user to let the user set a new password.

Note The link to reset the password is by default valid for 60 minutes. You
can edit the length of the validity in Collibra Console.

Enable a user

You can enable a user.

Note

l You can only enable users if they were created manually.
l Newly created users are enabled by default.
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Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. In the row of the user that you want to enable, click .

» The user account is enabled.
» The icon changes into a green .

Disable a user

You can disable a user.

Note You can only disable users if they were created manually.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. In the row of the user that you want to enable, click .

» The user account is disabled.
» The icon changes into a green .
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Delete a user

You can delete one or more users in one go.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. Perform one of the following steps:

If you want to... Follow these steps

Delete a single
user

a. In the row of the user that you want to delete, click .

» The Delete user dialog box appears.
b. Click Delete user.

Delete more
than one user

a. Select the check boxes in front of the users that you want to delete.
b. In the action toolbar, click Delete.

» The Delete <number> users dialog box appears.
c. Click Delete <number> users.

» One or more users are deleted.
» If a deleted user posted any comments, those comments remain in the system but
without an associated name.

Export user table as a CSV file

You can export the information in the user table as a CSV file.
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Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. In the tab pane, click Users.

» The user table appears.
3. Above the table, to the right, click .

» The Export users activity starts.
4. When the Export users activity is finished, you can download the CSV file:

a. On the main menu, click , then Show more.

» Your profile page opens on the Activities tab page.
b. In the Results column of the Export users activity, click Results.

» Depending on your browser and browser settings, the files are downloaded
to a default location or a dialog box appears to specify the location for the down-
loads.

Example

This is an example of the user information that is exported:

l User ID
l Password status (activated
column)

l User status (enabled column)
l Username
l Email address
l First name
l Last name
l Gender
l Default language
l Last login time
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View users that are logged in

As an administrator, you can view which users are currently logged in.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. If required, add the column Online.

a.  On the content toolbar, click → Columns → Currently logged in.

» The Currently logged in column appears.

Groups
A group is a logical collection of users.

The main purpose of groups is to facilitate assigning roles and responsibilities. When a
group is assigned a resource role, the users in the group receive the resource roles and
their permissions.

Managing groups

There are several options for managing groups. However, you can only use one of the
options below. It is not possible to combine them.

l Manage groups in LDAP, using Group field mapping.
o Prerequisite: You have configured the Group field setting in the user attributes
to assign groups.
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o If there are manually created groups in Collibra Data Intelligence Cloud, they
are removed before the LDAP-managed groups are created.

o No synchronization is required for this option to work.
l Manage groups in Collibra.

o Prerequisite: You have not configured the Group field setting in Collibra Con-
sole in the user attribute settings.

o Groups are managed directly in Collibra. Creating groups and assigning users
to the groups is done within Collibra.

o No synchronization is required for this option to work.

Out-of-the-box groups

Collibra contains a number of out-of-the-box groups. They are used to manage various
aspects of Collibra.

Default name UUID Purpose

EVERYONE_GROUP "00000000-0000-0000-
0000-000001000001";

The Everyone group contains all users
and is mainly used to manage view
permissions. It is hidden in Collibra and
should not be used for anything else.

USERS_GROUP "00000000-0000-0000-
0000-000001000002";

The Users group contains all users and
can be used for actions that affect all
users. It is hidden in Collibra.

GROUP_DATA_
CUSTODIANS

"00000000-0000-0000-
0000-000001000003";

The Data Custodians group is meant for
users with the Data Custodian resource
role and can be used for actions that affect
all such users.

Note When users are assigned
the Data Custodian resource role
for a resource, they are not
automatically added to the Data
Custodians group; however, you
can manually add them to the
group.
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User group page

The user group page contains relevant information about that user group.

The view bar contains some basic information about the user group, such as the name and
the number of members.

The group page contains the following tab pages:

Tab page Description

Overview The overview page contains general information such as the name and the number of
members.

It also contains a table containing the members of the user group, and allows you to
add users to or remove users from the groups.

Responsibilities The responsibilities page contains the responsibilities that are assigned to the
user group.

Create a user group

You can create a user group.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. In the tab pane, click Users → Groups.

» The user group table appears.

840

https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0635
https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0630
https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0630


4. Above the table, to the right, click Add.
» The Create groups dialog box appears.

5. Enter the required information.

Field Description

Name The names of the new user groups.

Tip
You can simultaneously create multiple user groups.
To do so, after typing the name, press Enter, and then type the next
name. User group names must be globally unique. If you enter a name
that already exists, it appears in the strike-through style.

6. Click Save.

Open user group page

You can open the user group page of a user group:

l From the settings.
l From the profile page of a member.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Open a user group page from the settings

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. In the tab pane, click Users → Groups.

» The user group table appears.
4. Click a group name.
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Open a user group page from the profile page of a member

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the tab pane, click Groups.
3. Click the name of a user group.

Edit a user group

You can edit a user group.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. In the tab pane, click Users → Groups.

» The user group table appears.
» The user group table appears.

4. Double-click a cell.
5. Make the necessary changes.
6. Click .

Add a user to a user group

You can add a user to a user group:

l While creating one or more users.
l From the user table.
Do this if you want to add a user to one or more user groups.
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l From the user group page.
Do this if you want to add multiple users to a single user group.

l From the user's profile page.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Add a user to a user group from the user table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3.  Perform one of the following steps:

o Double-click a cell in the Groups column.
o Hover your mouse over a cell in the Groups column and click .

4. Click in the field and start typing the name of the group.
5. Select the group from the suggestions.
6. If required, select Apply to visible rows.

This will add all visible users to the groups.

Tip You can filter the columns first to add a selection of users to the group.

7. Click .

Add a user to a user group from the user group page

1. Open a user group page.
2. Above the table, to the right, click Add.

» The Add to group dialog box appears.
3. Enter the required information.

Field Description

Users Choose one or more users.

Chapter 28

843

https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0635
https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0630
https://productresources.collibra.com/docs/collibra/latest/#cshid=DOC0630


Chapter 28

4. Click Add.
» The users are added to the user group and the users now appear in the table.

Add a user to a user group from the profile page

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the tab pane, click Groups.
3. Above the table, to the right, click Add.

» The Add to groups dialog box appears.
4. Enter the required information.

Field Description

Groups Choose one or more user groups.

5. Click Add.
» The user is added to the user groups and the groups now appears in the table.

Remove a user from user group

You can remove a user from a user group:

l By deleting a user.
l From the user table.
Do this if you want to delete a user from one or more user groups.

l From the user group page.
Do this if you want to delete multiple users from a single user group.

l From the user's profile page.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.
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Remove a user from a user group from the user table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3.  Perform one of the following steps:

o Double-click a cell in the Groups column.
o Hover the mouse pointer over a cell in the Groups column and click .

4. In the user group name, click .

5. If required, select Apply to visible rows.
This will add all visible users to the groups.

Tip You can filter the columns first to add a selection of users to the group.

6. When you have added the groups, click .

Remove a user from a user group from the user group page

1. Open a user group page.
2. Perform one of the following steps:

If you want to... Follow these steps

Remove a
single user from
user group

a. In the row of the user that you want to remove from the group, click .

» The Remove user from group dialog box appears.

Remove more
than one user
from the user
group

a. Select the check boxes in front of the groups from which you want to
remove the user.

b. In the action toolbar, click Remove.
» The Remove users from group dialog box appears.

3. Click Remove <number of selected users> users.

Remove a user from a user group from the profile page

1. Click your avatar, then Profile.
» Your profile page appears.
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2. In the tab pane, click Groups.
3. Perform one of the following steps:

If you want to... Follow these steps

Remove a user
from a single
user group

a. In the row of the group from which you want to remove the user, click
.

» The Remove from group dialog box appears.

Remove a user
from more than
one user group

a. Select the check boxes in front of the groups from which you want to
remove the user.

b. In the action toolbar, click Remove.
» The Remove from group dialog box appears.

4. Click Remove.

Delete a user group

You can delete one or more user groups.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. In the tab pane, click Users → Groups.
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» The user group table appears.
4. Perform one of the following steps:

If you want to... Follow these steps

Delete a single
group

a. In the row of the group that you want to delete, click .

» The Delete group dialog box appears.
b. Click Delete group.

Delete one or
more groups

a. Select the check boxes in front of the groups that you want to delete.
b. In the action toolbar, click Delete.

» The Delete <number> groups dialog box appears.
c. Click Delete <number> groups.

LDAP user and group management
The Collibra Console administrator can integrate Collibra Data Intelligence Cloud with
your company's LDAP servers. This administrator can synchronize user data as well as
group-related information. When LDAP is configured, authentication (credential checking)
is done directly on the LDAP server(s).

To synchronize with an LDAP server, the LDAP fields have to be mapped to the
corresponding Collibra fields and the LDAP server has to be configured correctly.

All the fields that are mapped to an LDAP user attribute are read only in Collibra. You
cannot change them in the UI.

You can recognize LDAP users

l by the LDAP column in the user table.
l on the user's profile page.
l in the user table, by the absent (reset password) and / (enabled/disabled)

user icons.

In the next sections, you can find how to use LDAP in Collibra.

LDAP synchronization

Synchronization is the process of importing all LDAP data in Collibra Data Intelligence
Cloud.
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Users can be synchronized in the following ways:

l Automatically: You can configure a CRON job to synchronize the Collibra users with
your LDAP.

l Manually: You can synchronize LDAP manually.

Individual user data is synchronized every time a user signs in to Collibra. If the user is
authenticated through LDAP, the user data is synchronized with Collibra. If the product
identifies the user as deleted from the LDAP server, the user is disabled in Collibra and
access is denied.

Tip To set up the LDAP connection correctly, ensure that you know how your LDAP
servers work and how they are structured, or ask your LDAP IT team for help

Synchronize LDAP users manually

You can manually synchronize your LDAP users to Collibra Data Intelligence Cloud
manually.

Prerequisites

You have a global role with the User Administration or the System Administration global
permission, for example Sysadmin.

Synchronize LDAP users from the Settings page

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click General.

» The general settings appear on the Activities tab page.
3. Click Synchronize with LDAP.

» The LDAP users are displayed in the table.
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Synchronize LDAP users from the Users or Groups page

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Do one of the following:

o In the tab pane, click Users.
» The user table appears.

o In the tab pane, click Users → Groups.
» The user group table appears.

3. Above the table, click Synchronize LDAP.
» The LDAP users are displayed in the table.

LDAP FAQ

What if the connection between Collibra DGC and the LDAP server is lost?

LDAP users cannot sign in to Collibra anymore. LDAP users who were logged in before
losing the LDAP connection can continue working until their HTTP session is closed.
When the LDAP synchronization job is triggered manually or automatically through
scheduling, a javax.naming.CommunicationException is thrown and displayed in the
logs.

What happens if a mapped field of an LDAP user cannot be found for a
certain entry on the LDAP server during the synchronization?

The field remains empty when the user is imported in the application. However, both the
username and email address are mandatory in Collibra. If either field is not mapped in the
configuration, LDAP cannot be enabled. Also, when searching for users on the LDAP
server, a filter is used to make sure that only users with a username and email address are
returned.

Are there any mandatory fields to map?

Yes. You have to specify at least a mapped field for the username and email fields. A user
who does not have both mapped field attributes is ignored during the synchronization.
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I'm seeing a lot of connection problems during the synchronization of users
and there are no users visible in Collibra DGC after synchronizing. What
could be the problem?

First check if the URL and credentials to connect to the LDAP servers are correct. If they
are, but the problem persists, it could be related to the paging.

Paging is only possible if your LDAP server supports it. It also requires the connection to
remain open during the synchronization process, to keep track of which page is to be
processed next.

Paging is enabled by default and can be disabled by entering '0' in the User page size
field.

Is the synchronization job really necessary?

No. If you disable the synchronization job, users can still be authenticated in the
application. Each time the user logs in, personal information is updated and reflected in
Collibra. However, a user's personal information is not visible until the first sign-in to the
application. This way the user is not known yet to the application. You also need the
synchronization job to enable Groups from LDAP. These are only synchronized in the job,
unless you have mapped the groups as an attribute of the user. Then the groups will be
taken in on the first encounter as the group of a user who is signing in.

What if usernames from LDAP don't comply with Collibra's username
requirements?

If a username coming from LDAP does not meet the username requirements of Collibra
then this user is skipped during synchronization.

To avoid this problem, ensure that your usernames from LDAP meet the Collibra
username requirements.

Collibra username requirements
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l General requirements:
o Uniqueness: Duplicate username are not allowed, regardless of case

Example usernamecase and UserNameCase are considered duplicate

o No leading or trailing spaces
o No empty usernames
o Maximum of 255 characters

l Character limitations: Usernames may only contain characters in the following
Unicode categories:

o Letter
o Number
o Symbol
o Punctuation
o Non-spacing marks

Profile page
The profile page of a user contains information about that user.

You can always see all information on your own profile page. On the profile pages of other
users, you see basic information such as their name and contact information. If you have a
global role with the User Administration or the System Administration global permission,
for example Sysadmin, you can see all information for all users.

Full profile page

The view bar contains important information about the user, such as the name, license
type, required license type and email address. It contains buttons to edit the user's
name and reset the password.

The profile page contains the following tab pages:
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Tab page Description

Overview The overview page contains general information such as the user's
account information, mail notification settings and contact information.

Groups The groups page contains the groups of which the user is a member and,
with the right permissions, allows you to add the user to or remove the
user from groups.

Responsibilities The responsibilities page contains the responsibilities that are assigned to
the user.

History The history page contains the history of the user's actions.

Activities The activities pages contains the list of your activities.

Mentions The mentions page contains a list of all comments in which you are mentioned.

Example

Basic profile page

The view bar contains some basic information about the user, such as their name and
email address.

The profile page contains the following tab pages:
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Tab page Description

Overview The overview page contains the user's contact information.

Groups The groups page contains the groups of which the user is a member.

Responsibilities The responsibilities page contains the responsibilities that are assigned to
the user.

Example

Open a profile page

As a regular user, you can open your own profile page. Administrators can open
everybody's profile page.

Prerequisites

If you want to open the profile page of another user, you have a global role with the User
Administration or the System Administration global permission, for example Sysadmin.

Open your own profile page

1. Click your avatar, then Profile.
» Your profile page appears.
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Open another user's profile page

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
3. Click the username of the user whose profile you want to open.

Edit user details

You can edit your own profile such as the application language, email notifications and
contact email address on your profile page. You can also reset your password, you receive
instructions to do so by email.

Prerequisites

If you want to edit the user details of another user, you have a global role with the User
Administration or the System Administration global permission, for example Sysadmin.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the upper-right corner, click Edit.
» The Edit dialog box appears.
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3. Enter the required information.

Field Description

First name Enter the first name of the user.

Last name Enter the last name of the user.

Email Enter the email address on which the user receives all communication from
Collibra, such as the registration mail and notifications.

4. Click Save.

Edit the user account settings

As a regular user, you can edit the settings of your own user account on your profile page.
As an administrator, you can also edit other users' settings.

Prerequisites

If you want to edit the user account settings of another user, you have a global role with the
User Administration or the System Administration global permission, for example
Sysadmin.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the Account section, click .
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3. Enter the required information.

Field Description

Username Enter the username.

Collibra username requirements
o General requirements:

n Uniqueness: Duplicate username are not allowed, regardless of
case

Example usernamecase and UserNameCase are
considered duplicate

n No leading or trailing spaces
n No empty usernames
n Maximum of 255 characters

o Character limitations: Usernames may only contain characters in the
following Unicode categories:
n Letter
n Number
n Symbol
n Punctuation
n Non-spacing marks

Application Lan-
guage

Choose the interface language.

As an administrator, you can add or edit interface languages.

Note From version 2022.11 onwards, Collibra takes the default
language of your browser into account to select the interface text
language of some sections. Collibra now also has translations of some
interface text available out of the box. Consequently, you can no longer
edit that interface text, nor translate it into unsupported languages. This
includes the interface text of Usage Analytics, Data Marketplace and the
Homepage.

4. Click Save.
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Edit the contact information

As a regular user, you can edit contact information of your own user account on your
profile page. As an administrator, you can also edit other users' contact information.

Note You can also add new contact information.

Prerequisites

If you want to edit the contact information of another user, you have a global role with the
User Administration or the System Administration global permission, for example
Sysadmin.

Edit contact information from a profile page

1. Click your avatar, then Profile.
» Your profile page appears.

2. Perform one of the following steps:
o In the Contact section, click .

Do this to edit the existing fields.
o In the Contact section, click Add.
Do this to add a new field, or edit the existing fields.

Note If you edit the email address, a notification email is sent to the old email
address.

3. Edit the contact information.
4. Click Save.

Edit contact information from the user table

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
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3.  Perform one of the following steps:
o Double-click a cell in the E-mail column.
o Hover your mouse over a cell in the E-mail column and click .

Note If you edit the email address, a notification email is sent to the old email
address.

4. Click in the field and type the new email address.
5. Click .

Edit the email notification settings

You can edit the email notification settings for your own user account. As an administrator,
you can also edit other users' notification settings.

If you enable notifications, you will be notified via email whenever changes are made to
assets for which you have been assigned a responsibility.

Note Only the 20 most recent changes for a given asset are shown in the
notification email.

Prerequisites

If you want to edit the email notification settings of another user, you have a global role
with the User Administration or the System Administration global permission, for example
Sysadmin.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the Notifications section, click .
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3. Select or clear the necessary check boxes.

Field Explanation

Notify me of content
updates

Specify whether or not you want to receive email notifications.

If you select this option, email notifications will be sent to the email
address shown in the Contact section of your Profile page, at the
specified frequency.

Days of the week Receive email notifications only on the days you specify.

Monthly Receive a summary email once a month.

4. Click Save.

Edit the maintenance announcement settings

You can edit the maintenance announcement settings on your profile page.

If you enable maintenance announcements, you receive notifications in Collibra about
scheduled maintenance.

Prerequisites

Usage statistics are enabled. Contact Collibra support if this is not the case.

Steps

1. Click your avatar, then Profile.
» Your profile page appears.

2. In the Scheduled Maintenance Notifications section, click .

3. Select or clear the check box.
4. Click Save.

User licenses
A user license is the overall authorization for a user to perform certain actions in Collibra.
What a user can actually do in Collibra depends on the global roles and the responsibilities
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of the user.

License types
The license type defines the actions a user is authorized to carry out. There are currently
two license types:

License type Description

Read-only A Read-only license is the basic license type. It allows a user to:

l View resources.
l Collaborate using social features such as comments, tags and ratings.

Note It does not allow users to create, edit or delete resources.

You can view which global and resource permissions require a Read-only license, in

Settings.

Standard A Standard license is the enhanced license type. It allows a user to perform all actions
that require Read-only permissions, and create, view, edit and delete resources, such
as:

l Create, edit and delete assets.
l Create, edit and delete communities, domains and responsibilities.
l Create and share (anyone’s) application, community and domain views.
l Create and share (anyone’s) dashboards.
l Bulk import assets through Excel, CSV or API (Connect).
l Manage and participate in workflows.
l Edit the operating model, for example create, edit and delete asset types.
l Manage users, user groups, roles and permissions.

You can see which global and resource permissions require a Standard license, in

Collibra Settings.

The maximum number of licenses is defined in the license file.

Warning If your organization occupies more licenses than the maximum (as
stipulated in your contract and identified in the license file), your administrator will
receive a warning, but all users will retain access to all Collibra functionality, as
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determined by their roles and responsibilities. Occupying more licenses than the
maximummay have financial and legal implications.

Access to Collibra Console does not require a license.

License usage
A User is a specific individual that you authorize to use the Collibra software, regardless of
whether such individual is using the Collibra software at any given time. Each individual
shall be assigned a unique User identification. Multiple individuals may not share the same
User identification. In addition to all individual Users, all users of a non-human operated
device shall be counted as User if such device has access to the Collibra software in
accordance with User roles and responsibilities. Users are limited to the number set forth
in the respective Order, and access to the Collibra software will be restricted to such
number of Users through a license management key provided by Collibra. If a User no
longer requires access to the Collibra software, you may deactivate that individual and you
can designate a new individual as a User of the Collibra software without incurring
additional fees.

Required license type
For each user, Collibra calculates the required license type.

The required license type is:

l The license type that a user needs to carry out the actions available to the user via
the roles and responsibilities that were assigned to the user.

l The maximum license type of any permission included in a global role or resource
role of that user.

If none of the permissions require a Standard license, the required license of the user is
Read-only.
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Tip You can see the required license type of all permissions in the Settings. You
can also see the required license types of all permissions and the packaged global
roles and resource roles in the administration guide:

l Permissions of the packaged global roles
l Permissions of the packaged resource roles

Effective licenses
In the user table, the Effective licenses are the number of Standard licenses in use both
by permission and by workflow participation. Workflow participation for licensing is logged
for each user every time they participate in or start a workflow within a calendar month.
This number is then reset at the start of the next month. You can see when a user last
participated in a workflow by adding the Latest workflow participation column to the user
table.

Workflow participation

When a user participates in a workflow they will retain a Read-only license but be counted
as a Standard license. You can see when a user last took part in a workflow if you add the
column, Latest workflow participation to the users table.

Examples

Users with a Read-only license will only be counted for that specific calendar month’s
effective licenses when they have participated in a workflow during that calendar month.
For example, if a Read-only user has only participated in a workflow in September, then
they will not be counted for October, or any other calendar months’ effective licenses, as
long as there is no workflow participation.

During the month, the Effective license count in the panel above the user table will
continue to grow as workflow participation is carried out by users with a Read-only license
by permission are counted as Standard users for that month (to enable them to participate
in workflows). The number listed for effective license at the end of the month is then
captured and reset at the start of the next month. For example, the effective number is 200
at the start of September, then there are 20 Read-only users with workflow participation by
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mid September, so that the number will show as 220. If there are another 30 new Read-
only users (unique from the last 20 users) with workflow participation by the end of
September, then the number will show as 250 at the end of the month. At the start of
October (on the 1st of the month), it will be reset back to 200 and begin to increase again
with the number of new Read-only users with workflow participation.

Actions
An administrator can view the available number of licenses per license type.

View used licenses
As an administrator, you can view how many licenses of each type are currently in use.
Note The information in this table is, by default, refreshed nightly.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Users and groups.

» The users and groups settings appear on the Users tab page.
» The number of Standard licenses by workflow participation & permissions (Effect-
ive) and the number of Standard licenses by permissions only (Required) are shown
above the user table.

3. If required, you can export these numbers by clicking .

» A CSV file will download.

Note You can add the column, Latest workflow participation to see when a user last took
part in a workflow, as this participation will require a Standard license.
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Number Description

Standard License refers to the type of license. User with the Standard license
can create, edit and delete resource as well as participate in workflows. See
the User licenses page for details.

The Effective licenses are the number of Standard licenses in use both by
permission and by workflow participation. See the User licenses page for
details.

The number of licenses in use versus the number of available license.

The Required licenses are the number of Standard licenses in use by per-
mission only. See the User licenses page for details.

The number of licenses in use versus the number of available license.

Use this icon to export a CSV file with the monthly totals for Effective and
Required licenses.

View the permissions per license type
You can see which global and resource permissions require which license type, in

Settings.

Tip You can also see the permissions of the packaged global roles and resource
roles in the admin guide:

l Permissions of the packaged global roles
l Permissions of the packaged resource roles

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Roles and permissions.

» The roles and permissions settings appear on the Global roles tab page.
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3. Do one of the following:
o In the tab pane, click Global Permissions, to view the global permissions and
their required license type.

o In the tab pane, click Resource Permissions, to view the resource permissions
and their required license type.

» The required license type is shown in the column Required license.

Standard license consumption
A Standard license in Collibra allows the holder to interact with the platform more,
performing more tasks and activities than someone with a Read-only license can.

Occupying a standard license seat

Each individual permission in Collibra requires either a Standard or a Read-only license.
This applies to both global and resource permissions. Which license a given permission
requires is visible under Settings →Global Permissions or Settings → Resource
Permissions.

A role corresponds to a set of permissions, if the role contains at least one permission that
requires a Standard license, then the role requires a Standard license.

The aggregate license requirement for each role is visible under Settings →Global Roles
or Settings → Resource Roles.

Roles are assigned to users, either directly or through a group. If the user has at least one
role that requires a Standard license, then the user is occupying a license seat. This is
known as the user’s required license.

Global roles are assigned in Settings →Global Roles and resource roles are assigned on
community, domain or asset level (referred to as assigned responsibilities).

With the 2021 license model, a user with a Read-only required license participating in a
workflow during a given calendar month will also effectively occupy a Standard license
until the end of that month. This is known as the user’s effective license.
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Verify why a specific user requires a Standard license

If you want to check why a certain user is being counted as occupying a Standard license
you can follow these steps:

Global roles

1. Go to Settings → Users and Groups.
2. Find the user that requires a Standard license and click on their name.
3. On the user’s profile page click the Groups tab to see the list of groups the user

belongs to.
4. In a separate browser, go to Settings →Global roles.
5. Each listed role indicates whether it requires a Standard or Read-only license.
6. Now verify if the user or one of their groups is assigned to a global role that

requires a Standard license
» 1st browser show the user’s Groups tab.
» 2nd browser shows the Global Roles page.
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Resource roles

1. Go to Settings → Users and Groups.
2. Find the user that requires a Standard license and click on their name.
3. On the user’s profile page click the Responsibilities tab and verify if the user has

a role that requires a Standard license.
4. In a separate browser, go to Settings → Resource roles.
5. Each listed role indicates whether it requires a Standard or Read-only license.
6. Now verify if the user or one of their responsibilities is assigned to a resource role

that requires a Standard license.
» 1st browser show the user’s Responsibilities tab.
» 2nd browser shows the Resource Roles page.

Update a Standard license to a Read-only license

If you want to update a user from a Standard license to a Read-only license, you need to
remove any roles and permissions that require a Standard license.

You can do this using the steps indicated above for verifying why a specific user requires a
Standard license.

Note For customers that have SSO enabled, depending on the configuration of the
system, removing a user from a group may require a change in the connected LDAP
system.
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Services configuration
On the Services configuration settings page of the Collibra settings, you can edit settings
that affect your entire platform. For example, you can edit the help menu and configure the
search feature.

Note The services configuration in the Collibra settings is the same as the
DGC service settings that require the ADMIN role in Collibra Console. By default,
you do not see this section. Contact Collibra support if you want to use this section.

The Collibra configuration includes the following options:

General settings
The general settings of Collibra Data Intelligence Cloud.

Setting Description

Default locale
(Requires restart)

The default locale for new users. It has to contain a language code and may
contain a country code.

l The language has to be an ISO language code.
l The country has to be an ISO country code.
Examples: pl, en_US, nl_BE.

Enable view
rights

l True (default): The view permissions feature is enabled.
l False: The view permissions feature is disabled.

Show target asset
type above relation
table

l True (default): Show the asset type of the target asset in the title of rela-

tion tables on an asset page. The target asset can be either the head or the
tail of the relation, depending on which asset page you have open.

l False: Hide the asset type of the target asset.

The default value is true.

Help Menu
The configuration of the Help menu in Collibra Data Intelligence Cloud.
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Setting Description

Links The list of links in the help menu.

Menu item
name

The name of the menu item as it will appear in Collibra Data Intelligence
Cloud's help menu.

Menu index The position of the menu item in the help menu. The top position starts with
the value 1.

Menu URL The target URL of the menu item.

Show admin
only

l True: The menu item is only visible to users with the Sysadmin role.
l False: The menu item is visible to every user.

Email configuration
The configuration of email notifications.

Note In a Collibra Data Intelligence Cloud environment, you cannot update the
email server settings, such as host and port. For more information, see Collibra
Data Intelligence Cloud infrastructure.

Setting Description

Default schedule
(Requires restart)

The Cron schedule to send emails only at specific times. With this, you can send
emails in batches and avoid an overload of mails.

Keep in mind that these emails are only workflow emails and have nothing to do with
the notification schedule.

If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops
responding.

Template map The location of template emails.

From address The email address used as the sender of all outgoing emails.

Contact Collibra support to change the From address, see also Email configuration.

Chapter 28

869

co_quartz-cron-syntax.htm
https://support.collibra.com/
co_email-configuration.htm


Chapter 28

Setting Description

Email address
change notification

This setting is only
available for the
ADMIN role.

If you change the email address to which notifications are sent, notification of
the change is sent to the old email address.

Notifications
The configuration of notification emails to users.

Note These settings can be overridden for every user in the preferences.xml file.

Setting Description

Notification days The days of the week on which Collibra sends notifications. The days are represented
by numbers from 1 to 7, where 1 represents Sunday.

Per row you can add one day.

Daily roles The roles that receive notifications on the days defined in Notification days.

Enable monthly
notifications

l True: The users receive a monthly summary.
l False (default): The users do not receive a monthly summary.

Roles for monthly
notifications

The roles that receive monthly notification emails. This is only relevant if
Enable monthly notifications is True.

Hyperlinking configuration
The configuration of automatic hyperlinks. When you change a setting, you have to rebuild
the hyperlinks.
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Setting Description

Enable hyper-
linking

l True: Hyperlinks are created automatically.
l False (default): Hyperlinks are not created automatically.

For more information about automatic hyperlinks, see Hyperlinking.

Warning If you enable this setting, the performance of Collibra can
decrease.

Enable case sens-
itivity

l True: Hyperlinks are case-sensitive.
l False (default): Hyperlinks are not case-sensitive.

Note If you edit this setting, you have to reindex Collibra.

Excluded asset type
IDs

The list of asset types that are ignored by automatic hyperlinking. You can enter
multiple asset type IDs, separated by commas.

Excluding assets reduces the amount of hyperlinks, which improves performance.

Tip We recommend that you exclude technical asset types such as Column,
Field, Table, Code Value and Code Set.

Note If you edit this setting, you have to reindex Collibra.

Recommender configuration
The configuration of the recommender.
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Setting impacts Description

Catalog recom-
mender enabled

All recom-
mendations

l True (default): The "Data sets you might like"

section is included on the Data Catalog Home
page. This section shows data sets you might be
interested in, as determined by the recommender,
which takes into account your data sets and the
data sets of similar users.

l False: The "Data sets you might like" section is

not included on the Data Catalog Home page.

Data set recom-
mender execution
time

Recommendations
of data sets to users

The schedule (CRON job) by which the data set
recommender looks for recommended data sets for a user.

By default the data set recommender does this every night.

Asset recom-
mender execution
time

Recommendations
of business assets to
data assets

The schedule (CRON job) by which the asset recom-
mender looks for suggested relations between busi-
ness assets and data sets.

Data set matcher
execution time

Data set matcher The schedule (CRON job) by which the data set
matcher looks for similar data sets.

Data set similarity
threshold

Data set matcher The amount of business assets that have to be related to
two data sets before the data sets are considered to be
similar.

This percentage is expressed by a decimal where 1,00
equals 100%.

Example
If this value is 0.3 and at least 30% of the related business
assets are related to both data sets, they are considered to
be similar.

Duplicate schema
threshold

Schema matcher The amount of assets that have to be related to both
schemas before the schemas are considered to be similar.

This percentage is expressed by a decimal where 1,00
equals 100%.
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Setting impacts Description

Fuzzy vs exact
matching strategy
for business assets

Recommendations
of business assets to
data sets and of busi-
ness assets to
column assets

The percentage that determines to what extent assets with
a similar name become more important.

The ranking in the search engine results always has an
impact on the suggestion score. However, similarity
between the asset names can also be taken into account. If
you decrease this percentage, the ranking of the search
results becomes more important for the suggestion score,
while the similarity between the asset names becomes less
important. If you increase the percentage, assets with
similar names will receive a higher suggestion score.

This percentage is expressed by a decimal where 1,00
equals 100%. You can enter a value greater than 1,00.

Recommendation
weights for data
sets

Recommendations
of data sets to users

An ordered comma-separated list of values that define the
importance of properties for recommendations. The order
of the values reflects the importance of the value.

This setting is only used for data set recommendations if
your Collibra does not yet have enough data for relevant
results from the active recommendations algorithms.

Possible values:

l CERTIFIED: Data sets that are certified are con-
sidered more relevant.

l POPULARITY: The number of visits to the data
set page.

Active recom-
mendation
algorithms

Recommendations
of data sets to users
and of business
assets to data sets

A comma-separated list of algorithms that calculate
recommendations. By default, all available algorithms are
listed.

Possible values:

l BASELINE
l USER_MEAN
l IICF (Item-Item Collaborative Filtering)
l SLOPE_ONE
l WEIGHTED_SLOPE_ONE
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Setting impacts Description

Data set elements
threshold

Recommendations
of data sets to users

The maximum number of elements per data set that the
recommender will use to train the model. The data set
elements are taken randomly.
Lowering this number can prevent out-of-memory issues
but also impacts the accuracy of recommendations for
large data sets.

Warning If you create an invalid Cron pattern, Collibra Data Intelligence Cloud
stops responding.

Search index configuration
The configuration of the search index.

Setting Description

UI search
appends wildcard

l True (default): A wildcard (asterisk) is automatically added to each

search query. An asterisk is not added in the following exceptions:
o If the query contains a tilde (~).
o If the query ends with a quotation mark (").

Note This applies only to queries via the user interface. A wildcard is not
added automatically for REST API queries.

l False: No wildcard is added to the search query.

Maximum batch
size

The amount of resources scanned in one go for the search query.

The default value is 5,000. The maximum value is 30,000.

Maximum batch
size for relations

Maximum batch size for relations reindex.
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Setting Description

Stop words

(Requires restart)

A list of stop words that are ignored as tokens for the index.

The default list of English stop words includes:

a, an, and, are, as, at, be, but, by, for, if, in, into, is, it, no, not, of, on, or, such, that, the,
their, then, there, these, they, this, to, was, will, with

If you choose not to create your own list of stop words, the default list applies.

If you create your own list of stop words, you have to:

1. Reindex Collibra Data Intelligence Cloud.
2. Restart the environment to apply your changes. For more information, go to Stop an

environment and Start an environment.

Relation-based
search

l True (default): The Data Marketplace search considers certain assets

and relation types between assets. As a result, your search results not only
include assets that directly match the search criteria, but also assets that
match the criteria through specific relation types.

Example A column named Order is included in a data set named
Customer. If the relation-based search is enabled and you search for
Order in Data Marketplace, then the data set Customer appears in the
search results because the data set contains this column.

Tip For more information about this feature and the default relation types,
go to Filtering and searching based on relations in Data Marketplace.

l False: The Data Marketplace search results do not consider relations.

After you enable this setting, you must reindex Data Marketplace relations or reindex
Collibra completely.

Note In new Collibra environments, this setting is enabled by default. In
upgraded Collibra environments, the previous status of this setting is retained.

Tokenizer
The configuration of the tokenizer of the indexing mechanism. If you edit these settings,
you need to restart and reindex your environment.
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Setting Description

Type The tokenizer that is used. Currently two tokenizers are supported:

l Standard (default): This tokenizer uses the word break rules from the
Unicode Text Segmentation algorithm, as specified in Unicode Standard
Annex #29.

l Character: This tokenizer sees words as groups of all alphanumeric char-
acters together with a configurable list of extra characters. This can be
used if you know for sure which characters should keep certain words
together. For example, if you want to keep words with a dash ( - ) together,
you have to add the dash in the allowedCharacters parameter.

Parameter map The allowed characters if the Type is Character.

l Field key: This field has to contain allowedCharacters.
l Field value: The concatenated list of characters that does not split strings
into separate tokens. For example, the concatenated list -' allows dashes
and apostrophes in tokens.

Boosting
The configuration of the boosting function.

Setting Description

Asset The boost factor of assets.

Class Match The boost factor of data classes.

Community The boost factor of communities.

Domain The boost factor of domains.

User The boost factor of users.

User group The boost factor of user groups.

Name The boost factor of names.

Comment The boost factor of comments.
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Setting Description

Tag The boost factor of tags.

Attribute boost
map

The boost factor of attribute types.

l Field key: The attribute type ID.
l Field value: The boost factor of the attribute type.

Display exact
match of name as
first

l True (default): If the name of an asset is exactly the same as the search

text, put it at the top of the search results regardless of boost factors.
l False: Use the regular search order, taking into account boost factors.

Asset boost map The boost factor of asset types.

l Field key: The asset type ID.
l Field value: The boost factor of the asset type.

Partial exact match
enabled

Enables partial exact matching while searching for multi word phrases.

l True (default): For multi-word search text, the search engine considers

the exact match percentage with the resource name, when ordering the res-
ults.

Example You enter search text "scheduled maintenance". Two
example assets are ordered as follows:
a. An asset named "daily scheduled maintenance", as two of the

three words (66%) match exactly.
b. An asset named "daily scheduled maintenance revised", as two

of the four words (50%) match exactly.

l False: The exact match percentage is not taken into account in the

score calculation.

Slow logs configuration
The configuration of the slow logs function.
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Setting Description

Indexing
threshold

The time limit, in milliseconds, after which an index query is logged in Elasticsearch.

If the value is set to 0 (zero), all index queries are logged.

Changes to this setting require a full reindex of your Collibra Data Intelligence Cloud
environment.

Fetching
threshold

The time limit, in milliseconds, after which a fetch query is logged in Elasticsearch.

If the value is set to 0 (zero), all fetch queries are logged.

Changes to this setting require a full reindex of your Collibra Data Intelligence Cloud
environment.

5.4 Search Event Log configuration
The configuration of indexing.

Setting Description

Asynchronous
indexing

l True (default): Enable asynchronous indexing.
l False: Disable asynchronous indexing.

Note In new Collibra environments, this setting is enabled by default. In
upgraded Collibra environments, the previous status of this setting is retained.
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Setting Description

Automatic rela-
tion indexing

This setting keeps Data Marketplace up to date if relations between assets are created,
updated, or removed.

Example If the relation between asset A and asset B changes and this relation
is used in relation-based filters or relation-based search, then the Data
Marketplace search considers this change.

l True: Automatically index certain relation type changes between assets

so that the relation information remains consistent between Collibra and
Data Marketplace. The relation types that are considered are the relation
paths used by relation-based search and filters. If such a relation type
between assets changes, the change is reflected in the search index after
some time.

Note Collibra does not automatically reindex relations between
assets for relation paths that end with an attribute. You need to
manually reindex the relations.

Warning If you select True, you must also enable the
Asynchronous indexing setting because every relation change
results in an event that is processed via asynchronous indexation.

Tip For more information about this feature and the default relation
types, go to Filtering and searching based on relations in Data
Marketplace.

l False (default): Changes to relations are not automatically indexed. This

can cause inconsistencies between Collibra and Data Marketplace. You
can, however, manually reindex Data Marketplace relations.

Upload configuration
The configuration of the file upload service.

The file upload restrictions apply to the following actions in Collibra:
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l Importing and exporting assets and complex relations.
l Uploading attachments.
l Importing and exporting CMA files in the Migration feature.

Setting Description

Max file size The maximum file size in bytes for uploads.

l For cloud environments, the default value is 512 MB or 536,870,912 bytes.
This value cannot be changed.

l For on-premises environments, the default is 10 MB or 10,485,760 bytes.

Max per day The maximum number of uploads per user per day.

l For cloud environments, the default value is 1,235,465 uploads. This value
cannot be changed.

l For on-premises environments, the default is 150 uploads.

Accepted content
types

The MIME type names of the files you want to allow for uploads.

For example, type application/pdf for PDF files.

Statistics configuration
The configuration of statistics.

Setting Description

Buffer size The maximum amount of statistics entries that the buffer can contain before saving
them in the database.

The default value is 10.

Buffer flush time The maximum amount of time in milliseconds to keep statistic entries in memory before
saving them in the database.

The default values is 10,000.
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Cron map List of statistics, listed by their Cron name, and a Cron interval.

These are the default values:

Field key Field value

workflow-task 0 59 23 * * ?

active-users 0 0/15 * * * ?

term-count 0 59 23 * * ?

vocabulary-
count

0 59 23 * * ?

page-hit 0 0 * * * ?

task-count 0 0 * * * ?

If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops
responding.

Import configuration
The configuration for imports.

Setting Description

Rebuild hyper-
links after import

l True (default): Automatically rebuild the hyperlinks after an import.
l False: Do not rebuild the hyperlinks after an import.

Asset respons-
ibilities support

l True: Enable importing responsibilities at asset level.
l False (default): Disable importing responsibilities at asset level.

Warning Setting specific responsibilities on a large number of resources will
affect the performance and stability of the system.
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Setting Description

Import UI v2 l True: Use the original import interface for importing assets and complex

relations.
l False (default): Use the new import interface for importing assets and

complex relations, with improved usability and performance.

Excel import configuration
The configuration of Excel import.

Setting Description

The default CSV
separator char-
acter

The default separator character of the CSV fields for complex relations.

The default CSV
quote character

The default quote character of the CSV fields for complex relations.

Number of rows per
chunk of data

When importing views, the database is called repeatedly, each time importing a chunk
of data from the import file. This option defines how many rows each chunk of data can
contain.

Lower values reduce the burden on memory. Higher values require more memory, but
may slightly increase the speed of the export.

The default value is 5,000.

Excel export configuration
The configuration of Excel export.

Setting Description

The default CSV
separator char-
acter

The default separator character of the CSV fields for complex relations.
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The default CSV
quote character

The default quote character of the CSV fields for complex relations.

Number of rows per
chunk of data

When exporting views, the database is called repeatedly, each time fetching a chunk of
data to build the export file. This option defines how many rows each chunk of data can
contain.

Lower values reduce the burden on memory. Higher values require more memory, but
may slightly increase the speed of the export.

The default value is 5,000.

CSV export configuration
The configuration of CSV export.

Setting Description

Always use
quotes

l True: Use quotes for every cell in the CSV.
l False (default): Only use quotes when necessary.

Number of rows per
chunk of data

When exporting views, the database is called repeatedly, each time fetching a chunk of
data to build the export file. This option defines how many rows each chunk of data can
contain.

Lower values reduce the burden on memory. Higher values require more memory, but
may slightly increase the speed of the export.

The default value is 5,000.

API call logging
The configuration of the API call logging.

Setting Description

Enabled l True: API call logging is enabled.
l False (default): API call logging is disabled.
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Maximum num-
ber of log entries
(Requires restart)

The maximum number of API calls to store in the database. Once this number is
reached, the oldest records are overwritten.

The default value is 1,000,000.

Pattern duration
list

The list of methods and a corresponding minimum duration time. The min-
imum duration time is the minimum time before the method is stored in the
database.

Minimum dur-
ation

The time in milliseconds that an API call must last before it is logged.

Method pat-
tern

The method that you want to log in the database. For each pattern that you
want to log, you have to add a new pattern.

System metrics
The configuration of metric collection.

Setting Description

Enable (Requires
restart)

l True (default): Metric collection is enabled.
l False: Metric collection is disabled.

Enable JVMmet-
rics (Requires
restart)

l True (default): JVM metric collection is enabled.
l False: JVMmetric collection is disabled.

Enable advanced
metrics (Requires
restart)

l True: Advanced metrics collection is enabled. Enabling this option has a

negative impact on the performance of your environment.
l False (default): Advanced metrics collection is disabled.

Enable minimal
monitoring (Requires
restart)

l True: Monitoring of the metrics is enabled.
l False (default): Monitoring of the metrics is disabled.

Security configuration
The configuration of security.
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Setting Description

X-Frame options
(Requires restart)

The content of the HTTP-header X-Frame-Options. This is set on all rendered

pages and is used to avoid clickjacking attacks. By default, only pages with the same
origin can use the rendered pages in a frame.

Limit user ses-
sions

l True: A user can only open one session.
l False (default): A user can open multiple sessions.

Office research
guest access

l True: The Office research integration is always allowed guest access

via REST, regardless of the general Guest access setting.
l False (default): The general Guest access setting is kept.

Note Currently, The Office research integration is only available when Collibra
Data Intelligence Cloud is publicly available, which is why this override setting
is necessary.

Prevent
advanced html
features in text
dashboard

Text widgets can contain full HTML. However, this means an attacker could potentially
execute an XSS attack by injecting malicious HTML. For more information, see the
Troubleshooting section.

l True: Potentially dangerous HTML elements are removed from text

attributes when you save the text field.
l False (default): No HTML elements are removed from text attributes when you

save the text field.

Note
If you enable this setting, the following HTML elements are deleted when you
save:

l script (including JavaScript)
l svg
l frame
l frameset
l iframe
l any event handlers

Guest access

This setting
requires the
SUPER role.

l True: Anyone that can access the URL, has viewing rights to the sys-

tem.
l False (default): The user is asked to sign in before having access to any

data.
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Enable schema
introspection

l True: Schema fields are shown during an introspection.
l False (default): Schema fields are hidden during an introspection.

Enable customer
validation func-
tions

l True (default): Groovy scripts with custom validation functions can be

loaded.
l False: Groovy scripts with custom validation functions cannot be

loaded.

LDAP
The configuration of an LDAP server to handle the authentication.

Setting Description

Enable LDAP
integration
(Requires restart)

l True: The LDAP integration is enabled.
l False (default): The LDAP integration is disabled.

Sync after restore l True (default): LDAP data is synchronized with Collibra when an initial

data set is bootstrapped.
l False: LDAP data is synchronized with Collibra only when the LDAP syn-

chronization job is triggered.

User page size The page size that is used when retrieving users during synchronization.

The default value is 500. You can set it to 0 to disable paging.

Note This is a global setting. If you are working with multiple LDAP servers,
only the value for the main server is taken into account.

Group page size The page size that is used when retrieving groups.

You can set it to 0 to disable paging.

Note This is a global setting. If you are working with multiple LDAP servers,
only the value for the main server is taken into account.
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Setting Description

Time limit Specifies the time limit in milliseconds for all LDAP searches.

The default value is 120,000.

You can set it to 0 to disable the time limit.

Tip
l If you get Time limit Exceeded error messages, increase the
default value or check why the LDAP search takes too long.

l We recommend that you modify the User page size and Group
page size settings before you modify this setting.

Sync job enabled l True (default): The synchronization job is enabled.
l False: The synchronization job is disabled.

Sync job cron The schedule to perform an LDAP synchronization (CRON).

The default value for this setting is daily at midnight.

If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops
responding.

User field map-
ping

The configuration mapping of all the user fields. This determines which LDAP
field ismapped to which user field. Empty fields are ignored during the syn-
chronization.

Username The unique user ID in the LDAP, typically UID. This is a mandatory field.

Email The corresponding email field in the LDAP directory. This is a mandatory field.

First name The first name field in the LDAP directory.

Last name The last name field in the LDAP directory.

Middle name The middle name field of the LDAP directory, this is usually givenName.

Enabled Indication whether a user is active or inactive in LDAP.
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Setting Description

Language The language and locale of the user. It has to contain a language code and may
contain a country code.

l The language has to be an ISO language code.
l The country has to be an ISO country code.

Examples: pl, en_US, nl_BE.

Group The LDAP property that defines to which groups the user belongs. If there is a group
entry in the LDAP directory, use the Group field mapping settings.

Additional
email list

An additional email list.

Instant mes-
saging fields

The mapping for the user's IM locations.

AIM The mapping for the user's AOL IM account.

Google
Talk

The mapping for the user's Google Talk IM account.

Icq The mapping for the user's ICQ IM account.

Jabber The mapping for the user's Jabber IM account.

Messenger The mapping for the user's Live Messenger IM account.

Skype The mapping for the user's Skype IM account.

Yahoo Mes-
senger

The mapping for the user's Yahoo Messenger IM account.

Website map Enter the field value and field key to map a social media website.

Phone The mapping for the user's phone.

Fax The mapping for the user's fax number.

Mobile The mapping for the user's mobile number.

Pager The mapping for the user's pager number.
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Setting Description

Private The mapping for the user's private number.

Work The mapping for the user's work number.

Other The mapping for any other phone number for this user.

Home
address

The mapping for the user's home address.

Street The mapping for the user's street.

Number The mapping for the user's number.

City The mapping for the user's city.

Post code The mapping for the user's postal code.

State The mapping for the user's state.

Country The mapping for the user's country.

Work address The mapping for the user's work address.

Street The mapping for the user's street.

Number The mapping for the user's number.

City The mapping for the user's city.

Post code The mapping for the user's postal code.

State The mapping for the user's state.

Country The mapping for the user's country.

Gender The mapping information for the user's gender.

Mapping The attribute key for the gender value. If the content equals one of the male or
female mappings, the user will be saved as male or female. Otherwise a
default of UNKNOWN will be used.
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Male value The value for male users.

Female
value

The value for female users.

Group field map-
ping

Groups can be defined as a separate structure or as a userField. The following
section allows you to sync with a group structure that is unrelated to the user
structure.

Group name
field

The name of the group to use in the application.

Users field The user DNs that are member of the group.

Servers The Collibra parameters to map with your LDAP server parameters.

The URL or IP address to the LDAP server, for example ldap://ldap.y-
ourcompany.com:389 or ldaps://ldap.yourcompany.com:636.

The DN of the administrator user that is used for authentication, for example
admin.

The password of the administrator user.

The base DN for when you are working with relative DNs. This base DN is
used for all LDAP look-ups.

The base DN of where the LDAP users for Collibra are located. If a base has
been specified, it is used as a prefix for this user base. Subtree search is used,
so all DNs located below are searched for matching users.

The filter that specifies which users can authenticate in the application. By
default, all the objects found in the user base are selected, including the root.
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The filter that specifies which users are imported by the synchronization job. The users
have to be the same as, or a subset of, the Authentication user LDAP filter.

If you provide no value for this setting, the same filter as specified for the
Authentication user LDAP filter setting is used. That allows you to synchronize only
the users that have to have access to the application, even if they have not logged in
yet. Users in the Authentication user LDAP filter are synchronized each time they
authenticate and are only available after the first sign-in to the application. This is the
default setting.

The authentication mechanism for authenticating users on the LDAP servers.

l True: The LDAP context is destroyed immediately. When using TLS,

some servers require the connection to be shut down by the client before
the LDAP context is destroyed.

l False (default): The LDAP context is not destroyed immediately.

Specifies what to do with referrals. Possible values:

Note If you are experiencing slow searches on Microsoft Active Directory with
the follow value for the Referral setting, try using the Global Catalog as Active
Directory domain controller. The Global Catalog enables searching for Active
Directory objects in any domain in the forest without the need for subordinate
referrals. This can dramatically speed up searching. However, the Global
Catalog only contains a subset of the attributes of an object. This solution is
only viable if the attributes requested for the search results are stored in the
global catalog. Note that the Global Catalog is accessible on port 3268/3269,
not the standard 389/636 LDAP ports.

The base DN of where all the groups are located. If a base has been specified,
that base is used as the prefix for this group base.

The LDAP filter to which each group has to comply to be synchronized.

Batch syn-
chronization

The synchronization of the users with the LDAP server happens in batches.

Batch size The number of users in each batch. If a batch fails, none of the users in that batch is
updated and the user names are listed in the DGC service log. Other batches are
processed as normal. After processing all batches, Collibra disables users that are no
longer in LDAP, unless one ore more batches failed.

Set the value to 0 to disable batch processing.
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Password
The configuration of passwords.

Setting Description

Minimum length
(Requires restart)

The minimum length of passwords.

The default minimum length is 12.

Maximum length
(Requires restart)

The maximum length of passwords.

The default maximum length is 1,024.

Digits required
(Requires restart)

l True (default): Passwords have to contain one or more digits.
l False: Passwords do not have to contain digits.

Non alpha-
numeric required
(Requires restart)

l True (default): Passwords have to contain one or more non-alpha-

numeric (special) characters.
l False: Passwords do not have to contain non-alphanumeric characters.

Uppercase
required
(Requires restart)

l True (default): Passwords have to contain one or more upper-case char-

acters.
l False: Passwords do not have to contain upper-case characters.

Lowercase
required
(Requires restart)

l True (default): Passwords have to contain one or more lower-case char-

acters.
l False: Passwords do not have to contain lower-case characters.

Username dis-
allowed
(Requires restart)

l True (default): Passwords cannot be the username.
l False: Passwords can be the username.

Expiration interval
(months)

The number of months before users have to change their passwords.

Set it to 0 if users never have to change their passwords.

The default interval is 6 months.
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Allowed login
failures

The number of consecutive failed login attempts that are allowed before the user
account is disabled.

Set it to 0 for unlimited attempts.

The default is 3 login failures.

No reuse count The number of previous passwords users cannot reuse. The default is 1: the user
cannot change his password to what it currently is.

Set this to 0 to allow using the same password.

Password reset
link validity period

The number of minutes that a link to reset a password remains valid. Beyond this time,
the user has to request a new password reset link.

The default value is 60 minutes.

The minimum value is 15 minutes, the maximum value is 1,440 minutes (24 hours).

Account lock-out
duration

The number of minutes that a user cannot sign in after too many failed sign-in attempts.
If the number of minutes is set to 0, a Collibra administrator must reset the password to
unlock the account. This setting is only applicable if the "Allowed sign-in failures"
setting is defined.

A locked-out account does not mean that your account is disabled.

REST
The security configuration of the REST interface.

Setting Description

CSRF token
enabled

l True: The validity of a request is checked with a CSRF token.
l False (default): The validity of a request is not checked with a

CSRF token.

Referrer enabled l True: The HTTP referrer header is used to identify the origin of the

request.
l False (default): The HTTP referrer header is not used to identify the ori-

gin of the request. It is recommended to leave this option disabled.
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Referrer checking
allow empty

l True (default): The HTTP referrer header can be empty.
l False: The HTTP referrer header cannot be empty.

SSL
The configuration of SSL.

Setting Description

Key store name The name of the keystore file. The file is expected to be in the <collibra_
data>/dgc/security folder.

Key store pass-
word

The password of the keystore.

Key store type The type of the keystore file. For example, JKS or PKCS12.

Trust store name The name of the truststore file. The file is expected to be in the <collibra_
data>/dgc/security folder.

Trust store pass-
word

The password of the truststore.

Trust store type The type of the truststore file. For example, JKS or PKCS12.

SSO
The configuration of Single Sign-On (SSO) authentication.
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Mode The SSOmode of Collibra.

The possible values are:

l SAML_ATTRIBUTES
l SAML_LDAP
l SSO_HEADER
l SSO_HEADER_LDAP
l DISABLED

Header The name of the header to be checked. The contents of this header is used for the
search query, which is SSO_HEADER = username.

The value of the actual query depends on DN and possibly Attribute.

DN If the SSO mode is SSO_HEADER_LDAP or SAML_LDAP, this field determines
whether the distinguished name (DN) or attribute is used:

l True: The header has to contain the distinguished name (DN) of the

user in the LDAP.
l False (default): The header has to contain the value of Attribute.

If the SSO mode is DISABLED, SSO_HEADER or SAML_ATTRIBUTES, this field is
ignored.

Attribute This field is only used if the SSO mode is SSO_HEADER_LDAP or SAML_LDAP,
and if DN is False.

If the above criteria are met, the LDAP has to contain this value.

Example
If Attribute is FirstName, then the header should contain the FirstName of the user that
was signed in.

Disable automatic
user creation when
signing in via SSO

If users try to sign in via SSO, they still need a user account in Collibra. You can either
create the user accounts automatically when they sign in, or create the user accounts
manually or via LDAP synchronization

l True: User accounts are not created automatically.
l False (default): User accounts are created automatically.
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Disable the Collibra
signin page

When SSO is enabled, a user can still navigate to the /signin page and try to log in via
that page. However, you can disable that page.

l True: Users cannot access the Collibra signin page.
l False (default): Users can access the Collibra signin page

SAML The configuration of SAML.

Metadata
HTTP

The URL of the SAML metadata file to be used. The URL always has to be
reachable by the Collibra environment.

Entity Pro-
vider Entity
ID

The entity ID inside the metadata to be referenced.

Note A metadata file can describe multiple entity IDs, make sure to use in the
entity ID from the correct metadata file.

Attribute
fields

The mappings of attributes in the SAML response. The values are used as keys to look
for in the SAML response.

Examples of attribute fields are first name, last name, address information, phone
numbers and so on.

First name The mapping for the user's first name.

This attribute is optional. The value can be empty.

Last name The mapping for the user's last name.

This attribute is optional. The value can be empty.

Email The mapping for the user's email address.

This attribute is optional for existing users, but mandatory for new users.

Warning If the email address is invalid when you synchronize, the user is
deactivated and the user information is not updated.

Enabled The mapping that indicates whether the account of the incoming user is
enabled.
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Group The mapping (attribute) which indicates to which Collibra groups the user should be
added. If the groups don't exist yet, they will be created. This attribute can have
multiple values (groups) or the groups can be sent as a comma-separated list of
groups.

If passing groups in this attribute, you must set Groups DGC Managed to False.

Phone The mapping for the user's phone.

Fax The mapping for the user's fax number.

Mobile The mapping for the user's mobile number.

Pager The mapping for the user's pager number.

Private The mapping for the user's private number.

Work The mapping for the user's work number.

Other The mapping for any other phone number for this user.

Home
address

The mapping for the user's home address.

Street The mapping for the user's street.

Number The mapping for the user's number.

City The mapping for the user's city.

Post
code

The mapping for the user's postal code.

State The mapping for the user's state.

Country The mapping for the user's country.

Work
address

The mapping for the user's work address.

Street The mapping for the user's street.

Number The mapping for the user's number.
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City The mapping for the user's city.

Post
code

The mapping for the user's postal code.

State The mapping for the user's state.

Country The mapping for the user's country.

Instant
messaging

The mapping for the user's IM locations.

AIM The mapping for the user's AOL IM account.

Google
Talk

The mapping for the user's Google Talk IM account.

Icq The mapping for the user's ICQ IM account.

Jabber The mapping for the user's Jabber IM account.

Messenger The mapping for the user's Live Messenger IM account.

Skype The mapping for the user's Skype IM account.

Yahoo Mes-
senger

The mapping for the user's Yahoo Messenger IM account.

Gender The mapping information for the user's gender.

Mapping The attribute key for the gender value. If the content equals one of the male or
female mappings, the user will be saved as male or female. Otherwise a
default of UNKNOWN will be used.

Male
value

The value for male users.

Female
value

The value for female users.
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Groups DGC
managed

Option to configure that groups should be managed by Collibra, or that groups should
be set by the SAML assertion (SAML+Attributes mode).

This option is only relevant if Mode is SAML_ATTRIBUTES.

l True: The groups are fully managed by Collibra. In the UI the admin has

the option to assign groups to users, without it being overwritten by SAML.
l False (default): The groups are managed by the SAML assertions. In

this case the groups are managed by the SAML IDP. Be sure to configure
the Group attribute in the Attribute Fields section.

Service Pro-
vider Entity
ID

Field that determines the value of the Entity ID parameter in the service provider

metadata returned by Collibra. The default value is empty, in which case Collibra uses

the value of the Base URL field.

Enter a custom value if the base URL does not match the audience configured in

your SAML identity provider.

Warning The value of the audience restriction in the SAML response has
to be exactly the same as the value of this field.

Note SSO does not work if the Service Provider Entity ID field
contains the base URL with trailing forward slash (for example
www.collibra.com/), and the audience of your IDP contains the
base URL without a trailing forward slash (for example
www.collibra.com).
Both values need to be exactly the same. In this case, you can resolve the
issue by changing the value in the configuration of your IDP, or the value of this
field. It does not matter whether both have a trailing forward slash or not, as
long as they contain the same value.

Sign authen-
tication
requests
(Requires
restart)

l True: Authentication requests have to be signed.
l False (default): Authentication request don't have to be signed.

Force authn
l True (default): The SP authentication request forces re-authentication.
l False: The SP authentication request does not force re-authentication.
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Force pass-
ive

l True: The reauthentication has to happen in the background.
l False (default): The reauthentication does not have to happen in the

background.

This is only relevant if Force authn is True.

Name ID Name ID that is used in the SP authentication. The default value is
urn:oasis:names:tc:SAML:2.0:nameid-format:persistent.

The Name ID value is mandatory.

Name ID
allow create

l True (default): The IDP can create a name ID to fulfill the SP authen-

tication request.
l False: The IDP cannot create a name ID to fulfill the SP authentication

request.

Disable client
address

l True: The validation of the client IP address in the assertion message is

disabled.
l False (default): The validation of the client IP address in the assertion

message is enabled.

SAML
Requested
authentication
context

Settings for the SAML requested authentication context. The IDP uses the
authentication context to authenticate the user. By default, the authentication context
mandates user/password authentication over HTTPS.

Disable
l True: The requested authentication context section is not sent in the

SAML request.
l False (default): The requested authentication context section is sent in

the SAML request.

Comparison
type

The comparison type that is transmitted in the requested authentication context.

Possible values:

l minimum
l maximum
l better
l exact (default value)

For more information about the comparison type values, refer to the SAML
specifications.
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Setting Description

Reference
list

The list of class references in the requested authentication context. You can separate
list items with the pipe character (|).

For more information about this list, refer to the SAML specifications.

Declaration
list

The list of class declarations in the requested authentication context. You can separate
list items with the pipe character (|).

For more information about this list, refer to the SAML specifications.

Response
decryption
mode

Enable the support for encrypted SAML responses.

l DISABLED: Collibra only accepts plain-text SAML responses.
l OPTIONAL: Collibra can handle both encrypted and plain-text SAML
responses.

l FORCED: Collibra only accepts encrypted SAML responses.

Once OPTIONAL or FORCED is selected, the encryption key pair is generated and
added to the Collibra SAML keystore. A self-signed certificate is generated and works
in most situations. If your IdP rejects self-signed certificates, you will have to add a
certificate that is signed by a trusted 3rd party.

Validity
period of the
SAML cer-
tificate

The SAML certificate expiry date in years.

By default, the SAML certificate expires after 20 years.

Signout
The configuration of redirecting after signing out of Collibra.

Setting Description

Override signout
URL (Requires
restart)

l True: Redirect the user to a specific website after signing out.
l False (default): Redirect the user to the sign-in page after signing out.

Signout redirect
URL (Requires
restart)

The URL to be redirected to when signing out.
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Import/Export
The configuration to avoid the Formula Injection vulnerability in Excel.

Setting Description

Escape Excel
formulas

The option to disable Formula Injection into Excel. When enabling this option, an
escape character is added at the beginning of Excel formulas during the export and is
removed when importing formulas.

The escape character will be added to fields that start with one of the following
characters:

l equation: =
l plus: +
l minus: -
l at-sign: @

This option is enabled by default.

Excel formulas
escape character

The escape character for Excel formulas when exporting or importing data.

JWT
The JSONWeb Token configuration.

Setting Description

JSONWeb Key
Set URL

The URL to retrieve public key information needed to verify the authenticity of JSON
Web Tokens (JWTs), issued by an authorization server.

This setting is required to enable JWT authentication.

JWT Token
Types

A case-insensitive comma-separated list of accepted JWT media types coming in the
typ header parameter.

Leave blank if the authorization server does not provide a media type parameter.

The default values is at+jwt,jwt.

JWT Algorithms A comma-separated list of accepted JWT algorithms coming in the alg header
parameter. See https://tools.ietf.org/html/rfc7518#section-3.1 for details.

Leave blank to accept all digital signature algorithms.
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Setting Description

JWT Issuer The accepted issuer coming in the iss JWT claim.

Leave blank if the authorization server does not provide an issuer claim.

JWT Audience A comma-separated list of accepted audience values for the aud claim.

The value for this field is a configuration setting in your authorization server, which
identifies your Collibra environment as the intended recipient of the JWT.

Leave blank if the authorization server does not provide an audience claim.

JWT Principal ID
Claim Name.

The name of the JWT claim containing the principal's identity. See
https://tools.ietf.org/html/rfc7519#section-4.1.2 for details.

Defaults to the standard subject claim, sub.

Change this setting only if your authorization server has other means of identifying the
principal, for example, a client_id claim.

This setting is required if JWT authentication is enabled.

JWT Maximum
Clock Skew

The maximum acceptable difference in seconds between the clocks of the machines
running the authorization server and Collibra.

Differences smaller than the given amount are ignored when performing time
comparisons for token validation.

The default value is 60 seconds if left blank.

HTTP headers
The configuration of the HTTP headers

Field Description

URL pattern The pattern of the URLs to which the HTTP response header is applied.

This field supports wildcards such as **, * and ?.

Tip This pattern matches all URLs: /**.
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Field Description

HTTP headers The HTTP response headers in a key-value format.

You can add new HTTP response headers by clicking Add at the bottom of the section,
and entering the HTTP response header name as the field key and the HTTP response
header value as the field value.

Whitelists
The configuration for whitelist placeholders that can be used in security headers.

Option Description

connect-src
whitelist

The 'connect-src' whitelist. To use this whitelist in a security header, use the '
{connectSrcWl}' placeholder.

font-src whitelist The 'font-src' whitelist. To use this whitelist in a security header, use the '
{fontSrcWl}' placeholder.

frame-src whitel-
ist

The 'frame-src' whitelist. To use this whitelist in a security header, use the '
{frameSrcWl}' placeholder.

img-src whitelist The 'img-src' whitelist. To use this whitelist in a security header, use the '
{imgSrcWl}' placeholder.

script-src whitelist The 'script-src' whitelist. To use this whitelist in a security header, use the '
{scriptSrcWl}' placeholder.

style-src whitelist The 'style-src' whitelist. To use this whitelist in a security header, use the '
{styleSrcWl}' placeholder.

frame-ancestors
whitelist

The 'frame-ancestors' whitelist. To use this whitelist in a security header, use
the '{frameAncestorsWl}' placeholder.

Tableau frame-
ancestors whitel-
ist

The tableau 'frame-ancestors' whitelist. To use this whitelist in a security
header, use the '{tableauFrameAncestorsWl}' placeholder.
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Disclaimer
The configuration of a disclaimer upon signing in to Collibra.

Setting Description

Disclaimer l True: Upon signing in, show a disclaimer that you have to agree with

before you can continue.
l False (default): Don't show a disclaimer.

Disclaimer mes-
sage

The disclaimer message that is shown after signing in.

If you leave this field empty, there is a default message.

You can use basic html tags, such as headers, paragraphs, images and hyperlinks.

Collibra Connect
The configuration to communicate with Collibra Connect.

Setting Description

Base URL The URL to Collibra Connect.

Username The username to connect to Collibra Connect.

Password The password to connect to Collibra Connect.

Register data source
Global parameters that apply to Data Source Registration.

Setting Description

Table types to
ignore

A comma separated list of table types that are not ingested. For example,
INDEX and SEQUENCE.
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Setting Description

AWS regions
restriction

A list of AWS regions Data Catalog is allowed to connect to. For example, eu-west-3
and us-east-2. For a list of all AWS locations, see the AWS documentation.

l If you want to allow Collibra to make a connection to any AWS region,
leave the field empty.

l If you remove a region from this list and the region was previously used for
an S3 integration, you may want to delete the Glue database from the pre-
viously used region manually. By default, Collibra does not remove it. The
Glue database has the following naming convention: collibra_catalog_
<Asset Id>_<Domain Id>
For example: collibra_catalog_d3174a88-5ffe-4d50-8fbe-7bf0832ec3af_
5d198ce9-4e56-4d0e-a885-58204da50741

l When using Edge, a warning is added to the logs if an invalid region is
detected in the restricted regions list.

AWS API call rate Allowed number of AWS API calls per second.

Use this option to limit the number of API calls per second to prevent throttling errors
from the AWS API.

Database regis-
tration via Edge

An option to enable database registration via Edge.

l True: Register a data source via Edge.
l False: Register a data source via Jobserver only.

Note Enabling data source registration via Edge does not prevent you from
registering a data source via Jobserver as well.

Collibra Data
Quality
& Observability
Synchronization
UI via DQ Con-
nector on Edge

An option to enable the Data Quality extraction interface in Collibra

l True: The Quality extraction tab is available on the configuration page

of a database asset
l False (default): The Quality extraction tab is not available and as such,

it is not possible to extract and synchronize data quality information.

You can only enable Collibra Data Quality & Observability synchronization if you also
enabled Database registration via Edge.
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Setting Description

Amazon S3 syn-
chronization via
Edge

An option to enable Amazon S3 file system registration and synchronization via Edge.

l True: You can register and synchronize an Amazon S3 file system via

Edge.
l False: You can only register an Amazon S3 file system via Jobserver.

Note Enabling the registration of an Amazon S3 file system via Edge does not
prevent you from registering an Amazon S3 file system via Jobserver.

For more information, see Working with Amazon S3.

Source Tags Syn-
chronization via
Edge (Beta)

An option to register and synchronize the tags on individual columns and tables in the
data source during the data source registration via Edge. This means the tags become
available and searchable in Data Catalog and can be used in business or policy
processes and in workflows.

Note Currently, you can only synchronize source tags from Snowflake.

l True: The Include Source Tags option becomes available when you

define the rules for the synchronization of a data source via Edge. If you
include the source tags, the tags defined on the assets in the data source
are registered and available from the Schema, Table, Database View, and
Column assets in the Source Tags attribute.

l False: Source tags are not registered in Data Catalog.

Jobserver
The configuration of the Jobserver service.

Setting Description

Jobserver list The list of registered Jobserver instances.
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Setting Description

Name The name of the Jobserver as it will appear when you register a data source in Data
Catalog.

The name is a freely chosen name but it is recommended to only use alphanumerical
characters and dashes, for example Jobserver-1.

You will have to use this name as the ID of the gateway and in the address of this
configuration.

Protocol The protocol that is used for the communication between the Data Governance Center
service and the Jobserver service.

It is recommended to use HTTPS, especially if the services are hosted in different
network segments.

Address The address (IP address, URL, hostname) of the Jobserver.

Trusted server
CA certificate

The certificate of the trusted CA needed to validate the server certificate. If blank, the
default truststore will be used. The default truststore is defined in the SSL configuration
section of the DGC service.

The CA certificate of the server party (Jobserver).

Client
certificate

The client certificate offered by the DGC service to the server. If blank, you cannot
select mutual authentication as the Jobserver service authentication level.

Client private
key

The private key of the DGC service's certificate.

Table profiling
data size

The approximate maximum disk size of the data in MB that will be used to profile a
table. The value cannot exceed 10,000.

Test
connection
timeout

This timeout is a time limit (in seconds) after which the connection test is stopped and a
timeout error is shown. The default value is 60 seconds.

Data profiling
Profiling must be executed again after a change in this section.
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Setting Description

Maximum num-
ber of samples

The maximum number of samples you want to collect for a data source. The
default value is 100. The maximum value is 1,000.
This setting is specific to sample data.

Maximum value
length

The maximum length of a value extracted during profiling or sampling. Addi-
tional characters are trimmed.

Default date pat-
tern

The default format used to decode dates. It is the default pattern used for
detecting dates when the Date Pattern and/or Time Pattern attribute is not
specified in Column assets.

Default time pat-
tern

The default format used to decode times. It is the default pattern used for
detecting times when the Date Pattern and/or Time Pattern attribute is not
specified in Column assets.

Default combined
date and time pat-
tern

The default format used to decode combined dates and times. It is the default
pattern used for detecting combined dates and times when the Date Pattern
and/or Time Pattern attribute is not specified in Column assets.

Empty values A comma separated list of strings enclosed in double quotes. A value that matches one
of those expressions is considered an empty value.

Please note that a database null value is always considered an empty value, for
example "", "na" and "none".

Data type detec-
tion threshold

The percentage of matching Column values to reach for an Advanced Data
Type to be considered a possible Data Type for that Column. This is
expressed as a value between 0.0 and 1.0).

Anonymize data An option to anonymize sensitive data.

l True: Content in columns with data type Text or Geo is removed or

replaced by a random hash value before the profiling results are sent to the
cloud.

l False (default): No content is removed or replaced by a random hash

value.

Tip If you profile and classify via Edge, the data in columns with data type Text
or Geo is automatically anonymized before it is sent to Collibra Data
Intelligence Cloud.
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Setting Description

Database pro-
filing via Edge

An option to enable profiling and classifying synchronized metadata via Edge instead
of Jobserver.

l True: Profiling and classification via Edge.
l False: Profile via Jobserver and classify via the Data Classification Plat-

form.

Note You can only enable Database profiling via Edge if you also enabled
Database registration via Edge.

Parallel database
profiling via Edge

The maximum number of databases that Edge can profile and classify at the same
time.

Note Schemas in a database are always processed sequentially.

By default, the value of the setting is one. This means Edge processes one profiling job
at a time. The maximum value is four.
If you change this setting, you must restart Collibra.

Beta features
The configuration of features in beta state.

Setting Description

Tableau pro-
visioning enabled

l True: Provisioning to Tableau is enabled.
l False (default): Provisioning to Tableau is disabled.

Max number of
concurrent import
jobs

The maximum number of import jobs that can be executed at the same time via the
API. This is to avoid memory issues.

Default value is 4, set to 0 if there is no limit.
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Setting Description

Task sidebar l True (default): Workflow tasks appear in the sidebar on both resource

pages an the task management page. Task forms appear in the sidebar
instead of dialog boxes. Users can seamlessly complete their tasks from
the task management page and have a side-by-side view of the tasks and
resource details on resource pages.

l False : Workflow tasks appear in the task bar on resource pages and in

a sidebar on the task management page. Task forms appear in dialog
boxes. The behavior is the same as with older versions of Collibra.

Settings landing
enabled

l True (default): Show the new Settings landing page in your Collibra

environment.
l False : Use the classic Settings page in your Collibra environment.

New Scope page
enabled

This setting
requires the
SUPER role.

l True (default): Enable the use of the enhanced Scope page.
l False: Disable the use of the enhanced Scope page and use the basic

Scope page instead.

Allow access to
the Workflow
Designer

Enables the Workflow Designer access global permission which allows
access to the Workflow Designer, a visual tool for creating process definitions.

Frontend enabled

This setting
requires the
SUPER role.

Enable the frontend (shell) in the application. This will be served under the
/apps/ and select other endpoints if enabled.

Data Marketplace
Advanced Filter
Settings

Enable this setting to try out personal saved filters and recommended filters for user
groups in Data Marketplace.

l True: The advanced filters can be used in Data Marketplace.
o Data consumers can save a set of filters that they use frequently as a
personal saved filter.

o Data Marketplace administrators can save a set of filters and make it
available only to a specific user group (recommended filters) or to all
user groups (filter tabs).

l False: (default): The beta feature is not enabled.
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Setting Description

Throttling enabled

This setting requires the
SUPER role.

l True: REST API v1 throttling is enabled.
l False (default): REST API v1 throttling is disabled.

Number of requests

This setting requires the
SUPER role.

The number of allowed request for the configured number of
seconds.

Number of seconds

This setting requires the
SUPER role.

The number of seconds during which the configured number of
requests can be performed.

Setting Description

Throttling enabled

This setting requires the
SUPER role.

l True: REST API v2 throttling is enabled.
l False (default): REST API v2 throttling is disabled.

Number of requests

This setting requires the
SUPER role.

The number of allowed request for the configured number of
seconds.

Number of seconds

This setting requires the
SUPER role.

The number of seconds during which the configured number of
requests can be performed.

Setting Description

Throttling enabled

This setting requires the
SUPER role.

l True: GraphQL throttling is enabled.
l False (default): GraphQL throttling is disabled.

Number of requests

This setting requires the
SUPER role.

The number of allowed request for the configured number of
seconds.
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Setting Description

Number of seconds

This setting requires the
SUPER role.

The number of seconds during which the configured number of
requests can be performed.

Graph query
The configuration of the Graph query engine which is used to retrieve data from the
repository.

For the general Graph query settings in a cloud environment, you need the SUPER role.
Contact Collibra support if you want to edit these settings.. For on-premises environments,
you can edit the settings yourself.

The Graph query settings are not available in on-premises environments.

Graph query limits

Setting Description

Enables limiting of the num-
ber of root nodes in result

l True: Enable limiting the number of root elements as result of

a Graph query.
l False (default): Disable limiting the number of root elements

as result of a Graph query.

Maximum number of root
nodes that can be reques-
ted with graph query API

The maximum number of root nodes that you can request in the view
configuration of an API call (REST or workflow).

If you exceed this value in the view configuration, an exception is shown. If
no value is defined in the view configuration, then the default value is taken.

The default value is 100,000.

Note If the number of asset types or domain types exceeds the set
number, the hierarchy will be incomplete. Make sure that the limit is
always higher than the actual number of asset and domain types.

Chapter 28

913

https://support.collibra.com/


Chapter 28

Setting Description

Maximum number of nodes
that can be requested with
the graph query API in a
single page

The maximum number of both root and children nodes that can be
requested through Output API in a single data page. If the value is
outside of the allowed range an exception is thrown. The default
value is 1 million.

Graph query timeouts

Setting Description

Maximum number of
minutes a graph query can
run

The maximum number of minutes that the graph query runs before it will
time out. The maximum is 1,440 minutes (1 day).

The default value is 480.

Table
The configuration of tables.

Setting Description

Time limit for load-
ing data in tables
in seconds

The time limit after which a table stops loading on a page.

Example A value of 600 means that if a table hasn’t loaded within 600
seconds, the task is canceled and a timeout error is shown.

The default value is 60, the maximum value is 720 seconds.

Multi-column sort
The configuration of multi-column sorting.

Setting Description

Multi-column sort-
ing on tables

l True: Tables can be sorted on multiple columns.
l False (default): Tables can be sorted on one column.
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Setting Description

Number of
columns avail-
able for multi-sort

Type the maximum number of columns that can be used to simultaneously sort tables.

The default value is 3, the minimum is 1, the maximum is 9.

This setting is only relevant is Multi-column sorting on tables is True.

Inherited responsibilities

Setting Description

Enable Inherited
Responsibilities

l True: Show inherited responsibilities on asset views.
l False (default): Do not show inherited responsibilities on asset views.

Note This setting only affects asset views and tile sets. It does not affect the
Responsibilities tab page of asset pages.

Purge configuration
The configuration of the automatic purging of data from the repository database. Purging
means to delete data of a specified age. This helps to keep your data relevant and keep
the database from growing infinitely.

Setting Description

Purge schedule
(Requires restart)

A Cron expression specifying the timing and frequency of purge cycles.

The default scheduled time is 002 * *, which equates to 02:00 every day.

If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops
responding.

Maximum time for
each purge cycle
(Requires restart)

Maximum amount of time (in seconds) allowed for each purge cycle.

The default value is 7,200, which is two hours.

Any qualifying data that is not purged in the allowed time will be addressed in a
subsequent purge cycle, which picks up where the previous cycle left off.
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Setting Description

List of data ele-
ments and age at
which each will
be purged
(Requires restart)

The data elements that will be purged at the specified age, in a key-value format:

l The data elements to be purged (Field key). Possible data elements:
o Statistics: Data that has been used to calculate data quality.
o Authentication events: Data about authentication in your environment.
o Validation results: Information about data validation.
o Jobs: Data about all jobs that are created in your environment.
o Workflows: Data about completed workflow instances and tasks.
o License usage: Data about how licenses are used in your environment.

l The age (in months) at which each individual data element will be purged
(Field value).

Enable removal
of orphaned tags
(Requires restart)

Option to enable the automatic deletion of tags that are not assigned to any assets.

l True (default): Orphan tags are deleted according to the timing and fre-

quency that you specify.
l False: Orphan tags are not deleted.

Orphaned tags
removal schedule
(Requires restart)

A Cron expression specifying the timing and frequency of the deletion of orphan tags.

The default scheduled time is 001* *, which equates to 01:00 every day.

If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops
responding.

Cloud Data Classification configuration
With data classification you can automatically assign data classes to ingested data.

Note In a Collibra Data Intelligence Cloud environment, you have to create a
support ticket to configure this feature.

Setting Description

Enable Data
Classification

l True: Enable Collibra's data classification technology.
l False (default): Do not use Collibra's data classification technology are

not accepted.
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Classification thresholds

Setting Description

Enable automatic
classification
acceptance and
rejection

True: The automatic acceptance and rejection of data classification suggestions is

active.

False (default): Data classification suggestions are not automatically accepted or

rejected.

Tip Start using the Automatic Data Classification tool by manually accepting
and rejecting the data classification suggestions. Only activate the automatic
acceptance and rejection feature if you are comfortable with the results the tool
provides.

Automatic accept-
ance threshold

The percentage from which data classification suggestions must be accepted
automatically.
If you set this value to 75, then the classification suggestions with a confidence level of
75% or higher are automatically accepted.

If multiple classification suggestions meet the threshold condition for a column, the
classification suggestion with the highest confidence level percentage is accepted
automatically if this classification suggestion is the only one to have that confidence
level percentage.

Example
You set the automatic acceptance threshold to 85%. You classify a table with 2
columns.

l For column A, three classification suggestions are possible, one
with confidence level 93%, one with 92%, and one with 90%.

l For column B, two classification suggestions are possible. Their
confidence level is the same, 86%.

The results of the automatic acceptance will be:

l For column A, the classification suggestion with 93% will be
accepted automatically.

l For column B, nothing is done, both suggestions will be visible.

The default acceptance threshold is 90.
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Setting Description

Automatic rejec-
tion threshold

The percentage from which data classification suggestions must be rejected
automatically. If you set this value to 49, then all data classification suggestions with a
confidence level of 49% or lower are automatically rejected.

The default rejection threshold is 10.

Note If the acceptance threshold and rejection threshold are set to the same value,
and a data classification suggestion has this confidence level percentage, the
classification suggestion will be rejected.

Reporting
For more information about these settings, see Introduction to the Reporting Data Layer.

Setting Description

Cloud Provider Cloud provider - AWS or GCP

Customer GUID The GUID of your Collibra environment.

Note This field is configured by Collibra Cloud Ops.

Insights download bucket
name

The name of the AWS S3 bucket in which your reporting data is stored.

Note This field is configured by Collibra Cloud Ops.

Insights AWS S3 Region The AWS S3 region in which your data is processed.

Note This field is configured by Collibra Cloud Ops.

Insights zip location pattern A pattern with the format "/zip/insights_%s.zip", where "%s" is replaced by
the Collibra Insights snapshot date.

Note This field is configured by Collibra Cloud Ops.
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Setting Description

Tableau report URL pattern The Tableau URL pattern, which should contain {reportName}.

Tip You can paste the URL from the Link field in Tableau, as
described in Generate the dashboard reports you configured in
Collibra Data Intelligence Cloud Settings.

Reports definitions

Report view name The report name, as you want it to appear on the report button in the
Usage Analytics widget, for example "Data Maturity Dashboard".

Report name The report name, as it appears in the URL of the Tableau report, for
example "DataMaturityDashboard".

Catalog Experience
Data Catalog Experience improves the layout of Data Catalog's asset pages.

Setting Description

Enable Catalog
experience

l True: Catalog experience is enabled. This will improve the layout of

Data Catalog's asset pages, such as those of Data Set, Schema, Table
and Column assets.

l False: Catalog experience is disabled.

Catalog Experience
Titlebar theme

The theme for the Catalog experience. You can choose between the LIGHT and
DARK.

This option is only applicable if the Enable Catalog experience option is enabled.

Diagrams
These settings determine dialog loading time and size limits.
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Setting Description

Maximum loading
time for the back
end

The time limit, in seconds, after which a diagram stops fetching data.

The value must be a positive integer and cannot be greater than 3,600 (one hour).

The default value is 300.

Example A value of 300 means that if a diagram hasn’t fetched all data within
300 seconds, the diagram stops fetching data and an empty diagram with a
notification is shown.

Size limit for the
backend

The maximum number of nodes plus edges that will be fetched by the backend, to build
a diagram.

The value must be a positive integer and cannot be greater than 100,000.

The default value is 10,000.

Example A value of 10,000 means that if the total number of nodes plus edges
is greater than 10,000, the diagram does not load and a notification is shown.

Size limit for the
frontend

The maximum number of visible nodes plus edges that can be shown on the page.

The value must be a positive integer and cannot be greater than 10,000.

The default value is 2,000.

Example A value of 2,000 means that if the total number of visible nodes and
edges is greater than 2,000, the diagram does not load and a notification is
shown.

Maximum flow
depth

The system-wide maximum number of flow relations between the start node and any
other diagram node.

The value must be an integer between 1 and 100.

The default value is 50.

Note
l If the maximum flow depth is specified in the selected diagram view,
that value supersedes the maximum you specify here.

l You can also manually adjust the flow depth in the diagram.
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Setting Description

Diagrams Business
Qualifier Filter (*)

l True: Users can filter diagrams by a specified Business Qualifier asset.
l False (default): Users are unable to filter diagrams by Business Qual-

ifier.

Everywhere Desktop configuration
These settings determine some of the ways in which Collibra for Desktopinteracts with
Collibra Data Intelligence Cloud.

Note These settings are only applied in Collibra for Desktop if you have Collibra
2021.01 or newer in combination with Collibra for Desktop 1.2.1 and newer.

Setting Description

Default search filter The filter that is applied, by default, to search results. The value must be the
UUID of the filter.

To find the UUID, open the Collibra environment and click in the Search
box. Click the name of a search filter. In the address bar you will see the
UUID of the filter.

Note Specifying a default search filter in the application will
override the default filter that you specify here.

Custom Search box place-
holder

Placeholder text that appears in the Search field before a user enters
search text.

The default text is "Search in Collibra".

Shortcut Search Enable or disable the use of a keyboard shortcut to search for selected text
in Collibra Data Intelligence Cloud from within your browser or another
application.

l True (default): Users can use the keyboard shortcut you spe-

cify in the following setting to search in Collibra Everywhere.
l False: Keyboard shortcut is disabled.
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Setting Description

Custom Shortcut Search The keyboard shortcut to search for selected text in Collibra Data
Intelligence Cloud from within your browser or another application.

Tip The keyboard shortcut has to be a combination of Control, Alt
or Shift with one letter or number. On macOS you can also use the
Command key.

Note
l To make available the keyboard shortcut, you have to
enable the feature in the previous setting.

l Specifying a keyboard shortcut in the application will
override the shortcut that you specify here.

Enable Auto Hyperlinking Option to enable automatic hyperlinking within Collibra for Desktop.

With this option enabled, the name of an asset automatically becomes a
hyperlink when you fill out a text attribute.

This option only works if the Enable hyperlinking option in Collibra Console
is also enabled.

Enable Workflows Option to enable workflows in Collibra Everywhere.

This allows you to complete tasks or start a workflow in the app. The
available workflows depend on the ones that you add to the Global
workflows and Asset workflow configuration.

Recommender The Recommender helps users by suggesting relevant business assets
and data sets, based on certain relation types and the past actions of similar
users.

l True: Recommender is enabled.
l False (default): Recommender is disabled.

This feature only works if Analytics is enabled. You can enable Analytics in
section 1 General of the DGC service configuration.
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Setting Description

Auto-updater Option to automatically upgrade Collibra Everywhere when a new version is
available.

l True (default): Collibra Everywhere is automatically upgraded

when a new version is available.
l False: You need to manually upgrade Collibra Everywhere

when a new version is available.

Note If you enable automatic updates, you have to whitelist the S3
bucket collibra-otg-desktop-installers in the region eu-west-1.

Allow User Configuration Option to allow users to edit personal settings in Collibra Everywhere.

l True (default): Users can edit personal settings.
l False: Users cannot edit personal settings.

Global workflows The list of workflows that is available in the app's main menu.

Enter the UUIDs of the workflows. An example workflow could be "Create
issue".

Asset workflow The list of workflows that is available on an asset page in the app.

Enter the UUIDs of the workflows. An example workflow could be "Ask the
expert".

No search result workflows The workflows that are available if there are no search results found.

Enter the UUIDs of the workflows. An example workflow could be "Propose
new business term".

Enable autostart Option to automatically start Collibra for Desktop when signing in to your
operating system.

l True: The app starts automatically when signing in to your

operating system.
l False (default): The app does not start automatically.

If you have set this option in the Collibra for Desktop settings, this option is
neglected.
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Everywhere Mobile configuration
These settings determine some of the ways in which Collibra for Mobileinteracts with
Collibra Data Intelligence Cloud.

Setting Description

Default search fil-
ter

The filter that is applied, by default, to your search results. The value must be the UUID
of the filter.

This filter overrules any search filter that is set in the app.

To find the UUID, open the Collibra environment and click in the Search box. Click the
name of a search filter. In the address bar you will see the UUID of the filter.

Custom Search
box placeholder

The text that is shown in the search box of Collibra for Mobile before a user
enters search text.

Enable Workflows Option to enable workflows in Collibra for Mobile.

This allows you to complete tasks or start a workflow in the app. The available
workflows depend on the ones that you add to the Global workflows and Asset
workflow configuration.

Global workflows The list of workflows that is available in the app's main menu.

Enter the UUIDs of the workflows. An example workflow could be "Create issue".

Asset workflow The list of workflows that is available on an asset page in the app.

Enter the UUIDs of the workflows. An example workflow could be "Ask the expert".

No search result
workflows

The workflows that are available if there are no search results found.

Enter the UUIDs of the workflows. An example workflow could be "Propose new
business term".

Collibra Browser Extension
The settings determine how and where you can use the Everywhere Chrome Extension.
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Setting Description

Domains Add a web domain, for example of a web application such as Power BI or Tableau, on
which the Browser Extension automatically appears as overlay.

Edge
Edge configuration options, when changing an option, you only have to refresh the page
that runs your Collibra environment.

Setting Description

Enable Edge jobs
feature (beta)

l True: Enable the Edge jobs page, this page gives you a overview of all

jobs and their status.
l False (default): Disable the Edge jobs page.

Tableau Metadata API
You need the Tableau metadata API to ingest Tableau 2020.2 and newer.

Warning If you upgrade to Tableau version 2020.2 or newer, but previously
synchronized an older Tableau version via the REST API and XML mapping, you
have to prepare the migration procedure to prevent losing manually added relations,
attributes, tags, comments and stitching results.

Setting Description

Enable Tableau
metadata API

l True: Tableau metadata API is enabled. This enables you to ingest

Tableau 2020.2 or newer into Data Catalog.
l False: Tableau metadata API is disabled. If you ingest Tableau 2020.2

or newer, the ingestion will fail. This prevents data loss of manually added
relations and attributes.
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Job Service (Activities)

Setting Description

Number of
executor threads
for the Job Ser-
vice

The maximum number of threads, or jobs, that the Job Service can run in parallel.

Generally speaking, increasingly the number of jobs running in parallel reduces overall
processing time. Conversely, it requires more system resources, which can negatively
impact performance. It also increases the risk of job conflicts.

Lineage on Edge

Setting Description

DGC user name The DGC user that is used to ingest technical lineage data into the envir-
onment via the technical lineage servers.

DGC user pass-
word

Password of the DGC user that is used to ingest technical lineage data into the
environment via the technical lineage servers.

Collibra system
name flag

Enable this option if Lineage uses a Collibra system name.

Collibra Protect

Setting Description

Protect scheduler
fixed delay

The number of minutes in between synchronizations.

The default value is 60 minutes.

926



License configuration

Setting Description

License usage
snapshot cron job
schedule

This sets how often the license usage snapshot is refreshed. This cannot run
at an interval smaller than 60 minutes.

Data Marketplace configuration
The configuration of the Data Marketplace.

Setting Description

Data Marketplace l True (default): Data Marketplace is enabled. Anyone with the required

permissions can use or configure the Data Marketplace application from
the Applications icon .

Note When Data Marketplace is enabled and you reindex Collibra
completely, the relations are also reindexed automatically. You don't need
to start it manually. However, reindexing the relations will not reindex
Collibra completely.

l False: Data Marketplace is not enabled.

After you enable this setting, reindex Data Marketplace relations or reindex Collibra
completely.

Note In new Collibra environments, this setting is enabled by default. In
upgraded Collibra environments, the previous status of this setting is retained.

Data Privacy
The configuration of the Data Privacy landing page.
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Setting Description

Privacy landing
page

l True: Enables the Privacy landing page.
l False: Disables the Privacy landing page.

Migration
The Migration feature allows you to migrate the operating model and views from one
Collibra Data Intelligence Cloud environment to another environment. This makes it easier
to migrate changes between development environments, testing environments and the
actual production environment.

Migration is not meant to be used for backups, or to migrate instance data, such as assets
and domains. You can use the import and export features to move assets to another
environment. You can use backups for disaster recovery.

Note Exporting and importing CMA files is restricted by the file upload settings,
which determine the maximum file size, allowed file extensions and maximum
amount of uploads and downloads per day. Contact Collibra support if you want to
change the file upload settings.

Warning
The versions of the source and target environment have to be the same. Migrating
between different versions may lead to unexpected behavior.

For example, migrating does not work correctly if you import a CMA file in an
environment of version 2021.07 or older if the CMA file includes assignments of any
of the following asset types:

l BI Report Attribute
l Business Qualifier
l Column
l Field
l Looker Report Attribute
l Report Attribute
l Table
l Tableau Report Attribute
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Overview of the migration procedure
1. Export objects from a source environment.

a. Choose the objects that you want to migrate.
b. Download the summary and the archive file.
c. Review the summary.

2. Create a backup of your target environment.

Note This is technically not mandatory, but highly recommended.

3. Import the archive file.
» You are guided through the import process. This process consists of the following
main steps: upload the archive file, review the changes via a simulation, and start the
import.
» Once the import is completed, the model objects are created, edited, or removed
as necessary. You can also download an import report.

Best practice
It is highly recommended not to make risky changes to the metamodel of your Production
environment. Instead, we recommend you use a separate Development environment and
Testing environment:

1. Create a backup of your production environment.
2. Restore the backup in your Development and Testing environments.
3. Make the necessary changes in the Development environment.
4. Use the migration feature to re-apply the changes from the Development environment

to the Testing environment.
5. Thoroughly test the changes in the Testing environment.
6. If required, repeat steps 3 to 5.
7. If you are satisfied with the changes, use the migration feature to re-apply the changes

from the Testing environment to the Production environment.

Note Since migration moves the operating model, the existing instance data in
the Production environment is not changed.
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Export model objects
Using the Migration feature, you can export the model objects of a Collibra environment,
for example if you want to import them later in another environment.

Note Exporting and importing CMA files is restricted by the file upload settings,
which determine the maximum file size, allowed file extensions and maximum
amount of uploads and downloads per day. Contact Collibra support if you want to
change the file upload settings.

Prerequisites
You have a global role that has the System administration global permission.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Migration.

» The migration page appears on the Export tab page.
3. Select the model objects that you want to export.

If you want to
export...

Do the following:

Assignments a. At the top of the page, click Asset type assignments.
b. Select one or more assignments.

Tip Click Select all to export all assignments, or click the name of a
scope to export all assignments in that scope.

Global roles a. At the top of the page, click Global roles.
b. Select one or more roles.

Tip Click Select all to export all roles.
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If you want to
export...

Do the following:

Resource roles a. At the top of the page, click Resource roles.
b. Select one or more roles.

Tip Click Select all to export all roles.

Workflows a. At the top of the page, click Workflows.
b. Select one or more workflows.

Tip Click Select all to export all workflows.

Views You can export different types of views, including asset views, dashboards,
diagram views and search filters.

Note You can only export views that are public or shared with a
global role.

Dashboard
views

a. At the top of the page, click Views.
b. In the filter pane to the left, click the type of view that you want to

export.
» The views that are public or shared with a global role appear in
the table.

c. Select one or more views.

Tip To export all available views of a certain type, you can select the
checkbox in front of the view type in the filter pane.

Diagram
views

Search filters

Global asset
views
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If you want to
export...

Do the following:

Asset views in
application
pages

a. At the top of the page, click Views.
b. In the filter pane to the left, click Asset views - in Applications.

» The applications pages appear in the table.
c. Perform one of the following steps:

n If you want to export all available views in all application pages,
select the checkbox in front of Asset views - in Applications in
the filter pane.

n If you want to export all views of a specific application page,
select the checkbox in front of the name of the application page.

n If you want to export specific views, do the following:
i. Click the name of an application page.

» The available views appear in the right column.
ii. Select one or more views.

Asset views in
communities
and domains
pages

a. Click Views.
b. In the filter pane to the left, click Asset views - in Communities and

Domains.
» The organization browser appears in the table.

c. Perform one of the following steps:
n If you want to export all available views in all community and

domain pages, select the checkbox in front of Asset views - in
Communities and Domains in the filter pane.

n If you want to export all views of an community or domain, select
the checkbox in front of the name of the community or domain.

n If you want to export specific views, do the following:
i. Click the name of an community or domain.

» The available views appear in the right column.
ii. Select one or more views.

Note Referenced model objects are also exported based on the export logic.
For example, if you export a workflow, all roles to which the workflow refers
are also exported.

4. In the upper-right corner, click Export.
» The Provide file name and description dialog box appears.
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5. Enter the required information.

Field Description

Archive file name The name of the exported archive file.

Note The extension is always CMA, which is short for Collibra Migration
Archive.

Report file name The name of the report file, which contains a summary of the exported model
objects.

Note You cannot edit the name of the report file.

Description The description of the archive.

6. Click Export.
» The report and the archive are downloaded.

7. Click Close.

Migration export logic
The export logic of the migration feature determines how an object is exported: which
fields it needs and which other objects it requires.

If you export an object, Collibra Data Intelligence Cloud automatically exports all
referenced objects. For example, if you export a workflow, Collibra will also all export roles,
asset types and status to which the workflow refers. For that reason, the migration feature
differentiates between primary objects and secondary objects:

l Primary objects are objects that you choose to migrate.
l Secondary objects are objects that are needed for the correct behavior of a primary
object or another secondary object.

Primary objects
You can migrate most of the model objects and navigation artifacts:
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l Model objects:
o Assignments
o Global roles
o Resource roles

l Workflows
l Navigation artifacts that are public or shared with a role:

o Table views
o Dashboards
o Diagram views
o Search filters

Note
l For navigation artifacts, you cannot choose specific artifacts to migrate. All
navigation artifacts that are public or shared with a role are migrated.
Navigation artifacts that are private or only shared with specific users are not
migrated.

l For model objects, you can choose specific objects to migrate. For example,
you can migrate one specific workflow.

l You cannot choose to migrate anything else. Keep in mind that other objects
might be migrated as secondary objects.

Secondary objects
Secondary objects are objects that are referenced by a primary object or by another
secondary object. These could also be instance data.

These include the following objects:

l Assets
l Asset types
l Assets referenced by a filter clause on a relation type filter
l Characteristic types

o Attribute types
o Complex relation types
o Relation types

l Communities
l Data quality rules
l Domain types
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l Domains
l Roles
l Status
l Validation rules

Objects that cannot be migrated
Some objects will never be migrated. This is a non-exhaustive list:

l Attachments
l Comments
l Data quality scores
l Ratings
l Tags
l Tasks
l User groups
l Users

Export logic by object
The following table shows an overview of all objects, their exported fields and the
secondary objects to which they can refer.
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Object Migrated fields and secondary objects

Asset l Name
l ID
l Status

o ID
o Name
o Description

l Parent domain
o ID
o Name
o Description
o Exclude from Autohyperlinking
o Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

o Parent communities, up to the root level
n ID
n Name
n Description

l Asset type
o ID
o Name
o Description
o Parent asset types, up to the root asset type (for example Business
asset)

o Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

o displayNameEnabled
o ratingsEnabled
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Object Migrated fields and secondary objects

Asset type l ID
l Name
l Description
l Parent asset types, up to the root asset type (for example Business asset)
l Display options

o Color
o Symbol (none, Icon or Code)
o Code
o Icon reference

l displayNameEnabled
l ratingsEnabled
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Object Migrated fields and secondary objects

Assignment l ID
l Asset types referenced in the assignment

o ID
o Name
o Description
o Parent asset types, up to the root asset type (for example Business
asset)

o Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

o displayNameEnabled
o ratingsEnabled

l Articulation rules
l Fields referenced in the assignment

o Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.
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Object Migrated fields and secondary objects

Kind Properties

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

o Relation types
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
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Object Migrated fields and secondary objects

n ratingsEnabled
o Complex relation types

n ID
n Name
n Description
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in
the target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

n Minimum cardinality
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Object Migrated fields and secondary objects

n Maximum cardinality
n Leg types (relation types)

n Role
n Co-role
n Asset types that are head or tail of the relation types

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled
n Minimum cardinality
n Maximum cardinality

l Data quality rules referenced in the assignments
o ID
o Name
o Description
o Aggregation path

n Relation trace entries (path): The sequence of relation types and
their direction
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
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Object Migrated fields and secondary objects

n Icon reference
n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Categorization relation types
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
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Object Migrated fields and secondary objects

n Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

o Data Quality Metrics: attribute types of the Metric attribute type kind
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

l Domain types referenced in the assignment
o Parent domain types up to root

n ID
n Name
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Object Migrated fields and secondary objects

n Description
l If it is a scoped assignment: the scope of the assignment

o ID
o Name
o Description
o Communities

n ID
n Name
n Description
n Parent communities, up to the root level

n ID
n Name
n Description

Note
n If the scope contains an entire community that contains

subcommunities and domains, the subcommunities and
domains are not included.

n If domains or communities are included in the scope, their
parent communities will be included too. Other children of its
parent community will not be included, unless they are also in
the scope.

n The domain type of the included domains are also included.

o Domains
n ID
n Name
n Description
n Exclude from Autohyperlinking
n Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

n Parent communities, up to the root level
n ID
n Name
n Description
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Object Migrated fields and secondary objects

l If it is a scoped assignment: the global assignment.
l Statuses referenced in the assignment

o ID
o Name
o Description

l Validation rules referenced in the assignment
o Characteristic types that are referenced in the validation script

n Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in
the target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

n Relation types
n ID
n Description
n Role

Chapter 28

945



Chapter 28

Object Migrated fields and secondary objects

n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Complex relation types
n ID
n Name
n Description
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n Attribute types
n ID
n Name
n Description
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Object Migrated fields and secondary objects

n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten
in the target environment, so it may remove
values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule
assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

n Minimum cardinality
n Maximum cardinality

n Leg types (relation types)
n Role
n Co-role
n Asset types that are head or tail of the relation types

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example

Business asset)
n Display options

n Color
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Object Migrated fields and secondary objects

n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled
n Minimum cardinality
n Maximum cardinality

o The domain of the validation rule asset
n n ID

n Name
n Description

o The Validation Rule Domain type
n Parent domain types up to root

n ID
n Name
n Description

o The Validation Rule asset type
n Parent asset types, up to the root asset type (for example Business

asset)
o The status of the validation rule

n ID
n Name
n Description
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Object Migrated fields and secondary objects

Attribute l ID
l Parent asset

o Name
o ID
o Status

n ID
n Name
n Description

o Parent domain
n ID
n Name
n Description
n Exclude from Autohyperlinking
n Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

n Parent communities, up to the root level
n ID
n Name
n Description

o Asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Business

asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

l Attribute type
o ID
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Object Migrated fields and secondary objects

o Name
o Description
o Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

l Value(s)
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Attribute type l ID
l Name
l Description
l Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value list)

Allowed values

Warning The list of allowed values is overwritten in the target
environment, so it may remove values.

Numeric o Only integers
o Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

Community l ID
l Name
l Description
l Parent communities, up to the root level

o ID
o Name
o Description
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Object Migrated fields and secondary objects

Complex relation
type

l ID
l Name
l Description
l Display options

o Color
o Symbol (none, Icon or Code)
o Code
o Icon reference

l Attribute types
o ID
o Name
o Description
o Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

o Minimum cardinality
o Maximum cardinality

l Leg types (relation types)
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o Role
o Co-role
o Asset types that are head or tail of the relation types

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Business

asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled
o Minimum cardinality
o Maximum cardinality
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Data quality rule l ID
l Name
l Description
l Aggregation path

o Relation trace entries (path): The sequence of relation types and their
direction
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

o Categorization relation types
n ID
n Description
n Role

954



Object Migrated fields and secondary objects

n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

l Data Quality Metrics: attribute types of the Metric attribute type kind
o ID
o Name
o Description
o Attribute type kind and its properties

Kind Properties

Date None
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Kind Properties

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

Domain l ID
l Name
l Description
l Exclude from Autohyperlinking
l Domain type

o ID
o Name
o Description
o Parent domain types up to root

n ID
n Name
n Description

l Parent communities, up to the root level
o ID
o Name
o Description
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Domain type l ID
l Name
l Description
l Parent domain types up to root

o ID
o Name
o Description

Relation type l ID
l Description
l Role
l Co-role
l Head asset type

o ID
o Name
o Description
o Parent asset types, up to the root asset type (for example Business
asset)

o Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

o displayNameEnabled
o ratingsEnabled

l Tail asset type
o ID
o Name
o Description
o Parent asset types, up to the root asset type (for example Business
asset)

o Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

o displayNameEnabled
o ratingsEnabled
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Roles l No secondary objects
l ID
l Name
l Description
l Global
l Permissions
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Scope l ID
l Name
l Description
l Communities

o ID
o Name
o Description
o Parent communities, up to the root level

n ID
n Name
n Description

Note
o If the scope contains an entire community that contains
subcommunities and domains, the subcommunities and
domains are not included.

o If domains or communities are included in the scope, their parent
communities will be included too. Other children of its parent
community will not be included, unless they are also in the
scope.

o The domain type of the included domains are also included.

l Domains
o ID
o Name
o Description
o Exclude from Autohyperlinking
o Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

o Parent communities, up to the root level
n ID
n Name
n Description
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Status l ID
l Name
l Description
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Validation rule l Name
l ID
l Characteristic types that are referenced in the validation script

o Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

o Relation types
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
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n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

o Complex relation types
n ID
n Name
n Description
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties
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Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in
the target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

n Minimum cardinality
n Maximum cardinality

n Leg types (relation types)
n Role
n Co-role
n Asset types that are head or tail of the relation types

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
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n Icon reference
n displayNameEnabled
n ratingsEnabled
n Minimum cardinality
n Maximum cardinality

l The parent domain of the validation rule asset
o n ID

n Name
n Description

l The Validation Rule Domain type
o Parent domain types up to root

n ID
n Name
n Description

l The Validation Rule asset type
o Parent asset types, up to the root asset type (for example Business
asset)

l The status of the validation rule
o ID
o Name
o Description
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Workflow l Name
l Description
l Status
l Assignment rules (Applies To section)

o Asset types
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Business

asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

o Communities
n ID
n Name
n Description
n Parent communities, up to the root level

n ID
n Name
n Description

o Domains
n ID
n Name
n Description
n Exclude from Autohyperlinking
n Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

n Parent communities, up to the root level
n ID
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n Name
n Description

l Is Global Create
l Start label
l Configuration variables

o Asset types
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Business

asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

o Characteristic types
n Attribute types

n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in
the target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.
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Kind Properties

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

n Relation types
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
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n ratingsEnabled
n Complex relation types

n ID
n Name
n Description
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten
in the target environment, so it may remove
values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule
assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text
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Kind Properties

True/False

(boolean)

Metric

n Minimum cardinality
n Maximum cardinality

n Leg types (relation types)
n Role
n Co-role
n Asset types that are head or tail of the relation types

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example

Business asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled
n Minimum cardinality
n Maximum cardinality

o Communities
n ID
n Name
n Description
n Parent communities, up to the root level

n ID
n Name
n Description

o Domains
n ID
n Name
n Description
n Exclude from Autohyperlinking
n Domain type

n ID
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n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

n Parent communities, up to the root level
n ID
n Name
n Description

o Roles
o Status

n ID
n Name
n Description

l Business Item object type (i.e. Global vs Asset)
l Roles allowed to start
l Roles allowed to stop
l Roles allowed to reassign
l Start events
l Exclusivity
l Candidate user check disabled
l Guest user accessibility
l Registered user accessibility
l Process ID
l Workflow XML
l Flowable forms

Navigation objects
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Table view l ID
l Name
l Description
l Configuration
l Is preferred
l Is default
l Sharing rules
l Assignment rules

Chapter 28

971



Chapter 28

Object Migrated fields and secondary objects

Dashboard Any field referenced in a template of a widget:

l ID
l Name
l Asset types

o ID
o Name
o Description
o Parent asset types, up to the root asset type (for example Business
asset)

o Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

o displayNameEnabled
o ratingsEnabled

l Communities
o ID
o Name
o Description
o Parent communities, up to the root level

n ID
n Name
n Description

l Domains
o ID
o Name
o Description
o Exclude from Autohyperlinking
o Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

o Parent communities, up to the root level
n ID
n Name
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n Description
l Roles
l Status

o ID
o Name
o Description
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Diagram view Any object referenced in the diagram view or its filter:

l ID
l Name
l Asset types

o ID
o Name
o Description
o Parent asset types, up to the root asset type (for example Business
asset)

o Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

o displayNameEnabled
o ratingsEnabled

l Characteristic types , for example in an overlay.
o Attribute types

n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.
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Kind Properties

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

o Relation types
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
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n ratingsEnabled
o Complex relation types

n ID
n Name
n Description
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in
the target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

n Minimum cardinality
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n Maximum cardinality
n Leg types (relation types)

n Role
n Co-role
n Asset types that are head or tail of the relation types

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled
n Minimum cardinality
n Maximum cardinality

l Communities
o ID
o Name
o Description
o Parent communities, up to the root level

n ID
n Name
n Description

l Domains
o ID
o Name
o Description
o Exclude from Autohyperlinking
o Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description
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o Parent communities, up to the root level
n ID
n Name
n Description

l Roles
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Search filter Any object referenced in the search filter:

l Asset types
o ID
o Name
o Description
o Parent asset types, up to the root asset type (for example Business
asset)

o Display options
n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

o displayNameEnabled
o ratingsEnabled

l Characteristic types
o Attribute types

n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in the
target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)
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Kind Properties

Text Plain text

True/False

(boolean)

Metric

o Relation types
n ID
n Description
n Role
n Co-role
n Head asset type

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

n Tail asset type
n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled

o Complex relation types
n ID
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n Name
n Description
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n Attribute types
n ID
n Name
n Description
n Attribute type kind and its properties

Kind Properties

Date None

Multiple
selection

(Multi value
list)

Allowed values

Warning The list of allowed values is overwritten in
the target environment, so it may remove values.

Numeric n Only integers
n Metric

Script Language.

Note This field is only used for validation rule assets.

Selection

(single value
list)

Allowed values (adding values, AND removals)

Text Plain text

True/False

(boolean)

Metric

n Minimum cardinality
n Maximum cardinality

n Leg types (relation types)
n Role
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n Co-role
n Asset types that are head or tail of the relation types

n ID
n Name
n Description
n Parent asset types, up to the root asset type (for example Busi-

ness asset)
n Display options

n Color
n Symbol (none, Icon or Code)
n Code
n Icon reference

n displayNameEnabled
n ratingsEnabled
n Minimum cardinality
n Maximum cardinality

l Comments
l Communities

o ID
o Name
o Description
o Parent communities, up to the root level

n ID
n Name
n Description

l Domains
o ID
o Name
o Description
o Exclude from Autohyperlinking
o Domain type

n ID
n Name
n Description
n Parent domain types up to root

n ID
n Name
n Description

o Parent communities, up to the root level
n ID
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n Name
n Description

l Roles
l Status

o ID
o Name
o Description

Understanding the migration export report
After exporting model objects from a Collibra Data Intelligence Cloud environment, a
report is created and downloaded alongside the migration file itself. The report is an XLSX
file containing a summary of what has been exported.

Structure of the report
The report consists of three worksheets, each containing specific information:

Worksheet name Contents

Summary A table that shows the amount of objects of each type that were exported.

Primary
Resources

A table in which each row contains a primary object that you exported and the objects
that it requires.
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Worksheet name Contents

Associated
Dependencies

A table in which each row contains a secondary object that was exported to support a
primary or another secondary object. Its columns is identical to the Primary Resources
worksheet.

Columns on the Primary Resources and Associated Dependencies
worksheets

The tables on the Primary Resources and the Associated Dependencies worksheets
contain information about the exported objects and the objects they require. Each column
contains specific information:
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Column name Contents

ResourceType The type of the object that was exported.

For the primary resources, the available values are:

l Assignment
l Role
l View:ASSETTABLE
l View:DASHBOARD
l View:DIAGRAM
l View:DOMAINTABLE
l Workflow

For the associated dependencies, the available values are:

l AssetType
l AttributeType:BooleanAttributeType
l AttributeType:DateAttributeType
l AttributeType:NumericAttributeType
l AttributeType:ScriptAttributeType
l AttributeType:SingleValueListAttributeType
l AttributeType:StringAttributeType
l Community
l ComplexRelationType
l Domain
l DomainType
l RelationType
l Role
l Status

ID: The unique identifier of the object that was exported.

Name: The name of the object.
In most cases, the name is a clickable link that opens Collibra in your browser and shows you the
object. The main exceptions are objects of the View:DIAGRAM type and objects of the
View:ASSETTABLE type which are asset views containing a relation type on asset pages.

For most object types, this column contains only the name of the exported object. However,
there are some exceptions:

l Assignments are exported by asset type. As a consequence, the name is built up
accordingly: <asset type> : <assignment>.

Example Business Asset : Global Assignment.

l View:ASSETTABLE objects which represent an asset view containing a relation
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Column name Contents

type on asset pages have a name which is built up by several elements: assetType-
<asset type ID>|relation type-<relation type ID>. In some cases, the name is
followed by true|catalog.

Example assetType-00000000-0000-0000-0001-
000400000001|relationType-00000000-0000-0000-0000-
000000007062|true|catalog

l RelationType objects represent a relation type, which doesn't have a specific name.
Their name is built up as follows: [<head asset type>] <role> / <co-role> [<tail asset
type>].

Example [Business Asset] represents / represented by [Data Asset]

Dependencies: Overview of the secondary objects that are required by the object.
They are ordered by type and show the ID and the name of the secondary object.

ID The unique identifier of the object that was exported.
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Column name Contents

Name The name of the object.

In most cases, the name is a clickable link that opens Collibra in your browser and
shows you the object. The main exceptions are objects of the View:DIAGRAM type and
objects of the View:ASSETTABLE type which are asset views containing a relation
type on asset pages.

For most object types, this column contains only the name of the exported object.
However, there are some exceptions:

l Assignments are exported by asset type. As a consequence, the name is
built up accordingly: <asset type> : <assignment>.

Example Business Asset : Global Assignment.

l View:ASSETTABLE objects which represent an asset view containing a
relation type on asset pages have a name which is built up by several ele-
ments: assetType-<asset type ID>|relation type-<relation type ID>. In
some cases, the name is followed by true|catalog.

Example assetType-00000000-0000-0000-0001-
000400000001|relationType-00000000-0000-0000-0000-
000000007062|true|catalog

l RelationType objects represent a relation type, which doesn't have a spe-
cific name. Their name is built up as follows: [<head asset type>] <role> /
<co-role> [<tail asset type>].

Example [Business Asset] represents / represented by [Data
Asset]

Dependencies: Overview of the secondary objects that are required by the object.
They are ordered by type and show the ID and the name of the secondary object.

Dependencies Overview of the secondary objects that are required by the object. They are ordered by
type and show the ID and the name of the secondary object.
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Tracing dependents and precedents
For each object, you can trace whether it is required by another object and which
secondary objects it requires. Though this is not visually represented in the XLSX file, you
can identify the dependencies by means of the ID.

Learn more about the export logic of migration.

You can easily see which objects require which objects in the Dependencies column. A
quick way to trace dependents and precedents is to copy the ID of a dependent object, and
search for it in the entire workbook.

Tip
l All objects in the Associated Dependencies worksheet can be traced back to
one or more primary objects.

l You can let MS Excel find all matches in the entire workbook, which will give
you a quick overview of all occurrences of the ID on all worksheets of the
workbook.

Example 1: Precedents

You exported a number of workflows. You notice in the report that the Acronym asset type
was also exported. You want to know why that asset type was exported. You search for all
occurrences of the ID of the asset type in the entire workbook. You find concurrences on
the Associated Dependencies and/or Primary Resources worksheets, where you can see
which objects require the Acronym asset type.
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Example 2: Dependents

You exported the Issue Creation Workflow. In the Dependencies column, you see that it
requires the [Issue] impacts / impacted by [Asset] relation type. You want to see whether
that relation type in turn also requires other objects to be exported. You search for all
occurrences of the ID of the relation type in the entire workbook. You find the row on the
Associated Dependencies worksheet, where you can check its dependencies.
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Import model objects
Using the Migration feature, you can import an archive file containing model objects of a
Collibra Data Intelligence Cloud environment.

Note Exporting and importing CMA files is restricted by the file upload settings,
which determine the maximum file size, allowed file extensions and maximum
amount of uploads and downloads per day. Contact Collibra support if you want to
change the file upload settings.

Warning
l Importing model objects cannot be undone. Make sure that there is a recent
backup available before doing this.

l The versions of the source and target environment have to be the same.
Migrating between different versions may lead to unexpected behavior.
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Prerequisites
l You have a global role that has the System administration global permission.
l An archive file that was exported from an environment that has the same Collibra ver-
sion.

l A backup of the environment.

Steps

1. On the main menu, click , and then click Settings.

» The Collibra settings page opens.
2. Click Migration.

» The migration page appears on the Export tab page.
3. In the tab pane, click Migration → Import.

» The Migration Import page appears.
4. Upload an archive file in one of the following ways:

o Drag and drop the file in the upload area.
o Click Upload a file, browse to the location of the file and click Open.

» An overview of the model objects that will be added, edited, or removed appears.

Number Description

Details about the uploaded archive file.

A table that shows, for each type, the number of model objects
that will be added, edited, or removed.

When you select a specific type, the list of model objects
appears. For each model object, you can see what will happen.
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Number Description

When you select a specific model object, details about change
appear.

5. Review the import simulation by verifying the model objects that will be added,
edited, and removed.

6. Click Import.
» The Confirm import dialog appears.

7. Select I have an up-to-date backup containing the data and history of this Collibra
platform.

8. Click Import.
» The archive file is imported, meaning that model objects are created, edited, or
removed as necessary. This can take some time.
» Once the import is completed, you can download an import report.

Migration import logic
The import logic determines how migrated objects are matched to objects in the target
environment, and what happens if a match is found.

Import matching
During import, Collibra Data Governance Center tries to match each migrated object with
an object in the target. In most cases, matching is done first based on the ID of the object.
If the target environment does not have an object matching the ID, the matching algorithm
will try to use a logical key. This logical key may be different depending of the type of
object.
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1. By ID
2. By logical key

Tip
In most cases, the logical key is the Name field, within the same type of object.
For others, it is usually a combination of properties. For example:

o For relation types, the logical key is the combination of the source (head)
asset type, the role, the co-role and the target (tail) asset type.

o For assignment, the logical key is the combination of the asset type ID
and scope ID.

Outcome of importing an object
Depending on the similarity of the objects in the archive and the target environment,
importing an archive may create or edit objects.

Tip Migration will never delete objects, but it may reduce assignments, rename
assets and so on.

The table below contains the general import logic.

Outcome When Description

A matched
object is not
edited.

1. A match is found
based on the match-
ing logic.

2. The matched object
has the same prop-
erties as the
migrated object.

If the migrated object and the object in the target environment
have the same properties, nothing happens.
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Outcome When Description

A matched
object is
edited.

1. A match is found
based on the match-
ing logic.

2. The matched object
has different prop-
erties than the
migrated object.

The matched object will be edited with the properties from the
migrated object. Migration will never delete objects, but it may
reduce assignments, rename assets and so on.

Example
l If you migrate an assignment that includes
fewer characteristic types than in the target,
Collibra removes those characteristic types
from the assignments, but does not delete the
actual characteristic types.

l If you migrate a view with a filter on a
community that has a different name in the
target, Collibra renames the community in the
target.
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Outcome When Description

An
unmatched
object is
updated.

1. A match is found
based on the ID of
the objects, but
they have different
names.

2. In the target envir-
onment, another
object has the
same name as the
migrated object.

1. The name of the existing object with the same name
will be changed to <original name>-Migra-

tion-YYYYMMDD hh:mm:ss.
2. The matched object will be edited with the properties

from the migrated object, including the name.

Example
Before the import:

l The target environment contains an asset type
with the following information: Name:
Crawler, ID: 0000.

l The target environment contains a second
asset type with the following information: Name:
AWS Crawler, ID: 1111.

l The archive contains an asset type with the
following information: Name: AWS Crawler,
ID: 0000.

After the import:

l The target environment contains an asset type
with the following information: Name:
AWS Crawler, ID: 0000.

l The target environment contains a second
asset type with the following information: Name:
AWS Crawler-Migration-20210101
13:15:12, ID: 1111.

A new object
is created.

If no match is found. A new object is created with all properties from the migrated
object, including the ID.

Import logic by object
Depending on the migrated object, different fields and secondary objects are exported
along with it. This also affects the matching logic when these objects are imported in the
target environment. The table below gives further information about how primary and
secondary objects are imported.
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Object Import logic

Asset Matching logic based on:

1. ID
2. Full name and parent domain

The following table contains the possible cases and results.

Case Matched asset
1

Matched asset
2

Result

1 ID n/a Matched asset 1 is updated.

2 Full name
and parent
domain

n/a Matched asset 1 is updated.

3 None n/a A new asset is created.

Note Assets in system-owned domains (for example Issues) cannot be
migrated.
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Object Import logic

Asset type Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched asset
type 1

Matched asset
type 2

Result

1 ID and name n/a Matched asset type 1 is updated.

2 ID Name Matched asset type 1 is updated.

Matched asset type 2 is renamed.

3 Name n/a Matched asset type 1 is updated.

4 ID n/a Matched asset type 1 is updated.

5 None n/a A new asset type is created.

Note
l If for an asset type, ratings are disabled in the archive file, but the
matched asset type in the target environment has ratings enabled,
the import will fail. This is because migration cannot delete the
ratings of assets of that type.

l Asset types are imported using the depth-first order.
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Object Import logic

Assignment Matching logic based on:

1. ID
2. Asset type and scope

The following table contains the possible cases and results.

Case Matched
assignment 1

Matched
assignment 2

Result

1 ID n/a Matched assignment 1 is updated.

2 Asset type
and scope

n/a Matched assignment 1 is updated.

3 None n/a A new assignment is created.

Note Assignments are imported in a specific order:

1. Global assignments
2. Scoped assignments
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Object Import logic

Attribute Matching logic based on:

1. ID
2. Combination of parent asset, attribute type and value

The following table contains the possible cases and results.

Case Matched object
1

Matched
object 2

Result

1 ID n/a Matched object 1 is updated.

2 Combination of
parent asset,
attribute type
and value

n/a Matched object 1 is updated.

3 None n/a A new object is created.

Note
l Attributes in system-owned domains (for example Issues) cannot
be migrated.

l The only fields that you can migrate are validation scripts of
validation rule assets and description fields of any resource.
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Object Import logic

Attribute type Matching logic based on:

1. ID, name and kind
2. Name and kind
3. ID and kind

The following table contains the possible cases and results.

Case Matched
attribute type 1

Matched
attribute type 2

Result

1 ID, name and
kind

n/a Matched attribute type 1 is updated.

2 ID and name n/a Matched attribute type 1 is renamed.

A new attribute type is created.

Note
Because you cannot edit the attribute
type kind through Collibra's UI, this
can only be done if:

1. An attribute type is deleted.
2. Using the Java/REST API, a

new attribute type is created
with the same name and ID as
the deleted attribute type, but
with a different kind.

3 Name n/a Matched attribute type 1 is renamed.

A new attribute type is created.

4 Name and
kind

n/a The ID of matched attribute type 1 is updated.

5 ID and kind n/a Matched attribute type 1 is renamed and
updated.
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Case Matched
attribute type 1

Matched
attribute type 2

Result

6 ID n/a A new attribute type is created with a new ID.

Note
Because you cannot edit the attribute
type kind through Collibra's UI, this
can only be done if:

1. An attribute type is deleted.
2. Using the Java/REST API, a

new attribute type is created
with the same name and ID as
the deleted attribute type, but
with a different kind.

7 ID and kind Name and kind Matched attribute type 2 is updated.

8 ID and kind Name Matched attribute type 1 is renamed and
updated.

Matched attribute type 2 is renamed.

9 ID Name and kind Matched attribute type 2 is updated.

10 ID Name Matched attribute type 2 is renamed.

A new attribute type is created with a new ID.

11 None n/a A new attribute type is created.

Note If you import an attribute type of the kind Selection or Multiple Selection
via the Solution install, allowed values from the CMA file are added to the list of
allowed values in the target environment.

Tip If you know that fundamental changes were made to attribute types, you
can avoid import problems by deleting attribute types in the target migration
before importing the archive.
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Object Import logic

Community Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched
community 1

Matched
community 2

Result

1 ID and name n/a Matched community 1 is updated.

2 ID Name Matched community 1 is updated.

Matched community 2 is renamed.

3 Name n/a Matched community 1 is updated.

4 ID n/a Matched community 1 is updated.

5 None n/a A new community is created.

Note Communities are imported using the depth-first order.
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Object Import logic

Complex relation
type

Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched
complex
relation type 1

Matched
complex
relation type 2

Result

1 ID and name n/a Matched complex relation type 1 is updated.

2 ID Name Matched complex relation type 1 is updated.

Matched complex relation type 2 is renamed.

3 ID n/a Matched complex relation type 1 is updated.

4 Name n/a Matched complex relation type 1 is updated.

5 None n/a A new complex relation type is created.

Note
l When a complex relation leg type has the same role, co-role and
target asset type than an existing one in the matched complex
relation type, the existing one will be updated, even when the ID is
different. Adding a second relation type with the same properties
would result in an error.

l Updating the assignment of a complex relation type which impacts
leg types and attribute types can remove a leg type if it is no longer
included in the migration archive. If the leg type has instance data,
the import will fail.

l Migration does not update leg types when source, target, role, co-
role are identical.
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Object Import logic

Data quality rule Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched data
quality rule 1

Matched data
quality rule 2

Result

1 ID and name n/a Matched data quality rule 1 is updated.

2 ID Name Matched data quality rule 1 is updated.

Matched data quality rule 2 is renamed.

3 Name n/a Matched data quality rule 1 is updated.

4 ID n/a Matched data quality rule 1 is updated.

5 None n/a A new data quality rule is created.
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Object Import logic

Domain Matching logic based on:

1. ID and name
2. Name and parent community
3. ID

The following table contains the possible cases and results.

Case Matched
domain 1

Matched
domain 2

Result

1 ID and name n/a Matched domain 1 is updated.

2 ID Name and
parent com-
munity

Matched domain 1 is updated.

Matched domain 2 is renamed.

3 Name and
parent com-
munity

n/a Matched domain 1 is updated.

4 ID n/a Matched domain 1 is updated.

5 None n/a A new domain is created.

Note Issue domains cannot be migrated
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Object Import logic

Domain type Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched
domain type 1

Matched
domain type 2

Result

1 ID and name n/a Matched domain type 1 is updated.

2 ID Name Matched domain type 1 is updated.

Matched domain type 2 is renamed.

3 Name n/a Matched domain type 1 is updated.

4 ID n/a Matched domain type 1 is updated.

5 None n/a A new domain type is created.

Note Domain types are imported using the depth-first order.
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Object Import logic

Relation type Matching logic based on:

1. ID, source asset type and target asset type
2. Source asset type, target asset type, role and co-role

The following table contains the possible cases and results.

Case Matched
relation type 1

Matched
relation type 2

Result

1 ID, source
asset type and
target asset
type

n/a Matched relation type 1 is updated.

2 ID Source asset
type, target
asset type,
role and co-
role

Matched relation type 2 is updated.

3 Source asset
type, target
asset type,
role and co-
role

n/a Matched relation type 1 is updated.

4 None n/a A new relation type is created.

Chapter 28

1007



Chapter 28

Object Import logic

Roles Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched role 1 Matched role 2 Result

1 ID and name n/a Matched role 1 is updated.

2 ID Name Matched role 1 is updated.

Matched role 2 is renamed.

3 Name n/a Matched role 1 is updated.

4 ID n/a Matched role 1 is updated.

5 None n/a A new role is created.
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Object Import logic

Scope Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched
scope 1

Matched
scope 2

Result

1 ID and name n/a Matched scope 1 is updated.

2 ID Name Matched scope 1 is updated.

Matched scope 2 is renamed.

3 Name n/a Matched scope 1 is updated.

4 ID n/a Matched scope 1 is updated.

5 None n/a A new scope is created.

Note The global scope cannot be migrated.
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Object Import logic

Status Matching logic based on:

1. ID and name
2. Name
3. ID

The following table contains the possible cases and results.

Case Matched
status 1

Matched
status 2

Result

1 ID and name n/a Matched status 1 is updated.

2 ID Name Matched status 1 is updated.

Matched status 2 is renamed.

3 Name n/a Matched status 1 is updated.

4 ID n/a Matched status 1 is updated.

5 None n/a A new status is created.
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Object Import logic

Validation rule Matching logic based on:

1. ID
2. Full name and parent domain

The following table contains the possible cases and results.

Case Matched
validation rule
1

Matched
validation rule
2

Result

1 ID n/a Matched validation rule 1 is updated.

2 Full name
and parent
domain

n/a Matched validation rule 1 is updated.

3 None n/a A new validation rule is created.

Note If there is a match, only the Description and Validation script are
changed. Other characteristics are not changed.

Workflow Matching logic based on:

1. Workflow process ID
2. Workflow name

The following table contains the possible cases and results.

Case Matched
workflow 1

Matched
workflow 2

Result

1 Process ID and
workflow name

n/a Matched workflow 1 is updated.

2 Process ID Workflow
name

Matched workflow 1 is updated.

Matched workflow 2 is renamed with a suffix of

- $processId.

3 None n/a A new workflow is created.

Navigation objects
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Object Import logic

Table view Matching logic based on:

1. ID
2. Name, type, location and common assigned resources

The following table contains the possible cases and results.

Case Matched
table view 1

Matched table
view 2

Result

1 ID n/a Matched table view 1 is updated.

2 Name, type,
location and
at least 1
common
assigned
resource

n/a Matched table view 1 is updated.

3 None n/a A new table view is created.

Dashboard Matching logic based on:

1. ID
2. Name, type, location and common assigned resources

The following table contains the possible cases and results.

Case Matched
dashboard 1

Matched
dashboard 2

Result

1 ID n/a Matched dashboard 1 is updated.

2 Name, type,
location and
at least 1
common
assigned
resource

n/a Matched dashboard 1 is updated.

3 None n/a A new dashboard is created.
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Object Import logic

Diagram view Matching logic based on:

1. ID
2. Name, type, location and common assigned resources

The following table contains the possible cases and results.

Case Matched
diagram view
1

Matched
diagram view 2

Result

1 ID n/a Matched diagram view 1 is updated.

2 Name, type,
location and
at least 1
common
assigned
resource

n/a Matched diagram view 1 is updated.

3 None n/a A new diagram view is created.

Search filter Matching logic based on:

1. ID
2. Name, type, location and common assigned resources

The following table contains the possible cases and results.

Case Matched
search filter 1

Matched
search filter 2

Result

1 ID n/a Matched search filter 1 is updated.

2 Name, type,
location and
at least 1
common
assigned
resource

n/a Matched search filter 1 is updated.

3 None n/a A new search filter is created.
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Migration import troubleshooting
In some very specific situations, the Migration feature has some limitations which may lead
to undesired effects. This topic describes a situation in which objects seem to disappear
during the import.

Import logic
For each object in the migration file, the Migration feature tries to find a match in the target
environment. First, it looks for objects of the same object type and with the same ID. If no
matches are found, it looks for objects of the same object type with the same logical key.
For most objects, this is the name. For more information about the import logic see
Migration import logic.

Summary
The same object exists in your source and target environment. You renamed the object in
your source environment, and created an object of the same type and gave it the original
name of the first object. This may cause the import feature to overwrite the first object
when importing in the target environment.

Detailed explanation

1. In the beginning, the source and the target environment are the same.
2. You edit the name of an existing source object, and optionally other properties.

» This has no effect on the ID of the first source object.
3. You create an object of the same type and gave it the original name of the first object.
4. You export both source objects to a migration file.
5. You import the migration file in the target environment.

» When importing the migration file in the target environment, two scenarios can take
place.
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Scenario 1: The older object is processed first.

a. The import logic looks for the first target object based on the ID.
» The import logic finds the first target object.

b. The import logic overwrites the first target object with the first source object.
» This does not affect the ID, but it does change the name of the first target object.

c. The import logic looks for the second object based on the ID.
» The import logic does not find the second target object.

d. The import logic looks for an object based on the name.
» The import logic does not find the second target object.

e. The import logic creates a new object with the properties of the second source object,
including its name.

f. The two objects in the two environments are identical.

Scenario 2: The newer object is processed first.

a. The import logic looks for the second target object based on the ID.
» The import logic does not find a target object.

b. The import logic looks for the second object based on the name.
» The import logic finds the target object of the first source object.

c. The import logic overwrites the first source object with the second target object.
» This has no effect on the ID.

d. The import logic looks for the first target object based on the ID.
» The import logic finds the first target object, which was overwritten by the second
source object.

e. The import logic overwrites the first source object again, this time with the first target
object.
» This does not affect the ID, but it does change the name of the first target object.

f. The second target object does not exist in the target environment.

Replace the Collibra logo
By default, Collibra Data Intelligence Cloud has the Collibra logo on the sign-in page and
in the top-left corner.

You can use your own images:

Chapter 28
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l As the logo in the upper-left corner.
l On the sign-in page and while opening Collibra.

Warning From version 2022.11 onwards, you can no longer edit the user interface
configuration of new features. This includes Usage Analytics, Data Marketplace and
the Homepage.

Prerequisites
l You have the SUPER role in Collibra Console.
l You need knowledge of the JSON syntax.
l You need images with the following properties:

o The recommended image format is SVG, but JPG and PNG are also sup-
ported.

o The dimensions of the image on the sign-in page must be 310 x 85 px (w x h).
o The dimensions of the logo in Collibra must be 50 x 45 px (w x h).
o If the custom image is larger, it will be resized to the mentioned dimensions, so
make sure that the custom logo has the same width/height ratio.

Steps
1. Add your images to the Collibra folder structure:

a. Open Collibra Console with a user profile that has at least the ADMIN role.
» Collibra Console opens the Infrastructure page.

b. Create a backup of your cloud environment that only includes the cus-
tomizations and configuration.

c. Download the backup.
» A ZIP file is downloaded to your hard disk.

d. Edit the backup:
i. Extract the ZIP file on your local computer.
» A folder with the name of the ZIP file is created.

ii. In the created folder structure, go to <backup-dir>/dgc/images.

Note If any of these folders do not exist, create them.

iii. Copy your images to this folder.
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iv. In your file browser, open the extracted backup folder with the new logos.
v. Create a ZIP file of all the contents in this folder.

Warning Do not create a ZIP file from the extracted directory
itself. Doing so will result in an invalid backup file.

e. Restore the new backup file:
i. Upload the new ZIP file to Collibra Console.
ii. Restore the customizations and configuration of the new ZIP file.
iii. Wait until your environment is up and running again.

2. Contact Collibra support to edit the user interface configuration to use the images.

What's next?
Sign in to Collibra to see the new images. If you signed in before, you may have to clear
your browser cache.

Tip You can also change the loading message by editing the
ui.core.loadingapplication key of the interface text.

Use a custom favicon
By default, Collibra Data Intelligence Cloud has the Collibra logo as favicon. You can also
upload the favicon of your own organization.

Warning From version 2022.11 onwards, you can no longer edit the user interface
configuration of new features. This includes Usage Analytics, Data Marketplace and
the Homepage.

Prerequisites
l You have the ADMIN or SUPER role in Collibra Console.
l Your favicon has the name favicon.ico.
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Steps
1. Create a backup of your cloud environment that only includes the customizations

and configuration.
2. Download the backup.
3. Edit the backup:

a. Extract the backup somewhere on your local computer.
A folder with the name of the ZIP file is created.

b. In the created folder structure, go to <backup-dir>/dgc/images/icons.

Note If any of these folders do not exist, create them.

c. Copy your favicon.ico in this folder.
d. Create a ZIP file of all the content inside the backup folder.

Do not create a ZIP file from the extracted directory itself, this would result in an
invalid backup file.

4. Restore the new backup file:
a. Upload the new ZIP file to Collibra Console.
b. Restore only the customizations and configuration of the new ZIP file.
c. Wait until your environment is up and running again.

5. Clear the cache of your browser and go to your environment.
» Your own favicon will appear.
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	 Collibra functionalitiesIn this section, you find more information about the general functionalities of Collibra Data Intelligence Cloud such as searching for data, using dashboards and the global Create button.In this chapterScreen elements in the user interfaceThe Collibra Data Intelligence Cloud user interface contains a number of common elements that appear throughout the product. You can navigate through Collibra Data Intelligence Cloud using your mouse or keyboard. For more information, see Accessibility.Page layoutNo.Element nameDescriptionHome buttonOpen the Homepage or your default dashboard.Navigation browserOpen the Browse pane.Search fieldSearch for any resource in Collibra. buttonCreate any resource from any location.Shopping basketRequest access to data sets and reports.Tasks indicatorCheck how many workflow tasks are awaiting your attention and manage those tasks from the My tasks page.Activities trackerCheck the Collibra activities and view the history of all the jobs you started. InfoGet access to the product documentation, to Collibra Product Resource Center and University, and to the Collibra support portal.If you have the Sysadmin role, you can access the API documentation.AvatarView and modify your profile, sign out, and report a problem.Application menuOpen another application: Business Glossary: Manage your business terms.   Catalog: Manage data sets.   Policy manager: Manage your organization's policies.   Reference Data: Manage your code values and code sets. Global view: See all assets in a single view. Data Helpdesk: Manage issues.   Stewardship: Manage your tasks.   Settings: Manage your data governance operating model and your users.SubmenuOpen one of the subpages of the current application.View selectorSwitch between views.View toolbarManage the current view.Filter paneFilter the resources in the view.  Action toolbarPerform actions on the assets that you selected in the view or start a workflow.Content toolbarManage the resources in the current view.Table or set of tilesSee the resources in the current view in a table or as tiles. Arranging list itemsOn some pages and in some dialog boxes, you can arrange list items to change the order of their appearance on the page. For example when adding fields to a view or editing an asset type assignment.You can have arrangeable lists in dialog boxes and on regular pages. You can arrange the list items in the same way.In a dialog boxOn a pageMoving items by dragging and droppingThe easiest way to move items up or down is typically by dragging and dropping:Click in front of an item and hold down the mouse button.Move your mouse to the desired location in the order.Release the mouse button.Moving items via the drop-down menuEach item also has a drop-down menu that allows you to quickly change the position of the item in the list:Click  in front of an item.Perform one of the following steps:Click Top to move the item to the top of the list.Click Bottom to move the item to the bottom of the list.Point to Before and click an item in the list to move the current item to the position above the clicked item.AccessibilityIn an effort to make all Collibra applications accessible for visually or physically impaired users, all applications are gradually being upgraded to meet accessibility requirements as set out in the Section 508 Standards (US) and WCAG 2.0 (Worldwide).Collibra has taken measures to ensure accessibility, for example:Icons and text have sufficient contrast with the background.Images have clear alternative text to facilitate the use of third-party assistive technology.Navigation on our pages is enhanced, for example, you can open a link in a new tab.You can navigate through most screen sections by keyboard.You can edit interface text to make messages less dependent on visual screen elements.Navigating using your keyboardAs part of the accessibility goals of Collibra, you can navigate using your keyboard.ActionDescriptionMoving the focus pointThe focus point indicates the current focus of your navigation. If you hover your mouse pointer over an element, you typically see the background change, or text becomes underlined.When you use the keyboard, the same effect takes place as when you hover your mouse pointer. However, rather than moving your mouse, you can jump to the next element using the tab key on your keyboard. You can also press shift + tab to jump to the previous element.ExampleTypeUnfocused elementFocused elementButtonLinkClicking and activating screen elementsPress enter to activate an element when it is the focus point. This allows you to press a button or open a link, using your keyboard rather than clicking.Opening and closing dialog boxes and pop-upsClick any dialog box or pop-up to open it. You can navigate in the dialog boxes and pop-ups just as you would anywhere else. To close it, press escape.Selecting and clearing checkboxesNavigate to a checkbox and press the space bar to select it or clear it.Selecting radio buttonsUse the arrow keys on your keyboard to select radio buttons. Navigate to the radio buttons using the tab key, then press ←, →, ↓ or ↑ to change which radio button is selected.Skipping repetitive sectionsMost pages in Collibra Data Intelligence Cloud contain repetitive sections at the top of the page, such as the main menu. You can skip this section using the Skip to content button. This button is the first available element when you start navigating in a repetitive section using your keyboard.Signing in and signing outAs soon as you have a user account, you can sign in to Collibra Data Intelligence Cloud.Sign inGo to any page of your environment.The Sign-in page opens.Enter your username and password.If a disclaimer is enabled, you have to agree with the disclaimer to sign in. If you don't agree with the disclaimer, you are signed out automatically.If Single Sign-On (SSO) is configured for your environment, you can be signed in automatically if you are signed in to the SSO system.By default, the username is case-sensitive. However, some LDAP configurations make the username not case sensitive.Sign outClick your avatar, then Sign out.The Sign-in page opens.Depending on your environment's configuration, you may be signed out automatically if you are inactive for a certain period of time. Most of the changes you have made during your session will be saved. However, if you had a text field or dialog box open when you were signed out, that information may be lost.Access a community, domain, asset view, or dashboardYou can access a community, domain, asset view, or dashboard via the Browse pane.The Browse pane provides an overview of the following:All communities and domains on the Organization tab.      By default, the Organization tab shows only the top-level communities. To view the subcommunities and domains in a community, click next to the community name. When you click a community or domain, the corresponding community or domain page appears. This page contains the community or domain details and allows you to make changes.All pinned asset views on the Asset Views tab.All dashboards on the Dashboards tab.      You can search for a community, domain, asset view, or dashboard by using the search field.The Create buttonIn Collibra Data Intelligence Cloud, there is a green Create button at the top of the screen. It enables you to create any resource from any location, if you have the correct permissions.The following table describes the categories of resources you can create with the Create button:ItemDescriptionSuggestedA list of resources that you might want to create. The resources available to you here depend on your location in Collibra:   If you are on one of the submenu pages, for example, Business assets, Metrics or Glossaries, the suggested resources are specific to that submenu page.  If you are on a domain page, the suggested resources are all the asset types that are assigned to the domain.  If you are on a community page, the suggested resources are all the asset types that are assigned to the domains in the community.  If you are on an asset page, the suggested resource is an asset of that same type. This list is not available when you click the Create button from the default dashboard.RecentA list of recently created resources, most recent first.ActionsA list of global workflows that have the option Show in global create enabled.AssetA list of all the asset types that are available in your data governance model. The list is divided into sections, according to the parent asset type, for example, Business Asset or Data Asset.OrganizationA list of organizational resources, such as a Community or a Business Asset Domain.To quickly find what you are looking for, you can type a search term in the Filter field. The results are based on the category you selected.You can only create assets of a certain type in a certain domain if that asset type has been assigned to that domain.If you try to create an asset of a type that is not assigned to the domain you are currently in, the Domain field in the Create dialog box is not automatically filled in.Views in CollibraViews in Collibra Data Intelligence Cloud define how you can look at lists of assets. You can configure views to see, for example, tables or a set of tiles. A view is also the basis for Importing and exporting.While you are working with a view, Collibra stores your view configuration when you navigate to a different page and even when you sign out. You can also undo your changes.ViewsA view defines a table or set of tiles by storing the following data:The display mode, to specify whether assets are shown in a table or as tiles.Filters, to specify which assets are displayed.Applied sorting, to specify the order of the assets.Visible columns (for tables) or fields (for tiles), to specify which information about assets is displayed.Hierarchy, to display, optionally, a hierarchy of assets instead of a flat list (not applicable in tile display mode).You can create as many views as you want without causing problems for Collibra's performance.A view is also the basis for Importing and exporting.Example of a view in table display mode:Example of a view in tile display mode:When you view a table or set of tiles for the first time, you are using the Collibra DGC default view, unless somebody already shared a custom view as default with you.Each view has a unique URL. You can use this URL to open the view directly, without having to navigate to the location. For example, you can embed the view URL in a text widget on a dashboard, in an email and so on. You can simply copy the URL from the address bar and paste it where needed.View typesCollibra offers different types of views:DashboardsSearch filtersDiagram viewsRelation views on an asset pageAsset views, for example in a domain or community, in the global view and in application views.Asset views are available in the following applications:ApplicationTabs with a view selectorBusiness GlossaryBusiness AssetsGlossariesReference DataCode Values/SetsHierarchiesData CatalogReportsData SetsData DictionaryTechnology AssetsData HelpdeskIssuesData QualityData StewardshipBusiness DimensionsPolicy ManagerGovernance AssetsView selector and toolbarThe view selector allows you to switch between views and the view toolbar to manage the currently selected view.It appears in views containing a table or a set of tiles.The view bar has the following items:NumberButtonDescription1n/aThe view selector shows the name and description of the current view, and allows you to choose another view.2Button to edit the name and the description of the current view.3Button to save changes to the current view, or to create a new view.4Button to share the current view.5Button to delete the current view.Create a viewYou can create a view, for example, if you want it to contain specific fields and display assets based on a filter.You can create as many views as you want without causing problems for Collibra's performance.StepsNavigate to the set of assets (in table display modes or tile display mode) for which you want to create a view.Example: Business GlossaryIf you want to start from the configuration of an existing view, switch to that view.Set the required filters.Customize the table or customize the set of tiles.Optionally, enable hierarchy or wrap text (not applicable in tiles display mode).On the right side of the view bar, click .       In the view toolbar, click , then Save as.The Save view as dialog box appears.Enter the required information.OptionDescriptionNameThe name of the new view.DescriptionOptional. The description of the new view. You can add extra information about the view if necessary.View sharing optionsThe sharing options allow you to share the view:Public: All Collibra Data Intelligence Cloud users can use the new view.Private: Only the creator of the view can use the new view.Share with specific roles, groups & users: The users with whom you want to share the new view. You can select Roles, Groups and Users.              Promote viewYou can promote the view by pinning it to the view or making it the default view:Default: The new view becomes the default view when you open the table or set of tiles.Pin: The view is pinned to the view selector.Click Save.Edit a viewYou can edit a view, for example, if you want it to change its name.StepsNavigate to the set of assets (in table display mode or tile display mode) for which you want to edit a view.Example: Business GlossarySwitch to the view that you want to edit.       In the view toolbar, click .The Edit name & description dialog box appears.Enter the required information.OptionDescriptionNameThe name of the new view.DescriptionOptional. The description of the new view. You can add extra information about the view if necessary.Click Save.Edit a view's configurationYou can edit a view, for example, if you want it to change its fields and filters.StepsNavigate to the set of assets (in table display mode or tile display mode) for which you want to edit a view.Example: Business GlossarySwitch to the view that you want to edit.If required, do the following:Edit the view's filters.Customize the table or customize the set of tiles.Enable hierarchy or wrap text.       In the view toolbar, click , then Save.Share a viewYou can share a view, for example, if you want to give other users access to it.StepsNavigate to the set of assets (in table display mode or tile display mode) for which you want to edit a view.Example: Business GlossarySwitch to the view that you want to edit.On the right side of the view bar, click .The Share view dialog box appears.Enter the required information.OptionDescriptionView sharing optionsThe sharing options allow you to share the view:Public: All Collibra Data Intelligence Cloud users can use the new view.Private: Only the creator of the view can use the new view.Share with specific roles, groups & users: The users with whom you want to share the new view. You can select Roles, Groups and Users.              Promote viewYou can promote the view by pinning it to the view or making it the default view:Default: The new view becomes the default view when you open the table or set of tiles.Pin: The view is pinned to the view selector.Click Save.Delete a viewYou can delete a view, for example, if you no longer need it.You can delete a view in several ways:From the view bar.From the overview.Delete a view from the view barNavigate to the set of assets (in table display mode or tile display mode) for which you want to delete a view.Example: Business GlossarySwitch to the view that you want to delete.       In the view toolbar, click .The Delete view <view name> dialog box appears.Click Delete view.Delete a view from the overviewNavigate to the set of assets (in table display mode or tile display mode) for which you want to delete a view.Example: Business GlossaryIn the view selector, click , then Show all.In the table, click  at the end of the row of the view you want to delete.The Delete view <view name> dialog box appears.Click Delete view.Pin a view to the view selectorYou can pin a view to the view selector if you want to make it easier to open it.StepsNavigate to the set of assets (in table display mode or tile display mode) for which you want to edit a view.Example: Business GlossaryClick the view selector, then Show all...In the views table, click the thumbtack () to the left of the views you want to pin or unpin.Switch between viewsYou can switch between views, for example, if you want to see the information of another view.StepsNavigate to the set of assets (in table display mode or tile display mode) for which you want to edit a view.Example: Business GlossaryIn the view selector, click next to the name of the current view.Do one of the following:If...then...The view you want to display is in the list,Click the view in the drop-down menu.The view you want to display is not in the list,Click Show all. Click the name of the view you want to display.Global viewsGlobal views enable you to show all assets of Collibra Data Intelligence Cloud in one view, regardless of their community, domain or application. You can use all view features, such as: Change the display mode to table or tiles.Create views with different fields and filters.Import and export the assets or complex relations in the view.Open a global view    On the main menu, click   , and then click   Global view.  If required, switch to another view.Timeout period for the loading of tables and tilesIn some cases, the loading of a table or set of tiles can take a while. This can happen if the view contains a lot of data, or if it has complex sorting and filtering applied. The timeout period is a time limit (in seconds) after which the loading task is stopped and a timeout error is shown. If the timeout period expires before the view has loaded, you can try refreshing the view or, if applicable, simplifying its configuration by:Removing basic or advanced asset filters.Removing the sorting on multiple columns (tables only).Reducing the row count or tiles count.Reducing the number of columns (in a table) or fields (in a set of tiles). You can configure the maximum loading time of tables.Configure the maximum loading time of tablesIn some cases, the loading of a table or set of tiles can take a while. You can configure the maximum loading time.Depending on your environment, follow this procedure either in the Services Configuration section of the Collibra settings or in Collibra Console. This topic contains the procedure for Collibra Console. If your Settings page has a Configuration tab, you can follow this procedure on that tab. For more information, go to the online documentation.PrerequisitesYou have the ADMIN or SUPER role in Collibra Console.You have the SUPER role in Collibra Console.StepsOpen the DGC service settings for editing:Open Collibra Console.Collibra Console opens with the Infrastructure page.In the tab pane, expand an environment to show its services.    In the tab pane, click   the Data Governance Center service of that environment.Click Configuration.Click Edit configuration.Go to the Table section.Enter the required information:SettingDescriptionTime limit for loading data in tables in secondsEnter the maximum amount of seconds to load a table. If this time is exceeded, a timeout error is displayed. The default value is 60.A value of 0 means that there is no time limit. Click Save all.Asset filtersAsset filters enable you to quickly find the data in Collibra Data Intelligence Cloud by limiting the amount of assets shown in a table or a set of tiles. You can find the filter function on almost every page containing data.In this section, you can learn how to work with filters.Basic and advanced filteringCollibra Data Intelligence Cloud has two modes for filtering data:Basic: Filter data by creating simple filter expressions that are always combined by the logical AND function.Advanced: Filter data by creating complex filter expressions. An advanced filter is a combination of filter expressions that can be combined by using the logical AND and OR functions. In the filter pane, you can toggle between basic and advanced filtering:Basic filtering:Advanced filtering:When you have applied a filter, you can save the view for later usage.Basic filtersYou can create basic filters by adding filter expressions. A filter expression is created by selecting a characteristic and assigning one or more values to it. In a basic filter, you can combine multiple expressions.The characteristics are grouped in the following categories:Properties: All the asset properties in Collibra such as name, asset type, tags and so on. Attributes: All the asset attributes in Collibra, such as note, definition, quality and so on.Relations: All the relations in Collibra.Roles: All the resource roles that are defined in Collibra, such as Requester, Assignee, Reviewer and so on.To add characteristics to the filter, consult Create a basic filter.Filter behaviorMultiple values for one characteristic are treated as an OR clause.Example: The example filters the assets if the asset type is Acronym or Business Term.All the simple expressions in a basic filter are treated as an AND clause.You can remove a filter characteristic by clicking next to the filter characteristic that you want to delete, or you can remove a single value from a filter characteristic by clicking next to its value.Other filter aspectsIf you use filters in hierarchy views (not available in tile display mode), Collibra only applies the filter at the 'root' (start) level of the hierarchy. Child rows are not filtered.In the Roles category of the filter characteristics, you can select one or more specific users or user groups, or current user to filter on the signed-in user. This has the advantage that it is not necessary to create a filter for every single user.Example: Filter assets by current user with Reviewer responsibility: If user A is signed in, the table shows the assets for which User A has Reviewer responsibility. If user B is signed in, the table shows the assets for which User B has Reviewer responsibility.The Roles category of a basic filter does not take into account inherited responsibilities. If you want to include inherited responsibilities in the filter criteria, you can use an advanced filter.Create a basic filterIf you want to customize a view to make sure that you only see the assets that you really need, you can create a filter.To create a basic filter, follow these steps:Navigate to a table or set of tiles that contains the assets you want to see.Example: Business GlossaryIn the Filters pane, next to filters, click Edit.Verify that you are in basic filter mode. If you aren't, click Switch to basic.In the right column of the Filters pane, select the characteristics that you want to include in your filter.You can do this in different ways:By typing the name of what you are looking for in the search field at the top, and then selecting the characteristic.By going through the list while expanding or collapsing characteristics to find what you are looking for, and then selecting the values.For some characteristics, you have to select the values from a predefined list, for example Type or Status.For some characteristics, you have to type one or more values, for example Name or Definition.Multiple values for a characteristic are treated as an OR clause.All the simple expressions in a basic filter are treated as an AND clause.You can remove a filter characteristic by clicking next to the filter characteristic that you want to delete, or you can remove a single value from a filter characteristic by clicking next to its value.Click Apply to activate the filter or click Cancel to close the filter characteristics pane.Advanced filtersAdvanced filters are like basic filters in that they consist of one or more filter clauses. Advanced filters, however, use advanced logical operators. In a basic filter clause, the logical operator is equals. In advanced filter clauses, the operator depends on the property, characteristic or resource role that you select as the filter criterion.The filter criteria are grouped as follows:Properties: All the asset properties in Collibra, for example name, asset type and tags.Attributes: All the asset attributes in Collibra, for example note, definition and quality.Relations: All the relations in Collibra.Roles: All the resource roles that are defined in Collibra, for example Business Steward, Requester and Assignee.The following table shows some examples of operators, per filter criterion type:Filter criterion typeOperatorsText, for example Nameequalsdoes not equalcontainsdoes not containstarts withdoes not start withends withdoes not end withexistsdoes not existBoolean, for example Certifiedequalsdoes not equalexistsdoes not existNumeric, for example Articulation Scoreequalsdoes not equalless thanless than or equalsgreater thangreater than or equalsDate, for example Created Onequalsbeforebefore or equal toafterafter or equal tolast (...) daysexistsdoes not existResource role, for example Business Stewardcontainsdoes not containequalsdoes not equalstarts withdoes not start withends withdoes not end withexistsdoes not existIf you select the logical operator equals, you can select the value Current User, to find all assets for which you have been assigned the specified resource role. This means that users might see different results in the same view, depending on their responsibilities.Filtering by resource role and a specific user is extended to user groups that include the specified user, for the selected resource role. John Fisher is included in a user group named The Dream Team. There are a number of assets for which The Dream Team user group has been assigned as the Business Steward. If you filter a view by Business Steward, and specify the user John Fisher, all such assets will pass the filter.You can create a combination of clauses by using the AND and OR operators and brackets. The order of the clauses does not affect the results.Depending on the logical operator, you can add multiple values. If you do so, the values are treated as an OR operator.The filter below finds assets that meet these criteria: they have the asset type Business Term OR the assets have both the domain Business Glossary and one of these three statuses: Accepted, Approval Pending or Candidate.Create an advanced filterYou can create an advanced filter to only see the assets that you need in your view.StepsNavigate to a table or set of tiles that contains the assets you want to see.Example: GlossaryIn the Filters pane, next to Filters, click Edit.Ensure that you are in advanced filter mode. If you aren't, click Switch to advanced.In the Filters pane, define the filter clauses.Select a characteristic from the Characteristic list.Select an operator.Add one or more values. The content of the value field depends on the selected operator.Click Add filter criteria to add the next filter clause.In the Filter rule field, define how the filter clauses must be interpreted. See Filter rules.Click Apply to activate the filter or Cancel to discard the changes.If you want to filter assets by relation type and use an exclusionary logic operator, such as does not equal or does not contain, you have to introduce two filter clauses, as shown in the following example. A. This filter clause conveys that you only want to consider assets that have the relation type, for example, Asset synonym of asset Asset.B. This filter clause shows, of all assets that have the filter type that is specified in clause A, for example, Asset synonym of asset Asset relation, only the assets for which the acronym does not equal a specified value, in this example CRT.Without the exists filter clause, the filter results will include assets that do not have the Asset synonym of asset Asset relation type, which is not helpful.Filter rulesWhen you create an advanced filter, you can create complex filters by combining the filter clauses you created with Create an advanced filter. By default, the filter clauses are combined with the AND (conjunction) operator. However, you can also combine the clauses by using brackets and the OR (disjunction) operator.OperatorExplanationANDA result must fit all filter clauses.Example: A AND B AND C means that only a resource that fits all three filter clauses is added to the results.ORA result must fit one of the filter clauses.Example: A OR B OR C means that whenever a resource fits one of the three filter clauses, it is added to the results.A filter uses the following operator precedence to filter the data:Operations inside brackets.AND operations.OR operations.Filter rule examplesA OR B AND C: First, check the AND operation. The result must fit clause B and C.Second, combine it with clause A. The result must fit either A or the result of the AND operation.(A OR B) AND C: First, check the operation between brackets. The result must fit either clause A or clause B.Second, combine it with clause C. The result must fit clause C and the result of the operation between brackets.Reset a filterIf you have applied a filter and you want to return to the original view, follow these steps:Open a view and apply a filter.Click Revert to original.In the Revert to original dialog box, click Revert.You return to the originally selected view.Display modesThroughout Collibra Data Intelligence Cloud, you can choose to view assets in tables (table display mode) or as sets of tiles (tiles display mode).When assets are viewed in table display mode, each table row represents one asset. When they are shown in tile display mode, each tile represents one asset.Example of a view in table display mode:Example of a view in tile display mode:Table display modeWhen resources are viewed in table display mode, each table row represents one community, domain, asset or so forth. You can also switch to tile display mode.Working with tablesAll tables in DGC have some common features and actions. For some tables, you can do additional actions. No.Element nameDescription1View selectorThe view selector shows the name and description of the current view, and allows you to choose another view.2View toolbarThe view bar contains buttons to save, edit, share and delete the current view.3Asset filterYou can use an asset filter to limit the number of assets shown.4Action menuThe action toolbar contains a selection counter and actions that you can perform on assets you select in the table.5Table menuThe table menu contains buttons for actions that you can perform on the table.6FieldsThe fields are the column headers.You can customize the table to determine which fields are shown and in which order they're shown. You can also rename the field display names.From the header, you canSelect all visible assets. Sort on one or more columns, in ascending or descending order.Apply a column filter.Clear a column filter.7BodyThe body of the table shows the actual content of the table in rows.From a table, you can do the following:Select a row.Edit the content of one, selected or all visible cells.8PagesThe table pages. This section appears if the table contains more rows than you are displaying.You can do the following:Define the number of rows per page.              Navigate between table pages.              9CounterThe total number of assets in the table.If the table contains more than 10 000 rows, the counter displays 10 000 +. Click it to see the exact count.Switch to table display modeIf you are in tiles display mode, you can quickly convert the set of tiles to a table.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Display mode → Table.Action toolbarThe action toolbar contains a selection counter and actions that you can perform on assets you select in the table.You can:Delete multiple assets.      Move multiple assets to another domain.      Validate assets.This is only visible if a validation rule is assigned to the asset type. Start an asset workflow from an asset table.Only workflows that apply to all the selected assets are available.      Table content toolbarWhen you are viewing assets in table display mode, the content toolbar contains buttons for actions that you can perform on the table.The following table provides an overview of the possible actions:ButtonDescriptionImport assets or complex relations.Export assets or complex relations.Display a selection of assets as a hierarchy, or tree structure, based on their relation type. When you select only one relation type, Collibra Data Intelligence Cloud builds the hierarchy as deeply as possible, traversing occurrences of that single relation type as often as it can. Enable or disable hierarchies. Refresh the table.Manage columns and rows. You can add, remove and move columns and select the number of rows that are displayed on one page. See Customizing tables. You can also switch to tile display mode.Display a preview of the selected row. You can select a row by clicking on the row itself, not the check box.Select or clear rowsTo edit or delete multiple rows in one go, you can select multiple rows in a table. Do not confuse this with highlighting a row by clicking anywhere in the row.StepsOpen a view in the table display mode.Perform one of the following steps:If you want to...do...select a single row:                Click the checkbox in front of the row.              select all visible rows:Click the checkbox in the header of the column.clear a selected row:Click a selected checkbox again.In the table header, you can see how many of the available assets are selected.Edit cells in a tableYou can edit most content in tables. You can do this for individual rows or multiple rows in one go.StepsOpen a view in the table display mode.Perform one of the following steps:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears. Perform one of the following steps:If the field is a free text field, you can edit the cell by typing.If the field is a drop-down list, type the new value or use the drop-down menu .If the field is a date, type the new date or use the date editor .Perform one of the following steps:If you want to change...do...the current row only:  Click .                all visible rows:Click Apply to all visible rows.  Click .  selected rows:Select one or more rows.Click Apply to all selected rows.  Click .  Wrap the text in a cell of a tableCollibra Data Intelligence Cloud can wrap the text in cells of tables so it appears on multiple lines inside the cell. This makes the cell content more readable.Wrap the text of an individual cellOpen a view in the table display mode.Hover your mouse over a cell and click .The height of the table row increases so the complete text in all cells in that row becomes readable.You cannot save the wrapping, so when you reload the page or open the view later, the text is no long wrapped.Wrap the text of all cellsOpen a view in the table display mode.On the content toolbar, click → Wrap Text.  The pagination of the table is set to 20 rows per page.The height of all table rows increases so the complete text in the cells becomes readable.Optionally, in the view toolbar, click , then Save to save the view and always wrap the text when the view opens.Customizing tablesIf you want a table to display only the information you need about specific assets, you can change several aspects of the table.Add columns to a tableIn Collibra Data Intelligence Cloud, a table has a default view, displaying a default set of columns. You can edit the asset view by adding columns to it.You can also show responsibilities as a column.StepsOpen a view in the table display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click Select fields.The Select fields dialog box appears.Select one or more items in the list.You can use predefined filters and the search box to quickly find columns.Click Update.The Select fields dialog box appears.If required, do the following:Edit a column name.      Edit the column order.Click Save.Show responsibilities in an asset tableAn asset view can show the responsibilities of a resource, these responsibilities are shown per role.If you enabled inherited responsibilities in the settings, you can show the inherited responsibilities. Inherited responsibilities have a gray background and cannot be edited in an asset view. Direct responsibilities have a white background and can be edited.StepsOpen a view in the table display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click Select fields.The Select fields dialog box appears.Select one or more roles in the list.You can find all roles in the Roles tab page.Click Update.The Select fields dialog box appears.If you enabled inherited responsibilities in Collibra Console, you can select Show inherited responsibilities to show inherited responsibilities.Click Save.Edit the column orderYou can edit the order in which the columns are arranged in a table.If you enable hierarchies for a table, the Name column automatically appears as the leftmost column in the table and it is frozen. More information: Freeze columns.StepsOpen a view in the table display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click and drag a row up or down.Click Save.Edit a column nameYou can edit the column names in a table.StepsOpen a view in the table display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  In the Display name field, type a new name.Click Save.Remove columns from a tableYou can remove columns from tables in two ways:Remove columns from the Table Columns dialog boxDo this if you want to remove one column.StepsOpen a view in the table display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  At the end of the line, click .Click Save.Remove columns from the Select Columns dialog boxDo this if you want to remove several columns or add columns in one go.StepsOpen a view in the table display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click Select fields.The Select fields dialog box appears.Clear the check box in front of one or more items in the list.You can use predefined filters and the search box to quickly find columns.Click Update.Click Save.Change the number of rows per pageIf a table contains a large amount of rows, they will be split across multiple pages. You can change the number of rows that are shown per page of the table.StepsTo change the number of rows per page, follow these steps:Open a view in the table display mode.On the content toolbar, click → Change Rows per Page → <number>.  Freeze columnsFreezing columns keeps the leftmost columns in a table visible when you scroll horizontally to the right.If you enable hierarchies for a table, the Name column automatically appears as the leftmost column in the table and it is frozen. You can still change the column order.StepsOpen a view in the table display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click for the Move to freeze column(s) setting, and drag it below the last column you want to freeze.Click Save.Sort on one or more columnsSorting the contents of a table helps you visualize your content and find the data you want. You can sort on one or more columns.The availability of multi-column sorting and the maximum number of columns on which you can simultaneously sort depends on your organization's environment settings in Collibra Console. Multi-column sorting is not available in tile display mode; however, you can sort on more than one column while in table display mode and then switch to tile display mode. The sort results will be accurately applied to the tiles. See Sort a set of tiles.StepsTo sort the contents of a table based on one or more columns, follow these steps:Open a view in the table display mode.Click the column name of the column on which you want to sort. appears next to the column name and the table is sorted in ascending order.To sort in descending order, click the column name again.To sort the data on a second column, click the desired column name. appears next to the column name and the table is sorted in ascending order.To sort in descending order, click the column name again.To remove sorting, click the column name a third time.To sort the data on a third column, click the desired column name. appears next to the column name.The contents of the table are first sorted according to the first column you've selected. Within that sort result, the contents are further sorted according to the second column you've selected.To sort by additional columns, continue as above.If you start sorting on a second column, the sorting icon of the first column changes into . Navigate between table pagesIf a table contains more rows than you are currently showing, it is split in several pages. You can navigate between these pages.You can define the number of rows per page. More information: Change the number of rows per page.StepsOpen a view in the table display mode.If the table contains more rows than those displayed, the lower left corner shows the pages.Do one of the following:To navigate to...click...the previous pagethe next pagethe first pagethe first page.Example: 1-10one of the 2 previous or following pagesthe desired page.the last pagethe last page.Example: 100-110ExampleFiltering tablesYou can filter tables in different ways:Apply a column filter.Do this to quickly filter on a column using a simple string.Asset filters.Do this to use advanced filters.Apply a column filterYou can filter the content in a table using a column filter. When you apply a column filter, only rows containing the specified string are shown.You can also use asset filters to define complex criteria. More information: Asset filters.StepsTo apply a column filter, follow these steps:Open a table.In a column header, click .The column header becomes a search box.Type the text you want to filter on. Clear a column filterAfter you applied a column filter, you can clear it again to make more rows visible.StepsTo clear a column filter, follow these steps:Apply a column filter.In the table name, click .Working with hierarchiesA hierarchy is a visual representation of relations between assets. The hierarchy feature for asset views enables you to display a set of assets in a table as a hierarchy or a tree structure based on the relations between the assets. You can select which relation types to display in the hierarchy.Collibra Data Intelligence Cloud uses dotted lines to graphically depict the relations between the assets in the hierarchy. Small carets (triangles) depict nodes in the hierarchy that you can expand.When enabling hierarchies, you can choose between the following types of hierarchies:Single-path hierarchy: For each node at a certain level in the hierarchy, there is only one path to the nodes at the next level. Multi-path hierarchy: At each junction, any relation type in the hierarchy path is traversed to find more nodes. That is, all relations are traversed for any asset, at any depth. In a hierarchy, filters are applied only at the root level.You cannot export or import a hierarchy.In a hierarchy, you cannot use the tile mode of display.ExampleSingle-path hierarchySuppose that you have assets that represent Reports. Each Report asset contains Report Attribute assets. You can depict this as a single-path hierarchy using a single relation type:[Report] contains [Report Attribute]The maximum depth (that is, the number of relations between a root node and a leaf node) of the resulting hierarchy is one.Suppose that some of those Report Attributes are represented by Business Assets via the following relation type:[Data Asset] represented by [Business Asset]Report Attribute is a child asset type of Data Asset.You can depict this as a single-path hierarchy using the following relation types:[Report] contains [Report Attribute][Data Asset] represented by [Business Asset]The maximum depth of the resulting hierarchy is two.Suppose that those Reports are grouped into other Reports. You can depict this as a single-path hierarchy using a single relation type:[Report] groups [Report]The fundamental difference between this hierarchy and the previous one is that in this hierarchy, the target asset type of the relation (Report) is also the source asset type (Report), which can result in a hierarchy of unlimited depth. For example:Report A groups Reports B and CReport B groups Reports D and EReport C groups Reports FWhile this hierarchy shows the Groups relations between the Reports, it does not show the Report Attributes contained in each Report. A single-path hierarchy does not allow two relation types to be simultaneously depicted in a hierarchy as follows:[Report] groups [Report][Report] contains [Report Attribute]In a single-path hierarchy, each Report node acts like a junction at which you can view the instances of one relation type or the other, but not both.Multi-path hierarchyConsidering the example described earlier, in a multi-path hierarchy, you can simultaneously view:[Report] groups [Report][Report] contains [Report Attribute][Data Asset] represented by [Business Asset]When viewing the hierarchy for a community or domain, if the parent of a node that is in the community or domain belongs to a different community or domain, that node is not shown in the hierarchy.Enable or disable hierarchiesYou can enable hierarchies to display an asset table in a tree structure, or disable hierarchies to display a flat asset table.StepsOpen a view in the table display mode.On the content toolbar, click .The Configure Hierarchy dialog box appears.Enter the required information.FieldDescriptionEnable HierarchySelect or clear this checkbox to enable or disable hierarchies, respectively. Single pathA hierarchy in which, for each node at a certain level, there is only one path to the nodes at the next level. MultipathA hierarchy in which all relations are traversed for any asset, at any depth.Define a hierarchy using relation typesSpecify the relation types that you want to use for your hierarchy.Click Apply.Tile display modeWhen resources are shown in tile display mode, each tile represents one asset. You can also switch to table display mode.Working with tilesIn tile display mode, each tile represents one asset. The tiles have some common features and actions.No.Element nameDescription1View selectorThe view selector shows the name and description of the current view, and allows you to choose another view.2View barThe view bar contains buttons to save, edit, share and delete the current view.3Asset filterYou can use an Asset filters to limit the number of tiles that are displayed.4Tiles action menuThe tiles action menu with a selection counter and buttons that enable you to:Sort the tiles in ascending or descending order, by field.Delete multiple assets.      Move multiple assets to another domain.      Validate assets.       This is only visible if a validation rule is linked to the asset type. Start a workflow from a table.Only workflows that apply to all the selected assets are available.      5Tiles menuThe Tiles content toolbar contains buttons for actions that you can perform on the set of tiles.6Fields and valuesFields and values of the asset.You can customize a set of tiles by adding, moving and removing fields and selecting the number of tiles that are displayed per page.7PagesThe tiles pages. This section appears if there are more tiles than you are displaying on one page.You can:Change the number of per page.Navigate between tiles pages.8CounterThe total number of tiles.If a set of tiles contains more than 10 000 tiles, the counter displays 10 000 +. Click it to see the exact count.Switch to tiles display modeIf you are in table display mode, you can quickly convert the table to a set of tiles.StepsOpen a view in the table display mode.On the content toolbar, click → Change Display Mode → Tiles.Tiles action toolbarThe tiles action toolbar contains a selection counter and actions you can perform on selected tiles.You can:Sort the tiles in ascending or descending order, by field.Delete multiple assets.      Move multiple assets to another domain.      Validate assets.       This is only visible if a validation rule is linked to the asset type. Start a workflow from a table.Only workflows that apply to all the selected assets are available.      Tiles content toolbarWhen you are viewing assets in tile display mode, the content toolbar contains buttons for actions that you can perform on a set of tiles.The following table provides an overview of the possible actions:ButtonDescriptionImport assets or complex relations.Export assets or complex relations.Enable or disable hierarchies.The hierarchy feature is only available in table display mode.Refresh the table.Manage fields and tiles count. You can customize a set of tiles by adding, moving and removing fields and selecting the number of tiles that are displayed per page.You can also switch to table display mode.Enable or disable the preview.Preview is only available in table display mode.Customize a set of tilesIf you want a set of tiles to display only the information you need about the assets, you can change several aspects of the tiles.Add fields to a set of tilesIn Collibra Data Intelligence Cloud, a set of tiles has a default view, displaying a default set of fields. You can add, remove and rename the fields that appear in the tiles.You can also show responsibilities as a field.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click Select fields.The Select fields dialog box appears.Select one or more items in the list.You can use predefined filters and the search box to quickly find fields.Click Update.If required, do the following:Change a field name.      Change the order of the fields.      Click Save.Show responsibilities in a tile setTiles can show the responsibilities of a resource, these responsibilities are shown per role. If you enabled inherited responsibilities in Collibra Console, you can show the inherited responsibilities. Inherited responsibilities have a gray background and direct responsibilities have a white background.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click Select fields.The Select fields dialog box appears.Select one or more roles in the list.You can find all roles in the Roles tab page.Click Update.The Select fields dialog box appears.If you enabled inherited responsibilities in Collibra Console, you can select Show inherited responsibilities to show inherited responsibilities.Click Save.Edit the order of the fieldsYou can edit the order in which the fields are arranged in a set of tiles.The community-domain breadcrumb will always appear at the top of the tile, followed by the asset name, status and report image, if an image has been uploaded for the asset.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click and drag a field up or down.Click Save.Edit a field nameYou can edit the field names in a set of tiles.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  In the Display name field, type a new name.Click Save.Remove fields from a set of tilesYou can remove fields from a set of tiles in two ways:Use the Fields dialog box.Do this if you want to remove a single field.Use the Select fields dialog box.Do this if you want to add or remove one or more fields in one go.Remove fields using the Fields dialog boxDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click for the field you want to remove.Click Save.Remove fields using the Select fields dialog boxDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click Select fields.The Select fields dialog box appears.Clear the check box in front of one or more items in the list.You can use predefined filters and the search box to quickly find fields.Click Update.Click Save.Edit the number of tiles per pageIf a view contains a large amount of tiles, they will be split across multiple pages. You can change the number of tiles that are shown per page.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.On the content toolbar, click → Change Rows per Page → <number>.  Select multiple tilesWhen you select a single tile, all of the actions available to you appear above the tiles, in the tiles action menu. The same is true when you select multiple tiles. For all of the tiles you've selected, you can perform the same actions or start a workflow.Only workflows that apply to all selected tiles are available.StepsTo select multiple tiles, follow these steps:Do one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.To select consecutive tiles, click the first tile, press and hold down the Shift key, and then select the last tile you want.To select non-consecutive tiles:If you're working with Windows OS, press and hold down the Ctrl key, and then click each tile you want.If you're working with macOS, press and hold down the Command key, and then click each tile you want.Sorting tilesSorting tiles helps you visualize your content and find the data you want. You can sort a set of tiles in ascending or descending order, by the field of your choice.In tile display mode, you can only sort on one field at a time, whereas in table display mode, you can sort on one or more columns simultaneously. However, if you sort on more than one column in table display mode and then switch to tiles display mode, the results of the multi-column sorting is carried over to the tiles. If you then change the sorting while in tile display mode, the sort will be based on the single field of your choice.Sort a set of tilesYou can sort a set of tiles by the field of your choice.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.By default, the tiles are arranged in descending alphabetical order, by name.Do one of the following: On the left, click Name, or if sorting has been done by another field, click that field name.If you or someone else sorted on more than one column in table display mode and you then switched to tile display mode (see the note below), click .A drop-down menu appears, with all the fields that are currently visible for the set of tiles. Select the field by which you want to sort the tiles.The tiles are sorted in descending order.Optionally, click to sort in ascending order.If you or someone else sorted on more than one column in table display mode and then you switch to tile display mode, the multi-column sort is carried over to tiles. In the following example figure, the table was sorted by the Name and Domain columns before switching to tiles display mode.Navigate between tiles pagesIf a set of tiles contains more tiles than you are currently showing, they are split across multiple pages. You can navigate between these pages.You can change the number of tiles per page.StepsDo one of the following:Open a view in tiles display mode.Open an asset page with related assets shown in tiles display mode.If the set of tiles contains more tiles than those displayed, the lower left corner shows the number of pages.Do one of the following:To navigate to...click...the previous pagethe next pagethe first pagethe first page.Example: 1-10one of the two previous or following pagesthe desired page.the last pagethe last page.Example: 261-268ExampleFiltering tilesYou can use advanced Asset filters to filter the tiles shown in tile display mode.Searching in Collibra You can use the Search field and the Search widget to quickly find any resource in Collibra Data Intelligence Cloud, including assets, communities, domains, users, user groups and more. Both options take you to the Search page, where you can edit your search text and work with the search results.Search fieldThe search finds resources that contain a word that begins with your search text. For example, if you type ca, the search results could contain California, Lewis Carroll or Meercat.Recently viewedWhen you click in the Search field, the five most recently viewed resources are shown in the quick search panel.If refreshed navigation is enabled for your Collibra environment, the search results are automatically filtered by the current domain or community if you search with a domain or community page open.Top resultsWhen you start typing in the Search field, the top 10 results are shown in the quick search panel.In compiling the top results, the search engine searches for your text in the Name field only. As such, these results might not appear as the top results on the Search page, when you launch the search.The order of the top results takes boosting into account.ActionsAfter typing something in the Search field, you can do any of the following:Press Enter to start the search. The Search page, with results matching your search text is shown.Click on an asset name, to go to the asset page.Search pageThe Search page consists of the following areas: No.Part nameDescription1Facet paneA dynamically generated collection of facets that allows you to: Add and remove search fields, to expand or reduce the scope of your search.Navigate and refine the search results.The Facet pane is only shown if your search yields results.2Search filtersA drop-down list of all your saved search filters, with the name of the currently applied filter shown. By default, no search filter is applied.The buttons allow you to:: Create a new search filter or save a copy of an existing filter.: Edit the name and description of a search filter.: Share a search filter: Delete a search filter.3Search input fieldShows your search text. You can edit your search text here.Click for examples of how wildcards and symbols work in your search text.4Search resultsShows: The results that match your search.The total number or results.The applied sorting criterion and sorting order. By default, search results are sorted in order of descending relevance.The selected fields in which the search is performed. By default, all fields are searched.Click to: Add or remove fields that are shown for each search result.Edit the number of results shown per page.For any result that is an asset, click the three dots () to show the workflows that are available for the asset.Click the name of a search result to open its detailed page.In Collibra Console, you can influence the order of the search results by editing the boost factor of resources and attribute types. See also Relevance in search results.It's possible that you or another user created a search filter that includes a field or facet that no longer exists in your Collibra Data Intelligence Cloud environment. In this case, the invalid field or facet is highlighted, as shown in the following image, so that you can easily identify it and delete it from the search filter. Invalid fields and facets are ignored during search queries.Wildcards and symbols for searchingIf you want to find a resource, but are not quite sure of its name, you can use the follow wildcards:WildcardDescription?Replaces any single character. Example: by typing ?owie, you can find Bowie, Rowie, Mowie, and so on.*Replaces any string of characters. Example: by typing B*e, you can find Bowie, Badge, Byte, and so on.~Represents a fuzzy search, words with spelling similar to the search query. Example: by typing Owi~, you can find Ozi, Zowie, Bowie, and so on.!Excludes words. Example: by typing !David Bowie, you can find Lester Bowie, Joe Bowie and so on. Represents a literal search.Example: by typing David Bowie, you can find David Bowie and David Bowie Songs, but not David or Bowie.Sort the search resultsYou can sort search results by the following criteria:RelevanceThe Name fieldThe Last Modified fieldStepsPerform a search via the Search field or Search widget.On the Search page, click next to the sort field.Select the basis by which to sort the search results.By default, the results are sorted in descending order.Optionally, click to sort in ascending order.What's next?If you sorted the search results by an attribute type that is not shown in the tiles, you can add it to the tiles, so that you can see the values that determined the sort order.You can create a search filter or edit an existing search filter, to save your sort settings as part of the saved filter configuration.Relevance in search resultsBy default, search results are sorted in order of descending relevance.What is relevance in the context of search results?Relevance is a calculation of the similarity, measured across several lines of comparison, between your search text and the content of the resources in your Collibra environment.In a set of search results, the relevance of each resource is represented by a positive number, or score. The higher the score, the more relevant the resource is to your search text.How are relevance scores derived?To derive relevance scores, the Collibra search engine uses a combination of query clauses and boost factors.Query clausesWhen you perform a search, the Collibra search engine queries the database, using various query clauses. Each query clause compares the similarity between your search text and your Collibra resources, along a different line of comparison.The following are example objectives of different query clauses:Calculate the similarity between the spelling of your search term and the term found in a field in the database. Calculate how frequently your search term appears in a field. The more often it appears, the greater the relevance. A field containing five occurrences of a given term is more likely to be relevant than a field containing one occurrence of the term.Calculate the occurrence percentage of a term among all words in a particular field. For example, if your search term occurs twice in the 10-word description of an asset, that asset will have a higher relevance score than an asset for which your search term occurs twice in its 20-word description.BoostingSearch boost factors allow you to influence the order of the search results. You can edit search boost factors to increase or decrease the importance of a resource type, field or asset type, in the search ranking.For more information on boosting, see Search boost settings.What is a faceted search?The Facet pane shows the relevant criteria by which to navigate and refine the search results. We refer to these criteria as facets, and the concept of using facets to navigate and refine search results as a faceted search.In introducing the concept of a faceted search, it may be helpful to draw the distinction between it and a more traditional filter-based search.Filter-based searchFilters work by analyzing the search results and excluding resources (for example, assets, users and communities) that don't meet certain criteria. In a filter-based search, the collection of filters that is available to you is constant. The relevance of the filters to the search results is not considered. As such, some of the filters available to you could either have no effect on the results, or reduce the results to a null set.Faceted searchFacets are dynamically generated according to the resources that make up the search results. They allow you to narrow results by several different dimensions simultaneously.      In a faceted search, only facets that are relevant to the search results appear in the Facet pane on the Search page. As you select facets, to navigate and refine the search results, the Facet pane is automatically updated, again showing only facets that are relevant to the refined set of results.    As shown in the following image, the facets in the Facet pane at any given moment include the number of resources that match both the search text and the value of the available facets. This gives you a view of the composition of the search results, and helps you avoid searches that yield no results.Navigating and refining the search resultsThe Search page offers a variety of dynamically generated facets by which to navigate and refine your search results.No.Part nameDescription1Search in facetsThese facets enable you to navigate to resources via organizational path or resource category.FacetUseOrganizationNavigate to resources by drilling down at the organizational level and limiting the search results to a specific community, subcommunity or domain. If, for example, you click on a root-level community, the results will be refined to include only the resources (meaning subcommunities, domains and assets) in that community that match your search text.CategoryNavigate to a specific category of resources, such as assets, communities, domains, users or user groups.2Refine facetsThese facets act as filters to refine the search results.The following table shows the packaged refine facets:Filter criteriaUse this to show only those search results...Asset typeThat are of a specified asset type, such as Business Term, Acronym, Column or Table.This criterion is only applicable if you have selected the category Assets.In the following example image, the search engine searches for your text only in assets of asset type Standard, Column and Data Set.StatusThat have a specified status, such as Candidate, Accepted, Deployed or Rejected.Last modifiedThat were modified within the specified time frame; within the last 24 hours, week, month or year.Created byThat were created by the specified users.            Created onThat were created within the specified time frame; within the last 24 hours, week, month or year.TagsThat have the specified tag(s).You can click the tag in any of the search results, to search for all domains and assets with that tag.Working with facetsClick Clear, to clear all selections for a specific facet type.At the top of the page, click Clear all, to clear all facet type selections on the search page.Click Show all, to show all the facets by which to refine the scope of your search for a particular facet type. As shown in the following example image, if there are more than 15 facets, the list will open in a dialog box.Adding and removing facets on the search page is not the same as:Filtering the search results.Adding or removing fields to a set of tiles.Permissions    No particular license is needed to create and manage search filters; however, certain global permissions are needed. PermissionWith this permission, you can...Manage and share anyone's Views, Dashboards, Search filtersCreate and manage search filters for yourself and other users, and share with other users.Manage your own Views, Dashboards, Search filtersCreate and manage your own search filters.Share your own Views, Dashboards, Search filtersShare search filters that you created.Users are not granted permissions directly, but through global roles and responsibilities.Search filtersYou can create a search filter from scratch. When you create a search filter, it exists only for you. However, with the correct global permission, you can share the filter with other users.By default, no search filter is applied.Create a search filterYou can create a search filter from scratch.When you create a search filter, the sorting and search fields are part of the saved configuration.Create a search filter via the save iconPerform a search via the Search field or Search widget.The Search page appears.Optionally:Navigate and refine the search results by selecting from the available facets.Sort the search results.Select the fields in which to search.When you've achieved the desired results, click .Enter a name and description of the filter.    Select with whom you want to share the filter.Select Public, to share the filter with all users.Select Private, to share the filter with no one. This is the default setting.Select Share with specific global roles, groups and users, and then enter the relevant roles or groups.Click Save.The new filter is added to your list of filters.Create a search filter via the Add a new search filter optionPerform a search via the Search field or Search widget.The Search page appears.Click No search filter, and then select Add a new search filter.Enter a name and description of the filter.    Select with whom you want to share the filter.Select Public, to share the filter with all users.Select Private, to share the filter with no one. This is the default setting.Select Share with specific global roles, groups and users, and then enter the relevant roles or groups.Click Save.The new filter is added to your list of filters.Save a copy of a search filterYou can save a copy of any search filter, and then edit it to suit your needs.StepsPerform a search via the Search field or Search widget.On the Search page, click on the search filter label, to expand the search filter drop-down list, and then select the relevant filter. Click , and then select Save As.Enter a name and description of the filter.    Select with whom you want to share the filter.Select Public, to share the filter with all users.Select Private, to share the filter with no one. This is the default setting.Select Share with specific global roles, groups and users, and then enter the relevant roles or groups.Click Save.The new filter is added to your list of filters.      When you save a copy of the search filter, the sorting and search fields are part of the saved configuration, but the search text is not.    Edit a filter's name and descriptionYou can edit the names and descriptions of the search filters you've created.StepsPerform a search via the Search field or Search widget.On the Search page, click on the search filter label, to expand the search filter drop-down list, and then select the relevant filter.Click .The Edit name and description dialog box appears.Edit the name and/or the description.Click Save.Edit a search filterYou can edit an existing search filter to suit your needs.StepsPerform a search via the Search field or Search widget.On the Search page, click on the search filter label, to expand the search filter drop-down list, and then select the relevant filter.In the Facet pane, reconfigure the available facets to achieve the desired filter results.Click , and then select Save.Share a search filterYour permissions determine whether or not you can share search filters, and if so, whether you can share only filters you've created or also the filters that others have created and shared with you. StepsPerform a search via the Search field or Search widget.On the Search page, click on the search filter label, to expand the search filter drop-down list, and then select the relevant filter.Click .    Select with whom you want to share the filter.Select Public, to share the filter with all users.Select Private, to share the filter with no one. This is the default setting.Select Share with specific global roles, groups and users, and then enter the relevant roles or groups.Click Save.Delete a search filterIf you have the SysAdmin global role, you can delete your own search filters and those that other users have created and shared with you. If you don't have the SysAdmin global role, you can only delete search filters that you've created.StepsPerform a search via the Search field or Search widget.On the Search page, click on the search filter label, to expand the search filter drop-down list, and then select the relevant filter.Click .Click Delete filter to confirm.Text editorsText editors in Collibra Data Intelligence Cloud allow you to enter, format and edit text.The following text editors are available throughout Collibra:Standard text editor.Mini text editor.Table text editor.Plain text editor.Standard text editorThe standard text editor is a rich text formatting editor. You use this editor on text widgets and asset pages to edit text attributes such as Definition and Note. It allows HTML formatting and styling. For advanced formatting, you can use the toolbar or enter HTML code after clicking in the toolbar. The standard text editor supports most HTML elements, inline CSS styling and table (< t >) structures. However, this means an attacker could potentially execute an XSS attack by injecting malicious HTML. However, when you save, the following HTML elements are removed for security reasons:script (including JavaScript)svgframeframesetiframeany event handlersText attributes are always protected, but you can also enable this for text widgets in Collibra Console. For more information, see the Troubleshooting section.Mini text editorYou use the mini text editor typically for comments, ratings and so on. The toolbar offers basic formatting options.Table text editorThe table text editor allows you to edit and format text in asset tables, The toolbar contains all the editing options of the mini text editor toolbar, plus a clear formatting option. Plain text editor The plain text editor allows you to enter text without formatting. Use of text editorsThe following table identifies where the various text editors and field are used.EditorLocation of useStandard text editorDashboard Text widgetCommunity, domain and asset pagesMini text editorCommentsRatingsTable text editorTable text fieldsPlain text editorAdd characteristic option of an assetKeyboard shortcutsFor the standard text editor, you can use the following keyboard shortcuts to edit or format your text: ActionPCMacBoldCtrl + BCommand + BItalicCtrl + ICommand + IUnderlineCtrl + UCommand + USelect allCtrl + ACommand + ARedoCtrl + Y / Ctrl + Shift + ZCommand + Y / Command + Shift + ZUndoCtrl + ZCommand + ZHeader 1Alt + Shift + 1Control + Option + 1Header 2Alt + Shift + 2Control + Option + 2Header 3Alt + Shift + 3Control + Option + 3Header 4Alt + Shift + 4Control + Option + 4Header 5Alt + Shift + 5Control + Option + 5Header 6Alt + Shift+6Control + Option + 6ParagraphAlt + Shift + 7Control + Option + 7Keyboard focus to toolbarAlt + F10Option + F10Toggle fullscreenAlt + Shift + FCommand + Shift + F ActivitiesAn activity is a process that Collibra runs in the background. While the process is running, you can use Collibra as usual. Activities are, for example, importing and exporting assets, or registering a data source and profiling data.Activities listsActivities lists show more information about the most recent or ongoing activities in Collibra Data Intelligence Cloud, for example the creation date and the status.There are activities lists in different locations.On your profile pageIn the main menuIn the Collibra settingsActivities list in the main menuThe activities list in the main menu only shows the most recent and ongoing activities. You can open the activities list by clicking in the main menu. If there are activities still running, the wheel is spinning.Click Show more to open the activities list on your profile page.Activities list on your profile pageThe activities list on your profile page contains a table with all your activities. It also shows more information about each activity, for example the creation date, name, status, start, finish and result.You can open the activities list by clicking Show more in the activities list on the main menu or by opening your profile page and clicking the Activities tab.ColumnDescriptionCreatedThe date and time that the activity started.NameThe name of the activity.StatusThe status of the activity. The following statuses can be shown: Canceled for canceled activities.Canceling for activities that are in the process of being canceled.        Completed for completed activities.Error for failed activities.Running for activities that are still running.Waiting for activities that are not started yet.Job ResultSpecific results of the job based on whether you selected the option to continue on error.              Success: All imports are completed without any errors.Completed with error: There are some errors but all successful imports are completed.Aborted: The import was stopped after reaching the threshold of the number of failed commands set in the import configuration setting in Collibra Console . All successful commands before reaching the threshold were completed.Failure: Something went wrong and caused the job to stop before processing all imports or reaching the number of failed commands threshold.StartedThe date and time that the activity started.FinishedThe date and time that the activity finished.ResultsIf available, a button to see detailed results of the activity. Depending on the activity, the result can be different. If you exported assets and click Results in the activities list, you download the export results. If you registered a data source in Data Catalog, a dialog box shows more information about the registration job.<Column to delete an activity>A button () to delete the activity.Activities list in the General section of the Collibra settingsThe activities list in the General section of the Collibra settings contains a table with all activities started by all users. It also shows more information about each activity, for example the creation date, name, status, start, finish and result.ColumnDescriptionCreatedThe date and time that the activity started.NameThe name of the activity.StatusThe status of the activity. The following statuses can be shown: Canceled for canceled activities.Canceling for activities that are in the process of being canceled.        Completed for completed activities.Error for failed activities.Running for activities that are still running.Waiting for activities that are not started yet.Job ResultSpecific results of the job based on whether you selected the option to continue on error.              Success: All imports are completed without any errors.Completed with error: There are some errors but all successful imports are completed.Aborted: The import was stopped after reaching the threshold of the number of failed commands set in the import configuration setting in Collibra Console . All successful commands before reaching the threshold were completed.Failure: Something went wrong and caused the job to stop before processing all imports or reaching the number of failed commands threshold.StartedThe date and time that the activity started.FinishedThe date and time that the activity finished.ResultsIf available, a button to see detailed results of the activity. Depending on the activity, the result can be different. If you exported assets and click Results in the activities list, you download the export results. If you registered a data source in Data Catalog, a dialog box shows more information about the registration job.<Column to delete an activity>A button () to delete the activity.Profile pageThe profile page of a user contains information about that user.You can always see all information on your own profile page. On the profile pages of other users, you see basic information such as their name and contact information. If you have a global role with the User Administration or the System Administration global permission, for example Sysadmin, you can see all information for all users.Full profile pageThe view bar contains important information about the user, such as the name, license type, required license type and email address. It contains buttons to edit the user's name and reset the password.The profile page contains the following tab pages:Tab pageDescriptionOverviewThe overview page contains general information such as the user's account information, mail notification settings and contact information.GroupsThe groups page contains the groups of which the user is a member and, with the right permissions, allows you to add the user to or remove the user from groups.ResponsibilitiesThe responsibilities page contains the responsibilities that are assigned to the user.HistoryThe history page contains the history of the user's actions.ActivitiesThe activities pages contains the list of your activities.MentionsThe mentions page contains a list of all comments in which you are mentioned.Basic profile pageThe view bar contains some basic information about the user, such as their name and email address.The profile page contains the following tab pages:Tab pageDescriptionOverviewThe overview page contains the user's contact information.GroupsThe groups page contains the groups of which the user is a member.ResponsibilitiesThe responsibilities page contains the responsibilities that are assigned to the user.Open a profile pageAs a regular user, you can open your own profile page. Administrators can open everybody's profile page.PrerequisitesIf you want to open the profile page of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Open your own profile pageClick your avatar, then Profile.Your profile page appears. Open another user's profile page    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.Click the username of the user whose profile you want to open.Edit the user account settingsAs a regular user, you can edit the settings of your own user account on your profile page. As an administrator, you can also edit other users' settings.PrerequisitesIf you want to edit the user account settings of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.StepsClick your avatar, then Profile.Your profile page appears. In the Account section, click .Enter the required information.FieldDescriptionUsernameEnter the username.Collibra username requirementsGeneral requirements:Uniqueness: Duplicate username are not allowed, regardless of caseusernamecase and UserNameCase are considered duplicateNo leading or trailing spacesNo empty usernamesMaximum of 255 charactersCharacter limitations: Usernames may only contain characters in the following Unicode categories:          LetterNumberSymbolPunctuationNon-spacing marksApplication LanguageChoose the interface language.As an administrator, you can add or edit interface languages.From version 2022.11 onwards, Collibra takes the default language of your browser into account to select the interface text language of some sections. Collibra now also has translations of some interface text available out of the box. Consequently, you can no longer edit that interface text, nor translate it into unsupported languages. This includes the interface text of Usage Analytics, Data Marketplace and the Homepage.Click Save.Edit the contact informationAs a regular user, you can edit contact information of your own user account on your profile page. As an administrator, you can also edit other users' contact information.You can also add new contact information.PrerequisitesIf you want to edit the contact information of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Edit contact information from a profile pageClick your avatar, then Profile.Your profile page appears.Perform one of the following steps: In the Contact section, click .Do this to edit the existing fields.In the Contact section, click Add.Do this to add a new field, or edit the existing fields.If you edit the email address, a notification email is sent to the old email address.Edit the contact information.Click Save.Edit contact information from the user table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page. Perform one of the following steps:Double-click a cell in the E-mail column.Hover your mouse over a cell in the E-mail column and click .If you edit the email address, a notification email is sent to the old email address.Click in the field and type the new email address.Click .Edit the email notification settingsYou can edit the email notification settings for your own user account. As an administrator, you can also edit other users' notification settings.If you enable notifications, you will be notified via email whenever changes are made to assets for which you have been assigned a responsibility.Only the 20 most recent changes for a given asset are shown in the notification email.PrerequisitesIf you want to edit the email notification settings of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.StepsClick your avatar, then Profile.Your profile page appears.In the Notifications section, click .Select or clear the necessary check boxes.FieldExplanationNotify me of content updatesSpecify whether or not you want to receive email notifications. If you select this option, email notifications will be sent to the email address shown in the Contact section of your Profile page, at the specified frequency.Days of the weekReceive email notifications only on the days you specify.MonthlyReceive a summary email once a month.Click Save.Edit the maintenance announcement settingsYou can edit the maintenance announcement settings on your profile page.If you enable maintenance announcements, you receive notifications in Collibra about scheduled maintenance.PrerequisitesUsage statistics are enabled. Contact Collibra support if this is not the case.StepsClick your avatar, then Profile.Your profile page appears.In the Scheduled Maintenance Notifications section, click .Select or clear the check box.Click Save.Edit user detailsYou can edit your own profile such as the application language, email notifications and contact email address on your profile page. You can also reset your password, you receive instructions to do so by email.PrerequisitesIf you want to edit the user details of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.StepsClick your avatar, then Profile.Your profile page appears.In the upper-right corner, click Edit.  The Edit dialog box appears.Enter the required information.FieldDescriptionFirst nameEnter the first name of the user.Last nameEnter the last name of the user.EmailEnter the email address on which the user receives all communication from Collibra, such as the registration mail and notifications.Click Save.
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	 Asset functionalitiesIn this section, you find more information about the general functionalities on asset pages such as diagrams, relations and ratings.In this chapterAsset pagesAn asset page contains information about one asset. An asset is a resource that is stored and managed in Collibra Data Intelligence Cloud and owned or controlled by the customer. An asset is the capital building block by which to capture information (in terms of characteristics).Identical asset names per domain‘Identical asset names per domain’ is a feature that allows you to specify a regular name and a unique full name for an asset. If ‘identical asset names per domain’ is enabled for an asset type, then multiple assets of that asset type can have an identical name in a domain.All assets must have a unique full name per domain, regardless of whether or not ‘identical asset names per domain’ is enabled.Technically, all assets have two names: A name: the regular name that is used by default in most places in the UI, such as the asset page title bar, preview panes, diagrams, search results, automatic hyperlinks and relation tables.A full name: the fully qualified name that must be unique within a domain. It is mainly used for technical operations (through the API) and when you edit an asset whose asset type allows identical names per domain.By default, the name of an asset is the same as its full name. Collibra Data Intelligence Cloud automatically synchronizes them, so users don't notice the difference. However, for some asset types, it may be beneficial to allow users to edit the name and full name independently of one another, and have multiple assets with an identical name in one domain. This has the following benefits:You can use a shorter or simpler name for an asset that has a long or complex full name. This is particularly useful in Collibra Data Catalog.You can use the same name for multiple assets in one domain. Keep in mind that the full name still has to be unique for each asset in a domain.Affected featuresThe API is backward-compatible with regard to this feature, meaning the behavior of the API is not affected by whether or not ‘identical names per domain’ is enabled. Drop-down fieldsIn asset drop-down fields, you can search for an asset based on the name or the full name. This also includes the drop-down menus to:Add manual hyperlinks to an asset in a text attribute.Add (complex) relations  on an asset page and in assets table.Filter relations on an asset table. Add data to a data set. TablesThe Name column contains the name. This column cannot be removed because it is used by hierarchy.The Full name column is a regular column that is optional.The relation columns contain asset names.You can use both the name and full name as: An advanced filter.A sort option.A column filter.The preview pane shows the asset's name.Editing cells:If the asset type allows identical asset names per domain, you can edit both the name and full name of an asset, independently of one another.If the asset type does not allow identical asset names per domain, editing either the name or full name changes both values.Bulk editing the Name and Full name column is not possible.TilesThe name is used in tile header.Full name is a regular field. It can be moved, hidden and you can edit field name.Name and full name are both available as a sort option.DiagramsThe default node name is the asset name. You can also use the full name (or any other property) as node name.You can use Name and Full Name as a node overlay.The preview shows the name of an asset.ExportThe name is always exported to the Name column.If you select Add the characteristics needed for reimport:The full name is always exported (to uniquely identify each asset during re-import). Relations are exported based on the full name: relation name [role/co-role asset type] → Full Name.If you do not select Add the characteristics needed for reimport:If the Full name column is added to the view, it is exported to the Full name column.Relations are exported based on the name: relation name [role/co-role asset type] → Name.ImportFull name has to be mapped, unless you map the ‘ID’ column (only available in special view ‘All Characteristics').Full name will auto-map to the Full name column.When you import a file that was exported pre-5.4, you have to manually map the Full name column of the view to the Name column of the import file.Name will auto-map to the Name column.Name does not have to be mapped.Complex relations:Relation asset full name auto-maps to relation name [role/co-role asset type] → Full Name. When you import a file that was exported pre-5.4, you have to manually map the Full name column of the view to the relation name [role/co-role asset type] → co-role/role asset type column of the import file.Relation asset display name should not be mapped.SearchBasic search: searches for assets by name.Advanced search: searches for assets by name, when name is in the search criteria.Currently, you can not define a search filter for the ‘full name’ field.In the search results, the Name column shows the asset name.The preview shows the asset name.Validation rulesTo refer to the name in your validation rule scripts, use displayName.To refer to the full name in validation rule script, use fullName.Validation rules are backward compatible with regard to this feature, meaning a validation rule written prior to 5.4, will behave the same in 5.4.ActionsAdministrators can enable or disable identical asset names per domain for an asset type. If identical asset names per domain has been enabled for an asset type and there are multiple assets in the domain with identical names, the feature can still be disabled. Collibra will simply show the full name of such assets, throughout the UI.You can edit the asset name and full name.You can add the Full name field to a table or tile.Create assetsIn Collibra Data Intelligence Cloud, domain types are assigned to asset types. You can add an asset to only that domain whose domain type is assigned to the asset type of the asset.Requirements and permissionsThe requirements and permissions for creating an asset depends on the values that you select in the Domain and Type fields when creating the asset.You have the Asset > Add resource permission for the domain that you select when creating the asset.This permission is granted through a resource role that is assigned to you either on the domain or on the community to which the domain belongs (via inheritance). For more information, go to Responsibilities.You have a global role that has the relevant global permission for the type of asset that you are creating. For example, if you want to create a Business Term asset, you must have a global role that has the Business Semantics Glossary global permission. Similarly, if you want to create a Policy asset, you must have a global role that has the Policy Manager global permission.To view the global permissions for all packaged (out-of-the-box) asset types, go to Overview of packaged asset types.StepsOpen the product for which you want to create an asset (for example, Business Glossary).On the main toolbar, click .The Create dialog box appears.On the Assets tab, click an asset type from the list.The Create Asset dialog box appears.Enter the required information.FieldDescriptionTypeThe asset type of the asset that you are creating.DomainThe domain to which the asset will belong. Ensure that the domain type of the selected domain is assigned to the selected asset type.NameA name to identify the asset.You can simultaneously create multiple assets. To do so, after typing the name, press Enter, and then type the next name. Depending on the settings, asset names may need to be unique in their domain. If you enter a name that already exists, it appears in the strike-through style.Click Create.A message stating that one or more assets are created appears in the upper-right corner of the page.Asset page overviewThe asset page provides an overview of information related to an asset, based on its asset type's assignment. The assignment determines which and how many elements are by default added to the asset page.NumberSectionDescriptionBreadcrumbsThe breadcrumbs of the current asset.Asset type representationThe icon or abbreviation of the asset type.You can edit how an asset type is represented.Asset nameThe name of the asset.Resource toolbarAdditional actions, such as editing the asset and starting a workflow.Articulation score The articulation score of the asset.If there are no articulation score rules assigned to the asset, the asset page does not show an articulation score.Asset validationThe validation result of the validation rules assigned to the asset.StewardsThe stewards of the asset. You can see up to three stewards on the asset page. If there are more, click See all <number> to see them on the Responsibilities page.Tab pane A collapsible pane that allows you to navigate to other pages of the asset and add characteristics as specified in the assignment.EditorThe currently selected page, in this case the Overview page, which contains all the attributes, relations and complex relations that have been defined for the asset and whose type was added to the relevant assignment.If a certain attribute type has been assigned as mandatory for this asset type, this attribute is shown in the asset's Overview tab, even if no attribute value has been defined yet.If you want to copy and paste text from other sources into a text field, we recommend that you click , and then paste the text into the Show source code field. This will remove any unwanted formatting or tagging of the text. For detailed information, see the knowledge base article on Collibra Support Portal.AttributeAn attribute is a characteristic of an asset containing information about the asset. This information can be in various formats, depending on the attribute kind:True/False: A binary choice.Date: The format of the date depends on the user's locale settings.Multiple selection: One or more values from a predefined list.Number: If this is a fraction, the decimal separator shown in the UI is decided by the user's locale settings, usually a comma or a dot.Selection: One value from of a predefined list.Text: which may also include images and hyperlinks.If a text attribute does not have any value, it shows the message No value has been given yet. If a text attribute has an empty value, it shows a message Empty value.          Text attributes can have up to 100.000 bytes.RelationRelations of the same type are shown in a list. You can show the list in different display modes:Table: You can also choose the columns, or sort and filter their content.Tiles: You can choose which fields to display and determine how many tiles to display.Complex relationComplex relations of the same type can be shown in different ways:Table: You can show related assets in a table. This is the default way. You can edit this table in the same way you can any other table.Diagram: You can show complex relations as a diagram to visualize the underlying relations. You can scroll through the diagram and move nodes, but you cannot edit the diagram as extensively as you can via the diagram view.ExampleRelation viewsThe asset page provides an overview of information related to an asset, based on its asset type's assignment. This includes the relations and complex relations.You only see complex relations if you have permission to view all assets of the complex relation.Display modes All relations and complex relations of the same type are displayed in a separate section with the relation type as section title. Each section can be shown in different display modes:Table: By default, related assets are shown in a table. You can edit this table in the same way you can any other table.ExampleTiles: You can show the related assets as a set of tiles. You can edit this set of tiles in the same way you can any other set of tiles.ExampleDiagram: You can show complex relations as a diagram to visualize the underlying relations. You can scroll through the diagram and move nodes, but you cannot edit the diagram as extensively as you can via the diagram view.ExampleSaving and sharing the layout of relation viewsFor each relation type and complex relation type, there is a default layout of the relation view. Similar to regular views, you can change most elements of the layout:The fields.The display mode: table or tiles.The sorting and sort direction.The tiles or rows per page.If the assets are shown in table display mode, the width of each column.If you make changes, Collibra automatically saves the layout.If you have the Manage shared Views, Dashboard and Search Filter global permission, you can also override the layout of this relation type or complex relation type for all users by clicking  → Save for all users. The previous layout of other users is lost. However, all users can still make fresh changes.Print an asset page or save as a PDF fileYou can print an asset page or save it as a PDF file to share information about an asset outside of Collibra Data Intelligence Cloud, for example for audit, reporting or security purposes.Not all information is printed:Relations are represented by a simple list, with the relation type as the header. Only the names of the related assets are printed in the list. The other fields of the related assets, for example their domains and asset types, are not printed. Additionally, only the related assets of the first page of the relation table are printed. The other related assets are not printed.Complex relations are not printed.Comments are not printed.Attachments are not printed.Attributes that were never given a value (except for tags) are not printed.StepsOpen an asset page.In the resource toolbar, click .    The print preview and the Print dialog box appear.If required, change the print settings, such as the printer or paper size.Depending on your browser and print settings, click Save or Print.Edit an assetYou can edit an asset to suit your needs.StepsOpen an asset page.Perform one of the following steps:In the resource toolbar, click Edit.In the resource toolbar, click Actions > Edit.The Edit <asset name> dialog box appears.Enter the required information.FieldDescriptionNameThe name of the asset.If identical asset names per domain is disabled for this asset type, the name of an asset must be unique in its domain. If it is disabled and you type an existing name, an error message will appear below this field.Full nameThe full name of the asset. The full name of an asset must always be unique in its domain.This field is only available if identical asset names per domain is enabled for this asset type.Do not edit the full name of assets needed to synchronize or refresh data sources. This may cause unexpected results and break the synchronization or refresh process.TypeThe asset type.StatusThe status of the asset.Click Save.Edit the name of an assetYou can edit the name of an asset in different ways:From the asset page.By editing the name cell in an asset view.If Identical asset names per domain is enabled for the relevant asset type, you can also edit the asset's full name.Edit the name of an asset from the asset pageOpen an asset page.In the resource toolbar, click Edit.The Edit <asset name> dialog box appears.Enter the required information.FieldDescriptionNameThe name of the asset.If identical asset names per domain is disabled for this asset type, the name of an asset must be unique in its domain. If it is disabled and you type an existing name, an error message will appear below this field.Full nameThe full name of the asset. The full name of an asset must always be unique in its domain.This field is only available if identical asset names per domain is enabled for this asset type.Do not edit the full name of assets needed to synchronize or refresh data sources. This may cause unexpected results and break the synchronization or refresh process.Click Save.Identical asset names per domain‘Identical asset names per domain’ is a feature that allows you to specify a regular name and a unique full name for an asset. If ‘identical asset names per domain’ is enabled for an asset type, then multiple assets of that asset type can have an identical name in a domain.All assets must have a unique full name per domain, regardless of whether or not ‘identical asset names per domain’ is enabled.Technically, all assets have two names: A name: the regular name that is used by default in most places in the UI, such as the asset page title bar, preview panes, diagrams, search results, automatic hyperlinks and relation tables.A full name: the fully qualified name that must be unique within a domain. It is mainly used for technical operations (through the API) and when you edit an asset whose asset type allows identical names per domain.By default, the name of an asset is the same as its full name. Collibra Data Intelligence Cloud automatically synchronizes them, so users don't notice the difference. However, for some asset types, it may be beneficial to allow users to edit the name and full name independently of one another, and have multiple assets with an identical name in one domain. This has the following benefits:You can use a shorter or simpler name for an asset that has a long or complex full name. This is particularly useful in Collibra Data Catalog.You can use the same name for multiple assets in one domain. Keep in mind that the full name still has to be unique for each asset in a domain.Affected featuresThe API is backward-compatible with regard to this feature, meaning the behavior of the API is not affected by whether or not ‘identical names per domain’ is enabled. Drop-down fieldsIn asset drop-down fields, you can search for an asset based on the name or the full name. This also includes the drop-down menus to:Add manual hyperlinks to an asset in a text attribute.Add (complex) relations  on an asset page and in assets table.Filter relations on an asset table. Add data to a data set. TablesThe Name column contains the name. This column cannot be removed because it is used by hierarchy.The Full name column is a regular column that is optional.The relation columns contain asset names.You can use both the name and full name as: An advanced filter.A sort option.A column filter.The preview pane shows the asset's name.Editing cells:If the asset type allows identical asset names per domain, you can edit both the name and full name of an asset, independently of one another.If the asset type does not allow identical asset names per domain, editing either the name or full name changes both values.Bulk editing the Name and Full name column is not possible.TilesThe name is used in tile header.Full name is a regular field. It can be moved, hidden and you can edit field name.Name and full name are both available as a sort option.DiagramsThe default node name is the asset name. You can also use the full name (or any other property) as node name.You can use Name and Full Name as a node overlay.The preview shows the name of an asset.ExportThe name is always exported to the Name column.If you select Add the characteristics needed for reimport:The full name is always exported (to uniquely identify each asset during re-import). Relations are exported based on the full name: relation name [role/co-role asset type] → Full Name.If you do not select Add the characteristics needed for reimport:If the Full name column is added to the view, it is exported to the Full name column.Relations are exported based on the name: relation name [role/co-role asset type] → Name.ImportFull name has to be mapped, unless you map the ‘ID’ column (only available in special view ‘All Characteristics').Full name will auto-map to the Full name column.When you import a file that was exported pre-5.4, you have to manually map the Full name column of the view to the Name column of the import file.Name will auto-map to the Name column.Name does not have to be mapped.Complex relations:Relation asset full name auto-maps to relation name [role/co-role asset type] → Full Name. When you import a file that was exported pre-5.4, you have to manually map the Full name column of the view to the relation name [role/co-role asset type] → co-role/role asset type column of the import file.Relation asset display name should not be mapped.SearchBasic search: searches for assets by name.Advanced search: searches for assets by name, when name is in the search criteria.Currently, you can not define a search filter for the ‘full name’ field.In the search results, the Name column shows the asset name.The preview shows the asset name.Validation rulesTo refer to the name in your validation rule scripts, use displayName.To refer to the full name in validation rule script, use fullName.Validation rules are backward compatible with regard to this feature, meaning a validation rule written prior to 5.4, will behave the same in 5.4.ActionsAdministrators can enable or disable identical asset names per domain for an asset type. If identical asset names per domain has been enabled for an asset type and there are multiple assets in the domain with identical names, the feature can still be disabled. Collibra will simply show the full name of such assets, throughout the UI.You can edit the asset name and full name.You can add the Full name field to a table or tile.Move an asset to another domainYou can move a single asset to a different domain.If an asset is moved to a domain in another scope, its assignment of its assets may change.PrerequisitesYou have a resource role with the Asset > Remove resource permission for the asset you want to move.You have a resource role with the Asset > Add resource permission for the domain to which you want to move the asset.Move a single asset from the asset pageOpen an asset page.Perform one of the following steps:In the resource toolbar, click Move. If you cannot see the Move button then click More → Move.In the resource toolbar, click Actions > Move.The Move <asset name> dialog box appears.In the Move dialog box, click the new domain.Click Save.Move multiple assets from a domain pageOpen a domain page.    In the tab pane, click   Assets.  Select the assets you want to move.In the action toolbar, click Move.In the Move selected assets dialog box, select the new domain.Click Save.Move multiple assets from the global viewOpen the global view.Select the check boxes in front of the assets you want to move.In the action toolbar, click Move.In the Move selected assets dialog box, click the new domain.Click Save.Delete an assetThis section describes how to delete an asset in table display mode and tile display mode.You can also delete multiple assets at once.Deletion is permanent, you cannot undo it.  If you delete a configuration asset of a data source, you also delete its configuration. Register your data source again to create a new configuration asset or contact support for more information.Via an asset pageOpen an asset page.Perform one of the following steps:In the resource toolbar, click More > Delete.In the resource toolbar, click Actions > Delete.Click Delete..Delete an asset from a viewIn table display modeOpen a view in table display mode.If necessary, filter using a table filter or a column filter to easily find the asset.Select the check box in front of the asset you want to delete.In the action toolbar, click Delete.The Delete assets dialog box appears.Click Delete.In tile display modeOpen a view in tile display mode.If necessary, filter using a tile filter or a field filter to easily find the asset.Select the tile you want to delete.In the action toolbar, click Delete.The Delete assets dialog box appears.Click Delete..Delete multiple assetsThis section describes how to delete multiple assets at once, in table display mode and tile display mode.Deletion is permanent, you cannot undo it.Delete multiple assets in table display modeOpen a table.If necessary, filter the table using a table filter or a column filter.Select the check boxes in front of the assets you want to delete.You can select all the visible assets at once by clicking the check box next to the Name column header.In the action toolbar, click Delete.The Delete assets dialog box appears.Click Delete.Delete multiple assets in tile display modeOpen a set of tiles.If necessary, filter the tiles using a tile filter or a field filter.Select the tiles you want to delete.In the action toolbar, click Delete.The Delete assets dialog box appears.Click Delete.CharacteristicsCharacteristics is a generic term for attributes, relations and complex relations.Add characteristics to an assetYou can add a characteristic to an asset to add additional information about it.PrerequisiteYou have assigned the characteristic type to the relevant assignment of the asset's type.StepsOpen an asset page.    In the tab pane, click   Add Characteristic.The Add a characteristic dialog box appears.In the Add a Characteristic dialog box, do one of the following:If ...then ...You want to add an attribute:Click Attributes.You want to add a relation:Click Relations.You want to filter the characteristics:Click All.Click in the Search field.Start typing the name of the characteristic that you want to add.If the characteristic type is not in the list, it is not in the asset type's assignment.Enter the required information.The required information depends on the characteristic that you are adding.Click Save.Edit asset characteristicsYou can edit characteristics of an asset. The procedure you should follow depends on the type of characteristic you want to edit.If ...then ...you want to edit an attribute:Open an asset page.Double-click the attribute or click .Edit the attribute. Click Save.you want to edit a relation:Delete the existing relation.Create a new relation.you want to edit a complex relation:Open an asset page.Go to the complex relation you want to edit.Click to change one of more relations.The Edit Complex Relation dialog box is shown.        Edit the content of the complex relation, to meet your needs.On the right, the minimum and maximum amount of items that are required are shown.Click Next and then Finish.If the characteristic type is not in the list, it is not in the asset type's assignment.Remove asset characteristicsYou can remove an asset characteristic as long as the minimum number of occurrences in the assignment has not been reached. Open an asset page.At the end of the line, click .A dialog box appears.Click Delete.These steps can be used to remove attributes, relations or complex relationsAttributes An attribute is a characteristic that describes an asset by means of an individual field. The attribute's kind defines the class of information that the attribute contains.You can add an attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.About attributesAn attribute is a characteristic that describes an asset by means of an individual field. The attribute's kind defines the class of information that the attribute contains.You can add an attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.Examples of attributes The following table contains attribute types and a description of the attribute that can be added to an asset.Attribute typeDescription of the attributeExample of an attributeDefinitionThe description with background information on the assetAsset: Customer Definition: A person, company or organization that purchases a commodity or service.Last Review DateThe date on which the asset was reviewed.02/05/2020FrequencyThe rate at which an asset changes over a particular period of time.DailyRows FailedThe number of rows that failed a rule.15Personally Identifiable InformationA boolean field to indicate whether an asset contains personally identifiable information.TrueAn attribute can contain up to 100.000 bytes, which corresponds to roughly up to 100 000 characters in the source code of the attribute.Add an attributeYou can add attributes to an asset to describe that asset.PrerequisitesThe attribute's type is in the relevant assignment of the asset's type. If the minimum cardinality of the relevant attribute type is greater than 0, or if an attribute of that type already exists, the asset page always contains an attribute field for the attribute type.Add an attribute from an asset pageOpen an asset page.    In the tab pane, click   Add Characteristic.The Add a characteristic dialog box appears.In the Add a Characteristic dialog box, click the Attributes tab.The Add <attribute type> dialog box appears.Enter the value of the attribute.If you want to add a Description attribute, enter the description that you want to add to the asset.Click Save.Add an attribute from a tableOpen a view in the table display mode.If required, add the column of the attribute type to the table:Above the table, to the right, click →  Fields.Click Select fields → Attributes.Select the relevant attribute types.Click Update.Click Save.Perform one of the following steps:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears. Enter the required information.Perform one of the following steps:If you want to change...do...the current row only:  Click .                all visible rows:Click Apply to all visible rows.  Click .                selected rows:Select one or more rows.Click Apply to all selected rows.  Click .                Edit an attributeYou can edit the value of an attribute.You can edit the definition of an asset. If you delete an attribute value from an attribute type of the Selection or Multiple Selection kind, then you can no longer edit the values of the attributes of that type without removing those invalid values. We recommend that you remove invalid attribute values from the attributes before removing them from the attribute type. Edit an attribute from the asset pageOpen an asset page.Double-click the attribute or click .Edit the attribute. Click Save.Edit an attribute from a tableOpen a view in the table display mode.If required, add the column of the attribute type to the table:Above the table, to the right, click →  Fields.Click Select fields → Attributes.Select the relevant attribute types.Click Update.Click Save.Perform one of the following steps:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears. Enter the required information.Perform one of the following steps:If you want to change...do...the current row only:  Click .                all visible rows:Click Apply to all visible rows.  Click .                selected rows:Select one or more rows.Click Apply to all selected rows.  Click .                Delete an attributeYou can delete attributes as long as the minimum number of occurrences has not been reached.If you delete an attribute value from an attribute type of the Selection or Multiple Selection kind, then you can no longer edit the values of the attributes of that type without removing those invalid values. We recommend that you remove invalid attribute values from the attributes before removing them from the attribute type. Delete an attribute from an asset pageOpen an asset page.At the end of the line, click .A dialog box appears.Click Delete. Delete an attribute from a tableOpen a view in the table display mode.If you don't see the column of the attribute type, add it to the table:Above the table, to the right, click → Fields.Click Select fields → Attributes.Select the relevant attributes.Click Update.Click Save.Click next to the attribute that you want to delete.The Delete <attribute> dialog box appears.Click Yes.      The attribute field is now empty.Relations A relation is a characteristic that describes how two assets relate to each other. The relation's type defines the relation and determines which assets can be related. About relationsA relation is a characteristic that describes how two assets relate to each other. The relation's type defines the relation and determines which assets can be related. You can add a relation between assets if the relation's type is in the relevant assignment of the asset's type.Add a relationYou can add a relation to link two assets.PrerequisitesThe relation's type is in the relevant assignment of the asset's type. If the minimum cardinality of the relevant relation type is greater than 0, or if a relation of that type already exists, the asset page always contains a relation table for the relation type.Add a relation from the asset pageOpen an asset page.    In the tab pane, click   Add Characteristic.The Add a characteristic dialog box appears.Click Relations.Search for and click <the relation type that you want to create>.The Add relation type <asset type> dialog box appears.Enter the required information.OptionDescriptionAssetsThe name of the related asset.Filter suggested assets by organizationOption to filter the suggestions based on selected communities and domains.If this option is selected, the organization tree appears. You can then filter and select domains and communities.Start dateOptionally enter the date on which the relation between the assets becomes applicable.End dateOptionally enter the date on which the relation between the assets is no longer applicable. Leave this field empty to create a permanent relation.Click Save.Add relations from a tableOpen a view in the table display mode.If you don't see the column of the relation type, add it to the table:Above the table, to the right, click → Fields.Click Select fields → Relations.Select the relevant relation types.Click Update.Click Save.Perform one of the following steps:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears. Enter one or more assets.Perform one of the following steps:If you want to change...do...the current row only:  Click .                all visible rows:Click Apply to all visible rows.  Click .                selected rows:Select one or more rows.Click Apply to all selected rows.  Click .                Edit a relationYou cannot edit a relation, but you can delete the existing relation and create a new one.Edit a relation from an asset pageDelete the existing relation.Open an asset page.At the end of the line, click .A dialog box appears.Click Delete.Add a new relation.Open an asset page.    In the tab pane, click   Add Characteristic.The Add a characteristic dialog box appears.Click Relations.Search for and click <the relation type that you want to create>.The Add relation type <asset type> dialog box appears.Enter the required information.OptionDescriptionAssetsThe name of the related asset.Filter suggested assets by organizationOption to filter the suggestions based on selected communities and domains.If this option is selected, the organization tree appears. You can then filter and select domains and communities.Start dateOptionally enter the date on which the relation between the assets becomes applicable.End dateOptionally enter the date on which the relation between the assets is no longer applicable. Leave this field empty to create a permanent relation.Click Save.Edit a relation from a tableOpen a view in the table display mode.If required, add the column of the relation type to the table:Above the table, to the right, click → Fields.Click Select fields → Relations.Select the relevant relation types.Click Update.Click Save.Perform one of the following steps:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears. Remove or add one or more assets.Perform one of the following steps:If you want to change...do...the current row only:  Click .                all visible rows:Click Apply to all visible rows.  Click .                selected rows:Select one or more rows.Click Apply to all selected rows.  Click .                Delete a relationYou can delete relations between two assets as long as the minimum number of occurrences in the assignment has not been reached.Delete a relation from an asset pageOpen an asset page.At the end of the line, click .A dialog box appears.Click Delete.If view your relation in tile display mode, the is in the upper-right corner.Delete a relation from a tableOpen a view in the table display mode.If you don't see the column of the relation type, add it to the table:On the content toolbar, click → Edit Fields.The Fields dialog box appears.  Click Select fields → Relations.Select the relevant relation types.Click Update.Click Save.Perform one of the following steps:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears. Remove one or more assets from the cell.Perform one of the following steps:If you want to change...do...the current row only:  Click .                all visible rows:Click Apply to all visible rows.  Click .                selected rows:Select one or more rows.Click Apply to all selected rows.  Click .                Complex relations A complex relation is a characteristic that describes how two or more assets relate to each other. It can also have attributes of its own, for example, Description and Priority. Technically, they are objectified associations: simplified assets that cannot exist independently. The complex relation's type defines the relations and attributes the complex relation can have.About complex relationsA complex relation is a characteristic that describes how two or more assets relate to each other. It can also have attributes of its own, for example, Description and Priority. Technically, they are objectified associations: simplified assets that cannot exist independently. The complex relation's type defines the relations and attributes the complex relation can have.You can add a complex relation between assets if the complex relation's type is in the relevant assignment of the asset's type.A complex relation cannot have more than 32,767 relations to assets.ExampleWhen you add a complex relation, you add one or more relations between the assets and the complex relation itself. The assets of those relations are always the head of the relation, while the complex relation is always the tail.The following example creates a complex relation type called Code Mapping, with three relation types (source, target and crosswalk) and two attribute types (Description and Transformation Logic).For each relation type in the complex relation type, you can select head assets. Above the fields, you can see the minimum and maximum occurrences for each relation type. For each selected head asset, a relation of the relevant type is created between the head asset and the complex relation. You can also add attributes to the complex relation.Add a complex relation to an assetYou can add a complex relation to an asset, to create a link between two or more assets and add attributes.If you want to add many complex relations, you can also import them.PrerequisitesThe complex relation's type is in the relevant assignment of the asset's type. If the minimum cardinality of the relevant complex relation type is greater than 0, or if a complex relation of that type already exists, the asset page always contains a complex relation table for the complex relation type.StepsOpen an asset page.    In the tab pane, click   Add Characteristic.The Add a characteristic dialog box appears.In the Add a Characteristic dialog box, click the Relations tab.Select a relation of the type Complex Relation, for example, Field Mapping Target. The Add <complex relation type> dialog box appears.Enter the required information.The available fields depend on the configuration of the complex relation type.See an example.The minimum and maximum amount of assets that you can add is displayed in the right upper corner of every relation field. If there is no maximum amount, the maximum amount of assets to add in the relation was not set.Click Finish.Edit a complex relationYou can edit a complex relation, for example if you want to edit its legs or attributes.StepsOpen an asset page.Find the complex relation you want to edit.Click to change one of more relations or attributes.The Edit Complex Relation dialog box appears.Enter the required information.The required fields depend on the configuration of the complex relation type.Click Save.Delete a complex relationYou can delete a complex relation between two or more assets as long as the minimum number of occurrences in the assignment has not been reached. StepsOpen an asset page.At the end of the line, click .A dialog box appears.Click Delete.The complex relation is deleted.HyperlinkingIn Collibra Data Intelligence Cloud, you can manually create hyperlinks in text attributes or enable automatic hyperlinking to easily navigate from asset to asset or from an asset to a website.Automatic hyperlinkingIn Collibra, every asset is a potential target of a hyperlink. If the name of an asset is mentioned somewhere in a text attribute of another asset, that mention automatically gets a hyperlink to the corresponding asset. Collibra keeps all hyperlinks up to date when you edit your data.You can enable or disable automatic hyperlinking at the different levels:Environment: Contact Collibra support if you want to enable or disable automatic hyperlinking in your entire environment.Domain: If automatic hyperlinking is enabled in Collibra Console, you can enable or disable it on the domain level. Because every asset is a possible target, automatic hyperlinking can lead to an excessive amount of hyperlinks, which can negatively affect performance. Therefore, by default, automatic hyperlinking is disabled for all domains. However, you can enable it.Individual assets: An asset may have a common word as its name, for example, is, a, or or and. When that happens, you don't want hyperlinks to this asset because it would lead to a lot of useless hyperlinks. Therefore, you can exclude such assets from automatic hyperlinking.If there are assets with identical names, they are all shown in a pop-up when you click the link. Then, you can click one to open its asset page.After importing data or after a backup has been restored, Collibra triggers a rebuild of the automatic hyperlinks. You can also rebuild the hyperlinks manually.By default, automatic hyperlinking is not case sensitive. For example, an asset 'Nato' will also be hyperlinked if it is mentioned as 'NATO', and vice versa.Contact Collibra support to change case-sensitivity for automatic hyperlinking.Manual hyperlinkingYou can use manual hyperlink if you want a hyperlink to or from a specific asset. This is particularly useful if automatic hyperlinking is disabled, or if the link text does not match the name of the target asset.You can also manually create hyperlinks to web addresses.Disable automatic hyperlinking to a specific assetYou can disable automatic hyperlinking at domain level and asset level.Contact Collibra support if you want to enable or disable automatic hyperlinking for your entire environment.An asset may have a common word as its name, for example, is, a, or or and. When that happens, you don't want hyperlinks to this asset because it would lead to a lot of useless hyperlinks.You can still manually create hyperlinks that target the asset.StepsOpen an asset page.In the toolbar, click, Auto hyperlinks.The Auto hyperlinks dialog box appears.Enter the required information.FieldDescriptionNo Automatic HyperlinkCollibra Data Intelligence Cloud will not create automatic hyperlinks to this asset.Click to close the dialog box.What's next?All automatic hyperlinks to the asset are removed and Collibra Data Intelligence Cloud no longer creates automatic hyperlinks to the asset. If you enable automatic hyperlinking to the specific asset again, you have to rebuild the hyperlinks.Enable automatic hyperlinking in a domainAutomatic hyperlinking is especially useful for linking to Business Term assets. But as every asset is a possible target, automatic hyperlinking can lead to an excessive amount of hyperlinks, which can negatively affect performance. Therefore, by default, automatic hyperlinking is disabled for all domains.Nevertheless, you can enable automatic hyperlinking at the domain level.You can use the Manage auto hyperlinks workflow to enable or disable automatic hyperlinking in bulk.PrerequisitesAutomatic hyperlinking is enabled. Contact Collibra support if this is not the case.StepsGo to the domain page of the domain for which you want to enable automatic hyperlinking.In the resource toolbar, click Actions → Auto hyperlinks.The Auto hyperlinks dialog box appears.Enter the required information.FieldDescriptionNo Automatic HyperlinkCollibra will not create automatic hyperlinks to assets in this domain when its name occurs in a text attribute of another asset. You can use this option when the asset name is a common word like ‘and’, ‘or’, ‘it', etc. You can still create manual hyperlinks to this asset.Once you make a change the dialogue box closes automatically.What's next?Rebuild the hyperlinks to automatically create the hyperlinks to all the assets in the domain. Delete an automatic hyperlinkCollibra Data Intelligence Cloud can automatically create hyperlinks to assets. However, you can delete some or all of the hyperlinks without touching other potential automatic hyperlinks to the destination asset.StepsOpen an asset page.Click in the text field with an automatic hyperlink.Select the text.In the Edit toolbar, click (Remove autohyperlink).The hyperlink is removed.Click Save, to save the content of the text field.What's next?The automatic hyperlink is removed, but if you edit the text field again and you add the same text, the automatic hyperlink will again be created. If the hyperlinks are rebuilt, for example after restoring a backup, the hyperlinks may reappear.To prevent an automatic hyperlink to a specific asset, you have to disable automatic hyperlinking for the target asset or the domain of the target asset.Create a hyperlink to an assetYou can manually create hyperlinks to assets.Collibra Data Intelligence Cloud can also create hyperlinks automatically.StepsOpen an asset page.Double-click a text attribute, for example the definition, to edit the text.Select the text to transform into a hyperlink.On the Edit toolbar, click (Insert/edit link) → Link to asset.In the Assets field, start typing the name of the asset to which you want to link.The assets are filtered as you type.To help you identify the correct asset, the domain of each asset is shown below the asset name.Click the asset to which you want to link.You can link to multiple assets, in which case, all links are shown when you click the link. You can then select which one to follow.Click Save, to save the hyperlink.Click Save, to save the content of the text field.Create a hyperlink to a web addressIn addition to creating hyperlinks to other assets in your environment, you can also create hyperlinks to web addresses. When you click the hyperlink, it will automatically open in a new tab.StepsOpen an asset page.Double-click a text attribute or click to edit the text.Select the text to transform into a hyperlink.On the Edit toolbar, click (Insert/edit link) → Link to URL.Enter the required information.SettingDescriptionURLThe target website of the hyperlink. If you don't start the URL with http:// or https://, the system will ask if it has to add http://. If you don't add either prefix, Collibra Data Intelligence Cloud will consider the URL content an asset.You will only see this field if the hyperlink you edit is a link to a URL.Text to displayThe display text that will be visible in the attribute. By default, this is the text that you selected.Click Save, to save the hyperlink.Optionally, edit the source code so that the hyperlink automatically opens in a new tab when you click it.Click Source code ().Type target =_blank after the href attribute.Click <a xml=lang href=https://productresources.collibra.com/ target=_blank>here</a> for more information. Click Save.Click Save.Edit a manually created hyperlinkAfter you have created a hyperlink, you can always edit it afterwards. Automatic hyperlinks cannot be edited.StepsOpen an asset page.Double-click a text attribute or click  in the text field that contains the hyperlink that you want to edit. Click anywhere on the hyperlinked text and click Edit.        Update the link: Enter the required information.           ttFieldDescriptionURLThe target website of the hyperlink. If you don't start the URL with http:// or https://, the system will ask if it has to add http://. If you don't add either prefix, Collibra Data Intelligence Cloud will consider the URL content an asset.You will only see this field if the hyperlink you edit is a link to a URL.AssetsThe target assets of the hyperlink.The assets are filtered as you type. Click the asset to which you want to link.You will only see this field if the hyperlink edit is a link to an asset.Text to displayThe display text that will be visible in the attribute. By default, this is the text that you selected.Click Save.Click Save.Remove a manually created hyperlinkYou can remove manually created hyperlinks in text attributes.StepsOpen an asset page.Click in the text field that contains the hyperlink that you want to remove.Click anywhere on the hyperlinked text and click Unlink.The hyperlink is removed. If the hyperlink pointed to many assets, all links are removed.Click Save, to save the content of the text field.RatingsRatings enable users to subjectively rate the quality of an asset, using a five-star rating system, and write a free-text review of the asset, in support of the rating provided.Unlike objective parameters such as data quality, certifications and articulation scores, ratings are purely subjective assessments of data quality.Enabling ratingsRatings are enabled by asset type. When ratings are enabled for a particular asset type, users can rate any asset of that asset type. PermissionsNo particular license is needed to rate assets or to edit or delete ratings; however, certain resource permissions are needed. PermissionWith this resource permission, you can...Rating > AddRate any asset of an asset type for which the feature is enabled.Edit or delete your own ratings.Rating > ModifyEdit other users' ratings.Rating > RemoveDelete other users' ratings.Users are not granted permissions directly, but through global roles and responsibilities.Guest users can see all ratings and reviews, but cannot provide ratings or reviews of their own.Adding, editing and removing ratings doesn't change assets, so their last modified date will not be updated.ActionsView ratings.Enable or disable ratings.Rate an asset.Edit a ratings.Delete a rating.Delete all ratings of assets of a specific type.Enable or disable ratingsYou can enable and disable ratings via the asset type pages, in Settings.Enabling ratings for a particular asset type is not inherited by children asset types. The feature has to be manually enabled for each child asset type.By default, ratings are enabled for asset types Data Set and Report and their children asset types. Ratings are disabled, by default, for all other packaged asset types and any asset types you create.Ratings cannot be disabled for a specific asset type if user ratings exist for any assets of that asset type. In other words, all user ratings for all assets of a specific asset type must be manually deleted before ratings can be disabled for that asset type.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.In the upper-right corner, click Edit.  The Edit <asset type> dialog box appears.Enter the required information.FieldDescriptionEnable ratingsSelect to allow users to rate assets.Ratings enable users to subjectively rate the quality of an asset, using a five-star rating system, and write a free-text review of the asset, in support of the rating provided.Click Save.View ratingsIf ratings are enabled for an asset type and one or more ratings has been provided for an asset of that type, the associated ratings activity appears in several places in the UI.On an asset pageRatings information appears on the asset page of any asset with one or more ratings.No.Description1The average of all user ratings for that asset.2The total number of ratings. 3A horizontal bar chart showing the distribution of ratings.4The percentage of total votes per number of stars.5Your rating and review.6Other users' ratings and reviews, ordered from newest to oldest.In the History tabUser ratings and any edits to, or deletions of, ratings are shown in the History tab page of the relevant:Asset pages.User profiles.Community pages.Domain pages.In an asset table or set of tilesThere are two fields related to ratings that can be shown in an asset table or set of tiles:Average rating: The average of all user ratings for each asset.Number of ratings: The total number of ratings for each asset.You can sort on these two fields and filter them.Rate an assetYou can rate any asset of an asset type for which ratings have been enabled.Ratings can only be given via asset pages.You can edit or delete your ratings at any time.StepsOpen an asset page.In the My rating section, click the star that corresponds most closely to your opinion of the quality level of the asset.The rating range is from one to five stars, with five representing the highest level of quality and one representing the lowest.Optionally, enter a review of the asset in the text field.This collaborative feature is intended to help an organization improve the quality of its data and help users trust the quality of the data. As such, if you provide a rating of three stars or fewer, we strongly encourage you to provide a review, to help the owner understand how the quality of the asset might be improved.Click Save.The average user rating is recalculated.Edit a ratingIf, for any reason, your opinion of the quality of an asset changes, you can edit or delete the ratings you've given, at any time. With the correct resource permissions, you can also edit other users' ratings.StepsOpen an asset page.If required, edit your own :In the My rating section, click .Make the necessary changes:Click the star that corresponds most closely to your opinion of the quality level of the asset. Edit your review, if relevant.Click Save.The average user rating is recalculated.If required, edit another user's rating:In the Rating section, click next to the rating you want to edit.Make the necessary changes:Click the star that corresponds most closely to the other user's opinion of the quality level of the asset. Edit the review, if relevant.Click Save.The average user rating is recalculated. Delete a ratingIf, for any reason, your opinion of the quality of an asset changes, you can edit or delete the ratings you've given, at any time. With the correct resource permissions, you can also delete other users' ratings. This can be helpful if one or more previous ratings and reviews are no longer relevant.StepsOpen an asset page.If required, delete your own rating:In the My rating section, click .Click Delete, to confirm.The average user rating is recalculated.If required, delete another user's rating:In the Ratings section, click next to the rating you want to delete.Click Delete, to confirm.The average user rating is recalculated.Delete all ratingsYou can delete all ratings of all assets of an asset type in one go. This is mainly helpful if you want to disable ratings for that asset type.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.In the upper-right corner, click Delete ratings.  The Confirm deletion dialog box appears.Click Delete ratings.TagsIn addition to strictly governed metadata, you can use tags to categorize assets. A tag is a piece of metadata that is used to label an asset, to help categorize the asset. You can use the same tag for all the assets that belong to the same category of a business (for example, finance). Although the tags are stored in the Collibra Data Intelligence Cloud database, they are not strictly governed by Collibra. Tags can be added to only assets.Adding, editing, or deleting a tag from an asset does not change the last modified date of the asset.BenefitsSome of the benefits of tags are as follows:You can search for assets with a specific tag by clicking the tag on an asset page or on the tags overview page.You can select the Tag facet on the Search page to navigate search results.You can use tags in filter clauses.You can import and export tags.Tag name characteristicsThe characteristics of tag names are as follows:Tag names are case sensitive. For example, you can enter the following tag names: Car, car. However, tag suggestions are not case sensitive. For example, typing car can provide the following suggestions: Car, car.Tag names cannot contain spaces.Tag names can contain underscores (_).The maximum length of the tag name is 250 characters.PermissionsThe following table contains the permissions that you need to manage tags on the asset and tags overview pages.PagePermissionAssetResourceAsset > Tags > Update: Add, edit, and delete tags.            For information about how to grant this permission to a role, go to Enable permission to use tags.You can grant this permission to only the role that has the relevant global permission for the associated asset type and has at least the view access to the associated community or domain. For more information, go to Responsibilities.Tags overviewGlobal Tags > Manage tags: Edit, merge, and delete tags.This permission allows admin and super users to manage all tags.Tags > View tags: View the tags overview page.Tags overview pageThe tags overview page provides an overview of all the tags in Collibra Data Intelligence Cloud. With the right permissions, you can view, delete, edit, and merge tags. By default, the tags table shows the Name column and the Created By column. You can add more columns. The following table describes all available columns.ColumnDescriptionAssets CountTotal number of assets to which a specific tag has been applied.Created ByThe user who created the tag.Created OnThe date on which the tag was created.Last ModifiedThe date and time when the tag was last modified.Last Modified ByThe user who last modified the tag.NameName of the tag. Tag names cannot contain spaces and the maximum length is 250 characters. The underscore ( _ ) character is allowed.Search by tagsYou can search for all assets for which a specific tag has been applied, by clicking the tag on an asset page or the tags overview page. The search results are shown on the Search page.Edit a tag on the tags overview pageIf you have the correct resource permission, you can edit an existing tag on the tags overview page.Steps    On the main menu, click   , and then click   Stewardship.  In the submenu, click Tags.The Tags overview page opens.Hover your mouse over the name of a tag.Click edit to the right of the tag name. Edit the name.  Click .  Merge tags on the tags overview pageYou can merge tags on the tags overview page. You merge tags by changing the name of a tag to that of another existing tag.Steps    On the main menu, click   , and then click   Stewardship.  In the submenu, click Tags.The Tags overview page opens.Hover your mouse over the name of a tag.Click edit to the right of the tag name. Change the name of the tag to that of another existing tag.Click to the right of the tag. The Merge tags confirmation dialog box appears.Click Merge.Delete a tag from the tags overview pageYou can delete one or more tags from the tags overview page. Steps    On the main menu, click   , and then click   Stewardship.  In the submenu, click Tags.The Tags overview page opens.Select the checkboxes to the left of the tags you want to delete.In the resource toolbar, click More > Delete.Add a tag to an asset on an asset pageYou can add a tag to an asset on an asset page.StepsOpen an asset page.Double-click in the Tags section, or click on the right-hand side of the section.Type the text for your tag and press Enter. As you type, already existing tags that match what you are typing are suggested. If you want to use a suggested tag, you can click on it. Otherwise, you can ignore the suggestions.You can add as many tags as you want.Click Save.Add a tag to an asset in an asset table or set of tilesYou can add a tag to an asset in a table.StepsOpen any set of assets in table display mode.Double-click in the Tags column, or click  on the right-hand side of that column.If you do not see the Tags column, add it to the table. See Customizing tables.Type the text for your tag and press Enter. As you type, already existing tags that match what you are typing are suggested. If you want to use a suggested tag, you can click on it. Otherwise, you can ignore the suggestions.You can add as many tags as you want.  Click .  Delete a tag from an asset on an asset pageYou can delete a tag from an asset on an asset page.StepsOpen an asset page.Double-click in the Tags section, or click on the right-hand side of the section.Click next to the tags that you want to delete.Click Save.Delete a tag from an asset in an asset tableYou can delete a tag from an asset in an asset table.StepsOpen any set of assets in table display mode.Double-click in the Tags column, or click  on the right-hand side of that column.If you do not see the Tags column, add it to the table. See Customizing tables.Click next to the tags that you want to delete.If you want to delete the tags from all assets that are visible on the page, select the Apply to all visible rows check box.  Click .  AttachmentsYou can add attachments to communities, domains and assets. Examples of attachments are reference materials or other documents that are related to the resource.AttachmentsAn attachment is a file that you upload via an asset page, domain page or community page. You can use this to add reference materials or other documents that are related to the resource.You can find attachments on the community, asset or domain page → Files.Adding and removing attachments doesn't modify assets, so their last modified date will not be updated.Uploading attachments is restricted by the file upload settings, which determine the maximum file size, allowed file extensions and maximum amount of uploads and downloads per day. Contact Collibra support if you want to change the file upload settings.Add attachmentsYou can add files to an asset, domain or community as attachments. Adding and removing attachments doesn't change assets, so their last modified date will not be updated.Uploading attachments is restricted by the file upload settings, which determine the maximum file size, allowed file extensions and maximum amount of uploads and downloads per day. Contact Collibra support if you want to change the file upload settings.StepsOpen a community, domain, or asset page.    In the tab pane, click   Files.  Upload a file in one of the following ways:Drag and drop the file in the upload area.Click Upload a file, browse to the location of the file and click Open.The file is displayed in the table.CommentsYou can discuss a community, domain, or asset via comments. For example, if you want to discuss the attributes of an asset or propose related assets, you can do so via comments.Comments are shown on the Overview or Details tab of a community, asset, or domain page. Depending on your permissions, you can add a comment, reply to a comment (), edit your comment (), and delete your comment ().To add a comment, you must have the following resource permission: Comment > AddTo edit your comment, you must have the following resource permission: Comment > UpdateTo delete your comment, you must have the following resource permission: Comment > RemoveAdding, editing, or deleting a comment does not change the last modified date of the community, domain, or asset.Add commentsYou can add comments to communities, domains, and assets. For example, if you want to discuss the description of an asset, you can do so via comments.Requirements and permissionsYou have the Comment > Add resource permission for the community, domain, or asset to which you want to add comments.StepsOpen a community, domain, or asset page.In the left pane, click either Overview → Comments or Details → Comments.In the Comments field, enter your comment. You can use the toolbar to: Modify the appearance of the comment.Add links and images in the comment.Mention other users in the comment. Click Save.Your comment is saved.User mentionsYou can draw a user's attention to a comment, community, domain, or asset via the User mention option. Mention a userTo mention a user in a comment, select or enter @, and then type the user's first name, last name, or username. As you type a name, matching names appear, even if the typed character is not the first character in a name.In a user mention, the user is addressed by their first and last names. If the first and last names for a user are not available, their username is used. If, however, the profile of the user is deleted, their name in the mention is replaced with @Deleted User.List of user mentionsTo view all the comments in which you are mentioned, go to your profile page, and then, in the tab pane, click Mentions.ItemDescriptionThe name of the user who mentioned you in a comment. This can be the full name, first name, last name, or username of the user, depending on which information is available.The name of the resource to which the comment was added.The time when the comment was added.The link to the comment. When you click the link, the resource page is shown with the comment highlighted.Email notificationWhen you mention a user, they receive an email message that contains the content of the comment in which they are mentioned and a link to the page containing the comment.ItemDescriptionThe name of the user who mentioned you in a comment. This can be the full name, first name, last name, or username of the user, depending on which information is available. If you click the name, their profile page in Collibra is shown. You are, however, first prompted to sign in to Collibra.The name of the resource (that is, community, domain, or asset) to which the comment was added. If you click the name, the resource page in Collibra is shown.The content of the comment. If you click your name, your profile page in Collibra is shown.The button to open the comment in Collibra.The button to open the list of all comments in which you are mentioned, in Collibra.View permissionIf you mention a user who does not have the permission to view the resource, a message indicating so appears.If you are the mentioned user who does not have the permission to view the resource, and if you click the resource link in the email notification, the following message is shown: Not authorized.ResponsibilitiesResponsibilities are used to assign a resource role to one or more users and/or user groups. Based on their responsibilities, users can act on the permissions conveyed to them via the resource role. ResponsibilitiesA responsibility is the assignment of one or more users and/or user groups to a resource role for a resource.Based on their responsibilities, users can act on the permissions conveyed to them via the resource role. Child resources always inherit the responsibilities from their parent resources:If the resource is a community, the responsibilities are inherited by subcommunities, domains and assets in the community. For example, if you are a Business Steward for a certain community, you are a Business Steward for all the subcommunities, domains and assets inside that community.If the resource is a domain, the responsibilities are inherited by the assets in the domain.If the resource is an asset, the responsibilities only apply to the asset itself, because assets never have children.Suppose the following setup:Anita Morrison is assigned the Community Manager resource role for a community called Enterprise.John Fisher is assigned the Business Steward resource role for a domain called Critical Data Elements in the Enterprise community.Joanna Zhou is assigned the Owner resource role for a domain called Critical Data Elements in the Enterprise community.William Parker is assigned the Owner resource role for an asset called Customer Revenue in the Critical Data Elements domain.This leads to the following responsibilities:ResourceDirect responsibilitiesInherited responsibilitiesEnterprise communityAnita Morrison as Community ManagerNoneCritical Data Elements domainJohn Fisher as Business StewardJoanna Zhou as OwnerAnita Morrison as Community ManagerCustomer Revenue assetWilliam Parker as OwnerAnita Morrison as Community ManagerJohn Fisher as Business StewardJoanna Zhou as OwnerYou can view direct and inherited responsibilities of a resource in different places.View responsibilities for a resourceYou can view the responsibilities for a resource in the following locations:In the Responsibilities tab of a resource.In any view that displays communities, domains or assets, in the specific column or field for that role.Open any view in table or tiles mode.Perform one of the following steps:In tile mode: add the required fields.In table mode, add the required column.Each role has its own field or column.Depending on the settings in Collibra Console, you may also see the inherited responsibilities.In the Responsibilities tab of a user's profile page.You can also view your own responsibilities.Open a profile page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.In the Responsibilities tab of a user group page.Open a group page.    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.    In the tab pane, click   Users → Groups.The user group table appears.    In the tab pane, click   Responsibilities.The Responsibilities page appears.In the Preview pane of an asset, for example on an asset page.The preview pane only shows the direct responsibilities.The Responsibilities pageThe Responsibilities page shows the view permissions and the responsibilities of a resource.The background colors of the responsibilities show where the responsibility comes from.ColorDescriptionGrayThe user or group inherited the role.WhiteThe user or group was directly assigned to this role for the resource.If a user or group has a responsibility but not the required view permissions, a warning appears in the box. For example, a user was assigned the Steward role for a resource but does not have view permissions for it.For information on view permissions, see the Collibra Data Intelligence Cloud Administration Guide.Create a responsibilityYou can create a responsibility:By assigning a resource role to a user or user group on the responsibilities page of a resource.By adding a user in the table column of a role.By editing an existing responsibility.For optimal performance and ease of use, we recommend that you create responsibilities mainly on domains and communities and not directly on assets. Creating responsibilities directly on large amounts of assets may lead to decreased performance.Assign a resource role to a user or user group on the responsibilities pageOpen a community, domain, or asset page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.Above the table, to the right, click Add.The Add responsibilitiy dialog box appears.Enter the required information.OptionDescriptionRoleEnter the role that you want to assign to a user or group for this resource.People Enter the users and user groups to which you want to assign a role for this resource.Click Add.The users or groups with the assigned role are now displayed in the Responsibilities table.If you want to assign a user or user group a resource role that other users or groups already have for this resource, you can click and add them in the People field in the Assign role box.If there are only inherited roles, is not available.Assign a role to a user or user group for a resource from a tableOpen a table that displays communities, domains or assets.      If required, add the column of the role that you want to assign to the user. Perform one of the following steps:Double-click a cell in the column of the role.Hover your mouse pointer over a cell in the column and click .Click in the field and enter the user or user group.If required, select Apply to visible rows.This will create the responsibilities for all visible users.You can filter the columns first, to assign a role to a user for specific resources in one go.Click .Edit a responsibilityYou can edit a responsibility:by deleting it and creating a new one.in an asset table.You cannot edit inherited responsibilities.Edit a responsibility in a tableOpen a table that displays communities, domains or assets.      If required, add the column of the role that you want to edit.Depending on the settings in Collibra Console, you may also see the inherited responsibilities. You cannot edit these inherited responsibilities. Perform one of the following steps:Double-click a cell in the column of the role.Hover your mouse over a cell in the column and click .Edit the responsibility:Click in the field and enter a new user or user group.Click next to the user or user group to remove the user or user group.If required, select Apply to visible rows.This will edit the responsibilities of all visible users.You can filter the columns first to assign a user to specific resources in one go.Click .Delete a responsibilityYou can delete a responsibility:From the responsibilities page of a resource.From a table.You cannot delete inherited assignments.Delete a responsibility from the responsibilities page of a resourceOpen a community, domain, or asset page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.In the Responsibilities table, click next to the name of the user or group that you want to remove. Click Delete to confirm.Delete responsibilities for a resource from a tableOpen a table that displays communities, domains or assets.      If required, add the column of the role that you want to edit.Depending on the settings in Collibra Console, you may also see the inherited responsibilities. You cannot delete these inherited responsibilities. Perform one of the following steps:Double-click a cell in the column of the role.Hover your mouse over a cell in the column and click .In the cell editor, click next to the user or user group.If required, select Apply to visible rows.This will delete the responsibilities from all visible users.You can filter the columns first to assign a user to specific resources in one go.Click .View permissionsA view permission is the right to see a resource and its children. It determines which users can see and work with which resources. You assign a view permission to users or user groups on domain or community level. Consequently, only these users can see the resources and their children, including the assets. This also includes relations to assets: if you do not have view permissions for an asset, you don't see the relations to that asset, for example in views or on the asset page of the related assets.Understanding view permissionsBy default, all users can see all resources. You can tell that there are no view permissions if Unrestricted view permissions is in the View permissions section of the resource's Responsibilities page.If you add users or user groups to the view permissions of a resource, only those users or groups can view the resource and its children. All child resources inherit the view permissions from parent resources. Once you have added users or user groups to the view permissions of a resource, you cannot create view permissions for any of its child or parent resources.You can recognize inherited view permissions by their gray background.A user with the System Administration global permission, for example via the Sysadmin global role can see all views in Collibra, even if they are not shared.A user with the Manage all views permission can see only views that are shared.Impact of view permissions on responsibilitiesView permissions affect responsibilities. If a user has a responsibility for a certain resource, but does not have view permission, that user cannot act upon that responsibility. The responsibility becomes inactive, due to the lacking view permission.To activate the responsibility, you have to create the view permission for this resource or a parent resource.In the example below, Luke O'Reilly is the Owner of the SCPM Glossary domain, but he does not have the view permission to see the domain. As a consequence, he cannot see the assets or act on his responsibility. On the Responsibilities page, his responsibility shows an error message to clearly show that there is a problem. You can solve the problem in one of the following ways:Create a view permission for Luke.Add Luke to the user group that has a view permission.Delete all view permissions, so that everyone can see the assets.Delete Luke's responsibility as Owner and pick another person for that role.Create a view permissionYou can create a view permission if you don't want all users to see certain resources.PrerequisitesYou have a resource role with the Edit View Permissions resource permission, for example Community Manager.None of the parent communities or children of the current resource have a view permission.StepsOpen a community or domain page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.Above the table, to the right, click Add.The Add view permissions dialog box appears.In the Users or Groups field, start typing the name of the user or user group.Select a user or user group from the suggestions.Click Add.Delete a view permissionYou can delete a view permission if you want to change which users are allowed to see certain resources.PrerequisitesYou have a resource role with the Edit View Permissions resource permission, for example Community Manager.One or more users or user groups have a view permission on the resource.StepsOpen a community or domain page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.In the View Permissions section, click next to the name of the user or group that you want to remove.A confirmation message appears.Click Delete.One view permission is deleted, so only the remaining users or user groups can see this resource and its children.If you deleted the last view permission, all users can now see this resource and its children.Asset data qualityThe Quality page of an asset makes data quality results of an asset available to the business stakeholders. The dashboard aggregates the following values:Collected over time on attributes.Aggregated from different assets along a number of predefined relations.The assets for which these data quality dashboards are available and how the values are aggregated are defined in data quality rules, which can be edited on the Data Quality Rule tab on the Settings page. For the following examples, a data quality rule exists on business terms, aggregating values from data quality rules related to these business terms.Asset qualityThe assets for which the quality dashboard is available have an extra option in their tab menu, namely Quality. The dashboard displays the aggregated passing fraction (quality score) for the asset in the form of ring charts.Each ring chart shows the quality score in the form of:A quality score as a percentage.A color code indicating the quality of this passing fraction:Red: 0-50%Orange: 50-85%Green: 85 - 100%An arrow indicating the trend of the score compared to the previous measurement.The first ring chart shows the general score of the asset. The ring charts next to it show subscores for a specific dimension, such as Accuracy, Conformity, Completeness and Consistency. Only values that belong to that specific dimension are then taken into account. The dimensions to use are configured in the metric group. In this example, it is the relation: Data Quality Rule is Classified By  Data Quality Dimension.Underneath the top pane, three selection boxes are available. They display an extra overview, details and history pane, respectively.To close a pane, click  in the upper-right corner of the pane.Data quality overview paneThe Overview pane shows more information about each level in the aggregation path for the selected general score or dimension. For each level, it shows the number of involved assets of a certain type and what their results are: failing (red) or passing (gray). It also shows the total number of rows, the number of failing rows (red) and the number of passing rows (gray) that resulted in the given scores.In the following example, the Conformity dimension consists of a total of 38 070 rows, 26 575 of which were failing. Two Data Quality Rules were involved, one of which was failing. And these Data Quality Rules were used by one Data Entity, which has an aggregated failing result.Asset quality details paneThe Details pane shows more information about all the assets involved in a table format.For each asset, a row with the following default columns is shown:Data Asset: The data asset signifierRows Passed: The number of passing rows, aggregated as a sum of the passing rows of the underlying assetsRows Failed: The number of failing rows, aggregated as a sum of the failing rows of the underlying assetsQuality Score: The score aggregated as an average of the quality scores of the underlying assetsResult (failing or passing): The aggregated result as a logical conjunction of the results of the underlying assets.Some extra columns can be displayed in this table by clicking → Columns.These include:Full name: The unique full name of the asset.Domain: The domain to which the asset belongs.Type: The type of the asset.Dimension: The dimension that applies to these assets, if any. Dimensions are used to calculate the subscores, as mentioned earlier.Asset quality historyThe History pane shows the evolution of the quality score over time, for up to one month in the past.You can display the date and the score for a specific period at the top right of the pane by hovering your pointer over that period.When you select a period by clicking on it, the top left corner of the pane shows a trend of the score compared to the period before it.Validation rulesValidation rules are special assets of the type Validation Rule. They allow you to verify whether assets meet certain criteria. They have a special attribute Validation Script, which contains a validation script that evaluates assets of the types to which the validation rule is assigned.Administrator actionsCreate a domain of the type Validation rule domain.Create a validation rule.Edit a validation rule.Delete a validation rule.Assign a validation rule to an asset type.Change the order of validation rules.Unassign a validation rule from an asset type.User actionsValidate assets.View the validation result.Revalidate an asset.Executing validation rulesYou can execute validation rules in many ways:Validate assetsDo this to manually validate assets.      Revalidate an assetDo this after editing an invalid asset.      Automatically.You can configure a workflow to start a validation on given events. For example when a asset is added or an attribute is edited.To configure triggers on certain events, see Getting started with workflows.Validation loggingCollibra Data Governance Center can write extensive log messages from the execution of validation rules. These messages are written to the dgc.log file.If the execution of a validation rule fails, analyzing the log is probably the most thorough approach.For more information on how to configure validation logging, see Logging.When contacting support regarding a problem with validation, attach the log file to the ticket.Validate assetsValidating an asset executes all validation rules assigned to the asset type. If an asset does not meet all validation rules, the asset is invalid.You can see the validation result on: An asset page’s title bar.As a column, when viewing assets in table display mode.As a field, when viewing assets in tiles display mode.As an overlay in a traceability diagram.After validation, the dgc.log file will also contain more extensive messages. For more information on how to configure validation logging, see Logging.By default, validation is not automatically triggered when an asset is edited, so you have to revalidate it after editing an asset. However, you can create a workflow for this. To configure validation on certain events, see Getting started with workflows.PrerequisitesEither of the following:You have a resource role with the Validation Execution resource permission, for example Community Manager.You have a global role that has the Manage all resources global permission.Validate an asset from the asset pageOpen an asset page.In the resource toolbar, click (validate).Validate one or more assets from an asset tableOpen a set of assets in table display mode.Select checkboxes in front of the assets you want to validate.In the action toolbar, click Validate.Validate one or more assets from a set of tilesOpen a set of assets in tile display mode.Select the assets you want to validate.In the action toolbar, click Validate.Revalidate an assetYou can revalidate assets that were previously validated to see whether they meet the validation rules that are assigned to the asset type.Validating an asset executes all validation rules that are assigned to the asset types. If an asset does not meet all validation rules, the asset is invalid.You can see the validation result:An asset page’s title bar.As a column, when viewing assets in table display mode.As a field, when viewing assets in tiles display mode.As an overlay in a diagram.You can create a workflow to automatically revalidate assets. To configure validation on certain events, see Getting started with workflows.PrerequisitesEither of the following:You have a resource role with the Validation Execution resource permission, for example Community Manager.You have a global role that has the Manage all resources global permission.Revalidate an asset from the asset pageOpen an asset.In the upper right corner, click valid or invalid.Click Revalidate. Revalidate one or more assets from an asset viewOpen an asset table.Select checkboxes in front of one or more assets.In the action toolbar, click Validate.Revalidate an asset from an asset viewOpen an asset table.If you don't see the Validation Result column, add it to the table.More info on adding columns to a table: Customizing tables.Click or .You can see the validation result of each validation rule.Click Revalidate.View the validation resultAfter validating or revalidating assets, you can view the result and make changes where necessary.View the validation result from the activities listOpen the activities list.In the table, you see the validations.In the results column, click Result.The Validation results dialog box appears.ExampleThe results column shows or to indicate whether they are respectively valid or invalid.If you want to fix invalid assets, you can open them by clicking them.View the validation result on the asset pageOpen an asset page.In the upper right corner, you see valid or invalid.View the validation result in an asset tableOpen an asset table.If you don't see the Validation Result column, add it to the table.More info on adding columns to a table: Customizing tables.Click or .You can see the validation result of each validation rule.History in CollibraCollibra Data Intelligence Cloud automatically keeps a history of users and resources such as assets, domain and communities. This history keeps track of most changes to that resource and its children, as well as who made the changes.Users can provide a definition of a business term, edit its name, move it to a new domain, and change the status. These changes are in the history of the affected assets, their parent domain, all parent communities and the history of the users themselves.You can view the history of any resource in the History tab of the resource's page, as shown in the following image.History pageThe History page provides an overview of the history of a user or a resource and its children. For examples, it contains all actions related to the following:Creating, editing and deleting resources.        In some cases, an edit is logged as a delete plus a create. For example, if you edit a Description attribute of a Data Usage complex relation, the original Description attribute is deleted, and a new Description attribute is created with the new content.Moving assets to a different domain.Adding, editing and removing characteristics.Changes to the asset status.Social features such as comments, tags and ratings.Uploading and deleting attachments.Workflows and the resulting changes.Creating, editing and deleting responsibilities.The history does not show changes to inherited responsibilities.The history does not show changes to the view permissions.In the case of the user history, adding and removing the user to or from user groups.Some actions do not change the last modification date of an asset. See here for actions that do change the last modification date and actions that don't.ColumnContent1The filter that allows you to filter the history based on the type of action, the user or a time period.2The icon that represents the type of action that was applied to the resource:: Added information.: Edited information.: Deleted information. : Multiple changes in one go. Click the icon to expand and show the individual changes                              3The summary of the action.4The name of the affected resource.5The user who applied the action.6The date and time when the action was applied.View the history of a resourceYou can view the change history of an asset, domain or community.StepsOpen an asset page.    In the tab pane, click   History.The history is shown in a table.By default, the filter only shows the 10 latest changes in the last month.If required, do one of the following:Click Load More below the table to load more history items.Edit the filter criteria above the table to see only specific history items.CriterionDescriptionActionChoose one of the actions:AddEditDeleteThe effect of this filter criterion depends on the resource:For assets, this includes action that affect an attribute. For domains, this includes actions affecting the domain itself, but also actions affecting assets in the domain.For communities, this includes actions affecting the community itself, but also actions affecting assets, domains and subcommunities of the community.WhoChoose a user whose actions you want to see.fromChoose the start date of the period of which you want to see the actions.The default value of this criterion is one month before the current date.toChoose the end date of the period of which you want to see the actions.The default value of this criterion is the current date.Remove the Action or Who filter criteria by deleting the value in the filter box using the Delete key of your keyboard.About the last modification date The last modification date shows the date of the last modification to an asset. Not all modifications to an asset will change this date. On this page, you see an overview of actions that change the last modification date and actions that don't.Actions that change the last modification dateAsset property changes:Asset (full) nameAsset display nameAsset statusMove asset to another domainExclude or include asset from auto-hyperlinkingAsset attribute changes:Add new attributeEdit attribute valueDelete an attributeOther:Articulation scoreActions that don't change the last modification dateAsset relations:Add a relation to an assetRemove a relation from an assetAsset responsibilities:Grant a new role to a user or user groupRemove a user or user groupCollaborative actions:Add or remove tagsAdd or remove ratingsStart workflowsTask completionAdd, edit or remove commentsOther:Add attachmentTake diagram pictureValidation resultReferences tab of an asset pageThe References tab of an asset page shows a table with assets that have at least one string attribute or comment containing the name of the asset that you have currently opened.By default, the table shows the Asset, Reference Type, and Reference Value columns. You can, however, add more columns.The following table describes the available columns.ColumnDescriptionAssetThe full name of the asset that references the opened asset.Reference TypeThe type of the attribute that references the opened asset.Reference ValueThe text of the attribute that references the opened asset.StatusThe status of the asset that references the opened asset.TypeThe type of the asset that references the opened asset.Asset recommenderThe asset recommender suggests relevant assets based on the assets that were visited in the past. The provided recommendations can be based on the overall asset popularity across the organization or targeted for a specific user. Depending on where the recommendations are shown, they can also be categorized and filtered by asset type, domain or community. To ensure the recommendations are based on up-to-date information, the asset recommender is retrained every day. For more information, go to Asset recommender strategy.Asset recommendations are shown in Collibra for Desktop, Home page, and Data Marketplace. In the following example, the asset recommender is used to display popular data and recommended data in Data Marketplace.The asset recommender is a Cloud-only feature. The asset recommender also requires that application usage data is collected for the environment. Recommendations are not available in environments with instance names that contain one of the following strings: -qa, beta, -poc, ie-, infra-, docker, training, sandbox, or :.Recommendations in new environments will be empty or less meaningful for some time until the asset recommender collected enough user behavior data.If you just started using Collibra as a user, you won't receive any recommendations. You'll receive recommendations after using Collibra and after the daily retraining of the asset recommender.Asset recommender strategyThe asset recommender is trained on asset visit data. It roughly follows these steps:Data on asset visits, like which users visited which assets, when, and how often, is collected and processed to assign a score to all asset and visitor combinations. The score reflects the interest of a user in the asset. Asset visits in Collibra platform, Collibra for Desktop, Collibra for Mobile, and Data Marketplace are taken into account.Visits to the following instance names are not taken into account:Instance names that contain the following strings: -qa, beta, -poc, ie-, infra-, docker, training, sandbox, and :.Instance names that do not contain .collibra.comA model is trained to predict all user-asset interest scores. The model learns to generate informative recommendations for assets and users based on the collected data.Certain asset visits are filtered out when the asset recommender is retrained, for example, assets visited by only one user, assets that are only visited once, and asset visits that take less than six seconds. The data collection and model training are triggered daily to ensure that asset recommendations are based on up-to-date information. Troubleshooting asset recommenderIssue: You do not receive any recommendations where you expect them.Possible reasons:If you just started using Collibra as a user, you won't receive any recommendations. You'll receive recommendations after using Collibra and after the daily retraining of the asset recommender.You visited assets, but the visits were filtered out during retraining. In this case, the asset recommender cannot provide recommendations.It is possible that no relevant assets can be suggested because of applied asset type, community or domain filters where the recommendations are shown. For example, assets outside the Data Marketplace scope will not be recommended in the context of Data Marketplace.It is possible that no relevant assets can be suggested in the instance.
	 HomepageThe Collibra Homepage is the default page that appears when you sign in to Collibra Data Intelligence Cloud or when you click on any page in Collibra. The Homepage guides you within Collibra by showing information that is relevant to you, such as your dashboards, the most viewed assets, and the recommended assets. The Homepage also allows you to perform a search, for example, for a community, domain, or asset.The Homepage changes how you find or access your dashboards. You can access all your dashboards on the Dashboards card on the Homepage or on the Dashboards tab in the Browse pane.If you are an administrator, you can define the headings and the content shown in each section of the Homepage and thus create a Homepage that can meet user needs.In Collibra 2022.11 or newer, the Homepage is enabled by default.In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer, the Homepage is available but disabled by default.In Collibra environments upgraded from 2022.11 to a newer version, the previous status of the Homepage (enabled or disabled) is retained.For information about how to enable or disable the Homepage, go to Enable or disable the Homepage. If you are an administrator, the Edit Page button is shown on the Homepage to enable you to customize the Homepage.     Enable or disable the HomepageIn Collibra 2022.11 or newer, the Homepage is enabled by default.In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer, the Homepage is available but disabled by default.In Collibra environments upgraded from 2022.11 to a newer version, the previous status of the Homepage (enabled or disabled) is retained.Depending on your environment, follow this procedure either in the Services Configuration section of the Collibra settings or in Collibra Console. This topic contains the procedure for Collibra Console. If your Settings page has a Configuration tab, you can follow this procedure on that tab. For more information, go to the online documentation.Requirements and permissionsYou have the ADMIN or SUPER role in Collibra Console.You have the SUPER role in Collibra Console.The Frontend enabled setting is enabled.  StepsOpen the DGC service settings for editing:Open Collibra Console.Collibra Console opens with the Infrastructure page.In the tab pane, expand an environment to show its services.    In the tab pane, click   the Data Governance Center service of that environment.Click Configuration.Click Edit configuration.Go to the Homepage section.Select the required value.ValueDescription TrueEnables the Homepage. When you sign in to Collibra, the Homepage is shown. The Homepage replaces your default dashboard. False (default)Disables the Homepage. When you sign in to Collibra, your default dashboard is shown, instead of the Homepage.Click Save all.Homepage overviewThe following table describes the sections shown on the Homepage.No.DescriptionContains the title.Contains an introduction.Allows you to perform a search, directing you to the global search results page.Helps you to find content and perform your daily activities. Depending on how the Homepage is customized, this section can contain any three of the following cards:Dashboards: A list of dashboards that you can access.My Quick Links: A list of links to the pages that you can quickly access. You can add, edit, rearrange, and delete quick links.My Tasks: A list of tasks that are assigned to you.Most Viewed Assets: A list of assets that your colleagues viewed the most in the last 30 days.Recommended Assets: A list of assets that you might like based on your search history and the assets that you previously viewed.Edit the HomepageYou can customize the Homepage for the users of Collibra by providing relevant and contextual content.This topic describes how to edit the Homepage, including how to preview and publish it.When you edit the Homepage, your changes are automatically saved each time that you click outside the section where you made the changes.    Requirements and permissionsYou have a global role that has the System administration global permission.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .In the upper-right corner of the page, click Edit Page.The Homepage opens in the editor mode.If another administrator has edited or is editing the Homepage, a message indicating so is shown on the Homepage. For example, Draft saved 8 minutes ago by John. You can, however, still edit the Homepage.Edit the sections as needed. How to edit the sectionsNo.DescriptionEnter a title for the Homepage.In the first box, enter a greeting.If you want the first name of a user to be shown in the greeting, enter {Name}. For example, if you enter Hello {Name}, when a user named Jane Doe signs in, the following greeting is shown to her: Hello Jane. If the user does not have a first name, the username is shown.In the second box, enter an introduction.Add an image. How to add an image Hover your pointer over the current image, and then click Add Content. The Add Content dialog box appears.Enter the required information. Add Image by Link: The link to the image that you want to be shown. If you leave this field blank, the default Collibra Homepage image will be shown.Alt text: A meaningful description of the image. If the image fails to load, this description is shown in place of the image. The description also helps screen-reading tools to describe the image.Click Save.In the first box, enter a heading that indicates that users can perform a search, for example, What are you looking for?. In the second box, enter the text that you want to be shown in the search field to guide users, for example, Search Collibra.In the box, enter a heading that indicates that users can find content, for example, Where would you like to go?.The top subsection that is located below the box contains the selected cards, which will be shown to users. The bottom subsection contains the available cards, which you can choose to show to users. To move a card from one subsection to another, drag the card and drop it to where you want it in the subsection.While a total of five cards are available, a maximum of three cards can be shown to users.On the My Quick Links card, you can add, edit, rearrange, and delete quick links.If you want to pause editing the Homepage or want to publish the edited Homepage later, click Close Editor. This action saves all the changes that you made to the Homepage and shows the last published Homepage in the view mode.If you want to discard all the changes that you made to the Homepage, click , and then click Delete Draft. You can then continue to make new changes to the Homepage.If you want to restore the Collibra version of the Homepage, which is the original version, click Restore Collibra Version, and then click Publish.        Optional: Click Preview.A preview of the Homepage is shown.If you want to make more changes to the Homepage, click Back to Editor.To publish the Homepage, click Publish.          The edited Homepage is published to all the users.Add a quick linkYou can add up to six links to the My Quick Links card on the Homepage. The links that you add to the card are shown only to you.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .        On the My Quick Links card, click Add a Quick Link.The Add a Quick Link dialog box appears.Enter the required information.FieldDescriptionURLEnter the address of the web page that you want to be able to quickly access from the My Quick Links card.Text to DisplayEnter the text that you want to show in place of the address on the My Quick Links card.Open in New Tab If you want the web page to open in the same browser tab, clear the checkbox.If you want the web page to open in a new browser tab, select the checkbox.Click Save.The link is shown on the My Quick Links card.You can edit, rearrange, or delete the quick link.Edit a quick linkYou can edit the links on the My Quick Links card on the Homepage.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .On the My Quick Links card, click Edit.Click next to the link that you want to edit.The Edit Quick Link dialog box appears.Enter the required information.FieldDescriptionURLEnter the address of the web page that you want to be able to quickly access from the My Quick Links card.Text to DisplayEnter the text that you want to show in place of the address on the My Quick Links card.Open in New Tab If you want the web page to open in the same browser tab, clear the checkbox.If you want the web page to open in a new browser tab, select the checkbox.Click Save. On the My Quick Links card, click Save.The edited link is shown on the My Quick Links card.You can rearrange or delete the quick link.Rearrange a quick linkYou can change the position of the links on the My Quick Links card on the Homepage.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .On the My Quick Links card, click Edit.Hover your pointer over the link whose position you want to change.Drag to the position where you want the link to be shown. Click Save.The link is rearranged.Delete a quick linkYou can delete the links on the My Quick Links card on the Homepage.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .On the My Quick Links card, click Edit.Click next to the links that you want to delete.Click Save.The links are no longer shown on the My Quick Links card.Importing and exportingThe import and export functionality in Collibra Data Intelligence Cloud are useful to respectively quickly add or update content and to transfer data to an external file or system.ImportingThe import functionality allows you to create or edit data in bulk in Collibra Data Intelligence Cloud.By importing, you can create and edit communities, domains, assets, mappings or complex relations and their characteristics such as attributes, relations and tags from a view.For importing complex relations using an Excel file, see the knowledge base on the Collibra Support Portal.If you want to edit a lot of assets in one go, you can perform the so-called export/import roundtrip. First create a view that contains all the assets and characteristics that you want to edit, then export the assets from that view. You can then edit the exported file, and import the assets back into the same view. Collibra will automatically map the characteristics during the import, implementing your changes.You can also use the import functionality for integrations and synchronization with external systems. Instead of manually importing and exporting assets, you can use the Import REST API to automate the workflow. Visit the Developer Portal to learn more.For example, you can use the import functionality to do the following:Create assets in a new or existing domain.Add and edit characteristics of existing assets.Edit the display name or full name of existing assets.Move assets to a new or existing domain.Importing assets and complex relations is restricted by the file upload settings, which define the maximum file size, allowed file extensions and maximum amount of uploads and downloads per day. Contact Collibra support if you want to change the file upload settings. The default maximum file size is 512 MB.When importing a very large Excel file, you may encounter an error with the file being too large. If this is the case you will need to split the file into multiple smaller files or use CSV.Importing data from a large Excel file can consume a lot of memory. We advise you to import from CSV instead of Excel, or to limit the Excel file to only contain the data you really need.Import responsibilitiesYou can import responsibilities along with your assets. To do so, you map table headers in your import files to the applicable role in the same way as you map attributes. You will need to map your responsibilities during the import process for them to be included. If you wish to import responsibilities then you will need Asset responsibilities support setting enabled. You will also need to add the required user IDs or group IDs to the corresponding role in the file (one ID per row) and save it. If you want to ensure you have the right format for import then you can export the asset table, ensuring you add the required role column to the view first.You can find the required IDs from the relevant table, e.g. the user IDs from the Users table and the group IDs from the Groups table. These will be labeled on their respective tables as Resource ID.Difference between the old and new import processThere are a number of differences and improvements between the old (v1) and new (v2) import process. ScenarioOld (v1) import processNew (v2) import processYou don’t provide an asset type for the import.The asset type defaults to Business Asset on import.There is no default. You'll see an error message and the import is canceled.You start the import from a domain page but do not specify the domain in the import file.             The import defaults to the current domain.No default domain is assumed, and the import will be unable top proceed. This is to prevent unintentional and incorrect domain imports.Multiple relations are imported, but they do not all contain the full relation information.Any partial information is ignored and the import continues successfully.An error notifies you that there is missing information for the relations and the import is canceled.Your file contains ambiguous relations, that have no clear path to mapping. Relations with no clear match are auto-mapped to the first matching relation. Only relations that are uniquely identified get auto-mapped. If the is no unique identifier then auto-mapping will not happen and you will need to manually map the relation. You want to import responsibilities with your assets. You cannot import responsibilities. You can import responsibilities if you enable the Asset responsibilities support setting.Your file contains whitespace around the content.The content of cells is are trimmed, so the whitespace before and after the content is removed. There is no trimming of content. Import assetsYou can import assets with the import functionality. For example, this is useful if you have a list of business terms in Excel and you want to manage them in Collibra Data Intelligence Cloud. Prerequisites    You have prepared an Excel or CSV file for upload:Only the essential sheets, columns and rows remain.Numbers that have to be interpreted as text are preceded by a single quotation mark.Dates are formatted as yyyy-mm-dd.If you want to import responsibilities, Asset responsibilities support is enabled.Import using the new wizardYou can import responsibilities along with your assets.Open a view.Above the table, to the right, click → Assets.The Import dialog box appears.Drag and drop the file or click Upload a file and choose the appropriate Excel or CSV file for upload.If you chose a CSV file:Enter the required information.FieldDescriptionColumn SeparatorThe character used to delimit the columns in the CSV file.QuoteThe character before and after a string to capture the entire cell.Escape CharacterThe character that is used to use the column separator or quote character as plain text.Click Next.  Manage the mapping of the fields of the import file and your Collibra resources:The Import mapping dialog box appears and Collibra tries to map the table headers in your import file to Collibra resources, based on the names of the fields and columns.NumberFieldDescription1AutomapButton to let Collibra automatically map all table headers in the import file to Collibra resources, based on their names.2ClearButton to remove all mappings.3Mapping tableThis table enables you to map table headers in the import file to Collibra resources. Each row in the table has a background color to indicate whether the table header is mapped or not. Green: When the table header from the import file is mapped to a Collibra resource the row will be highlighted in green.Red: After clicking the warning about unmapped items these rows will be highlighted in red and moved to a separate section at the bottom of the table. Once a table header in the unmapped section has a mapping selected it will be moved to the green mapped section.  You can use the Automap button to automatically map a table header, unless you have already manually changed the mapping. If you manually change a mapping then auto-mapping will not longer override this selection. An individual mapping can be cleared by using the cross icon in the Table Headers column. If a relation type in your file matches with multiple relation types in Collibra then it will not be auto-mapped, meaning you will be required to map this relation type manually. This is to avoid any incorrect mapping. 4Table HeadersThis column contains the field name of the table headers in your file. 5Collibra ResourcesThis column shows to which Collibra resource the file field is mapped. If the field is unmapped then there is a drop down list with the available Collibraresources . For relations, a hierarchy is displayed.Click Automap to let Collibra map all previously unmapped columns automatically.If required, manually map columns to another resource.Click Next.The Import options appear.Enter the required information.SettingResultCreate new assets if they don't yet existIf assets do not exist, Collibra creates them. Collibra creates a new domain and top-level community if the following conditions are met:You mapped columns of the import file to the domain, domain type and community characteristics of the view.The columns contain a domain and/ or community name that doesn't exist yet.How do you want to handle existing assets?Choose to either:Delete existing assets and recreate them again based on the file.Update existing assets with any new values from the file.How do you want to handle existing attributes, relations and responsibilities that were mapped?Choose to either:Replace all existing values with the ones provided in the file.Only add new values.Delete existing assets from the domain that are not in the file.Collibra deletes existing assets from a domain if they are not in the import file. If an existing domain is referenced in the import file, then any assets from that domain not included in the file are also deleted. This applies to all domains defined for relations as well. Test importCollibra first simulates an import without affecting the data to give you an overview of how the actual import would affect the data. After the overview, you can proceed with the import, go back to change the options or cancel the import.Click the Test Import button. The test results appear.If everything looks okay, click Import. If it doesn't, click Back to change the mapping or import options. The import results appear.Click Close.Import using the old wizardFor the original import wizard, the max file size is restricted to 100 MB.Open a view.Above the table, to the right, click → Assets.The Import dialog box appears.Click Select File and choose the appropriate Excel or CSV file for upload.Click Next. If you chose a CSV file, do the following: Enter the required information.FieldDescriptionColumn SeparatorThe character used to delimit the columns in the CSV file.QuoteThe character before and after a string to capture the entire cell.Escape CharacterThe character that is used to use the column separator or quote character as plain text.Click Next.Manage the mapping of the columns of the import file and the view's fields.The Import mapping dialog box appears and Collibra tries to map the columns from the import file with the Collibra resources, based on the names of the columns and resources.NumberFieldDescription1View selectorThe view selector allows you to choose a view whose characteristics will appear in the list.You can also choose All characteristics to show all characteristics.2AutomapButton to let Collibra automatically map all columns from the file to Collibra resources based on their names. 3ClearButton to clear all mapped characteristics in the Import Column.4Mapping tableThis table enables you to map characteristics of the view to columns of the import file.Each row has a background color to indicate whether a characteristics is mapped or not.Dark green: The characteristic is mapped to a column in the import file.Light green: The relation is mapped partially. This means not all underlying fields are mapped.White: The characteristic is not mapped.5CharacteristicThis column contains the available characteristics. Depending on the selection in the view selector, it contains either the characteristics of the selected view, or all characteristics. For relations, a hierarchy is displayed.6Import ColumnThis column should contain fields in which you can choose columns of the import file to map to a characteristic of the view.If required, choose another view in the view selector. Choose All characteristics to show all characteristics. In most cases, this makes it easier to map all characteristics.Click Automap to let Collibra map all visible columns automatically.If required, manually map columns to another characteristic.Click Next.The Import options appear.Enter the required information.SettingResultCreate new assets and domains if non-existent.If assets or domains do not exist, Collibra creates them.Collibra creates a new domain and top-level community if the following conditions are met:You mapped columns of the import file to the domain, domain type and community characteristics of the view.The columns contain a domain and/or community name that doesn't exist yet.How do you want to handle existing assets? Replace them with the new assets. (=> delete + create)If assets exist, Collibra deletes them first and creates them again based on the import file.Update the name, properties and attributes.If assets exist, Collibra compares the attributes and updates them if necessary.How do you want to handle mapped attributes? Replace them with new attributes. (=> delete + create)If attributes exist, Collibra deletes them and creates them again based on the import file.Select this option if you want to update existing, or add new attributes, such as a definition.Create as new attributes.If attributes exist, Collibra creates another instance of the attributes based on the import file.Select this option if you do not want to edit the existing attributes, but always want to create new attributes. This could result in multiple instances of the same attributes, such as a definition.Delete existing assets from the domain that are not in the file.Collibra deletes existing assets from a domain if they are not in the import file. If an existing domain is referenced in the import file, then any assets from that domain not included in the file are also deleted. This applies to all domains defined for relations as well. Test ImportCollibra first simulates an import without affecting the data to give you an overview of how the actual import would affect the data. After the overview, you can proceed with the import, go back to change the options or cancel the import.Click the Test Import button. The test results appear.If everything looks okay, click Import. If it doesn't, close the dialog box to cancel the import or click Back to change the mapping or import options. The import results appear.Click Close.Import complex relationsYou can import complex relations with the import functionality. For example, this is useful if you want to create a lot of complex relations in one go. Prerequisites    You have prepared an Excel file for upload:Only the essential sheets, columns and rows remain.Numbers that have to be interpreted as text are preceded by a single quotation mark.Dates are formatted as yyyy-mm-dd.The related assets to connect for a single complex relation must be specified in a single cell.Your import file has the correct structure to import complex relations.Import using the new wizardOpen a view.Above the table, to the right, click → Complex Relations.The Import dialog box appears.Drag and drop the file or click Upload a file and choose the appropriate Excel file for upload.Click Next.Select the Complex Relation Type from the drop down list.   Manage the mapping of the fields of the import file and your Collibra resources:The Import mapping dialog box appears and Collibra tries to map the table headers in your import file to Collibra resources, based on the names of the fields and columns.FieldDescriptionAutomapButton to let Collibra automatically map all table headers in the import file to Collibra resources, based on their names.ClearButton to remove all mappings.Mapping tableThis table enables you to map table headers in the import file to Collibra resources. Each row in the table has a background color to indicate whether the table header is mapped or not. Green: When the table header from the import file is mapped to a Collibra resource the row will be highlighted in green.Red: After clicking the warning about unmapped items these rows will be highlighted in red and moved to a separate section at the bottom of the table. Once a table header in the unmapped section has a mapping selected it will be moved to the green mapped section.  You can use the Automap button to automatically map a table header, unless you have already manually changed the mapping. If you manually change a mapping then auto-mapping will not longer override this selection. An individual mapping can be cleared by using the cross icon in the Table Headers column. If a relation type in your file matches with multiple relation types in Collibra then it will not be auto-mapped, meaning you will be required to map this relation type manually. This is to avoid any incorrect mapping. Table HeadersThis column contains the field name of the table headers in your file. Collibra ResourcesThis column shows to which Collibra resource the file field is mapped. If the field is unmapped then there is a drop down list with the available Collibraresources . For relations, a hierarchy is displayed.Complex Relation TypeSelect the complex relation type you want to use for mapping. Click Automap to let Collibra map all previously unmapped columns automatically.If required, manually map columns to another resource.Click Next.The Import options appear.Enter the required information.SettingResultTest importCollibra first simulates an import without affecting the data to give you an overview of how the actual import would affect the data. After the overview, you can proceed with the import, go back to change the options or cancel the import.Click the Test Import button. The test results appear.If everything looks okay, click Import. If it doesn't, click Back to change the mapping or import options. The import results appear.Click Close.Import using the old wizardFor the original import wizard, the max file size is restricted to 100 MB.Open a view.Above the table, to the right, click → Complex Relations.The Import dialog box appears.Click Select File and choose the appropriate Excel file for upload.Click Next. Select the complex relation type that you want to import.Click Next.   Manage the mapping of the columns of the import file and the view's fields.The Import mapping dialog box appears and Collibra tries to map the columns from the import file with the Collibra resources, based on the names of the columns and resources.NumberFieldDescription1AutomapButton to let Collibra automatically map all columns from the file to Collibra resources based on their names. 2ClearButton to clear all mapped characteristics in the Import Column.3Mapping tableThis table enables you to map characteristics of the view to columns of the import file.Each row has a background color to indicate whether a characteristics is mapped or not.Dark green: The characteristic is mapped to a column in the import file.Light green: The relation is mapped partially. This means not all underlying fields are mapped.White: The characteristic is not mapped.4CharacteristicThis column contains the available characteristics. Depending on the selection in the view selector, it contains either the characteristics of the selected view, or all characteristics. For relations, a hierarchy is displayed.5Import ColumnThis column should contain fields in which you can choose columns of the import file to map to a characteristic of the view.If required, choose another view in the view selector. Choose All characteristics to show all characteristics. In most cases, this makes it easier to map all characteristics.Click Automap to let Collibra map all visible columns automatically.If required, manually map columns to another characteristic.Click Next.The Import options appear.Enter the required information.SettingResultTest ImportCollibra first simulates an import without affecting the data to give you an overview of how the actual import would affect the data. After the overview, you can proceed with the import, go back to change the options or cancel the import.Click the Test Import button. The test results appear.If everything looks okay, click Import. If it doesn't, close the dialog box to cancel the import or click Back to change the mapping or import options. The import results appear.Click Close.Import file structure of a complex relation You can define multiple relations with the same role. The different assets to relate to are formatted as a comma-separated list in a single cell. This means that:       For every role in the complex relation type, you have to specify the Asset column. Fill in a comma-separated list of the asset names to connect to the complex relation with that role. If there is an asset in the import file that does not exist, it is created automatically.  If an asset name contains a comma, you can use double quotes around the asset names to ignore the comma as a separator.   For example, to refer to an asset named last name, first name, the name has to be written as last name, first name.   If your asset names have commas as well as double quotes, you can change the standard behavior of the double quote by using a backslash (\).   For example, to refer to an asset called last name , first name, the name has to be written as last name \,\ first name.  If you specify the domain names for mapped assets, you also have to use a comma-separated list in the Domain column, even if the domain is the same for all the assets. If you have to specify the domain and community for the relation assets as well, it is important that the size and order of the comma-separated lists for all three aspects (asset name, domain, community) is the same. If the referred assets are not all in the current domain, you can specify one or more domains to search in, by mapping the Domain characteristic to a column containing a comma-separated list of domain names. If there is a domain in the import file that does not exist, it is created automatically.    If the referred domains are not all in the current community, you can specify one or more communities to search in, by mapping the Community characteristic to a column containing a comma-separated list of community names.     ExportingThe export functionality makes it easy to transfer data from Collibra to an external file or system.You can export assets or complex relations to a CSV or XLSX file. The exported file is very similar to the data you view in the table on the screen.All relevant properties of a table are taken into account in an export:Filters: Determine which assets are exported.Columns: Determine which information about assets is exported.Sorting: Determine the order in which the assets are exported.Export assetsYou can export assets from a view. For example, this is useful if you want to create an overview in Excel.StepsNavigate to the asset table that you want to export.Example: Business GlossaryAbove the table, to the right, click > Assets.The Export dialog box appears.Enter the required information.FieldDescriptionViewChoose the view that you want to export.By default, your current view is filled in as view to export.Add the characteristic needed for reimport. (ID, Domain, Community, ...)Select this option if you want to reimport the export file later.By default, the export file only contains the characteristics that are displayed in the view. If you select this field, the export file will contain additional columns that are needed for the reimport.Remove text formattingSelect this option to remove any formatting of attributes in the export file.When you reimport a file with this option selected, the columns are not automatically mapped to prevent overwriting formatted text. If you manually map the columns, you lose the text formattingFile nameType the name of the export file.By default, the name of the export file is set to the name of the view.File typeChoose the file type of the export.By default, the exported file type is Excel, but you can change it to CSV.Sheet nameType the name of the sheet in the export file.This option only appears if you select Excel as the File type.Character selectorSelect the characters you want to use as the Separator, Quote and Escape. This option only appears if you select Excel as the File type.Click Export.A progress message is displayed. You can send this message to the background by closing it. When the export is finished, the export file is downloaded according to the settings of your web browser.Close the progress message.You can access the export file after finishing the export process by going to Settings → Activities and then clicking Results alongside the export action. Export complex relationsYou can export complex relations. They have to be represented differently in a table structure than assets. For that reason, the export of complex relations is handled differently.StepsNavigate to the asset table that you want to export.Example: Business GlossaryAbove the table, to the right, click > Complex Relations.The Export dialog box appears.Enter the required information.FieldDescriptionComplex Relation TypeChoose the type of the complex relations that you want to export.Add the characteristic needed for reimport. (ID, Domain, Community, ...)Select this option if you want to reimport the export file later.By default, the export file only contains the characteristics that are displayed in the view. If you select this field, the export file will contain additional columns that are needed for the reimport.Remove text formattingSelect this option to remove any formatting of attributes in the export file.When you reimport a file with this option selected, the columns are not automatically mapped to prevent overwriting formatted text. If you manually map the columns, you lose the text formattingFile nameType the name of the export file.By default, the name of the export file is set to the name of the view.File typeChoose the file type of the export.By default, the exported file type is Excel, but you can change it to CSV.Sheet nameType the name of the sheet in the export file.This option only appears if you select Excel as the File type.Character selectorSelect the characters you want to use as the Separator, Quote and Escape. This option only appears if you select Excel as the File type.Click Export.A progress message is displayed. You can send this message to the background by closing it. When the export is finished, the export file is downloaded according to the settings of your web browser.Close the progress message.You can access the export file after finishing the export process by going to Settings → Activities and then clicking Results alongside the export action. Export dialog box for complex relationsFieldDescriptionComplex Relation TypeThe complex relation type that you want to export.Add the characteristic needed for reimport. (ID, Domain, Community, ...)By default, the export file only contains the characteristics that are displayed in the view. By selecting this check box, you can add a column for ID characteristics. These characteristics help to identify specific resources during an import.Remove text formatting.By default, the export file contains the raw content of text attributes, including text markup. By selecting this check box, you can remove most of the text formatting from exported attributes. If you choose to remove text formatting, it is better not to import the unformatted text. To prevent the overwriting of formatted text, Collibra ensures that the column names are not automatically mapped while you are importing a file that was exported without text formatting.File nameBy default, the name of the export file is set to the name of the view. You can give the file any name you like, however.File typeBy default, the exported file type is .xls, but you can change it to .csv if you prefer.Sheet nameName of one of the sheets in an Excel or CSV file.Update complex relations in bulkIf you want to make changes to multiple complex relations of the same type at once, follow these steps:Export complex relations.In the exported file, make the necessary changes.Do not change the ID values.Save and close the file.Import the complex relations.In the mapping step, also map the ID field to the Business Term Mapping - id column in your exported file.DiagramsDiagrams allow you to show and interact with many assets and relations in an easy-to-read way. A diagram helps you to quickly see to which other assets a specific asset is related. Two assets are related if you can navigate from one to the other by traversing one or more relations.You can find a diagram in the tab pane of every asset page. You can work with diagrams in the diagram editor, to determine how a diagram is shown. Collibra Data Intelligence Cloud comes with several packaged diagram views for common use cases. You can also create and share your own diagram views.For complete information on diagrams, see the Documentation Center.The image below shows a diagram with assets, relations and complex relations.In this chapterDiagram and diagram view terminologyTo work with diagrams and diagram views, you have to understand the following concepts.ConceptDescriptionDiagramThe diagram that results from applying a diagram view to a given asset. It sometimes also called result diagram.Diagram viewA kind of query that determines which nodes and edges have to be shown in a diagram for a given asset. The diagram view also determines how the nodes and edges are shown.You can define multiple diagram views for the same asset type. LoopA diagram view that contains a path that revisits the same node. For example, [Business Asset] groups [Business Asset], or [Data Element] sources [Field Mapping], [Field Mapping] targets [Data Element]. A diagram view with a loop can lead to a diagram that has very long paths. NodeIn a diagram, a node is an asset or a complex relation.  The node for an asset is depicted by a rectangle.  The node for a complex relation is depicted by a circle or a rectangle with rounded corners.Boxed nodeA node that is contained inside a boxing node. For example, a Column asset can be boxed by a Table asset.Boxing nodeA node that contains one or more boxed nodes. If it is expanded, you can see the boxed nodes. If it is collapsed, you cannot see the boxed nodes. For example, a Table asset can box multiple Column assets.Locked nodeA collapsed boxing node that cannot be expanded.Incoming relationAn incoming relation of a node is when the selected node is the tail side of the relation type, in other words, an edge for which this node is the 'to' node.For example, the relation [Business Term] has code / is code for [Code Value] is incoming for a Code Value.Outgoing relationAn outgoing relation of a node is when the selected node is the head side of the relation type, in other words, an edge for which this node is the 'from' node. For example, the relation [Business Term] has code / is code for [Code Value] is outgoing for a Business Term.EdgeIn a diagram, an edge is a directed relation between two nodes. The word 'directed' indicates that the direction in which the relation is used is relevant for the diagram.An edge is normally depicted by an arrow between two nodes. The arrow points to the 'to' node. It can also be represented by means of boxing and boxed nodes, in which one node contains the other.FlowThe entire course of nodes and edges from the start node to the end node.ContextA collection of nodes that does not belong in the flow. The nodes have an incoming edge from a flow node. For example, nodes that represent a System asset can be context nodes.OverlayAn overlay is a characteristic of a node that is shown in the diagram. Overlays are added in a diagram view and can be shown or hidden via the diagram toolbar.Traversal strategyThe logic that describes which relations and assets are included in the diagram.Nodes and edgesNodes and edges are the fundamental building blocks of diagrams and diagram views:In diagrams, nodes are rectangles or circles that represent, respectively, assets or complex relations. Edges represent relations between assets or between assets and complex relations.In diagram views, nodes are rectangles or circles that represent, respectively, asset types or complex relation types. Edges represent relation types between asset types or between asset types and complex relation types. Both nodes and edges can be represented in different ways in diagrams and diagram views.Relations connect assets, or assets and complex relations. In diagrams, this is represented by edges that connect nodes. Each node can have incoming and outgoing edges:An edge of a node is incoming if that node is the 'to' node of the edge. This depends on the relation type and the direction of the edge:The node is the tail side of the relation type, and the edge has the role direction.The node is the head side of the relation type, and the edge has the co-role direction.An edge of a node is outgoing if that node is the 'from' node of the edge. This depends on the relation type and the direction of the edge:The node is the head side of the relation type, and the edge has the role direction.The node is the tail side of the relation type, and the edge has the co-role direction.      Consider the diagram below:The red node represents a Tableau Data Source asset.The blue node represents a Tableau Workbook asset.The arrow edge between the nodes represents a relation of the type Tableau Data Source is source of / is source for Tableau Workbook.The edge is outgoing for the Tableau Data Source node.The edge is incoming for the Tableau Workbook node.Node and edge stylesEdges represent relations, which in turn describe a link between assets. To represent the meaning of those links in a diagram, edges can be represented in different ways. Depending on the meaning of the relation, you can choose which edge style suits best.Arrow: The most basic way to represent an edge is by means of an arrow. This representation is ideal for visualizing flows and causal relations.Boxed and boxing: Many relation types are used to describe a part-whole relation, such as Tableau Project groups / is grouped by Report. For that reason, you can also represent the relation between those assets as boxing nodes and boxed nodes.A node that has an outgoing edge of the boxing style, becomes a boxing node. For the boxed node, the same edge is an incoming edge of the boxed style. Additionally, one boxing node could contain several boxed nodes, which have edges of their own.Boxing nodes can be expanded or collapsed:An expanded boxing node shows its boxed nodes.You can collapse them by clicking in the upper right corner of the node.A collapsed boxing node does not show its boxed nodes. As a consequence, if the hidden boxed nodes have arrow edges to nodes that are not contained by the boxing nodes, the diagram shows them as arrow edges of the boxing node.You can expand them by clicking in the upper right corner of the node.A locked node is a collapsed node that cannot be expanded.You can recognize locked boxing nodes by the in the upper right corner. You can still explore the nodes to see the edges.Duplicate nodesIn some cases, the same asset might be represented by more than one node. In other words, there are two nodes representing the same asset, on the same diagram. This can be caused by several of reasons, but the most common reason is that an asset matches more than one node of the diagram view.A node in a diagram view represents an asset type or a complex relation type. In the result diagram, this node represents an asset of that asset type or an asset of a child asset type. As a result, if a diagram view contains a node for an asset type and a node for its child asset types, the result diagram may contain an asset of the child asset type that matches both nodes of the diagram view. Therefore, the asset node is duplicated.Suppose the following situation;The Business Process asset type has two child asset types: Business Phase and Milestone.You have the following assets:Business Process asset: Define StrategyBusiness Phase asset: PlanMilestone asset: Validate StrategyYour assets have the following relations:Plan Business Phase has subprocess Define Strategy Business ProcessPlan Business Phase has Milestone: Validate Strategy MilestoneDefine Strategy Business Process Next: Validate Strategy Milestone The diagram view configuration is the following:The Business Process node has a boxing edge: Business Process has subprocess Business Phase.The Business Phase node has two boxing edges:Business Phase has subprocess Business Process 2Business Phase has MilestoneBusiness Process 2 node has an arrow edge: Business Process 2 Next Business Process 2.This leads to the following diagram view:Because the Business Process asset type has two child asset types that are also on the diagram view, the result diagram can have duplicate nodes. In the example below, the Validate Strategy asset, of the Milestone asset type, is represented by two separate nodes.Because Milestone is a child asset type of Business Process, Milestone assets can match both Milestone nodes and Business Process nodes. Furthermore, the Validate Strategy Milestone asset has two separate incoming edges: The Plan Business Phase has Validate Strategy Milestone, with the boxing style.The Define Strategy Business Phase asset Next Validate Strategy, with the arrow style.Therefore, the Validate Release Strategy Milestone node is duplicated:Diagram layoutsDiagram layouts determine the location of nodes and edges in a diagram, but do not change which nodes and edges are shown. You can select a diagram layout in the diagram toolbar.Diagram layoutDescriptionFlow / ContextNodes and edges are shown in a flow and a context region. In the flow region, nodes are shown mostly from left to right.The context region is shown above the flow region. The edges that begin or end with a node in the context region are shown with less emphasis (thinner and light gray). You can choose which nodes are in the context region by selecting the Context checkbox in the node properties form.If there are no nodes in the context region, this layout produces the same result as Hierarchy left -> right.For an edge between a flow node and a context node, the 'from' node must be in the flow region and the 'to' node in the context region.Hierarchy left - rightNodes and edges are shown in a flow, predominantly from left to right. This is the default layout.Hierarchy top - downNodes and edges are shown in a flow, from top to bottom.Hierarchy bottom - upNodes and edges are shown in a flow, from bottom to top.CircularNodes and edges are arranged in a circular fashion.Boxing nodes are not supported in this layout, therefore:The diagram is completely redrawn.The explored nodes are removed from the diagram.The nodes expand or collapse to their initial state.Returning to a layout that supports boxing nodes completely redraws the diagram.RadialNodes and edges are shown in a radial fashion, with no overlaps, few edge crossings and few bends.Boxing nodes are not supported in this layout. This has the same consequences as described for the Circular layout.Smart OrganicNodes and edges are distributed in a well-balanced manner, with few edge crossings.Traversal strategies A traversal strategy determines which nodes and edges are traversed and displayed in a diagram. The diagram view determines the initial traversal strategy, but you can select another one in the diagram toolbar.Traversal strategyDescriptionEnd-to-endFor the start node, Collibra Data Intelligence Cloud traverses the relations of the types that occur in the diagram in all directions, incoming and outgoing, and adds all the nodes and edges that it encounters to the diagram. For each encountered node, Collibra traverses the relations only in the same direction as that in which they were encountered. If a node was encountered while traversing an outgoing relation, Collibra looks for outgoing relations of that node and vice versa. This behavior is like traversing a hierarchy.This is the default traversal strategy.UpstreamFor the start node, only the incoming edges are traversed and shown.For each node encountered, only the incoming edges are traversed.DownstreamFor the start node, only the outgoing edges are traversed and shown.For each node encountered, only the outgoing edges are traversed.CompleteFor the start node, the relations are traversed in both directions. All encountered nodes and edges are added to the diagram.For each encountered node, both incoming and outgoing edges are traversed. Essentially, this means that each encountered node is treated as a start node.This strategy can result in a very large diagram that can take a long time to load.Diagram editorThe diagram editor allows you to view and edit diagrams.NoNameDescription1View titleThe name and description of the current diagram view.You can select a different view from a list of pinned and applicable views for an asset of this type. You can open the list of views when you click the view name and then Show all. 2Diagram toolbarThe toolbar to work with the diagram.3View bar menuThe buttons to manage the diagram view.4The button to create a new diagram view, starting from the selected node.5The button to edit the current diagram view.6The button to edit the name and description of the current diagram view.7The button to save the diagram view as a new view.8The button to share the diagram view. 9The button to delete the diagram view.10DiagramThis is the actual depiction of the traceability of the current asset, according to the selected diagram view.11Overview ()The box to zoom and navigate a diagram that is too large to fit the screen.You can move it to anywhere in the diagram.12LegendThe legend explains the color codes and symbols of the items in the diagram. You can move it to anywhere in the diagram. For each asset type and complex relation type that is visible on the diagram, the legend shows the color and symbol, followed by the name of the type. If all occurrences of a given type are boxed inside collapsed boxing nodes, that type is not visible and therefore, not shown in the legend. Click a row in the legend to select all occurrences of that type in the diagram. You can use this to expand or collapse all nodes of the same type.13Preview panelThe preview panel with information about the selected node.Diagram toolbarThe toolbar of the diagram editor helps you to edit settings that apply to the entire diagram.ButtonNameDescriptionLayoutSelect a layout. The layout determines the location of nodes and edges, but does not change which nodes and edges are shown. Traversal strategySelect a traversal strategy to change which nodes and edges are shown in the diagram. Flow depthSpecify the flow depth, meaning the flow relation path length from the start flow node set to any other flow node.            Business qualifier          Filter a diagram to contain only assets that are qualified by a chosen business qualifier.Zoom inZoom in on the diagram.Zoom outZoom out of the diagram.Zoom to readable valueZoom the diagram to a size that is readable.Shrink to fitZoom the diagram to a size that fits the screen.OverviewShow or hide the overview inset that enables you to zoom and navigate.LabelsShow or hide the labels of the edges and complex relations.OverlaysShow or hide overlays for all nodes in the diagram.If the view does not have any defined overlays, the button is grayed out. ExportExport the diagram as a PDF or SVG file  to your default downloads folder.RedrawDiscard all the changes that you made to the diagram and restore it to the initial state.LegendShow or hide the legend panel containing the explanation of the nodes. The legend explains the color codes and symbols of the items in the diagram. You can move it to anywhere in the diagram. For each asset type and complex relation type that is visible on the diagram, the legend shows the color and symbol, followed by the name of the type. If all occurrences of a given type are boxed inside collapsed boxing nodes, that type is not visible and therefore, not shown in the legend. Click a row in the legend to select all occurrences of that type in the diagram. You can use this to expand or collapse all nodes of the same type.PreviewShow or hide the preview panel on the right side of the screen. It contains information about the characteristics of the currently selected node (asset or complex relation).FilterEnable or disable all filters in the diagram view.If the view does not have any defined filters, the button is grayed out. PictureCreate a picture based on the diagram.FindFind a node in the diagram.FullscreenShow the current diagram in full-screen mode. The button changes to , to exit full-screen mode.The diagram preview panelThe preview panel offers a quick overview of the node that you select in the diagram. The content of the preview panel depends on the type of node that you select in the diagram:AssetsComplex relationsBreadcrumbsName of the assetAsset type code or icon, as described in Edit an asset type's representation.You can hover over the code or icon to view the asset type.StatusCreated onLast modifiedAll assigned characteristicsTagsAll assigned characteristicsLast modified by (user), with date and timeCreated by (user)To open or close the diagram preview panelOpen a diagram.On the diagram toolbar, click .Optionally, click the node that you want to preview.The preview panel appears or disappears.Working with diagramsThe diagram is a feature to show and interact with many assets and relations in an easy-to-read diagram. The diagram helps you to quickly see to which other assets a specific asset is related. Two assets are related if you can navigate from one asset to another by traversing one or more relations.Summary diagramsDepending on the diagram view, diagrams can contain a large number of nodes and edges. Opening a diagram with many nodes can take a long time. All nodes and edges are important to render the diagram correctly, but you don't always need to see every single node. Often, the diagram is only used to show the high-level outcome. Summary diagrams contain high-level nodes that are locked. Locked nodes are boxing nodes that cannot be expanded. The low-level boxed nodes and their edges are taken into account to show the edges of the locked nodes, but the diagram requires less loading time.The following example shows a summary diagram that contains two locked nodes, representing System assets. These System assets can have a lot of relations. In a regular diagram this would take a lot of time to load. However, because these nodes are locked on this summary diagram, it loads faster. Open a diagramYou can open a diagram of an asset to visualize its relations.StepsOpen an asset page.    In the tab pane, click   Diagram.The diagram appears in the default diagram view.If necessary, select a different diagram view.If a diagram exceeds the size or time limit set by your administrator, an error notification is shown. In this case, you can try to edit the diagram view to reduce the number of nodes and edges or ask your administrator to increase the diagram limits.Open another node's diagramYou can open a diagram for another node in the diagram you have currently open. This action also opens the asset page of the selected node.You can return to the initial diagram by using the back button of your browser.StepsOpen a diagram.Select a node.In the context menu, point to Start here.The available diagram views appear.Click one of the diagram views.Clicking Start here opens another node's diagram in the same diagram view.The diagram view of selected node's asset page appears.Open a business qualifier diagramYou can open a business qualifier diagram, meaning a diagram that contains only assets or complex relations that are qualified by a chosen Business Qualifier asset.PrerequisitesThe Diagrams Business Qualifier Filter is enabled in Collibra Console.A Filtering by business qualifier option (either Optional or Mandatory) is selected for at least one node in the selected diagram view.Either the start node is a Business Qualifier asset, or both of the following are true:The start node matches a view node that has a Filtering by business qualifier option (either Optional or Mandatory) selected.The start node has at least one Business Qualifier path.StepsOpen the asset page of a Business Qualifier asset.    In the tab pane, click   Diagram.The diagram appears in the default diagram view.If necessary, select a different diagram view.The diagram view must be a business qualifier view, meaning a view with at least one node for which a Filtering by business qualifier option is selected.In the Diagram toolbar, click , to enable all filters in the diagram view.In the Business Qualifier drop-down list, select the relevant Business Qualifier asset.The diagram is filtered to contain only the assets or complex relations that are qualified by the selected Business Qualifier asset.Open an asset page from a diagramYou can open an asset page while you are viewing a diagram without closing it. StepsOpen a diagram.Right-click the node of which you want to view the asset page.In the context menu, click Open in new tab. The asset page opens on the diagram page.Find node in a diagramYou can search a diagram for a specific node.StepsOpen a diagram.On the toolbar, click .The search box appears.Start typing in the search box.The counter next to the search box indicates how many matches are found.The first match is selected in the diagram.You can use the arrows to navigate between the matches.Export a diagramYou can export a diagram to a PDF or SVG file.StepsOpen a diagram. Make the necessary changes to the diagram.Select a view.Select a layout.Select a traversal strategy.Filter by business qualifier. See Work with filters in a diagram view.Adjust the flow depth.Zoom in or out.Explore nodes.Expand or collapse nodes.Trace a path between nodes.Move nodes, enable or disable labels, the legend, and so on.On the toolbar, click and select PDF or SVG.    The resulting file is automatically downloaded to your default downloads folder.The default file name is diagram.pdf or diagram.svg.Start a workflow for a node in the diagramYou can start a workflow from nodes in a diagram, if the workflow is assigned to the relevant asset type.StepsOpen a diagram.Select a node.In the context menu, point to Actions.A submenu appears with the available workflows.Click the workflow that you want to start.Workflows that have already been started are not listed.If there are no workflows available, Actions is grayed out.Edit a diagramYou can edit a diagram to represent the nodes as clearly as possible.StepsOpen a diagram. Make the necessary changes to the diagram.Select a view.Select a layout.Select a traversal strategy.Filter by business qualifier. See Work with filters in a diagram view.Adjust the flow depth.Zoom in or out.Explore nodes.Expand or collapse nodes.Trace a path between nodes.Move nodes, enable or disable labels, the legend, and so on.Select a diagram layoutYou can select a diagram layout to change the way nodes are shown in a diagram.StepsOpen a diagram.On the toolbar, click the layout box and select a layout.Diagram layoutDescriptionFlow / ContextNodes and edges are shown in a flow and a context region. In the flow region, nodes are shown mostly from left to right.The context region is shown above the flow region. The edges that begin or end with a node in the context region are shown with less emphasis (thinner and light gray). You can choose which nodes are in the context region by selecting the Context checkbox in the node properties form.If there are no nodes in the context region, this layout produces the same result as Hierarchy left -> right.For an edge between a flow node and a context node, the 'from' node must be in the flow region and the 'to' node in the context region.Hierarchy left - rightNodes and edges are shown in a flow, predominantly from left to right. This is the default layout.Hierarchy top - downNodes and edges are shown in a flow, from top to bottom.Hierarchy bottom - upNodes and edges are shown in a flow, from bottom to top.CircularNodes and edges are arranged in a circular fashion.Boxing nodes are not supported in this layout, therefore:The diagram is completely redrawn.The explored nodes are removed from the diagram.The nodes expand or collapse to their initial state.Returning to a layout that supports boxing nodes completely redraws the diagram.RadialNodes and edges are shown in a radial fashion, with no overlaps, few edge crossings and few bends.Boxing nodes are not supported in this layout. This has the same consequences as described for the Circular layout.Smart OrganicNodes and edges are distributed in a well-balanced manner, with few edge crossings.You can go back to the initial diagram by clicking . Keep in mind that all your changes are discarded if you do this.Select a traversal strategyYou can select a traversal strategy to determine which nodes and edges are traversed and displayed in a diagram. If you change the traversal strategy, the diagram is completely redrawn and explored nodes are removed.StepsOpen a diagram.On the diagram toolbar, click the traversal strategy box and select a traversal strategy.Traversal strategyDescriptionEnd-to-endFor the start node, Collibra Data Intelligence Cloud traverses the relations of the types that occur in the diagram in all directions, incoming and outgoing, and adds all the nodes and edges that it encounters to the diagram. For each encountered node, Collibra traverses the relations only in the same direction as that in which they were encountered. If a node was encountered while traversing an outgoing relation, Collibra looks for outgoing relations of that node and vice versa. This behavior is like traversing a hierarchy.This is the default traversal strategy.UpstreamFor the start node, only the incoming edges are traversed and shown.For each node encountered, only the incoming edges are traversed.DownstreamFor the start node, only the outgoing edges are traversed and shown.For each node encountered, only the outgoing edges are traversed.CompleteFor the start node, the relations are traversed in both directions. All encountered nodes and edges are added to the diagram.For each encountered node, both incoming and outgoing edges are traversed. Essentially, this means that each encountered node is treated as a start node.This strategy can result in a very large diagram that can take a long time to load.Adjust the flow depth in a diagramTo help you control the size of business diagrams, you can adjust the flow depth, the flow relation path length from the start flow node set to any other flow node.You can also:Contact Collibra support to edit system-wide maximum flow depth.Specify the maximum flow depth in a diagram view.For complete information on related terminology and functionality, see Maximum flow depth.StepsOpen a diagram view.        In the Flow depth field of the diagram toolbar, enter a value between 0 and 99.Click Save.Working with the diagram overview insetThe overview inset of the diagram editor allows you to keep an overview of the complete diagram, while the main screen is showing only a section of it.StepsOpen a diagram.On the toolbar, click the to show or hide the overview inset.The overview inset is shown over the diagram. You can still see the diagram underneath.Perform one of the following steps:ActionDescriptionsZoom in or out by scaling:                Move your mouse pointer over the lower right corner of the blue square, until it turns into a sleek slanted arrow.Click and hold, then drag the pointer to zoom in or out.Navigate in the diagram:                Move your mouse pointer over the blue square. The pointer turns into a four-way arrow.Click and hold, then drag the pointer to move the square to what you want to see.Zoom in or out in the diagram editorWhen working with diagrams, you can zoom in or out in different ways.StepsOpen a diagram.Perform one of the following steps:StrategyDescriptionZoom in or out with buttons.On the toolbar, click (Zoom in) or (Zoom out) as needed.Zoom in or out by scrolling with your mouse.Move your mouse pointer to anywhere on the diagram and use your mouse wheel to zoom. The zoom is centered at the mouse pointer.Zoom in or out by scaling.On the toolbar, click the button (Overview).An overview inset with a miniature version of the entire diagram is shown in the top right corner. The section of the diagram that is shown on the screen is visible as a blue rectangle on the overview.                              Move your mouse pointer over the lower right corner of the blue rectangle, until it turns into a sleek slanted arrow.Click and hold, then drag the pointer to zoom in or out.Zoom to readable value.On the toolbar, click .Adapt the diagram to fit in the view.On the toolbar, click .Explore nodes in a diagramFor each node in a diagram, there might be relations that are not depicted in the diagram. This is the case if the type of relation is not in the diagram view or the relation is not traversed due to the selected traversal strategy. You can still add these relations and their nodes to the diagram, by 'exploring' the node.To remove the relations that you added to a node by using the explore mode, right-click the node and click Remove explored.StepsOpen a diagram.Select a node.In the context menu, point to Explore.A submenu appears with the available relation types, and a count of how many relations exists for this type.Click one of the relation types or group of relation types:ModeDescriptionAllExplore all relation types of the selected node. Clicking Explore in the context menu has the same result.IncomingExplore all incoming relations of the selected node.A relation is considered incoming when the selected node is the tail side of the relation type. For example, the relation [Business Term] has code / is code for [Code Value] is incoming for a Code Value.OutgoingExplore all outgoing relations of the selected node.A relation is considered outgoing when the selected node is the head side of the relation type. For example, the relation  [Business Term] has code / is code for [Code Value] is outgoing for a Business Term.Any specific relation typeExplores the relations of the selected relation type.Expand or collapse nodesIf a node has an outgoing edge with the boxing style, it becomes a boxing node. Your diagram view determines whether boxing nodes are expanded or collapsed by default. Your diagram view can also lock collapsed nodes, which means that you cannot expand the collapsed boxing node.Though you cannot expand locked nodes, you can explore them to see their boxed nodes.StepsOpen a diagram.Do one of the following:        Select a node.Select multiple nodes by holding down the select key and clicking nodes. On a macOS systemOn a Windows systemClick the first one and then hold down cmd while clicking on the next ones.Click the first one and then hold down ctrl while clicking on the next ones.In the legend, click the asset type or complex relation type that you want to expand or collapse. You have now selected all nodes of this type.Do one of the following:In the node, click or .In the context menu of a node, click Expand/Collapse selected.Trace all paths between nodes in the diagramYou can trace all paths between any number of nodes on the diagram, which means you can show the relations between the nodes. You can trace a path between nodes in the following ways:The highlight mode: Keep the whole diagram and highlight the nodes and edges on the path.The crop mode: Remove any node or edge that is not on the path.StepsOpen a diagram.Select one, two or more nodes in the diagram:On a macOS systemOn a Windows systemClick the first one and then hold down cmd while clicking on the next ones.Click the first one and then hold down ctrl while clicking on the next ones.Do one of the following:To keep the whole diagram and highlight the path, right-click one of the selected nodes and click Trace path → Highlight.To remove anything that is not part of the path between the two selected nodes, right-click one of the nodes and click Trace path → Crop.If you selected a single node, all relations are traced.If you selected multiple nodes, the path between the selected nodes is traced.If there is no path between the nodes, a message is displayed.Move a node in the diagramIf you want a node to be in a different location in the diagram, you can easily move it around. StepsOpen a diagram.Click a node and hold down your mouse button. To select multiple nodes, do the same but select multiple nodes.On a macOS systemOn a Windows systemClick the first one and then hold down cmd while clicking on the next ones.Click the first one and then hold down ctrl while clicking on the next ones.Move the node to where you want it and release the mouse button.      You cannot save the these changes, but you can create a picture or export the diagram with these changes.Diagram viewsIn this section, you can find more information about what you can do with diagram views.Create a diagram viewYou can create your own diagram views:From scratch.From an existing view.Create a diagram view from scratchOpen an asset page.    In the tab pane, click   Diagram.The diagram appears in the default diagram view.Click to add a new view.Edit the diagram view.Create a diagram view from an existing viewOpen an asset page.    In the tab pane, click   Diagram.The diagram appears in the default diagram view.If required, select another diagram view.Click .The Save view as dialog box appears.Enter the required information.FieldDescriptionName*Type a name for the diagram view.DescriptionType a description for the diagram view.Sharing optionsThis section determines who has access to this diagram view. PublicSelect to share this diagram view with all users. PrivateSelect to share this diagram view with no one. Share with specific roles, groups & usersSelect to choose with whom to share the diagram view. RolesSelect or type the roles whose users you want to give access. GroupsSelect or type the groups whose users you want to give access. UsersSelect or type the users to whom you want to give access.Promote DefaultSelect to use this diagram view as the default view when you open the diagram editor. PinSelect to pin the diagram view. Pinned diagram views appear in the view selection drop-down list.Fields marked with a * are mandatory.Edit the diagram view.Open a diagram viewYou can open a diagram view to view the diagram of an asset.StepsOpen an asset page.    In the tab pane, click   Diagram.The diagram appears in the default diagram view.If necessary, select a different diagram view.If a diagram exceeds the size or time limit set by your administrator, an error notification is shown. In this case, you can try to edit the diagram view to reduce the number of nodes and edges or ask your administrator to increase the diagram limits.If the diagram depth is limited by a specified maximum flow depth value, a notification informs you that the diagram is incomplete.It’s possible that an asset type or characteristic that is referenced in a diagram view was deleted from your Collibra environment by another user. In this case, an error message appears and the invalid asset type or characteristic is amended with the word “Invalid”, so that you can easily identify it and edit the diagram view as necessary.Select a diagram viewTo select to a different diagram view, follow these steps:Open a diagram view.Do one of the following:Select a pinned view:Click the current view name and select a view from the list of pinned views.Show me where to click.Select an unpinned view:Click the current view name and click Show all... at the bottom.Click on a view in the list of views that apply to an asset of this type.It’s possible that an asset type or characteristic that is referenced in a diagram view was deleted from your Collibra environment by another user. In this case, an error message appears and the invalid asset type or characteristic is amended with the word “Invalid”, so that you can easily identify it and edit the diagram view as necessary.Edit the name and description of a diagram viewYou can edit the name and the description of a diagram view.StepsOpen a diagram view.        Click . The Edit name and description dialog box appears.Enter the required information.FieldDescriptionNameType a name for the diagram view.The default name is the name of the diagram view and a date stamp.DescriptionType a description for the diagram view.Click Save.      Edit a diagram viewYou can edit a diagram view.StepsOpen a diagram view.Click .The General properties form appears.Edit the general properties as required.FieldDescriptionLayoutSelect the layout of your diagram view.Diagram layoutDescriptionFlow / ContextNodes and edges are shown in a flow and a context region. In the flow region, nodes are shown mostly from left to right.The context region is shown above the flow region. The edges that begin or end with a node in the context region are shown with less emphasis (thinner and light gray). You can choose which nodes are in the context region by selecting the Context checkbox in the node properties form.If there are no nodes in the context region, this layout produces the same result as Hierarchy left -> right.For an edge between a flow node and a context node, the 'from' node must be in the flow region and the 'to' node in the context region.Hierarchy left - rightNodes and edges are shown in a flow, predominantly from left to right. This is the default layout.Hierarchy top - downNodes and edges are shown in a flow, from top to bottom.Hierarchy bottom - upNodes and edges are shown in a flow, from bottom to top.CircularNodes and edges are arranged in a circular fashion.Boxing nodes are not supported in this layout, therefore:The diagrampicture is completely redrawn.The explored nodes are removed from the diagrampicture.The nodes expand or collapse to their initial state.Returning to a layout that supports boxing nodes completely redraws the diagrampicture.RadialNodes and edges are shown in a radial fashion, with no overlaps, few edge crossings and few bends.Boxing nodes are not supported in this layout. This has the same consequences as described for the Circular layout.Smart OrganicNodes and edges are distributed in a well-balanced manner, with few edge crossings.Traversal strategyIndicates which nodes and edges have to be traversed and displayed.Traversal strategyDescriptionEnd-to-endFor the start node, Collibra Data Intelligence Cloud traverses the relations of the types that occur in the diagram in all directions, incoming and outgoing, and adds all the nodes and edges that it encounters to the diagram. For each encountered node, Collibra traverses the relations only in the same direction as that in which they were encountered. If a node was encountered while traversing an outgoing relation, Collibra looks for outgoing relations of that node and vice versa. This behavior is like traversing a hierarchy.This is the default traversal strategy.UpstreamFor the start node, only the incoming edges are traversed and shown.For each node encountered, only the incoming edges are traversed.DownstreamFor the start node, only the outgoing edges are traversed and shown.For each node encountered, only the outgoing edges are traversed.CompleteFor the start node, the relations are traversed in both directions. All encountered nodes and edges are added to the diagram.For each encountered node, both incoming and outgoing edges are traversed. Essentially, this means that each encountered node is treated as a start node.This strategy can result in a very large diagram that can take a long time to load.OverviewSelect to show the overview inset in the initial diagram.LabelsSelect to show the edge and node labels in the initial diagram.LegendSelect to show the legend in the initial diagram.PreviewSelect to show the preview in the initial diagram.Max node label lengthType the maximum number of characters for node labels. If a label is longer than this value, it is truncated.Type 0 if you always want to show the entire label.The default setting is 50.Max edge label lengthType the maximum number of characters for edge labels. If a label is longer than this value, it is truncated.Type 0 if you always want to show the entire label.The default setting is 30.Select a node.The Node properties form appears.Edit the node properties as required.FieldDescriptionGeneralThis section allows you to edit the general properties of the selected node.Click it to collapse and expand this section.NameType a name for the selected node.By default, this is the name of the asset type or complex relation type. For readability, it is recommended to use the name of the asset type or complex relation type.You can refer to this node by using its ID in the from and to fields of the edge properties form.This ID must be unique in the current diagram view.TypeChoose an asset type.By default, this is the asset type of the selected node.Display nameChoose the characteristic to use as the display name of the node in the diagram.If you leave this field empty, the node shows the name of the asset or the name of the complex relation. You can also choose a characteristic, for example, attribute or relation.The drop-down displays all the characteristics that apply.You can filter the list by starting to type.OverlaysChoose fields that you want to show on the node. For example, you can show characteristics, the status or the parent domain.The drop-down displays all the fields that you can show.You can filter the list by starting to type.ContextSelect to place the node in the context region of the diagram. If not selected, the node is placed in the flow region.This influences the traversal strategy: an edge from a flow node to a context node is always included in the diagram. This edge has to be outgoing from the flow node and incoming to the context node. This means that, when you switch a node from flow to context, you have to flip any edge that is outgoing from this context node and incoming to a flow node. For more information about the traversal strategy, see Which nodes and edges are included in a diagram?.Boxing nodes optionsThe options to determine how you want to show boxed nodes by default.The start node is always visible in the diagram, even when it is boxed inside of a collapsed or locked node.ExpandedSelect to show boxing nodes and their boxed nodes.CollapsedSelect to show boxing nodes, but not their boxed nodes. In the resulting diagram, you can expand these boxing nodes.Collapsed (hide boxed nodes)Select to show boxing nodes, but not their boxed nodes. In the resulting diagram, these nodes are locked, so you cannot expand them.Diagrams with locked nodes are also called summary diagrams.The boxed nodes of a locked node are not loaded when you open the diagram. As a consequence, opening the diagram may be a lot faster if some of the boxing nodes are locked.You can still explore locked nodes to see the boxed nodes.EdgesThis section allows you to add, edit and delete the edges.Click it to collapse and expand this section.Outgoing <outgoing edges>The outgoing edges that currently exist.AddClick to add an outgoing edge. Incoming <incoming edges>The incoming edges that currently exist.AddClick to add an incoming edge. FiltersThis section allows you to work with filters.Click it to collapse and expand this section.Filtering by business qualifierEnable users to filter diagrams by a chosen Business Qualifier asset.This feature is only available if it is enabled in Collibra Console.<existing filters>The filter criteria that currently exist.Add filter criteriaClick to create a filter.Select an edge.The Edge properties form appears.Edit the edge properties as required.FieldDescriptionRelation typeSelect a relation type to define the relation type of the currently selected edge.The drop-down list shows all available directed relation types.Role directionIndicates the direction in which instances of this relation type are traversed.Selected: The edge is traversed from head to tail. The edge label is the role of the relation type.Cleared: The edge is traversed from tail to head. The edge label is the co-role of the relation type.fromSelect the node from which the edge starts. In the drop-down list of nodes, the nodes that match the current type of edge are shown first (under Matching types). Nodes that do not match the current type are shown after the matching types (under All types). It is also indicated if the node is already in the diagram (on diagram).A matching node is (a parent of) the head asset type of the current relation type (when Role direction is selected) or (a parent of) the tail asset type of the relation type (when Role direction is cleared). Selecting a node that is already in the diagram view adds this edge to that node.Selecting a node that is not yet in the diagram view adds this node to the view.toSelect the node in which the edge ends.You must select an ID from the drop-down list of nodes. The list contains nodes that match the current type of edge.A matching node is (a parent of) the tail asset type of the current relation type (when Role direction is selected) or (a parent of) the head asset type of the relation type (when Role direction is cleared). Selecting a node that is already in the diagram view adds this edge to that node.Selecting a node that is not yet in the diagram view adds this node to the view.StyleSelect the style of the edge.Arrow: An arrow from the outgoing side to the incoming side. The pointer is on the incoming side of the arrow. This is the default setting.ExampleBusiness Asset is the selected node.Boxed: The node on the outgoing side is enclosed by the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxed by Employee.Boxing: The node on the outgoing side encloses the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxing Employee.LabelType a label for the edge.If you do not specify a label, either the role or co-role name of the relation type from the operating model is used in both the diagram view and the diagram.If the Role direction check box is selected, the label is the role of the relation. If it is cleared, it uses the co-role.Click Save.The General properties formThe General properties form is used to define the overall look and feel of your diagram. This pane appears when you edit a diagram view and you have not selected a node or edge.FieldDescriptionLayoutSelect the layout of your diagram view.Diagram layoutDescriptionFlow / ContextNodes and edges are shown in a flow and a context region. In the flow region, nodes are shown mostly from left to right.The context region is shown above the flow region. The edges that begin or end with a node in the context region are shown with less emphasis (thinner and light gray). You can choose which nodes are in the context region by selecting the Context checkbox in the node properties form.If there are no nodes in the context region, this layout produces the same result as Hierarchy left -> right.For an edge between a flow node and a context node, the 'from' node must be in the flow region and the 'to' node in the context region.Hierarchy left - rightNodes and edges are shown in a flow, predominantly from left to right. This is the default layout.Hierarchy top - downNodes and edges are shown in a flow, from top to bottom.Hierarchy bottom - upNodes and edges are shown in a flow, from bottom to top.CircularNodes and edges are arranged in a circular fashion.Boxing nodes are not supported in this layout, therefore:The diagrampicture is completely redrawn.The explored nodes are removed from the diagrampicture.The nodes expand or collapse to their initial state.Returning to a layout that supports boxing nodes completely redraws the diagrampicture.RadialNodes and edges are shown in a radial fashion, with no overlaps, few edge crossings and few bends.Boxing nodes are not supported in this layout. This has the same consequences as described for the Circular layout.Smart OrganicNodes and edges are distributed in a well-balanced manner, with few edge crossings.Traversal strategyIndicates which nodes and edges have to be traversed and displayed.Traversal strategyDescriptionEnd-to-endFor the start node, Collibra Data Intelligence Cloud traverses the relations of the types that occur in the diagram in all directions, incoming and outgoing, and adds all the nodes and edges that it encounters to the diagram. For each encountered node, Collibra traverses the relations only in the same direction as that in which they were encountered. If a node was encountered while traversing an outgoing relation, Collibra looks for outgoing relations of that node and vice versa. This behavior is like traversing a hierarchy.This is the default traversal strategy.UpstreamFor the start node, only the incoming edges are traversed and shown.For each node encountered, only the incoming edges are traversed.DownstreamFor the start node, only the outgoing edges are traversed and shown.For each node encountered, only the outgoing edges are traversed.CompleteFor the start node, the relations are traversed in both directions. All encountered nodes and edges are added to the diagram.For each encountered node, both incoming and outgoing edges are traversed. Essentially, this means that each encountered node is treated as a start node.This strategy can result in a very large diagram that can take a long time to load.OverviewSelect to show the overview inset in the initial diagram.LabelsSelect to show the edge and node labels in the initial diagram.LegendSelect to show the legend in the initial diagram.PreviewSelect to show the preview in the initial diagram.Max node label lengthType the maximum number of characters for node labels. If a label is longer than this value, it is truncated.Type 0 if you always want to show the entire label.The default setting is 50.Max edge label lengthType the maximum number of characters for edge labels. If a label is longer than this value, it is truncated.Type 0 if you always want to show the entire label.The default setting is 30.The Node properties formThe Node properties form is used to define a node in the diagram view and the edges that are connected to it.This pane appears when you edit a diagram view and you have selected a node.FieldDescriptionGeneralThis section allows you to edit the general properties of the selected node.Click it to collapse and expand this section.NameType a name for the selected node.By default, this is the name of the asset type or complex relation type. For readability, it is recommended to use the name of the asset type or complex relation type.You can refer to this node by using its ID in the from and to fields of the edge properties form.This ID must be unique in the current diagram view.TypeChoose an asset type.By default, this is the asset type of the selected node.Display nameChoose the characteristic to use as the display name of the node in the diagram.If you leave this field empty, the node shows the name of the asset or the name of the complex relation. You can also choose a characteristic, for example, attribute or relation.The drop-down displays all the characteristics that apply.You can filter the list by starting to type.OverlaysChoose fields that you want to show on the node. For example, you can show characteristics, the status or the parent domain.The drop-down displays all the fields that you can show.You can filter the list by starting to type.ContextSelect to place the node in the context region of the diagram. If not selected, the node is placed in the flow region.This influences the traversal strategy: an edge from a flow node to a context node is always included in the diagram. This edge has to be outgoing from the flow node and incoming to the context node. This means that, when you switch a node from flow to context, you have to flip any edge that is outgoing from this context node and incoming to a flow node. For more information about the traversal strategy, see Which nodes and edges are included in a diagram?.Boxing nodes optionsThe options to determine how you want to show boxed nodes by default.The start node is always visible in the diagram, even when it is boxed inside of a collapsed or locked node.ExpandedSelect to show boxing nodes and their boxed nodes.CollapsedSelect to show boxing nodes, but not their boxed nodes. In the resulting diagram, you can expand these boxing nodes.Collapsed (hide boxed nodes)Select to show boxing nodes, but not their boxed nodes. In the resulting diagram, these nodes are locked, so you cannot expand them.Diagrams with locked nodes are also called summary diagrams.The boxed nodes of a locked node are not loaded when you open the diagram. As a consequence, opening the diagram may be a lot faster if some of the boxing nodes are locked.You can still explore locked nodes to see the boxed nodes.EdgesThis section allows you to add, edit and delete the edges.Click it to collapse and expand this section.Outgoing <outgoing edges>The outgoing edges that currently exist.AddClick to add an outgoing edge. Incoming <incoming edges>The incoming edges that currently exist.AddClick to add an incoming edge. FiltersThis section allows you to work with filters.Click it to collapse and expand this section.Filtering by business qualifierEnable users to filter diagrams by a chosen Business Qualifier asset.This feature is only available if it is enabled in Collibra Console.<existing filters>The filter criteria that currently exist.Add filter criteriaClick to create a filter.The Edge properties formThe Edge properties form is used to define edges in the diagram view.This pane appears when you edit a diagram view and select an edge.FieldDescriptionRelation typeSelect a relation type to define the relation type of the currently selected edge.The drop-down list shows all available directed relation types.Role directionIndicates the direction in which instances of this relation type are traversed.Selected: The edge is traversed from head to tail. The edge label is the role of the relation type.Cleared: The edge is traversed from tail to head. The edge label is the co-role of the relation type.fromSelect the node from which the edge starts. In the drop-down list of nodes, the nodes that match the current type of edge are shown first (under Matching types). Nodes that do not match the current type are shown after the matching types (under All types). It is also indicated if the node is already in the diagram (on diagram).A matching node is (a parent of) the head asset type of the current relation type (when Role direction is selected) or (a parent of) the tail asset type of the relation type (when Role direction is cleared). Selecting a node that is already in the diagram view adds this edge to that node.Selecting a node that is not yet in the diagram view adds this node to the view.toSelect the node in which the edge ends.You must select an ID from the drop-down list of nodes. The list contains nodes that match the current type of edge.A matching node is (a parent of) the tail asset type of the current relation type (when Role direction is selected) or (a parent of) the head asset type of the relation type (when Role direction is cleared). Selecting a node that is already in the diagram view adds this edge to that node.Selecting a node that is not yet in the diagram view adds this node to the view.StyleSelect the style of the edge.Arrow: An arrow from the outgoing side to the incoming side. The pointer is on the incoming side of the arrow. This is the default setting.ExampleBusiness Asset is the selected node.Boxed: The node on the outgoing side is enclosed by the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxed by Employee.Boxing: The node on the outgoing side encloses the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxing Employee.LabelType a label for the edge.If you do not specify a label, either the role or co-role name of the relation type from the operating model is used in both the diagram view and the diagram.If the Role direction check box is selected, the label is the role of the relation. If it is cleared, it uses the co-role.EdgesIn a diagram, an edge is a directed relation between two nodes. The word 'directed' indicates that the direction in which the relation is used is relevant for the diagram.An edge is normally depicted by an arrow between two nodes. The arrow points to the 'to' node. It can also be represented by means of boxing and boxed nodes, in which one node contains the other.ActionsAdd an edge to a node.Edit an edge.Remove an edge of a node.Add an edge in a diagram viewYou can add an edge to a node in a diagram view.StepsOpen a diagram view.Click .The General properties form appears.Select a node in the diagram.The Node properties form appears.In the Node properties form, go to the Edges section.Perform one of the following steps:Under Outgoing, click Add.This adds an edge starting from the selected node.Under Incoming, click Add.This adds an edge ending in the selected node.Define the edge characteristics:Edge characteristicDescriptionRelation TypeChoose a relation type from the list of applicable types.Start typing to reduce the list.Role directionChoose in which direction to traverse a relation. For example, [Business asset] groups/is grouped by [Business Asset], if you select the Role direction option, you traverse in the role direction, meaning from parent to child. If you don't select this option, you traverse in the co-role direction, meaning from child to parent.toChoose the type of node (asset or complex relation) from the list of types. The dropdown first shows node types that match the relation type, but also allows you to choose a node whose type does not match the relation type. You can select a new node, or a node that already exists on the diagram.StyleSelect the style of the edge.Arrow: An arrow from the outgoing side to the incoming side. The pointer is on the incoming side of the arrow. This is the default setting.ExampleBusiness Asset is the selected node.Boxed: The node on the outgoing side is enclosed by the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxed by Employee.Boxing: The node on the outgoing side encloses the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxing Employee.Click Add.Optionally, edit the edge.This allows you to edit the label of the edge.Above the diagram, to the right, click Save.Edit an edge in a diagram viewYou can edit an edge of a node in a diagram view.StepsOpen a diagram view.Click .The General properties form appears.Perform one of the following steps:Select an edge in the diagram.Select a node in the diagram and click next to an incoming or outgoing edge in the edge section.The Edge properties form appears.Enter the required information.FieldDescriptionRelation typeSelect a relation type to define the relation type of the currently selected edge.The drop-down list shows all available directed relation types.Role directionIndicates the direction in which instances of this relation type are traversed.Selected: The edge is traversed from head to tail. The edge label is the role of the relation type.Cleared: The edge is traversed from tail to head. The edge label is the co-role of the relation type.fromSelect the node from which the edge starts. In the drop-down list of nodes, the nodes that match the current type of edge are shown first (under Matching types). Nodes that do not match the current type are shown after the matching types (under All types). It is also indicated if the node is already in the diagram (on diagram).A matching node is (a parent of) the head asset type of the current relation type (when Role direction is selected) or (a parent of) the tail asset type of the relation type (when Role direction is cleared). Selecting a node that is already in the diagram view adds this edge to that node.Selecting a node that is not yet in the diagram view adds this node to the view.toSelect the node in which the edge ends.You must select an ID from the drop-down list of nodes. The list contains nodes that match the current type of edge.A matching node is (a parent of) the tail asset type of the current relation type (when Role direction is selected) or (a parent of) the head asset type of the relation type (when Role direction is cleared). Selecting a node that is already in the diagram view adds this edge to that node.Selecting a node that is not yet in the diagram view adds this node to the view.StyleSelect the style of the edge.Arrow: An arrow from the outgoing side to the incoming side. The pointer is on the incoming side of the arrow. This is the default setting.ExampleBusiness Asset is the selected node.Boxed: The node on the outgoing side is enclosed by the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxed by Employee.Boxing: The node on the outgoing side encloses the node on the incoming side.ExampleBusiness Asset is the selected node. It is boxing Employee.LabelType a label for the edge.If you do not specify a label, either the role or co-role name of the relation type from the operating model is used in both the diagram view and the diagram.If the Role direction check box is selected, the label is the role of the relation. If it is cleared, it uses the co-role.Above the diagram, to the right, click Save.Remove an edge in a diagram viewYou can remove an edge of a node in a diagram view.StepsOpen a diagram view.Click .The General properties form appears.Select a node in the diagram.The Node properties form appears.Perform one of the following steps:Click next to an incoming or outgoing edge in the edge section.Select an edge in the diagram and click in the upper right corner.Above the diagram, to the right, click Save.Maximum flow depthBig diagrams can have very long paths, or chains of edges. They can take a long time to build, and are canceled if they exceed specified time and size limits for fetching data.To help you control the size of diagrams, you can specify the maximum flow depth, meaning the flow relation path length from the start flow node set to any other flow node. This aims to improve readability and performance, and reduce the potential for diagrams that are too big to build.Terminology and detailsTerminologyDescriptionFlow nodeA diagram node that matches a diagram view node that is not marked as context.This means that the context checkbox is not selected and, therefore, the node is situated in the flow region of the diagram.When the start node is a flow node, the start flow node set is only the start asset.Context nodeA diagram node that matches a diagram view node that is marked as context. This means that the context checkbox is selected and, therefore, the node is situated in the context region of the diagram.When the start node is a context node, the start flow node set is all assets and complex relations that are reachable from the start node by traversing only flow-context and context-context edges.Start flow node setThe merge of all start node sets of each diagram view node that it matches.When the start node matches multiple diagram view nodes, the start flow node set is the merge of all start node sets of each view node that it matches.Flow depthThe flow relation path length from the start flow node set to any other flow node.Flow edgeAn edge for which both nodes are flow nodes.Maximum flow depth is ignored when traversing edges that are not flow edges. Flow-context edges and context-context edges are ignored in order to maximize context, which reduces diagram size and improves readability.Specifying the maximum flow depthYou do not have to enable this feature. You can, however, edit the system-wide maximum flow depth in Collibra Console. This establishes a maximum flow depth for all diagrams. The default value is 50. You can also specify the maximum flow depth at the diagram view level. If you specify a value in a diagram view, that value supersedes the system-wide value in Collibra Console.Adjusting flow depth in a diagramWe refer to a result diagram whose depth is limited by a specified maximum flow depth value as an incomplete diagram. When an incomplete diagram is opened, a notification informs you that the diagram is incomplete. You can manually adjust the flow depth in the diagram, to view nodes that are hidden at greater depths.When you open a diagram, the value shown in the diagram toolbar is the value that was set for the selected diagram view? If no value is set at the diagram view level, the value shown is the value that is set in Collibra Console.LimitationsIt bears mentioning that limiting flow depth does not prevent all diagrams from becoming too big to build. It can be that a single node has a large number of related assets, for example a Schema asset that contains 10,000 Table assets. In this case, the flow depth is only 1, but the diagram will fan out and might become too big to build.Specify maximum flow depthTo help you control the size of business diagrams, you can specify the maximum flow depth in a diagram view.There are two ways to do so:Via the diagram editorVia the JSON text editorYou can also adjust the flow depth in a result diagram.      The value that you specify in the diagram view supersedes the value in Collibra Console. The default value in the Collibra Console configuration setting is 50.Via the diagram editorOpen a diagram view.        In the View bar menu, click .The General properties form appears.In the Flow depth field, enter a value between 0 and 99.Click Save.Via the JSON text editorOpen a diagram view.        In the View bar menu, click .The General properties form appears.Click the Text tab, to switch to the diagram view text editor.Scroll down and add flowDepth: x, where x is the maximum flow depth.Click Save.For more information on working with the diagram view text editor see:                    JSON syntax: Nodes sectionTips for creating correct diagram views with the JSON text editorDetailed description of JSON syntax for diagram viewsA diagram view can be described by a file in a specific JavaScript Object Notation (JSON) format.To design diagram views in JSON text format, it is important that you know the information in this section.The examples of JSON code in the following sections are key-value pairs that you can use to create a diagram view.JSON syntax: Diagram sectionThese settings determine general display settings for the diagram.JSON syntaxDescriptionvisitStrategy: directed, directedIncoming,directedOutgoing,completeGraphIndicates which nodes and edges have to be traversed and displayed. This setting is optional. You can choose one of the following values:   directed: For the start node, Collibra traverses the relations in all directions and adds all the nodes that it finds. For the encountered nodes, Collibra traverses relations only in the same direction as how they are encountered: if a node was encountered by traversing an outgoing relation, Collibra looks for outgoing relations, and vice versa.  This behavior is similar to traversing a hierarchy.   This is the default setting.For a refinement to this strategy, see also the setting for layoutRegion. completeGraph: All nodes and edges related to the current asset are displayed, irrespective of the direction in which they were encountered.directedIncoming:For the start node, Collibra only traverses the incoming relations and adds all the nodes that it encounters. For the encountered nodes, Collibra traverses relations only in the same direction as how they are encountered: incoming relations only.directedOutgoing: For the start node, Collibra only traverses the outgoing relations and adds all the nodes that it encounters. For the encountered nodes, Collibra traverses relations only in the same direction as how they are encountered: outgoing relations only.Be careful with using completeGraph, this setting can lead to very large diagrams.resultNodeUnicityStrategy: multipleNodesPerAssetId,      singleNodePerAssetIdIndicates the number of times a node is displayed if it matches multiple nodes in the diagram view. This setting is optional. You can pick one of the following values:     multipleNodesPerAssetId: If an asset is encountered more than once for different nodes in the diagram view, it is represented by multiple nodes in the diagram, one per matching view node.This is the default setting.    singleNodePerAssetId: If an asset is encountered more than once for different nodes in the diagram view, it is represented by a single node in the diagram.                              If one asset is encountered multiple times for the same node in the diagram view, it is always displayed only once in the diagram. In that situation, there is a loop for that node.                          layout: HierarchyLeftRight,      HierarchyTopBottom, HierarchyBottomTop,     Circular,      SmartOrganic,      Radial,      Flow/ContextIndicates the layout style of the diagram. This setting is optional. You can pick one of the following values:   HierarchyLeftRight: Nodes and edges are displayed in a flow mostly from left to right. This is the default setting.   HierarchyTopBottom: Nodes and edges are displayed in a flow mostly from top to bottom.HierarchyBottomTop: Nodes and edges are displayed in a flow mostly from bottom to top.  Circular: Nodes and edges are arranged in a radial tree, where all nodes with the same number of edges to a given node are drawn in a circle.   SmartOrganic: Nodes and edges are distributed in a well-balanced manner, there are minimal edge crossings.   Radial: Nodes and edges are displayed with no overlaps, few edge crossings and few bends.   Flow/Context: Layout style for diagrams with a flow and a context region. See also layoutRegion in the nodes section.   Nodes and edges in the flow region are displayed mostly from left to right. The nodes and edges in the context region are displayed above the flow region.  An edge that begins or ends with a context node, is shown with less emphasis (thinner and in light gray) than an edge between two flow nodes.  If you specify this layout, keep in mind that for an edge between a flow node and a context node, the from node has to be in the flow region and the to node has to be in the context region.showOverview: false, true  Indicates if the overview is displayed.  This setting is optional.  You can pick one of the following values:     false: The overview is not displayed. This is the default setting.    true: The overview is displayed.showLabels: false, true  Indicates if the edge and node labels are displayed.  This setting is optional.  You can pick one of the following values:     false: The overlays are not displayed. This is the default setting.    true: The overlays are displayed.showLegend: false, true  Indicates if the diagram legend is displayed. The legend shows all asset types and complex relation types that occur in the diagram.   This setting is optional.  You can pick one of the following values:     false: The legend is not displayed.     true: The legend is displayed. This is the default setting.showPreview: false, true                Indicate if the preview pane is displayed by default. The preview pane shows information about the selected node or edge.                              This setting is optional.                              You can pick one of the following values: false: The legend is not displayed.     true: The legend is displayed. This is the default setting.showFields: false, true  Indicates if the overlays are displayed.  This setting is optional.  You can pick one of the following values:     false: The labels are not displayed.    true: The labels are displayed. This is the default setting.maxNodeLabelLength: 0, <positive integer number>Indicates the maximum length of the node labels (whether they should be truncated when they are too long). This setting is optional. You can provide 0 or a positive integer number as the value:   0: Node labels are not truncated, they are displayed in full length.  The default setting is 50. maxEdgeLabelLength: 0, <positive integer number>  Indicates the maximum length of the edge labels. Edge labels are truncated when they are longer.   This setting is optional.  You can provide 0 or a positive integer number as the value:     0: Edge labels are not truncated, they are displayed in full length.    The default value is 30. edgeBundling: false, trueIndicates whether edges of the same type are bundled to reduce clutter.This setting is optional.You can pick one of the following values:false: Edges are not bundled.true: Edges are bundled. This is the default setting.webworkersEnabled: false, trueIndicates whether the layout-related calculations can be moved to a separate DGC service thread. This is useful for larger diagrams, so that your browser does not freeze while rendering the diagram.This setting is optional.You can pick one of the following values:false: Layout-related calculations are not moved to a separate DGC thread of your processor.true: For large diagrams, layout-related calculations are moved to a separate DGC thread of your processor. This is the default setting.JSON syntax: Layout optionsThese options determine the layout of hierarchical diagrams.Flow / ContextHierarchy left - rightHierarchy top - downHierarchy bottom - uplayoutOptions: { compactGroups: false, componentArrangementPolicy: topmost, edgeBends: true, edgeBundling: true, edgeToEdgeDistance: 5, minimumLayerDistance: auto, nodeToEdgeDistance: 5, orthogonalRouting: true,  preciseNodeHeightCalculation: true,  recursiveGroupLayering: true, separateLayers: true, webWorkers: true, nodePlacer: { barycenterMode: auto, breakLongSegments: auto, groupCompactionStrategy: none, nodeCompaction: auto, straightenEdges: auto } }JSON syntax with all default valuesDescriptioncompactGroups: true // falseGroup compaction reduces the number of node layers without reversing edge directions.The resulting layering tries to keep the layer span of a boxing node at a minimum, while minimizing the overall vertical space.You can choose one of the following values: true: The diagram view uses as few node layers as possible. The layers of a diagram are also used inside a boxing node.Examplefalse: The diagram view does not try to reduce the number of node layers. This results in separate layers inside a boxing node.ExampleThis option is only applicable when recursiveGroupLayering is set to true.This option is optional. The default value is false.This option does not affect the loading time of the diagram.componentArrangementPolicy: topmost // compact Choose how to arrange boxed nodes that are not connected by the arrow edge with other nodes. This is only applicable to boxed and boxing edges.You can choose one of the following values:topmost: Vertically align the boxed nodes with their topmost boxed node inside the boxing node.Examplecompact: Put the boxed nodes in different layers to reduce the size of the boxing node. This reduces the overall diagram size.If the diagram layout is Hierarchy left - right or Flow / Context, the height of the diagram will be minimized.If the diagram layout is Hierarchy bottom - up or Hierarchy top - down, the width will be minimized.ExampleThis option is optional. The default value is topmost.This option does not affect the loading time of the diagram.edgeBends: true // false Choose whether edges can be curved and can contain bends.When this option is false, the edgeBundling and orthogonalRouting options are automatically ignored. You can choose one of the following values:true: Enables edge bends.Examplefalse: Disables edge bends, edgeBundling and orthogonalRouting.Edges without bends go in a straight line from source node to target node, and may cross other nodes. They don’t reserve space for edge labels.ExampleThis option is optional. The default value is true.     Choosing true may lead to an increased loading time of the diagram.  edgeBundling: true // falseChoose whether arrow edges can be bundled at the source or target node when they represent the same incoming or outgoing relation. Only one edge label is displayed for a bundled edge. You can choose one of the following values:true: Enable edge bundling.Examplefalse: Disable edge bundling.ExampleThis option is optional. The default value is true.    Choosing true may lead to an increased loading time of the diagram.  edgeToEdgeDistance: 5 // autoSet the minimum distance (in pixels) between two adjacent edges in one layer. This affects the horizontal distance if the diagram layout is:Hierarchy left - rightFlow / Context, but only for nodes in the flow This affects the vertical distance if the diagram layout is:Hierarchy top - downHierarchy bottom - upFlow / Context, but only for nodes in the context You can choose one of the following values:[Any positive integer value]: Use this amount of pixels.auto: Let a layouting algorithm automatically set the value.This option is optional. The default value is 5.This option does not affect the loading time of the diagram.minimumLayerDistance: 5 // autoSet the minimum distance (in pixels) between two adjacent layers. This affects the horizontal distance if the diagram layout is:Hierarchy left - rightFlow / Context, but only for nodes in the flow This affects the vertical distance if the diagram layout is:Hierarchy top - downHierarchy bottom - upFlow / Context, but only for nodes in the context You can choose one of the following values:[Any positive integer value]: Use this amount of pixels.auto: Let a layouting algorithm automatically set the value.This option is optional. The default value is auto.This option does not affect the loading time of the diagram.nodeToEdgeDistance: 5 // auto Set the minimum distance (in pixels) between an edge and an adjacent node in the same layer. This affects the horizontal distance if the diagram layout is:Hierarchy left - rightFlow / Context, but only for nodes in the flow This affects the vertical distance if the diagram layout is:Hierarchy top - downHierarchy bottom - upFlow / Context, but only for nodes in the context You can choose one of the following values:[Any positive integer value]: Use this amount of pixels.auto: Let a layouting algorithm automatically set the value.This option is optional. The default value is 5.This option does not affect the loading time of the diagram.orthogonalRouting: true // false Choose whether or not edges can be routed orthogonally.You can choose one of the following values:true: All edge segments are horizontal or vertical.Examplefalse: Edge segments can be diagonal.ExampleThis option is optional. The default value is true.This option does not affect the loading time of the diagram.preciseNodeHeightCalculation: true // falseDetermines the precision with which node heights are rendered to visually accommodate diagram text.true: Each node is correctly sized to fit its label text. For extremely large diagrams, this can result in significantly longer loading times.false: Loading times are vastly improved, but label text might not always fit in the nodes. When label text doesn't fit, the text is truncated by an ellipsis. For example: ABC_Finance_Freq....This option is optional. The default value is true.    Choosing true may lead to an increased loading time of the diagram.  recursiveGroupLayering: true // false Choose whether boxing edges are respected during layering. This option is ignored when the diagram does not contain boxing nodes. Enabling this option may change the diagram flow. Some arrow edges may go in the opposite direction. Otherwise occupying only adjacent layers by boxing nodes wouldn’t be possible in some cases. You can choose one of the following values:true: Boxing nodes are layered recursively:Boxed nodes in the same boxing node always occupy adjacent layers.Examplefalse: Group information is ignored during the layering.ExampleThis option is optional. The default value is true.    Choosing true may lead to an increased loading time of the diagram.  separateLayers: true // falseStrictly separate nodes of different layers. In other words, nodes are placed below each other. This prevents big nodes from extending into an adjacent layer.You can choose one of the following values:true: Layers are separated.Examplefalse: Layers are not separated.ExampleThis option is optional. The default value is true.This option does not affect the loading time of the diagram.webWorkers: true // false Choose whether big diagrams should be built in the background thread.You can choose one of the following values:true: Enables multi-thread support for diagram building.This makes layout processing faster and less likely to freeze the browser.false: All diagrams are built in the main thread.This option is optional. The default value is true.    Choosing false may lead to an increased loading time of the diagram.  nodeplacerUse additional options for placing the nodes. barycenterMode: true // false // autoChoose whether the diagram should be as symmetric as possible. This may result in more edge bends.You can choose one of the following values:true: The diagram is more symmetric but may have more edge bends.Examplefalse: The diagram is less symmetric but may have fewer edge bends.Exampleauto: The layouting algorithm decides whether this option is set to true or false, depending on the diagram data.  This option is optional. The default value is auto.    Choosing true may lead to an increased loading time of the diagram.   breakLongSegments: true // false // autoChoose whether the diagram should break long arrow edges in favor of a more compact layout.You can choose one of the following values:true: Long edges are broken, for a more compact diagram.Examplefalse: Long edges are not broken.Exampleauto: The layouting algorithm decides whether this option is set to true or false, depending on the diagram data.  This option is optional. The default value is auto.    Choosing true may lead to an increased loading time of the diagram.   groupCompactionStrategy: none // maximumChoose the strategy for controlling the horizontal compactness of boxing nodes.You can choose one of the following values:none: Do not use horizontal group compaction. The contents of a boxing node will occupy nearly the same horizontal positions as when not grouped at all.Examplemaximum: Make boxing nodes as narrow as possible.ExampleThis option is optional. The default value is none.                  Choosing none may lead to an increased loading time of the diagram.                 nodeCompaction: true // false // autoChoose whether to reduce the height of the diagram as much as possible. This places the nodes of a layer in a stacked style (horizontally interleaving), which reduces the width of the layer.You can choose one of the following values:true: Nodes are placed in a compact style.This may result in an increased width.Examplefalse: Nodes are not placed in a compact style.Exampleauto: The layouting algorithm decides whether this option is set to true or false, depending on the diagram data.  This option is optional. The default value is auto.This option does not affect the loading time of the diagram. straightenEdges: true // false // autoApply a post-processing step to reduce edge bends.You can choose one of the following values:true: The post-processing step is applied to reduce edge bends.ExampleThis may violate some minimum distances specified by the user and the edge distribution may no longer be uniform.false: Post-processing step is not applied.Exampleauto: The layouting algorithm decides whether this option is set to true or false, depending on the diagram data.  This option is optional. The default value is auto.    Choosing true may lead to an increased loading time of the diagram.  JSON syntax: Nodes sectionThese settings determine the display settings for nodes. You must add a node for each asset type and complex relation type that you want to include in the diagram.The JSON representation of a diagram is always automatically generated. The JSON syntax allows you to update the diagram layout. Keep in mind that it is much easier to add and edit overlays through the graphical diagram view editor. See Edit a diagram view and The Node properties form.JSON syntaxDescriptionid: Business Asset  Determines the name of the node.  This setting is mandatory.  You can type any string here, but it must be unique in this view. For readability, we recommend using the name of the asset type or complex relation type as the ID.   You can refer to this node by using its ID in the from and to key-value pairs of the edges section.type: {id: 00000000-0000-0000-0000-000000011001}Determines the resource ID of the asset type or the complex relation type. This setting is mandatory. You can have multiple nodes with the same Type in one diagram view. The value must be a valid resource ID of an asset type or complex relation type. See Find a resource ID of an asset type and Find the resource ID of a complex relation. layoutRegion: flow, context  Determine if the node is treated as a flow node or a context node. This influences the traversal strategy. An edge from a flow node to a context node is always included in the diagram.  An edge between two flow nodes FN1 and FN2 is only included in the diagram if the edge from FN1 to FN2 is traversed in the same direction as the edge that brought FN1 into the diagram.   This setting is optional.  You can choose one of the following values:  flow: The node is part of the flow. This is the default setting.   context: The node is part of the context.    When you select the Flow/Context layout for a diagram, the edges between flow nodes are rendered horizontally, mostly from left to right (the from node is to the left of the to node).    The edges from flow to context nodes are rendered vertically, from bottom to top.label: Term   Determines the name that is displayed on the node in the diagram design view. For a node that represents a complex relation type, the label is used in the diagram as well.   This setting is optional.   You can provide any string as the value. If you do not specify a label, the name of the asset type or the complex relation type is used. collapsed: false, true            Indicates if the selected node is collapsed in the initial diagram. This setting is optional.         You can choose one of the following values:            false: The selected node is a boxing node and the boxed nodes are displayed.            true: The selected node is a boxing node and the boxed nodes are hidden.          name:Defines the name that has to be displayed on the node. By default, this is the asset's name, but you can specify any characteristic. Use the same syntax as for fields.fields:Defines which characteristics are shown in the node's overlay. The order of the fields determines the order of the characteristics in the overlay.This setting is optional.You can pick one or more of the following values:name: The asset's name, as defined in the name: setting.status: The asset's status value.domain: The domain in which the asset is located.community: The lowest-level community in which the asset is located.assetType: The asset's type.When filtering a diagram by asset type, keep in mind that all subtypes are included, meaning they pass the filter along with the specified asset type.tags: Any tags that were created for the asset.                    “responsibility_<ID>: The overlay is a resource role type with the ID that you type here. The diagram shows the avatars of users and user groups that have this role for this asset.                  createdOn: The date when the asset was created.createdBy: The name of the user who created the asset.lastModifiedOn: The date and time when the asset was last modified.lastModifiedBy: The name of the user who last modified the asset.stringAttribute_<ID>: The overlay is a string attribute type with the ID that you type here. Example: stringAttribute_00000000-0000-0000-0000-000000000001dateAttribute_<ID>: The overlay is a date attribute with the ID that you type here.numericAttribute_<ID>: The overlay is a date attribute with the ID that you type here.booleanAttribute_<ID>: The overlay is a boolean attribute with the ID that you type here.singleValueListAttribute_<ID>: The overlay is a single-selection attribute with the ID that you type here.multiValueListattribute_<ID>: The overlay is a multi-selection attribute with the ID that you type here.dataQualityRule_<ID>: The overlay is the percentage score of a data quality metric group with the ID that you type here. The score overlay shows the percentage, the color (red/amber/green) and trend (up/down/flat).sourceRelation_<ID>: The overlay is a relation type where the node is a tail asset and has the ID that you type here.targetRelation_<ID>: The overlay is a relation type where the node is a head asset and has the ID that you type here.JSON syntax: Edges sectionThe edges settings determine which directed relations should be traversed, and how they should be depicted on the diagram. Each edge represents a relation type between two nodes (asset types or complex relation types) in the view.You have to ensure that the diagram view is a connected graph: each node in the diagram view is reachable from any other node.JSON syntaxDescriptionfrom: Business Asset  Indicates which node is the head asset.  This setting is mandatory.  You must fill in a node ID (id) from the nodes section.to: Table Column1   Indicates which node is the tail asset.  This setting is mandatory.  You must fill in a node ID (id) from the nodes section.type: 00000000-0000-0000-0000-000000007038Indicates the ID of the relation type. This setting is mandatory.You have to fill in the resource ID of the relevant relation type. You can copy and paste these resource IDs from the Settings UI:   Attribute type.Relation type.Complex relation type.roleDirection: true, false  Determines the direction of the edge; is it the role or co-role. This setting is mandatory.   You can pick one of the following values:   true: The edge is traversed from head to tail.    false: The edge is traversed from tail to head. style: arrow, boxed, boxing   Determines how edges are displayed.  This setting is optional.   You can pick one of the following values:  arrow: The edge is represented by an arrow. The arrow starts at the 'from' node and ends at the 'to' node. This is the default setting.    boxing: The edge is represented as a 'from' asset that boxes one or more 'to' assets. In other words, a head asset contains one or more tail assets.    boxed: The edge is represented as a 'from' asset that is boxed by a 'to' asset. In other words, a tail asset contains one or more head assets.label: Groups   Determines the name that is displayed on edges in the diagram.  This setting is optional.  If you do not specify a label, the role or co-role of the relation type from the operating model is used, in both the diagram view and the diagram.  If roleDirection is true, Collibra uses the role, if it is false, it uses the co-role. Tips for creating correct diagram views with the diagram view text editorAlthough you can create and edit diagram views via the text editor, we recommend that you use the graphical view editor when possible. However, if you want to configure advanced filter expressions for a diagram, you have to complete the configuration via the diagram view text editor.Each change that you make via the graphical view editor is reflected in the text editor and vice versa.TipsCollibra Data Intelligence Cloud checks the full syntax of your JavaScript Object Notation (JSON) as you type. If the JSON code is incorrect, Collibra detects this immediately and the Save button remains inactive.For example:If you omit the required comma between two key-value pairs, Collibra shows an error message, and highlights the offending line.If you make a typo in a value, Collibra shows an error and displays the allowed values.JSON is a case-sensitive language. This means that you must use the exact key-value pairs as they are described in this guide.The code must contain a nodes section and an edges section. The order of the sections is irrelevant. Layout to improve readability (spaces, tabs, empty lines), is irrelevant.Collibra checks if each resource ID (conceptTypeId, binaryFactTypeId, attributetypeID) that you specified, exists in the operating model. If a resource ID does not exist, it is removed from the diagram view and a warning and an error are displayed. Collibra does not save your view unless you correct the error.Collibra checks if the diagram view is a connected graph.A diagram view is a connected graph when every node can be reached from any other node by traversing the edges. If the diagram is not connected, a warning is displayed. Collibra does not save your view unless you correct the error.You can create key-value pairs with a key name that is not listed in this guide. These key-value pairs are allowed in the code but are ignored. As such, typos in the key names do not trigger Collibra to show a warning or error. You can use this to your advantage, for example, to add comments to the JSON view.Pin a diagram viewYou can pin a diagram view in the dropdown of the view selection field: While creating it.From the diagram editor.From the diagram view list.Pin a view from the diagram editorOpen a diagram view.Click .The Share view dialog box appears.Select the Pin check box.Click Save.Pin a view from the diagram view list.Open a diagram view.Click the current view name and click Show all... at the bottom.The available views appear.Click in front of the views you want to pin.Unpin a diagram viewYou can unpin a diagram view to remove it from the dropdown of the view selection field:In the diagram editor.In the diagram view list.Unpin a view in the diagram editorOpen a diagram view.Click .The Share view dialog box appears.Clear the Pin check box.Click Save.Unpin a view in the diagram view list.Open a diagram view.Click the current view name and click Show all... at the bottom.The available views appear.Click in front of the views you want to pin.Set a diagram view as defaultSetting a diagram view as default for an asset means that you indicate that this diagram view is the one to be used initially, when the users with whom you shared this diagram view display a diagram for an instance of this asset type and all its child asset types. StepsOpen a diagram view.Click .The Share view dialog box appears.Select the Default check box.Click Save.Share a diagram viewYou can share a diagram view with other users or make it private.Users with whom the diagram view is shared can only edit the diagram view if they also have the Manage and share anyone's Views, Dashboards, Search filters permission.By default, diagram views are public.StepsOpen a diagram view.Click .The Share view dialog box appears.Enter the required information.FieldDescriptionSharing optionsThis section determines who has access to this diagram view. PublicSelect to share this diagram view with all users. PrivateSelect to share this diagram view with no one. Share with specific roles, groups & usersSelect to choose with whom to share the diagram view. RolesSelect or type the roles whose users you want to give access. GroupsSelect or type the groups whose users you want to give access. UsersSelect or type the users to whom you want to give access.Promote DefaultSelect to use this diagram view as the default view when you open the diagram editor. PinSelect to pin the diagram view. Pinned diagram views appear in the view selection drop-down list.Click Save.Work with filters in a diagram viewWhen you create a diagram view, you can configure filters to only keep the nodes that you are interested in or to limit the number of nodes that are shown in a diagram.Users can enable or disable all filters in the diagram toolbar.StepsOpen a diagram view.Click .The General properties form appears.Select a node in the diagram.The Node properties form appears.In the Node properties form, go to the Filters section.Perform one of the following steps:ActionDescriptionFiltering by business qualifierCollibra versionAction2021.01Select the Filtering by business qualifier checkbox to filter a diagram to contain only the assets or complex relations that are qualified by the chosen business qualifier.2021.02 or newerIn the Filtering by business qualifier drop-down list, select one of the following settings:Mandatory: The diagram only contains assets or complex relations that match this view node and are qualified by the chosen business qualifier.Optional: The diagram includes: Assets or complex relations that match this view node and are qualified by the chosen business qualifier. Assets or complex relations that match this view node and are not qualified by any business qualifier.This feature is only available if it is enabled in Collibra Console.You can apply filtering by business qualifier to view nodes that represent asset types or complex relation types.Add a simple filterSelect a characteristic and enter one or more values. Click Add filter criteria to add more filter criteria.You can add multiple values for a characteristic. If you select multiple values, the filter clause uses the IN operator. In other words, any of the values is accepted.Example:reads Domain IN (BA Domain, Data Quality Dimensions)You cannot use wildcards in the value of a filter clause.If you use multiple filter clauses, they are always combined with the logical AND operator. In other words, all filter clauses have to be met.Configure advanced filter expressionsSee Configure an advanced filter expression in a diagram view.Edit a filterEdit the filter criteria to match your needs.Delete a filterClick to delete a filter criterion.Above the diagram, to the right, click Save.Configure an advanced filter expression in a diagram viewTo configure advanced filter expressions for diagrams, you have to complete the configuration via the diagram view JSON text editor.StepsAdd a simple filter, as described in Work with filters in a diagram view.Click the Text tab, to switch to the diagram view text editor.Find the node on which you created the simple filter and change the IN operator to one of the following operators:Operators for attributes kinds text and plain textINNOT_INCONTAINSNOT_CONTAINSSTARTS_WITHNOT_STARTS_WITHENDS_WITHNOT_ENDS_WITHThe operators EXISTS and NOT_EXISTS do not work in advanced filter expressions for diagrams.Operators for attribute kinds date and numberINNOT_INLESSLESS_OR_EQUALSGREATERGREATER_OR_EQUALSAbove the diagram, to the right, click Save.Examples and additional informationExample of a node with a filter on the Report Attribute asset typeFiltering by asset type is particularly useful for diagrams. When filtering a diagram by asset type, keep in mind that all subtypes are included, meaning they pass the filter along with the specified asset type. { layoutRegion: flow, id: Report Attribute, type: { id: 00000000-0000-0000-0000-000000031027 }, filters: [ {  operator: IN,  values: [  00000000-0000-0000-0000-000000031027  ],  field: assetType } ] },Example of a node with a filter on a data attributeYou have to provide the value in Unix Epoch datetime, in milliseconds. This example is for a custom date attribute to be greater than 2020-okt-1. { operator: GREATER, values: [ 1601483854000 ], field: dateAttribute_7ff7f6af-33d3-4fdf-8ac5-bf918606315f }For more information on configuring advanced filter expressions in the diagram view text editor, see:                    JSON syntax: Nodes sectionTips for creating correct diagram views with the JSON text editorFiltering by business qualifierFiltering by business qualifier allows you to filter a diagram to contain only assets or complex relations that are qualified by a chosen business qualifier. The difference from traditional filtering is that the filter value is not fixed in the diagram view; instead, the user can choose the business qualifier to filter by in the result diagram, without having to change the view. This is a form of dynamic filtering. We refer to such a diagram as a business qualifier diagram.Business qualifier diagrams are smaller and load faster than unqualified diagrams, and their focused qualifier makes them easier to understand. The following is true of every asset in a business qualifier diagram:Every asset matches a node in the business qualifier view.Every asset can be reached from the start asset by selecting the view and applying the normal traversal strategy. In other words, the asset would be included in an ordinary diagram.Every asset has a business qualifier path to the selected business qualifier.For descriptions of these terms, see Terminology.Enabling business qualifier diagramsTo view Business Qualifier diagrams, the feature has to be enabled in Collibra Console.If enabled in Collibra Console, the Filtering by business qualifier option is shown in the Filters section of the Node properties form, when editing a diagram view. The filter icon appears on the nodes for which the option is selected, like on any other node for which a filter is applied.      To make the feature available to users, a Filtering by business qualifier option (either Optional or Mandatory) has to be selected for at least one view node.    Key asset type and relation typesThe various business qualifiers that can qualify assets and complex relations in a business qualifier diagram are represented by Business Qualifier assets. When filtering by business qualifier, the start node can be a Business Qualifier asset, a Column asset or a complex relation.Business Qualifier assetsBusiness Qualifier assets relate to other assets by the following packaged relation type:HeadRoleCo-roleTailBusiness Qualifierqualifiesis qualified byAssetColumn assetsColumn assets relate to Business Attribute assets that are related to Business Qualifier assets. The packaged relation types are the following:HeadRoleCo-roleTailBusiness Qualifierqualifiesis qualified byData AttributeData Attributegroupsis grouped byColumnComplex relationsWhen configuring business qualifier filtering for complex relations, you need to edit the relevant complex relation type and add a relation leg pertaining to the Business Qualifier asset.TerminologyTermDescriptionBusiness qualifier viewA diagram view with at least one node for which a Filtering by business qualifier option is selected.Business qualifier diagramA diagram for which all of the following conditions are met:The selected diagram view is a business qualifier view.Filters are enabled in the diagram toolbar.Either the start node is a Business Qualifier asset, or both of the following are true:The start node matches a view node that has a Filtering by business qualifier option (either Optional or Mandatory) selected.The start node has at least one Business Qualifier path.Business qualifier pathAn asset has a business qualifier path if either of the following is true:The asset has at least one relation asset qualified by a Business Qualifier asset.The asset is a Column, and both: The Column asset is grouped by a Data Attribute asset.That Data Attribute asset is qualified by a Business Qualifier asset.Configure business qualifier filtering for a complex relationYou can configure business qualifier filtering for a complex relation.PrerequisitesTo edit a complex relation type, you need a global role that has the System administration global permission.The Diagrams Business Qualifier Filter is enabled in Collibra Console.StepsSee the following example for detailed instruction on how to carry out each step in this procedure.Edit the relevant complex relation type, for example Field Mapping. Specifically, you need to add a relation leg pertaining to the Business Qualifier asset.If not already done, create the Business Qualifier asset that you will use to filter a diagram.Specify the Business Qualifier asset in the complex relation type.Add a relation between the relevant assets.We are referring here to assets that are the head or tail of the complex relation type legs, for example Column assets and the Business Qualifier asset.            In the relevant diagram view, enable the Filtering by Business Qualifier option for both the Column asset node and the Field Mapping complex relation node.    Show me an exampleIn this example, we are working with the commonly used Field Mapping complex relation type that comes packaged with Collibra Data Intelligence Cloud. As the Field Mapping complex relation type is often used to track the flow of metadata from source column to target column, we also refer in this example to the Data Element asset type, which is a parent of the Column asset type. Lastly, the Field Mapping complex relation type is, by default, included the global role of the Data Element asset type.Start by editing the Field Mapping complex relation type. Specifically, you need to add a relation leg pertaining to a Business Qualifier asset.    On the main menu, click   , and then click   Settings.The Collibra settings page opens.In the Operating model section, click Complex relations.In the table, find the Field Mapping row and click at the end of the row.The Edit Field Mapping dialog box appears.At the bottom of the Relations section, click Add relation.Enter the required information.Role: We recommend the value is qualified by, but you can enter any text value that suits your needs.Asset type: Business Qualifier.Leave the default values for the other fields as they are.      Click Save.Let's assume that no appropriate Business Qualifier asset exists. Therefore, you need to create one.On the main toolbar, click .The Create dialog box appears.Click the Assets tab.In the list of asset types, click Business Qualifier.The Create Asset dialog box appears.Enter the required information.FieldDescriptionTypeThe asset type of the asset that you are creating. In this case, Business Qualifier.DomainThe domain to which the new assets will belong. You can only create a asset type in any domain of a domain type that is assigned to a selected asset type.NameThe name of the new Business Qualifier asset. For our example, let's use: BQ1.Click Create.A message at the top-right of your screen confirms that one or more assets are created.Specify the Business Qualifier asset in the complex relation type.Open one of the relevant leg assets. Let's choose one of the Column assets.    In the tab pane, click   Details.In the Field Mapping section, hover your pointer over any of the assets, and then click .The Edit Field Mapping dialog box appears. Notice that the is qualified by relation leg is empty.In the is qualified by field, add the Business Qualifier asset. In this example, BQ1.Click Next.If necessary, add a description of the Field Mapping complex relation.Click Finish.Now add a relation between a Column asset and the Business Qualifier asset.Open one of the relevant Column assets.    In the tab pane, click   Add Characteristic.The Add a characteristic dialog box appears.Click Relations.Search for and click is qualified by Business Qualifier.The Add is qualified by Business Qualifier dialog box appears.Enter the required information.OptionDescriptionAssetsThe name of the Business Qualifier asset. In this example, BQ1.Start dateOptionally enter the date on which the relation between the assets becomes applicable.End dateOptionally enter the date on which the relation between the assets is no longer applicable. Leave this field empty to create a permanent relation.Click Save.            In the relevant diagram view, enable the Filtering by Business Qualifier option for both the Column asset node and the Field Mapping complex relation node.            Open a relevant Column asset page.    In the tab pane, click   Diagram.The diagram appears in the default diagram view.If necessary, select a different diagram view. Click .The General properties form appears.Select a node in the diagram.The Node properties form appears.You need to carry out steps e-h for both the Column asset node and the Field Mapping complex relation node.In the Node properties form, go to the Filters section.Enable business qualifier filtering:Your Collibra versionAction2021.01Click the Filtering by business qualifier checkbox.2021.02 or newerIn the Filtering by business qualifier drop-down list, select Mandatory, so that the diagram will only contain assets matching this view node that are qualified by the chosen business qualifier.Above the diagram, to the right, click Save.In the diagram toolbar, click the Business qualifier drop-down menu and select BQ1.Delete a diagram viewYou can delete a diagram view.StepsOpen an asset page.    In the tab pane, click   Diagrams.      Select the diagram view that you want to delete.In the view bar, click .Click Delete view.PicturesA picture is a copy of a diagram that is stored separately from the original. You can edit the pictures in the same way you edit diagrams, but there are fewer options available.Pictures are an easy way to save a diagram after you configured it. You can then reuse it later.Available actionsCreate a picture.Open a picture.Edit a picture.Select a layout.Zoom in or out.Expand or collapse nodes.Trace a path between nodes.Move nodes, enable or disable labels, the legend, and so on.Export a picture.Delete a picture.Picture editorThe picture editor allows you to view and edit pictures. You can access the picture editor by opening a picture.NoNameDescription1Picture nameThe name of the picture.2Picture toolbarThe toolbar to work in the picture.3View bar menuThe buttons to edit the picture's name, share it or delete it.          4PictureThis is the actual depiction of the traceability of the current asset, according to the picture you opened.5Overview ()Zoom and navigate a picture that is too large to fit the screen.You can move it to anywhere in the diagram.6LegendThe legend explains the color codes and symbols of the items in the picture. You can move it to anywhere in the picture. For each asset type and complex relation type that is visible on the picture, the legend shows the color and symbol, followed by the name of the type. If all occurrences of a given type are boxed inside collapsed boxing nodes, that type is not visible and therefore, not shown in the legend. Click a row in the legend to select all occurrences of that type in the picture. You can use this to expand or collapse all nodes of the same type.7Preview panelThe preview panel with information about the selected node.8Time stampThe date and time on which the picture was created.Picture toolbarThe toolbar of the picture editor helps you to edit settings that apply to the entire picture.ButtonNameDescriptionLayoutSelect a layout. The layout determines the location of nodes and edges, but does not change which nodes and edges are shown. Zoom inZoom in on the picture.Zoom outZoom out from the picture.Zoom to readable valueZoom the picture to a size that is readable.Shrink to fitZoom the picture to a size that fits the screen.OverviewShow or hide the overview inset that enables you to zoom and navigate.LabelsShow or hide the labels of the edges and complex relations.OverlaysShow or hide overlays for all nodes in the picture.If the view does not have any defined overlays, the button is grayed out. ExportExport the picture as a PDF or SVG file  to your default downloads folder.RedrawDiscard all the changes that you made to the picture and restore it to the initial state.LegendShow or hide the legend panel containing the explanation of the nodes. The legend explains the color codes and symbols of the items in the picture. You can move it to anywhere in the picture. For each asset type and complex relation type that is visible on the picture, the legend shows the color and symbol, followed by the name of the type. If all occurrences of a given type are boxed inside collapsed boxing nodes, that type is not visible and therefore, not shown in the legend. Click a row in the legend to select all occurrences of that type in the picture. You can use this to expand or collapse all nodes of the same type.PreviewShow or hide the preview panel on the right side of the screen. It contains information about the characteristics of the currently selected node (asset or complex relation).PictureCreate a picture based on the picture.FindFind a node in the picture.FullscreenShow the current picture in full-screen mode. The button changes to , to exit full-screen mode.Create a pictureYou can create a picture based on a diagram.StepsOpen a diagram or a picture. Make the necessary changes.Select a layout.Zoom in or out.Expand or collapse nodes.Trace a path between nodes.Move nodes, enable or disable labels, the legend, and so on.On the toolbar, click       .The Save diagram as picture dialog box appears.Enter the required information.FieldDescriptionName*Type a name for the picture.The default name is the name of the diagram view and a date stamp.DescriptionType a description for the picture.Sharing optionsThis section determines who has access to this picture. PublicSelect to share this picture with all users. PrivateSelect to share this picture with no one. Share with specific roles, groups & usersSelect to choose with whom to share the picture. RolesSelect or type the roles whose users you want to give access. GroupsSelect or type the groups whose users you want to give access. UsersSelect or type the users to whom you want to give access.Promote PinSelect to pin the picture. Pinned pictures appear in the view selection drop-down list.Fields marked with a * are mandatory.Click Save.The resulting picture appears in the Pictures section of the tab pane.Pin a pictureYou can pin a picture in the drop-down of the view selection field while creating it.from the picture editor.Pin a view from the picture editorOpen a picture.Click .The Share picture dialog box appears.Select the Pin check box.Click Save.Unpin a pictureYou can unpin a picture to remove it from the drop-down of the view selection fieldUnpin a picture in the picture editorOpen a diagram view.Click .The Share view dialog box appears.Clear the Pin check box.Click Save.Share a pictureYou can share a picture with other users or keep it private.StepsOpen a picture.Click .The Share picture dialog box appears.Enter the required information.FieldDescriptionSharing optionsThis section determines who has access to this picture. PublicSelect to share this picture with all users. PrivateSelect to share this picture with no one. Share with specific roles, groups & usersSelect to choose with whom to share the picture. RolesSelect or type the roles whose users you want to give access. GroupsSelect or type the groups whose users you want to give access. UsersSelect or type the users to whom you want to give access.Promote PinSelect to pin the picture. Pinned pictures appear in the view selection drop-down list.Click Save.Open a pictureYou can open a picture of a diagram of an asset to visualize its relations in the picture editor.StepsOpen an asset page.    In the tab pane, click   Pictures.The picture list appears.Click a picture in the list.The picture is opened in the picture editor.What's next?You can now edit or export the picture.Find node in a pictureYou can search a picture for a specific node.StepsOpen a picture.On the toolbar, click .The search box appears.Start typing in the search box.The counter next to the search box indicates how many matches are found.The first match is selected in the picture.You can use the arrows to navigate between the matches.Edit the name and description of a pictureYou can edit the name and the description of a picture.StepsOpen a picture.        Click . The Edit name and description dialog box appears.Enter the required information.FieldDescriptionNameType a name for the picture.The default name is the name of the original diagram view and a date stamp.DescriptionType a description for the picture.Click Save.      Edit a pictureYou can edit a picture to represent the nodes as clearly as possible.StepsOpen a picture. Make the necessary changes to the picture.Select a layout.Zoom in or out.Expand or collapse nodes.Trace a path between nodes.Move nodes, enable or disable labels, the legend, and so on.Select a picture layoutYou can select a picture layout to change the way nodes are shown in a picture.StepsOpen a picture.On the toolbar, click the layout box and select a layout.Diagram layoutDescriptionFlow / ContextNodes and edges are shown in a flow and a context region. In the flow region, nodes are shown mostly from left to right.The context region is shown above the flow region. The edges that begin or end with a node in the context region are shown with less emphasis (thinner and light gray). You can choose which nodes are in the context region by selecting the Context checkbox in the node properties form.If there are no nodes in the context region, this layout produces the same result as Hierarchy left -> right.For an edge between a flow node and a context node, the 'from' node must be in the flow region and the 'to' node in the context region.Hierarchy left - rightNodes and edges are shown in a flow, predominantly from left to right. This is the default layout.Hierarchy top - downNodes and edges are shown in a flow, from top to bottom.Hierarchy bottom - upNodes and edges are shown in a flow, from bottom to top.CircularNodes and edges are arranged in a circular fashion.Boxing nodes are not supported in this layout, therefore:The picture is completely redrawn.The explored nodes are removed from the picture.The nodes expand or collapse to their initial state.Returning to a layout that supports boxing nodes completely redraws the picture.RadialNodes and edges are shown in a radial fashion, with no overlaps, few edge crossings and few bends.Boxing nodes are not supported in this layout. This has the same consequences as described for the Circular layout.Smart OrganicNodes and edges are distributed in a well-balanced manner, with few edge crossings.Picture layoutsPicture layouts determine the location of nodes and edges of a picture, but do not change which nodes and edges are displayed. You can select a picture layout in the toolbar of the picture editor.Diagram layoutDescriptionFlow / ContextNodes and edges are shown in a flow and a context region. In the flow region, nodes are shown mostly from left to right.The context region is shown above the flow region. The edges that begin or end with a node in the context region are shown with less emphasis (thinner and light gray). You can choose which nodes are in the context region by selecting the Context checkbox in the node properties form.If there are no nodes in the context region, this layout produces the same result as Hierarchy left -> right.For an edge between a flow node and a context node, the 'from' node must be in the flow region and the 'to' node in the context region.Hierarchy left - rightNodes and edges are shown in a flow, predominantly from left to right. This is the default layout.Hierarchy top - downNodes and edges are shown in a flow, from top to bottom.Hierarchy bottom - upNodes and edges are shown in a flow, from bottom to top.CircularNodes and edges are arranged in a circular fashion.Boxing nodes are not supported in this layout, therefore:The picture is completely redrawn.The explored nodes are removed from the picture.The nodes expand or collapse to their initial state.Returning to a layout that supports boxing nodes completely redraws the picture.RadialNodes and edges are shown in a radial fashion, with no overlaps, few edge crossings and few bends.Boxing nodes are not supported in this layout. This has the same consequences as described for the Circular layout.Smart OrganicNodes and edges are distributed in a well-balanced manner, with few edge crossings.Working with the picture overview insetThe overview inset of the picture editor allows you to keep an overview of the complete picture, while the main screen is showing only a section of it.StepsOpen a picture.On the toolbar, click the to show or hide the overview inset.The overview inset is shown over the picture. You can still see the picture underneath.Perform one of the following steps:ActionDescriptionsZoom in or out by scaling:                Move your mouse pointer over the lower right corner of the blue square, until it turns into a sleek slanted arrow.Click and hold, then drag the pointer to zoom in or out.Navigate in the picture:                Move your mouse pointer over the blue square. The pointer turns into a four-way arrow.Click and hold, then drag the pointer to move the square to what you want to see.Zoom in or out in the picture editorWhen working with pictures, you can zoom in or out in different ways.StepsOpen a picture.Perform one of the following steps:StrategyDescriptionZoom in or out with buttons.On the toolbar, click (Zoom in) or (Zoom out) as needed.Zoom in or out by scrolling with your mouse.Move your mouse pointer to anywhere on the picture and use your mouse wheel to zoom. The zoom is centered at the mouse pointer.Zoom in or out by scaling.On the toolbar, click the button (Overview).An overview inset with a miniature version of the entire picture is shown in the top right corner. The section of the picture that is shown on the screen is visible as a blue rectangle on the overview.                              Move your mouse pointer over the lower right corner of the blue rectangle, until it turns into a sleek slanted arrow.Click and hold, then drag the pointer to zoom in or out.Zoom to readable value.On the toolbar, click .Adapt the diagram to fit in the view.On the toolbar, click .Trace all paths between nodes in a pictureYou can trace all paths between any number of nodes on the picture, which means you can show the relations between the nodes. You can trace a path between nodes in the following ways:The highlight mode: Keep the whole picture and highlight the nodes and edges on the path.The crop mode: Remove any node or edge that is not on the path.StepsOpen a picture.Select one, two or more nodes in the picture:On a macOS systemOn a Windows systemClick the first one and then hold down cmd while clicking on the next ones.Click the first one and then hold down ctrl while clicking on the next ones.Do one of the following:To keep the whole picture and highlight the path, right-click one of the selected nodes and click Trace path → Highlight.To remove anything that is not part of the path between the two selected nodes, right-click one of the nodes and click Trace path → Crop.If you selected a single node, all relations are traced.If you selected multiple nodes, the path between the selected nodes is traced.If there is no path between the nodes, a message is displayed.Move a node in the pictureIf you want a node to be in a different location in the picture, you can easily move it around. StepsOpen a picture.Click a node and hold down your mouse button. To select multiple nodes, do the same but select multiple nodes.On a macOS systemOn a Windows systemClick the first one and then hold down cmd while clicking on the next ones.Click the first one and then hold down ctrl while clicking on the next ones.Move the node to where you want it and release the mouse button.      You cannot save the these changes, but you can create a picture or export the picture with these changes.Expand or collapse picture nodesIf a node has an outgoing edge with the boxing style, it becomes a boxing node. Your diagram view determines whether boxing nodes are expanded or collapsed by default. Your diagram view can also lock collapsed nodes, which means that you cannot expand the collapsed boxing node.StepsOpen a picture.Do one of the following:        Select a node.Select multiple nodes by holding down the select key and clicking nodes. On a macOS systemOn a Windows systemClick the first one and then hold down cmd while clicking on the next ones.Click the first one and then hold down ctrl while clicking on the next ones.In the legend, click the asset type or complex relation type that you want to expand or collapse. You have now selected all nodes of this type.Do one of the following:In the node, click or .In the context menu of a node, click Expand/Collapse selected.Export a pictureYou can export a picture to a PDF or SVG file.StepsOpen a picture. Make the necessary changes to the picture.Select a layout.Zoom in or out.Expand or collapse nodes.Trace a path between nodes.Move nodes, enable or disable labels, the legend, and so on.On the toolbar, click and select PDF or SVG.    The resulting file is automatically downloaded to your default downloads folder.The default file name is diagram.pdf or diagram.svg.Delete a pictureYou can delete a picturefrom the picture list.from the picture editor.Delete a picture from the picture list.Open an asset page.    In the tab pane, click   Pictures.The picture list appears.At the end of a line, click .The Delete picture dialog box appears.Click Delete picture.Delete a picture from the picture editorOpen a picture.In the upper right corner, click .The Delete picture dialog box appears.Click Delete picture.Diagram FAQWhich nodes and edges are included in a diagram?Collibra Data Intelligence Cloud only adds relevant relations and nodes to the diagram by using a specific traversal strategy. The traversal strategy is the logic that describes which relations and assets have to be included in the diagram. To understand the traversal strategy, it is important that you know the difference between incoming and outgoing edges and between flow and context nodes.From a start node, Collibra adds all the relations (both incoming and outgoing) and the relation's node whose relation type is mentioned in the view.When traversing further downstream from a node that is downstream from the start node, Collibra adds all the relations and nodes that are downstream, but not the ones that are upstream.When traversing further upstream, Collibra adds all relations and nodes that are upstream of that node, but not the ones that are downstream.For the following example diagram, the view contains the Groups relation type and Four Wheel Vehicle is the start node.Any downstream relation of an upstream node (Vehicle, Vehicle on Wheels, ...) is irrelevant for the diagram and thus not shown. The same traversal strategy is applied to any node that is on the upstream side of a node that is downstream of the start node.If you jump to Vehicle, you see that the diagram has changed for the Vehicle on Wheels node. This node no longer has the upstream relation to object with wheels, but the relation to Two Wheel Vehicle is added.Can I set a different traversal strategy for my diagram view?All examples in this chapter, unless mentioned otherwise, use the default traversal strategy. We call this the 'directed' traversal strategy. It can be paraphrased as 'keep on walking and don't look back'.You can also switch the traversal strategy to complete graph, by always looking in all directions. Depending on your data, this could obviously lead to a much bigger diagram, with many more nodes and edges.Going back to the example given in the FAQ Which nodes and edges are included in a diagram?, and applying that strategy results in the following diagram:Note the new upstream branch of Wheeled vehicle, which is downstream from the start node. An upstream node in that branch, Wheeled object, has a downstream branch: Ferris wheel.You can switch the traversal strategy in the JSON form of the diagram view by adding the following key-value pair to the top-level diagram sectionvisitStrategy: completeGraph.For more information, see Diagram views.When editing a diagram view, I can assign each node to either the 'Flow' or 'Context' layout region. What does that do? The default traversal strategy ('directed') gives the required results when you depict a set of assets that are related through some kind of (data) flow or dependency. For nodes in the flow section, and the edges between them, you can paraphrase the ‘directed’ traversal strategy as keep on walking and don't look back. But when the relation represents a link to context rather than flow, the edge between two nodes should always be traversed, even if the related node is upstream of a downstream node, or vice versa. You can also regard an edge between a flow node and a context node as bidirectional: it should always be traversed.This notion becomes clearer when you look at the following example.When the flow depicts transformations of table columns, the tables that contain the columns, and the business terms that are related to them, provide context to the columns. The context nodes are always relevant, regardless of whether the column was encountered while going upstream or downstream. The context nodes are always added to the diagram.For this traversal strategy, you can assign a node in the diagram view to be a context node.Consider the following example diagram view:This view contains flow only.An example diagram for this view is below:We started from the Order amount USD asset.Now assume that you also want to see to which tables these columns belong.You could add a relation from column to table to the view (in other words, a downstream edge), but this relation would only be considered on the downstream side, and if we add the column/table relation in the reverse direction, it would only be considered on the upstream side. To solve this problem, we designate the Table as a context node, so that the relation from Column to Table is always traversed, both for Columns that are upstream as well as downstream.Resulting in the diagram below:Both upstream and downstream Columns show the Table that contains them. The edge from Column to Table was always traversed.What is special about the flow/context layout?The Flow/Context layout is special because it has a specific behavior.If you set the diagram layout to Flow/Context, the nodes that are in the Flow layout region, also known as flow nodes, are depicted as a left-to-right hierarchy in the lower half of the diagram. The context nodes are all in the top half of the diagram.Flagging your nodes as flow or context nodes is always relevant, even when the diagram layout is not Flow/Context. For more information about how this is relevant, see When editing a diagram view, I can assign each node to either the 'Flow' or 'Context' layout region. What does that do? .Can I change the node colors and symbols that are used for an asset type or complex relation type?You can view and edit the color and symbol of each asset type and complex relation type in Settings. However, you need a role that can access the Settings and the permission to make changes to the operating model.All assets and complex relations of the same type have the same color and symbol across all diagrams.
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	 Data modelingIn this section, we describe the structure of the Collibra Data Intelligence Cloud data model, how data is related and how you can organize your data.
	 Collibra building blocksTo be able to create a decent data governance model, it is important that you understand the basic building blocks of Collibra Data Intelligence Cloud and how they relate to each other.The following table lists the concepts and explains how Collibra captures information.ConceptIconDescriptionCommunityA community is a grouping of subcommunities and domains. It often corresponds to functional divisions in a company and works best if it is aligned with the company's governance organization.Domain typeNoneA domain type defines the semantics of a domain, as a kind of template. It defines which assets types users can create in the domain.DomainA domain is a logical grouping of assets and belongs to exactly one community. It has a domain type that specifies which asset types can be created in the domain. A domain has a unique name within its community. A domain is the instance of exactly one domain type. ScopeNoneA scope is a selection of communities and domains that you can assign to one or more asset types.In a scope, you can define amongst others a domain type, attribute types and relation types.Asset typeNoneAn asset type defines the semantics of an asset, as a kind of template. It defines which attribute types and relation types the asset can have. Scopes are assigned to asset types.AssetAn asset is the fundamental building block or resource for which you want to capture information. An asset belongs to exactly one domain and has a unique name within that domain. An asset is the instance of exactly one asset type.Attribute typeNoneAn attribute type defines the class of information that an attribute contains. It is assigned to an asset type through a scope.AttributeNoneAn attribute is a specific piece of information that captures information about an asset. One asset can contain many attributes.Relation typeNoneA relation type specifies the type of relation between two asset types. A relation type is bidirectional, going from a head asset type to a tail asset type and the other way around.RelationNoneA relation is a link between exactly two assets. It captures how two assets are related to each other. One asset can have many relations. A relation is the instance of exactly one relation type.Complex Relation TypeNoneA complex relation type specifies the characteristics of a complex relation instance. A complex relation is a type of relation that helps you to create many-to-many relations, as well as capture attributes (description, priority, ...) on top of the many-to-many relation. They can be regarded as 'objectified associations'. A complex relation type is specified by its name, description, a collection of relation types and a collection of attribute types.The following diagram explains how the concepts from the table are related to each other.CommunitiesA community is a grouping of other communities and domains. It often corresponds to functional divisions in a company and works best if it is aligned with the company's governance organization.Each community can contain any number of subcommunities.You can recognize a community by the following icon: .Collibra uses some packaged communities. You can edit them, but you cannot delete them. If required, you can hide them by restricting their view permissions.Community nameIDURLBusiness Analysts Community00000000-0000-0000-0001-000100000001<your environment>/community/00000000-0000-0000-0001-000100000001Data Governance Councilbc40c085-352c-4a8c-8ee7-494fe821308e<your environment>/community/bc40c085-352c-4a8c-8ee7-494fe821308eSchemas00000000-0000-0000-0001-000100000002<your environment>/community/00000000-0000-0000-0001-000100000002ActionsCreate a communityAdd domains to a community by creating a new domain or moving an existing domain.Create a responsibility to assign a resource role to a user or group for a community.Edit the name of a community.Move a community to another parent community.Delete a community.Community page overviewThe community page provides a complete overview of all information related to a community.NumberSectionDescriptionBreadcrumbsThe breadcrumbs of the current community.Community representationThe icon or abbreviation of the community.Community nameThe name of the community.Resource toolbarAdditional actions, such as editing the community and starting a workflow.StewardsThe stewards of the community. You can see up to three stewards on the community page. If there are more, click See all <number> to see them on the Responsibilities page.Tab pane A collapsible pane that allows you to navigate to other pages of the community and add characteristics.EditorThe currently selected page, in this case the Overview page, which contains all the attributes that have been defined for the community.The Organization section contains a simple asset view with all the assets in the domains of the community.If you want to copy and paste text from other sources into a text field, we recommend that you click , and then paste the text into the Show source code field. This will remove any unwanted formatting or tagging of the text. For detailed information, see the knowledge base article on Collibra Support Portal.Create a communityYou can create a new community at the top level of your organization, or under another community.StepsOn the main toolbar, click .The Create dialog box appears.Click the Organization tab.In the Community section, click Community.The Create Community dialog box appears.Enter the required information.FieldDescriptionCommunityThe community under which the new communities will be located.If you leave this field empty, the communities will be located at the top level of your organization.NameThe names of the new communities.You can simultaneously create multiple communities. To do so, after typing the name, press Enter, and then type the next name. Community names must be globally unique. If you enter a name that already exists, it appears in the strike-through style.Click Create.Edit the name of a communityYou can edit the name of a community:From the community page. From an organization table.Edit the name of a community from the community pageOpen a community page.In the resource toolbar, click Actions → Edit.The Edit <community name> dialog box appears.Enter the required information.FieldDescriptionNameThe name of the community. Community names have to be globally unique.Click Save.Edit the name of a community from an organization tableOpen an asset page that contains an organization table, for example a community page.In the Name column, do one of the following:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears.Edit the name.Click . Move a communityYou can move a community to another parent community. If a community is moved to a community in another scope, the assignment of its assets may change. If moving a community causes a conflict of scopes, the moved domain is removed from its original scope.StepsOpen a community page.In the resource toolbar, click Actions → Move.The Move <community name> dialog box appears.Enter the required information.FieldDescriptionCommunityEnter the name of the new parent community. Community names have to be unique in their parent community. If you try to move this community to a parent community that already contains a community with the same name, an error message will appear after clicking Save.Click Save.Delete a communityYou can delete a community. When you delete a community, you will also delete its contained views, domains and assets.StepsOpen a community page.In the resource toolbar, click Actions → Delete.The Delete Confirmation dialog box appears.Click Delete <community name>.DomainsA domain is a logical grouping of assets. It always has a domain type and belongs to exactly one community.You can recognize a domain by the following icon: .Collibra uses some packaged domains. You can edit them, but you cannot delete them. If required, you can hide them by restricting their view permissions.Domain nameDomain typeIDURLNew Data SetsData Usage Registry00000000-0000-0000-0001-000200000001<your environment>/domain/00000000-0000-0000-0001-000200000001Data Quality DimensionsBusiness Asset Domain00000000-0000-0000-0000-000000006019<your environment>/domain/00000000-0000-0000-0000-000000006019Issue ClassificationIssue Classification00000000-0000-0000-0000-000000006011<your environment>/domain/00000000-0000-0000-0000-000000006011New ApplicationsTechnology Asset Domain00000000-0000-0000-0000-000000006018<your environment>/domain/00000000-0000-0000-0000-000000006018New Business TermsGlossary00000000-0000-0000-0000-000000006013<your environment>/domain/00000000-0000-0000-0000-000000006013New Data AssetsData Asset Domain00000000-0000-0000-0000-000000006015<your environment>/domain/00000000-0000-0000-0000-000000006015New Policies & Business RulesGovernance Asset Domain00000000-0000-0000-0000-000000006016<your environment>/domain/00000000-0000-0000-0000-000000006016New ProcessesBusiness Asset Domain00000000-0000-0000-0000-000000006017domain/00000000-0000-0000-0000-000000006017New Reference DataCodelist00000000-0000-0000-0000-000000006014<your environment>/domain/00000000-0000-0000-0000-000000006014ActionsCreate a domain.      Edit a domain.      Move a domain.      Create a responsibility to assign a resource role to a user or group for a community.Delete a domain.      Domain page overviewThe domain page provides a complete overview of all information related to a domain.NumberSectionDescriptionBreadcrumbsThe breadcrumbs of the current domain.Domain type representationThe icon or abbreviation of the domain type.Domain nameThe name of the domain.Resource menuAdditional actions, such as editing the domain and starting a workflow.StewardsThe stewards of the domain. You can see up to three stewards on the domain page. If there are more, click See all <number> to see them on the Responsibilities page.Tab pane A collapsible pane that allows you to navigate to other pages of the domain and add characteristics.Overview: Contains the description of and comments about a domain.Assets: Displays the assets in the domain.Responsibilities: Displays the view permissions and the responsibilities for a domain.History: Displays which user has done what with this domain.Files: Contains attachments.EditorThe currently selected page, in this case the Overview page, which contains all the attributes that have been defined for the domain.If you want to copy and paste text from other sources into a text field, we recommend that you click , and then paste the text into the Show source code field. This will remove any unwanted formatting or tagging of the text. For detailed information, see the knowledge base article on Collibra Support Portal.Create a domainYou can create a new domain in a community. StepsOn the main toolbar, click .The Create dialog box appears.Click the Organization tab.Click a domain type from the list. To create a Process Register domain, use the Process Register domain type.If you selected the wrong domain type here, you can still change it in the Type field in the next screen.The Create Domain dialog box appears.Enter the required information.FieldDescriptionTypeThe domain type of the domain you are creating.This field contains the domain type that you clicked in the previous step. You can change it if needed.CommunityThe community under which the domain will be located.NameThe name of the new domain.You can simultaneously create multiple domains. To do so, after typing the name, press Enter, and then type the next name. Domain names must be unique in their parent community. If you enter a name that already exists, it appears in the strike-through style.ExampleClick Create.Edit a domainYou can edit the name and domain type of a domain:From the domain page. From an organization table.Edit a domain from the domain pageOpen a domain page.In the resource toolbar, click Actions → Edit.The Edit <domain name> dialog box appears.Enter the required information.FieldDescriptionNameThe name of the domain. Domain names have to be unique in their community.TypeThe domain type.Click Save.Edit a domain from an organization table.Open an asset page that contains an organization table, for example, a community page.In the Name or Domain Type column, do one of the following:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears.Edit the name or domain type.Click . Move a domainYou can move a domain to another community.If a domain is moved to a community in another scope, the assignment of its assets may change. If moving a domain causes a conflict of scopes, the moved domain is removed from its original scope.StepsOpen a domain page.In the resource toolbar, click Actions → Move.The Move <domain name> dialog box appears.Enter the required information.FieldDescriptionCommunityEnter the name of the new parent community. Domain names have to be unique in the community. If you try to move this domain to a community that already contains a domain with the same name, an error message will appear after clicking Save.Click Save.Delete a domainYou can delete a domain. When you delete a domain, you will also delete its contained views and assets.StepsOpen a domain page.In the resource toolbar, click Actions → Delete.The Delete Confirmation dialog box appears.Click Delete <domain name>.
	 Asset typesAn asset type defines the semantics of an asset, as a kind of template. Via its assignment, it defines which attribute types, relation types and statuses the asset can have. It also determines which articulation rules, data quality rules and validation rules are applied, and the domain types in which it can be created.Some asset types can only be created in a specific Collibra application and in a specific domain type. For example, you can only create assets of the Validation Rule type in a domain of the Validation Rule Domain type. You can see the required domain type in the assignment of the asset type.Overview of packaged asset typesAn asset type defines the semantics of an asset, as a kind of template. Via its assignment, it defines which attribute types, relation types and statuses the asset can have. It also determines which articulation rules, data quality rules and validation rules are applied, and the domain types in which it can be created.If you want to create an asset of a specific type, you need access to one or more domains of the required type. For example, you can only create KPI assets in a Report Catalog domain. As an admin, you can see and edit the required domain types in the assignment.Listed below are the five main asset types and their default icons. All other asset types are descend from these: Business Asset Data Asset Governance Asset Issue Technology Asset The table below contains all packaged asset types and their description.For an interactive overview of all packaged asset types, including the relevant domain types and applications, see the online version of this guide.Asset typeDescriptionBusiness AssetA type of asset that is exclusively used and governed by the business user community. Its instance assets, and all instances instantiating its subtypes, pertain to the business organization. Business assets typically include business concepts like Business Term, Business Process, Line of Business, etc. that help to build the semantics of any organization with insufficient details to build an actual business application.Business DimensionA set of reference information that categorizes and describes business terms in a way that provides context and meaningful answers to business questions.Examples: business process, line of business, regionBI FolderA collection of BI contentLooker FolderA container that stores Looker Looks, Dashboards and other folders.MicroStrategy FolderA collection of MicroStrategy reports and data models.MicroStrategy ProjectA collection of MicroStrategy visualizations, report attributes and tables.Power BI CapacityA resource that hosts Power BI Workspaces.Power BI FolderA collection of Power BI Report Server Dashboards, Reports and Data Models.Power BI WorkspaceA collection of Power BI Dashboards, Reports and Data Models.SSRS Folder    A collection of SQL Server Reporting Services and Power BI Report Server Reports and Data Sets.  Tableau ProjectCollection of Tableau workbooks and data sources.Tableau SiteCollection of content (workbooks, data sources, users, …) that's walled off from any other content on that instance of Tableau Server.Business ProcessA set of activities and tasks that, once completed, produces value to the business.Examples: campaign management, talent recruitmentData CategoryA container for all the business definitions that encompass associated terminology and definitions that an organization is trying to govern.Examples: master data, reference data, transactional dataData ConceptA data concept is a high level theoretical representation of the most common data properties of a data domain. A data concept is the business counterpart of a data attribute in a logical data dictionary, just as a data attribute is the logical counterpart of a field or column in the physical data dictionary. (Example: an address is a data concept of the data domain customer or organisation).Data DomainAlso known as Data Category or Subject area, this is a container of all the business data domains and data concepts that encompass associated terminology and definitions that an organization is trying to govern. Examples: Master Data (Customer, Product), Reference Data. Business Data Domains group Data Concepts (Year, Date, Address, Name, etc.)Line of BusinessA logical element or segment of an organization that serves a particular business need. Line of business is also known as business unit or business area.Examples: retail, e-commerce, investment managementBusiness QualifierBusiness Qualifiers qualify certain assets. This can be used as filters in Business Qualifier Diagrams.Business TermA word or phrase that describes a concept that is used in a particular branch of business.Examples: customer, person purchase count, loan amountAcronymAn abbreviation of a business term that forms a word or a name. It is formed by stringing the initial components of a business term together. It is often pronounced as a word.Examples: ERP, EDW, EADMeasureAn asset type that is used for calculations, such as sum, count, average, minimum or maximum.Examples: net sales, top customers, on-hand inventoryKPIKey Performance Indicator, an indicator to periodically measure the success of or the progress towards a strategic goal of a particular activity or of an organization.Examples: employee turnover, customer attrition, claims denial rateReportA document containing information that is organized in a narrative, graphic, or tabular form. The document is prepared on an ad hoc, periodic, recurring, regular or as-required basis.Reports can refer to specific periods, events, occurrences or subjects. BI ReportA visual representation of data or a collection of visualizations.Looker DashboardA collection of Looker tiles with metrics from one or more Looker Looks.Looker LookA detailed view of a Looker Data Set, with visualizations of findings and insights.Looker QueryA query that creates a simple report in a Looker Tile or Looker Look.Looker TileAn element that represents data on the Looker Dashboard.MicroStrategy DossierA collection of MicroStrategy chapters and pages.MicroStrategy ReportA detailed view of a MicroStrategy data model, with visualizations of findings and insights.Power BI DashboardA collection of Power BI tiles with metrics from one or more Reports and Data Models.Power BI ReportA detailed view of a Power BI Data Model, with visualizations of findings and insights.Power BI TileAn element representing data on the Power BI Dashboard.SSRS KPIA key performance indicator of SQL Server Reporting Services.SSRS ReportA detailed view of an SQL Server Reporting Services Data Set, with visualizations of findings and insights.Tableau DashboardA collection of several worksheets and supporting information, shown on a single screen, so that you can simultaneously compare and monitor a variety of data.Tableau WorksheetA worksheet is a single sheet on which you can build views of your data.Tableau WorkbookCollection of sheets. A sheet can be a worksheet, a dashboard or a story.Data AssetA type of asset that represents details of organizational data in two layers. One layer is independent of any particular technology for non-technical stakeholder communication. The other one is taking the implementation system for technical stakeholder communication into account. Examples: Data Element, TableCode SetAn enumerated list of valid code values for a specific topic, where the code set is the whole and the code values are parts of that whole. It is a data asset that defines the set of permissible values to be used by other data assets.Examples: Product Code Set, Person Gender Code, ISO 3166 Country CodeCode ValueA valid form of representation for an asset, shortened or covert.Examples:In the Person Gender Code, “male”, “female”, “not known” and not specified are represented by the valid code values 1, 2, 0 and 9.“US” is part of the ISO 3166 code set and refers to The United States of America.CrosswalkMapping between two or more code sets.Data ElementA construct that documents aspects of something abstract, especially one that is essential for business.Examples: person birth date, person addressColumnAn atomic unit of data that can be stored in a database table.Examples: FST_NM, EMPIDData AttributeA specification that defines a property of a data entity.Examples: CustomerBirthDate, EmployeeFirstNameBI Data AttributeAn atomic unit of data that represents a BI report.Looker Data Set ColumnAn atomic unit of data that is used in a Looker Look or Looker Tile. It represents a column in a Looker Data Set.MicroStrategy ColumnA column in a MicroStrategy data model.Power BI ColumnA column in a Power BI Data Model.SSRS ColumnA column in an SQL Server Reporting Services Report Data Set.Tableau Data AttributeA specification that defines a property of a Tableau data entity.Examples: CustomerBirthDate, EmployeeFirstName.FieldAn atomic unit of data that can be stored in a file.Examples: FirstName, EmpIDReport AttributeAn atomic unit of data that represents a report.BI Report AttributeAn atomic unit of data that represents a BI report.Looker Report AttributeAn atomic unit of data that is used in a Looker Look or Looker Tile. It represents the actual use a Looker Data Set Column.MicroStrategy Report AttributeA detailed view of a MicroStrategy visualization, with findings and insights.SSRS ParameterA column that is part of an SQL Server Reporting Services Data Set and that is used in a KPI.Tableau Report AttributeAn atomic unit of data that represents a Tableau report.Examples: ExpenseAmount, RiskAmountData SetA collection of related sets of data assets that are data elements or composed of data elements.Example: Customer Contact informationBI Data SetA collection of data that is used for BI report creationLooker Data SetA collection of data that is used to define Looker Dimensions and Measures.SSRS Data ModelA collection of data that is used to create an SQL Server Reporting Services Report.Data structureA logical grouping (through whole-part relation) of data elements.Example: cfPerson is a data structure that contains the cfBirthDate, cfPersonFullName data elements.Data EntityA unit of data that can be classified and can have a stated relationship to other units of data.Examples: Customer, EmployeeBI Data EntityA unit of data in a BI data source that can be classified and can have a stated relationship to other units of data.Power BI TableA table in a Power BI Data Model.SSRS TableA table in an SQL Server Reporting Services Report Data Set.Tableau Data EntityAn abstraction from the physical implementation of database tables, used for Tableau report creation.Data ModelOrganizes data elements and standardizes how the data elements relate to one another. The data model often facilitates the communication between business and technology.Examples: customer subject area model, event subject area modelBI Data ModelA diagram that organizes data elements and standardizes how the data elements relate to one another. The Data Model is often used as a communication aid between business and technology. Examples: Customer Subject area model, Event Subject area modelMicroStrategy Data ModelA collection of data that is used to create MicroStrategy reports.Power BI Data FlowA collection of tables that are created and managed in workspaces in the Power BI service.Power BI Data ModelA collection of data that is used to create a Power BI report.Tableau Data ModelAn abstraction from the physical implementation of database, schema, file, etc., used for Tableau report creation.SchemaAn asset that contains the location of specific data. It provides all the details that are required for setting up a connection to a database or server. TableAn implementation of data entities in columns and rows, in a given database system. It is the basic structure of a relational database.Examples: Account_tbl, CUST_ADDR Database ViewA Database View is a virtual table based on the result-set of an SQL statement.Data UsageAn asset that clearly documents how the data can be used between data produces and consumers for specific purposeExample: Sales growth information that is available to share for read-only requirementsForeign KeyAsset type used to model the Primary key - Foreign key relations in relational databases.Mapping SpecificationMapping between two or more data structures.Governance AssetA type of asset that is used to monitor and advocates to maximize performance or utilization of other Business and Data assets while minimizing the risk factors in alignment with Organisational/Business goals.Assessment ReviewAn asset of this type is created when an assessment is conducted on an asset and submitted for review.Data Quality DimensionRepresents criteria that are relevant for assessing quality and categorizes different aspects of how data quality is measured. Examples: accuracy, completeness, consistency Data Sharing AgreementAn agreement between data producers and consumers with terms and conditions including provisions concerning access and dissemination to 'pool' a set of data for specific purposes. Examples: Sales growth information that is available only to the Risk team for generating internal reports.Issue CategoryAllows you to categorize Issue type assets to help with organization and reporting.Example: You want to differentiate between types of issues, such as a Duplication issue or a Completeness issue. Policy A statement of intent that is set by a council and is implemented by a set of standards. Example: Personal information must be adequately protected.StandardConsists of specific low-level mandatory controls that help enforce and support the policy. Example: All personal information is encrypted with a specific encryption type. RuleDefines or constrains some aspect of specific business data categories. It is intended to control or influence the behavior of the business. Example: Every customer must have a unique identifier.Business RuleDefines or constrains some aspect of specific business data. It is intended to control or influence the behavior of business data. Example: Customer numbers have to be unique.Data Quality MetricAn implementation of data quality rules in a selected physical database system using a particular data quality tool. Example: CRM.ACT.Tx_ID cannot be null, must be a 9-digit number and has to take the 999-99-9999 format in the CRM system, and ERP.Cust.SSN has to take the 999999999 format in the ERP system. Data Quality RuleA specification that defines which actions are required to measure the quality level of a data element for its intended use. Example: SSN must be a unique 9-digit identification number for 100% of US personal accounts for tax processing. Validation RuleA rule that describes a criterion to which content in DGC has to comply.IssueThe parent asset type of all issues.Data IssueA problem related to issue management, also referred to as issue.Technology AssetA piece of information technology (hardware, software, database, software platform) that helps an organization to run a business application.Examples: Database, FileDatabaseA collection of data that is systematically organized or structured, to make it is easy to create, update and query the information. Examples: Ora_DGC_V45, SalesDB2020File ContainerAn asset type that represents Cloud File Container.DirectoryA collection of data that is treated by a computer as a unit, for the purposes of input and output.Examples: businessGlossary.xls, dataDictionary05220.csv, datacatalogv25.txtGCS BucketAn asset type that represents an Google Cloud Storage bucket which is a logical unit of storage containing Google Cloud Storage objects.S3 BucketAn asset type that represents an Amazon S3 Bucket, which is a logical unit of storage containing Amazon S3 Objects.File GroupA collection of physical files which together represent a single logical file.ServerA computer program or device that supports other computer programs and their usersBI ServerA visual analytics platform for creating and storing visualizations.Looker TenantA platform to create Looker Dashboards and rich visualizations.MicroStrategy ServerA visual analytics platform for creating and storing MicroStrategy reports and data models.Power BI ServerA visual analytics platform for creating and storing Power BI Reports and Data Models.SSRS Server    A visual analytics platform for creating and storing SQL Server Reporting Services and Power BI Report Server Reports and Data Sets.  Tableau ServerA visual analytics platform for creating interactive dashboards and rich visualisationsSystemExecutable software that you can buy commercially off the shelf (COTS), or build internally, to automate one or more business functions that help run a business smoothly and efficiently. Examples: CRM, ERP, EDWBI Data SourceThe link between a BI System and an external system.Tableau Data SourceThe link between Tableau and an external system. A Tableau data source contains the information to connect to external data, table names, the table relationships, and any customizations that you make.File StorageAn asset type that represents a Cloud File Storage bucket.GCS File SystemAn asset type that represents Google Cloud Storage file system.S3 File SystemAmazon S3 (Simple Storage Service) file system abstraction.Create an asset typeYou can create an asset type. For example, you can do this if the packaged asset types do not suffice.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.Above the table, to the right, click Add.The Asset Type Creation dialog box appears.Enter the required information.FieldDescriptionNameThe name of the asset type. You can add more than one type by pressing Enter.The name of the asset type must be globally unique.Parent Asset TypeThe parent asset type from which the new asset type inherits all properties.Click Save.If you create an asset type and hierarchically nest the new asset type under, for example, a Catalog asset type, you may encounter asset page rendering issues. This is due to a difference in the required characteristics of the asset type you created and the Catalog asset type. Likewise, if you remove a required characteristic from an asset type, you may encounter page rendering issues for asset pages of that asset type.What's next?If necessary, edit the asset type, for example by doing one of the following:Enable or disable ratings and reviews.Enable or disable non-unique naming.Edit the representation in Collibra Data Intelligence Cloud.Edit an asset typeYou can edit an asset type. For example you can do this if you want to give it another name.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.In the upper-right corner, click Edit.  The Edit <asset type> dialog box appears.Enter the required information.FieldDescriptionNameEnter the name of the asset type.The name of the asset type must be unique.Allow identical asset names per domainSelect to enable identical asset names per domain.Clear to disable identical asset names per domain.Enable ratingsSelect to allow users to rate assets.Ratings enable users to subjectively rate the quality of an asset, using a five-star rating system, and write a free-text review of the asset, in support of the rating provided.Display optionsThese fields allow you to edit how assets of this type are represented on the asset page and in diagrams. ColorsThe default colors that you can use for the complex relation nodes of this type. Color hex valueThe hexadecimal value of the color that you want for assets of this type.For a list of colors and their hexadecimal values, see ColorHexa. SymbolA graphical representation for assets of this type.You can choose one of the following values:None: No graphical representation is used for assets of this type.Code: Assets of this type are represented with a code in front of them. You can specify the code that you want in the Code field.Icon: Assets of this type are represented with an icon in front of them. You can select the icon that you want in the Icon reference field. CodeThe code that is displayed in front of assets of this type. This code is also displayed in the legend of diagrams. By default, this field contains the initials of the selected asset type.This field is only displayed if you have selected Code in the Symbol field. Icon referenceThe icon that is displayed in front of assets of this type. This icon is also displayed in the legend of diagrams.This field is only displayed if you have selected Icon in the Symbol field.PreviewDisplays two previews of your asset type configuration.The left preview is the title bar on an asset page.The right preview is a diagram node.Click Save.Edit an asset type's representationYou can change the color and icon by which an asset is represented in Collibra Data Intelligence Cloud. This can be handy to quickly spot a specific asset type in a diagram.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.In the upper-right corner, click Edit.  The Edit <asset type> dialog box appears.Enter the required information.FieldDescriptionDisplay optionsThese fields allow you to edit how assets of this type are represented on the asset page and in diagrams. ColorsThe default colors that you can use for the complex relation nodes of this type. Color hex valueThe hexadecimal value of the color that you want for assets of this type.For a list of colors and their hexadecimal values, see ColorHexa. SymbolA graphical representation for assets of this type.You can choose one of the following values:None: No graphical representation is used for assets of this type.Code: Assets of this type are represented with a code in front of them. You can specify the code that you want in the Code field.Icon: Assets of this type are represented with an icon in front of them. You can select the icon that you want in the Icon reference field. CodeThe code that is displayed in front of assets of this type. This code is also displayed in the legend of diagrams. By default, this field contains the initials of the selected asset type.This field is only displayed if you have selected Code in the Symbol field. Icon referenceThe icon that is displayed in front of assets of this type. This icon is also displayed in the legend of diagrams.This field is only displayed if you have selected Icon in the Symbol field.PreviewDisplays two previews of your asset type configuration.The left preview is the title bar on an asset page.The right preview is a diagram node.Click Save.Enable or disable ratingsYou can enable and disable ratings via the asset type pages, in Settings.Enabling ratings for a particular asset type is not inherited by children asset types. The feature has to be manually enabled for each child asset type.By default, ratings are enabled for asset types Data Set and Report and their children asset types. Ratings are disabled, by default, for all other packaged asset types and any asset types you create.Ratings cannot be disabled for a specific asset type if user ratings exist for any assets of that asset type. In other words, all user ratings for all assets of a specific asset type must be manually deleted before ratings can be disabled for that asset type.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.In the upper-right corner, click Edit.  The Edit <asset type> dialog box appears.Enter the required information.FieldDescriptionEnable ratingsSelect to allow users to rate assets.Ratings enable users to subjectively rate the quality of an asset, using a five-star rating system, and write a free-text review of the asset, in support of the rating provided.Click Save.Enable or disable identical asset names per domainYou can enable and disable Identical asset names per domain, by asset type.PrerequisitesYou have a new or existing asset type.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.In the upper-right corner, click Edit.  The Edit <asset type> dialog box appears.Enter the required information.FieldDescriptionAllow identical asset names per domainSelect to enable identical asset names per domain.Clear to disable identical asset names per domain.Click Save.Move an asset typeYou can move an asset type to another parent asset type. As a consequence, the asset type may inherit the assignment of the new asset type, which may impact, amongst others, the possible characteristics.PrerequisitesYou have a global role that has the System administration global permission.Move an asset type from the asset type table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the row of the asset type that you want to move, click .The Select Parent Asset Type dialog box appears.Enter the required information.FieldDescriptionParentChoose the parent asset type.Click Save.Move an asset type from the asset type page Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.Above the table, to the right, click Move.The Select Parent Asset Type dialog box appears.Enter the required information.FieldDescriptionParentChoose the parent asset type.Click Save.Delete an asset typeYou can delete an asset type. For example, you can do this if you no longer need an asset type that you created earlier.PrerequisitesYou have a global role that has the System administration global permission.It is not a packaged asset type.There are no assets of that asset type. If assets of that asset type exist, either edit their asset type or delete them.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the row of the asset type that you want to delete, click . The Delete Asset Type dialog box appears.Click Yes.
	 AssignmentsAn assignment is a collection of components that is assigned to an asset type and optionally to its child asset types.In this section, we provide more information about the assignments in Collibra Data Intelligence Cloud.AssignmentsAn assignment is a collection of components, such as characteristics and statuses, assigned to an asset type and optionally to its child asset types.Assignments determine what you can do with assets in the user interface of Collibra Data Intelligence Cloud, but they do not limit the possibilities of the API or import feature.Assignments and scopesAn assignment can apply globally, in which case it is called the global assignment, or to a scope, in which case it is called a scoped assignment.The global assignment applies to all assets that are not in a scope. A scoped assignment only applies to assets that are located in a domain or community that belongs to the scope. An asset type can only have one global assignment, but many scoped assignments.Before adding a scoped assignment, an asset type must have a global assignment. You can add the global assignment by going to the Asset Type page and clicking the Add Global Assignment button. Self-relation types are now divided in the assignment table with the head and tail appearing on separate lines. For an interactive overview of asset type whose assignments have changed visit the online documentation.ComponentsYou can assign the following components to an asset type.Characteristics The Characteristics page contains a list of all attribute types, relation types and complex relation types that can be added to an asset of this type, if the asset is in the scope of the assignment.An assignment line consists of the following:One characteristic type, including its description and kind.The minimum and maximum cardinality.The cardinality of an assignment line determines how many characteristics of this type can be added to an asset.NumberMinimumMaximumnot filled inThis is not possible. The minimum number of occurrences must at least be 0.You can add as many characteristics of this characteristic type as you want.0The characteristic doesn't automatically appear on the asset page, but you can add it via Add characteristics.If the maximum cardinality is 0, you cannot add this characteristic to the asset. 1 or greater The characteristic's type is automatically visualized on the asset page of the asset, even if the characteristic doesn't exist yet.You can add characteristics of this type until you reach this maximum.The asset type filter, if the characteristic is a relation type.You can use the asset type filter to restrict the asset types that you can use as the target of this relation type.The MicroStrategy Report Attribute asset type has an assignment line containing the Report Attribute contained in / contains Report relation type. Instead of allowing any asset of the Report type or its children, you can use the asset type filter to restrict it to only assets of the MicroStrategy Report type.Domain typesThe Domain types page contains the hierarchy of domain types. You can select domain types to allow assets of this type to be put in domains of this type. Assets of this asset type can then be created in the domains of the selected types.StatusesThe Statuses page contains a list of statuses with their description. When you create a new asset of the asset type for which you have an assignment, the asset gets the first status from this list.ArticulationThe Articulation page shows the articulation score calculatorData quality rulesThe Data quality rules page contains a list of data quality rules with their description.Validation rulesThe Validation rules page contains a list of validation rules with their description.InheritanceIf an asset type does not have an assignment, then the asset type inherits all assignments of its parent asset type. If an asset type has one or more assignments, it does not inherit any assignments of its parent asset type.Create an assignmentYou can create an assignment for an asset type if you want to change the behavior of assets of this type in Collibra Data Intelligence Cloud. For example, you do this if you want to make a specific attribute type available only for assets of a certain type.PrerequisitesYou have a global role that has the System administration global permission.If you want to create a scoped assignment, you have created the scope.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.Create a global or scoped assignment:        Assignment typeStepsGlobal assignment    In the tab pane, click   Add global assignment.The Add Global Assignment dialog box appears.Click Add global assignment.The asset type no longer inherits the assignments of its parent asset types.Each asset type can only have one global assignment.Scoped assignment    In the tab pane, click   Add assignment.The Select scope for this assignment dialog box appears.Select a scope.You can only add one scope at a time.Click Add assignment.The settings of the global assignment are copied into the selected scope.You can only create scoped assignments if the asset type has a global assignment.What's next?You can now edit the assignment.Edit an assignmentYou can edit an assignment. For example, you do this if you want to add a specific attribute type to assets of a certain type.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.Perform one of the following steps:ComponentStepsCharacteristicsAssign one or more characteristic types to the asset type.Above the table, to the right, click Edit.Above the table, to the right, click Add characteristic.The Add a Characteristic dialog box appears.Click the characteristic type that you want to add.You can use the filter to search for a specific characteristic type.The characteristic type appears at the bottom of the table.If required, set the Asset Type Filter to restrict the relation type target available to a sub-set of assets. If required, edit the minimum or maximum number of occurrences of the characteristic. OptionDescriptionMin.The minimum number of occurrences of the characteristic. Set this option to 1 or greater to make the characteristic appear automatically on the asset page.Max.The maximum number of occurrences that you can assign to an asset type.Leave this option empty if you don't want a limit to the maximum number of occurrences.Above the table, to the right, click Save.You can now add the characteristic to the assets of this type.Domain typesAssign one or more domain types to the asset type.    In the tab pane, click   Domain Types.The domain type table appears.Above the table, to the right, click Edit.In the domain types overview, select the domain types to assign the selected asset type to.Click Save.StatusesAssign one or more statuses to the asset type.    In the tab pane, click   Statuses.  Above the table, to the right, click Edit.Above the table, to the right, click Add.In the Add status dialog box, click the status to add to the asset type.Statuses in gray are already assigned to the asset type.Repeat this step for every status that you want to assign.Click Save.ArticulationAssign one or more articulation rules.Data quality rulesAssign one or more data quality rules.    In the tab pane, click   Data quality rules.  Above the table, to the right, click Edit.Above the table, to the right, click Add.The Add data quality rule dialog box appears.Click a data quality rule.The data quality rule appears at the bottom of the list of data quality rules.If required, change the order.Click Save.Validation rulesAssign one or more validation rules to the asset type.    In the tab pane, click   Validation rules.The Asset type - Validation rules editor appears.Above the table, to the right, click Edit.Above the table, to the right, click Add.The Add validation rule dialog box appears.Click a validation rule.The validation rule appears at the bottom of the list of validation rules.If required, change the order.Click Save.Delete an assignmentYou can delete an assignment. For example, you do this if you no longer want assets to have specific attribute types. For some asset types, you cannot delete the global assignment because it is required for the proper functioning of Collibra Data Intelligence Cloud.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.    In the tab pane, click   .If you want to delete the global assignment, you first have to delete all scoped assignments.Click Yes.If you deleted the global assignment, the asset type inherits all assignments of its parent asset type.Restrict relations for an assignmentYou can restrict the target asset types that are available for an assigned relation type to one of its child asset types This allows you to limit the possible assets available for relations of that type to assets of the selected type and its descendants. By reducing the list of available asset types, you can reduce potential confusion and incorrect relations, without having to create new relation types with more restrictive heads and tails.When selecting an asset in the Asset Type Filter, the available relations are restricted to assets of that type and any of its descendants. Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.Above the table, to the right, click Edit.In the Asset Type Filter field, select the asset type from which you want to start the restriction.Above the table, to the right, click Save.Assign a characteristic type to an asset typeYou can assign a characteristic type to an asset type by adding it to the asset type's assignment. As a result, you can see and add characteristics of this type to assets of this type on the asset page, if the asset is in the scope of the assignment.Via the import API, the import functionality or a workflow, you can add characteristic types that are not in the assignment. The asset page only shows characteristics whose type is in the asset type's assignment.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.Above the table, to the right, click Edit.Above the table, to the right, click Add characteristic.The Add a Characteristic dialog box appears.Click the characteristic type that you want to add.You can use the filter to search for a specific characteristic type.The characteristic type appears at the bottom of the table.If required, set the Asset Type Filter to restrict the relation type target available to a sub-set of assets. If required, edit the minimum or maximum number of occurrences of the characteristic. OptionDescriptionMin.The minimum number of occurrences of the characteristic. Set this option to 1 or greater to make the characteristic appear automatically on the asset page.Max.The maximum number of occurrences that you can assign to an asset type.Leave this option empty if you don't want a limit to the maximum number of occurrences.Above the table, to the right, click Save.You can now add the characteristic to the assets of this type.Assign a domain type to an asset typeYou can assign a domain type to an asset type by adding it to the asset type's assignment. As a result, you can create assets of this type in domains of this type, if the domain is in the scope of the assignment.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.    In the tab pane, click   Domain Types.The domain type table appears.Above the table, to the right, click Edit.In the domain types overview, select the domain types to assign the selected asset type to.Click Save.Assigning a status to an asset typeYou can assign a status to an asset type by adding it to the asset type's assignment. As a result, you can give assets of this type this status on the asset page, if the asset is in the scope of the assignment.PrerequisitesYou have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.    In the tab pane, click   Statuses.  Above the table, to the right, click Edit.Above the table, to the right, click Add.In the Add status dialog box, click the status to add to the asset type.Statuses in gray are already assigned to the asset type.Repeat this step for every status that you want to assign.Click Save.Assign a validation rule to an asset typeYou can assign a validation rule to an asset type by adding it to the asset type's assignment. As a result, you can validate assets of this type against this validation rule, if the asset is in the scope of the assignment.PrerequisitesYou have a global role that has the System administration global permission.You have created a Validation Rule asset.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.    In the tab pane, click   Validation rules.The Asset type - Validation rules editor appears.Above the table, to the right, click Edit.Above the table, to the right, click Add.The Add validation rule dialog box appears.Click a validation rule.The validation rule appears at the bottom of the list of validation rules.If required, change the order.Click Save.Assign a data quality rule to an asset typeYou can assign a data quality rule to an asset type by adding it to the asset type's assignment. As a result, the data quality dashboard is available for assets of this type if the asset is in the scope of the assignment.PrerequisitesYou have a global role that has the System administration global permission.You have created a data quality rule.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.    In the tab pane, click   Data quality rules.  Above the table, to the right, click Edit.Above the table, to the right, click Add.The Add data quality rule dialog box appears.Click a data quality rule.The data quality rule appears at the bottom of the list of data quality rules.If required, change the order.Click Save.What's next?If the asset has all relations as defined in the aggregation path, you can go to the relevant asset pages and open the Quality tab page to see the data quality results.
	 Overview of characteristic typesCharacteristic types is a generic term for attribute types, relation types and complex relation types.Attribute typesAn attribute type defines the class of information that an attribute contains.You can add an attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.About attribute typesAn attribute type defines the class of information that an attribute contains.You can add an attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.Examples of attributes and attribute typesThe following table contains attribute types and a description of the attribute that can be added to an asset.Attribute typeDescription of the attributeExample of an attributeDefinitionThe description with background information on the assetAsset: Customer Definition: A person, company or organization that purchases a commodity or service.Last Review DateThe date on which the asset was reviewed.02/05/2020FrequencyThe rate at which an asset changes over a particular period of time.DailyRows FailedThe number of rows that failed a rule.15Personally Identifiable InformationA boolean field to indicate whether an asset contains personally identifiable information.TrueKinds of attribute typesAttribute types can contain different kinds of information, for example, free text, dates and numbers.FieldDescriptionDateA date value. If you edit attributes of this type, you can pick a date using the date selector.The date format that is displayed in the UI, can be different depending on the language settings in your user profile. For example, dd/mm/yyyy or yyyy/mm/dd.Multiple SelectionA field that allows multiple values that you can select from a predefined list.with valuesThe values from which you can select one or more.NumberA number, or a number with a fraction.Only integers. (..., -2, -1, 0, 1, 2, ...)Checkbox to only allow integer numbers.Numeric values are stored as Floating Point values (IEEE 754 standard), which are not able to represent all numbers accurately. Due to this technical constraint, rounding issues occur for both negative and positive numbers. The bigger the number, the more noticeable the rounding issue. MetricCheckbox to make this attribute type a metric. This allows you to assign this attribute type as a metric when you create a data quality rule.SelectionA field that allows a single value that you can select from a predefined list.with valuesThe values from which you can select one.TextTextual input which may contain formatting.Plain TextCheckbox to disable formatting.True/FalseA binary option that allows you to indicate whether something is true or false.MetricCheckbox to make this attribute type a metric. This allows you to assign this attribute type as a metric when you create a data quality rule.An attribute can contain up to 100.000 bytes, which corresponds to roughly up to 100.000 characters in the source code of the attribute.Overview of packaged attribute typesAn attribute is a characteristic that describes an asset by means of an individual field. The attribute's kind defines the class of information that the attribute contains.You can add an attribute to an asset if the attribute's type is in the relevant assignment of the asset's type.The table below contains all packaged attribute types. You can also create new attribute types.TypeDescriptionAssigned to asset typeKind1st DecileThe data 1st decile value.ColumnText1st PercentileThe data 1st percentile value.ColumnText1st QuartileThe data 1st quartile value.ColumnText3rd QuartileThe data 3rd quartile value.ColumnText5th PercentileThe data 5th percentile value.ColumnText95th PercentileThe data 95th percentile value.ColumnText99th PercentileThe 99th percentile value.ColumnText9th DecileThe data 9th decile value.ColumnTextAbbreviation A shorthand signifier for an asset.ReportTextAnalysis The analysis of this issue. Issue TextApplication Regulation Any regulations that apply to the application. For example, for certain applications that consumes data, there is a regulation about how to handle that. Directory, System, Technology AssetTextApplication Standards Any standards applied to the business application. Directory, System, Technology AssetTextApproval DateThe date on which the assessment was approved.Assessment Review DateAssessment LinkThe link to the submitted assessment.Assessment Review StringBackground Background information on the asset. TextCalculation Rule The rule that specifies how the KPI or metric is calculated.KPI, Tableau Report AttributeTextCategorical DataData is considered categorical if it can only take a limited set of different values.ColumnTrue/FalseCategoryA possible value for Categorical Data.ColumnTextCertifiedIndicates whether or not a report asset meets the set standards.Data Set, Looker Dashboard, Looker Data Set, Looker Look, Looker Tile, Power BI Dashboard, Power BI Data Model, Power BI Report, Power BI Tile, Tableau Data Source, Tableau View, Tableau WorkbookTrue/FalseChar octet LengthFor character types, the maximum number of bytes in the column.ColumnNumericColumn PositionThe index of the column in the table.ColumnNumericConformity ScoreThe amount of rows that passed the rule.Business Rule, Data Quality MetricNumericCo-roleRelationship name from tail to head.-TextCriticality IndicatorIndicate the criticality of an asset.-True/FalseData Source The data source of an asset. It specifies where the data corresponding to this asset is coming from.Database, Tableau Data Model, SchemaTextData Source TypeThe type of the registered data source.Schema, DatabaseTextData Type The logical Data type detected by Collibra profiling.ColumnTextData Type Precision The precision of the data type. For example how many characters it can contain. Data Attribute, Data Element, Report AttributeNumericDate and/or Time PatternThe pattern used to encode a time, date or both. Format must be compatible with a java DateTimeFormatter. Example: yyyy-MM-dd HH:mm:ss.ColumnTextDefault ValueThe default value for the column.ColumnTextDefinition The definition of the business asset. This is the shortest possible description that clearly defines the business asset. Business Asset, Business Process, Business Term, Data Category, KPI, Line of Business, Measure, Report, Report AttributeTextDescription The description of the asset. This is typically a more verbose way to describe what the asset means.Asset, Business Dimension, Business Rule, Code Set, Code Value, Column, Crosswalk, Data Asset, Data Attribute, Database, Data Element, Data Entity, Data Model, Data Quality Dimension, Data Quality Metric, Data Quality Rule, Data Set, Data Sharing Agreement, Data Structure, Data Usage, Directory, File, File Group, Governance Asset, Issue, Issue Category, Looker Dashboard, Looker Data Set, Looker Data Set Column, Looker Folder, Looker Look, Looker Query, Looker Report Attribute, Looker Tenant, Looker Tile, Mapping Specification, Policy, Power BI Capacity, Power BI Dashboard, Power BI Data Model, Power BI Table, Power BI Column, Power BI Report, Power BI Server, Power BI Tile, Power BI Workspace, Report, Report Attribute, Role Type, Rule, S3 Bucket, S3 File System, Schema, Standard, System, Table, Tableau Data Source, Tableau Project, Tableau Report Attribute, Tableau Server, Tableau Site, Tableau View, Tableau Workbook, Technology Asset, Validation Rule, Workflow DefinitionTextDescription From Source SystemThe description from the source system of the asset.Table, ColumnStringDescriptive Example An example of the asset.Asset, Business Asset, Business Process, Business Rule, Business Term, Code Set, Code Value, Data Asset, Data Attribute, Data Category, Data Element, Data Entity, Data Model, Data Quality Metric, Data Quality Rule, Data Structure, Directory, Governance Asset, Issue Category, KPI, Line of Business, Measure, Policy, Report, Role Type, Rule, Standard, System, Technology AssetTextDocument creation dateDate the document was created.Looker Dashboard, Looker Folder, Looker Look, Tableau Data Source, Tableau View, Tableau WorkbookDateDocument last accessed dateDate the document was last accessed.Looker Dashboard, Looker LookDateDocument last viewed dataDate the document was last viewed.Looker Dashboard, Looker LookDateDocument modification dateDate the document was last edited.Looker Look, Tableau Data Source, Tableau View, Tableau WorkbookDateDocument sizeSize of the document in megabytes.File, File Group, Tableau WorkbookNumericEffective End Date Date as of which an asset is scheduled to end.Business Rule, Code Set, Code Value, Data Quality Metric, Data Quality Rule, Data Usage, Governance Asset, Issue Category, Policy, RuleDateEffective Start DateDate on which asset takes effect.Business Rule, Code Set, Code Value, Data Quality Metric, Data Quality Rule, Data Usage, Governance Asset, Issue Category, Policy, RuleDateEmpty Values CountThe number of empty values for that columnColumnNumericEmpty values definition overrideOverrides the default list of values to consider as empty or missing values during data profiling. It must be a comma separated list of text values with each value enclosed in double quotes.Column, Schema, TableTextEntity Load Date The load date of the entities from the external system.Data Quality MetricTextException Scenario The exception scenario.Business Rule, Data Quality Metric, Data Quality Rule, Data Sharing Agreement, Governance Asset, Issue Category, Policy, Rule, StandardTextExternal System LabelThe label from external system.File, GCS Bucket, File ContainerStringFavorites countThe number of Looker Looks and Looker Dashboards that are marked as favorite.Looker Dashboard, Looker LookNumberFile LocationThe location of the original source file.File, SchemaTextFile TypeThe type of a File, which may constrain its format, its content or both.File, File GroupTextForeign Key Delete RuleWhat happens to the foreign key when primary is deleted.Foreign KeyTextForeign Key Evaluation DeferrabilityCan the evaluation of the foreign key constraints be deferred until commit.Foreign KeyTextForeign Key Update RuleWhat happens to foreign key when primary is updated.Foreign KeyTextFrequencyRate at which an asset changes over a particular period of time.Report, Report AttributeTextGlue Database NameThe name of the AWS Glue database in which this data is referenced and described.TableStringGlue Table NameThe name of the AWS Glue table in which this data is referenced and described.TableStringInclusion ScenarioThe inclusion scenarioBusiness Rule, Data Quality Metric, Data Quality Rule, Data Usage, Governance Asset, Issue Category, Policy, Report, Report Attribute, Rule, StandardTextInferred Data Type The data type of a data asset that was automatically inferred by profiling corresponding instance data. TextIs Auto IncrementedIndicates whether this column is auto incremented.ColumnTrue/FalseIs GeneratedIndicates whether this is a generated column.ColumnTrue/FalseIs MandatoryIs the asset mandatory or not.Data AttributeTrue/FalseIs NullableDetermines if the column can store NULL values.ColumnTrue/False Is Primary KeyIndicates if the column is a primary key.ColumnTrue/FalseIs Unique If the asset is unique or not. Data AttributeTrue/FalseIT Requirements Describes the requirements from an IT perspective for the asset.Crosswalk, Mapping SpecificationTextKey sequence Key Sequence of an element in a foreign key NumericLast Review DateDate on which asset was last reviewed.Code Set, Data Usage, Report, Report Attribute, StandardDateLast Sync DateDate on which asset was synchronized with external system.Code Set, Code Value, Database, Data Quality Metric, FileDateLicenseThe current license. Data SetTextLoaded RowsThe number of rows that were loaded.Business Rule, Data Quality MetricNumericLoaded ValuesThe number of values that were loaded. NumericLoad Sample A sample. TextLocation The location where the actual asset is stored or can be found. Asset, Code Set, Code Value, Data Asset, Data Attribute, Database, Data Element, Data Entity, Data Model, Data Structure, Directory, Report, Report Attribute, Role Type, S3 Bucket, System, Technology AssetTextMateriality The materiality. Data UsageTextMaximum Text LengthThe length of the longest text value in this columnColumnNumericMaximum ValueThe maximum value, using alphabetical order for textColumnTextMax Length The maximum length of any value corresponding to the data asset. NumericMeanThe mean of values (numeric only), excluding missing valuesColumnNumericMeasurement The measurement of the asset.Business Rule, Data Quality Rule, Governance Asset, Issue Category, Policy, RuleNumericMedianThe data median valueColumnTextMinimum Text LengthThe length of the shortest text value in this columnColumnNumericMinimum ValueThe minimum value, using alphabetical order for textColumnTextMin Length The minimum length of any value corresponding to the data asset. NumericModeThe value with the highest frequency for a categorical feature.ColumnTextNon Conformity ScoreThe amount of rows that failed the rule.Business Rule, Data Quality MetricNumericNote A note.Asset, Business Asset, Business Process, Business Rule, Business Term, Code Set, Code Value, Data Asset, Data Attribute, Database, Data Category, Data Element, Data Entity, Data Model, Data Quality Rule, Data Structure, Directory, File, KPI, Line of Business, Measure, Policy, Report Attribute, Role Type, Standard, System, Technology AssetTextNull CountThe number of null values in the data corresponding to the data asset. NumericNumber of Attributes The number of attributes of the data entity. NumericNumber of distinct valuesThe number of different values stored in this columnColumnNumericNumber of FilesThe number of files in a File Group.File GroupNumericNumber Of Fractional DigitsThe number of fractional digits.ColumnNumericNumber of ValuesThe number of distinct instance values in the data corresponding to the data asset. NumericOriginal NameName of this object in its source environment. The 'Original Name' may differ from the asset's name in Data Governance Center.Column, Tableau Data Source, Tableau Project, Tableau Report Attribute, Tableau Site, Tableau View, Tableau WorkbookTextOwner in sourceThe email address of the owner of the data objects in a data source, represented in Collibra by the asset types mentioned here.Looker Dashboard, Looker Folder, Looker Look, Power BI Data Model, Power BI Report, Power BI Workspace, Tableau Project, Tableau Data Model, Tableau Workbook, Tableau DashboardTextPassing Fraction The % of rows or entities that have passed the rule.Business Rule, Data Quality MetricNumericPersonally Identifiable InformationAn indicator to flag an asset that could potentially be used to identify a specific individual.ColumnTrue/FalsePredicate The logical formula that will be executed to implement the rule.Data Quality RuleTextPrimary Key NameThe name of the primary key composed by the column.ColumnTextPriority The priority of this issue. IssueTextProfiled Row CountThe number of rows from the data set that were selected for profiling. NumericProfiling InformationProvides additional information related to the status of the profiling results.TableTextPurpose The reason why the asset exists. Business Rule, Data Sharing Agreement, Data Usage, File, Governance Asset, Issue Category, Policy, Rule, StandardTextRatingThe current rating. NumericRefresh ConflictProvides the information about the conflict detected on the Data Asset during a Schema refresh if any.Column, TableTextRefresh FrequencyThe frequency of refresh. TextReport ImageImage of the report viewLooker Look, Tableau View, Tableau WorkbookTextResolution The solution of how this issue can or is resolved. Issue TextResult The result. Business Rule, Data Quality MetricTrue/FalseRoleRelationship name from head to tail. TextRole in ReportThe use of Report Attribute in Report (for example, measure or dimension)Tableau Report AttributeTextRow CountThe number of rows inside the data set, possibly including duplicated or missing valuesColumnNumericRows Failed The amount of rows that failed the rule.Data Quality MetricNumericRows Passed The amount of rows that passed the rule.Data Quality MetricNumericRuleThe description of the rule. TextSchema Name The name of the schema.TextScopeThe scope of applications that correspond to this policy.Crosswalk, Database, Data Usage, Directory, Mapping Specification, Policy, Report, Report Attribute, System, Technology AssetTextSecurity ClassificationClassification of assets based on sensitivity.Column, Data Usage, Report, Report AttributeTextSequence Number The sequence number of the asset. Often used to order assets in a specific way. Data AttributeNumericSizeThe size of the column in the table.ColumnNumericSource Type The source type of an asset. TextSource TagsThe tags assigned to the asset in the source system. For more information, go to Register a data source via Edge.Schema, Table, Database View, ColumnTextStandard DeviationThe statistical standard deviation of values (numeric only)ColumnNumericStart DateThe date on which the assessment was started.Assessment ReviewDateState The current state. Text State Changed byThe cause of the state change.Power BI WorkspaceTextState Changed Date The date the state was changed. Data Sharing AgreementTextSubmission DateThe date on which the assessment was submitted.Assessment ReviewDateSynchronization StatusProvides information about the status of the Schema synchronization.SchemaTextTable TypeThe table type that is declared in the data source. For example: TABLE, VIEW, ...TableTextTechnical Data TypeThe Data Type of a data asset as it is declared by the data source. For example: String, Integer, Varchar, Blob, Boolean, ...Column, Data Attribute, Data Element, Report Attribute, Power BI Column, Tableau Report AttributeTextThreshold The minimum percentage of all rows or entities that must pass the rule.Data Quality MetricNumericTransformation Logic The transformation logic. TextURLUniform Resource Locator, also colloquially known as web address.Directory, File, File Group, Looker Look, S3 Bucket, Tableau Server, Tableau Site, Tableau ViewTextValidation Result The results of validation. True/FalseValidation ScriptContains the validation logic to evaluate the content of an asset.Validation RuleScript  Value DistributionThe distribution percentage of the valuesNumericVarianceThe statistical variance of values (numeric only)ColumnNumericVisible on serverWorksheet is uploaded to Tableau server.Tableau ViewTrue/FalseVisits countNumber of visits on Tableau reportLooker Dashboard, Looker Look, Tableau ViewNumericWeighting FactorA factor by which some quantity is multiplied in order to make it comparable with others. NumericCreate an attribute typeYou can create an attribute type. For example, if the packaged attributes types do not meet your needs.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Characteristics → Attributes.  Above the table, to the right, click Add.The Create Attribute Type dialog box appears.Enter the required information.FieldDescriptionNameThe name of the object.The name of the attribute type must be globally unique.You can simultaneously create multiple objects. To do so, after typing the name, press Enter, and then type the next name. If you enter a name that already exists, it appears in the strike-through style.DescriptionThe description of the object. This field is optional.KindThe kind of information that attribute of this type can contain, for example, date, number or selection.DateA date value. If you edit attributes of this type, you can pick a date using the date selector.The date format that is displayed in the UI, can be different depending on the language settings in your user profile. For example, dd/mm/yyyy or yyyy/mm/dd.Multiple SelectionA field that allows multiple values that you can select from a predefined list.with valuesThe values from which you can select one or more.NumberA number, or a number with a fraction.Only integers. (..., -2, -1, 0, 1, 2, ...)Checkbox to only allow integer numbers.Numeric values are stored as Floating Point values (IEEE 754 standard), which are not able to represent all numbers accurately. Due to this technical constraint, rounding issues occur for both negative and positive numbers. The bigger the number, the more noticeable the rounding issue. MetricCheckbox to make this attribute type a metric. This allows you to assign this attribute type as a metric when you create a data quality rule.SelectionA field that allows a single value that you can select from a predefined list.with valuesThe values from which you can select one.TextTextual input which may contain formatting.Plain TextCheckbox to disable formatting.True/FalseA binary option that allows you to indicate whether something is true or false.MetricCheckbox to make this attribute type a metric. This allows you to assign this attribute type as a metric when you create a data quality rule.Click Save.What's next?You can now assign the attribute type to an asset type.Edit an attribute typeYou can edit the name and description of an attribute type. You can't edit the attribute type's kind.If you want to edit an attribute type's kind, you have to delete the attribute type first and then create a new one. Keep in mind that the new attribute type will have a new ID.PrerequisitesYou have a global role that has the System administration global permission.If you delete an attribute value from an attribute type of the Selection or Multiple Selection kind, then you can no longer edit the values of the attributes of that type without removing those invalid values. We recommend that you remove invalid attribute values from the attributes before removing them from the attribute type. Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Attributes.The table with attribute types appears.In the table, double-click a name or description field.Type the new name or description.  Click .  Delete an attribute typeYou can delete custom attribute types. You cannot delete packaged attribute types.PrerequisitesYou have a global role that has the System administration global permission.The attribute type is not a packaged attribute type.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Attributes.The table with attribute types appears.At the end of the row of the attribute type that you want to delete, click .The Delete <attribute type> dialog box appears.Click Yes.Relation typesA relation is a characteristic that describes how two assets relate to each other. The relation's type defines the relation and determines which assets can be related. About relation typesA relation is a characteristic that describes how two assets relate to each other. The relation's type defines the relation and determines which assets can be related. You can add a relation between assets if the relation's type is in the relevant assignment of the asset's type.Elements in a relation typeA relation type has four elements:ElementDescriptionHeadAsset type of assets that can be the head of the relation. TailAsset type of assets that can be the tail of the relation. RoleThe description of the relation type going from the head asset to the tail asset.Co-role The description of the relation type going from the tail asset to the head asset.Relations are bidirectional. For example, in the relation type Table is part of/contains Database, the Table asset is part of the Database asset, and the Database asset contains the Table asset.Overview of packaged relation typesA relation is a characteristic that describes how two assets relate to each other. The relation's type defines the relation and determines which assets can be related. The following table shows packaged relation types. You can also create new relation types.role is the description of the relation type going from the head asset type to the tail asset type.co-role is the description of the relation type going from the tail asset type to the head asset type.This is a table of all packaged relation types. For a sortable overview of all packaged relation types, see the online version of this information in the Documentation Center.HeadRoleCo-roleTailAssetcomplies toapplies toGovernance AssetAssetgoverned bygovernsGovernance AssetAssetis essential forrequiresData UsageAssetrelated toimpacted byAssetAssetspecializesgeneralizesAssetAssetusesused inAssetBusiness Assetgroupsgrouped byBusiness AssetBusiness Assethas acronymis acronym forAcronymBusiness Assetrepresentsrepresented byData AssetBusiness Dimensionclassifiesis classified byAssetBusiness Dimensiongroupsis grouped intoReportBusiness Dimensionsourceis source ofSystemBusiness Processconsumesis consumed byBusiness AssetBusiness Processproducesis produced byBusiness AssetBusiness Termallowed valueallowed value ofBusiness TermBusiness Termhas codeis code forCode ValueBusiness Termsynonymsynonym ofBusiness TermCode Setsource ofsourceCrosswalkCode Settarget oftargetCrosswalkCode Valuegroupsgrouped byCode ValueCode Valueis part ofcontainsCode SetColumnis part ofcontainsTableData Assetgroupsis grouped byData AssetData Assetimplemented inimplementsTechnology AssetData Assetis essential foris constrained byData UsageData Elementallowed valueallowed value forCode ValueData Elementallowed value setapplies toCode SetData Elementis part ofcontainsData StructureData Entitycontainsis part ofData AttributeData Entityis part ofcontainsData ModelData Quality Ruleallowed valueallowed value forCode ValueData Quality Ruleallowed value setallowed value set forCode SetData Quality Ruleclassified byclassifiesData Quality DimensionData Quality Ruleexecuted byexecutesData Quality MetricData Quality Rulegovernsis governed byData ElementData Setcontainsis part ofData ElementData Setrelated toimpacted byBusiness AssetData Sharing Agreementis requested byrequestsBusiness DimensionData Structuresource ofsourceMapping SpecificationData Structuretarget oftargetMapping SpecificationData Usageis required byrequiresData Sharing AgreementDirectorycontainsis part ofDirectoryDirectorycontainsis part ofFile GroupFilecontainsis part ofTableFile Containercontainsis contained inFileFile Containercontainsis part ofFile ContainerFile Groupcontainsis part ofTableFile Storagecontainsis part ofFile ContainerGovernance Assetgroupsis grouped byGovernance AssetGovernance Assetresolvesresolved byIssueGovernance Assetviolated byviolatesIssueIssuecategorized bycategorizesIssue CategoryIssuehas duplicateis duplicate forIssueIssueimpactsimpacted byAssetLine of Businessassociatesis associated withBusiness AssetPolicyis enforced byenforcesRuleReportgroupsis grouped intoReportReportrelated tois impacted byBusiness AssetReportusesused inReportReport Attributecontained incontainsReportReport Attributeis source foris target ofReport AttributeRole Typeis responsible foris responsibility ofAssetRuleis implemented byimplementsBusiness RuleSchemacontainsis part ofTableServerhostsis hosted inBusiness DimensionStandardis included inincludesPolicySystemimplementsis implemented inData SetTableis input forhas inputTransformation RuleTableis part ofcontainsDatabaseTableau Siteassemblesis assembled inTableau ProjectTechnology Assetgroupsis grouped byTechnology AssetTechnology Assethasbelongs toSchemaTechnology Assetsource system forsource systemBusiness TermTechnology Assetsource system forsource systemData AssetTechnology Assetsystem of record forsystem of recordBusiness TermTechnology Assetsystem of record forsystem of recordData AssetTechnology Assetsystem of use forsystem of useBusiness TermTechnology Assetsystem of use forsystem of useData AssetTransformation Ruleis input forhas inputTransformation RuleTransformation Ruleproducesis produced byTableCreate a relation typeYou can create a new relation type if, for example, the packaged relation types do not meet your needs.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Relations.Above the table, to the right, click Add.The Create relation type dialog box appears.Enter the required information.ElementDescriptionHeadAsset type of assets that can be the head of the relation. TailAsset type of assets that can be the tail of the relation. RoleThe description of the relation type going from the head asset to the tail asset.Co-role The description of the relation type going from the tail asset to the head asset.The combination of the relation type's head, tail, role, and co-role has to be globally unique.Click Create.ExampleThe following example creates a part-whole relation type between two assets: Data Element is part of / contains Data Structure.What's next?You can now assign the relation type to an asset type and after that add a relation to an asset.Edit relation typesYou can edit a relation type by changing the role or co-role of a relation type or its description.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Relations.In the row of the relation type that you want to edit, click at the end of the Role or Co-role column.Enter the required information and click .The relation type is edited.The combination of the relation type's head, tail, role, and co-role has to be globally unique.Delete a relation typeYou can delete a relation type that you created yourself. However, you can't delete packaged complex relation types.PrerequisitesYou have a global role that has the System administration global permission.The relation type is not a packaged relation type.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Relations.In the row of the relation type that you want to delete, click .     The Delete <relation type> dialog box is shown.If a dialog box appears, click Yes.The relation type is deleted.Complex relation types A complex relation is a characteristic that describes how two or more assets relate to each other. It can also have attributes of its own, for example, Description and Priority. Technically, they are objectified associations: simplified assets that cannot exist independently. The complex relation's type defines the relations and attributes the complex relation can have.About complex relation typesA complex relation is a characteristic that describes how two or more assets relate to each other. It can also have attributes of its own, for example, Description and Priority. Technically, they are objectified associations: simplified assets that cannot exist independently. The complex relation's type defines the relations and attributes the complex relation can have.You can add a complex relation between assets if the complex relation's type is in the relevant assignment of the asset's type.A complex relation cannot have more than 32,767 relations to assets.ExampleWhen you add a complex relation, you add one or more relations between the assets and the complex relation itself. The assets of those relations are always the head of the relation, while the complex relation is always the tail.The following example creates a complex relation type called Code Mapping, with three relation types (source, target and crosswalk) and two attribute types (Description and Transformation Logic).For each relation type in the complex relation type, you can select head assets. Above the fields, you can see the minimum and maximum occurrences for each relation type. For each selected head asset, a relation of the relevant type is created between the head asset and the complex relation. You can also add attributes to the complex relation.Cardinality of relation types and attribute types in complex relation typesWith complex relations, you can associate two or more assets in a relation and add attributes to the complex relation. When you create a complex relation type, you set the cardinality of the relation types and attribute types to determine how many relations and attributes you can or must provide when you create a complex relation of that type.For every complex relation type, at least one relation type must have a minimum cardinality of 1 or greater. Overview of packaged complex relation typesA complex relation is a characteristic that describes how two or more assets relate to each other. It can also have attributes of its own, for example, Description and Priority. Technically, they are objectified associations: simplified assets that cannot exist independently. The complex relation's type defines the relations and attributes the complex relation can have.The table below contains all packaged complex relation types. You can also create new complex relation types.NameDescriptionRelation typesAttribute typesAssigned asset typesCode Mapping Complex mapping between two or more code values Source - Code Value (1:-)Description (0:1)Transformation Logic (0:1)Code ValueCrosswalk Target - Code Value (1:-)Crosswalk - Crosswalk (1: 1)Data Usage Data UsageUses - Data Asset (1:-)Description (0:1) Materiality (0:1)  Used in - Business Asset (1:-)Governed by - Rule (1:-)Fact Type Head - Asset (1: 1) Role (1:-) Co-role (1:-) Tail - Asset (1: 1)Field Mapping Complex mapping between two or more data fields Source - Data Element (1:-)Description (0:1) Transformation Logic (0:1)ColumnData AttributeData ElementFieldMapping SpecificationReport Attribute Target - Data Element (1:-)Mapping specification - Mapping Specification (1: 1)Foreign Key MappingComplex mapping between two columns representing a primary key and a foreign keyConstrains - Column (1: 1)Key sequence (1:1)ColumnForeign Key References - Column (1: 1)Is part of - Foreign Key (1: 1)Create a complex relation typeYou can create a complex relation type. For example, if the packaged complex relation types do not meet your needs.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Complex Relations.Above the table, to the right, click Add.The Create complex relation type dialog box appears.Enter the required information.FieldDescriptionNameThe name of the complex relation type.The name of the complex relation type must be globally unique.DescriptionThe description of the complex relation type.Display optionsThese fields allow you to edit how complex relations of this type are represented in diagrams.ColorThe default colors that you can use for the complex relation nodes of this type.Color hex valueThe hexadecimal value of the color that you want for complex relations of this type.For a list of colors and their hexadecimal values, see ColorHexa.SymbolA graphical representation for complex relations of this type.You can choose one of the following values:None: No graphical representation is used for complex relations of this type.Code: Complex relations of this type are represented with a code in front of them. You can specify the code that you want in the Code field.Icon: Complex relations of this type are represented with an icon in front of them. You can select the icon that you want in the Icon reference field.CodeThe code that is displayed in front of complex relations of this type. This code is also displayed in the legend of diagrams. This field is only displayed if you have selected Code in the Symbol field.Icon referenceThe icon that is displayed in front of complex relations of this type. This icon is also displayed in the legend of diagrams.This field is only displayed if you have selected Icon in the Symbol field.PreviewTwo previews of the representation of complex relations of this type:The left preview is the title bar on a complex relation page.The right preview is a diagram node.RelationsThe relation types of the complex relation type. At least one relation type is required.RoleThe description of the relation type going from the head asset to the tail asset.Co-roleThe description of the relation type going from the tail asset to the head asset.Asset typeThe asset type of the head of the relation. The complex relation type can only be used by assets of this asset type or its children if the complex relation type is in the asset type's assignment.The complex relation is always the tail of the complex relation type.Min.The minimum amount of relations of this type.You must have at least one relation with a minimum cardinality of 1 or greater.Max.The maximum amount of relations of this type.AttributesThe attribute types of the complex relation type. Attribute TypeThe attribute type used by this complex relation type.Min.The minimum amount of attributes of this type.Max.The maximum amount of attributes of this type.Click Save.What's next?You can now assign the complex relation type to an asset type and after that add a complex relation to an asset.Edit a complex relation typeYou can edit the name, description and display options of a complex relation type. You can't edit existing relations and attributes in the complex relation, but you can add relations and attributes to the complex relation type.If you want to edit the relations or attributes of a complex relation type, you have to delete the complex relation type first and then create a new one. Keep in mind that the new complex relation type will have a new ID.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Complex Relations.In the row of the complex relation type that you want to edit, click .The Edit complex relation dialog box appears.Enter the required information.FieldDescriptionNameThe name of the complex relation type.The name of the complex relation type must be globally unique.DescriptionThe description of the complex relation type.Display optionsThese fields allow you to edit how complex relations of this type are represented in diagrams.ColorThe default colors that you can use for the complex relation nodes of this type.Color hex valueThe hexadecimal value of the color that you want for complex relations of this type.For a list of colors and their hexadecimal values, see ColorHexa.SymbolA graphical representation for complex relations of this type.You can choose one of the following values:None: No graphical representation is used for complex relations of this type.Code: Complex relations of this type are represented with a code in front of them. You can specify the code that you want in the Code field.Icon: Complex relations of this type are represented with an icon in front of them. You can select the icon that you want in the Icon reference field.CodeThe code that is displayed in front of complex relations of this type. This code is also displayed in the legend of diagrams. This field is only displayed if you have selected Code in the Symbol field.Icon referenceThe icon that is displayed in front of complex relations of this type. This icon is also displayed in the legend of diagrams.This field is only displayed if you have selected Icon in the Symbol field.PreviewTwo previews of the representation of complex relations of this type:The left preview is the title bar on a complex relation page.The right preview is a diagram node.RelationsThe relation types of the complex relation type. At least one relation type is required.RoleThe description of the relation type going from the head asset to the tail asset.Co-roleThe description of the relation type going from the tail asset to the head asset.Asset typeThe asset type of the head of the relation. The complex relation type can only be used by assets of this asset type or its children if the complex relation type is in the asset type's assignment.The complex relation is always the tail of the complex relation type.Min.The minimum amount of relations of this type.You must have at least one relation with a minimum cardinality of 1 or greater.Max.The maximum amount of relations of this type.AttributesThe attribute types of the complex relation type. Attribute TypeThe attribute type used by this complex relation type.Min.The minimum amount of attributes of this type.Max.The maximum amount of attributes of this type.Click Save.Delete a complex relation typeYou can delete custom complex relation types. However, you can't delete packaged complex relation types.PrerequisitesYou have a global role that has the System administration global permission.The complex relation type is not a packaged complex relation type.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Characteristics → Complex Relations.In the row of the complex relation type that you want to delete, click .      The Delete <complex relation type> dialog appears.Click Yes.The complex relation type is deleted.
	 Domain typesA domain type is a property of a domain that determines which assets can be included in the domain, based the asset's type.Some asset types can only be created in a specific Collibra application and in a specific domain type. For example, you can only create assets of the Validation Rule type in a domain of the Validation Rule Domain type. You can see the required domain type in the assignment of the asset type.Overview of packaged domain typesA domain type is a property of a domain that determines which assets can be included in the domain, based the asset's type.The table below contains all packaged domain types and their description. You can find out about domain types that are not packaged on their dedicated pages, such as Process Register, which is part of Data Privacy. For an interactive overview of all packaged domain types, including the relevant asset types and applications, see the online version of this documentation.TypeTypeDescriptionBI CatalogBI CatalogA collection of Tableau assets with the list of related attributes.Business Asset DomainBusiness Asset Domain Business Dimensions Business Asset Domain Business Dimensions A set of business dimensions that categorize and describe business terms.Report CatalogBusiness Asset Domain Report CatalogA collection of reports and their definitions with the list of related report characteristics.CodelistCodelistAny kind of data that is used solely to categorize other data found in a database, or solely for relating data in a database to information beyond the boundaries of the enterprise.HierarchiesCodelist HierarchiesA Code list with a hierarchical structure in its Code ValuesData Asset DomainData Asset Domain Data Usage RegistryData Asset Domain Data Usage RegistryA collection of data usage agreements and related data structures.Logical Data DictionaryData Asset Domain Logical Data DictionaryRepresents details of organizational data, independent of any particular technology, and uses vocabulary of a business area to communicate with non-technical stakeholders.Mapping DomainData Asset Domain Mapping DomainGroups data assets of the crosswalk type (to map between code sets) and mapping specification (used to map between data structures).Physical Data DictionaryData Asset Domain Physical Data DictionaryA collection of physical objects, such as tables, columns, file fields, views and APIs, to describe how data is stored, arranged and related to each other in a data storage technology/location.GlossaryGlossaryA prioritized list of business terms and acronyms, and their meanings.Governance Asset DomainGovernance Asset Domain Assessment Review RegisterData Governance Domain Assessment Review RegisterDomain type for Assessment Review assets, which are created when an assessment is conducted on an asset and submitted for review.Policy DomainData Governance Domain Policy DomainA set of polices and standards related to an organization.RulebookData Governance Domain RulebookA set of rules that are used as a basis for making decisions and governing programs or policies.Issue ClassificationIssue Classification Storage CatalogStorage CatalogA domain type that contains assets of the asset type S3 File System or GCS File System.Technology Asset DomainTechnology Asset DomainAn inventory of all technology assets and their business benefits.Validation Rule DomainValidation Rule DomainA domain type for domains containing validation rules.Create a domain typeYou can create new domain types.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Domain Types.The domain type table appears.Above the table, to the right, click Add.The Domain Type Creation dialog box appears.Enter the required information.OptionDescriptionNameType a name for the domain type.You can enter more than one value at a time. To do this, press Enter after typing a value and then type the next.Parent TypeSelect the parent domain type.Click Create.Edit a domain typeYou can edit the name and the description of a domain type in the domain type table.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Domain Types.The domain type table appears.In the Name or Description column, do one of the following:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears.Edit the name or description.Click . Move a domain typeYou can move a domain type to another parent domain type in the domain type table.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Domain Types.The domain type table appears.At the end of a row, click .The Select Parent Domain Type dialog box appears.Enter the required information.FieldDescriptionParent typeSelect the new parent type of the domain type.Click Save. Delete a domain typeYou can delete a domain type in the domain type table.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Domain Types.The domain type table appears.At the end of a row, click .The Delete <domain type> dialog box appears.Click Yes.
	 Asset statusesThe status indicates the condition of an asset or workflow.Overview of packaged statusesUse statuses to reflect the life cycle of resources. The following statuses can be used out of the box in your workflows.StatusDescription          Use          AcceptedThe stewards approved an asset definition.The technical stewards are granting the requested access.The reviewer is appointing an assignee to resolve an issue.An asset is accepted at the end of the Approval and Simple Approval workflows.A data usage asset is accepted when the approvers, who are the owners of the resources that are part of an access request, have approved the request in the Request Assets Access workflow.An issue is accepted after the stewards approved its proposed solution. At this stage of the Issue Management workflow, the reviewer either appoints an assignee or marks the issue as resolved.Access GrantedThe requester has been granted access to the requested resources.The requester is assigned a Data Analyst Level 2 role for the newly granted resources, as the final step in the Request Assets Access workflow.Approval PendingThe approvers are voting for the approval of a data usage request.A data usage asset has this status during the voting sub-process of the Request Assets Access workflow.Approved Currently not in use.CandidateThe initial status of an asset.Newly created assets receive this status.DeployedThe initial status of a workflow.Refers to workflow definitions.DisabledThe workflow is currently not in use.Refers to workflow definitions.EnabledThe workflow is currently active.Refers to workflow definitions.Implemented Currently not in use.In ProgressThe assignee is solving the issue.The status is used in the Issue Management workflow.InvalidThe reviewer rejected an issue.The initial status of a data usage asset.Reviewers can reject invalid issues during the Issue Management workflow.Newly created data usage requests receive this status in the Request Assets Access workflow.Monitored Currently not in use.NewThe initial status of an issue.Newly created issues receive this status.Obsolete Currently not in use.PendingThe requester is providing more information about an issue.The status is used in the Issue Management workflow.RejectedThe approvers rejected the data usage request.The status is used in the Request Assets Access workflow.Resolution PendingThe reviewer is validating the asignee's solution to an issue. ResolvedThe issue is resolved.The status is used in the Issue Management workflow.Reviewed Currently not in use.Submitted for ApprovalThe stakeholders are verifying the proposed solution to an issue.The status is used in the Issue Management workflow.Under ReviewThe stakeholders are reviewing an asset.The reviewer is analyzing an issue and proposing a solution.An asset is under review from the moment the subject matter experts have approved its definition until it is accepted in the Approval workflow. There is no intermediary status in the Simple Approval workflow.After being submitted or after being rejected by the stakeholders, an issue is under review while a reviewer analyzes it, in the Issue Management workflow.Create a statusCollibra Data Intelligence Cloud comes out of the box with a large number of statuses for all the resources, for example assets and workflow tasks.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Statuses.  Above the table, to the right, click Add.Type the name for the status.You can create multiple statuses at once by pressing Enter and type another name.Statuses that already exist appear in strike-through format.Click Create.Edit a statusYou can edit the name and the description of a status. If you enter a description, it appears as a tooltip next the status on asset pages. You can use this to give more details about the status to other users.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Statuses.  Do one of the following in the Name or Description column:Double-click a cell.Hover your mouse over a cell and click .The cell editor appears. Enter the new name or description.  Click .  Delete a statusYou can delete a status if is no longer used in any kind of workflow.Enabled, Disabled and Deployed are system resources. They are specific to describe workflows and cannot be deleted.PrerequisitesYou have a global role that has the System administration global permission.The status that you want to delete is not used by any asset.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.    In the tab pane, click   Statuses.  On the right of the status you want to delete, click .The Delete dialog box appears.Click Yes. The status is deleted.
	 Articulation scoreThe articulation score of an asset is a percentage that indicates how complete the asset is according to the articulation score rules. It is typically used to give you a quick estimation of the status of the asset and whether the most important characteristics are present.The score is shown in the title bar of the asset page, a column in a table or as a field on a tile. In this section you will learn more about how the articulation score is calculated and how you can manage the articulation score rules.Articulation scoresThe articulation score of an asset is a percentage that indicates how complete the asset is according to the articulation score rules. It is typically used to give you a quick estimation of the status of the asset and whether the most important characteristics are present.You can configure an articulation score calculator that contains your own rules. Whenever an asset is edited, either manually or via a workflow, the articulation score is reset to 0 and the articulation score rules are executed in their specific order.The score is shown in the title bar of the asset page, a column in a table or as a field on a tile. You may have to refresh the page after you edited the asset to see the new score.If you edited the articulation rules or their assignment, the articulation score of the assets to which it is assigned does not recalculate. You still need to edit each asset to trigger recalculation of the articulation score.Articulation score rulesAn articulation rule consists of a number of fields that determine when a rule applies and what the result is.The Condition field and the subsequent Status or Characteristic field determine when a rule applies. These fields allow your rule to look for a specific status or a specific characteristic. Having multiple instances of the same characteristic, for example, two notes, does not apply the rule more than once.The Score and Value fields determine what the effect of the articulation rule is. You can either increase the score, or set the score to a specific value.'Increasing the score' means that the value will be added to the percentage that was received from the other rules. It does not increase the score of the asset before it was edited.If a rule sets the score to a specific value, all previous rules effectively become useless.ExampleSuppose this is the articulation score calculator:1ConditionCharacteristic addedCharacteristicDefinitionScoreIncrease score byValue332ConditionStatus set toStatusCandidateScoreSets score toValue03ConditionStatus set toStatusIn progressScoreSets score toValue104ConditionStatus set toStatusUnder reviewScoreSets score toValue505ConditionStatus set toStatusReviewedScoreSets score toValue806ConditionStatus set toStatusAcceptedScoreSets score toValue1007ConditionCharacteristic addedCharacteristicNoteScoreIncrease score byValue22A business term has the following attributes:Status: In progressA definitionA noteArticulation score: 32%Articulation score rule 1 matches and adds 33%.Current score: 33%Articulation score rule 2 does not match.Articulation score rule 3 matches and sets the score to 10%.Current score: 10%Articulation score rule 4 does not match.Articulation score rule 5 does not match.Articulation score rule 6 does not match.Articulation score rule 7 matches and adds 22%Final articulation score: 32%A second note is added, the definition is deleted and the status of the business term is changed to Reviewed. It now has the following attributes:Status: ReviewedTwo notesArticulation score: 100%Articulation score rule 1 does not match.Articulation score rule 2 does not match.Articulation score rule 3 does not match.Articulation score rule 4 does not match.Articulation score rule 5 matches and adds 80%.Current score: 80%Articulation score rule 6 does not match.Articulation score rule 7 matches and adds 22%Final articulation score: 100%Create an articulation score ruleYou can create a new articulation score rule. For example, you can do this if you want to give users a quick indication about the completeness of an asset.Steps    Open the scope of an asset type.    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.        Click the name of an asset type.          In the tab pane, click   <name of the scope>, then click Articulation.The default scope is Global assignment. Above the table, to the right, click Edit.Above the table, to the right, click Add rule.A new row for an articulation rule appears at the bottom of the list.Enter the required information.FieldDescriptionConditionThe condition of the articulation rule that determines when the rule applies.Status set to: The score depends on a specific status of an asset.Characteristic added: The score depends on a specific characteristic of an asset.StatusThe specific status that an asset must have for the rule to apply.This field only appears if the Condition is Status set to.CharacteristicThe specific characteristic that an asset must have for the rule to apply.This field only appears if the Condition is Characteristic added.ScoreThe impact on the score if an asset meets the condition and status or characteristic.increase score by: Adds a value to the articulation scoresets score to: Sets the articulation score to a specific value. As a consequence, the previous score and the previous rules are discarded.ValueThe value that is used by the rule.Click Save.ExampleTo specify that adding an attribute adds 20 % to the calculation score, configure the following:Result: The articulation calculator is added to the articulation table and is assigned to the given asset types.Edit an articulation score rule    You can delete an articulation score rule. For example, you can do this if you want to increase the importance of a certain attribute type on the articulation score.Steps    Open the scope of an asset type.    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.        Click the name of an asset type.          In the tab pane, click   <name of the scope>, then click Articulation.Above the table, to the right, click Edit.Enter the required information.FieldDescriptionConditionThe condition of the articulation rule that determines when the rule applies.Status set to: The score depends on a specific status of an asset.Characteristic added: The score depends on a specific characteristic of an asset.StatusThe specific status that an asset must have for the rule to apply.This field only appears if the Condition is Status set to.CharacteristicThe specific characteristic that an asset must have for the rule to apply.This field only appears if the Condition is Characteristic added.ScoreThe impact on the score if an asset meets the condition and status or characteristic.increase score by: Adds a value to the articulation scoresets score to: Sets the articulation score to a specific value. As a consequence, the previous score and the previous rules are discarded.ValueThe value that is used by the rule.Click Save.Delete an articulation score rule    You can delete an articulation score rule. For example, you can do this if you no longer need an existing articulation score rule.Steps    Open the scope of an asset type.    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.        Click the name of an asset type.          In the tab pane, click   <name of the scope>, then click Articulation.Above the table, to the right, click Edit.Click next to the rule that you want to delete.Click Save.
	 Asset data qualityThe Quality page of an asset makes data quality results of an asset available to the business stakeholders. The dashboard aggregates the following values:Collected over time on attributes.Aggregated from different assets along a number of predefined relations.The assets for which these data quality dashboards are available and how the values are aggregated are defined in data quality rules, which can be edited on the Data Quality Rule tab on the Settings page. For the following examples, a data quality rule exists on business terms, aggregating values from data quality rules related to these business terms.Asset qualityThe assets for which the quality dashboard is available have an extra option in their tab menu, namely Quality. The dashboard displays the aggregated passing fraction (quality score) for the asset in the form of ring charts.Each ring chart shows the quality score in the form of:A quality score as a percentage.A color code indicating the quality of this passing fraction:Red: 0-50%Orange: 50-85%Green: 85 - 100%An arrow indicating the trend of the score compared to the previous measurement.The first ring chart shows the general score of the asset. The ring charts next to it show subscores for a specific dimension, such as Accuracy, Conformity, Completeness and Consistency. Only values that belong to that specific dimension are then taken into account. The dimensions to use are configured in the metric group. In this example, it is the relation: Data Quality Rule is Classified By  Data Quality Dimension.Underneath the top pane, three selection boxes are available. They display an extra overview, details and history pane, respectively.To close a pane, click  in the upper-right corner of the pane.Data quality overview paneThe Overview pane shows more information about each level in the aggregation path for the selected general score or dimension. For each level, it shows the number of involved assets of a certain type and what their results are: failing (red) or passing (gray). It also shows the total number of rows, the number of failing rows (red) and the number of passing rows (gray) that resulted in the given scores.In the following example, the Conformity dimension consists of a total of 38 070 rows, 26 575 of which were failing. Two Data Quality Rules were involved, one of which was failing. And these Data Quality Rules were used by one Data Entity, which has an aggregated failing result.Asset quality details paneThe Details pane shows more information about all the assets involved in a table format.For each asset, a row with the following default columns is shown:Data Asset: The data asset signifierRows Passed: The number of passing rows, aggregated as a sum of the passing rows of the underlying assetsRows Failed: The number of failing rows, aggregated as a sum of the failing rows of the underlying assetsQuality Score: The score aggregated as an average of the quality scores of the underlying assetsResult (failing or passing): The aggregated result as a logical conjunction of the results of the underlying assets.Some extra columns can be displayed in this table by clicking → Columns.These include:Full name: The unique full name of the asset.Domain: The domain to which the asset belongs.Type: The type of the asset.Dimension: The dimension that applies to these assets, if any. Dimensions are used to calculate the subscores, as mentioned earlier.Asset quality historyThe History pane shows the evolution of the quality score over time, for up to one month in the past.You can display the date and the score for a specific period at the top right of the pane by hovering your pointer over that period.When you select a period by clicking on it, the top left corner of the pane shows a trend of the score compared to the period before it.Data quality rulesData quality rules are rules that calculate the quality of a certain asset based on a predefined aggregation path and metrics. The results of a data quality rule are available in a data quality dashboard on the asset page of assets of the type to which you assigned the data quality rule.Data quality and report certificationData quality is an important aspect of report certification. However, we understand that not all organizations are at a stage in their governance program where data quality is fully enabled.When you are certifying a report, the last step of the Certify Report workflow involves a data quality check to ensure:The report contains data attributes.All columns have positive data quality metrics.Data quality is a mandatory criterion for attaining the Gold certification level. If you don't have data quality configured, the highest certification level a report can attain is Silver.About data quality rulesData quality rules are rules that calculate the quality of a certain asset based on a predefined aggregation path and metrics.The results of a data quality rule are available in a data quality dashboard via the Quality tab on the asset page of the asset for which you calculated its data quality. Data quality rules define for which assets the data quality dashboard is created and how the data quality values are aggregated. A data quality result aggregates values that have been collected over time on attributes and that are aggregated from different assets along a number of predefined relations. The example shows the data quality rule Default Insurance data quality rule for business term and is explained in more detail in the following sections.FieldsName and DescriptionThe data quality rule consists of a unique name and a description that is shown in the Data quality rules table in the DGC Settings and in the assignments of an asset type.PathThe data quality rule aggregates values that are collected through a defined aggregation path. An aggregation path consists of a chain of relations that is to be followed from the asset to which the data quality rule is assigned, to the asset containing the actual values. In the example above, values from 'Governance Assets' are aggregated for 'Business Assets' by looking up: The 'Data Assets' that these business assets are represented by.The 'Governance Assets' that these data assets are governed by.CategorizationSelect a relation in the categorization field to create subscores for assets at the end of the aggregation path that have this relation. The data quality dashboard on the asset's page then shows these subscores. These subscores are attributes belonging to the asset that has a relation to the asset at the end of the aggregation path.The data quality dashboard also shows subscores limited to certain dimensions, such as 'Accuracy'. The values of an asset at the end of the aggregation path are only taken into account for these subscores if the asset 'belongs' to the given dimension. An asset 'belongs' to a dimension when it has a relation of the type defined in the Categorization to that dimension. In the given example, the 'Data Quality Rule' should have a relation Classified by to, for example, the 'Accuracy' Data Quality Dimension.MetricsThe metrics of a data quality rule define the values that are displayed in the data quality dashboard and which operation should be used when aggregating the value. These values are attributes that are available on the last asset of the aggregation path, in this example the 'Governance Asset'.This section contains a couple of metrics that are fixed for each metrics group:NameOperationDescriptionRows PassedTotalThe aggregated sum of passing rows.Rows FailedTotalThe aggregated sum of failing rows.ResultLogical ANDThe aggregated logical and of the result: failing or passing.Passing FractionAverageThe aggregated average of the passing fraction (quality score).You can add extra metrics and their corresponding operation by clicking Add Metric.Create a data quality ruleYou can create a new data quality rule.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Data quality rules.  Above the table, to the right, click Add.Enter the required information.FieldDescriptionNameThe name of the data quality rule.DescriptionThe description of the data quality rule.PathThe chain of relations to follow from the asset to which the data quality rule is assigned, to the asset containing the actual values. CategorizationThe relation type that determines to which subscore the metric belongs.The values of an asset at the end of the aggregation path are only taken into account for these subscores if the asset has the relation that you enter here. MetricsThe metrics of a data quality rule define the values that are displayed in the data quality dashboard and which operation should be used when aggregating the value. These values are attributes that are available on the last asset of the aggregation path.This section contains a couple of metrics that are fixed for each metrics group:'Rows Failed', operation 'Total': aggregated sum of failing rows'Rows Passed', operation 'Total' aggregated sum of passing rows'Passing Fraction', operation 'Average': aggregated average of the passing fraction (quality score)'Result', operation 'Logical AND': aggregated logical and of the result: failing or passingYou can add extra metrics and their corresponding operation by clicking Add Metric.Click Save.
	 Validation rulesValidation rules are special assets of the type Validation Rule. They allow you to verify whether assets meet certain criteria. They have a special attribute Validation Script, which contains a validation script that evaluates assets of the types to which the validation rule is assigned.Administrator actionsCreate a domain of the type Validation rule domain.Create a validation rule.Edit a validation rule.Delete a validation rule.Assign a validation rule to an asset type.Change the order of validation rules.Unassign a validation rule from an asset type.User actionsValidate assets.View the validation result.Revalidate an asset.Create a validation ruleYou can create validation rules to verify whether assets meet certain criteria.PrerequisitesYou have a domain of the type Validation Rule Domain.You have a global role that has the System administration global permission.StepsOpen the product for which you want to create an asset (for example, Business Glossary).On the main toolbar, click .The Create dialog box appears.On the Assets tab, click Validation Rule.The Create Asset dialog box appears.Enter the required information.FieldDescriptionTypeThe asset type of the asset that you are creating.DomainThe domain to which the asset will belong. Ensure that the domain type of the selected domain is assigned to the selected asset type.NameA name to identify the asset.You can simultaneously create multiple assets. To do so, after typing the name, press Enter, and then type the next name. Depending on the settings, asset names may need to be unique in their domain. If you enter a name that already exists, it appears in the strike-through style.Click Create.A message stating that one or more assets are created appears in the upper-right corner of the page.What's next? You can now open and edit the validation rule asset, for example to add a validation script.Assign the validation rule to an asset type.Edit a validation ruleYou can edit validation rules. PrerequisitesYou have a global role that has the System administration global permission.StepsOpen a validation rule asset. The asset page appears.Double-click any attribute.Fill in the required information.Learn more about the validation script attribute here: Validation scripts.Click Save.Delete a validation ruleYou can delete validation rules in the same way as normal assets.You cannot delete a validation rule if it is assigned to an asset type.PrerequisitesYou have unassigned the validation rule from asset types.You have a global role that has the System administration global permission.StepsOpen the validation rule domain to which the validation rule belongs.        In the first row of the validation rule table, select one or more checkboxes. In the action toolbar, click Delete.The Delete assets dialog box appears.Click Yes.    Assign a validation rule to an asset typeYou can assign a validation rule to an asset type by adding it to the asset type's assignment. As a result, you can validate assets of this type against this validation rule, if the asset is in the scope of the assignment.PrerequisitesYou have a global role that has the System administration global permission.You have created a Validation Rule asset.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.    In the tab pane, click   Validation rules.The Asset type - Validation rules editor appears.Above the table, to the right, click Edit.Above the table, to the right, click Add.The Add validation rule dialog box appears.Click a validation rule.The validation rule appears at the bottom of the list of validation rules.If required, change the order.Click Save.Change the order of validation rulesYou can change the order of validation rules that are assigned to an asset type.The order of the validation rules will determine the order in which they are executed and shown on the asset page.PrerequisitesYou have an asset type that has multiple validation rules assigned to it.You have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   the name of the assignment.    In the tab pane, click   Validation rules.The Asset type - Validation rules editor appears.Above the table, to the right, click Edit.Click in front of a validation rule and hold down the mouse button.Move your mouse to the desired location in the order.Release the mouse button.Click Save.Unassign a validation rule from an asset typeYou can unassign a validation rule from an asset type via its assignment. PrerequisitesA validation rule that is assigned to an asset type.You have a global role that has the System administration global permission.Steps Open an asset type.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Operating Model.The operating model settings appear on the Asset types tab page.In the overview of asset types, click an asset type.The Asset type editor opens.    In the tab pane, click   Global assignment or the scope to which you want to add the validation rule.    In the tab pane, click   Validation rules.The Asset type - Validation rules editor appears.Above the table, to the right, click Edit.        In the validation rule table, click at the end of the line of a validation rule.      Click Save.Executing validation rulesYou can execute validation rules in many ways:Validate assetsDo this to manually validate assets.      Revalidate an assetDo this after editing an invalid asset.      Automatically.You can configure a workflow to start a validation on given events. For example when a asset is added or an attribute is edited.To configure triggers on certain events, see Getting started with workflows.Validation loggingCollibra Data Governance Center can write extensive log messages from the execution of validation rules. These messages are written to the dgc.log file.If the execution of a validation rule fails, analyzing the log is probably the most thorough approach.For more information on how to configure validation logging, see Logging.When contacting support regarding a problem with validation, attach the log file to the ticket.Validate assetsValidating an asset executes all validation rules assigned to the asset type. If an asset does not meet all validation rules, the asset is invalid.You can see the validation result on: An asset page’s title bar.As a column, when viewing assets in table display mode.As a field, when viewing assets in tiles display mode.As an overlay in a traceability diagram.After validation, the dgc.log file will also contain more extensive messages. For more information on how to configure validation logging, see Logging.By default, validation is not automatically triggered when an asset is edited, so you have to revalidate it after editing an asset. However, you can create a workflow for this. To configure validation on certain events, see Getting started with workflows.PrerequisitesEither of the following:You have a resource role with the Validation Execution resource permission, for example Community Manager.You have a global role that has the Manage all resources global permission.Validate an asset from the asset pageOpen an asset page.In the resource toolbar, click (validate).Validate one or more assets from an asset tableOpen a set of assets in table display mode.Select checkboxes in front of the assets you want to validate.In the action toolbar, click Validate.Validate one or more assets from a set of tilesOpen a set of assets in tile display mode.Select the assets you want to validate.In the action toolbar, click Validate.Revalidate an assetYou can revalidate assets that were previously validated to see whether they meet the validation rules that are assigned to the asset type.Validating an asset executes all validation rules that are assigned to the asset types. If an asset does not meet all validation rules, the asset is invalid.You can see the validation result:An asset page’s title bar.As a column, when viewing assets in table display mode.As a field, when viewing assets in tiles display mode.As an overlay in a diagram.You can create a workflow to automatically revalidate assets. To configure validation on certain events, see Getting started with workflows.PrerequisitesEither of the following:You have a resource role with the Validation Execution resource permission, for example Community Manager.You have a global role that has the Manage all resources global permission.Revalidate an asset from the asset pageOpen an asset.In the upper right corner, click valid or invalid.Click Revalidate. Revalidate one or more assets from an asset viewOpen an asset table.Select checkboxes in front of one or more assets.In the action toolbar, click Validate.Revalidate an asset from an asset viewOpen an asset table.If you don't see the Validation Result column, add it to the table.More info on adding columns to a table: Customizing tables.Click or .You can see the validation result of each validation rule.Click Revalidate.View the validation resultAfter validating or revalidating assets, you can view the result and make changes where necessary.View the validation result from the activities listOpen the activities list.In the table, you see the validations.In the results column, click Result.The Validation results dialog box appears.ExampleThe results column shows or to indicate whether they are respectively valid or invalid.If you want to fix invalid assets, you can open them by clicking them.View the validation result on the asset pageOpen an asset page.In the upper right corner, you see valid or invalid.View the validation result in an asset tableOpen an asset table.If you don't see the Validation Result column, add it to the table.More info on adding columns to a table: Customizing tables.Click or .You can see the validation result of each validation rule.Validation scriptsA validation script is an attribute of a validation rule asset. It contains the validation logic, which expresses a single condition to evaluate assets.The outcome of the evaluation is binary: valid: The validated asset meets the condition.invalid: The validated asset does not meet the condition. Depending on the result, it can also show a custom message.Validation scripts are written using a syntax that is based on Groovy, but enhanced specifically for validation rules in Collibra Data Intelligence Cloud.For general syntax-related questions, you can always refer to the Groovy syntax.Within the validation script, you can use the following features:Aggregate functionsValidation functionsMulti-line boolean expressionsCollectionsClosuresValidation script structureThe structure of validation scripts can be basic or advanced. More information:Basic script structureAdvanced validation script structureBasic script structureThe basic script structure only contains the pure validation logic in a rule. More information: Validation logic.rule { } ExampleThe following script checks that the asset name is not empty and contains more than two characters.rule { isNotEmpty(name, message: Name cannot be empty) && isLengthMore( name, 2, message: Name should have more than 2 characters) }Advanced validation script structureThe advanced script structure contains up to three sections, which are all contained in a rule. rule { given { } when {  } then { } }Examplerule { given { definitions = attributes['Definition'] } when { isEqual(type.id,\          '00000000-0000-0000-0000-000000011001') } then { isNotEmpty(definitions, \          message: The asset ${name} \   in domain ${vocabulary.name} must have          at least one definition) } }Given-sectionYou can use this optional section to define variables that you can re-use in the rest of the script. Variables can make the rest of the validation script more readable. It allows you to separate data creation from the actual constraint-checking validation logic. Each line of the given-section contains a variable name, an equal sign and an asset property. More info: Asset model.ExampleThe following given-section creates the variable definitions , which contains a list of the values of the Definition attributes.given { definitions = attributes['Definition']}When-sectionYou can use this optional section if certain conditions have to be met before the rule is executed. If you do not use this section, the validation logic is applied to all assets.If an asset does not meet these conditions, the validation logic is not executed and the outcome of the rule is valid.If the conditions are met, the validation logic is executed. The outcome of the rule will then depend on the actual validation logic in the then-section.Each line of the when-section typically contains:A validation function. More info: Validation functions.An attribute from the given-section, an asset property or a constant value that you entered in the script.ExampleThe following when-section only allows assets to be validated if they are of a specific asset type.when { isEqual(type.id,'00000000-0000-0000-0000-000000011001')}Then-sectionThe then-section contains the pure validation logic. More information: Validation logic.Asset modelThe asset model is the technical structure of assets. You can use the asset model to refer to specific fields of assets: its attributes and properties. This is required for optimal use of validation rules.This information does not apply to worfklows and APIs.Graphical representationThe asset model can be represented graphically. Further below you can find explanations on each individual field.GeneralFieldExplanationarticulationScoreThe articulation score of the asset.idThe resource ID. Every resource that can be retrieved using the asset model has this property.nameThe full name of an asset. All resources have this property (community, vocabulary and asset).signifierIdentical to name but only available for the BasicAssetModel.This field is deprecated.displayNameThe name of the resource. All resources have this property (community, vocabulary and asset).statusThe status of the asset.status.idThe resource id of the status.status.nameThe name of the status.status.signifierIdentical to status.name.This field is deprecated.typeThe asset type.type.idThe resource ID of the asset type.type.nameThe name of the asset type.type.signifierIdentical to type.name.vocabularyThe domain of the asset.vocabulary.idThe ID of the vocabulary.vocabulary.nameThe name of the vocabulary.vocabulary.community.idThe ID of the community of the asset.vocabulary.community.nameThe name of the community of the asset.generalConceptThe general concept of the asset.This field is deprecated.generalConcept.idThe ID of the general concept.This field is deprecated.generalConcept.nameThe name of the general concept.This field is deprecated. generalConcept.signifierIdentical to generalConcept.name.This field is deprecated.AttributesAttributes is a dictionary that contains all attribute values. You can retrieve the list for a given attribute type name or attribute type ID.There are several possibilities to navigate the attributes of an asset.FieldExplanationattributes.'Definition'The list of all Definition attribute values.attributes['Definition']Identical to attributes.'Definition'.attributes['00000000-0000-0000-0000-000000000202']Identical to attributes.'Definition', but using the resource ID of the Definition attribute type.attributes.'00000000-0000-0000-0000-000000000202'.first()The first attribute value within the list of all the Definition attributes.attributes.'00000000-0000-0000-0000-000000000202'?.first()Identical to attributes.'00000000-0000-0000-0000-000000000202'.first(), but null-safe.?. is the null-safe getter of Groovy. You cannot combine the ?. with the [ ... ] notation. This means that if the referenced attribute is not present, the result is null, whereas the expression without the question mark fails to execute.attributes['Definition'][1]The second Definition attribute value of the asset. This uses index-based navigation of the list, and the first element has index 0. RelationsRelations allow you to retrieve the list of target assets through a given relation, and each target is an asset model in itself. Navigation is done in a similar way as for attributes.(Complex) Relations are only available one level deep. This means that when your script refers to a target asset through a (complex) relation, that referred asset will contain all the aspects of the asset that are mentioned above (name, attributes, etc), but without the (complex) relations of the referred asset.FieldExplanationrelations['Related To']The list of target assets of all Related To relations.relations['Related To']?.first().nameThe name of the first target asset using the Related To relation in a null-safe way.?. is the null-safe getter of Groovy. You cannot combine the ?. with the [ ... ] notation. This means that if the referenced attribute is not present, the result is null, whereas the expression without the question mark fails to execute. Complex relationsComplex relations are a type of relation. However, because they are less predictable, not all possible relations can be listed here.FieldExplanationcomplexRelations.<complexRelationType(Name/Id)>.<firstrelationname>.<secondrelationname>Similar to the relations, the end result will be an asset model. Example If you have a complex relation type with name CRT and id 1, containing four relation types up, down, left and right,all sides referencing a business term.These are the complex relations:FieldExplanationcomplexRelations.CRT.up.rightThe list of the complex relations from up to right.complexRelations['CRT']['up']['right']Identical to complexRelations.CRT.up.right.complexRelations.'CRT'?.'up'?.'right'Identical to complexRelations.CRT.up.right, but does not fail in case the list of CRT is empty, nor if the up side is empty.?. is the null-safe getter of Groovy. You cannot combine the ?. with the [ ... ] notation. This means that if the referenced attribute is not present, the result is null, whereas the expression without the question mark fails to execute.complexRelations['1'].down.upThe list of the complex relations from down to up.Asset type modelFieldDescriptionnameThe full name of the asset type.displayEnabledParameter that determines whether the Identical asset names per domain feature is enabled for the asset type.ratingEnabledParameter that determines whether ratings are enabled for the asset type.idThe resource id. signifierIdentical to name but only available for the BasicAssetModel.This field is deprecated.Validation logicThe validation logic of a validation rule expresses the condition that is checked by the validation rule. In a basic validation script, it is contained directly in the rule. In an advanced validation script, it is contained in the then-section. More information: Validation scripts.StructureEach line typically consists of:A validation function. More info: Validation functions.An attribute from the given-section, an asset property or a constant value.A message for when assets do not meet the condition of the validation function.Other syntactic elements:Aggregate functionsValidation functionsMulti-line boolean expressionsCollectionsClosuresWhat's next?If an asset does not meet the validation logic, the outcome of the rule is invalid.If the asset meets the validation logic, the outcome of the rule is valid.Examplethen { isNotEmpty(attributes['Definition'],     message: The asset ${name} in domain ${vocabulary.name} \         must have at least one definition)}Validation functionsValidation functions are the functions in a validation script that check for a condition. The result is a boolean: true or false.To make the validation script more readable, there are many packaged validation functions. The built-in validation functions not only handle the validation, but they also provide a way to produce meaningful error messages. For more advanced functions, you need a closure, more information: Closures.General functionsThe function...checks whether...isEmpty (value)A value is empty, null or does not contain any element.isNotEmpty (value)A value is not empty.isEqual (value1, value2)A value is the same as a second value.isNotEqual (value1, value2)A value is not the same as a second value.isIn (value, Collection)A value is part of a collection.areIn (Collection values, Collection collection)A collection is part of another collection.isAny (Collection, Closure)Any value of a collection meets the criteria of a validation closure.isEvery (Collection, Closure)All values of a collection meet the criteria of a validation closure.isFalse (value)A value is false, empty or null according to the Groovy truth.Examples:isFalse (something): returns true if something is false.isFalse (something): returns false is something is true.isFalse (false): returns true.isFalse (null): returns true.isTrue (value)A value is true, empty or null according to the Groovy truth.Examples:isTrue (something): returns false if something is false.isTrue (something): returns true is something is true.isTrue (false): returns false.isTrue (null): returns true.isUnique (Collection, Closure)All values in a collection are unique.Examples:isUnique ([1,2,3]): will evaluate to true.isUnique ([1,2,3,1]): will evaluate to false.Examples:The closure {it % 2} allows only one even and one odd element in the list.isUnique ([3, 4], {it % 2}): will evaluate to true.isUnique ([1, 3, 4], {it % 2}): will evaluate to false, because both 1 and 3 are odd.validate (value)A value is a valid function, accepting any closure that is capable of returning true or false.Validate (value) is a general validation function used to check another function.Error messagesIf you add a message parameter in a validation function, a message appears if the result is false.You can add the message parameter anywhere in the list of function parameters. ExampleisEmpty (value, message: this value is not empty) is equivalent to isEmpty (message: this value is not empty, value).You can also include parameters in your message by using ${<asset property>}. More info on asset properties: Asset model.Example: message: The description of the ${name} asset in domain ${vocabulary.name} is empty.. When this message appears, name and vocabulary.name are automatically replaced by its value.Message parameters entered in the when-clause will not be taken into account.String functionsThe function...checks whether the value...isEmpty (value) Is empty or null.isNotEmpty (value)Is not empty.startsWith (value, prefix)Starts with prefix.contains (value, substring)Contains the given substring.endsWith (value, suffix)Ends with the given suffix.isLengthBetween (value, minLength, maxLength) Has a length between the specified range.The range is inclusive. For example isLengthBetween ('Hello', 2, 6) is true.isLengthLess (value, maxLength)Has a length less than the specified length.isLengthMore (value, minLength)Has a length longer than the specified length.isLengthEq (value, length)Has the specified string length.isAlpha (value)Contains only alphabetical characters.This is done through the regular expression [a-zA-Z]+ .isAlphaSpace (value)Contains only alphabetical characters and spaces.isAlphanum (value)Contains only alphabetical characters and digits.isAlphanumSpace (value)Contains only alphabetical characters, digits, and spaces.matches (value, regular expression)Matches the specified regular expression.A regular expression has to be placed between two forward slashes (/).Examples:matches (stream, /str.*/) checks whether stream matches the pattern str.*, which will result to true.matches (stream, /srl.*/): checks whether stream matches the pattern srl.* which results to false.Number functionsThe function...checks whether a number...isEven (number) Is even.isOdd (number)Is odd.isGreater (number1, number2)Is greater than the second number.isGreaterEq (number1, number2)Is greater than or equal to the second number.isLess (number1, number2)Is smaller than the second number.isLessEq (number1, number2)Is smaller than or equal to the second number.isPositive (number)Is greater than zero.isNonnegative (number)Is greater than or equal to zero.isNegative (number)Is smaller than zero.isBetween (number1, number2, number3)Is greater than the second but smaller than the third number.Date conversion functionsYou can use the date conversion functions to convert the date or time from one format to another.ImplementationPurposeLong toTimestamp(String dateConstant) { LocalDateTime.of( LocalDate.from(DateTimeFormatter.ISO_LOCAL_DATE.parse(dateConstant)), LocalTime.of(0, 0, 0) ).atOffset(ZoneOffset.UTC).toInstant().toEpochMilli() }Converts a date constant to a timestamp.@param dateConstant: the date in yyyy-MM-dd format .@return: the timestamp of the dateConstant.String toDateConstant(Long timestamp) { Instant.ofEpochMilli(timestamp).atOffset(ZoneOffset.UTC) .format(DateTimeFormatter.ISO_LOCAL_DATE) }Converts a timestamp to a date string in yyyy-MM-dd format.@param timestamp: the timestamp to convert.  @return: the string representation of the timestamp.String toDateConstant(Long timestamp, String pattern) { Instant.ofEpochMilli(timestamp).atOffset(ZoneOffset.UTC) .format(DateTimeFormatter.ofPattern(pattern, ValidationConfig.getInstance().getLocale())) }Converts a timestamp to a string using the given pattern.@param timestamp: the timestamp to convert.@param pattern: the pattern to use for conversion. For example: yyyy-MM-dd.@return: the string representation of the timestamp in the given pattern representation.String now() { Instant.now().atOffset(ZoneOffset.UTC).format(DateTimeFormatter.ISO_LOCAL_DATE) }Returns the current date string in yyyy-MM-dd format.@return: the current date in yyyy-MM-dd format.Date functionsThe functions for attributes with datatype Date, require a long value as timestamp, in the UNIX Epoch time format 1234567890000, and a string value as calendar date, in the ISO extended format YYYY-MM-DD.The function...checks whether a timestamp is...now()Returns the current date.isPast (Timestamp)In the past (before the system date).isFuture (Timestamp)In the future (after the system date).isEqual (Timestamp, Date)The same as the date.isLess (Timestamp, Date)Smaller than the date.isLessEq (Timestamp, Date)Smaller than or equal to the date.isGreater (Timestamp, Date)Greater than the date.isGreaterEq (Timestamp, Date)Greater than or equal to the dateisBetween(Timestamp, Date1, Date2)Greater than the first but smaller than the second date.Aggregate functionsAggregate functions allow you to extract a value from a collection. More information on collections: Collections.They are not validation functions in itself, but can help you in retrieving data you want to refer to more easily in the rest of your validation script.FunctionResultmax (Collection)The maximum of the given collection of values.min (Collection)The minimum of the given collection of values.avg (Collection)The average of the given collection of number values.sum (Collection)The sum of the given collection of number values.Multi-line boolean expressionsThe validation script of a validation rule may consist of multiple boolean expressions. To increase legibility, you can use specific constructs.Using the constructs makes your rule a little more verbose, but more readable in most cases.ConstructionsExpressionPurposeallOfAll the conditions have to be valid (= AND).anyOfOne or more of the conditions have to be valid (= OR).conditionCapture the result of a boolean to re-use in other constructs.ExamplesThe examples below give the same result but are formulated in a single line, multi-line or in a hybrid construct.Single-line expression:rule { ((isNotEmpty (name) && isEqual (name, 'doesnotequal2', message: 'shouldfail')\ || isEqual (name, 'doesnotequal')) && isNotEmpty (id) }Multi-line expression:rule {  allOf { anyOf {   allOf { condition { isNotEmpty (name) } condition { isEqual (name, 'doesnotequal2', message:\ 'shouldfail') }   }   condition { isEqual (name, 'doesnotequal') } } condition { isNotEmpty (id) }  } }Hybrid expression:rule {  allOf { anyOf {   condition { isNotEmpty (name) && isEqual (name,\        'doesnotequal2', message: 'shouldfail') }   condition { isEqual (name, 'doesnotequal') } } condition { isNotEmpty (id) }  } }ClosuresA closure is a function that you can pass as an argument to another function. It is contained by curly brackets, {<closure>}. You can also define variables before the arrow -> For more extensive documentation about closures, please refer to the Groovy closure documentation. ExamplesClosurePurpose{a, b -> a + b}Define two variables of an undefined type.Add them up.Show the result.{String a -> isNotEmpty (a) }Define a variable of the type String.Apply the validation function isNotEmpty on it.More info: isNotEmpty (value).{isNotEmpty (it)}Apply the validation function isNotEmpty on any variable that has it as its name.More info: isNotEmpty (value).Naming an argument is not necessary when there is only one.CollectionsA collection is a list of data. Usually you create it when retrieving attributes or relations.You can refer to a specific element in the collection in multiple ways. If a reference points to a value that doesn't exist, the rule will crash. For example, retrieving the fifth value of a list that only contains four values causes a crash.ReferenceResultmylist.first()The first value in the list mylist.mylist.last()The last value from the list mylist.mylist[1]The second element from the list mylist. The number is the index of the value you want to retrieve from the list.The first element has index zero. As a consequence, mylist.first() is equivalent to mylist.[0]. mylist.get(1)            The second element from the list my list. It is very similar to the example above.          mylist?.get(1)            The second element from the list. However, this syntax is null-safe.            ?. is the null-safe getter of Groovy. You cannot combine the ?. with the [ ... ] notation. This means that if the referenced attribute is not present, the result is null, whereas the expression without the question mark fails to execute.Using the *. operator in collectionsWhen using relations, you sometimes only need to have one value of the target assets, such as the name. You can use the *. operator for this. ScriptPurposeisIn ('expectedTargetName', relations['Is Related To']*.name)Check whether expectedTargetName is in the list of all names of the target assets. The *. operator applies the .name on every target asset and creates a new list. isEvery (relations['Is Related To']*.name, {targetName -> startsWith (targetName, 'S')})This will check that every target asset related to the current asset has a name that starts with S. Validate the first element of a collectionIn many situations, the first element is the only element you actually want to validate. For example, if you want to check if the first Description attribute is equal to a certain value, you can do this:ScriptPurposeisEqual (attributes['Description'].first(), 'myvalue')Retrieve the first element from list of Descriptions and compare this to myvalue.isEqual (attributes['Description'], ['myvalue'])Check wether the list of Descriptions is equal to the given list ['myvalue']. This is identical to the first example, but has as a side effect that if there is more than one occurrence of the Description attribute, the comparison will return false. As a consequence, it validates that there is exactly one Description attribute.Validation script examplesThese are examples of real validation scripts of validation rules.An asset must have at least one definition.rule {  isNotEmpty (attributes.'Definition'?.first(), \    message:The Asset ${name} in domain ${vocabulary.name} \ must have at least one Definition)}An attribute must comply to a given pattern (defined using a regular expression).rule {  given { codes = attributes.'Code'  }  when { isNotEmpty (codes)  }  then { matches (codes.first(), /S\d\d\d\d\d000/,\ message: The asset ${name} in domain \   ${vocabulary.name} Code must start with\      an S, then 5 digits, then 000)  }}All assets with a related to relation must have at least one uses relation.rule {  given { relatedTo = relations.'Related To' uses = relations.'Uses'  }  when { isNotEmpty (relatedTo)  }  then { isNotEmpty (uses, message: Asset ${name}\   has Related To relation, so it must \   also have a Uses relation)  }}An asset must comply to the following naming rule, defined by a regular expression: starts with T, followed by 4 digits, 2 zeroes and exactly one 0, 1 or 2.rule {  matches (name, /T(\d{4})0{2}[0,1,2]/, \    message: Asset ${name} does not comply to naming rule)}An asset name must consist of one or more words in capitals.rule {  matches(name, /(\p{Upper}+|\p{Space}*)*/, \    message: Name ${name} should be words in capitals)}All codes for a given asset must be in a different code list.rule {  given { code_domains = \   relations.'Code'?.vocabulary?.name  }  then { isUnique (code_domains)  }}A code must be related to only one business term.rule {  given { terms = relations.'Business Term'  }  when { isNotEmpty (terms)  }  then { isEmpty (terms[1] )  }}All target assets using the Transform complex relation following the from and to branch, must have the same name as the current asset.rule {  isEvery (\ complexRelations.'Transform'.from.to.name, \  {isEqual(name, it)}, \    message: Not all From and To names of the \  Transform relation are equal)}The total score of each asset related to the current asset through an Impacted By relation may not exceed 100.rule {  given { impacted = relations.'Impacted By'. totalScoresForEachRelatedAsset = impacted?.collect\   {it.attributes['Score'].sum {it.toIteger()}}  }  when { isNotEmpty (totalScoresForEachRelatedAsset)  }  then { isEvery (totalScoresForEachRelatedAsset, \      { isLessEq (it, 100)}, \      message: 'Not all related assets have a \     total score smaller or equal to 100')  }}When the first target asset of the current asset using the Is Grouped By relation is inactive, then the current asset must be inactive. Whether or not the current asset is active or not, is based on the boolean attribute Active.rule {  given { reference = relations.'Is Grouped By'?.first() active = reference.attributes.'Active'?.first()  }  when { isNotEmpty (reference) && isFalse (active)  }  then { isFalse (active, message: The node '${name}' in\   '${vocabulary.name}' should also be inactive, \   since it parent is inactive.)  }}
	 ScopesA scope in Collibra Data Intelligence Cloud is a selection of communities and domains that you can refer to in an assignment of an asset type. Each community or domain belongs to exactly one scope.Default scope and custom scopesCollibra always has a default scope. Initially, all communities and domains are part of the default scope.Depending on your requirements, you can create custom scopes and add specific communities and domains to it. If you add a community or domain to a custom scope, it is no longer part of the default scope. If you delete a custom scope, or remove communities and domains from a custom scope, the affected communities and domains revert to the default scope.For more information about scopes after an upgrade from version 4.x to 5.x, see Collibra Support Portal.Delete a scopeYou can delete a scope, for example, if you want an asset type to use the default assignment.When you delete a scope, the asset types that used this scope, revert to other custom scopes or, if there are no other custom scopes, to the default assignment.PrerequisitesYou have a global role that has the System administration global permission.StepsOpen the Scopes page.    On the main menu, click   , and then click   Settings.The Collibra settings page opens.In the Operating model section, click Scopes.The Scopes page opens.In the scope's tile, click .The Delete <scope name> dialog box appears. Click Delete.
	 WorkflowsYou can find this section on the Collibra Developer Portal.

	 HomepageThe Collibra Homepage is the default page that appears when you sign in to Collibra Data Intelligence Cloud or when you click on any page in Collibra. The Homepage guides you within Collibra by showing information that is relevant to you, such as your dashboards, the most viewed assets, and the recommended assets. The Homepage also allows you to perform a search, for example, for a community, domain, or asset.The Homepage changes how you find or access your dashboards. You can access all your dashboards on the Dashboards card on the Homepage or on the Dashboards tab in the Browse pane.If you are an administrator, you can define the headings and the content shown in each section of the Homepage and thus create a Homepage that can meet user needs.In Collibra 2022.11 or newer, the Homepage is enabled by default.In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer, the Homepage is available but disabled by default.In Collibra environments upgraded from 2022.11 to a newer version, the previous status of the Homepage (enabled or disabled) is retained.For information about how to enable or disable the Homepage, go to Enable or disable the Homepage. If you are an administrator, the Edit Page button is shown on the Homepage to enable you to customize the Homepage.     Enable or disable the HomepageIn Collibra 2022.11 or newer, the Homepage is enabled by default.In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer, the Homepage is available but disabled by default.In Collibra environments upgraded from 2022.11 to a newer version, the previous status of the Homepage (enabled or disabled) is retained.Depending on your environment, follow this procedure either in the Services Configuration section of the Collibra settings or in Collibra Console. This topic contains the procedure for Collibra Console. If your Settings page has a Configuration tab, you can follow this procedure on that tab. For more information, go to the online documentation.Requirements and permissionsYou have the ADMIN or SUPER role in Collibra Console.You have the SUPER role in Collibra Console.The Frontend enabled setting is enabled.  StepsOpen the DGC service settings for editing:Open Collibra Console.Collibra Console opens with the Infrastructure page.In the tab pane, expand an environment to show its services.    In the tab pane, click   the Data Governance Center service of that environment.Click Configuration.Click Edit configuration.Go to the Homepage section.Select the required value.ValueDescription TrueEnables the Homepage. When you sign in to Collibra, the Homepage is shown. The Homepage replaces your default dashboard. False (default)Disables the Homepage. When you sign in to Collibra, your default dashboard is shown, instead of the Homepage.Click Save all.Homepage overviewThe following table describes the sections shown on the Homepage.No.DescriptionContains the title.Contains an introduction.Allows you to perform a search, directing you to the global search results page.Helps you to find content and perform your daily activities. Depending on how the Homepage is customized, this section can contain any three of the following cards:Dashboards: A list of dashboards that you can access.My Quick Links: A list of links to the pages that you can quickly access. You can add, edit, rearrange, and delete quick links.My Tasks: A list of tasks that are assigned to you.Most Viewed Assets: A list of assets that your colleagues viewed the most in the last 30 days.Recommended Assets: A list of assets that you might like based on your search history and the assets that you previously viewed.Edit the HomepageYou can customize the Homepage for the users of Collibra by providing relevant and contextual content.This topic describes how to edit the Homepage, including how to preview and publish it.When you edit the Homepage, your changes are automatically saved each time that you click outside the section where you made the changes.    Requirements and permissionsYou have a global role that has the System administration global permission.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .In the upper-right corner of the page, click Edit Page.The Homepage opens in the editor mode.If another administrator has edited or is editing the Homepage, a message indicating so is shown on the Homepage. For example, Draft saved 8 minutes ago by John. You can, however, still edit the Homepage.Edit the sections as needed. How to edit the sectionsNo.DescriptionEnter a title for the Homepage.In the first box, enter a greeting.If you want the first name of a user to be shown in the greeting, enter {Name}. For example, if you enter Hello {Name}, when a user named Jane Doe signs in, the following greeting is shown to her: Hello Jane. If the user does not have a first name, the username is shown.In the second box, enter an introduction.Add an image. How to add an image Hover your pointer over the current image, and then click Add Content. The Add Content dialog box appears.Enter the required information. Add Image by Link: The link to the image that you want to be shown. If you leave this field blank, the default Collibra Homepage image will be shown.Alt text: A meaningful description of the image. If the image fails to load, this description is shown in place of the image. The description also helps screen-reading tools to describe the image.Click Save.In the first box, enter a heading that indicates that users can perform a search, for example, What are you looking for?. In the second box, enter the text that you want to be shown in the search field to guide users, for example, Search Collibra.In the box, enter a heading that indicates that users can find content, for example, Where would you like to go?.The top subsection that is located below the box contains the selected cards, which will be shown to users. The bottom subsection contains the available cards, which you can choose to show to users. To move a card from one subsection to another, drag the card and drop it to where you want it in the subsection.While a total of five cards are available, a maximum of three cards can be shown to users.On the My Quick Links card, you can add, edit, rearrange, and delete quick links.If you want to pause editing the Homepage or want to publish the edited Homepage later, click Close Editor. This action saves all the changes that you made to the Homepage and shows the last published Homepage in the view mode.If you want to discard all the changes that you made to the Homepage, click , and then click Delete Draft. You can then continue to make new changes to the Homepage.If you want to restore the Collibra version of the Homepage, which is the original version, click Restore Collibra Version, and then click Publish.        Optional: Click Preview.A preview of the Homepage is shown.If you want to make more changes to the Homepage, click Back to Editor.To publish the Homepage, click Publish.          The edited Homepage is published to all the users.Add a quick linkYou can add up to six links to the My Quick Links card on the Homepage. The links that you add to the card are shown only to you.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .        On the My Quick Links card, click Add a Quick Link.The Add a Quick Link dialog box appears.Enter the required information.FieldDescriptionURLEnter the address of the web page that you want to be able to quickly access from the My Quick Links card.Text to DisplayEnter the text that you want to show in place of the address on the My Quick Links card.Open in New Tab If you want the web page to open in the same browser tab, clear the checkbox.If you want the web page to open in a new browser tab, select the checkbox.Click Save.The link is shown on the My Quick Links card.You can edit, rearrange, or delete the quick link.Edit a quick linkYou can edit the links on the My Quick Links card on the Homepage.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .On the My Quick Links card, click Edit.Click next to the link that you want to edit.The Edit Quick Link dialog box appears.Enter the required information.FieldDescriptionURLEnter the address of the web page that you want to be able to quickly access from the My Quick Links card.Text to DisplayEnter the text that you want to show in place of the address on the My Quick Links card.Open in New Tab If you want the web page to open in the same browser tab, clear the checkbox.If you want the web page to open in a new browser tab, select the checkbox.Click Save. On the My Quick Links card, click Save.The edited link is shown on the My Quick Links card.You can rearrange or delete the quick link.Rearrange a quick linkYou can change the position of the links on the My Quick Links card on the Homepage.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .On the My Quick Links card, click Edit.Hover your pointer over the link whose position you want to change.Drag to the position where you want the link to be shown. Click Save.The link is rearranged.Delete a quick linkYou can delete the links on the My Quick Links card on the Homepage.StepsGo to the Homepage. The Homepage appears when you sign in to Collibra Data Intelligence Cloud. You can also go to the Homepage from any page by clicking .On the My Quick Links card, click Edit.Click next to the links that you want to delete.Click Save.The links are no longer shown on the My Quick Links card.
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	 Usage AnalyticsUsage Analytics is a usage-focused dashboard that provides a snapshot of who is using your Collibra Data Intelligence Cloud environment and how they are using and engaging with it. Usage Analytics shows you the behavioral data of your users and associated analytics within Collibra.The Usage Analytics dashboard contains various sections with trend line charts to help you gain insights into the adoption and usage of your Collibra environment. You can use the dashboard to monitor user activity, understand the total asset coverage, and identify popular communities or assets.About Usage Analytics Open the Usage Analytics dashboard Usage Analytics dashboard overview Usage Analytics detailed data About Usage AnalyticsThe Usage Analytics dashboard shows you data on users and products. You can use the data shown on the dashboard to view the usage over time, observe trends, measure success, allocate efforts, and maximize your investment and recharge costs. Who can benefit from the data The data on the Usage Analytics dashboard can benefit the following users:Administrators who manage or renew licenses.Business stewards who want to know if the content that they curate is useful.Community managers who want to know which subcommunities are active and which need more exposure.End users who want to see better recommendations on their content feed. How you can use the data With the data on the Usage Analytics dashboard, you can:Improve the usage of your Collibra environment by gaining insights into who is using Collibra and which communities, domains, and assets they are using.Improve the visibility and effectiveness of your adoption efforts by identifying how many users can access Collibra but have not done so and how many new users have signed in to Collibra. Example Suppose that you have trained some users on how to use Collibra and have run a campaign within your organization to help drive the usage of Collibra. If you want to measure the effectiveness of your campaign, you can view the New section on the Usage Analytics dashboard to check if those trained users signed in to the Collibra environment in a given period. Additionally, you can view the Inactive section to check which users did not sign in to the Collibra environment in a given period or when they were last active on the Collibra Platform. When and how the data is captured All the data shown on the Usage Analytics dashboard is refreshed every hour. Usage Analytics captures data based on when users sign in to Collibra Data Intelligence Cloud and when users visit the assets within a community or domain. These events are captured in Collibra and sent every hour to a database built for Usage Analytics. Privacy Usage Analytics leverages a process based on event capture, storage, and analytics, built and managed by Collibra. The Usage Analytics data is stored within the Collibra database, in accordance with the regional requirements for customer instances. The Usage Analytics data is made available only to customers—no third party systems can access this data.Open the Usage Analytics dashboardRequirements and permissionsYou have either the Sysadmin global role or one of the following global permissions:Insights > View Usage Analytics reportsWith this permission, you can view detailed data by clicking the cards on the Usage Analytics dashboard. In addition, you can download the data.Insights > View Usage Analytics SummaryWith this permission, you can view only a summary of the data on the Usage Analytics dashboard. The View Usage Analytics Summary permission affects only the view of the Usage Analytics dashboard. All the Usage Analytics events and detailed data will still be captured and stored.The Frontend enabled setting is enabled.  Collibra Data Intelligence Cloud is packaged with the Insights global role.If you have both the View Usage Analytics Summary permission and the View Usage Analytics reports permission, the latter permission takes precedence.Steps    On the main menu, click   , and then click  Usage Analytics.    The Usage Analytics dashboard opens.Usage Analytics dashboard overviewThe Usage Analytics dashboard shows key data related to the adoption and engagement of your Collibra environment within your organization over a given time period. The following table describes the sections shown on the dashboard.No.SectionDescriptionUsage PeriodAllows you to select the period for which you want to view the data. You can view the data for the last 1, 7 (default), 30, 60, 90, 180, or 365 days.The Current Period field shows the date range for the length of time selected in the Usage Period field. The Previous Period field shows the date range for the same length of time, but for the period before the current period. For example, if the Current Period field shows Oct. 1, 2022 - Oct. 7, 2022, then the Previous Period field shows Sep. 24, 2022 - Sep. 30, 2022.VisitorsShows how many users in your organization used Collibra in the current period.VisitsShows how users in your organization used Collibra and which resources they visited the most in the current period.Usage Analytics detailed data If you have the Sysadmin global role or the Insights > View Usage Analytics reports global permission, you can view more usage data by clicking the cards in the Visitors or Visits section.Visitors section overviewThe Visitors section on the Usage Analytics dashboard shows data related to the user engagement over a given period of time. The following table describes the cards shown in the section.CardDescriptionActiveActive visitors are users who signed in to Collibra in the current period.NewNew visitors are users who signed in to Collibra either for the very first time in the current period or for the first time in the current period after having been inactive in the previous period.            InactiveInactive visitors are users who did not sign in to Collibra in the current period.                    Understanding the data in the Visitors sectionThis topic describes the data that appears when you click a card in the Visitors section.ActiveThe Active card shows the number of users who signed in to Collibra in the current period.Depending on your permission, when you click the card, the following subsections appear:Active Standard Users: The number and evolution of active visitors who have the Standard User license, in the current and previous periods. Active Read-only Users: The number and evolution of active visitors who have the Read-only User license, in the current and previous periods.Active Visitors: The names and other attributes, such as the required license and the number of current visits, of all active visitors in the current period.On the Active Standard Users and Active Read-only Users subsections, you can hover your pointer over the solid (current period) or dotted (previous period) lines in the charts to compare the data between two corresponding days in the current and previous periods. What the number and text on the Active card indicates The following table describes what the number and the text on the Active card indicates.No.DescriptionThe number on the Active card considers all users who signed in to Collibra in the current period. These include not only standard and read-only visitors but also visitors whose profiles were deleted in the meantime.Suppose that the number on the Active card is 20, the number on the Active Standard Users is 10, and the number on the Active Read-only Users card is 8. This indicates that the remaining two users are deleted.The text on the Active card indicates the approximate percentage of active users in the current period in comparison with the previous period.Suppose that for a period of 30 days, the number on the Active card is 20 and the text on the Active card is 50.00% over previous period. The text means that there is approximately a 50% increase in the number of active users in the current period compared to the previous period, indicating that there were about 13 active users in the previous period.The arrow next to the number indicates the trend of the number of visitors compared with the previous period.An up arrow indicates that the number of visitors in the current period is more than that in the previous period.A down arrow indicates that the number of visitors in the current period is less than that in the previous period. A left arrow indicates that the number of visitors in the current period is the same as that in the previous period.Understanding the data in the Active Visitors subsection The following table describes the columns that are available in the Active Visitors subsection, including hidden columns and columns that appear only in the downloaded version of the subsection.Columns that are shown only in the downloaded version of the subsection are indicated by (*) next to them in the following table.ColumnDescriptionNameThe name of the visitor.User NameThe username of the visitor.This column is hidden by default. For information about how to show a column, go to Customize a table.User ID (*)The user ID of the visitor.Required LicenseThe license that the visitor requires for the assigned roles and responsibilities.If this data is unavailable, - is shown in the column.Effective LicenseThe actual license that the visitor is assigned. If this data is unavailable, - is shown in the column. This column is hidden by default. For information about how to show a column, go to Customize a table.Participated in workflowsYes: If the visitor started or stopped workflows or completed workflow tasks.No: If the visitor did not start or stop workflows or complete any workflow tasks.This column is hidden by default. For information about how to show a column, go to Customize a table.Current VisitsThe number of times that the visitor signed in to Collibra in the current period.Previous VisitsThe number of times that the visitor signed in to Collibra in the previous period.Days ActiveThe number of days that the visitor signed in to Collibra.Last ActiveThe UTC (Coordinated Universal Time) date when the visitor last signed in to Collibra. In the downloaded file, this column additionally shows the time in milliseconds.Deleted User Flag (*)0: The visitor profile is not deleted.1: The visitor profile was deleted since they last signed in to Collibra.Disabled User Flag (*)0: The visitor profile is enabled.1: The visitor profile was disabled since they last signed in to Collibra.Is New in Period (*)0: The visitor signed in to Collibra in the previous period.1: The visitor signed in to Collibra either for the very first time in the current period or for the first time in the current period after having been inactive in the previous period.NewThe New card shows the number of users who signed in to Collibra either for the very first time in the current period or for the first time in the current period after having been inactive in the previous period.Example Suppose that the current period is October 1, 2022-October 7, 2022 and the previous period is September 24, 2022-September 30, 2022. Consider a user named Jane who signed in to Collibra before the previous period (for example, on September 20th) but did not sign in to Collibra in the previous period. If Jane signs in to Collibra in the current period, Jane is considered a new user because she was inactive in the previous period.Depending on your permission, when you click the card, the following subsections appear:New Standard Users: The number and evolution of new visitors who have the Standard User license, in the current and previous periods. New Read-only Users: The number and evolution of new visitors who have the Read-only User license, in the current and previous periods.New Visitors: The names and other attributes, such as the required license and the number of current visits, of all new visitors in the current period.On the New Standard Users and New Read-only Users subsections, you can hover your pointer over the solid (current period) or dotted (previous period) lines in the charts to compare the data between two corresponding days in the current and previous periods. What the number and text on the New card indicates The following table describes what the number and the text on the New card indicates.No.DescriptionThe number on the New card considers all users who signed in to Collibra in the current period. These include not only standard and read-only visitors but also visitors whose profiles were deleted in the meantime.Suppose that the number on the New card is 20, the number on the New Standard Users is 10, and the number on the New Read-only Users card is 8. This indicates that the remaining two users are deleted.The text on the New card indicates the approximate percentage of new users in the current period in comparison with the previous period.Suppose that for a period of 30 days, the number on the New card is 20 and the text on the New card is 50.00% over previous period. The text means that there is approximately a 50% increase in the number of new users in the current period compared to the previous period, indicating that there were about 13 new users in the previous period.The arrow next to the number indicates the trend of the number of visitors compared with the previous period.An up arrow indicates that the number of visitors in the current period is more than that in the previous period.A down arrow indicates that the number of visitors in the current period is less than that in the previous period. A left arrow indicates that the number of visitors in the current period is the same as that in the previous period.Understanding the data in the New Visitors subsection The following table describes the columns that are available in the New Visitors subsection, including hidden columns and columns that appear only in the downloaded version of the subsection.In the New Visitors subsection, users who signed in to Collibra for the first time since the time that the Usage Analytics dashboard was enabled are identified by the label NEW .Columns that are shown only in the downloaded version of the subsection are indicated by (*) next to them in the following table.ColumnDescriptionNameThe name of the visitor.User NameThe username of the visitor.This column is hidden by default. For information about how to show a column, go to Customize a table.User ID (*)The user ID of the visitor.Required LicenseThe license that the visitor requires for the assigned roles and responsibilities.If this data is unavailable, - is shown in the column.Effective LicenseThe actual license that the visitor is assigned. If this data is unavailable, - is shown in the column. This column is hidden by default. For information about how to show a column, go to Customize a table.Participated in workflowsYes: If the visitor started or stopped workflows or completed workflow tasks.No: If the visitor did not start or stop workflows or complete any workflow tasks.This column is hidden by default. For information about how to show a column, go to Customize a table.Current VisitsThe number of times that the visitor signed in to Collibra in the current period.Days ActiveThe number of days that the visitor signed in to Collibra.First ActiveThe date when the visitors first signed in to Collibra, represented in Coordinated Universal Time (UTC). In the downloaded file, this column additionally shows the time in milliseconds.Last ActiveThe UTC (Coordinated Universal Time) date when the visitor last signed in to Collibra. In the downloaded file, this column additionally shows the time in milliseconds.Deleted User Flag (*)0: The visitor profile is not deleted.1: The visitor profile was deleted since they last signed in to Collibra.Disabled User Flag (*)0: The visitor profile is enabled.1: The visitor profile was disabled since they last signed in to Collibra.Is New in Period (*)0: The visitor signed in to Collibra in the previous period.1: The visitor signed in to Collibra either for the very first time in the current period or for the first time in the current period after having been inactive in the previous period.InactiveThe Inactive card shows the number of users who did not sign in to Collibra in the current period. Depending on your permission, when you click the card, the following subsections appear:Inactive Standard Users: The number and evolution of inactive visitors who have the Standard User license, in the current and previous periods. Inactive Read-only Users: The number and evolution of inactive visitors who have the Read-only User license, in the current and previous periods.Inactive Visitors: The names and other attributes, such as the required license and the number of previous visits, of all inactive visitors in the current period.On the Inactive Standard Users and Inactive Read-only Users subsections, you can hover your pointer over the solid (current period) or dotted (previous period) lines in the charts to compare the data between two corresponding days in the current and previous periods. What the number and text on the Inactive card indicates The following table describes what the number and the text on the Inactive card indicates.No.DescriptionThe number on the Inactive card considers all users who signed in to Collibra in the current period. These include not only standard and read-only visitors but also visitors whose profiles were deleted in the meantime.Suppose that the number on the Inactive card is 20, the number on the Inactive Standard Users is 10, and the number on the Inactive Read-only Users card is 8. This indicates that the remaining two users are deleted.The text on the Inactive card indicates the approximate percentage of inactive users in the current period in comparison with the previous period.Suppose that for a period of 30 days, the number on the Inactive card is 20 and the text on the Inactive card is 50.00% over previous period. The text means that there is approximately a 50% increase in the number of inactive users in the current period compared to the previous period, indicating that there were about 13 inactive users in the previous period.The arrow next to the number indicates the trend of the number of visitors compared with the previous period.An up arrow indicates that the number of visitors in the current period is more than that in the previous period.A down arrow indicates that the number of visitors in the current period is less than that in the previous period. A left arrow indicates that the number of visitors in the current period is the same as that in the previous period.Understanding the data in the Inactive Visitors subsection The following table describes the columns that are available in the Inactive Visitors subsection, including hidden columns and columns that appear only in the downloaded version of the subsection.Columns that are shown only in the downloaded version of the subsection are indicated by (*) next to them in the following table.ColumnDescriptionNameThe name of the visitor.User NameThe username of the visitor.This column is hidden by default. For information about how to show a column, go to Customize a table.User ID (*)The user ID of the visitor.Required LicenseThe license that the visitor requires for the assigned roles and responsibilities.If this data is unavailable, - is shown in the column.Effective LicenseThe actual license that the visitor is assigned. If this data is unavailable, - is shown in the column. This column is hidden by default. For information about how to show a column, go to Customize a table.Participated in workflowsYes: If the visitor started or stopped workflows or completed workflow tasks.No: If the visitor did not start or stop workflows or complete any workflow tasks.This column is hidden by default. For information about how to show a column, go to Customize a table.Previous VisitsThe number of times that the visitor signed in to Collibra in the previous period.Last ActiveThe UTC (Coordinated Universal Time) date when the visitor last signed in to Collibra. In the downloaded file, this column additionally shows the time in milliseconds.Deleted User Flag (*)0: The visitor profile is not deleted.1: The visitor profile was deleted since they last signed in to Collibra.Disabled User Flag (*)0: The visitor profile is enabled.1: The visitor profile was disabled since they last signed in to Collibra.Is New in Period (*)0: The visitor signed in to Collibra in the previous period.1: The visitor signed in to Collibra either for the very first time in the current period or for the first time in the current period after having been inactive in the previous period.Visits section overviewThe Visits section on the Usage Analytics dashboard shows data related to the platform adoption and usage over a given period of time. The following table describes the cards shown in the section.CardDescriptionCommunityThe community names and the number of times that the assets in those communities are visited in the current period.Domain TypeThe domain type names and the number of times that the assets associated with those domain types are visited in the current period.Asset TypeThe asset type names and the number of times that the assets of those asset types are visited in the current period.Understanding the data in the Visits sectionThis topic describes the data that appears when you click a card in the Visits section.CommunityThe Community card shows the five communities whose assets are visited the most in the current period. Depending on your permission, when you click the card, the Community subsection appears with the following tabs:Visits: The number of times that the users visited the assets by communities in the current period.Visitors: The number of users who visited the assets by communities in the current period.The left pane on the Visits or Visitors tab shows a list of all communities and domains in hierarchical order. You can search for a specific community or domain by using the Search Communities and Domains search box.When you click a community in the left pane, it expands to show its subcommunities and domains. In addition, the data for the community that you clicked is shown in the table next to the left pane. You can also click a subcommunity or domain in the left pane to view the data for that subcommunity or domain in the table. You can identify the community or domain for which the data is shown in the table by the label above the table. After having clicked a community or domain in the left pane, if you want to go back to viewing the data for all communities, click the same community or domain in the left pane again. When you view the data for all communities, the label All appears above the table.VisitsVisitorsCommunity: Understanding the data on the Visits tabOn the Visits tab, in the left pane, the number that appears next to each community or domain indicates how many times the users visited the assets within that community or domain in the current period. The arrow next to each number indicates the trend of the number of visits compared with the previous period. An up arrow indicates that the number of visits in the current period is more than that in the previous period.A down arrow indicates that the number of visits in the current period is less than that in the previous period. A left arrow indicates that the number of visits in the current period is the same as that in the previous period.Above the table, Current Period shows the number of times that the users visited the assets within the selected community or domain in the current period, and Previous Period shows the corresponding number in the previous period. This data is also graphically represented as a trend line chart. You can hover your pointer over the solid (current period) or dotted (previous period) lines in the chart to compare the data between two corresponding days in the current and previous periods.The table contains the following columns.ColumnDescriptionAsset NameThe name of the asset that belongs to the selected community or domain.Domain NameThe name of the domain to which the asset belongs.Current VisitsThe number of times that the asset was visited in the current period.Previous VisitsThe number of times that the asset was visited in the previous period.Community: Understanding the data on the Visitors tabOn the Visitors tab, in the left pane, the number that appears next to each community or domain indicates how many users visited the assets within that community or domain in the current period. The arrow next to each number indicates the trend of the number of visitors compared with the previous period.An up arrow indicates that the number of visitors in the current period is more than that in the previous period.A down arrow indicates that the number of visitors in the current period is less than that in the previous period. A left arrow indicates that the number of visitors in the current period is the same as that in the previous period.Above the table, Current Period shows the number of users who visited the assets within the selected community or domain in the current period, and Previous Period shows the corresponding number in the previous period. This data is also graphically represented as a trend line chart. You can hover your pointer over the solid (current period) or dotted (previous period) lines in the chart to compare the data between two corresponding days in the current and previous periods.The table contains the following columns.ColumnDescriptionAsset NameThe name of the asset that belongs to the selected community or domain.Domain NameThe name of the domain to which the asset belongs.Current VisitorsThe number of users who visited the asset in the current period.Previous VisitorsThe number of users who visited the asset in the previous period.Domain TypeThe Domain Type card shows five domain types of the domains whose assets are visited the most in the current period. Depending on your permission, when you click the card, the Domain Type subsection appears with the following tabs:Visits: The number of times that the users visited the assets by domain types in the current period.Visitors: The number of users who visited the assets by domain types in the current period.The left pane on the Visits or Visitors tab shows a list of domain types for all communities in a hierarchical order. Only the domain types that contain at least one domain are shown in the left pane. You can view the domain types for a specific community by selecting that community in the drop-down list box. You can search for a specific domain type or domain by using the Search Domain Types and Domains search box.When you click a domain type in the left pane, it expands to show all the domains of that type. In addition, the data for the domain type that you clicked is shown in the table next to the left pane. You can also click a domain in the left pane to view the data for that domain in the table. You can identify the domain type or domain for which the data is shown in the table by the label above the table. After having clicked a domain type or domain in the left pane, if you want to go back to viewing the data for all domain types within the selected community, click the same domain type or domain in the left pane again. When you view the data for all domain types, the label All appears above the table.VisitsVisitorsDomain Type: Understanding the data on the Visits tabOn the Visits tab, in the left pane, the number that appears next to each domain type or domain indicates how many times the users visited the assets within that domain type or domain in the current period. The arrow next to each number indicates the trend of the number of visits compared with the previous period. An up arrow indicates that the number of visits in the current period is more than that in the previous period.A down arrow indicates that the number of visits in the current period is less than that in the previous period. A left arrow indicates that the number of visits in the current period is the same as that in the previous period.Above the table, Current Period shows the number of times that the users visited the assets within the selected domain type or domain in the current period, and Previous Period shows the corresponding number in the previous period. This data is also graphically represented as a trend line chart. You can hover your pointer over the solid (current period) or dotted (previous period) lines in the chart to compare the data between two corresponding days in the current and previous periods.The table contains the following columns.ColumnDescriptionAsset NameThe name of the asset that belongs to the selected domain type or domain.Domain NameThe name of the domain to which the asset belongs.Current VisitsThe number of times that the asset was visited in the current period.Previous VisitsThe number of times that the asset was visited in the previous period.Domain Type: Understanding the data on the Visitors tabOn the Visitors tab, in the left pane, the number that appears next to each domain type or domain indicates how many users visited the assets within that domain type or domain in the current period. The arrow next to each number indicates the trend of the number of visitors compared with the previous period.An up arrow indicates that the number of visitors in the current period is more than that in the previous period.A down arrow indicates that the number of visitors in the current period is less than that in the previous period. A left arrow indicates that the number of visitors in the current period is the same as that in the previous period.Above the table, Current Period shows the number of users who visited the assets within the selected domain type or domain in the current period, and Previous Period shows the corresponding number in the previous period. This data is also graphically represented as a trend line chart. You can hover your pointer over the solid (current period) or dotted (previous period) lines in the chart to compare the data between two corresponding days in the current and previous periods.The table contains the following columns.ColumnDescriptionAsset NameThe name of the asset that belongs to the selected domain type or domain.Domain NameThe name of the domain to which the asset belongs.Current VisitorsThe number of users who visited the asset in the current period.Previous VisitorsThe number of users who visited the asset in the previous period.Asset TypeThe Asset Type card shows five asset types of the assets that are visited the most in the current period. Depending on your permission, when you click the card, the Asset Type subsection appears with the following tabs:Visits: The number of times that the users visited the assets by asset types in the current period.Visitors: The number of users who visited the assets by asset types in the current period.The left pane on the Visits or Visitors tab shows a list of asset types for all communities in hierarchical order. Only the asset types that contain at least one asset are shown in the left pane. You can view the asset types for a specific community by selecting that community in the drop-down list box. You can search for a specific asset type by using the Search Asset Types search box.After having clicked an asset type in the left pane, if you want to go back to viewing the data for all asset types within the selected community, click the same asset type in the left pane again. When you view the data for all asset types, the label All appears above the table.VisitsVisitorsAsset Type: Understanding the data on the Visits tabOn the Visits tab, in the left pane, the number that appears next to each asset type indicates how many times the users visited the assets within that asset type in the current period. The arrow next to each number indicates the trend of the number of visits compared with the previous period. An up arrow indicates that the number of visits in the current period is more than that in the previous period.A down arrow indicates that the number of visits in the current period is less than that in the previous period. A left arrow indicates that the number of visits in the current period is the same as that in the previous period.Above the table, Current Period shows the number of times that the users visited the assets within the selected asset type in the current period, and Previous Period shows the corresponding number in the previous period. This data is also graphically represented as a trend line chart. You can hover your pointer over the solid (current period) or dotted (previous period) lines in the chart to compare the data between two corresponding days in the current and previous periods.The table contains the following columns.ColumnDescriptionAsset NameThe name of the asset that belongs to the selected asset type.Domain NameThe name of the domain to which the asset belongs.Current VisitsThe number of times that the asset was visited in the current period.Previous VisitsThe number of times that the asset was visited in the previous period.Asset Type: Understanding the data on the Visitors tabOn the Visitors tab, in the left pane, the number that appears next to each asset type indicates how many users visited the assets within that asset type in the current period. The arrow next to each number indicates the trend of the number of visitors compared with the previous period. An up arrow indicates that the number of visitors in the current period is more than that in the previous period.A down arrow indicates that the number of visitors in the current period is less than that in the previous period. A left arrow indicates that the number of visitors in the current period is the same as that in the previous period.Above the table, Current Period shows the number of users who visited the assets within the selected asset type in the current period, and Previous Period shows the corresponding number in the previous period. This data is also graphically represented as a trend line chart. You can hover your pointer over the solid (current period) or dotted (previous period) lines in the chart to compare the data between two corresponding days in the current and previous periods.The table contains the following columns.ColumnDescriptionAsset NameThe name of the asset that belongs to the selected asset type.Domain NameThe name of the domain to which the asset belongs.Current VisitorsThe number of users who visited the asset in the current period.Previous VisitorsThe number of users who visited the asset in the previous period.Download the Usage Analytics dataYou can download the data shown on any of the expanded cards on the Usage Analytics dashboard as a comma-separated values (CSV) file. The downloaded file contains only the first 50,000 rows of the table.Requirements and permissionsYou have either the Sysadmin global role or the Insights > View Usage Analytics reports global permission.StepsOpen the Usage Analytics dashboard.     Click the card whose data you want to download.The card expands to show a table with the detailed data.Click .The first 50,000 rows of the table are downloaded as a CSV file on your computer.    Customize a tableYou can customize the table that is shown when you click a card in the Visitors or Visits section. For example, you can choose to show or hide certain columns or sort the table in ascending or descending order. You can sort the table by the column values in ascending, descending, or original order by clicking the column heading. StepsIn the table, hover your pointer over any column heading.          If you want to hide a column or sort the values in a column, you must hover your pointer over that column heading.                     Click .Select one of the following options.OptionDescriptionSort by ASCSorts the values in the column in ascending order.Sort by DESCSorts the values in the column in descending order.HideHides the column from the table.Show columnsEnables you to select the columns that you want to be shown in the table. If you want to show all available columns, click Show all.
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	 Insights Data AccessThe objective of Insights Data Access is to make reporting easier for you. It captures all your reporting data from Collibra and enables you to build reports to visualize the data.Insights Data Access can retrieve vast amounts of data while retaining history and without jeopardizing the Collibra front-end performance. You can then use the Collibra Insights widget to show Tableau reports or any report that can be shown as an iframe on your Collibra dashboard. If you are not using Tableau, you can still leverage the definition of the SQL view.For information about how the different Insights Data Access tables can be linked, go to Insights Data Access entity relationship diagram.For some example reports showing how you can leverage the power of Insights Data Access, go to Dashboard reports.Working with your reporting data Working with your reporting dataStoring your reporting dataEach night, Collibra stores a copy of your reporting data—all assets, attributes, relations, and responsibilities, for all domains and communities, including your operating model customizations—in Collibra Data Intelligence Cloud. The copy includes both real and delta data values. Each data record includes the date on which the data was copied. These timestamped data records are copied each day and stored for a rolling period of 31 days. A copy of the data is also taken on the last day of each month, and these monthly snapshots are stored in Collibra Data Intelligence Cloud indefinitely.Processing and availability of the previous day's reporting dataReporting data is processed in the Coordinated Universal Time (UTC) time zone.The time at which the reporting data is ready (as identified in the last column of the following table) can vary depending on the amount of data.In the following table, local time refers to the time (daylight saving time, if applicable) in the relevant region. For example, when considering the time for London, 02:00 local time means 02:00 in London.Cloud providerLocationData dump (UTC)Processing begins (UTC)Reporting data is ready (UTC)AWSSingapore14:00(22:00 local time) 16:00(00:00 (midnight) local time)20:00(04:00 local time)AWSSydney14:00(00:00 (midnight) local time)16:00(02:00 local time)20:00(06:00 local time)AWSFrankfurt00:00 (midnight)(02:00 local time)02:00(04:00 local time)06:00(08:00 local time)AWSIreland00:00 (midnight)(00:00 local time)02:00(02:00 local time)06:00(06:00 local time)AWSLondon00:00 (midnight)(01:00 local time)02:00(03:00 local time)06:00(07:00 local time)AWSCentral Canada05:00(01:00 local time)06:00(02:00 local time)10:00(06:00 local time)AWSNorthern Virginia05:00(01:00 local time)06:00(02:00 local time)10:00(06:00 local time)AWSNorthern California08:00(01:00 local time)09:00(02:00 local time)13:00(06:00 local time)GCPTokyo05:00(14:00 local time)05:00(14:00 local time)10:00(19:00 local time)GCPSingapore07:00(15:00 local time)07:00(15:00 local time)12:00 (noon)(20:00 local time)GCPSydney14:00(00:00 (midnight) local time)14:00(00:00 (midnight) local time)19:00(05:00 local time)GCPBelgium00:00 (midnight)(02:00 local time)00:00 (midnight)(02:00 local time)05:00(07:00 local time)GCPLondon00:00 (midnight)(01:00 local time)00:00 (midnight)(01:00 local time)05:00(06:00 local time)GCPQuebec05:00(01:00 local time)05:00(01:00 local time)10:00(06:00 local time)GCPSouth Carolina05:00(01:00 local time)05:00(01:00 local time)10:00(06:00 local time)GCPVirginia05:00(01:00 local time)05:00(01:00 local time)10:00(06:00 local time)GCPIowa06:00(01:00 local time)06:00(01:00 local time)11:00(06:00 local time)Downloading your dataDue to security considerations, you cannot access the data directly on Collibra Data Intelligence Cloud. A REST API is created to enable you to download your reporting data to a local server or your computer. If you specify the snapshot date that you want in the REST API, a ZIP file of your reporting data for the specified date is downloaded to your hard disk. Connecting your data with your business intelligence toolAfter you have downloaded your reporting data, you must establish a connection between your data and your organization's business intelligence tool. This guide describes the procedures to do so via Amazon Web Services and Google Cloud Platform.If you need assistance, contact your internal IT infrastructure team, who can advise you as to where to store the downloaded files and how to establish the connection with your organization's business intelligence tool.
	Working with your reporting data
	 Dashboard reportsYou can configure three different dashboard reports.Data MaturityThe Data Maturity report helps you track the completeness of critical assets, based on the business dimensions used in an organization.Privacy & Risk ReadinessThe Privacy & Risk Readiness helps you track the development of your organization's data and progress towards compliance with the relevant regulation. You can drill down, to view the details relative to a specific regulation, for a specific community, and select the process registers you want to monitor.Drilling down further, you can monitor the process registers of specific lines of business, including the business processes, data sets and third-parties related to a specific process register.Process RegisterThe Process Register report shows the important information of every Business Process asset of every Process Register domain in your Collibra environment. You can download the report as a printable PDF.Insights Data Access tablesInsights Data Access contains the following tables, which reflect the data that can be accessed through the Collibra user interface:The community hierarchy.All domains.All assets, including assets of custom asset types.All asset tags.All attributes related to these assets, such as Definition, Description, and custom attributes types.All relations related to these assets, such as categorizes and is categorized by, including custom relation types.All complex relations.Responsibilities, such as Owner and Stakeholder, for a given resource.Only responsibilities that are directly assigned at the asset level or domain level are included in Insights Data Access; inherited responsibilities from the community level are excluded.This is the reporting data that is copied and stored in Collibra Data Intelligence Cloud on a daily basis.Creating Insights Data Access on AWS and generating reportsBefore configuring the dashboard reports, you must set up Insights Data Access on Amazon Web Services (AWS). You can then create your dashboard reports via Collibra Console or URL.Set up Insights Data Access on AWSThis section describes how to set up Insights Data Access on Amazon Web Services (AWS) with S3 bucket storage and AWS Athena query service. You can, however, use alternative software. For information about how to set up Insights Data Access on the Google Cloud Platform, go to Set up Insights Data Access on GCP. Requirements and permissionsCollibra Data Intelligence Cloud 5.7 or newer.License for Collibra Insights.Software for working with Parquet files.StepsDownload a data snapshot from your Collibra environment.Upload the data to an S3 bucket.Download Insights Data Access from Collibra Marketplace.Set up the Insights Data Access model in AWS Athena.Step 1: Download a data snapshot from your Collibra DGC environmentEnter the following URL in your browser: <your-DGC-environment-URL>/rest/2.0/reporting/insights/download?snapshotDate=<snapshot_date>&format=zipwhere, <snapshot date> is the date from which you want the data, formatted as YYYY-MM-DD, for example 2019-07-23.A ZIP file of the data from your Collibra environment, for the specified date, is downloaded to your hard disk.Extract the ZIP files on your local computer.A folder with the name of the ZIP file is created.Step 2: Upload the data to an S3 bucketThis only needs to be done once for the collection Tableau workbook files. After that, you only need to carry out this step If the data layer model changes.Sign in to your AWS account.In the main menu, expand the Services page, and then select S3.On the Buckets tab, click Create bucket.The Create bucket dialog box appears.In the Bucket name field, enter a name for the bucket you are creating, for example collibra-insights.Click Next.Click Next to bypass the configuration options.Clear the Block all public access check box to allow access to Tableau.Click Next.Click Create bucket.The bucket is created.On the Buckets tab, search for your newly created bucket, and then click it.The bucket details page opens.Click Upload to upload the data you downloaded from your Collibra environment.The Upload dialog box appears.Click Add files, or drag all of the folders in the ZIP file you downloaded from your Collibra environment into the dialog box. The folders appear in the Upload dialog box.Click Upload.The folders are added to the newly created bucket.Step 3: Download the Insights Data Access package from Collibra MarketplaceGo to Collibra Marketplace.Download the Insights Data Access package.A ZIP file is downloaded to your hard disk.Extract the ZIP file on your local computer.A folder with the name of the ZIP file is created.Step 4: Create the Insights Data Access model in AWS AthenaOn the AWS main menu, expand the Services page, and then select Athena.On the New query tab, enter CREATE DATABASE <name-of-the-database>;. As shown in the following image (example), a database named collibra_rpt is already created.Click Run query.On the Database drop-down menu, select the database you created.Click + to add another query.In the Insights Data Access ZIP file you downloaded from the Marketplace, drag the first SQL file into a new query tab.The code appears in the query tab.Change the location to the recently created bucket.In this example, {{customer_data_location}} is replaced with collibra-insights.Click Run query.Repeat Steps 5 through 7 for each of the SQL files in the Insights Data Access ZIP file.When all the steps are completed, all table definitions are shown and Insights Data Access is fully configured.Generate dashboard reports via AWSAfter setting up Insights Data Access on Amazon Web Services (AWS), you can generate dashboard reports configured in Collibra Console.You can also generate dashboard reports via URL.Before you beginSet up Insights Data Access on AWSGCP.Requirements and permissionsThe Insights global role, to be able to view a report in Collibra Data Intelligence Cloud.A license for Tableau Desktop 2018.3.A Tableau Server or Tableau Online account.The athena:GetQueryResultsStream AWS permission, to be able to get the reporting data from AWS.StepsDownload the report templates from Collibra MarketplaceInstall the SQL views associated with the Tableau workbook filesPublish the workbook files to your Tableau Server or Tableau Online account and configure a database extract refresh schedule eventConfigure the reporting options in Collibra SettingsAdd a dashboard in Collibra and configure the Insights widgetStep 1: Download the report templates from Collibra Marketplace        Go to Collibra Marketplace.      Download the following three report template packages:Process Register Report TemplatePrivacy and Risk Readiness Report TemplateData Maturity Report TemplateThe three ZIP files are downloaded to your hard disk.Extract the ZIP files on your local computer.Folders with the names of the ZIP files are created. Each folder contains a SQL file and a TWBX file.Step 2: Install the SQL views associated with the Tableau workbook filesIf this is the first time you are installing the SQL views, you must perform this step for each of the Tableau workbook files.If you have previously installed the SQL views but are now installing a new version of a report, you must install the new SQL view, if one was provided with the new report.On the AWS main menu, expand the Services page, and then select Athena.On the Database menu, select the relevant database.Click + to add another query.In one of the report template package ZIP files you downloaded from Collibra Marketplace, drag the SQL file to a new query tab.The code appears in the query tab.Click Run query.Repeat Steps 3 through 5 for the SQL files in the other two report template packages.Step 3: Publish the workbook files to your Tableau Server or Online account and configure a refresh schedule eventOn your hard drive, go to the folder of one of the report templates you downloaded from Collibra Marketplace (for example, DataMaturity).Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).      If the following dialog box appears, click Yes.Perform one of the following steps:If the following dialog box appears, click Edit connection.If the Tableau dashboard is shown, click the Data Source tab in the lower-left corner of the page.Enter the information specific to your AWS server.Click Sign in.If you now receive an error, it may be an indication that the data source collibra_rpt is not configured. In this case, consider editing the connection details to point to the data source you have created.In the upper-right corner of the page, select an Extract connection.In the lower-left corner of the page, click the Dashboard tab.In the Save As dialog box, enter a name for the database extract file.Click Save.The extract file is saved and a database extract is cached. This can take several minutes to complete.When the dashboard is loaded, click or File > Save to save the database extract.On the main menu, click Server, and then click Sign In.In the Tableau Server Sign in dialog box, click Connect.Enter your Tableau sign in credentials.Select the site to which you want to publish the Tableau workbook.Click Server, and then select Publish Workbook.The following dialog box appears.Enter the required information.For the current task, the following fields are of interest.PropertyDescriptionProjectThe project to which you want to publish.NameThe name of the workbook.Refresh Schedule (Full Extract)The frequency with which the currently cached database extract is purged and a new extract is cached.Collibra recommends scheduling a daily refresh.SheetsAllows you to specify which sheets to include in the publication. You can hide sheets if you want to publish a dashboard without showing all the worksheets that were used to create it.To avoid clutter, consider clicking Edit and then clicking Only Dashboards.Data SourcesDetermines: Whether the data is embedded in the workbook or published separately.How users authenticate with data sources.Collibra recommends the following settings: Click Edit, and then:In the Publish Type drop-down menu, select Embedded in workbook.This enables users to view the report without having to authenticate themselves every time.In the Authentication drop-down menu, select Allow refresh access.This automatically refreshes the extract of the database. The frequency with which the cache is refreshed is determined by the value you enter in the Refresh Schedule field.More optionsAdditional publication options. Include external files determines whether or not external files are included in the publication.Only the DataMaturityDashboard.twbx file refers to external files. The Include external files option is not available for the other Tableau workbook files.Ensure that Include external files is selected, so that the images included with the Tableau workbook files are included in the publication.Click Publish.The report is published to your Tableau Server or Online account.On the Refresh Schedules tab, the refresh schedule event you configured is shown.Step 4: Configure the reporting options in Collibra SettingsOn the Workbooks tab in Tableau, click one of the workbook files, for example Privacy & Risk Readiness.Click Dashboard.Click Share.In the Share dialog box, copy the URL in the Link field.        Open Collibra Console with a user profile that has at least the ADMIN role.Collibra Console opens with the Infrastructure page.    In the tab pane, click   the Data Governance Center service of a Collibra environment.The details of the DGC service are shown.Click Configuration.Click Edit configuration.Scroll down the list of configuration options and click Reporting.In field Tableau report URL pattern, paste the URL that you copied from the Link field in Tableau.In the URL, replace the actual report name (such as DataMaturityDashboard) by {reportName}, for example:https://tableau-dev2.<your-Collibra-Data-Intelligence-Cloud-environment-URL>/t/Insights/views/{reportName}/iframeSizedToWindow=true&...Under Reports definitions, click Add.You must perform this step for all three reports.In a Report view name, enter the name of a report, as you want it to appear on the report button in the Insights widget, for example: Data Maturity DashboardPrivacy & Risk ReadinessProcess Registerln b Report name, enter the report name, for example:DataMaturityDashboardPrivacyRiskReadinessProcessRegisterUse the name as it appears in the URL of the Tableau report, for example DataMaturityDashboard.The settings in Console should look similar to the following example image:Click Add, and then add the report definitions for the remaining two reports.Click Save all.Step 5: Add a dashboard in Collibra and configure the Insights widgetTo facilitate the viewing of each report, we recommend that you add and configure a separate dashboard for each report. To do so, you have to complete this step for each report.In the Collibra main menu, click → Dashboards.In the view bar, click → Add Dashboard.Enter the required information.PropertyDescriptionNameThe name of your new dashboard. DescriptionA description of the dashboard (optional).LayoutThe number of columns in the layout of the dashboard.Ensure that 1 column is selected.Always visible in the toolbar.Option to always show the dashboard in the toolbar.Click Save.In the view bar, click → Edit widgets.Find the Insights widget and drag it onto the dashboard.The three reports that you configured in Collibra Settings are shown:Select the report you want to show on the dashboard.Click Save.The report is shown on the dashboard you created.What's next?Optionally, you can:Remove non-applicable regulation placeholder.Improve the visual output of the Data Maturity report.Generate a dashboard report via URL on AWSAfter setting up Insights Data Access on Amazon Web Services, you can generate a dashboard report via a URL, from tools such as Tableau Online, Power BI, Qlik, or ThoughtSpot.Requirements and permissionsThe Insights global role, to be able to view a report in Collibra Data Intelligence Cloud.A license for Tableau Desktop 2018.3.A Tableau Server or Tableau Online account.The athena:GetQueryResultsStream AWS permission, to be able to get the reporting data from AWS.StepsDownload the report templates from Collibra MarketplaceInstall the SQL views associated with the Tableau workbook filesPublish the workbook files to your Tableau Server or Tableau Online account and configure a database extract refresh schedule eventObtain the shareable linkAdd a dashboard in Collibra and add your report via URLStep 1: Download the report templates from Collibra Marketplace        Go to Collibra Marketplace.      Download the following three report template packages:Process Register Report TemplatePrivacy and Risk Readiness Report TemplateData Maturity Report TemplateThe three ZIP files are downloaded to your hard disk.Extract the ZIP files on your local computer.Folders with the names of the ZIP files are created. Each folder contains a SQL file and a TWBX file.Step 2: Install the SQL views associated with the Tableau workbook filesIf this is the first time you are installing the SQL views, you must perform this step for each of the Tableau workbook files.If you have previously installed the SQL views but are now installing a new version of a report, you must install the new SQL view, if one was provided with the new report.On the AWS main menu, expand the Services page, and then select Athena.On the Database menu, select the relevant database.Click + to add another query.In one of the report template package ZIP files you downloaded from Collibra Marketplace, drag the SQL file to a new query tab.The code appears in the query tab.Click Run query.Repeat Steps 3 through 5 for the SQL files in the other two report template packages.Step 3: Publish the workbook files to your Tableau Server or Online account and configure a refresh schedule eventOn your hard drive, go to the folder of one of the report templates you downloaded from Collibra Marketplace (for example, DataMaturity).Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).      If the following dialog box appears, click Yes.Perform one of the following steps:If the following dialog box appears, click Edit connection.If the Tableau dashboard is shown, click the Data Source tab in the lower-left corner of the page.Enter the information specific to your AWS server.Click Sign in.If you now receive an error, it may be an indication that the data source collibra_rpt is not configured. In this case, consider editing the connection details to point to the data source you have created.In the upper-right corner of the page, select an Extract connection.In the lower-left corner of the page, click the Dashboard tab.In the Save As dialog box, enter a name for the database extract file.Click Save.The extract file is saved and a database extract is cached. This can take several minutes to complete.When the dashboard is loaded, click or File > Save to save the database extract.On the main menu, click Server, and then click Sign In.In the Tableau Server Sign in dialog box, click Connect.Enter your Tableau sign in credentials.Select the site to which you want to publish the Tableau workbook.Click Server, and then select Publish Workbook.The following dialog box appears.Enter the required information.For the current task, the following fields are of interest.PropertyDescriptionProjectThe project to which you want to publish.NameThe name of the workbook.Refresh Schedule (Full Extract)The frequency with which the currently cached database extract is purged and a new extract is cached.Collibra recommends scheduling a daily refresh.SheetsAllows you to specify which sheets to include in the publication. You can hide sheets if you want to publish a dashboard without showing all the worksheets that were used to create it.To avoid clutter, consider clicking Edit and then clicking Only Dashboards.Data SourcesDetermines: Whether the data is embedded in the workbook or published separately.How users authenticate with data sources.Collibra recommends the following settings: Click Edit, and then:In the Publish Type drop-down menu, select Embedded in workbook.This enables users to view the report without having to authenticate themselves every time.In the Authentication drop-down menu, select Allow refresh access.This automatically refreshes the extract of the database. The frequency with which the cache is refreshed is determined by the value you enter in the Refresh Schedule field.More optionsAdditional publication options. Include external files determines whether or not external files are included in the publication.Only the DataMaturityDashboard.twbx file refers to external files. The Include external files option is not available for the other Tableau workbook files.Ensure that Include external files is selected, so that the images included with the Tableau workbook files are included in the publication.Click Publish.The report is published to your Tableau Server or Online account.On the Refresh Schedules tab, the refresh schedule event you configured is shown.Step 4: Obtain the shareable linkOn the Workbooks tab in Tableau, click one of the workbook files, for example Privacy & Risk Readiness.Click Dashboard.Click Share.In the Share dialog box, copy the URL in the Link field.Step 5: Add a dashboard in Collibra and then add your report via URLTo facilitate the viewing of each report, consider adding and configuring a separate dashboard for each report. To do so, you must complete this step for each report.On the Collibra main menu, click → Dashboards.In the view bar, click → Add Dashboard.Enter the required information.PropertyDescriptionNameThe name of your new dashboard. Description (optional)A description of the dashboard.LayoutThe number of columns in the layout of the dashboard.Ensure that 1 column is selected.Always visible in the toolbar.Option to always show the dashboard in the toolbar.Click Save.In the view bar, click → Edit widgets.Find the Insights widget, and then drag it to the dashboard.Click Enter a URL, and then enter the relevant URL.Click Save.The report is shown on the dashboard you created.What's next?Optionally, you can:Remove non-applicable regulation placeholder.Improve the visual output of the Data Maturity report.Creating Insights Data Access on GCP and generating reportsBefore configuring the dashboard reports, you must set up Insights Data Access on Google Cloud Platform (GCP). You can then create your dashboard reports via Collibra Console or URL.Set up Insights Data Access on GCPThis section describes how to set up Insights Data Access on the Google Cloud Platform (GCP) with Google Cloud Storage and Google BigQuery. You can, however, use alternative software. For information about how to set up Insights Data Access on Amazon Web Services, go to Set up Insights Data Access on AWS.Requirements and permissionsCollibra Data Intelligence Cloud 5.7 or newer.License for Collibra Insights.Software for working with Parquet files.StepsDownload a data snapshot from your Collibra environment.Upload the data to a Google Cloud Storage bucket.Create the Insights Data Access model in Google BigQuery.Step 1: Download a data snapshot from your Collibra DGC environmentEnter the following URL in your browser: <your-DGC-environment-URL>/rest/2.0/reporting/insights/download?snapshotDate=<snapshot_date>&format=zipwhere, <snapshot date> is the date from which you want the data, formatted as YYYY-MM-DD, for example 2019-07-23.A ZIP file of the data from your Collibra environment, for the specified date, is downloaded to your hard disk.Extract the ZIP files on your local computer.A folder with the name of the ZIP file is created.Step 2: Upload the data to a Google Cloud Storage bucketThis only needs to be done once for the collection Tableau workbook files. After that, you only need to carry out this step If the data layer model changes.Sign in to your GCP account and choose your working project for Insights deployment.We recommend that you create a separate project for Insights deployment.On the tab menu, click the Storage tab and then click Cloud Storage.On the Browser tab, click Create bucket.The Create a bucket dialog box appears.In the Name your bucket field, enter a name for the bucket you are creating, for example collibra-insights.Click Continue.        In the Choose where to store your data section, enter the relevant values, for example:Location type: Multi-regionLocation: Your geographic locationConsult your IT department for help with the correct values for your Collibra environment configuration and to ensure compliance with your company policies.Click Continue.In the Choose a default storage class for your data section, click Standard.Click Continue.in the Choose how to control access to objects section, enter the relevant values, for example:Access control: UniformConsult your IT department for help with the correct values for your Collibra environment configuration and to ensure compliance with your company policies.Click Continue.In the Choose how to protect object data section, enter the relevant values, for example:Protection tool: NoneConsult your IT department for help with the correct values for your Collibra environment configuration and to ensure compliance with your company policies.Click Create.The bucket is created.On the Browse tab, search for your newly created bucket, and then click it.The bucket details page opens.Click Upload Folder to upload the data you downloaded from your Collibra environment.The Upload dialog box appears.In the Upload dialog box, find the unpacked folders of the ZIP file you downloaded from your Collibra environment. As shown in the following image, there are eight folders to be uploaded.Select a folder, for example complex_relation, and then click Upload.You can only select one folder at a time.Repeat Steps 15 through 17 until you have uploaded all eight folders.The folders are added to the newly created bucket.Step 3: Create the Insights Data Access model in Google BigQueryThe objective of Steps 6 through 8 in the following procedure can also be achieved by using a Cloud shell command.On the left tab menu, in the BIG DATA section, click BigQuery.On the Explorer page, find your Insights project, and then click > Create dataset.In the Create dataset side panel, enter the relevant information.FieldDescriptionDataset IDA unique name for your dataset.Data locationThe geographical region of your data.Consult your IT department for help with the correct value for your Collibra environment configuration and to ensure compliance with your company policies.Click Create dataset.In the Explorer page, find your newly created dataset, and then click > Open.The dataset view page opens.In the dataset view page, click Create table.The Create table side panel opens.In the Create table section, enter the relevant information.FieldDescriptionCreate table fromSelect Google Cloud Storage.Select file from GCS bucketEnter <your-data-bucket-name>/<data type>/*.parquet The bucket name is the one you created in Step 2.4 and the data type, for example asset, is the sub-directory location.Step 9 of this procedure prompts you to repeat Steps 6 through 8, for each data type, for example, asset, attributes, relation, responsibility, and so on.File formatSelect Parquet.Source Data PartitioningThis checkbox must be cleared.Search for a project / Enter a project nameSelect the Search for a project option.Project nameSelect the project you are using for Insights deployment.Dataset nameSelect the database name you entered in Step 3.3.Table typeSelect Native table.Table nameEnter the data type. This must match the data type entered for the sub-directory location in the Select file from GCS bucket field.Step 9 of this procedure prompts you to repeat Steps 6 through 8, for each data type, for example, asset, attribute, relation, responsibility, and so on. Click Create table.Repeat Steps 6 through 8 for each data type in the file you downloaded in Step 1.1, for example, asset, relation, responsibility, and so on.When all the steps are completed, all table definitions are shown and Insights Data Access is fully configured.Use a Cloud shell commandThe objective of Steps 6 through 8 in the previous procedure can also be achieved by using a Cloud shell command.Run the following command, where <customer-dataset-name> and <customer-data-bucket> are replaced with the relevant values. bq load \ --noreplace \ --source_format=PARQUET \ <customer-dataset-name>.asset \ gs://<customer-data-bucket>/asset/*.parquet bq load \ --noreplace \ --source_format=PARQUET \ <customer-dataset-name>.asset_tag \ gs://<customer-data-bucket>/asset_tag/*.parquet bq load \ --noreplace \ --source_format=PARQUET \ customer-dataset-name>.attribute \ gs://<customer-data-bucket>/attribute/*.parquet bq load \ --noreplace \ --source_format=PARQUET \ <customer-dataset-name>.community \ gs://<customer-data-bucket>/community/*.parquet bq load \ --noreplace \ --source_format=PARQUET \ <customer-dataset-name>.complex_relation \ gs://<customer-data-bucket>/complex_relation/*.parquet bq load \ --noreplace \ --source_format=PARQUET \ <customer-dataset-name>.domain \ gs://<customer-data-bucket>/domain/*.parquet bq load \ --noreplace \ --source_format=PARQUET \ <customer-dataset-name>.relation \ gs://<customer-data-bucket>/relation/*.parquet bq load \ --noreplace \ --source_format=PARQUET \ <customer-dataset-name>.responsibility \ gs://<customer-data-bucket>/responsibility/*.parquet Generate dashboard reports via GCPAfter setting up Insights Data Access on Google Cloud Platform (GCP), you can generate dashboard reports configured in Collibra Console.You can also generate dashboard reports via URL.Before you beginCreate Insights Data Access on AWSGCP.Requirements and permissionsThe Insights global role, to be able to view a report in Collibra Data Intelligence Cloud.A license for Tableau Desktop 2018.3.A Tableau Server or Tableau Online account.The athena:GetQueryResultsStream AWS permission, to be able to get the reporting data from AWS.StepsDownload the report templates from Collibra MarketplaceInstall the SQL views associated with the Tableau workbook filesPublish the workbook files to your Tableau Server or Tableau Online account and configure a database extract refresh schedule eventConfigure the reporting options in Collibra SettingsAdd a dashboard in Collibra and configure the Insights widgetStep 1: Download the report templates from Collibra Marketplace        Go to Collibra Marketplace.      Download the following three report template packages:Process Register Report TemplatePrivacy and Risk Readiness Report TemplateData Maturity Report TemplateThe three ZIP files are downloaded to your hard disk.Extract the ZIP files on your local computer.Folders with the names of the ZIP files are created. Each folder contains a SQL file and a TWBX file.Step 2: Install the SQL views associated with the Tableau workbook filesIf this is the first time you are installing the SQL views, you must perform this step for each of the Tableau workbook files.If you have previously installed the SQL views but are now installing a new version of a report, you must install the new SQL view, if one was provided with the new report.In the BIG DATA section of the GCP left-hand menu, click BigQuery.In the Explorer page, click COMPOSE NEW QUERY.From one of the report template packages you downloaded from Collibra Marketplace, drag one of the SQL files to a new query tab.The code appears on the query tab.In the code, change any occurrences of <customer_dataset> to <the-name-of-your-Insights-dataset>.The dataset name is the value you entered in the Dataset ID field in Step 3 of the Create the Reporting Data Layer on Google Cloud Platform procedure.Click Save > Save View.The Save view dialog box appears.In the Save view dialog box, enter the relevant information:FieldDescriptionProjectThe project you are using for Insights deployment.Dataset IDThe value you entered in the Dataset ID field in Step 3 of the Create the Reporting Data Layer on Google Cloud Platform procedure.Table nameThe name of the report SQL file, for example data_maturity.Repeat Steps 3 through 5 for the SQL files in the other two report template packages.Step 3: Publish the workbook files to your Tableau Server or Online account and configure a refresh schedule eventOn your hard drive, go to the folder of one of the report templates you downloaded from Collibra Marketplace (for example, DataMaturity).Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).The Google sign in page appears.Select the relevant Google account.You are prompted to allow Tableau to access your Google account.        Ensure that both access options are selected, and then click Allow.              In the Tableau DataMaturityDashboard, click Edit Connection in the Dashboard Unavailable notification.The Data Source tab opens.Specify the following information.FieldDescriptionProjectThe project you are using for Insights deployment.DatasetWhat the user should choose.In the Table section, double-click the data_maturity view.The view appears in the main frame, indicating that a link to the data is made.In the upper-right corner of the page, select an Extract connection.In the lower-left corner of the page, click the Dashboard tab.In the Save As dialog box, enter a name for the database extract file.Click Save.The extract file is saved and a database extract is cached. This can take several minutes to complete.When the dashboard is loaded, click or File > Save, to save the database extract.On the main menu, click Server, and then click Sign In.In the Tableau Server Sign in dialog box, click Connect.Enter your Tableau sign in credentials.Select the site to which you want to publish the Tableau workbook.Click Server, and then select Publish Workbook.The following dialog box appears.Enter the required information.For this task, the following fields are of interest.PropertyDescriptionProjectThe project to which you want to publish.NameThe name of the workbook.Refresh Schedule (Full Extract)The frequency with which the currently cached database extract is purged and a new extract is cached.Collibra recommends that you schedule a daily refresh.SheetsAllows you to specify which sheets to include in the publication. You can hide sheets if you want to publish a dashboard without showing all the worksheets that were used to create it.To avoid clutter, Collibra recommends that you click Edit and then click Only Dashboards.Data SourcesDetermines: Whether the data is embedded in the workbook or published separately.How users authenticate with data sources.Collibra strongly recommends the following settings: Click Edit and then:In the Publish Type drop-down menu, select Embedded in workbook.This enables users to view the report without having to authenticate themselves every time.In the Authentication drop-down menu, select Allow refresh access.This automatically refreshes the extract of the database. The frequency with which the cache is refreshed is determined by the value you enter in the Refresh Schedule field.More optionsAdditional publication options. Include external files determines whether or not external files are included in the publication.Only the DataMaturityDashboard.twbx file refers to external files. The Include external files option is not available for the other Tableau workbook files.Ensure that the Include external files is selected, so that the images included with the Tableau workbook files are included in the publication.Click Publish.The report is published to your Tableau Server or Online account.On the Refresh Schedules tab, the refresh schedule event you configured is shown.Step 4: Configure the reporting options in Collibra SettingsOn the Workbooks tab in Tableau, click one of the workbook files, for example Privacy & Risk Readiness.Click Dashboard.Click Share.In the Share dialog box, copy the URL in the Link field.        Open Collibra Console with a user profile that has at least the ADMIN role.Collibra Console opens with the Infrastructure page.    In the tab pane, click   the Data Governance Center service of a Collibra environment.The details of the DGC service are shown.Click Configuration.Click Edit configuration.Scroll down the list of configuration options and click Reporting.In field Tableau report URL pattern, paste the URL that you copied from the Link field in Tableau.In the URL, replace the actual report name (such as DataMaturityDashboard) by {reportName}, for example:https://tableau-dev2.<your-Collibra-Data-Intelligence-Cloud-environment-URL>/t/Insights/views/{reportName}/iframeSizedToWindow=true&...Under Reports definitions, click Add.You must perform this step for all three reports.In a Report view name, enter the name of a report, as you want it to appear on the report button in the Insights widget, for example: Data Maturity DashboardPrivacy & Risk ReadinessProcess Registerln b Report name, enter the report name, for example:DataMaturityDashboardPrivacyRiskReadinessProcessRegisterUse the name as it appears in the URL of the Tableau report, for example DataMaturityDashboard.The settings in Console should look similar to the following example image:Click Add, and then add the report definitions for the remaining two reports.Click Save all.Step 5: Add a dashboard in Collibra and configure the Insights widgetTo facilitate the viewing of each report, we recommend that you add and configure a separate dashboard for each report. To do so, you have to complete this step for each report.In the Collibra main menu, click → Dashboards.In the view bar, click → Add Dashboard.Enter the required information.PropertyDescriptionNameThe name of your new dashboard. DescriptionA description of the dashboard (optional).LayoutThe number of columns in the layout of the dashboard.Ensure that 1 column is selected.Always visible in the toolbar.Option to always show the dashboard in the toolbar.Click Save.In the view bar, click → Edit widgets.Find the Insights widget and drag it onto the dashboard.The three reports that you configured in Collibra Settings are shown:Select the report you want to show on the dashboard.Click Save.The report is shown on the dashboard you created.What's next?Optionally, you can:Remove non-applicable regulation placeholder.Improve the visual output of the Data Maturity report.Generate a dashboard report via URL on GCPAfter setting up Insights Data Access on Google Cloud Platform, you can generate a dashboard report via a URL, from tools such as Tableau Online, Power BI, Qlik, or ThoughtSpot.Requirements and permissionsThe Insights global role, to be able to view a report in Collibra Data Intelligence Cloud.A license for Tableau Desktop 2018.3.A Tableau Server or Tableau Online account.The athena:GetQueryResultsStream AWS permission, to be able to get the reporting data from AWS.StepsDownload the report templates from Collibra MarketplaceInstall the SQL views associated with the Tableau workbook filesPublish the workbook files to your Tableau Server or Tableau Online account and configure a database extract refresh schedule eventObtain the shareable linkAdd a dashboard in Collibra and add your report via URLStep 1: Download the report templates from Collibra Marketplace        Go to Collibra Marketplace.      Download the following three report template packages:Process Register Report TemplatePrivacy and Risk Readiness Report TemplateData Maturity Report TemplateThe three ZIP files are downloaded to your hard disk.Extract the ZIP files on your local computer.Folders with the names of the ZIP files are created. Each folder contains a SQL file and a TWBX file.Step 2: Install the SQL views associated with the Tableau workbook filesIf this is the first time you are installing the SQL views, you must perform this step for each of the Tableau workbook files.If you have previously installed the SQL views but are now installing a new version of a report, you must install the new SQL view, if one was provided with the new report.In the BIG DATA section of the GCP left-hand menu, click BigQuery.In the Explorer page, click COMPOSE NEW QUERY.From one of the report template packages you downloaded from Collibra Marketplace, drag one of the SQL files to a new query tab.The code appears on the query tab.In the code, change any occurrences of <customer_dataset> to <the-name-of-your-Insights-dataset>.The dataset name is the value you entered in the Dataset ID field in Step 3 of the Create the Reporting Data Layer on Google Cloud Platform procedure.Click Save > Save View.The Save view dialog box appears.In the Save view dialog box, enter the relevant information:FieldDescriptionProjectThe project you are using for Insights deployment.Dataset IDThe value you entered in the Dataset ID field in Step 3 of the Create the Reporting Data Layer on Google Cloud Platform procedure.Table nameThe name of the report SQL file, for example data_maturity.Repeat Steps 3 through 5 for the SQL files in the other two report template packages.Step 3: Publish the workbook files to your Tableau Server or Online account and configure a refresh schedule eventOn your hard drive, go to the folder of one of the report templates you downloaded from Collibra Marketplace (for example, DataMaturity).Open the Tableau Workbook file (in this example, DataMaturityDashboard.twbx).The Google sign in page appears.Select the relevant Google account.You are prompted to allow Tableau to access your Google account.        Ensure that both access options are selected, and then click Allow.              In the Tableau DataMaturityDashboard, click Edit Connection in the Dashboard Unavailable notification.The Data Source tab opens.Specify the following information.FieldDescriptionProjectThe project you are using for Insights deployment.DatasetWhat the user should choose.In the Table section, double-click the data_maturity view.The view appears in the main frame, indicating that a link to the data is made.In the upper-right corner of the page, select an Extract connection.In the lower-left corner of the page, click the Dashboard tab.In the Save As dialog box, enter a name for the database extract file.Click Save.The extract file is saved and a database extract is cached. This can take several minutes to complete.When the dashboard is loaded, click or File > Save, to save the database extract.On the main menu, click Server, and then click Sign In.In the Tableau Server Sign in dialog box, click Connect.Enter your Tableau sign in credentials.Select the site to which you want to publish the Tableau workbook.Click Server, and then select Publish Workbook.The following dialog box appears.Enter the required information.For this task, the following fields are of interest.PropertyDescriptionProjectThe project to which you want to publish.NameThe name of the workbook.Refresh Schedule (Full Extract)The frequency with which the currently cached database extract is purged and a new extract is cached.Collibra recommends that you schedule a daily refresh.SheetsAllows you to specify which sheets to include in the publication. You can hide sheets if you want to publish a dashboard without showing all the worksheets that were used to create it.To avoid clutter, Collibra recommends that you click Edit and then click Only Dashboards.Data SourcesDetermines: Whether the data is embedded in the workbook or published separately.How users authenticate with data sources.Collibra strongly recommends the following settings: Click Edit and then:In the Publish Type drop-down menu, select Embedded in workbook.This enables users to view the report without having to authenticate themselves every time.In the Authentication drop-down menu, select Allow refresh access.This automatically refreshes the extract of the database. The frequency with which the cache is refreshed is determined by the value you enter in the Refresh Schedule field.More optionsAdditional publication options. Include external files determines whether or not external files are included in the publication.Only the DataMaturityDashboard.twbx file refers to external files. The Include external files option is not available for the other Tableau workbook files.Ensure that the Include external files is selected, so that the images included with the Tableau workbook files are included in the publication.Click Publish.The report is published to your Tableau Server or Online account.On the Refresh Schedules tab, the refresh schedule event you configured is shown.Step 4: Obtain the shareable linkOn the Workbooks tab in Tableau, click one of the workbook files, for example Privacy & Risk Readiness.Click Dashboard.Click Share.In the Share dialog box, copy the URL in the Link field.Step 5: Add a dashboard in Collibra and then add your report via URLTo facilitate the viewing of each report, consider adding and configuring a separate dashboard for each report. To do so, you must complete this step for each report.On the Collibra main menu, click → Dashboards.In the view bar, click → Add Dashboard.Enter the required information.PropertyDescriptionNameThe name of your new dashboard. Description (optional)A description of the dashboard.LayoutThe number of columns in the layout of the dashboard.Ensure that 1 column is selected.Always visible in the toolbar.Option to always show the dashboard in the toolbar.Click Save.In the view bar, click → Edit widgets.Find the Insights widget, and then drag it to the dashboard.Click Enter a URL, and then enter the relevant URL.Click Save.The report is shown on the dashboard you created.What's next?Optionally, you can:Remove non-applicable regulation placeholder.Improve the visual output of the Data Maturity report.
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	 Improve the visual output of the Data Maturity reportA well configured Data Maturity report will look something like the following image.However, it's possible that you correctly configured the Data Maturity report, but it looks more like the following image.Common scenarios and tipsHere are some common scenarios, explanations and tips for improving the visual output of the report.The progress circle charts show 0%In the following example image, the Ownership progress circle chart shows 0%.If you go to the Ownership Metrics tab, you see that there are many Business Term assets for inclusion in the report. One might expect that the presence of these assets would be reflected in the circle chart. However, the formula for calculating the percentage entails a division operation involving the number of assets with the status Approved. In this example, there are no assets that have the status Approved, and this 0 value results in an Ownership percentage of 0%.Keep in mind that progress circle charts are reliant on approved assets. In other words, the more mature the data set, the more meaningful the progress circle chart will be.No progress circle chart is shownIn the following example image, no progress circle chart is shown for the Data Model metric.Ensure that the relevant asset types are selected for the Data Model metric. At the bottom of the page, click the Data Model Metrics tab.In the Data tab, select Data Models Asset Types, and then select Edit Set.The Edit Set dialog box appears; however, no asset types are selected.Select the asset types that you want to monitor, for example Data Model, Data Entity and Data Attribute.Click OK.The data is now shown, in accordance with the selected asset types.Keep in mind that the formula for calculating the percentage entails a division operation involving the number of assets with the status Approved.On the Dashboard tab, the progress circle chart is now shown for the Data Model metric.The report includes non-applicable metricsIn this example image, we are not interested in the Data Structure, Reference Data, Authoritative Source and Distribution Source metrics, and want to remove them from the report.Remove a single metricSelect a single metric.You might have to first select the section, for example Enterprise, and drag the frame so that you can click an individual metric.Click the Remove from dashboard icon .Remove several metrics at onceClick in the Community section, so that the entire section is highlighted.Click the go to sheet icon .The Community data sheet opens.In the Measure Values section, select the metrics that you want to remove.In this example, we selected Data Structure, Reference Data, Authoritative Source and Distribution Source.Right-click on the selected metrics and select Remove.The metrics at the Community level are deleted.Assets you expected to see in the report are not shownIf assets that you expected to see in the report are not shown, it could be that the status of the assets are not correctly reflected in the relevant measures. By default, the reports are configured to show only assets with the status Approved. Assets with other statuses will not be shown in the reports.The report templates, however, are fully configurable. You can edit the relevant measures, to include other statuses, such as Accepted.Click in the Community section, so that the entire section is highlighted.Click the go to sheet icon .The Community data sheet opens.In the Measure Values section, select the measure that you want to edit.In this example, we selected Approved Definition Assets.Right-click on the selected measure and select Edit.In the calculation logic, change the asset status from Approved to the status you want, for example Accepted.Click OK.
	 Insights Data Access entity relationship diagramThe following Entity Relationship Diagram image shows how the different Insights Data Access tables can be linked. All tables contain both packaged variants and custom variants of the concept. Nested communities can be identified via the parent-child relation. Subcommunities also have the ID of the community stored next to them. To combine data for a given date, each table link clause must include snapshot_date.Tablestable_nameDescriptionAssetContains all of the assets in your Collibra Data Intelligence Cloud environment, including each asset's type and current status.Asset_tagContains all of the tags attached to the assets in your Collibra environment.AttributeContains all of the asset attributes in your Collibra environment.CommunityContains all of the communities in your Collibra environment, including subcommunities and domains.Complex_relationContains all of the relation legs for all of the complex relations in your Collibra environment.DomainContains all of the domains in your Collibra environment that contain assets.RelationContains all of the relations in your Collibra environment, from head to tail and vice versa.ResponsibilityContains all of the responsibilities in your Collibra environment that are directly assigned at the asset level or domain level.Inherited responsibilities from the community level are not included in Insights Data Access.Assetcolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1dateThe date on which the snapshot was created. This is synchronized with the snapshot table.asset_id2character varyingThe resource UUID of the asset. This is a unique identifier.asset_full_name3character varyingThe full name of the asset.asset_display_name4character varyingThe display name of the asset.domain_id5character varyingThe resource UUID of the domain. This is a unique identifier.asset_type_id6character varyingThe resource UUID of the asset type. This is a unique identifier.asset_type_name7character varyingThe name of the asset type.status_id8character varyingThe resource UUID of the status.status_name9character varyingThe name of the status.articulation10double precisionThe articulation score of the asset.ratings_average11double precisionThe aggregated average of the ratings of the asset.ratings_count12integerThe number of ratings of the asset.is_asset_system13booleanAn indicator of whether the asset is a system asset.creator_user_id14character varyingThe UUID of the user who created the asset.creator_username15character varyingThe username of the user who created the asset.creation_date16timestamp with time zoneThe date on which the asset was created.editor_user_id17character varyingThe UUID of the user who last edited the asset.editor_username18character varyingThe username of the user who last edited the asset.edited_date19timestamp with time zoneThe date on which the asset was last edited.Asset_tagcolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1dateThe date on which the snapshot was created.tag_id2character varyingThe resource UUID of the tag attached to the asset.asset_id3character varyingThe resource UUID of the asset to which the tag is attached.tag_name4character varyingThe display name of the tag attached to the asset.creator_user_id5character varyingThe UUID of the user who created the tag.creator_username6character varyingThe username of the user who created the tag.creation_date7timestamp with time zoneThe date on which the tag was created.editor_user_id8character varying The UUID of the user who last edited the tag.editor_username9character varyingThe username of the user who last edited the tag.edited_date10timestamp with time zoneThe date on which the tag was last edited.is_tag_system11booleanAn indicator of whether the tag is a system tag.Attributecolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1datetimeThe date on which the snapshot was created. This is synchronized with the snapshot table.attribute_id2character varyingThe UUID of the attribute.asset_id3character varyingThe UUID of the related assetasset_type_name4character varyingThe name of the asset type of the relation asset.attribute_type_id5character varyingThe UUID of the attribute type.attribute_type_name6character varyingThe name of the attribute type.attribute_type_description7character varyingThe description of the attribute type.kind8character varyingThe kind of attribute.is_attribute_integer9booleanAn indicator of whether the attribute is an integer.expression_long10character varyingThe value of the attribute.boolean_value11booleanThe value of the attribute converted to a Boolean value.datetime_value12datetimeThe value of the attribute converted to a date_time value.numeric_value13numericThe value of the attribute converted to a numeric value.creator_user_id14character varyingThe UUID of the user who created the attribute.creator_username15character varyingThe username of the user who created the attribute.creation_date16timestamp with time zoneThe date on which the attribute was created.editor_user_id17character varyingThe UUID of the user who last edited the attribute.editor_username18character varyingThe username of the user who last edited the attribute.edited_date19timestamp with time zoneThe date on which the attribute was last edited.complex_relation_id20character varyingThe UUID of the complex relation for which the attribute is defined.Communitycolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1dateThe date on which the snapshot was created. This is synchronized with the snapshot table.community_id2character varyingThe UUID of the community.community_name3character varyingThe name of the community.community_description4textThe description of the community.is_community_system5booleanAn indicator of whether the community is a system community.uri6character varyingThe URI of the community.parent_community_id7character varyingThe UUID of the community containing this community.level8integerThe level of the community containing this community. The top level starts at 1.level_community_id9character varyingThe UUID of the community containing this community at a certain level.level_community_name10character varyingThe name of the community containing this community at a certain level.level_community_description11textThe description of the community containing this community at a certain level.level_community_uri12character varyingThe URI of the community containing this community at a certain level.creator_user_id13character varyingThe UUID of the user who created the community.creator_username14character varyingThe username of the user who created the community.creation_date15timestamp with time zoneThe date on which the relation was edited.editor_user_id16character varyingThe UUID of the user who last edited the community.editor_username17character varyingThe username of the user who last edited the community.edited_date18timestamp with time zoneThe date on which the community was last edited.Complex_relationcolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1dateThe date on which the snapshot was created. This is synchronized with the snapshot table.complex_relation_type_id2character varyingThe UUID of the complex relation type.complex_relation_type_name3character varyingThe name of the complex relation type.complex_relation_type_description4character varyingThe description of the complex relation type.complex_relation_id5character varyingThe UUID of the complex relation.relation_type_id6character varyingThe UUID of the relation leg type.relation_role7character varyingThe role of the relation leg.asset_id8character varyingThe UUID of the related asset.creator_user_id9character varyingThe UUID of the user who created the complex relation.creator_username10character varyingThe username of the user who created the complex relation.creation_date11timestamp with time zoneThe date on which the complex relation was created.editor_user_id12character varyingThe UUID of the user who last edited the complex relation.editor_username13character varying The username of the user who last edited the complex relation.edited_date14timestamp with time zoneThe date on which the complex relation was last edited.Domaincolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1dateThe date on which the snapshot was created. This is synchronized with the snapshot table.domain_id2character varyingThe UUID of the domain.domain_name3character varyingThe name of the domain.domain_description4textThe description of the domain.domain_uri5character varyingThe URI of the domain.If you create a community or domain in a development environment and you restore a backup of the development environment on your production environment, the URI for the community or domain in the report will reflect that of the development environment, not the production environment.is_domain_system6booleanAn indicator of whether the domain is a system domain.domain_type_id7character varyingThe UUID of the domain type.domain_type_name8character varyingThe name of the domain type.domain_type_description9character varyingThe description of the domain type.community_id10character varyingThe UUID of the community.creator_user_id11character varyingThe UUID of the user who created the domain.creator_username12character varyingThe username of the user who created the domain.creation_date13timestamp with time zoneThe date on which the domain was created.editor_user_id14character varyingThe UUID of the user who last edited the domain.editor_username15character varyingThe username of the user who last edited the domain.editor_date16timestamp with time zoneThe date on which the domain was last edited.Relationcolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1dateThe date on which the snapshot was created. This is synchronized with the snapshot table.relation_id2character varyingThe UUID of the relation. This column, in combination with the direction column, is a unique identifier and can be used to uniquely identify each row.reation_type_id3character varyingThe UUID of the relation type.role_or_corole4character varyingThe role of the relation in the direction from head to tail, co-role of the relation in the direction from head to tail.direction5character varyingThe direction of the relation, which can be either: Head-to-tail, in which the first asset is the head and the second asset is the tail.Tail-to-head, in which the first asset is the tail and the second asset is the head.asset_id16character varyingThe UUID of the first asset in the relation.asset_type_id17character varyingThe UUID of the asset type of the first asset in the relation.asset_type_name18character varyingThe name of the asset type of the first asset in the relation.asset_id29character varyingThe UUID of the second asset in the relation.asset_type_id210character varyingThe UUID of the asset type of the second asset in the relation.asset_type_name211character varyingThe name of the asset type of the second asset in the relation.is_relation_generated12booleanAn indicator of whether the relation is generated.creator_user_id13character varyingThe UUID of the user who created the relation.creator_username14character varyingThe username of the user who created the relation.creation_date15timestamp with time zoneThe date on which the relation was created.editor_user_id16character varyingThe UUID of the user who last edited the relation.editor_username17character varyingThe username of the user who last edited the relation.edited_date18timestamp with time zoneThe date on which the relation was last edited.Responsibilitycolumn_nameordinal_positiondata_typeDescriptionsnapshot_date1dateThe date on which the snapshot was created. This is synchronized with the snapshot table.role_id2character varyingThe UUID of the role of the responsible user or user group.role_name3character varyingThe name of the resource role of the responsible user or user group.asset_id4character varyingThe UUID of the asset.user_id5character varyingThe UUID of the responsible user. This field is used only if the responsibility is assigned to a user.username6character varyingThe username of the responsible user. This field is used only if the responsibility is assigned to a user.user_firstname7character varyingThe first name of the responsible user. This field is used only if the responsibility is assigned to a user.user_lastname8character varyingThe last name of the responsible user. This field is used only if the responsibility is assigned to a user.user_email9character varyingThe username of the responsible user. This field is used only if the responsibility is assigned to a user.user_language10character varyingThe language of the responsible user. This field is used only if the responsibility is assigned to a user.is_user_guest12booleanAn indicator of whether the responsible user is a guest user.is_user_api13booleanAn indicator of whether the responsible user is an API user.is_user_activated14booleanAn indicator of whether the responsible user's account is activated.is_user_enabled15booleanAn indicator of whether the responsible user's account is enabled.is_responsibility_system16booleanAn indicator of whether the responsibility is a system responsibility.creator_user_id17character varyingThe UUID of the user who created the responsibility.creator_username18character varyingThe username of the user who created the responsibility.creation_date19timestamp with time zoneThe date on which the responsibility was created.editor_user_id20character varyingThe UUID of the user who last edited the responsibility.editor_username21character varyingThe username of the user who last edited the responsibility.edited_date22timestamp with time zoneThe date on which the responsibility was last edited.group_id23character varyingThe UUID of the user group to which the responsibility is assigned.group_name24character varyingThe name of the user group to which the responsibility is assigned.
	 Remove non-applicable regulation placeholder from Privacy & Risk Readiness reportIf you have purchased only one of the Collibra Data Privacy modules, CCPA or GDPR, you can remove the non-applicable placeholder from the report, as there will be no data to visualize.       In this example, the GDPR module was not purchased. Therefore, no GDPR-specific data is available.StepsClick on the non-applicable regulation, so that the entire section is highlighted.Click .Click Delete Containers, to confirm the deletion.

	 DashboardsA dashboard is a page that provides a high-level overview on the different areas of the product. It contains one or several configurable dashboard widgets that can show text, a shortcut to the search, the organization browser, buttons to start a workflow, and more.You can create as many dashboards as you want, each with a particular purpose. Dashboards cannot be assigned to a community or any other resource.The topics in this section assume that the Homepage is disabled. For more information, go to Access a dashboard. In Collibra 2022.11 or newer, the Homepage is enabled by default.In Collibra environments upgraded from 2022.10 or older to 2022.11 or newer, the Homepage is available but disabled by default.In Collibra environments upgraded from 2022.11 to a newer version, the previous status of the Homepage (enabled or disabled) is retained.PermissionsNo particular license is needed to manage and share your own dashboards; however, certain global permissions are needed. PermissionWith this global permission, you canManage your own Views, Dashboards, Search filtersCreate dashboards or copy existing ones.Share your own Views, Dashboards, Search filtersShare any of the dashboards that you copied or created.Manage and share anyone's Views, Dashboards, Search filtersCreate dashboards or copy existing ones.Edit the properties of any dashboard.Share any dashboard.Delete any dashboard.Access a dashboardThe way in which you can access a dashboard depends on if the Homepage is enabled or disabled.With the Homepage disabledIf the Homepage is disabled, you can access a dashboard on the page that appears when you sign in to Collibra or when you click , via: The dashboard tab bar, which shows up to five pinned dashboards in alphabetical order.The More menu.The default dashboard is opened by default. With the Homepage enabledIf the Homepage is enabled, you can access a dashboard via:The Dashboards card on the Homepage. The Dashboards tab in the Browse pane.Create a dashboardYou can create a dashboard, and then add and edit widgets to suit your needs.You can create as many dashboards as you want without affecting the performance of Collibra.Requirements and permissionsYou have a global role with the Manage your own Views, Dashboards, Search filters global permission; for example, Sysadmin.Steps    On the main menu, click   . On the dashboard bar, click → Add Dashboard.  Enter the required information.FieldDescriptionNameThe name of the dashboard. DescriptionA description of the dashboard.LayoutThe layout of the dashboard.Select the number of columns for the dashboard.PinSelect this checkbox if you want to pin the dashboard.Up to five pinned dashboards are shown on the dashboard tab bar in alphabetical order.Click Save. What's next?Add widgets to the dashboard.Copy a dashboardIf, for example, you want to reconfigure one of the widgets of a certain dashboard according to your needs, you can copy that dashboard, instead of creating one. You can create as many dashboards as you want without affecting the performance of Collibra.PrerequisitesYou have a global role with the Manage your own Views, Dashboards, Search filters global permission; for example, Sysadmin.Steps    On the main menu, click   . On the dashboard bar, click → Save as.Enter the required information.FieldDescriptionNameThe name of the dashboard. DescriptionThe description of the dashboard.Sharing optionsOptions that determine who can view the dashboard:Public: All users.Private: Only you.Share with specific roles, groups & users:Roles: Only the selected roles.Groups: Only the selected groups.Users: Only the selected users.PromoteOptions that determine how and where the dashboard appears:Default: As the first page when you sign in to Collibra.Pin: As a tab on the dashboard bar when you sign in to Collibra.Click Save.What's next?You can now edit the dashboard properties and widgets according to your needs.Edit the properties of a dashboardYou can edit the properties of a dashboard, including the name, description and layout.PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit properties.Enter the required information.FieldDescriptionNameThe name of the dashboard. DescriptionA description of the dashboard.LayoutThe layout of the dashboard.Select the number of columns for the dashboard.PinSelect this checkbox if you want to pin the dashboard.Up to five pinned dashboards are shown on the dashboard tab bar in alphabetical order.Click Save.Switch to another dashboardYou can switch from one dashboard to another.Steps    On the main menu, click   . In the dashboard toolbar, click the name of dashboard.Share a dashboardYou can share a dashboard with other users if the widgets provide information that is useful to them.PrerequisitesIf you want to share your own dashboard, you have a global role with the Share your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to share another user's dashboards, you have Manage shared Views, Dashboard and Search Filter global permission.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Share.Select with whom you want to share the dashboard.Specify whether or not you want to make the dashboard the default dashboard for the users with whom you are sharing it.Click Save.Delete a dashboardIf a dashboard is no longer useful, you can delete it.PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Delete.Click Yes.Dashboard widgetsA dashboard widget is an individual pane in a dashboarddashboard. Depending on its type, it has a different purpose. For example, it can contain quick links to important or useful information, statistics in a bar chart or a button to quickly start a workflow.WidgetsCollibra Data Intelligence Cloud comes with the following widgets:WidgetDescriptionBar ChartAsset or task metrics depicted in a bar chart.SearchA search field by which users can search for resources.TextA block of text, or message.Counters Asset or task metrics depicted by a graphic element with the total count.WorkflowA collection of workflow buttons by which users can start workflows.To DoAn overview of open tasks and issues.BrowserA hierarchical tree-structure of all communities, subcommunities and domains.Most ViewedA list of the ten most viewed assets over the last week, month or year.RecentA list of your ten most recently viewed assets.For complete information on adding and editing dashboard widgets, see the Documentation Center.The Widgets tabAll widgets have: A specific tab for configuring and editing the widget.The Widget tab, which is common to all widgets and contains the common configuration options.Field ExplanationShow title above the widgetTrue: A title is shown above the widget.In this case, specify a title.False: No title is shown above the widget.Show description above the widgetTrue: A description is shown above the widget.In this case, the packaged description is shown.False: No description is shown above the widget.Refresh everyTrue: The counter is refreshed according to the refresh rate you specify.In this case, specify the refresh rate. Possible values are: 5, 10, 25, 50 or 100 minutes.False: The counter is not automatically refreshed.Bar chart widgetThe Bar Chart widget enables you to display advanced metrics in the form of a bar chart.Configure a bar chartYou can add many different bar charts to the dashboard and configure them to suit your needs. PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.If required, add a Bar Chart widget to a dashboard.In the widget, click     .  On the Graph tab, click Create Template.In the Bar Chart Configuration wizard, click the type of data that you want to use.Assets: If you want to display metric information about assets.  Tasks: If you want to display metric information about tasks.In the by field, select how the data is grouped. If you group by Attribute Value, you can only select Boolean or Selection characteristic types.This setting defines how the bars in the bar chart, also known as groups, are constructed. Depending on what you select, additional fields are shown. Optionally, add up to 25 sets of filtered data:   Click Add Data Set.  In the Filter Label field, fill in a label name for the bar chart legend.  This field is mandatory.  Example: Business terms  In the row under the Filter Label field, specify a filter.  Example: Asset Type equals Business Term.  Click Save.  To add more data filters, repeat steps a - d.Click Next. Provide a template name. Select how the items in the bar chart are ordered: Alphabetical.Numerical, meaning that the groups are sorted by their value (the length of the bar).If necessary, select a graph type. Click Save & Apply.Search widgetThe Search widget on the dashboard is similar to the Search field in the main menu. If you type something and press Enter, the same search page is shown as if you searched via the Search field, and the search results are the same. The difference is that the Search widget does not show the most recently viewed resources or, while you are typing, the top results, as does the Search field.If the Search widget is not included on your dashboard, you can add it.Text widgetThe Text widget is a free-text field that allows you to add text to the dashboard. You can use it, for example, to inform users your latest data governance news, point users to certain pages with hyperlinks to a specific view and so on.When you add content to a Text widget, you can: Use the rich text editor in the Content tab, to format your text. Click , to edit the HTML source code.The text editor supports most HTML elements, inline CSS styling and table (< t >) structures. However, this means an attacker could potentially execute an XSS attack by injecting malicious HTML. However, you can automatically remove the following HTML elements to improve security:scriptsvgframeframesetiframeany event handlersany JavaScriptYou can enable this in Collibra Console. For more information, see the Troubleshooting section.Configure the Text widgetYou can configure the Text widget to post a free-text message on the dashboard. PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.If required, add a Text widget to a dashboard.In the widget, click     .  Type or cut and paste your text in the field and, optionally, format it using the rich text editor.If you want to copy and paste text from other sources into a text field, we recommend that you click , and then paste the text into the Show source code field. This will remove any unwanted formatting or tagging of the text. For detailed information, see the knowledge base article on Collibra Support Portal.Click Save.Supported HTML tagsThe following table shows the HTML tags you can use to format your text in the Text widget:Supported HTML tagsmeta option smallfontdlinput head textarea bigadtselect title h1 premapemstrongscript h2 codestyletablecolnoscript h3citespantdbrsvg h4sampdivthtfootiframe h5subimgtrtheadframeset h6suplinkcolgrouptbodyframe pstrikeulcol label icenterolfieldsetform bblockquotelilegendbutton uhrddno-hyperlinkCounters widgetThe Counters widget shows count statistics on your dashboard and the Metrics pages of the Collibra applications, for example the number of total assets in your environment or the number of open tasks or issues.When configuring a Counter widget, you choose from a fixed list of templates that determine the count statistics that are computed. The following table describes the computation for each template:Template nameDescriptionApplicationsNumber of Technology Assets.Approved AssetsNumber of assets with the status Accepted.AssetsNumber of assets.Assets Created Past DayNumber of assets created in the past day (24 hours).Assets Created Past MonthNumber of assets created in the past month (28 days).Assets Created Past Week Number of assets created in the past week (7 days).Business TermsNumber of Business Term assets.Code ValuesNumber of Code Value assets.ColumnsNumber of Column assets.CommunitiesNumber of communities.Data AssetsNumber of Data Assets.DomainsNumber of domains.File GroupsNumber of File Group assets.FilesNumber of File assets.Governance AssetsNumber of Governance Assets.Issues resolved past dayNumber of Issue assets for which the status became Resolved within the past day (24 hours). This counter does not show how many Issue assets were set to Resolved in the past 24 hours. Rather, it shows the total number of Issue assets that had the Resolved status at a specific point in time. By default, the Issue assets are counted once every 24 hours. The counting interval can be edited in Collibra Console. Keep in mind that increasing the frequency of the counts may negatively impact performance.Issues resolved past weekNumber of Issue assets for which the status became Resolved within the past week (7 days). This counter does not show how many Issue assets were set to Resolved in the past 7 days. Rather, it shows the total number of Issue assets that had the Resolved status at a specific point in time. By default, the Issue assets are counted once every 7 days. The counting interval can be edited in Collibra Console. Keep in mind that increasing the frequency of the counts may negatively impact performance.KPIsNumber of Key Performance Indicators.My Open TasksTotal number of unfinished tasks for the user.Unfinished is the status of the task, as documented in the workflow.New IssuesNumber of Issue assets with the status New.Open IssuesNumber of unresolved Issue assets. Unresolved Issue assets can have the following statuses:   New  Under Review  Accepted  Invalid  In Progress  Resolution Pending  PendingOpen TasksNumber of unfinished tasks for all users. Unfinished is the status of the task, as documented in the workflow.ProcessesNumber of Business Process assets.Reference Data DomainsNumber of Code-list domains.ReportsNumber of Report assets.S3 BucketsNumber of S3 Bucket assets.S3 File SystemsNumber of S3 File System assets.SchemasNumber of Schema assets.Tableau DashboardsNumber of Tableau Dashboard assets.Tableau ProjectsNumber of Tableau Project assets.Tableau ServersNumber of Tableau Server assets.Tableau SitesNumber of Tableau Site assets.Tableau StoriesNumber Tableau Story assets.Tableau ViewsNumber of Tableau View assets.Tableau WorkbooksNumber Tableau Workbook assets.TablesNumber of Table assets.Task DurationSum of all task durations.UsersNumber of users currently signed in to the environment.Configure the Counters widgetYou can add many different counters to the dashboard and configure them to suit your needs. PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.If required, add a Counters widget to a dashboard.In the widget, click     .  Enter the required information.TabField DescriptionCountersExisting counter or Add CounterDo one of the following:                Click Add Counter, to add a new counter.Expand the section of an existing counter, to edit its current configuration.TemplateSelect the template of the count statistic you want to show.Warning Level and Danger LevelOptionally, enter the values that represent your warning and danger thresholds, respectively.The threshold settings are designed for use with the following issue-related templates:                New IssuesOpen IssuesIssues resolved past dayIssues resolved pas weekURLOptionally, specify a URL to be accessed if a user clicks the counter. The URL must lead to a page in your Collibra environment. The webpage will open in the active browser window.Click Save.Warning and danger thresholdsThe warning and danger thresholds are optional settings that allow you to visually communicate certain risk or tolerance levels for Issue assets. The two threshold settings, Warning level and Danger level, can be configured:Per counter.Alone or in combination with one another.The threshold settings are designed for use with the following issue-related templates:                New IssuesOpen IssuesIssues resolved past dayIssues resolved pas weekExampleLet's say that your organization has established that 20 open issues (meaning Issue assets with a status other than Resolved) exceeds its risk appetite. To give this visibility within the appropriate community of Collibra users, you add the Counters widget to the dashboard, and configure a counter to show the number of open issues, of which there are currently 13. In accordance with your organization's risk appetite, and to give more meaning to the number of open issues, you set Warning Level to 10 and Danger Level to 20.The following example image shows the resulting Counters widget and, specifically, the Open Issues counter:Understanding the color bandsWhen values are given to one or both of the threshold settings, the band around the counter will be green, orange or red. The colors have the following meanings:Circle colorMeaningEntirely grayNo value has been set for either the warning or danger thresholds.GreenThe issue count is lower than both threshold values, or if only one threshold has been set, lower than that value.OrangeThe issue count is higher than the warning threshold value, but lower than the danger threshold value (if the danger threshold has been set).RedThe issue count is higher than the warning threshold value (if no danger threshold has been set) or higher than the danger threshold value, if it has been set. Workflow widgetThe Workflow widget adds one or more buttons to the dashboard, allowing users to start global workflows from the dashboard.When you customize this widget, there is a Buttons tab instead of a Content tab. You can specify which workflows have to be available and how they are displayed.You can specify the following parameters for each button:The label to display on the buttonThe global workflow that is started by clicking the buttonThe styling of the buttonConfigure the Workflow widgetYou can add and configure buttons for any enabled workflow. PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.If required, add a Workflow widget to a dashboard.In the widget, click     .  Enter the required information.TabFieldDescriptionButtons1The button text.2The workflow that will be started when a user clicks the button.3The color of the button, based on the type of workflow. Possible values and their associated colors are as follows:Default: grayDanger: redInfo: graySuccess: greenWarning: yellowThis field only determines the color of the button. It has no bearing on the workflow.Click Save.To Do widgetThe To Do widget provides a quick overview of open tasks and issues. You can: Click the Tasks and Issues buttons, to switch between tasks and issues.Click in the drop-down list, to sort the tasks by due date, asset and title. Click Show All, to go to the My Tasks page, where all tasks are shown.If there are several tasks or issues shown in the widget, you can vertically resize the widget, to see more items without having to scroll as much in the widget. To resize the widget, click the gray, bi-directional arrow at the bottom of the widget and drag it to size. Issues with the following statuses are not included in the list of open issues: ResolvedInvalidObsoleteDisabledYou cannot add to, or remove, these excluded statuses. This means that if you create your own statuses, you cannot add them to the excluded statuses. Configure the To Do widgetYou can configure the widget to show either: Only tasks that are assigned to you and open issues that you have created.All open tasks and issues across your Collibra environment.PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.If required, add a To Do widget to a dashboard.In the widget, click     .  Enter the required information.TabField ExplanationTasksShow tasksTrue: Show tasks in the widget.In this case, specify whether to show all tasks or only tasks assigned to you.False: Tasks are not shown in the widget.Show maximumTrue: Limit the number of tasks shown in the widget.In this case, specify the maximum number of tasks that can be shown. Possible values are: 5, 10, 15, 20, 25, 50 or 100.False: There is no limit to the number of tasks that can be shown.Issues Show issuesTrue: Show issues in the widget.In this case, specify whether to show all open issues or only open issues that you created.False: Issues are not shown in the widget.Show maximumTrue: Limit the number of issues shown in the widget.In this case, specify the maximum number of issues that can be shown. Possible values are: 5, 10, 15, 20, 25, 50 or 100.False: There is no limit to the number of issues that can be shown.Click Save.Click Close & save edits.Browser widgetThe Browser widget enables you to browse through the available communities and domains, via the dashboard.You can use the search field at the top of the widget, to quickly find communities and domains.This widget has no specific configuration settings. Like all other widgets, common configuration settings are available via the Widgets tab.You can also click the company logo at the top left-hand corner, to Access a community, domain, asset view, or dashboard via the Organization Browser.Most Viewed widgetThe Most Viewed widget shows the ten most viewed assets over a specified time range. The domain for each asset is shown under the asset name. You can:Click an asset name to go to that asset page.Click a domain name to go to that domain page.Configure the Most Viewed widgetYou can configure the widget to show the ten most viewed assets over the last week, month or year. PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.If required, add a Most Viewed widget to a dashboard.In the widget, click     .  Select the time range over which to show the most viewed assets: last week, last month or last year.Click Save.Click Close & save edits.Recent widgetThe Recent widget shows your ten most recently viewed assets.The domain for each asset is shown under the asset name. You can:Click an asset name to go to that asset page.Click a domain name to go to that domain page.This widget has no specific configuration settings. Like all other widgets, common configuration settings are available via the Widgets tab.Add a widget to a dashboardYou can add widgets to curate information-rich dashboards.PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.Click a widget and drag it onto the dashboard. You can browse through the widgets by using the page numbers below them.Edit a widget as required.Click Close & save edits.Move a widgetYou can move a widget if you feel like a widget belongs in a different location on the dashboard.PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . In the view bar, select the dashboard that you want to change. See Switch to another dashboard.On the dashboard bar, click → Edit widgets.Click and hold the button (move) on the widget that you want to move.Drag the widget to where you want it on the dashboard and release the mouse button.Click Close & save edits.Edit a widgetYou can edit the dashboard widgets to curate the information shown on the dashboard.PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.Edit the content of the widget, to meet your needs.Not every widget has the same tabs.The Widget tab is the same for each widget. Your configuration of the Widget tab defines how the widget is displayed on the dashboard.You can vertically resize any dashboard widget, by clicking and dragging the gray, bi-directional arrow at the bottom of the widget.Click Save.For complete information on working with dashboards and widgets, see the Collibra Documentation Center.Delete a widget from a dashboardIf a specific widget is no longer useful on a certain dashboard, you can delete it from that dashboard.PrerequisitesIf you want to manage your own dashboard, you have a global role with the Manage your own Views, Dashboards, Search filters global permission, for example Sysadmin.If you want to manage another user's dashboard, you have a global role with the Manage shared Views, Dashboard and Search Filter global permission, for example Sysadmin.Steps    On the main menu, click   . If required, switch to the relevant dashboard.On the dashboard bar, click → Edit widgets.In the widget, click     .  Click Delete to confirm.Click Close & save edits.
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	 Data HelpdeskWith the Data Helpdesk application of Collibra Data Intelligence Cloud, you can:Manage data issuesA problem related to issue management; also referred to as issue. efficiently.Quickly view newly created issues.Process issues assigned to a given user.Track the progress of the issues.View the data quality dimensions (accuracy, completeness, conformity, consistency, integrity are available out of the box) and the data quality rules.The following sections describe the issue roles, how to log issues and how to use the default 'Issue Management' workflow. Note that since administrators can change and customize the workflow, the actual behavior of your Collibra may be different than described.Data Helpdesk submenu pagesPageDescriptionIssuesContains a table with Issue assets in Collibra.Data QualityContains tables with Data Quality and Data Quality Dimension assets.MetricsContains a variety of statistics related to how the assets of the Data Helpdesk are used.In this chapterPackaged metamodel for the Data HelpdeskThe Data Helpdesk has specific asset types and domain types. Asset typesThe table below contains the packaged asset types that are relevant for the Data Helpdesk.Domain typesThe table below contains the packaged domain types that are relevant for the Data Helpdesk.WorkflowsThe table below contains the packaged workflows that are relevant for the Data Helpdesk.NameDescriptionAssessmentsThis process notifies the Business Steward (by default) that an Assessment Review asset is ready for review and prompts the Business Steward to approve or reject the asset.Cancel ProcessThis process notifies the concerned users of a workflow cancellation.Escalation ProcessThis process is the default mechanism for the escalation of user tasks in workflows.Issue CreationThis process facilitates issue creation.Issue ManagementThis process is used to route and resolve issues.Issue MoveThe Issue Move workflow is a process that changes the responsible community of an issue.Propose New Governance AssetThis process facilitates the creation of new Governance Assets in the Data Governance Council community.Simple ApprovalThe Simple Approval workflow is a single-step process that allows you to approve an asset in Collibra Data Intelligence Cloud.Voting Sub-ProcessThe Voting Sub-Process is a workflow that can be called by other workflows when users need to vote. It is used within other packaged workflows such as the Approval Process, the Simple Approval or the Issue Management workflow.You can use this sub-process in new custom workflows. The result is a true or false boolean that is provided to the parent workflow.Issue rolesThere are several roles involved in the issue management workflow. Some of the roles are assigned automatically by the workflow and others have to be configured or assigned while tasks of the workflow are being executed. Predefined variables can determine which users to select for a given situation. To learn more about configuring variables for workflows, see the Workflow Documentation in the Collibra Developer Portal.The following table contains the different roles in an issue.RoleDescriptionRequesterThe requester is the user who has logged an issue, which means that there can only be one requester per issue. The requester is kept up to date on the issue resolution progress and can be asked to provide more information.ReviewerThe reviewer analyzes the created issue and proposes a solution for it but does not implement the solution. The reviewer is responsible to ensure that all the information is available for solving the issue. This user can also mark an issue as invalid. Which user is assigned as reviewer, depends on the issue management workflow configuration. The reviewerUserExpression variable of the workflow determines which users are able to assign themselves as reviewer for the issue. By default this is the steward. After the workflow has started, the issue manager or the current reviewer can assign a different user as reviewer.StakeholderThe stakeholders of an issue are responsible for accepting or rejecting the analysis and solution that was proposed by the reviewer. The stakeholders of an issue can be configured through a variable called the stakeholderUserExpression in the workflow. By default, this is the steward. It is not possible to change the stakeholders after the workflow has started.AssigneeThe assignee is responsible for the actual implementation of the solution. It is the requester's responsibility to appoint assignees. The assignee receives a task for the implementation of the solution. Assignees are suggested by the workflow. The suggested assignees can be configured through the assigneeUserExpression variable of the workflow. Assignees can also assign another assignee after the workflow has started.Create a data issueBy creating a new data issue, you start a workflow to resolve data issues. The workflow behavior varies per company.StepsTo create a data issue, follow these steps:On the main toolbar, click .The Create dialog box appears.         In the Create dialog box, click the Actions tab. Click Issue Creation.If you don't see Issue Creation, you have to add the Issue Creation workflow to the global create, see I don't see a workflow in the global create.Complete the Log Issue dialog box.Title (mandatory): The name and a short descriptive title for the issue.Description (mandatory): A full description to explain the details of the issue.Priority: The priority of the issue. Possible values are (in order of importance from high to low): BlockingCriticalUrgentNormalMinorResponsible Community: The community that is, according to you, responsible for solving the issue. By default, this is the Data Governance Council community, which is responsible for taking in all new types of assets and assigning them to the right community.Relevant Assets: A list of assets that are impacted by the issue. When you start typing in this field, suggestions appear. Click a suggestion to add the asset to the issue. You can add multiple relevant assets.Click next to a related asset to remove it from the list.Click Create Issue.Example:What's next?The data issue is created and the proper workflow is automatically started. On the Diagram page of the created Data Issue asset page, you can find the assets that are related to the issue.Create issue: optionsOptionDescriptionTitleMandatory.The name and a short descriptive title for the issue.DescriptionMandatory.A full description to explain the details of the issue.PriorityThe priority of the issue. Possible values are (in order of importance from high to low): BlockingCriticalUrgentNormalMinorResponsible CommunityThe community that is, according to the reporter, responsible for solving the issue. By default, this is the Data Governance Council community, which is responsible for taking in all new types of assets and assigning them to the right community.Relevant AssetA list of assets that are impacted by the issue or that are subject of the issue. When you start typing in this field, suggestions appear. Click a suggestion to add the asset to the issue. You can add multiple relevant assets.Click next to a related asset to remove it from the list.Issue ClassificationThe classification of the issue, indicating what the issue type is.Tasks in the Issue Management workflowIn this section you can find more information about the various tasks in the Issue Management workflow. For more information about workflows, go to the Managing workflows section.It is possible that your Collibra Data Intelligence Cloud administrator has renamed the Issue Management workflow.Accepting or rejecting a data issueWhen the issue management workflow is started, tasks are assigned to the users that are defined in the workflow. These are by default the issue stewards. This workflow task has to be completed before a predefined deadline, if not, the issue is escalated to the issue manager who will set a reviewer manually.The stewards can accept or reject an issue. When one steward accepts the issue, its status becomes Under Review.Only when all stewards reject an issue, the issue is marked as invalid and the requester is notified.You can check if you have issues to accept or reject if you click the Tasks button in the main menu. Issues that have passed the due date, appear in red.Click on the task row to select it. You can accept or reject the task from the sidebar.When you click the name of the task or the related resource, the issue page opens.You can accept or reject the issue from the sidebar.When you accept the issue, the workflow automatically advances to the next step.You can also access the issues via Data Helpdesk → Issues and apply a filter to find the issues that require an action from you.Analyzing and proposing a solutionWhen the status of a task is Under Review, you can perform the following actions:Reassign Reviewer: Choose this action if you find that an other user is more suited to analyze the issue. The status of the task becomes Reassign Reviewer. Click Submit to assign a new user, role or group as the new reviewer for the issue.More Information: Choose this action if you need more information from the issue requester. The status of the issue becomes Pending. This action creates a task for the requester to provide more information about the issue.        When the requester has completed this task, the workflow returns to you with a task with the same four options.Invalid Issue: Choose this action to mark the issue as invalid. The requester is notified and the issue management workflow is finished. Note that this is an irreversible action.Request Approval: Choose this action to request an approval for your analysis and solution proposal. You can only click this action when you have provided a detailed analysis of the issue in the issue's Analysis attribute. In the Resolution attribute, you can propose a solution to the issue. When you request an approval, the contents of the Analysis and Resolution attributes can be evaluated and approved. The issue is marked as Submitted for approval.Approve or reject a solutionIn the approve/reject step, each stakeholder assigned to the issue is requested to accept or reject the analysis and solution proposed by the reviewer. All the stakeholders have to accept, otherwise the solution is not approved. If one stakeholder rejects the solution, the workflow creates a new task for the reviewer to update the analysis and solution, taking into account the comments given by the stakeholder who rejected the proposed solution. If approved, the issue is marked as Accepted.In the sidebar, provide a reason for your action.Click the Approve or Reject button.In the task bar, click the Approve/Reject button. The Approval dialog box appears.In the dialog box, provide a reason for your action.Click the Approve or Reject button.When all the stakeholders have approved the solution, the status of the issue becomes Approved.If the last stakeholder is a reviewer, the user can immediately appoint an assignee to solve the issue or close the issue if no further action is required.Appoint assignee or resolve the issueWhen all the stakeholders have accepted the proposed solution, it does not necessarily mean that the issue is resolved. It is possible that the solution still has to be implemented.When the solution is approved, the reviewer can decide to appoint an assignee who can implement the actual solution to resolve the issue, or mark the issue as resolved if there is no need for a specific implementation.After appointing an assignee, the issue is marked as 'In Progress'.You can appoint an assignee in the following ways:Fill in a list of users in the User field.Add groups in the Group field.Specify a role, in the Role field, that the selected user has to have on the current issue. If you also fill in the in community field, all the users with the specified role for the given community become the assignee of the issue.Depending on the issue management workflow configuration, a user can already be proposed to you in the User field.Provide a solutionIn the step to provide a solution, the assignee resolves an issue and provides an implementation.The assignee can reassign the task to someone else if that user is more suited to perform the task. When reassigning the task, a similar form is presented as described in the earlier step where the new assignee can be appointed, see Appoint assignee or resolve the issue.The assignee can also mark the issue as Solved. This ends the task and the workflow afterwards asks the reviewer to check if the solution matches the expectations. In this case, the issue is marked as Resolution Pending.This task has to be completed within a predefined period, if not, the workflow returns to the previous step and presents a new task to the reviewer to appoint a new assignee to perform the task.Instead of resolving the issue by implementing the proposed solution, it is possible that the issue can be resolved by linking it to a governance asset. For example, by forcing all assets to comply to a business rule so that the problem described in the issue can not happen again.To resolve an issue with a related asset, you need the correct rights in the community as assignee.You can link the issue with a governance asset as follows:On the issue page, click Characteristic.Click the Relations tab.Choose the Resolved by relation.Enter the resolving governance assets in the dialog box, optionally set a Start Date and End Date.Click Save.The relation appears in the resolved by Governance Asset table on the issue page.Click Solved in the green bar to mark the issue as resolved.Review a solutionIn the last step of the 'Issue Management' workflow, the reviewer can review the provided solution:Click Accept to accept the solution and mark the issue as Resolved and the requester is notified. This action ends the issue management workflow.If there are multiple reviewers, there is only one reviewer who has to accept the solution.Click Reject to reject the solution and mark the issue as Under review. The workflow returns to the Analyze and Propose Solution step, see Analyzing and proposing a solution.Click View relevant changes to view the history of the issue.Click Other → Reassign to assign the review step to an other user.Metrics pagesThe Metrics pages contain a variety of statistics related to how an application is used. They pages consist of one or more graphs, their legends and some counters.For each graph, you can edit the data set and the time range shown.On the Metrics page, the lines that are shown on a given graph are called data sets. Do not confuse these with data sets in the true context of CollibraData Catalog. On this page, when you click Add data set, it simply means that you want to add another line to the graph.ComponentsThe Metrics page consists of one or more graphs, their legend and some counters.NumberElementDescription1Color-coded barsThe color-coded bars give a quick overview of the graph.The vertical line leading from the color-coded bar indicates the difference between the minimum and maximum values.2Data set detailsMore details about the graph.Hover your pointer over the color-coded bars to the left of each line of graph to view them.Number of elementsThe amount of days in the time range.MinimumThe lowest count on any day in the data set.Q1The first quartile, meaning the lowest 25% of the data set.MedianThe median, meaning the middle value of the data set.Q3The third quartile, meaning the lowest 75% of the data set.MaximumThe highest count on any day in the time range.3GraphThe actual graph. What it shows exactly, depends on the data set. For example, it can show the number of assets viewed over the last month, or the number of licenses used. You can edit the time range of the graph.4Counts by dayThe counts for a specific day for each data set, by moving your mouse over the graph. The vertical red line identifies the day. The exact count for that day for each data set, is shown above the graph.5LegendThe legend of the graph, which also allows you to add, edit and delete the data sets.Add a data set to a metrics graphYou can add a data set to a graph on the Metrics pages, for example if you want to compare the amount of new assets of different types.StepsOpen the product for which you want to see the metrics, for example Business Glossary.In the submenu, click Metrics.The Metrics page appears.Under the relevant graph, to the right, click Add data set.The filter settings appear.Enter the required information: Filter settingDescriptionFilter TypeThe type of data that will be counted.Depending on the filter type that you select, different fields become available.Active UsersA daily count of the active users to have viewed the relevant assets.You can restrict the count results via the following additional filters:License: Limit the results to active users with a specific license type.Community: Limit the results to a specific community.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Product: Limit the results to active users within a specific Collibra Data Intelligence Cloud application.Role: Limit the results to active users that have been assigned a specific role.Asset CountA daily count of the relevant assets (either data or technology assets) that have been viewed.You can restrict the count results via the following additional filters:Type: Limit the results to a specific type.Domain: Limit the results to assets from a specific domain.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Status: Limit the results to assets with a specific status.Community: Limit the results to a specific community.Changed Task CountA daily count of workflow tasks that have been changed.You can restrict the count results via the following additional filters:Workflow: Limit the results to a task in a specific workflow.Task Type: Limit the results to tasks of a specific type.Task: Limit the results to a specific task.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community.Task Status: Limit the results to tasks that have a specific status (Completed, Deleted or Unfinished).User: Limit the results to a specific user.Domain CountA daily count of the domains with relevant assets (either data or technology assets) that have been viewed.You can restrict the count results via the following additional filters:Type: Limit the results to a specific type.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community. License AvailableA daily count of Collibra licenses that have been available to users.This is calculated by subtracting the licenses in use from the total licenses your organization has.You can restrict the count results via the following additional filters:License: Limit the results to a specific type.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. License UsageA daily count of Collibra licenses in use by all users in your organization.You can restrict the count results via the following additional filters:License: Limit the results to active users with a specific license type.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Page HitsA daily count of Collibra asset page hits.You can restrict the count results via the following additional filters:Community: Limit the results to a specific community. Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Domain: Limit the results to assets from a specific domain.Task CountA daily count of workflow tasks carried out.Workflow: Limit the results to a task in a specific workflow.Task Type: Limit the results to tasks of a specific type.Task: Limit the results to a specific task.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community.Task Status: Limit the results to tasks that have a specific status (Completed, Deleted or Unfinished).User: Limit the results to a specific user.Task DurationA daily count of workflow task duration.You can restrict the count results via the following additional filters:Workflow: Limit the results to a task in a specific workflow.Task Type: Limit the results to tasks of a specific type.User: Limit the results to a specific user.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community.Task: Limit the results to a specific task.Click Save data set.Edit a data set of a metrics graphYou can edit the data set that is shown in a graph on the Metrics pages.StepsOpen the product for which you want to create an asset (for example, Business Glossary).In the submenu, click Metrics.The Metrics page appears.In the legend under the relevant graph, click the data set you want to edit.The filter configuration for the data set appears.Enter the required information.Filter settingDescriptionFilter TypeThe type of data that will be counted.Depending on the filter type that you select, different fields become available.Active UsersA daily count of the active users to have viewed the relevant assets.You can restrict the count results via the following additional filters:License: Limit the results to active users with a specific license type.Community: Limit the results to a specific community.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Product: Limit the results to active users within a specific Collibra Data Intelligence Cloud application.Role: Limit the results to active users that have been assigned a specific role.Asset CountA daily count of the relevant assets (either data or technology assets) that have been viewed.You can restrict the count results via the following additional filters:Type: Limit the results to a specific type.Domain: Limit the results to assets from a specific domain.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Status: Limit the results to assets with a specific status.Community: Limit the results to a specific community.Changed Task CountA daily count of workflow tasks that have been changed.You can restrict the count results via the following additional filters:Workflow: Limit the results to a task in a specific workflow.Task Type: Limit the results to tasks of a specific type.Task: Limit the results to a specific task.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community.Task Status: Limit the results to tasks that have a specific status (Completed, Deleted or Unfinished).User: Limit the results to a specific user.Domain CountA daily count of the domains with relevant assets (either data or technology assets) that have been viewed.You can restrict the count results via the following additional filters:Type: Limit the results to a specific type.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community. License AvailableA daily count of Collibra licenses that have been available to users.This is calculated by subtracting the licenses in use from the total licenses your organization has.You can restrict the count results via the following additional filters:License: Limit the results to a specific type.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. License UsageA daily count of Collibra licenses in use by all users in your organization.You can restrict the count results via the following additional filters:License: Limit the results to active users with a specific license type.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Page HitsA daily count of Collibra asset page hits.You can restrict the count results via the following additional filters:Community: Limit the results to a specific community. Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Domain: Limit the results to assets from a specific domain.Task CountA daily count of workflow tasks carried out.Workflow: Limit the results to a task in a specific workflow.Task Type: Limit the results to tasks of a specific type.Task: Limit the results to a specific task.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community.Task Status: Limit the results to tasks that have a specific status (Completed, Deleted or Unfinished).User: Limit the results to a specific user.Task DurationA daily count of workflow task duration.You can restrict the count results via the following additional filters:Workflow: Limit the results to a task in a specific workflow.Task Type: Limit the results to tasks of a specific type.User: Limit the results to a specific user.Count Operation: Select the operation by which the results are shown in the template. For example, the sum of all values, the highest value or the lowest value each day over the last month. Community: Limit the results to a specific community.Task: Limit the results to a specific task.Click Save data set.The updated data set is shown in the graph.Edit the time range of a metrics graphBy default, the graphs on the Metrics pages are shown in daily increments, over a time range of one month. However, you can edit the time range to suit your needs.There are two ways to edit the time range:Click and drag in the graph.Select the dates for the graph.Click and drag in the graphOpen the product for which you want to create an asset (for example, Business Glossary).In the submenu, click Metrics.The Metrics page appears.Optionally, Add a data set to a metrics graph a data set to a graph.In the relevant graph, click at (or near) the first date in your desired range, and drag to the right, toward the last date in your desired range.While you are dragging, the color changes in the graph, indicating the resulting time range.Release the mouse button.The graph is adjusted to the new time range.Select the dates for the graphOpen the product for which you want to create an asset (for example, Business Glossary).In the submenu, click Metrics.The Metrics page appears.Optionally, Add a data set to a metrics graph a data set to a graph.On the left-hand side of the graph, click the date.A date picker appears.Click the first day of your desired time range, and then click Apply.The graph is adjusted to the date you selected.On the right-hand side of the graph, click on the date.A date picker appears.Click the last day of your desired time range, and then click Apply.The graph is adjusted to the date you selected.Remove a data set from a metrics graphYou can remove a data set that is shown in a graph on the Metrics pages if you don't want to see, for example, if you think there is too much information in a graph.Each graph will always show at least one data set. If it only contains one data set and you want to remove it, you first have to Add a data set to a metrics graph another data set. You can then remove the other one.StepsOpen the product for which you want to create an asset (for example, Business Glossary).In the submenu, click Metrics.The Metrics page appears.In the legend under the relevant graph, click on next to the data set you want to delete.The graph is updated.
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	 Data StewardshipThe Collibra Data Stewardship application helps data stewards manage their daily tasks. It also helps the administrators manage their stewards. Stewards can monitor and maintain their own space in the company's data governance ecosystem. This gives them a clear picture of their responsibilities inside the data governance structure.Data Stewardship submenu pagesPageDescriptionOrganizationContains a view with the hierarchical overview of communities and domains.Business DimensionsContains views for Business Process assets, Data Category assets and Line of Business assets.TagsProvides an overview of all tags in Collibra Data Intelligence Cloud.Physical Data ConnectorContains a table with high-level database information.MetricsContains a variety of statistics related to how the assets of the Stewardship application are used.Data ClassificationShows the available data classes in your Collibra environment.
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	 Using workflowsWorkflows in Collibra Data Intelligence Cloud allow you to define process steps, in BPMN standards, to get work done from initiation until completion, while at the same time defining ownership of every individual step. They allow users to complete tasks in a strictly guided and controlled way.You can see a detailed explanation of the out-of-the-box workflows that are included with Collibra Data Intelligence Cloud in the Workflows documentation.Start a global workflow Start an asset workflow from an asset page Start an asset workflow from an asset table or set of tiles My Tasks page Viewing workflow tasks Working with tasks Start a global workflowIf you want to start a workflow that is not linked to an asset, follow these steps:Go to a dashboard.If the dashboard does not have the workflow widget and you have the right permissions, you can add it yourself, see Add a widget to a dashboard.If you are not logged in and the guest user access is enabled for the workflow, you have to provide some identification and click Continue.In the workflow widget, click on the button of the workflow that you want to start.Fill in the required information in the dialog box and click the button at the bottom to confirm.The button's label depends on the workflow, for example, Propose for the Propose Business Term workflow or Create for the New Data Set workflow.Start an asset workflow from an asset pageIf you are on an asset page and you want to start a workflow for that asset, follow these steps:In the title bar, click the workflow that you want to start.If necessary, fill in the form.Click Submit at the bottom, to confirm.If you do not see the Submit button, you have to scroll to the bottom in the dialog box.Start an asset workflow from an asset table or set of tilesYou can start a workflow for one or more specific assets.StepsNavigate to a table or set of tiles.If you are: in table display mode, select the check boxes in front of the assets for which you want to start a workflow.in tile display mode, select the tiles for which you want to start a workflow. More information: Select multiple tiles.In the menu above the selected assets, click the name of the workflow you want to start.Only workflows that can be started for all selected assets at once are available.If necessary, fill in the form that is displayed.Click Submit. On the search page, you can also start an asset workflow by clicking for the relevant asset.My Tasks pageThe following image shows the different parts of the Tasks page:ElementNameDescriptionTasks submenuContains the following pages:  All Tasks: Shows all the tasks for which you have permission to view.  My Tasks: Shows all the tasks that have been assigned to you.  My Overdue Tasks: Shows the tasks that have been assigned to you that are past their due date.Select buttonAllows you to select one or multiple tasks for bulk operations.Tasks tableShows a list of tasks.Table menuContains refresh and display options for tasks table.Sidebar Contains all the elements that allow you to complete the task.Viewing workflow tasksWorkflows create tasks that ask users to provide input or to perform certain actions. You can view the tasks that are currently assigned to you in different locations, in different contexts.If a task is part of a workflow that has been started for a specific resource, you can consult the task on the resource page.It is displayed in the sidebar:You can also view all the tasks that have been assigned to you per resource. On the main menu bar, click the Tasks button.A page with a list of your tasks is displayed by default. You can order the tasks alphabetically by clicking the column headers.With the correct permission, you can do the following:Consult all other open tasks, on the All Tasks page. This view shows all your tasks and tasks for other users, for which you have permission to view.Cancel or reassign the tasks on the All Tasks page. When you cancel a task, you have to provide a reason in the dialog box that is displayed. After you have confirmed, the reason is shown as a comment on the corresponding asset page. You must not, in any way, complete tasks of other users.An Error column displays an error message if the workflow task encountered an unexpected error.Working with tasksEach task asks you to perform some kind of action. This can be something external to the application, provide input or change something in the application directly. When a task requires input, you are presented with a form to fill in the required information. You can complete tasks on the asset page or on the tasks pages.If you have more than one consecutive task assigned to you, each subsequent task is displayed immediately after the previous one is completed. This is especially useful in situations where a workflow is designed with multiple forms, one after the other, or a when you have more than one role for a resource.An example of this behavior is shown in the asset page screenshots in this section, where the user is assigned to Subject Matter Expert, Stakeholder, and Steward.For an example of a complete workflow, see Tasks in the Issue Management workflow.Completing a task on the asset pageOn asset pages, all task-related data is shown in the sidebar. You can complete all tasks actions from the sidebar.If the sidebar is not open, a task button indicates the number of active tasks.Completing a task from My Tasks pageOn the My Tasks page, all your tasks are listed in a table.To complete tasks from here you can use one of the following options:In the preview panel on the right of a selected task, you get information about the task and the step in the workflow diagram. Click on one of the buttons to complete the task.When you select a check box in front of a task, the actions that are possible for that task are displayed above the table. Click on one of the buttons to complete the task.When you select the check boxes of multiple tasks, the actions that are possible for that task are also displayed above the table. Click on one of the buttons to complete multiple tasks at once.If there is a form to fill in, it contains the names of all the assets for which you are completing a task.Even when you select different types of tasks, all the different options to complete a task are displayed. However, only the tasks for which the action is possible are completed and you cannot complete all of the tasks at once.Cancel a taskWith the correct permissions, you can cancel a task.    On the main menu, click   Tasks.   Click in the row of task that you want to cancel. Do not click the task name or resource name as that will open respectively the task details or asset page.The row is highlighted and the preview pane on the right is updated.At the bottom of the preview pane, click Cancel.Fill in an optional reason to cancel the task and click Cancel Task.Canceling a task means that the entire workflow is canceled and an event is created. It is possible that other workflows are listening for this event and are started automatically when this event occurs.Reassign a taskWith the correct permissions, you can reassign a task. To do so, follow these steps:    On the main menu, click   Tasks.   Click in the row of task that you want to cancel. Do not click the task name or resource name as that will open respectively the task details or asset page.The row is highlighted and the preview pane on the right is updated.At the bottom of the preview pane, click Reassign.Fill in the Reassign task dialog box.The workflow continues with the new set of users as candidates for the task. Keep in mind that if the task expects, for example, an attribute to be changed by one of the newly assigned users, that user needs the permission to do so.Click Reassign.View a workflow diagramEach task is part of a workflow. With the correct permissions, you can open the full workflow diagram. This allows you to see in which stage of the workflow the task is located.    On the main menu, click   Tasks.   Click the row of task that you want to cancel. Do not click the task name or resource name as that will open respectively the task details or asset page.The row is highlighted and the sidebar displays the task.In the sidebar, click the ellipses → View in workflow diagram.A rendering of the current position of the task in the workflow is displayed.
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	 Collibra settingsThe settings of Collibra Data Intelligence Cloud allow you to customize the operating model of your environment to your needs.By default, the settings open on a landing page that allows you to navigate to each of the sections. Contact Collibra support if you want to enable or disable this Settings landing page.General settings pageOn the General settings page of the Collibra settings, you can view and edit general settings. For example, you can see technical information and all activities. You can also add additional interface languages and manage banners.Tab pagesThe General settings page of the Collibra settings is split in several tab pages:Tab pageDescriptionSystemThis tab page contains information about the installation of your Collibra environment. You can also do the following: Rebuild the search index.Rebuild automatic hyperlinks.Upgrade the activity history.Activities            This tab page contains a table with all activities started by all users. It also shows more information about each activity, for example the creation date, name, status, start, finish and result.          LanguageThis tab page allows you to edit or translate the interface text of Collibra.BannersThis tab page allows you to create, edit or delete banners.Rebuild hyperlinksCollibra Data Intelligence Cloud can automatically create hyperlinks between assets. However, if those hyperlinks are outdated, you can rebuild them.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click General.The general settings appear on the Activities tab page.In the Automatic Hyperlinks section, click Rebuild automatic hyperlinks.Upgrade the activity history after an upgrade to 2020.11/5.7.7After an upgrade to 2020.11/5.7.7, the activity history of assets is not automatically visible in Collibra Data Intelligence Cloud. To view the activity history, you have to upgrade the history.The backup you restore needs to contain history data. This is one of the options when creating a backup.This is a one-time only action, subsequent upgrades don't require this extra step.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click General.The general settings appear on the Activities tab page.At the bottom of the page, click Upgrade History.What's next?The history in the backup is converted to the new environment. The conversion time depends on the size of the history in the backup.You can see the status of the history upgrade by viewing your activities.Interface text languagesThe interface text of Collibra Data Intelligence Cloud is available in several languages. The default language is English, but you can download French, German and Spanish translations from the Downloads section of the Collibra Product Resource Center.You can choose the interface language in your profile page. As an administrator, you can also edit and translate the interface text.From version 2022.11 onwards, Collibra takes the default language of your browser into account to select the interface text language of some sections. Collibra now also has translations of some interface text available out of the box. Consequently, you can no longer edit that interface text, nor translate it into unsupported languages. This includes the interface text of Usage Analytics, Data Marketplace and the Homepage.Supported languagesCollibra supports the following languages:EnglishFrenchGermanSpanishCollibra does not support other languages for the interface text and your instance data. For example, there are known issues with sorting and filtering non-Latin characters, and the Search feature might not return the right search results.LimitationsMost of the text in the interface of Collibra is translatable, including buttons, messages, tooltips, dialog boxes. However, there are some important limitations:The operating model is not translatable:Asset typesDomain typesStatusesCharacteristic typesRolesScopesInstance data is not translatable:Asset namesCharacteristicsTags and commentsNames of views and filtersText in dashboards and widgetsFrom version 2022.11 onwards, Collibra already has  translations of some interface text strings available out of the box. Consequently, you can no longer edit those interface text strings, nor translate them into unsupported languages.Structure of the interface textThe interface text is divided in translation messages, which consist of the following elements:ElementDescriptionMessage keyThe message key is a unique identifier that Collibra uses to retrieve the correct interface text.Activities.ActivitiesTable.status.error = ErrorEqual signAn equal sign between spaces ( = ).TextEditor.edit = EditA piece of interface textThe interface text is the actual piece of text in the user interface.COMMENT_ADDED = Comment AddedVariables (optional)Interface text may contains variables, which are placeholders for a piece of information. They are filled in when the text appears on the screen. They are represented by a number between curly brackets ({0}).PASSWORD_TOO_SHORT = The password must be at least {0} characters long.Markup (optional)Interface text may contain HTML tags to format text or to create hyperlinks in a piece of interface text.core.header.expired = Your password has expired!<br>Please change your password <a href={0} >here</a>.Edit or translate interface textYou can edit or translate the interface text of the Collibra Data Intelligence Cloud to meet your company's needs.You can work directly in the editor of Collibra, or you can copy the translation messages to a text file. You can then send the file to qualified translators, who probably don't have the required permissions to work in Collibra. You can download files containing the translation of the Collibra interface into French, German and Spanish from the Downloads page of the Collibra website.Message keys are not always backwards compatible with other Collibra versions. When you upgrade to a newer version, there might be new keys, renamed keys or keys that have been deleted.From version 2022.11 onwards, Collibra takes the default language of your browser into account to select the interface text language of some sections. Collibra now also has translations of some interface text available out of the box. Consequently, you can no longer edit that interface text, nor translate it into unsupported languages. This includes the interface text of Usage Analytics, Data Marketplace and the Homepage.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click General.The general settings appear on the Activities tab page.    In the tab pane, click   General → Language.At the top of the editor, choose the interface language.Languages that contain previously edited text are shown at the top of the drop-down menu.If you chose a previously edited language (), the editor contains the list of translation messages.If you chose a new language (), click Load Defaults to fill the editor with the default English UI text.Clicking Load Defaults multiple times inserts multiple copies of the interface text, so only click it once.Edit or translate the interface text, or paste the content from your translation file.Click Save.Reset interface textTo restore defaults from the language settings page you will need to override your changes with the default interface text.     On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click General.The general settings appear on the Activities tab page.    In the tab pane, click   General → Language.Click Load Defaults. Click Save.What's next?You can choose the interface language in your account settings.BannersBanners are messages that are visible for all users, on all pages of Collibra Data Intelligence Cloud.If you have a global role with the System Administration global permission, you can create, edit and delete banners in the Banners page of the General section of the Collibra settings.Top BannerThe top banner appears at the top of the page. It can contain up to 500 characters of rich text, including line breaks, but no images. You can dismiss it, after which it no longer appears until the message is updated. This is typically a good place to make company-wide announcements.Bottom BannerThe bottom banner appears at the bottom of the page. It can contain up to 250 characters of rich text, but no line breaks or images. You cannot dismiss the bottom banner and it is always visible, even in printed output. We recommend that you only use the bottom banner to display important information, such as disclaimers and legal information.Create a bannerYou can create a banner to post messages to all Collibra users.You can dismiss the top banner, so use it to post temporary announcements. You cannot dismiss the bottom banner, so use it to post important information, such as disclaimers and legal information.PrerequisitesYou have a global role that has the System administration global permission.Steps    Open the Banners page of the General section of the Collibra settings:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.In the General section, click Banners.The Banners page opens.In the Top Banner or Bottom Banner section, double-click or click .Enter the content of the banner.Click Publish.The Publish Banner dialog box appears.Click Publish.The banner is now visible on all pages for all users.Edit a bannerYou can edit a banner to update the message to all Collibra users.PrerequisitesYou have a global role that has the System administration global permission.Steps    Open the Banners page of the General section of the Collibra settings:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.In the General section, click Banners.The Banners page opens.In the Top Banner or Bottom Banner section, double-click or click .Edit the content of the banner.Click Publish.The Publish Banner dialog box appears.Click Publish.The updated banner appears on all pages for all users.Delete a bannerYou can delete a banner if it's no longer needed.PrerequisitesYou have a global role that has the System administration global permission.Steps    Open the Banners page of the General section of the Collibra settings:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.In the General section, click Banners.The Banners page opens.In the Top Banner or Bottom Banner section, double-click or click .The Remove Banner dialog box appears.Click Remove.The banner is no longer visible on any page.Operating model settings pageOn the Operating model settings page of the Collibra settings, you can view and edit the operating model, which defines the structure of the instance data, for example asset types, domain types, characteristic types and statuses.Tab pagesThe Operating model settings page of the Collibra settings is split in several tab pages:Tab pageWhat you can doAsset typesView and edit asset types and their assignments.Domain typesView and edit domain typesCharacteristicsView and edit characteristic types.AttributesView and edit attribute types.RelationsView and edit relation types.Complex relationsView and edit complex relation types.StatusesView and edit statuses.Data quality rulesView and edit data quality rules.ScopesView and edit scopes.Roles and permissions settings pageOn the Roles and permissions settings page of the Collibra settings, you can view and edit the permissions and roles to define which actions users can do.Tab pagesThe Roles and permissions settings page of the Collibra settings is split in several tab pages:Tab pageDescriptionGlobal rolesThis tab page allows you to view and edit global roles, and add or remove users.Resource rolesThis tab page allows you to view and edit resource roles, and add or remove users.Global permissionsThis tab page allows you to view global permissions, and add or remove global permissions to or from global roles.Resource permissionsThis tab page allows you to view resource permissions, and add or remove resource permissions to or from resource roles.PermissionsA permission is an authorization to access an application of Collibra Data Intelligence Cloud, or to view or edit a resource.Users are not granted permissions directly, but through global roles and responsibilities.Collibra provides a set of permissions that are included in the default roles. Permission typesCollibra has two types of permissions: Global permissionsResource permissionsRequired license type of permissionsCollibra has several types of permissions, based on the license type that a user needs to act on the permission.Resource permission typeDescriptionRead-only permissionA read-only permission is a permission for which a read-only license or higher is required.Standard permissionA standard permission is a permission for which a standard license is required.ActionsDetermine which global permissions are included in global roles.Determine which resource permissions are included in resource roles.Global permissionsA global permission is a permission that applies across all Collibra applications. It can be added to a global role. For an overview of the permissions in each packaged global role, see the online version of this documentation.Global permissionDescriptionRequired licenseAsset gridThe Asset grid global permission contains global permissions that allow users to configure asset grids. AdministrationThe Asset grid > Administration global permission allows users to create and manage asset grids.This global permission is only visible if Asset Grid Permission is enabled in Collibra Console.Read-onlyCatalogThe Catalog global permission contains global permissions that allow users to use advanced features of Data Catalog. Advanced Data TypeThe Catalog > Advanced Data Type permission group contains global permissions that allow users to manage advanced data types. AddThe Catalog > Advanced Data Type > Add global permission allows users to create advanced data types.StandardRemoveThe Catalog > Advanced Data Type > Remove global permission allows users to delete advanced data types.StandardUpdateThe Catalog > Advanced Data Type > Update global permission allows users to edit advance data types.StandardRegister Profiling InformationThe Catalog > Register Profiling Information global permission allows API users to enable data profiling when registering a data source.StandardTechnical LineageThe Catalog > Technical Lineage global permission allows users to see the technical lineage of a data source.Read-onlyEdgeThe Edge global permission contains global permissions that allow users to install and manage Edge sites.Currently, Edge is an on-demand cloud service. It will only become the default service once the migration from Jobserver to Edge is complete. InsightsThe Insights global permission contains global permissions related to Insights Data Access and Usage Analytics. Download the Insights reporting dataThe Insights > Download the Insights reporting data global permission allows users to download the data from the Insights Data Access API (formerly called Reporting Data Layer).StandardView Insights reportsThe Insights > View Insights reports global permission allows users to access the dashboard widgets.Read-onlyView Usage Analytics SummaryThe Insights > View Usage Analytics Summary global permission allows users to access the Usage Analytics dashboard, excluding the detailed usage data.Read-onlyView Usage Analytics reportsThe Insights > View Usage Analytics reports global permission allows users to access the Usage Analytics dashboard, including the detailed usage data, and also download the data.Read-onlyProduct RightsThe Product Rights permission group contains global permissions that allow users to access Collibra applications. AssessmentsThe Product Rights > Assessments global permission allows users to access the Assessments application.Read-onlyBusiness Semantics GlossaryThe Product Rights > Business Semantics Glossary global permission allows users to access the Business Glossary application.Read-onlyCatalogThe Product Rights > Catalog global permission allows users to access the Data Catalog application.Read-onlyData DictionaryThe Product Rights > Data Dictionary global permission allows users to access the Data Dictionary application.Read-onlyData HelpdeskThe Product Rights > Data Helpdesk global permission allows users to access the Data Helpdesk application.Read-onlyData Stewardship ManagerThe Product Rights > Data Stewardship Manager global permission allows users to access the Data Stewardship application.Read-onlyPolicy ManagerThe Product Rights > Policy Manager global permission allows users to access the Policy Manager application.Read-onlyPrivacyThe Product Rights > Privacy global permission allows users to access the Privacy landing page.Read-onlyReference Data ManagerThe Product Rights > Reference Data Manager global permission allows users to access the Reference Data application.Read-onlySystem AdministrationThe Product Rights > System Administration global permission allows users to manage all sections of the Collibra Settings, including the general settings, the operating model , roles, permissions, users, groups and workflows.StandardUser AdministrationThe Product Rights > User Administration global permission allows users to manage users and groups.StandardWorkflow AdministrationThe Product Rights > Workflow Administration global permission allows users to access the Workflow tab page of the Collibra Settings.StandardWorkflow Designer accessThe Product Rights > Workflow Designer access global permission allows users to access the Workflow Designer application from the Collibra menu.This permission becomes available after you enable the Allow access to the Workflow Designer Collibra configuration setting.Read-onlyResources The Resources permission group contains global permissions that allow users to see and manage assets, domains and communities. Manage all resourcesThe Resources > Manage all resources global permission allows users to see and manage all communities and domains, and assets whose type belongs to a product whose Product Right the user has, regardless of responsibilities.StandardTags The Tags permission group contains global permissions that allow users to see and manage tags in the Data Stewardship application. Manage tags The Tags > Manage tags global permission allows users to edit and delete tags on the tags page in the Data Stewardship application. StandardView tags The Tags > View tags global permission allows users to see the Tags Overview page in the Data Stewardship application. Read-onlyView PermissionsThe View Permissions permission group contains global permissions that allow users to see all views, which includes dashboards, diagram views, asset views, search filters and relation views on an asset page. View AllThe View Permissions > View All global permission allows users to see all communities, domains and the assets within them, thus ignoring view permissions.Read-onlyViews, Dashboards, Search filtersThe Views, Dashboards, Search filters permission group contains global permissions that allow users to manage and share views, dashboards and search filters. Manage shared Views, Dashboards, Search filtersThe Views, Dashboards, Search filters > Manage shared Views, Dashboards, Search filters global permission allows users to share, edit and delete views, dashboards and search filters that are shared.StandardManage your own Views, Dashboards, Search filtersThe Views, Dashboards, Search filters > Manage your own Views, Dashboards, Search filters global permission allows users to edit and delete your own views, dashboards and search filters.Read-onlyShare your own Views, Dashboards, Search filtersThe Views, Dashboards, Search filters > Share you own Views, Dashboards, Search filters global permission allows users to share your own views, dashboards and search filters.Read-onlyWorkflowThe Workflow permission group contains global permissions that allow users to manage workflows. Use workflow message eventsThe Workflow > Use workflow message events global permission allows users to pass message events to the workflow engine via an API call.This is used for API users.Read-onlyView all running tasksThe Workflow > View all running tasks global permission allows users to see ongoing tasks that are assigned to other users in the All Tasks tab on the tasks page.StandardResource permissionsA resource permission is a permission that applies to a resource and its children. They are combined into resource roles to create responsibilities. For an overview of the permissions in each packaged resource role, see the online version of this documentation.Resource permissionDescriptionRequired licenseAssetThe Asset permission group allow users to work with assets. AddThe Asset > Add resource permission allows users to create assets.StandardRemoveThe Asset > Remove resource permission allows users to delete assets.StandardUpdateThe Asset > Update resource permission allows users to edit assets.This only refers to the asset name and automatic hyperlinking.StandardUpdate StatusThe Asset > Update Status resource permission allows users to change the status of assets.StandardUpdate TypeThe Asset > Update Type resource permission allows users to change the asset type of assets.StandardAttributeThe Asset > Attribute permission group allow users to work with attributes of assets. AddThe Asset > Attribute > Add resource permission allows users to add characteristics to assets.If you want to use images and attachments in attributes of assets, you also need the Attachment > Add permission.StandardRemoveThe Asset > Attribute > Remove resource permission allows users to remove characteristics from assets.StandardUpdateThe Asset > Attribute > Update resource permission allows users to edit characteristics of assets.If you want to use images and attachments in attributes of assets, you also need the Attachment > Add permission.StandardDataThe Asset > Data permission group allow users to work with data from data sources. Access DataThe Asset > Data > Access Data resource permission allows users to create Tableau provision files.Read-onlyView SamplesThe Asset > Data > View Samples resource permission allows users to see sample data of data sources.Read-onlyResponsibilitiesThe Asset > Responsibilities permission group allow users to manage the responsibilities of assets. AddThe Asset > Responsibilities > Add resource permission allows users to create responsibilities for assets.StandardRemoveThe Asset > Responsibilities > Remove resource permission allows users to delete responsibilities from assets.StandardUpdateThe Asset > Responsibilities > Update resource permission allows users to edit responsibilities of assets.StandardTagsThe Asset > Tags permission group allow users to work with tags. UpdateThe Asset > Tags > Update resource permission allows users to edit and delete tags on asset pages and asset tables.Read-onlyAttachmentThe Attachment permission group allow users to manage attachments. AddThe Attachment > Add resource permission allows users to add attachments to resources.Read-onlyRemoveThe Attachment > Remove resource permission allows users to remove attachments from resources.Read-onlyUpdateThe Attachment > Update resource permission allows users to edit attachments of resources.Read-onlyCommentThe Comment permission group allow users to work with comments. AddThe Comment > Add resource permission allows users to add comments to resources.If you want to use images and attachments in comments, you also need the Attachment > Add permission.Read-onlyRemoveThe Comment > Remove resource permission allows users to delete comments from resources.StandardUpdateThe Comment > Update resource permission allows users to edit comments of resources.If you want to use images and attachments in comments, you also need the Attachment > Add permission.StandardCommunityThe Community permission group allow users to manage communities. AddThe Community > Add resource permission allows users to create and edit communities.If you want to use images and attachments in the description of communities, you also need the Attachment > Add permission.StandardConfigure external systemThe Community > Add resource permission allows users to set up connections to external data sources.StandardRemoveThe Community > Remove resource permission allows users to delete communities.StandardUpdateThe Community > Update resource permission allows users to edit communities.If you want to use images and attachments in the description of communities, you also need the Attachment > Add permission.StandardResponsibilitiesThe Community > Responsibilities permission group allow users to manage the responsibilities of communities. AddThe Community > Responsibilities > Add resource permission allows users to create responsibilities for communities.StandardRemoveThe Community > Responsibilities > Remove resource permission allows users to delete responsibilities from communities.StandardUpdateThe Community > Responsibilities > Update resource permission allows users to edit responsibilities of communities.StandardDomainThe Domain permission group allow users to manage domains. AddThe Domain > Add resource permission allows users to create and edit domains.If you want to use images and attachments in the description of domains, you also need the Attachment > Add permission.StandardRemoveThe Domain > Remove resource permission allows users to delete domains.StandardUpdateThe Domain > Update resource permission allows users to edit domains.If you want to use images and attachments in the description of domains, you also need the Attachment > Add permission.StandardResponsibilitiesThe Domain > Responsibilities permission group allow users to manage the responsibilities of domains. AddThe Domain > Responsibilities > Add resource permission allows users to create responsibilities for domains.StandardRemoveThe Domain > Responsibilities > Remove resource permission allows users to delete responsibilities from domains.StandardUpdateThe Domain > Responsibilities > Update resource permission allows users to edit responsibilities of domains.StandardRatingThe Ratings permission group allow users to work with ratings. AddThe Rating > Add resource permission allows users to rate assets, edit and delete your own ratings.Read-onlyRemoveThe Rating > Remove resource permission allows users to delete other users' ratings.StandardUpdateThe Rating > Update resource permission allows users to edit other users' ratingsStandardValidationThe Validation permission group allow users to validate assets. Validation executionThe Validation > Validation Execution resource permission allows users to manually start validation of an asset from the asset page or an asset table.StandardView PermissionsThe View Permissions permission group allow users to manage the view permissions of domains and communities. Edit View PermissionsThe View Permissions > Edit View Permissions resource permission allows users to edit the view permissions of domains and communities.StandardWorkflowThe Workflow permission group allow users to manage workflows tasks. Manage WorkflowsThe Workflows > Manage Workflows resource permission allows users to see all running workflow tasks for the related asset.It does not give you permission to cancel or reassign tasks, as this is determined by the workflow definition.StandardEnable permission to use tagsTo enable the permission to use tags, follow these steps:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Permissions → Resource.The matrix of resource permissions and roles appears.In the table, look up Tags.In the role column, click to enable the permission.If you see , that role is permitted to use tags.A user with one of the selected resource roles on an asset can use (add, update and delete) tags on that asset.Disable the permission to use tagsTo disable the permission to use tags, follow these steps:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Permissions → Resource.The matrix of resource permissions and roles appears.In the table, look up Tags.In the role column, click to disable the permission for the role.If you see , that role is not permitted to use tags.RolesA role is a collection of permissions that can be assigned to users and user groups.Role typesThe role type determines whether the permissions in the role apply to resources or the Collibra Data Intelligence Cloud applications.Collibra has two types of roles:Global rolesResource rolesGlobal rolesA global role is a role that consists of global permissions. You assign a user to a global role to determine which Collibra applications the user can use.Global rolesThe following table contains the packaged global roles.Global roleDescriptionAssessmentsA user who can access Assessments.Asset Grid AdminA user who can access Asset Grid.CatalogA user who can access Data Catalog. The global permissions in this role only require a consumer license.Catalog AuthorA user who can access Data Catalog. Users with this role can also create, edit and delete advanced data types.  Data DictionaryA user who can access the Data Dictionary application, which contains all the technical metadata of the physical data sources and other data assets.DataStewardA user who can access the Data Stewardship application for viewing tags, Business Dimensions and the organization structure, including the responsibilities of the communities and domains.DataSteward AuthorA user who can access the Data Stewardship application to see tags, Business Dimensions and the organization structure, including the responsibilities of the communities and domains. Users with this role can also manage tags on the tags overview page.Edge integration engineerA user who can add, edit and delete Edge connections and capabilities.Edge managerA user who can create, edit and delete Edge sites.Edge siteA user who can create a connection between itself, as an Edge site, and Collibra Data Intelligence Cloud.The user is not a person, but an Edge site. The user is automatically created when you install an Edge site.Edge site administratorA user who can download the download and installer files to install an Edge site.GlossaryA user who can access the Business Glossary application.Users with this role can access all business semantics glossary functionality and workflows concerning business term proposal and approval, data element usage, structure and glossary alignment.Data HelpdeskA user who can access the Data Helpdesk application, where users can log issues and check issue statuses and assignees.InsightsA user who can access Insights Data Access and Usage Analytics.Policy ManagerA user who can access the Policy Manager application, which is a collection of all governance assets.Privacy UserA user who can access the Privacy landing page.Collibra Data Privacy is a paid product.Protect AdminA user who has the same permissions as a Protect Author. In addition, this user can edit the data access rules and data protection standards of other users and also access additional APIs.Collibra Protect is a paid product.Protect AuthorA user who can create data protection standards and data access rules, view imported policies, view groups, and generate audits as an individual contributor.Collibra Protect is a paid product.Protect ManagerThis role is intended for the Collibra Protect system user to manage background processes and configure Collibra Protect.Collibra Protect is a paid product.Protect ReaderA user who can view Collibra Protect with read-only access to the content.Collibra Protect is a paid product.ReferenceDataA user who can access the reference data accelerator. Users with this role are typically allowed to:   Access all reference data functionality and workflows concerning code proposal, code approval and code mapping.  Define and manage the crosswalk, code value and codes set asset types and their subtypes.  Define and manage complex relation types such as code mapping.SysadminA user who can configure and manage the Collibra Data Intelligence Cloud. Users with this role are typically allowed to:   Access and modify the Settings.  Define and manage the operating model.Create a global roleYou can create a new global role. For example, you can do this if the packaged roles don't meet your specific needs.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Roles.The overview of global roles appears.Above the table, to the right, click Add.The Global Role Creation dialog box appears.Enter the required information.FieldDescriptionNameType a name for the role.DescriptionType a description for the role.UsersEnter the users or user group that are granted this role.You can still assign a global role to a user later.Click Save.What's next?Determine which global permissions are included in this role.Assign users to the role.Edit a global roleYou can edit a global role. You can do so, for example, if you want to edit the name or the description of a role.Do not confuse this with adding or removing global permissions.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.Double-click a cell.The cell editor appears.Edit the cell.  Click .  Add or remove global permissions to a global roleYou can determine which global permissions are included in a global role.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Permissions .The matrix of global permissions and roles appears.If required, add or remove columns:On the content toolbar, click → <the name of the role>.Above the table, to the right, click Edit.You can now edit the matrix of permissions and roles.Select or clear the checkboxes to add permissions to, or remove them from a role.Above the table, to the right, click Save.Assign a global role to a user or a user groupYou can assign a global role to a user or user group.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.In the row of the role to which you want to assign users or user groups, double-click the Members column.Start typing in the field and click the user or user group that you want to assign.Press Enter to assign multiple users or groups at once.Click Save.Delete a global roleYou can delete a global role. For example, you can do this if you no longer need a specific role.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.In the row of the role, click .The Delete dialog box appears.Click Delete.Resource roles and permissionsA resource role is a role that consists of resource permissions and applies to a resource and its children. For example, if you assign a resource role to a domain, it also applies to all assets in the domain. If you assign a resource role to a community, it also applies to all its subcommunities, domains and assets in the community. The purpose of resource roles is to grant resource permissions to users through a responsibility. For example, they determine which users can edit assets via the asset page or in a workflow.In this chapterResource rolesThe following table shows the packaged resource roles. Resource roleDescriptionAssigneeA user who is assigned to complete a task.Business StewardA user who is involved in daily, business-related decisions about the best ways to turn policy into practice.Chief Data OfficerA high-level decision maker who is responsible for enterprise-wide data governance and the utilization of information as an asset.Community ManagerA user who acts as liaison between all the different roles and groups. This user can also analyze and pack up issues, so that the data governance council can make decisions. Assigning and removing roles and responsibilities are also among this user's duties.Council MemberA user who represents business and technical data stakeholder functional groups.Data Analyst Level 1This role is assigned to a user on a date element level when this user is allowed to see a data sample of this data element.Data Analyst Level 2This role is assigned to a user on a date element level when this user has full access to the data.Data Category Manager Data CustodianA user who collects and holds information on behalf of a data provider or requester and who is responsible for managing the use, disclosure and protection of data.Issue ManagerA user who identifies and prioritizes issues with business impact, directs resources to the most urgent issues and reassigns tasks to different users in the absence of the assigned user.NormalA user who does not have any assigned responsibilities.OwnerA user who is responsible for accuracy, integrity, and timeliness of an information asset and for establishing the controls for its generation, collection, processing, access, dissemination and disposal.RequesterA user who makes a request related to an information asset.ReviewerA user who is assigned to review an outcome of a user task.StakeholderA user who can use, affect or be affected by an asset under discussion. This user wants to be involved or notified, but can only provide comments and reviews.Subject Matter ExpertA user who performs specific data-related tasks and is consulted to provide guidance and feedback to individuals with stewardship responsibilities.Technical StewardA user who is involved in daily, data-related decisions, executes business decisions and implements business requirements in a technology platform.Create a resource roleYou can create a new resource role. You can do so, for example, if the packaged resource roles don't meet your specific needs.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Roles→ Resource.The overview of resource roles appears.Above the table, to the right, click Add.The Resource Role Creation dialog box appears.Enter the required information.FieldDescriptionNameType a name for the role.DescriptionType a description for the role.Click Save.What's next?As new resource roles are created with no resource permissions included, you have to add them for the new resource role.As new resource roles are created with no resource permissions included, you have to add them for the new resource role.Create a responsibility to assign users to the roles for a resource.Edit a resource roleYou can edit a resource role. You can do so, for example, if you want to edit the name or the description of a role.Do not confuse this with adding or removing resource permissions.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Roles→ Resource.The overview of resource roles appears.Double-click a cell.The cell editor appears.Edit the cell.  Click .  Add or remove resource permissions for a resource roleYou can determine which resource permissions are included in a resource role.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Permissions → Resource.The matrix of resource permissions and roles appears.If required, add or remove columns:On the content toolbar, click → <the name of the role>.Above the table, to the right, click Edit.You can now edit the matrix of permissions and roles.Select or clear the checkboxes to add permissions to, or remove them from a role.Above the table, to the right, click Save.Delete a resource roleYou can delete a resource role. For example, you can do this if you no longer need a specific role.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.    In the tab pane, click   Roles→ Resource.The overview of resource roles appears.In the row of the role, click .The Delete dialog box appears.Click Delete.ResponsibilitiesResponsibilities are used to assign a resource role to one or more users and/or user groups. Based on their responsibilities, users can act on the permissions conveyed to them via the resource role. ResponsibilitiesA responsibility is the assignment of one or more users and/or user groups to a resource role for a resource.Based on their responsibilities, users can act on the permissions conveyed to them via the resource role. Child resources always inherit the responsibilities from their parent resources:If the resource is a community, the responsibilities are inherited by subcommunities, domains and assets in the community. For example, if you are a Business Steward for a certain community, you are a Business Steward for all the subcommunities, domains and assets inside that community.If the resource is a domain, the responsibilities are inherited by the assets in the domain.If the resource is an asset, the responsibilities only apply to the asset itself, because assets never have children.Suppose the following setup:Anita Morrison is assigned the Community Manager resource role for a community called Enterprise.John Fisher is assigned the Business Steward resource role for a domain called Critical Data Elements in the Enterprise community.Joanna Zhou is assigned the Owner resource role for a domain called Critical Data Elements in the Enterprise community.William Parker is assigned the Owner resource role for an asset called Customer Revenue in the Critical Data Elements domain.This leads to the following responsibilities:ResourceDirect responsibilitiesInherited responsibilitiesEnterprise communityAnita Morrison as Community ManagerNoneCritical Data Elements domainJohn Fisher as Business StewardJoanna Zhou as OwnerAnita Morrison as Community ManagerCustomer Revenue assetWilliam Parker as OwnerAnita Morrison as Community ManagerJohn Fisher as Business StewardJoanna Zhou as OwnerYou can view direct and inherited responsibilities of a resource in different places.View responsibilities for a resourceYou can view the responsibilities for a resource in the following locations:In the Responsibilities tab of a resource.In any view that displays communities, domains or assets, in the specific column or field for that role.Open any view in table or tiles mode.Perform one of the following steps:In tile mode: add the required fields.In table mode, add the required column.Each role has its own field or column.Depending on the settings in Collibra Console, you may also see the inherited responsibilities.In the Responsibilities tab of a user's profile page.You can also view your own responsibilities.Open a profile page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.In the Responsibilities tab of a user group page.Open a group page.    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.    In the tab pane, click   Users → Groups.The user group table appears.    In the tab pane, click   Responsibilities.The Responsibilities page appears.In the Preview pane of an asset, for example on an asset page.The preview pane only shows the direct responsibilities.The Responsibilities pageThe Responsibilities page shows the view permissions and the responsibilities of a resource.The background colors of the responsibilities show where the responsibility comes from.ColorDescriptionGrayThe user or group inherited the role.WhiteThe user or group was directly assigned to this role for the resource.If a user or group has a responsibility but not the required view permissions, a warning appears in the box. For example, a user was assigned the Steward role for a resource but does not have view permissions for it.For information on view permissions, see the Collibra Data Intelligence Cloud Administration Guide.Create a responsibilityYou can create a responsibility:By assigning a resource role to a user or user group on the responsibilities page of a resource.By adding a user in the table column of a role.By editing an existing responsibility.For optimal performance and ease of use, we recommend that you create responsibilities mainly on domains and communities and not directly on assets. Creating responsibilities directly on large amounts of assets may lead to decreased performance.Assign a resource role to a user or user group on the responsibilities pageOpen a community, domain, or asset page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.Above the table, to the right, click Add.The Add responsibilitiy dialog box appears.Enter the required information.OptionDescriptionRoleEnter the role that you want to assign to a user or group for this resource.People Enter the users and user groups to which you want to assign a role for this resource.Click Add.The users or groups with the assigned role are now displayed in the Responsibilities table.If you want to assign a user or user group a resource role that other users or groups already have for this resource, you can click and add them in the People field in the Assign role box.If there are only inherited roles, is not available.Assign a role to a user or user group for a resource from a tableOpen a table that displays communities, domains or assets.      If required, add the column of the role that you want to assign to the user. Perform one of the following steps:Double-click a cell in the column of the role.Hover your mouse pointer over a cell in the column and click .Click in the field and enter the user or user group.If required, select Apply to visible rows.This will create the responsibilities for all visible users.You can filter the columns first, to assign a role to a user for specific resources in one go.Click .Edit a responsibilityYou can edit a responsibility:by deleting it and creating a new one.in an asset table.You cannot edit inherited responsibilities.Edit a responsibility in a tableOpen a table that displays communities, domains or assets.      If required, add the column of the role that you want to edit.Depending on the settings in Collibra Console, you may also see the inherited responsibilities. You cannot edit these inherited responsibilities. Perform one of the following steps:Double-click a cell in the column of the role.Hover your mouse over a cell in the column and click .Edit the responsibility:Click in the field and enter a new user or user group.Click next to the user or user group to remove the user or user group.If required, select Apply to visible rows.This will edit the responsibilities of all visible users.You can filter the columns first to assign a user to specific resources in one go.Click .Delete a responsibilityYou can delete a responsibility:From the responsibilities page of a resource.From a table.You cannot delete inherited assignments.Delete a responsibility from the responsibilities page of a resourceOpen a community, domain, or asset page.    In the tab pane, click   Responsibilities.The Responsibilities page appears.In the Responsibilities table, click next to the name of the user or group that you want to remove. Click Delete to confirm.Delete responsibilities for a resource from a tableOpen a table that displays communities, domains or assets.      If required, add the column of the role that you want to edit.Depending on the settings in Collibra Console, you may also see the inherited responsibilities. You cannot delete these inherited responsibilities. Perform one of the following steps:Double-click a cell in the column of the role.Hover your mouse over a cell in the column and click .In the cell editor, click next to the user or user group.If required, select Apply to visible rows.This will delete the responsibilities from all visible users.You can filter the columns first to assign a user to specific resources in one go.Click .Managing workflows in CollibraA workflow in Collibra Data Intelligence Cloud is used to automate processes. Collibra comes with many out-of-the-box workflows, and you can always add new ones.When you decide how to configure your Collibra workflows, consider that the workflow events mechanism is not designed for mass import. Avoid triggering workflows as a result of an import operation because it has the potential of impacting the performance of your environment. If you must use workflows after importing large amounts of data, you should:Configure all script tasks to run asynchronously to prevent slowing down the import.Keep the number of start events to a minimum.Restrict the scope of the workflow as much as possible.Tab pagesThe Workflows settings page of the Collibra settings is split in several tab pages:Tab pageDescriptionDefinitionsThis tab page allows you to view and edit workflow definitions.InstancesThis tab page allows you to view and edit instances of running workflows.Out-of-the-box workflow deploymentsIn general, when you start your Collibra Data Intelligence Cloud environment, all missing out-of-the-box (OOTB) workflows are deployed, enabled and configured with the default settings.OOTB workflows are not automatically updated after an upgrade.The following list of rules applies to OOTB workflow deployments in version 5.1 or newer when you (re)start an environment:OOTB workflows that are missing (deleted or never deployed), are deployed, enabled and configured with the default settings.Deployed OOTB workflows are not automatically updated, even if they are not customized. To install a new version of an OOTB workflow, do either of the following:Remove the existing workflow and then restart the environment.Download the updated workflows from the Community Downloads page, customize them if necessary, and deploy them to your environment.If you created a workflow with the name of an OOTB workflow and the actual OOTB workflow is not deployed, the actual OOTB workflow is deployed, enabled and configured with a name having an OOTB_ prefix, for example OOTB_Approval Process.Disable the OTTB workflows you do not want to use. If you delete them, they are redeployed when the environment is restarted.Workflow engine upgradeIn Collibra Data Intelligence Cloud 5.6 or newer, the workflow engine uses Flowable instead of Activiti because of the lack of development and support for Activiti. The upgrade has the following impact:When you upgrade from version 5.5 or older to Collibra Data Intelligence Cloud 5.6 or newer, all workflows in your environment are redeployed for the new workflow engine. Running instances of workflows continue to use the old workflow engine until their completion, while new instances run with the new workflow engine.The upgrade to Flowable ensures the out-of-the-box workflows remain functional.Test your custom workflows thoroughly, even if they seem to work as expected.Your workflows could show unexpected behavior, especially after upgrading from version 4.6.x.When you reference the API v2 name space (http://www.collibra.com/apiv2), the workflow is validated against V2 methods and deprecated V1 methods trigger a method does not exist error when called.View and edit workflowsYou can view both the XML schema and a visual representation of the workflow definition in Collibra Data Intelligence Cloud.    You must have the Sysadmin global role or a global role that has at least the Workflow Administration global permission to   access this page:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Workflows.The Workflows settings page appears on the Definitions tab page.Select a workflow.    In the tab pane, click   Flow.To view large diagrams, drag the image or click to enter full screen.The lower part of the page contains the raw workflow definition:To edit workflows, follow the procedures described in the Edit an out-of-the-box workflow section of the Workflows documentation. For minor updates, you can edit the XML schema directly :Click to edit the XML.Click the Save button in the lower-right part of the page to save your changes and exit edit mode.The changes you make are not reflected in currently running instances of the workflow.Deploy a workflowYou deploy a workflow when you upload the workflow definition or exported workflow designer app to Collibra Data Intelligence Cloud.You can upload a workflow in *.bpmn, *.bpmn20.xml and zip format.PrerequisitesYou have a global role with the Workflow Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Workflows → Definitions.Click  Upload a file and select the workflow definition you want to deploy or drag and drop your workflow in the upload section.An Activity Queue window displays the upload progress. In case the update fails, you see an error message.    Uploading a workflow with the same process ID as an existing workflow in Collibra replaces the existing workflow.  Collibra does not accept two workflows with the same display name.  What's nextAfter a successful workflow deployment, edit the workflow definition settings in Collibra.Enable or disable workflowsYou can enable or disable workflows from the workflow definitions table or from the individual workflow definition pages.    You must have the Sysadmin global role or a global role that has at least the Workflow Administration global permission to   perform this action.Enable or disable a workflow from the workflow definitions table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Workflows → Definitions.At the end of the row, click or to respectively enable or disable a workflow.Enable or disable a workflow from the workflow definition page    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Workflows → Definitions.Click the workflow you want to enable or disable.      At the right of the title bar, click or to respectively enable or disable a workflow.Workflow configuration options in CollibraAfter you have successfully deployed a workflow, the default settings are applied to it. You can change the default settings and the workflow behavior to your organization's needs.In the overview of a workflow, you can change the header bar and some general workflow settings.Workflows title barThe title bar of workflow definition pages contains the name and status of the workflow and allows you to:Enable or disable the workflow.Edit the display name or status of the workflow.Delete the workflow.Collibra does not accept two workflows with the same display name.  Workflow statuses description:Deployed A new workflow has been uploaded to Collibra Data Intelligence Cloud.Enabled: The workflow is active and can be used.Disabled: The workflow cannot be used. If the workflow is a step in another workflow, that step fails.Once a workflow has been enabled, you cannot change the status back to Deployed.View and edit workflow definition settingsThe workflow definition settings are additional parameters that help you manage the workflow behavior and accessibility inside Collibra Data Intelligence Cloud.When you decide how to configure your Collibra workflows, consider that the workflow events mechanism is not designed for mass import. Avoid triggering workflows as a result of an import operation because it has the potential of impacting the performance of your environment. If you must use workflows after importing large amounts of data, you should:Configure all script tasks to run asynchronously to prevent slowing down the import.Keep the number of start events to a minimum.Restrict the scope of the workflow as much as possible.    You must have the Sysadmin global role or a global role that has at least the Workflow Administration global permission to   access this page:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Workflows.The Workflows settings page appears on the Definitions tab page.Select a workflow to view the definition settings.DescriptionThe description is a brief overview of the workflow. You can edit the description by:Changing the diagram process properties.Editing the workflow XML directly in Collibra Data Intelligence CloudApplies ToThis section defines the scope of the workflow. This includes the type of resource the workflow applies to, optional restriction rules and where you can start the workflow from.Click Edit to change the scope to any of the following:AssetCommunityDomainGlobal    When you change the scope, the rules are removed.       If you are changing from or to the Global scope, the roles are also removed.A global workflow is not restricted to any particular resource and can be added to dashboards.When you defined the resource that the workflow applies to, you can add restriction rules to finetune the scope of the workflow.Show me howClick Add.A dialog box appears.The available options depend on the selected scope.Select the Type. Select Asset to associate the workflow with all asset types.Select an optional domain or community the resource belongs to.Select an optional status of the resource the workflow applies to.Click Save.The restriction is added to the list. The workflow is restricted to the resources that meet the listed conditions.If you select multiple restrictions, they use the logical OR function.VariablesThese are configuration variables, a list of process variables that you can edit here.Click Edit to edit the variables.You can only edit configuration variables that have the Writable property set to true (default).If you redeploy a workflow, the configured variables remain the same. If you delete a workflow and then deploy it again, the variables revert to the default values.Start LabelThe start label is the name of the workflow when it is visible as a button on a resource page or in the drop-down list when you add it as a button on a dashboard. Click Edit to edit the label.Start EventA start event is an event that triggers the workflow, for example starting the workflow when an asset is created. Click Edit to edit the start event list.Combine the Start Event with Applies To settings to refine when the workflow is triggered.SettingDescriptionAsset AddedThe workflow starts when a new asset is created.Asset RemovedThe workflow starts when an asset is deleted.Asset Status ChangedThe workflow starts when the status of an asset is changed.Asset Domain ChangedThe workflow starts when an asset is moved to another domain.Asset Type ChangedThe workflow starts when the type of an asset is changed.Asset Attribute ChangedThe workflow starts when an attribute of an assets is changed.Asset Name ChangedThe workflow starts when the full name of an asset is changed. This is the fully qualified name that must be unique within a domain. To learn more, see Identical asset names per domain.Asset Display Name ChangedThe workflow starts when the name of an asset is changed. This is the regular name that is used by default in most places in the user interface.Asset Attribute AddedThe workflow starts when an attribute is added to an asset.Asset Attribute RemovedThe workflow starts when an attribute is removed from an asset.Domain AddedThe workflow starts when a domain is added to a community.Domain Removed The workflow starts when a domain is removed from a community.Role GrantedThe workflow starts when a user or a user group is assigned a resource or a global role.Role RevokedThe workflow starts when a user or a user group is removed from a resource or a global role.Workflow StartedThe workflow starts when a workflow is manually started.Manually starting a workflow configured with this option also triggers the workflow.Workflow CanceledThe workflow starts when a workflow is manually canceled.Manually canceling a workflow configured with this option also triggers the workflow.Workflow EscalationThe workflow starts when a workflow user task is escalated.The packaged Escalation Process workflow is configured to start with this option.Workflow task completedThe workflow starts when a workflow user task is completed.User AddedThe workflow starts when a new user account is created.User RemovedThe workflow starts when a user account is removed.User DisabledThe workflow starts when a user account is disabled.Commend AddedThe workflow starts when a new comment is added to a resource.Comment RemovedThe workflow starts when a comment is removed from a resource.Comment ChangedThe workflow starts when a comment is edited.Relation was added on an asset as headThe workflow starts when an asset becomes the head of a relation.Relation was removed from an asset as headThe workflow starts when an asset is no longer the head of a relation.Relation was added on an asset as tailThe workflow starts when an asset becomes the tail of a relation.Relation was removed from an asset as tailThe workflow starts when an asset is no longer the tail of a relation.Asset Tag EventThe workflow starts when a tag is either added to or removed from an asset.Data Classification AcceptedThe workflow starts when a result of the data classification process is accepted.Data Classification RejectedThe workflow starts when a result of the data classification process is rejected.Data Classification AddedThe workflow starts when a new data class is added to a column asset.Data Classification RemovedThe workflow starts when a data class is removed from a column asset, for example when the data class entry is deleted.Data Classification UpdatedThe workflow starts when a data classification changes, for example when the confidence of a suggested match changes value.Database Registration CompletedThe workflow starts when a database is successfully registered.Database Registration FailedThe workflow starts when the registration process of a database fails.If you select multiple start events, they use the logical OR function.RolesThe roles define the permissions to manage the workflow. For example, if a certain tasks must be urgently executed but the responsible person is on sick leave, a user with the defined role can reassign that task to somebody else. You can enter roles for starting and stopping workflows or reassigning workflow user tasks. The roles you can enter depend on the Applies To settings:If the scope is Global, you can only specify global roles in these fields.In all other cases, only resource roles are allowed. When specifying resource roles, only users that have the role for the specific resource can start and stop the workflow or reassign tasks.Click to edit the roles:Start Workflow: The button with the start label is available to users with these roles.Stop Workflow: The option to cancel the workflow is available to users with these roles.Reassign Tasks: The option to reassign the task is available to users with these roles.    The roles are removed when you are changing from or to the Global workflow scope.OtherThe section contains additional settings that determine who can start the workflow, how the workflow behaves in relation to the resource it applies to and if the workflow can be started from the global Create button.SettingDescriptionAny guest user can start the workflow.Indicates if guest users can start the workflow.If selected, users who are not signed in can start the workflow. When guest users start a workflow, some basic information, such as first name, last name and email address, is requested of them. That information can then be used to contact the user again, if needed.This check box overrides any roles that are specified in the Roles section.If you select this check box, you cannot select the Any signed in user can start the workflow check box. Any signed in user can start the workflow.Indicates that any user who is signed in can start the workflow.This check box overrides any roles that are specified in the Roles section.If you select this check box, you cannot select the Any guest user can start the workflow check box.Perform candidate user check on workflow start.Checks if all workflow user tasks have a candidate user expression that can be resolved to at least one Collibra Data Intelligence Cloud user. If the check fails, you see an error message when the workflow starts.This workflow can only run once at the same time on a specific resource.Determines if you can start a workflow multiple times, simultaneously for the same resource.If selected the workflow can only be started once for a given resource. If any user tries to start the same workflow for the same resource, an error message is displayed. However, users can still start the same workflow for a different resource or another workflow for the same resourceIf Lock resource is also selected, no other workflow can start on the same resource while this workflow is running neither can this workflow start if any other workflow is running on the same resource.Show in global create.Only valid for workflows where the scope is set to Global, allows users to start the workflow from the global Create button.Duration variablesBoth the escalationDuration and escalationType variables are only generated if there is no timer boundary event attached to the user task. In case there is one attached, it assumes that you will handle the escalation manually and no escalation variables are generated.For more information about specifying a duration for the variables, please read about the ISO 8601 standard. Also note that we support business day durations. You can denote a business day duration by using a B instead of a P. If you use a business day duration, weekends are not taken into account. If a business day duration ends at a weekend, the first weekday after the weekend is used. You can use the business day duration just like a normal duration.Other configuration settingsThe following table contains a description of the Other configuration settings in Collibra.SettingDescriptionAny guest user can start the workflow.Indicates if guest users can start the workflow.If selected, users who are not signed in can start the workflow. When guest users start a workflow, some basic information, such as first name, last name and email address, is requested of them. That information can then be used to contact the user again, if needed.This check box overrides any roles that are specified in the Roles section.If you select this check box, you cannot select the Any signed in user can start the workflow check box. Any signed in user can start the workflow.Indicates that any user who is signed in can start the workflow.This check box overrides any roles that are specified in the Roles section.If you select this check box, you cannot select the Any guest user can start the workflow check box.Perform candidate user check on workflow start.Checks if all workflow user tasks have a candidate user expression that can be resolved to at least one Collibra Data Intelligence Cloud user. If the check fails, you see an error message when the workflow starts.This workflow can only run once at the same time on a specific resource.Determines if you can start a workflow multiple times, simultaneously for the same resource.If selected the workflow can only be started once for a given resource. If any user tries to start the same workflow for the same resource, an error message is displayed. However, users can still start the same workflow for a different resource or another workflow for the same resourceIf Lock resource is also selected, no other workflow can start on the same resource while this workflow is running neither can this workflow start if any other workflow is running on the same resource.Show in global create.Only valid for workflows where the scope is set to Global, allows users to start the workflow from the global Create button.Out-of-the-box variables for workflowsBelow is a list of variables that you can use in workflows.Variable Descriptionaddress_commentsDueDateDue date as duration for the address_comments task.address_commentsTaskNotificationIndicates if a notification email for the address_comments task has to be sent.address_commentsEscalationDurationTime before the address_comments task is escalated.address_commentsEscalationTypeType of escalation for the address_comments task.comment_provideDueDateDue date as duration for the comment_provide task.comment_provideEscalationDurationTime before the comment_provide task is escalated.comment_provideEscalationTypeType of escalation for the comment_provide task.comment_provideTaskNotificationIndicates if a notification email for the comment_provide task has to be sent.commentTimeoutDurationTime before the comment_provide task times out.correct_definitionDueDateDue date as duration for the correct_definition task.correct_definitionEscalationDurationTime before the correct_definition task is escalated.correct_definitionEscalationTypeType of escalation for the correct_definition task.correct_definitionTaskNotificationIndicates if a notification email for the correct_definition task has to be sent.reviewCompletionPercentagePercentage of user candidates that is required to review the definition before the task is completed.reviewTimeoutDurationTime before the review process is forced to continue.reviewWarningTimeDurationTime before a reminder for the review definition task is sent.sendVotingActionEmailsIndicates if an action email has to be sent to candidate users, users that are required to vote.smeUserExpressionThe user expression for subject matter experts.stakeholderUserExpressionThe user expression for stakeholders.stewardUserExpressionThe user expression for stewards.voteCompletionPercentagePercentage of user candidates that is required to vote before the task is completed.voteTimeoutDurationTime before the voting process is forced to continue.voteWarningTimeDurationTime before a voting reminder is sent.Edit the workflow configuration optionsFor Collibra Data Privacy customers: Collibra Data Privacy comes with workflows for approving data privacy-specific assets. The Collibra packaged approval workflows (Approval Process, Asset Approval Process and Simple Approval Process) should not be used to approve data privacy-specific assets. As such, ensure that your Collibra approval workflows are not associated with data privacy-specific asset types, such as DPIA, PIA, Legitimate Interest Assessment and Compliance Self Assessment.    PrerequisitesYou have a global role with the Workflow Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Workflows.The Workflows settings page appears on the Definitions tab page.Click the workflow that you want to configure.Configure the available options:To add a restriction rule:The following example associates the asset type Business Rule with the workflow you selected in the previous step. For example, if you selected the Approval workflow, you will be able to use the Approval workflow to approve Business Rule assets.    When you change the scope of the workflow, the restriction rules are removed.  Click Add.A dialog box appears.  Provide one or more Types. In this example, you enter the Business Rule asset type. Select Asset to associate the workflow with all asset types.Click domain or community, and then provide the domains or communities to which the asset types belong.Select the status of the assets to which the workflow will apply.This setting is not applicable when you are applying the workflow to communities, domains or global.  Click Save.The asset type is added to the Applies To list. The workflow applies to any assets of this asset type, with the status you selected, in the domains or communities you selected.The restrictions use the logical OR function.In the example figure above, the workflow applies to Business Term assets that have the status New OR Data Asset assets that are in the Business Analysts Community and have the status Candidate.To modify the Variables, Start Label, Start Event and Roles:  Click .  Change the option. Click Save.To modify the Other options:Select or clear the check boxes.View the running instances of a workflowYou can view the currently running instances of your workflows.PrerequisitesYou have a global role with the Workflow Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Workflows.The Workflows settings page appears on the Definitions tab page.    In the tab pane, click   Workflows → Instances.The overview of workflow instances appears.For more information about the table, see View running workflow instances.You cannot view running workflows that contain only script tasks on the workflows instances page.View running workflow instancesThe workflows instances page displays details about running workflows that contain active user tasks. If the user task is part of a sub-process, you can see details about both the main process and the sub-process. You cannot see running workflows that contain only script tasks or that do not contain anymore user tasks.    You must have the Sysadmin global role or a global role that has at least the Workflow Administration global permission to   access this page:    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Workflows.The Workflows settings page appears on the Definitions tab page.    In the tab pane, click   Workflows → Instances.The overview of workflow instances appears.ColumnDescriptionWorkflowThe name of the running workflow.ResourceThe resource the workflow is associated with. Click the resource name to go to the resource page.TaskThe name of the active user task.UsersThe users the active task is assigned to. Click the user name to go to the user profile page.Starting DateThe start date of the process.ErrorPossible error message if the workflow instance encountered an error.Button to delete the workflow instance.Back up workflowsYou can create backups for individual workflows. This comes in handy if you have modified a packaged workflow definition and want to upgrade to a newer version of Collibra that contains newer workflow definitions.    You must have the Sysadmin global role or a global role that has at least the Workflow Administration global permission to   perform this action:Open a workflow. See View and edit workflows.Below the diagram of the flow, you can find the raw workflow definition (XML).Select all the raw workflow definition text and copy it.You don't have to go into the edit mode.Paste the text in a plain text file editor such as Notepad, Notepad++ or Vim and not an advanced text editor such as Word.Save the text file as a new file on your local file system.Delete workflowsYou can delete workflows from the workflow definitions table or from the individual workflow definition pages.    You must have the Sysadmin global role or a global role that has at least the Workflow Administration global permission to   perform this action.Delete a workflow from the workflow definitions table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Workflows → Definitions.At the end of the row, click to delete the workflow.Delete a workflow from the workflow definition page    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Workflows → Definitions.Click the workflow you want to delete. At the right of the title bar, click to delete the workflow.Currently running instances of a deleted workflow continue to run until their completion. Use the Collibra Command Line Interface to cancel workflow instances in bulk.Restore a workflowYou can restore a workflow.PrerequisitesYou have a global role with the Workflow Administration or the System Administration global permission, for example Sysadmin.StepsOn your computer, open a workflow that you have previously backed up. See Back up workflows.Copy the XML text from the file.If necessary, create a workflow in Eclipse - Flowable and then close all open windows.In the Flowable Explorer pane, right-click your workflow and click Open With → XML Editor.Click the Source tab.Paste the copied XML text in the blank pane.Click Save.Close the XML editor.In Collibra, deploy your workflow, see Deploy a workflow.Users and groups settings pageOn the Users and groups settings settings page of the Collibra settings, you can define users and what they are allowed to do in which part of Collibra Data Intelligence Cloud.Collibra Data Intelligence Cloud uses a standard user-group-role model. This means that you can create groups and add users to them. Subsequently, you can assign roles to individual users or groups.Assigning roles to users or groups is important:You provide or restrict permissions to do certain actions in Collibra, such as editing asset attributes or deleting domains.You define the responsibilities of the user. These responsibilities are mostly used in workflows to assign tasks to the correct users.You can manage users in the following ways:Manually: Create users and groups within Collibra.LDAP: Connect Collibra to your company's LDAP server to import users and groups.Tab pagesThe Users and groups settings page of the Collibra settings is split in several tab pages:Tab pageDescriptionUsersThis tab page allows you to view and edit user accounts.GroupsThis tab page allows you to view and edit groups.User and group management overviewFor handling user management, Collibra Data Intelligence Cloud uses a standard user-group-role model. This means that you can create user groups and add users to them. Subsequently, you can assign roles to individual users or user groups.Assigning roles to users or user groups is important:You provide or restrict permissions to do certain actions in Collibra, such as editing asset attributes or deleting domains.You define the responsibilities of the user. These responsibilities are mostly used in workflows to assign tasks to the correct users.You can manage users in the following ways:Manually: Create users and user groups within Collibra.LDAP: Connect Collibra to your company's LDAP server to import users and groups.UsersA user is an individual who has access to Collibra Data Intelligence Cloud through a user account.What the user can actually do in Collibra, depends on the license type, the global roles and the responsibilities assigned to the user.Users can be added to user groups to easily assign roles and responsibilities to multiple users at once.Username requirementsAll usernames within Collibra need to comply with our username requirements. Collibra username requirementsGeneral requirements:Uniqueness: Duplicate username are not allowed, regardless of caseusernamecase and UserNameCase are considered duplicateNo leading or trailing spacesNo empty usernamesMaximum of 255 charactersCharacter limitations: Usernames may only contain characters in the following Unicode categories:          LetterNumberSymbolPunctuationNon-spacing marksUser typesThe user type of a user depends on the license type they have.User typeDescriptionRead-only userA read-only user is a user with a read-only license.Standard userA standard user is a user with a standard license.User statusesThe user status of a user determines whether a user can log in or not.User statusDescriptionEnabledA user with the enabled status can log in to Collibra. The license of this user counts towards the maximum number of licenses, if the user has the active password status.DisabledA user with the disabled status cannot log in to Collibra.The license of this user does not count towards the maximum number of licenses.Password statusesPassword statusDescriptionActiveA user with the active password status is a user that has a password. InactiveA user with the inactive password status is a user that does not have a password. This is typically a temporary status that only occurs right after creating a user. When a password is created for the user, the password status becomes active. It cannot revert to inactive.Out-of-the-box usersCollibra contains a number of out-of-the-box users. They are used to manage various aspects of Collibra.Default nameUUIDPurposeSYSTEM_USER 00000000-0000-0000-0000-000000900001;The system user is used, amongst others, during the installation of Collibra. It is hidden in Collibra.ADMIN_USER 00000000-0000-0000-0000-000000900002;The admin user is the default administrator used to configure Collibra when it is installed.COLLIBRIAN_USER 00000000-0000-0000-0000-000000900000;The Collibrian user is a user that can be used by Collibra, for example to provide support. It is hidden in Collibra DGC and should not be used for anything else.WORKFLOW_USER 00000000-0000-0000-0000-000000900003;The workflow user is used when changes are made through a workflow. It is hidden in Collibra DGC and should not be used for anything else.Create a userYou can create one or more users in one go. At the same time, you can add the user(s) to user groups.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.Above the table, to the right, click Add.The Create Users dialog box appears.Enter the required information.FieldDescriptionUser detailsEnter the user details of the new users. Username*Type the username of the user to sign in to Collibra Data Intelligence Cloud. Collibra username requirementsGeneral requirements:Uniqueness: Duplicate username are not allowed, regardless of caseusernamecase and UserNameCase are considered duplicateNo leading or trailing spacesNo empty usernamesMaximum of 255 charactersCharacter limitations: Usernames may only contain characters in the following Unicode categories:          LetterNumberSymbolPunctuationNon-spacing marks Email*Type the email address to which Collibra sends emails, such as the registration email and notifications. First NameType the first name of the user. Last nameType the last name of the user. Click to remove a user. Add another userClick to add another user.Add to user groupsEnter user groups to add the new users to them. You can also add users to, or remove users from groups afterwards.A user needs access to at least one of the basic Collibra applications: Business Glossary, Reference Data, Data Stewardship or System administration. You can grant access by assigning one of the global roles that provide the required permissions to the users.Fields marked with * are mandatoryClick Create.The newly created users are enabled, but inactive.  The newly created users receive an email to set a password. As an administrator, you can also manually set or reset it. When the password is set, the user is active.Edit a userYou can edit a user.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.StepsOpen a user's profile page.Perform one of the following steps:Edit the account settings.Edit the contact information.Edit the email notifications.Edit the user details.Set or reset a user passwordYou can set or reset the password of a user:From the user table.From the user's profile page.Do this to reset your own password.You can only reset the password of users that were created manually.The default password requirements are outlined in the Password section of our Security configuration: options article. PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Set or reset a user password from the user table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.In the row of the user whose password you want to reset, click .The Password Reset dialog box appears.Choose how you want to reset the password.OptionDescriptionEmail a link to the user. Send an email to the user and let the user set a new password.The link to reset the password is by default valid for 60 minutes. You can edit the length of the validity in Collibra Console.Generate a new password automatically.Automatically generate a password.Specify a new password.Set a password yourself. Click Reset Password.Set or reset a user password from the user profile pageClick your avatar, then Profile.Your profile page appears.In the upper-right corner, click Reset Password.  An email is sent to the user to let the user set a new password.The link to reset the password is by default valid for 60 minutes. You can edit the length of the validity in Collibra Console.Enable a userYou can enable a user.     You can only enable users if they were created manually.Newly created users are enabled by default.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.In the row of the user that you want to enable, click .The user account is enabled.The icon changes into a green .Disable a userYou can disable a user.You can only disable users if they were created manually.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.In the row of the user that you want to enable, click .The user account is disabled.The icon changes into a green .Delete a userYou can delete one or more users in one go.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.Perform one of the following steps:If you want to...Follow these stepsDelete a single user                   In the row of the user that you want to delete, click . The Delete user dialog box appears.Click Delete user.Delete more than one userSelect the check boxes in front of the users that you want to delete.In the action toolbar, click Delete.The Delete <number> users dialog box appears.Click Delete <number> users.One or more users are deleted.If a deleted user posted any comments, those comments remain in the system but without an associated name. Export user table as a CSV fileYou can export the information in the user table as a CSV file.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    In the tab pane, click   Users.The user table appears.Above the table, to the right, click .The Export users activity starts.When the Export users activity is finished, you can download the CSV file:    On the main menu, click   , then Show more.Your profile page opens on the Activities tab page.In the Results column of the Export users activity, click Results.Depending on your browser and browser settings, the files are downloaded to a default location or a dialog box appears to specify the location for the downloads.ExampleThis is an example of the user information that is exported:User IDPassword status (activated column)User status (enabled column)UsernameEmail addressFirst nameLast nameGenderDefault languageLast login timeView users that are logged inAs an administrator, you can view which users are currently logged in.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.If required, add the column Online. On the content toolbar, click → Columns → Currently logged in.The Currently logged in column appears.GroupsA group is a logical collection of users.The main purpose of groups is to facilitate assigning roles and responsibilities. When a group is assigned a resource role, the users in the group receive the resource roles and their permissions.Managing groupsThere are several options for managing groups. However, you can only use one of the options below. It is not possible to combine them.Manage groups in LDAP, using Group field mapping.Prerequisite: You have configured the Group field setting in the user attributes to assign groups.If there are manually created groups in Collibra Data Intelligence Cloud, they are removed before the LDAP-managed groups are created.No synchronization is required for this option to work.Manage groups in Collibra.Prerequisite: You have not configured the Group field setting in Collibra Console in the user attribute settings.Groups are managed directly in Collibra. Creating groups and assigning users to the groups is done within Collibra. No synchronization is required for this option to work.Out-of-the-box groupsCollibra contains a number of out-of-the-box groups. They are used to manage various aspects of Collibra.Default nameUUIDPurposeEVERYONE_GROUP 00000000-0000-0000-0000-000001000001;The Everyone group contains all users and is mainly used to manage view permissions. It is hidden in Collibra and should not be used for anything else.USERS_GROUP 00000000-0000-0000-0000-000001000002;The Users group contains all users and can be used for actions that affect all users. It is hidden in Collibra.GROUP_DATA_CUSTODIANS 00000000-0000-0000-0000-000001000003;The Data Custodians group is meant for users with the Data Custodian resource role and can be used for actions that affect all such users.When users are assigned the Data Custodian resource role for a resource, they are not automatically added to the Data Custodians group; however, you can manually add them to the group.User group pageThe user group page contains relevant information about that user group.The view bar contains some basic information about the user group, such as the name and the number of members.The group page contains the following tab pages:Tab pageDescriptionOverviewThe overview page contains general information such as the name and the number of members.It also contains a table containing the members of the user group, and allows you to add users to or remove users from the groups.ResponsibilitiesThe responsibilities page contains the responsibilities that are assigned to the user group.Create a user groupYou can create a user group.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.    In the tab pane, click   Users → Groups.The user group table appears.Above the table, to the right, click Add.The Create groups dialog box appears.Enter the required information.FieldDescriptionNameThe names of the new user groups.You can simultaneously create multiple user groups. To do so, after typing the name, press Enter, and then type the next name. User group names must be globally unique. If you enter a name that already exists, it appears in the strike-through style.Click Save.Open user group pageYou can open the user group page of a user group:From the settings.From the profile page of a member.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Open a user group page from the settings    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.    In the tab pane, click   Users → Groups.The user group table appears.Click a group name.Open a user group page from the profile page of a memberClick your avatar, then Profile.Your profile page appears.    In the tab pane, click   Groups.  Click the name of a user group.Edit a user groupYou can edit a user group.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.    In the tab pane, click   Users → Groups.The user group table appears.The user group table appears.Double-click a cell.Make the necessary changes.Click .      Add a user to a user groupYou can add a user to a user group:While creating one or more users.From the user table.Do this if you want to add a user to one or more user groups.From the user group page.Do this if you want to add multiple users to a single user group.From the user's profile page.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Add a user to a user group from the user table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page. Perform one of the following steps:Double-click a cell in the Groups column.Hover your mouse over a cell in the Groups column and click .Click in the field and start typing the name of the group.Select the group from the suggestions.If required, select Apply to visible rows.This will add all visible users to the groups.You can filter the columns first to add a selection of users to the group.  Click .  Add a user to a user group from the user group pageOpen a user group page.Above the table, to the right, click Add.The Add to group dialog box appears.Enter the required information.FieldDescriptionUsersChoose one or more users.Click Add.The users are added to the user group and the users now appear in the table.Add a user to a user group from the profile pageClick your avatar, then Profile.Your profile page appears.    In the tab pane, click   Groups.  Above the table, to the right, click Add.The Add to groups dialog box appears.Enter the required information.FieldDescriptionGroupsChoose one or more user groups.Click Add.The user is added to the user groups and the groups now appears in the table.Remove a user from user groupYou can remove a user from a user group:By deleting a user.From the user table.Do this if you want to delete a user from one or more user groups.From the user group page.Do this if you want to delete multiple users from a single user group.        From the user's profile page.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Remove a user from a user group from the user table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page. Perform one of the following steps:Double-click a cell in the Groups column.Hover the mouse pointer over a cell in the Groups column and click .In the user group name, click .If required, select Apply to visible rows.This will add all visible users to the groups.You can filter the columns first to add a selection of users to the group.When you have added the groups, click .Remove a user from a user group from the user group pageOpen a user group page.Perform one of the following steps:If you want to...Follow these stepsRemove a single user from user group                   In the row of the user that you want to remove from the group, click . The Remove user from group dialog box appears.Remove more than one user from the user groupSelect the check boxes in front of the groups from which you want to remove the user.In the action toolbar, click Remove.The Remove users from group dialog box appears.Click Remove <number of selected users> users.Remove a user from a user group from the profile pageClick your avatar, then Profile.Your profile page appears.    In the tab pane, click   Groups.  Perform one of the following steps:If you want to...Follow these stepsRemove a user from a single user group                   In the row of the group from which you want to remove the user, click . The Remove from group dialog box appears.Remove a user from more than one user groupSelect the check boxes in front of the groups from which you want to remove the user.In the action toolbar, click Remove.The Remove from group dialog box appears.Click Remove.Delete a user groupYou can delete one or more user groups.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.    In the tab pane, click   Users → Groups.The user group table appears.Perform one of the following steps:If you want to...Follow these stepsDelete a single group                   In the row of the group that you want to delete, click . The Delete group dialog box appears.Click Delete group.Delete one or more groupsSelect the check boxes in front of the groups that you want to delete.In the action toolbar, click Delete.The Delete <number> groups dialog box appears.Click Delete <number> groups.LDAP user and group managementThe Collibra Console administrator can integrate Collibra Data Intelligence Cloud with your company's LDAP servers. This administrator can synchronize user data as well as group-related information. When LDAP is configured, authentication (credential checking) is done directly on the LDAP server(s).To synchronize with an LDAP server, the LDAP fields have to be mapped to the corresponding Collibra fields and the LDAP server has to be configured correctly.All the fields that are mapped to an LDAP user attribute are read only in Collibra. You cannot change them in the UI. You can recognize LDAP usersby the LDAP column in the user table.on the user's profile page.in the user table, by the absent (reset password) and / (enabled/disabled) user icons.In the next sections, you can find how to use LDAP in Collibra.LDAP synchronizationSynchronization is the process of importing all LDAP data in Collibra Data Intelligence Cloud.Users can be synchronized in the following ways:Automatically: You can configure a CRON job to synchronize the Collibra users with your LDAP.Manually: You can synchronize LDAP manually. Individual user data is synchronized every time a user signs in to Collibra. If the user is authenticated through LDAP, the user data is synchronized with Collibra. If the product identifies the user as deleted from the LDAP server, the user is disabled in Collibra and access is denied.To set up the LDAP connection correctly, ensure that you know how your LDAP servers work and how they are structured, or ask your LDAP IT team for helpSynchronize LDAP users manuallyYou can manually synchronize your LDAP users to Collibra Data Intelligence Cloud manually.PrerequisitesYou have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Synchronize LDAP users from the Settings page    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click General.The general settings appear on the Activities tab page.Click Synchronize with LDAP.The LDAP users are displayed in the table.Synchronize LDAP users from the Users or Groups page    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Do one of the following:    In the tab pane, click   Users.The user table appears.    In the tab pane, click   Users → Groups.The user group table appears.Above the table, click Synchronize LDAP.The LDAP users are displayed in the table.LDAP FAQWhat if the connection between Collibra DGC and the LDAP server is lost?LDAP users cannot sign in to Collibra anymore. LDAP users who were logged in before losing the LDAP connection can continue working until their HTTP session is closed. When the LDAP synchronization job is triggered manually or automatically through scheduling, a javax.naming.CommunicationException is thrown and displayed in the logs.What happens if a mapped field of an LDAP user cannot be found for a certain entry on the LDAP server during the synchronization?The field remains empty when the user is imported in the application. However, both the username and email address are mandatory in Collibra. If either field is not mapped in the configuration, LDAP cannot be enabled. Also, when searching for users on the LDAP server, a filter is used to make sure that only users with a username and email address are returned.Are there any mandatory fields to map?Yes. You have to specify at least a mapped field for the username and email fields. A user who does not have both mapped field attributes is ignored during the synchronization.I'm seeing a lot of connection problems during the synchronization of users and there are no users visible in Collibra DGC after synchronizing. What could be the problem?First check if the URL and credentials to connect to the LDAP servers are correct. If they are, but the problem persists, it could be related to the paging.Paging is only possible if your LDAP server supports it. It also requires the connection to remain open during the synchronization process, to keep track of which page is to be processed next.Paging is enabled by default and can be disabled by entering '0' in the User page size field.Is the synchronization job really necessary?No. If you disable the synchronization job, users can still be authenticated in the application. Each time the user logs in, personal information is updated and reflected in Collibra. However, a user's personal information is not visible until the first sign-in to the application. This way the user is not known yet to the application. You also need the synchronization job to enable Groups from LDAP. These are only synchronized in the job, unless you have mapped the groups as an attribute of the user. Then the groups will be taken in on the first encounter as the group of a user who is signing in.What if usernames from LDAP don't comply with Collibra's username requirements?If a username coming from LDAP does not meet the username requirements of Collibra then this user is skipped during synchronization.To avoid this problem, ensure that your usernames from LDAP meet the Collibra username requirements. Collibra username requirementsGeneral requirements:Uniqueness: Duplicate username are not allowed, regardless of caseusernamecase and UserNameCase are considered duplicateNo leading or trailing spacesNo empty usernamesMaximum of 255 charactersCharacter limitations: Usernames may only contain characters in the following Unicode categories:          LetterNumberSymbolPunctuationNon-spacing marks Profile pageThe profile page of a user contains information about that user.You can always see all information on your own profile page. On the profile pages of other users, you see basic information such as their name and contact information. If you have a global role with the User Administration or the System Administration global permission, for example Sysadmin, you can see all information for all users.Full profile pageThe view bar contains important information about the user, such as the name, license type, required license type and email address. It contains buttons to edit the user's name and reset the password.The profile page contains the following tab pages:Tab pageDescriptionOverviewThe overview page contains general information such as the user's account information, mail notification settings and contact information.GroupsThe groups page contains the groups of which the user is a member and, with the right permissions, allows you to add the user to or remove the user from groups.ResponsibilitiesThe responsibilities page contains the responsibilities that are assigned to the user.HistoryThe history page contains the history of the user's actions.ActivitiesThe activities pages contains the list of your activities.MentionsThe mentions page contains a list of all comments in which you are mentioned.Basic profile pageThe view bar contains some basic information about the user, such as their name and email address.The profile page contains the following tab pages:Tab pageDescriptionOverviewThe overview page contains the user's contact information.GroupsThe groups page contains the groups of which the user is a member.ResponsibilitiesThe responsibilities page contains the responsibilities that are assigned to the user.Open a profile pageAs a regular user, you can open your own profile page. Administrators can open everybody's profile page.PrerequisitesIf you want to open the profile page of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Open your own profile pageClick your avatar, then Profile.Your profile page appears. Open another user's profile page    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.Click the username of the user whose profile you want to open.Edit user detailsYou can edit your own profile such as the application language, email notifications and contact email address on your profile page. You can also reset your password, you receive instructions to do so by email.PrerequisitesIf you want to edit the user details of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.StepsClick your avatar, then Profile.Your profile page appears.In the upper-right corner, click Edit.  The Edit dialog box appears.Enter the required information.FieldDescriptionFirst nameEnter the first name of the user.Last nameEnter the last name of the user.EmailEnter the email address on which the user receives all communication from Collibra, such as the registration mail and notifications.Click Save.Edit the user account settingsAs a regular user, you can edit the settings of your own user account on your profile page. As an administrator, you can also edit other users' settings.PrerequisitesIf you want to edit the user account settings of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.StepsClick your avatar, then Profile.Your profile page appears. In the Account section, click .Enter the required information.FieldDescriptionUsernameEnter the username.Collibra username requirementsGeneral requirements:Uniqueness: Duplicate username are not allowed, regardless of caseusernamecase and UserNameCase are considered duplicateNo leading or trailing spacesNo empty usernamesMaximum of 255 charactersCharacter limitations: Usernames may only contain characters in the following Unicode categories:          LetterNumberSymbolPunctuationNon-spacing marksApplication LanguageChoose the interface language.As an administrator, you can add or edit interface languages.From version 2022.11 onwards, Collibra takes the default language of your browser into account to select the interface text language of some sections. Collibra now also has translations of some interface text available out of the box. Consequently, you can no longer edit that interface text, nor translate it into unsupported languages. This includes the interface text of Usage Analytics, Data Marketplace and the Homepage.Click Save.Edit the contact informationAs a regular user, you can edit contact information of your own user account on your profile page. As an administrator, you can also edit other users' contact information.You can also add new contact information.PrerequisitesIf you want to edit the contact information of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.Edit contact information from a profile pageClick your avatar, then Profile.Your profile page appears.Perform one of the following steps: In the Contact section, click .Do this to edit the existing fields.In the Contact section, click Add.Do this to add a new field, or edit the existing fields.If you edit the email address, a notification email is sent to the old email address.Edit the contact information.Click Save.Edit contact information from the user table    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page. Perform one of the following steps:Double-click a cell in the E-mail column.Hover your mouse over a cell in the E-mail column and click .If you edit the email address, a notification email is sent to the old email address.Click in the field and type the new email address.Click .Edit the email notification settingsYou can edit the email notification settings for your own user account. As an administrator, you can also edit other users' notification settings.If you enable notifications, you will be notified via email whenever changes are made to assets for which you have been assigned a responsibility.Only the 20 most recent changes for a given asset are shown in the notification email.PrerequisitesIf you want to edit the email notification settings of another user, you have a global role with the User Administration or the System Administration global permission, for example Sysadmin.StepsClick your avatar, then Profile.Your profile page appears.In the Notifications section, click .Select or clear the necessary check boxes.FieldExplanationNotify me of content updatesSpecify whether or not you want to receive email notifications. If you select this option, email notifications will be sent to the email address shown in the Contact section of your Profile page, at the specified frequency.Days of the weekReceive email notifications only on the days you specify.MonthlyReceive a summary email once a month.Click Save.Edit the maintenance announcement settingsYou can edit the maintenance announcement settings on your profile page.If you enable maintenance announcements, you receive notifications in Collibra about scheduled maintenance.PrerequisitesUsage statistics are enabled. Contact Collibra support if this is not the case.StepsClick your avatar, then Profile.Your profile page appears.In the Scheduled Maintenance Notifications section, click .Select or clear the check box.Click Save.User licensesA user license is the overall authorization for a user to perform certain actions in Collibra. What a user can actually do in Collibra depends on the global roles and the responsibilities of the user.License typesThe license type defines the actions a user is authorized to carry out. There are currently two license types: License typeDescriptionRead-onlyA Read-only license is the basic license type. It allows a user to:View resources. Collaborate using social features such as comments, tags and ratings. It does not allow users to create, edit or delete resources. You can view which global and resource permissions require a Read-only license, in Settings.StandardA Standard license is the enhanced license type. It allows a user to perform all actions that require Read-only permissions, and create, view, edit and delete resources, such as:Create, edit and delete assets.Create, edit and delete communities, domains and responsibilities.Create and share (anyone’s) application, community and domain views.Create and share (anyone’s) dashboards.Bulk import assets through Excel, CSV or API (Connect).Manage and participate in workflows.Edit the operating model, for example create, edit and delete asset types.Manage users, user groups, roles and permissions.You can see which global and resource permissions require a Standard license, in Collibra Settings.The maximum number of licenses is defined in the license file.If your organization occupies more licenses than the maximum (as stipulated in your contract and identified in the license file), your administrator will receive a warning, but all users will retain access to all Collibra functionality, as determined by their roles and responsibilities. Occupying more licenses than the maximum may have financial and legal implications.Access to Collibra Console does not require a license.License usageA User is a specific individual that you authorize to use the Collibra software, regardless of whether such individual is using the Collibra software at any given time. Each individual shall be assigned a unique User identification. Multiple individuals may not share the same User identification. In addition to all individual Users, all users of a non-human operated device shall be counted as User if such device has access to the Collibra software in accordance with User roles and responsibilities. Users are limited to the number set forth in the respective Order, and access to the Collibra software will be restricted to such number of Users through a license management key provided by Collibra. If a User no longer requires access to the Collibra software, you may deactivate that individual and you can designate a new individual as a User of the Collibra software without incurring additional fees.Required license typeFor each user, Collibra calculates the required license type.The required license type is:The license type that a user needs to carry out the actions available to the user via the roles and responsibilities that were assigned to the user.The maximum license type of any permission included in a global role or resource role of that user.If none of the permissions require a Standard license, the required license of the user is Read-only. You can see the required license type of all permissions in the Settings. You can also see the required license types of all permissions and the packaged global roles and resource roles in the administration guide:Permissions of the packaged global rolesPermissions of the packaged resource rolesEffective licensesIn the user table, the Effective licenses are the number of Standard licenses in use both by permission and by workflow participation. Workflow participation for licensing is logged for each user every time they participate in or start a workflow within a calendar month. This number is then reset at the start of the next month. You can see when a user last participated in a workflow by adding the Latest workflow participation column to the user table.Workflow participationWhen a user participates in a workflow they will retain a Read-only license but be counted as a Standard license. You can see when a user last took part in a workflow if you add the column, Latest workflow participation to the users table. ExamplesUsers with a Read-only license will only be counted for that specific calendar month’s effective licenses when they have participated in a workflow during that calendar month. For example, if a Read-only user has only participated in a workflow in September, then they will not be counted for October, or any other calendar months’ effective licenses, as long as there is no workflow participation.During the month, the Effective license count in the panel above the user table will continue to grow as workflow participation is carried out by users with a Read-only license by permission are counted as Standard users for that month (to enable them to participate in workflows). The number listed for effective license at the end of the month is then captured and reset at the start of the next month. For example, the effective number is 200 at the start of September, then there are 20 Read-only users with workflow participation by mid September, so that the number will show as 220. If there are another 30 new Read-only users (unique from the last 20 users) with workflow participation by the end of September, then the number will show as 250 at the end of the month. At the start of October (on the 1st of the month), it will be reset back to 200 and begin to increase again with the number of new Read-only users with workflow participation.ActionsAn administrator can view the available number of licenses per license type.View used licensesAs an administrator, you can view how many licenses of each type are currently in use.The information in this table is, by default, refreshed nightly.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Users and groups.The users and groups settings appear on the Users tab page.The number of Standard licenses by workflow participation & permissions (Effective) and the number of Standard licenses by permissions only (Required) are shown above the user table.If required, you can export these numbers by clicking .A CSV file will download.You can add the column, Latest workflow participation to see when a user last took part in a workflow, as this participation will require a Standard license. NumberDescriptionStandard License refers to the type of license. User with the Standard license can create, edit and delete resource as well as participate in workflows. See the User licenses page for details. The Effective licenses are the number of Standard licenses in use both by permission and by workflow participation. See the User licenses page for details. The number of licenses in use versus the number of available license. The Required licenses are the number of Standard licenses in use by permission only. See the User licenses page for details. The number of licenses in use versus the number of available license.Use this icon to export a CSV file with the monthly totals for Effective and Required licenses.View the permissions per license typeYou can see which global and resource permissions require which license type, in Settings. You can also see the permissions of the packaged global roles and resource roles in the admin guide:Permissions of the packaged global rolesPermissions of the packaged resource rolesSteps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.Click Roles and permissions.The roles and permissions settings appear on the Global roles tab page.Do one of the following:     In the tab pane, click   Global Permissions, to view the global permissions and their required license type.    In the tab pane, click   Resource Permissions, to view the resource permissions and their required license type.The required license type is shown in the column Required license.Standard license consumptionA Standard license in Collibra allows the holder to interact with the platform more, performing more tasks and activities than someone with a Read-only license can. Occupying a standard license seatEach individual permission in Collibra requires either a Standard or a Read-only license. This applies to both global and resource permissions. Which license a given permission requires is visible under Settings → Global Permissions or Settings → Resource Permissions. A role corresponds to a set of permissions, if the role contains at least one permission that requires a Standard license, then the role requires a Standard license.The aggregate license requirement for each role is visible under Settings → Global Roles or Settings → Resource Roles.Roles are assigned to users, either directly or through a group. If the user has at least one role that requires a Standard license, then the user is occupying a license seat. This is known as the user’s required license. Global roles are assigned in Settings → Global Roles and resource roles are assigned on community, domain or asset level (referred to as assigned responsibilities).With the 2021 license model, a user with a Read-only required license participating in a workflow during a given calendar month will also effectively occupy a Standard license until the end of that month. This is known as the user’s effective license.Verify why a specific user requires a Standard licenseIf you want to check why a certain user is being counted as occupying a Standard license you can follow these steps:Global roles Go to Settings → Users and Groups.Find the user that requires a Standard license and click on their name.On the user’s profile page click the Groups tab to see the list of groups the user belongs to.In a separate browser, go to Settings → Global roles.Each listed role indicates whether it requires a Standard or Read-only license.Now verify if the user or one of their groups is assigned to a global role that requires a Standard license1st browser show the user’s Groups tab.2nd browser shows the Global Roles page.Resource roles Go to Settings → Users and Groups.Find the user that requires a Standard license and click on their name.On the user’s profile page click the Responsibilities tab and verify if the user has a role that requires a Standard license.In a separate browser, go to Settings → Resource roles.Each listed role indicates whether it requires a Standard or Read-only license.Now verify if the user or one of their responsibilities is assigned to a resource role that requires a Standard license.1st browser show the user’s Responsibilities tab.2nd browser shows the Resource Roles page.Update a Standard license to a Read-only licenseIf you want to update a user from a Standard license to a Read-only license, you need to remove any roles and permissions that require a Standard license.You can do this using the steps indicated above for verifying why a specific user requires a Standard license. For customers that have SSO enabled, depending on the configuration of the system, removing a user from a group may require a change in the connected LDAP system. Services configurationOn the Services configuration settings page of the Collibra settings, you can edit settings that affect your entire platform. For example, you can edit the help menu and configure the search feature.The services configuration in the Collibra settings is the same as the DGC service settings that require the ADMIN role in Collibra Console. By default, you do not see this section. Contact Collibra support if you want to use this section.The Collibra configuration includes the following options:General settingsThe general settings of Collibra Data Intelligence Cloud.SettingDescriptionDefault locale (Requires restart)The default locale for new users. It has to contain a language code and may contain a country code. The language has to be an ISO language code. The country has to be an ISO country code. Examples: pl, en_US, nl_BE. Enable view rights True (default): The view permissions feature is enabled. False: The view permissions feature is disabled. Show target asset type above relation table True (default): Show the asset type of the target asset in the title of relation tables on an asset page. The target asset can be either the head or the tail of the relation, depending on which asset page you have open. False: Hide the asset type of the target asset.The default value is true.Help MenuThe configuration of the Help menu in Collibra Data Intelligence Cloud.SettingDescriptionLinksThe list of links in the help menu. Menu item nameThe name of the menu item as it will appear in Collibra Data Intelligence Cloud's help menu. Menu indexThe position of the menu item in the help menu. The top position starts with the value 1. Menu URLThe target URL of the menu item. Show admin only True: The menu item is only visible to users with the Sysadmin role. False: The menu item is visible to every user. Email configurationThe configuration of email notifications.In a Collibra Data Intelligence Cloud environment, you cannot update the email server settings, such as host and port. For more information, see Collibra Data Intelligence Cloud infrastructure.SettingDescriptionDefault schedule (Requires restart)The Cron schedule to send emails only at specific times. With this, you can send emails in batches and avoid an overload of mails. Keep in mind that these emails are only workflow emails and have nothing to do with the notification schedule.If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops responding.Template mapThe location of template emails.From address The email address used as the sender of all outgoing emails.Contact Collibra support to change the From address, see also Email configuration.Email address change notificationThis setting is only available for the ADMIN role.If you change the email address to which notifications are sent, notification of the change is sent to the old email address.NotificationsThe configuration of notification emails to users.These settings can be overridden for every user in the preferences.xml file.SettingDescriptionNotification daysThe days of the week on which Collibra sends notifications. The days are represented by numbers from 1 to 7, where 1 represents Sunday.Per row you can add one day.Daily rolesThe roles that receive notifications on the days defined in Notification days.Enable monthly notifications True: The users receive a monthly summary. False (default): The users do not receive a monthly summary.Roles for monthly notificationsThe roles that receive monthly notification emails. This is only relevant if Enable monthly notifications is True.Hyperlinking configurationThe configuration of automatic hyperlinks. When you change a setting, you have to rebuild the hyperlinks. SettingDescriptionEnable hyperlinking True: Hyperlinks are created automatically. False (default): Hyperlinks are not created automatically.For more information about automatic hyperlinks, see Hyperlinking.If you enable this setting, the performance of Collibra can decrease.Enable case sensitivity True: Hyperlinks are case-sensitive. False (default): Hyperlinks are not case-sensitive.If you edit this setting, you have to reindex Collibra.Excluded asset type IDsThe list of asset types that are ignored by automatic hyperlinking. You can enter multiple asset type IDs, separated by commas.Excluding assets reduces the amount of hyperlinks, which improves performance.We recommend that you exclude technical asset types such as Column, Field, Table, Code Value and Code Set.If you edit this setting, you have to reindex Collibra.Recommender configurationThe configuration of the recommender.SettingimpactsDescriptionCatalog recommender enabledAll recommendations True (default): The Data sets you might like section is included on the Data Catalog Home page. This section shows data sets you might be interested in, as determined by the recommender, which takes into account your data sets and the data sets of similar users. False: The Data sets you might like section is not included on the Data Catalog Home page.Data set recommender execution timeRecommendations of data sets to usersThe schedule (CRON job) by which the data set recommender looks for recommended data sets for a user.By default the data set recommender does this every night.Asset recommender execution timeRecommendations of business assets to data assets            The schedule (CRON job) by which the asset recommender looks for suggested relations between business assets and data sets. Data set matcher execution time Data set matcherThe schedule (CRON job) by which the data set matcher looks for similar data sets.Data set similarity thresholdData set matcherThe amount of business assets that have to be related to two data sets before the data sets are considered to be similar.This percentage is expressed by a decimal where 1,00 equals 100%.ExampleIf this value is 0.3 and at least 30% of the related business assets are related to both data sets, they are considered to be similar.Duplicate schema thresholdSchema matcherThe amount of assets that have to be related to both schemas before the schemas are considered to be similar.This percentage is expressed by a decimal where 1,00 equals 100%.Fuzzy vs exact matching strategy for business assetsRecommendations of business assets to data sets and of business assets to column assetsThe percentage that determines to what extent assets with a similar name become more important.The ranking in the search engine results always has an impact on the suggestion score. However, similarity between the asset names can also be taken into account. If you decrease this percentage, the ranking of the search results becomes more important for the suggestion score, while the similarity between the asset names becomes less important. If you increase the percentage, assets with similar names will receive a higher suggestion score.This percentage is expressed by a decimal where 1,00 equals 100%. You can enter a value greater than 1,00.Recommendation weights for data setsRecommendations of data sets to users            An ordered comma-separated list of values that define the importance of properties for recommendations. The order of the values reflects the importance of the value.This setting is only used for data set recommendations if your Collibra does not yet have enough data for relevant results from the active recommendations algorithms.Possible values:CERTIFIED: Data sets that are certified are considered more relevant.POPULARITY: The number of visits to the data set page.Active recommendation algorithmsRecommendations of data sets to users and of business assets to data setsA comma-separated list of algorithms that calculate recommendations. By default, all available algorithms are listed.Possible values:BASELINEUSER_MEANIICF (Item-Item Collaborative Filtering)SLOPE_ONEWEIGHTED_SLOPE_ONEData set elements thresholdRecommendations of data sets to users The maximum number of elements per data set that the recommender will use to train the model. The data set elements are taken randomly. Lowering this number can prevent out-of-memory issues but also impacts the accuracy of recommendations for large data sets.If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops responding.Search index configurationThe configuration of the search index.SettingDescriptionUI search appends wildcard True (default): A wildcard (asterisk) is automatically added to each search query. An asterisk is not added in the following exceptions:If the query contains a tilde (~).If the query ends with a quotation mark ().This applies only to queries via the user interface. A wildcard is not added automatically for REST API queries. False: No wildcard is added to the search query.Maximum batch sizeThe amount of resources scanned in one go for the search query.The default value is 5,000. The maximum value is 30,000.Maximum batch size for relationsMaximum batch size for relations reindex.Stop words(Requires restart)A list of stop words that are ignored as tokens for the index. The default list of English stop words includes:a, an, and, are, as, at, be, but, by, for, if, in, into, is, it, no, not, of, on, or, such, that, the, their, then, there, these, they, this, to, was, will, withIf you choose not to create your own list of stop words, the default list applies.If you create your own list of stop words, you have to:Reindex Collibra Data Intelligence Cloud.Restart the environment to apply your changes. For more information, go to Stop an environment and Start an environment.Relation-based search True (default): The Data Marketplace search considers certain assets and relation types between assets. As a result, your search results not only include assets that directly match the search criteria, but also assets that match the criteria through specific relation types.A column named Order is included in a data set named Customer. If the relation-based search is enabled and you search for Order in Data Marketplace, then the data set Customer appears in the search results because the data set contains this column.For more information about this feature and the default relation types, go to Filtering and searching based on relations in Data Marketplace. False: The Data Marketplace search results do not consider relations.After you enable this setting, you must reindex Data Marketplace relations or reindex Collibra completely.In new Collibra environments, this setting is enabled by default. In upgraded Collibra environments, the previous status of this setting is retained.TokenizerThe configuration of the tokenizer of the indexing mechanism. If you edit these settings, you need to restart and reindex your environment.SettingDescriptionType The tokenizer that is used. Currently two tokenizers are supported: Standard (default): This tokenizer uses the word break rules from the Unicode Text Segmentation algorithm, as specified in Unicode Standard Annex #29.Character: This tokenizer sees words as groups of all alphanumeric characters together with a configurable list of extra characters. This can be used if you know for sure which characters should keep certain words together. For example, if you want to keep words with a dash ( - ) together, you have to add the dash in the allowedCharacters parameter.Parameter mapThe allowed characters if the Type is Character.Field key: This field has to contain allowedCharacters.Field value: The concatenated list of characters that does not split strings into separate tokens. For example, the concatenated list -' allows dashes and apostrophes in tokens.BoostingThe configuration of the boosting function.SettingDescriptionAsset The boost factor of assets.Class MatchThe boost factor of data classes.Community The boost factor of communities.Domain The boost factor of domains.User The boost factor of users.User groupThe boost factor of user groups.Name The boost factor of names.Comment The boost factor of comments.Tag The boost factor of tags.Attribute boost mapThe boost factor of attribute types.Field key: The attribute type ID.Field value: The boost factor of the attribute type.Display exact match of name as first True (default): If the name of an asset is exactly the same as the search text, put it at the top of the search results regardless of boost factors. False: Use the regular search order, taking into account boost factors.Asset boost mapThe boost factor of asset types.Field key: The asset type ID.Field value: The boost factor of the asset type.Partial exact match enabledEnables partial exact matching while searching for multi word phrases. True (default): For multi-word search text, the search engine considers the exact match percentage with the resource name, when ordering the results.You enter search text scheduled maintenance. Two example assets are ordered as follows:An asset named daily scheduled maintenance, as two of the three words (66%) match exactly.An asset named daily scheduled maintenance revised, as two of the four words (50%) match exactly. False: The exact match percentage is not taken into account in the score calculation.Slow logs configurationThe configuration of the slow logs function.SettingDescriptionIndexing thresholdThe time limit, in milliseconds, after which an index query is logged in Elasticsearch. If the value is set to 0 (zero), all index queries are logged. Changes to this setting require a full reindex of your Collibra Data Intelligence Cloud environment.            Fetching threshold          The time limit, in milliseconds, after which a fetch query is logged in Elasticsearch. If the value is set to 0 (zero), all fetch queries are logged. Changes to this setting require a full reindex of your Collibra Data Intelligence Cloud environment.5.4 Search Event Log configurationThe configuration of indexing.SettingDescriptionAsynchronous indexing True (default): Enable asynchronous indexing. False: Disable asynchronous indexing.In new Collibra environments, this setting is enabled by default. In upgraded Collibra environments, the previous status of this setting is retained.Automatic relation indexingThis setting keeps Data Marketplace up to date if relations between assets are created, updated, or removed.If the relation between asset A and asset B changes and this relation is used in relation-based filters or relation-based search, then the Data Marketplace search considers this change. True: Automatically index certain relation type changes between assets so that the relation information remains consistent between Collibra and Data Marketplace. The relation types that are considered are the relation paths used by relation-based search and filters. If such a relation type between assets changes, the change is reflected in the search index after some time. Collibra does not automatically reindex relations between assets for relation paths that end with an attribute. You need to manually reindex the relations. If you select True, you must also enable the Asynchronous indexing setting because every relation change results in an event that is processed via asynchronous indexation.For more information about this feature and the default relation types, go to Filtering and searching based on relations in Data Marketplace. False (default): Changes to relations are not automatically indexed. This can cause inconsistencies between Collibra and Data Marketplace. You can, however, manually reindex Data Marketplace relations.Upload configurationThe configuration of the file upload service. The file upload restrictions apply to the following actions in Collibra:Importing and exporting assets and complex relations.Uploading attachments.Importing and exporting CMA files in the Migration feature.SettingDescriptionMax file sizeThe maximum file size in bytes for uploads. For cloud environments, the default value is 512 MB or 536,870,912 bytes. This value cannot be changed.For on-premises environments, the default is 10 MB or 10,485,760 bytes.Max per dayThe maximum number of uploads per user per day. For cloud environments, the default value is 1,235,465 uploads. This value cannot be changed.For on-premises environments, the default is 150 uploads.Accepted content typesThe MIME type names of the files you want to allow for uploads.For example, type application/pdf for PDF files.Statistics configurationThe configuration of statistics.SettingDescriptionBuffer sizeThe maximum amount of statistics entries that the buffer can contain before saving them in the database.The default value is 10.Buffer flush timeThe maximum amount of time in milliseconds to keep statistic entries in memory before saving them in the database.The default values is 10,000.Cron mapList of statistics, listed by their Cron name, and a Cron interval.These are the default values:Field keyField valueworkflow-task0 59 23 * * ?active-users0 0/15 * * * ?term-count0 59 23 * * ?vocabulary-count0 59 23 * * ?page-hit0 0 * * * ?task-count0 0 * * * ?If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops responding.Import configurationThe configuration for imports.SettingDescriptionRebuild hyperlinks after import True (default): Automatically rebuild the hyperlinks after an import. False: Do not rebuild the hyperlinks after an import.Asset responsibilities support True: Enable importing responsibilities at asset level. False (default): Disable importing responsibilities at asset level.Setting specific responsibilities on a large number of resources will affect the performance and stability of the system.Import UI v2 True: Use the original import interface for importing assets and complex relations. False (default): Use the new import interface for importing assets and complex relations, with improved usability and performance.Excel import configurationThe configuration of Excel import.SettingDescriptionThe default CSV separator characterThe default separator character of the CSV fields for complex relations. The default CSV quote characterThe default quote character of the CSV fields for complex relations. Number of rows per chunk of dataWhen importing views, the database is called repeatedly, each time importing a chunk of data from the import file. This option defines how many rows each chunk of data can contain. Lower values reduce the burden on memory. Higher values require more memory, but may slightly increase the speed of the export.The default value is 5,000.Excel export configurationThe configuration of Excel export.SettingDescriptionThe default CSV separator characterThe default separator character of the CSV fields for complex relations. The default CSV quote characterThe default quote character of the CSV fields for complex relations. Number of rows per chunk of dataWhen exporting views, the database is called repeatedly, each time fetching a chunk of data to build the export file. This option defines how many rows each chunk of data can contain. Lower values reduce the burden on memory. Higher values require more memory, but may slightly increase the speed of the export.The default value is 5,000.CSV export configurationThe configuration of CSV export.SettingDescriptionAlways use quotes True: Use quotes for every cell in the CSV. False (default): Only use quotes when necessary. Number of rows per chunk of dataWhen exporting views, the database is called repeatedly, each time fetching a chunk of data to build the export file. This option defines how many rows each chunk of data can contain. Lower values reduce the burden on memory. Higher values require more memory, but may slightly increase the speed of the export.The default value is 5,000.API call logging The configuration of the API call logging.SettingDescriptionEnabled True: API call logging is enabled. False (default): API call logging is disabled.Maximum number of log entries (Requires restart)The maximum number of API calls to store in the database. Once this number is reached, the oldest records are overwritten.The default value is 1,000,000.Pattern duration listThe list of methods and a corresponding minimum duration time. The minimum duration time is the minimum time before the method is stored in the database. Minimum durationThe time in milliseconds that an API call must last before it is logged. Method patternThe method that you want to log in the database. For each pattern that you want to log, you have to add a new pattern.System metricsThe configuration of metric collection.SettingDescriptionEnable (Requires restart) True (default): Metric collection is enabled. False: Metric collection is disabled.Enable JVM metrics (Requires restart) True (default): JVM metric collection is enabled. False: JVM metric collection is disabled.Enable advanced metrics (Requires restart) True: Advanced metrics collection is enabled. Enabling this option has a negative impact on the performance of your environment. False (default): Advanced metrics collection is disabled.Enable minimal monitoring (Requires restart) True: Monitoring of the metrics is enabled. False (default): Monitoring of the metrics is disabled.Security configurationThe configuration of security.SettingDescriptionX-Frame options (Requires restart)The content of the HTTP-header X-Frame-Options. This is set on all rendered pages and is used to avoid clickjacking attacks. By default, only pages with the same origin can use the rendered pages in a frame.Limit user sessions True: A user can only open one session. False (default): A user can open multiple sessions.Office research guest access True: The Office research integration is always allowed guest access via REST, regardless of the general Guest access setting. False (default): The general Guest access setting is kept.Currently, The Office research integration is only available when Collibra Data Intelligence Cloud is publicly available, which is why this override setting is necessary.Prevent advanced html features in text dashboardText widgets can contain full HTML. However, this means an attacker could potentially execute an XSS attack by injecting malicious HTML. For more information, see the Troubleshooting section. True: Potentially dangerous HTML elements are removed from text attributes when you save the text field. False (default): No HTML elements are removed from text attributes when you save the text field. If you enable this setting, the following HTML elements are deleted when you save:script (including JavaScript)svgframeframesetiframeany event handlersGuest accessThis setting requires the SUPER role. True: Anyone that can access the URL, has viewing rights to the system. False (default): The user is asked to sign in before having access to any data.Enable schema introspection True: Schema fields are shown during an introspection. False (default): Schema fields are hidden during an introspection.Enable customer validation functions True (default): Groovy scripts with custom validation functions can be loaded. False: Groovy scripts with custom validation functions cannot be loaded.LDAPThe configuration of an LDAP server to handle the authentication.SettingDescriptionEnable LDAP integration (Requires restart) True: The LDAP integration is enabled. False (default): The LDAP integration is disabled.Sync after restore True (default): LDAP data is synchronized with Collibra when an initial data set is bootstrapped. False: LDAP data is synchronized with Collibra only when the LDAP synchronization job is triggered.User page sizeThe page size that is used when retrieving users during synchronization.The default value is 500. You can set it to 0 to disable paging.This is a global setting. If you are working with multiple LDAP servers, only the value for the main server is taken into account.Group page sizeThe page size that is used when retrieving groups.You can set it to 0 to disable paging.This is a global setting. If you are working with multiple LDAP servers, only the value for the main server is taken into account.Time limitSpecifies the time limit in milliseconds for all LDAP searches.The default value is 120,000.You can set it to 0 to disable the time limit.If you get Time limit Exceeded error messages, increase the default value or check why the LDAP search takes too long.We recommend that you modify the User page size and Group page size settings before you modify this setting.Sync job enabled True (default): The synchronization job is enabled. False: The synchronization job is disabled.Sync job cron The schedule to perform an LDAP synchronization (CRON). The default value for this setting is daily at midnight. If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops responding. User field mappingThe configuration mapping of all the user fields. This determines which LDAP field ismapped to which user field. Empty fields are ignored during the synchronization. UsernameThe unique user ID in the LDAP, typically UID. This is a mandatory field. Email The corresponding email field in the LDAP directory. This is a mandatory field. First nameThe first name field in the LDAP directory. Last nameThe last name field in the LDAP directory. Middle nameThe middle name field of the LDAP directory, this is usually givenName. Enabled Indication whether a user is active or inactive in LDAP. Language The language and locale of the user. It has to contain a language code and may contain a country code. The language has to be an ISO language code. The country has to be an ISO country code. Examples: pl, en_US, nl_BE. Group The LDAP property that defines to which groups the user belongs. If there is a group entry in the LDAP directory, use the Group field mapping settings. Additional email listAn additional email list. Instant messaging fieldsThe mapping for the user's IM locations. AIM The mapping for the user's AOL IM account. Google Talk The mapping for the user's Google Talk IM account. Icq The mapping for the user's ICQ IM account. Jabber The mapping for the user's Jabber IM account. MessengerThe mapping for the user's Live Messenger IM account. Skype The mapping for the user's Skype IM account. Yahoo MessengerThe mapping for the user's Yahoo Messenger IM account. Website mapEnter the field value and field key to map a social media website. PhoneThe mapping for the user's phone. Fax The mapping for the user's fax number. Mobile The mapping for the user's mobile number. PagerThe mapping for the user's pager number. Private The mapping for the user's private number. Work The mapping for the user's work number. Other The mapping for any other phone number for this user. Home addressThe mapping for the user's home address. Street The mapping for the user's street. Number The mapping for the user's number. City The mapping for the user's city. Post code The mapping for the user's postal code. State The mapping for the user's state. Country The mapping for the user's country. Work addressThe mapping for the user's work address. Street The mapping for the user's street. Number The mapping for the user's number. City The mapping for the user's city. Post code The mapping for the user's postal code. State The mapping for the user's state. Country The mapping for the user's country. GenderThe mapping information for the user's gender. Mapping The attribute key for the gender value. If the content equals one of the male or female mappings, the user will be saved as male or female. Otherwise a default of UNKNOWN will be used. Male valueThe value for male users. Female value The value for female users.Group field mappingGroups can be defined as a separate structure or as a userField. The following section allows you to sync with a group structure that is unrelated to the user structure. Group name fieldThe name of the group to use in the application. Users fieldThe user DNs that are member of the group.Servers The Collibra parameters to map with your LDAP server parameters.The URL or IP address to the LDAP server, for example ldap://ldap.yourcompany.com:389 or ldaps://ldap.yourcompany.com:636.The DN of the administrator user that is used for authentication, for example admin.The password of the administrator user.The base DN for when you are working with relative DNs. This base DN is used for all LDAP look-ups.The base DN of where the LDAP users for Collibra are located. If a base has been specified, it is used as a prefix for this user base. Subtree search is used, so all DNs located below are searched for matching users. The filter that specifies which users can authenticate in the application. By default, all the objects found in the user base are selected, including the root.The filter that specifies which users are imported by the synchronization job. The users have to be the same as, or a subset of, the Authentication user LDAP filter. If you provide no value for this setting, the same filter as specified for the Authentication user LDAP filter setting is used. That allows you to synchronize only the users that have to have access to the application, even if they have not logged in yet. Users in the Authentication user LDAP filter are synchronized each time they authenticate and are only available after the first sign-in to the application. This is the default setting.The authentication mechanism for authenticating users on the LDAP servers. True: The LDAP context is destroyed immediately. When using TLS, some servers require the connection to be shut down by the client before the LDAP context is destroyed. False (default): The LDAP context is not destroyed immediately.Specifies what to do with referrals. Possible values:If you are experiencing slow searches on Microsoft Active Directory with the follow value for the Referral setting, try using the Global Catalog as Active Directory domain controller. The Global Catalog enables searching for Active Directory objects in any domain in the forest without the need for subordinate referrals. This can dramatically speed up searching. However, the Global Catalog only contains a subset of the attributes of an object. This solution is only viable if the attributes requested for the search results are stored in the global catalog. Note that the Global Catalog is accessible on port 3268/3269, not the standard 389/636 LDAP ports.The base DN of where all the groups are located. If a base has been specified, that base is used as the prefix for this group base.The LDAP filter to which each group has to comply to be synchronized.Batch synchronizationThe synchronization of the users with the LDAP server happens in batches. Batch sizeThe number of users in each batch. If a batch fails, none of the users in that batch is updated and the user names are listed in the DGC service log. Other batches are processed as normal. After processing all batches, Collibra disables users that are no longer in LDAP, unless one ore more batches failed. Set the value to 0 to disable batch processing.PasswordThe configuration of passwords.SettingDescription            Minimum length (Requires restart)The minimum length of passwords. The default minimum length is 12.            Maximum length (Requires restart)The maximum length of passwords. The default maximum length is 1,024.            Digits required (Requires restart) True (default): Passwords have to contain one or more digits. False: Passwords do not have to contain digits.            Non alphanumeric required (Requires restart) True (default): Passwords have to contain one or more non-alphanumeric (special) characters. False: Passwords do not have to contain non-alphanumeric characters.            Uppercase required (Requires restart) True (default): Passwords have to contain one or more upper-case characters. False: Passwords do not have to contain upper-case characters.             Lowercase required (Requires restart) True (default): Passwords have to contain one or more lower-case characters. False: Passwords do not have to contain lower-case characters.            Username disallowed (Requires restart) True (default): Passwords cannot be the username. False: Passwords can be the username.Expiration interval (months)The number of months before users have to change their passwords. Set it to 0 if users never have to change their passwords.The default interval is 6 months.Allowed login failuresThe number of consecutive failed login attempts that are allowed before the user account is disabled. Set it to 0 for unlimited attempts. The default is 3 login failures.No reuse countThe number of previous passwords users cannot reuse. The default is 1: the user cannot change his password to what it currently is. Set this to 0 to allow using the same password.Password reset link validity periodThe number of minutes that a link to reset a password remains valid. Beyond this time, the user has to request a new password reset link.The default value is 60 minutes.The minimum value is 15 minutes, the maximum value is 1,440 minutes (24 hours).Account lock-out durationThe number of minutes that a user cannot sign in after too many failed sign-in attempts. If the number of minutes is set to 0, a Collibra administrator must reset the password to unlock the account. This setting is only applicable if the Allowed sign-in failures setting is defined.A locked-out account does not mean that your account is disabled.RESTThe security configuration of the REST interface.SettingDescriptionCSRF token enabled True: The validity of a request is checked with a CSRF token. False (default): The validity of a request is not checked with a CSRF token.Referrer enabled True: The HTTP referrer header is used to identify the origin of the request. False (default): The HTTP referrer header is not used to identify the origin of the request. It is recommended to leave this option disabled.Referrer checking allow empty True (default): The HTTP referrer header can be empty. False: The HTTP referrer header cannot be empty.SSLThe configuration of SSL.SettingDescriptionKey store nameThe name of the keystore file. The file is expected to be in the <collibra_data>/dgc/security folder. Key store passwordThe password of the keystore. Key store typeThe type of the keystore file. For example, JKS or PKCS12.Trust store nameThe name of the truststore file. The file is expected to be in the <collibra_data>/dgc/security folder. Trust store passwordThe password of the truststore. Trust store typeThe type of the truststore file. For example, JKS or PKCS12.SSOThe configuration of Single Sign-On (SSO) authentication.SettingDescriptionMode The SSO mode of Collibra.The possible values are: SAML_ATTRIBUTES              SAML_LDAP              SSO_HEADERSSO_HEADER_LDAPDISABLEDHeader The name of the header to be checked. The contents of this header is used for the search query, which is SSO_HEADER = username.The value of the actual query depends on DN and possibly Attribute.DN If the SSO mode is SSO_HEADER_LDAP or SAML_LDAP, this field determines whether the distinguished name (DN) or attribute is used: True: The header has to contain the distinguished name (DN) of the user in the LDAP. False (default): The header has to contain the value of Attribute.If the SSO mode is DISABLED, SSO_HEADER or SAML_ATTRIBUTES, this field is ignored.Attribute This field is only used if the SSO mode is SSO_HEADER_LDAP or SAML_LDAP, and if DN is False.If the above criteria are met, the LDAP has to contain this value.Example If Attribute is FirstName, then the header should contain the FirstName of the user that was signed in.Disable automatic user creation when signing in via SSOIf users try to sign in via SSO, they still need a user account in Collibra. You can either create the user accounts automatically when they sign in, or create the user accounts manually or via LDAP synchronization True: User accounts are not created automatically. False (default): User accounts are created automatically.Disable the Collibra signin pageWhen SSO is enabled, a user can still navigate to the /signin page and try to log in via that page. However, you can disable that page. True: Users cannot access the Collibra signin page. False (default): Users can access the Collibra signin pageSAMLThe configuration of SAML. Metadata HTTPThe URL of the SAML metadata file to be used. The URL always has to be reachable by the Collibra environment. Entity Provider Entity IDThe entity ID inside the metadata to be referenced.A metadata file can describe multiple entity IDs, make sure to use in the entity ID from the correct metadata file. Attribute fieldsThe mappings of attributes in the SAML response. The values are used as keys to look for in the SAML response. Examples of attribute fields are first name, last name, address information, phone numbers and so on. First nameThe mapping for the user's first name.This attribute is optional. The value can be empty. Last nameThe mapping for the user's last name.This attribute is optional. The value can be empty. Email The mapping for the user's email address.This attribute is optional for existing users, but mandatory for new users.If the email address is invalid when you synchronize, the user is deactivated and the user information is not updated. Enabled The mapping that indicates whether the account of the incoming user is enabled. Group The mapping (attribute) which indicates to which Collibra groups the user should be added. If the groups don't exist yet, they will be created. This attribute can have multiple values (groups) or the groups can be sent as a comma-separated list of groups. If passing groups in this attribute, you must set Groups DGC Managed to False. PhoneThe mapping for the user's phone. Fax The mapping for the user's fax number. Mobile The mapping for the user's mobile number. PagerThe mapping for the user's pager number. Private The mapping for the user's private number. Work The mapping for the user's work number. Other The mapping for any other phone number for this user. Home addressThe mapping for the user's home address. Street The mapping for the user's street. Number The mapping for the user's number. City The mapping for the user's city. Post code The mapping for the user's postal code. State The mapping for the user's state. Country The mapping for the user's country. Work addressThe mapping for the user's work address. Street The mapping for the user's street. Number The mapping for the user's number. City The mapping for the user's city. Post code The mapping for the user's postal code. State The mapping for the user's state. Country The mapping for the user's country. Instant messagingThe mapping for the user's IM locations. AIM The mapping for the user's AOL IM account. Google Talk The mapping for the user's Google Talk IM account. Icq The mapping for the user's ICQ IM account. Jabber The mapping for the user's Jabber IM account. MessengerThe mapping for the user's Live Messenger IM account. Skype The mapping for the user's Skype IM account. Yahoo MessengerThe mapping for the user's Yahoo Messenger IM account. GenderThe mapping information for the user's gender. Mapping The attribute key for the gender value. If the content equals one of the male or female mappings, the user will be saved as male or female. Otherwise a default of UNKNOWN will be used. Male valueThe value for male users. Female value The value for female users. Groups DGC managedOption to configure that groups should be managed by Collibra, or that groups should be set by the SAML assertion (SAML+Attributes mode).This option is only relevant if Mode is SAML_ATTRIBUTES. True: The groups are fully managed by Collibra. In the UI the admin has the option to assign groups to users, without it being overwritten by SAML. False (default): The groups are managed by the SAML assertions. In this case the groups are managed by the SAML IDP. Be sure to configure the Group attribute in the Attribute Fields section. Service Provider Entity IDField that determines the value of the Entity ID parameter in the service provider metadata returned by Collibra. The default value is empty, in which case Collibra uses the value of the Base URL field.Enter a custom value if the base URL does not match the audience configured in your SAML identity provider. The value of the audience restriction in the SAML response has to be exactly the same as the value of this field.SSO does not work if the Service Provider Entity ID field contains the base URL with trailing forward slash (for example www.collibra.com/), and the audience of your IDP contains the base URL without a trailing forward slash (for example www.collibra.com). Both values need to be exactly the same. In this case, you can resolve the issue by changing the value in the configuration of your IDP, or the value of this field. It does not matter whether both have a trailing forward slash or not, as long as they contain the same value. Sign authentication requests (Requires restart) True: Authentication requests have to be signed. False (default): Authentication request don't have to be signed. Force authn True (default): The SP authentication request forces re-authentication. False: The SP authentication request does not force re-authentication. Force passive True: The reauthentication has to happen in the background. False (default): The reauthentication does not have to happen in the background.This is only relevant if Force authn is True. Name ID Name ID that is used in the SP authentication. The default value is urn:oasis:names:tc:SAML:2.0:nameid-format:persistent.The Name ID value is mandatory. Name ID allow create True (default): The IDP can create a name ID to fulfill the SP authentication request. False: The IDP cannot create a name ID to fulfill the SP authentication request. Disable client address True: The validation of the client IP address in the assertion message is disabled. False (default): The validation of the client IP address in the assertion message is enabled. SAML Requested authentication contextSettings for the SAML requested authentication context. The IDP uses the authentication context to authenticate the user. By default, the authentication context mandates user/password authentication over HTTPS. Disable True: The requested authentication context section is not sent in the SAML request. False (default): The requested authentication context section is sent in the SAML request. Comparison typeThe comparison type that is transmitted in the requested authentication context.Possible values:minimummaximumbetterexact (default value)For more information about the comparison type values, refer to the SAML specifications. Reference listThe list of class references in the requested authentication context. You can separate list items with the pipe character (|).For more information about this list, refer to the SAML specifications. Declaration list The list of class declarations in the requested authentication context. You can separate list items with the pipe character (|).For more information about this list, refer to the SAML specifications. Response decryption modeEnable the support for encrypted SAML responses.DISABLED: Collibra only accepts plain-text SAML responses.OPTIONAL: Collibra can handle both encrypted and plain-text SAML responses.FORCED: Collibra only accepts encrypted SAML responses.Once OPTIONAL or FORCED is selected, the encryption key pair is generated and added to the Collibra SAML keystore. A self-signed certificate is generated and works in most situations. If your IdP rejects self-signed certificates, you will have to add a certificate that is signed by a trusted 3rd party. Validity period of the SAML certificate The SAML certificate expiry date in years.By default, the SAML certificate expires after 20 years.SignoutThe configuration of redirecting after signing out of Collibra.SettingDescriptionOverride signout URL (Requires restart) True: Redirect the user to a specific website after signing out. False (default): Redirect the user to the sign-in page after signing out.Signout redirect URL (Requires restart)The URL to be redirected to when signing out. Import/ExportThe configuration to avoid the Formula Injection vulnerability in Excel.SettingDescriptionEscape Excel formulasThe option to disable Formula Injection into Excel. When enabling this option, an escape character is added at the beginning of Excel formulas during the export and is removed when importing formulas. The escape character will be added to fields that start with one of the following characters:equation: =plus: +minus: -at-sign: @This option is enabled by default.Excel formulas escape characterThe escape character for Excel formulas when exporting or importing data.JWTThe JSON Web Token configuration.SettingDescriptionJSON Web Key Set URLThe URL to retrieve public key information needed to verify the authenticity of JSON Web Tokens (JWTs), issued by an authorization server.This setting is required to enable JWT authentication.JWT Token TypesA case-insensitive comma-separated list of accepted JWT media types coming in the typ header parameter.Leave blank if the authorization server does not provide a media type parameter.The default values is at+jwt,jwt.JWT AlgorithmsA comma-separated list of accepted JWT algorithms coming in the alg header parameter. See https://tools.ietf.org/html/rfc7518#section-3.1 for details.Leave blank to accept all digital signature algorithms.JWT IssuerThe accepted issuer coming in the iss JWT claim.Leave blank if the authorization server does not provide an issuer claim.JWT AudienceA comma-separated list of accepted audience values for the aud claim.The value for this field is a configuration setting in your authorization server, which identifies your Collibra environment as the intended recipient of the JWT.Leave blank if the authorization server does not provide an audience claim. JWT Principal ID Claim Name.The name of the JWT claim containing the principal's identity. See https://tools.ietf.org/html/rfc7519#section-4.1.2 for details.Defaults to the standard subject claim, sub.Change this setting only if your authorization server has other means of identifying the principal, for example, a client_id claim.This setting is required if JWT authentication is enabled.JWT Maximum Clock SkewThe maximum acceptable difference in seconds between the clocks of the machines running the authorization server and Collibra.Differences smaller than the given amount are ignored when performing time comparisons for token validation.The default value is 60 seconds if left blank.HTTP headersThe configuration of the HTTP headersFieldDescriptionURL patternThe pattern of the URLs to which the HTTP response header is applied. This field supports wildcards such as **, * and ?. This pattern matches all URLs: /**.HTTP headersThe HTTP response headers in a key-value format.You can add new HTTP response headers by clicking Add at the bottom of the section, and entering the HTTP response header name as the field key and the HTTP response header value as the field value.WhitelistsThe configuration for whitelist placeholders that can be used in security headers.OptionDescriptionconnect-src whitelistThe 'connect-src' whitelist. To use this whitelist in a security header, use the '{connectSrcWl}' placeholder.font-src whitelistThe 'font-src' whitelist. To use this whitelist in a security header, use the '{fontSrcWl}' placeholder.frame-src whitelistThe 'frame-src' whitelist. To use this whitelist in a security header, use the '{frameSrcWl}' placeholder.img-src whitelistThe 'img-src' whitelist. To use this whitelist in a security header, use the '{imgSrcWl}' placeholder.script-src whitelistThe 'script-src' whitelist. To use this whitelist in a security header, use the '{scriptSrcWl}' placeholder.style-src whitelistThe 'style-src' whitelist. To use this whitelist in a security header, use the '{styleSrcWl}' placeholder.frame-ancestors whitelistThe 'frame-ancestors' whitelist. To use this whitelist in a security header, use the '{frameAncestorsWl}' placeholder.Tableau frame-ancestors whitelistThe tableau 'frame-ancestors' whitelist. To use this whitelist in a security header, use the '{tableauFrameAncestorsWl}' placeholder.DisclaimerThe configuration of a disclaimer upon signing in to Collibra.SettingDescriptionDisclaimer True: Upon signing in, show a disclaimer that you have to agree with before you can continue. False (default): Don't show a disclaimer. Disclaimer messageThe disclaimer message that is shown after signing in. If you leave this field empty, there is a default message. You can use basic html tags, such as headers, paragraphs, images and hyperlinks.Collibra ConnectThe configuration to communicate with Collibra Connect.SettingDescriptionBase URLThe URL to Collibra Connect. Username The username to connect to Collibra Connect. Password The password to connect to Collibra Connect. Register data sourceGlobal parameters that apply to Data Source Registration.SettingDescriptionTable types to ignoreA comma separated list of table types that are not ingested. For example, INDEX and SEQUENCE. AWS regions restrictionA list of AWS regions Data Catalog is allowed to connect to. For example, eu-west-3 and us-east-2. For a list of all AWS locations, see the AWS documentation.If you want to allow Collibra to make a connection to any AWS region, leave the field empty.If you remove a region from this list and the region was previously used for an S3 integration, you may want to delete the Glue database from the previously used region manually. By default, Collibra does not remove it. The Glue database has the following naming convention: collibra_catalog_<Asset Id>_<Domain Id>For example: collibra_catalog_d3174a88-5ffe-4d50-8fbe-7bf0832ec3af_5d198ce9-4e56-4d0e-a885-58204da50741When using Edge, a warning is added to the logs if an invalid region is detected in the restricted regions list.AWS API call rateAllowed number of AWS API calls per second.Use this option to limit the number of API calls per second to prevent throttling errors from the AWS API.Database registration via EdgeAn option to enable database registration via Edge. True: Register a data source via Edge. False: Register a data source via Jobserver only.Enabling data source registration via Edge does not prevent you from registering a data source via Jobserver as well.Collibra Data Quality & Observability Synchronization UI via DQ Connector on EdgeAn option to enable the Data Quality extraction interface in Collibra True: The Quality extraction tab is available on the configuration page of a database asset False (default): The Quality extraction tab is not available and as such, it is not possible to extract and synchronize data quality information.You can only enable Collibra Data Quality & Observability synchronization if you also enabled Database registration via Edge.Amazon S3 synchronization via EdgeAn option to enable Amazon S3 file system registration and synchronization via Edge. True: You can register and synchronize an Amazon S3 file system via Edge. False: You can only register an Amazon S3 file system via Jobserver.Enabling the registration of an Amazon S3 file system via Edge does not prevent you from registering an Amazon S3 file system via Jobserver.For more information, see Working with Amazon S3.Source Tags Synchronization via Edge (Beta)An option to register and synchronize the tags on individual columns and tables in the data source during the data source registration via Edge. This means the tags become available and searchable in Data Catalog and can be used in business or policy processes and in workflows.Currently, you can only synchronize source tags from Snowflake. True: The Include Source Tags option becomes available when you define the rules for the synchronization of a data source via Edge. If you include the source tags, the tags defined on the assets in the data source are registered and available from the Schema, Table, Database View, and Column assets in the Source Tags attribute. False: Source tags are not registered in Data Catalog.Jobserver The configuration of the Jobserver service.SettingDescriptionJobserver listThe list of registered Jobserver instances.NameThe name of the Jobserver as it will appear when you register a data source in Data Catalog.The name is a freely chosen name but it is recommended to only use alphanumerical characters and dashes, for example Jobserver-1.You will have to use this name as the ID of the gateway and in the address of this configuration.ProtocolThe protocol that is used for the communication between the Data Governance Center service and the Jobserver service.It is recommended to use HTTPS, especially if the services are hosted in different network segments.AddressThe address (IP address, URL, hostname) of the Jobserver.Trusted server CA certificateThe certificate of the trusted CA needed to validate the server certificate. If blank, the default truststore will be used. The default truststore is defined in the SSL configuration section of the DGC service.The CA certificate of the server party (Jobserver).Client certificateThe client certificate offered by the DGC service to the server. If blank, you cannot select mutual authentication as the Jobserver service authentication level.Client private keyThe private key of the DGC service's certificate.Table profiling data sizeThe approximate maximum disk size of the data in MB that will be used to profile a table. The value cannot exceed 10,000.Test connection timeoutThis timeout is a time limit (in seconds) after which the connection test is stopped and a timeout error is shown. The default value is 60 seconds.Data profilingProfiling must be executed again after a change in this section.SettingDescriptionMaximum number of samplesThe maximum number of samples you want to collect for a data source. The default value is 100. The maximum value is 1,000.This setting is specific to sample data.Maximum value lengthThe maximum length of a value extracted during profiling or sampling. Additional characters are trimmed. Default date patternThe default format used to decode dates. It is the default pattern used for detecting dates when the Date Pattern and/or Time Pattern attribute is not specified in Column assets. Default time patternThe default format used to decode times. It is the default pattern used for detecting times when the Date Pattern and/or Time Pattern attribute is not specified in Column assets. Default combined date and time patternThe default format used to decode combined dates and times. It is the default pattern used for detecting combined dates and times when the Date Pattern and/or Time Pattern attribute is not specified in Column assets. Empty valuesA comma separated list of strings enclosed in double quotes. A value that matches one of those expressions is considered an empty value. Please note that a database null value is always considered an empty value, for example , na and none.Data type detection thresholdThe percentage of matching Column values to reach for an Advanced Data Type to be considered a possible Data Type for that Column. This is expressed as a value between 0.0 and 1.0). Anonymize dataAn option to anonymize sensitive data. True: Content in columns with data type Text or Geo is removed or replaced by a random hash value before the profiling results are sent to the cloud. False (default): No content is removed or replaced by a random hash value.If you profile and classify via Edge, the data in columns with data type Text or Geo is automatically anonymized before it is sent to Collibra Data Intelligence Cloud.Database profiling via EdgeAn option to enable profiling and classifying synchronized metadata via Edge instead of Jobserver. True: Profiling and classification via Edge. False: Profile via Jobserver and classify via the Data Classification Platform.You can only enable Database profiling via Edge if you also enabled Database registration via Edge.Parallel database profiling via EdgeThe maximum number of databases that Edge can profile and classify at the same time.Schemas in a database are always processed sequentially.By default, the value of the setting is one. This means Edge processes one profiling job at a time. The maximum value is four.If you change this setting, you must restart Collibra.Beta featuresThe configuration of features in beta state. SettingDescriptionTableau provisioning enabled True: Provisioning to Tableau is enabled. False (default): Provisioning to Tableau is disabled.Max number of concurrent import jobsThe maximum number of import jobs that can be executed at the same time via the API. This is to avoid memory issues. Default value is 4, set to 0 if there is no limit.Task sidebar True (default): Workflow tasks appear in the sidebar on both resource pages an the task management page. Task forms appear in the sidebar instead of dialog boxes. Users can seamlessly complete their tasks from the task management page and have a side-by-side view of the tasks and resource details on resource pages. False : Workflow tasks appear in the task bar on resource pages and in a sidebar on the task management page. Task forms appear in dialog boxes. The behavior is the same as with older versions of Collibra.Settings landing enabled True (default): Show the new Settings landing page in your Collibra environment. False : Use the classic Settings page in your Collibra environment.New Scope page enabledThis setting requires the SUPER role. True (default): Enable the use of the enhanced Scope page. False: Disable the use of the enhanced Scope page and use the basic Scope page instead.Allow access to the Workflow DesignerEnables the Workflow Designer access global permission which allows access to the Workflow Designer, a visual tool for creating process definitions.Frontend enabledThis setting requires the SUPER role.Enable the frontend (shell) in the application. This will be served under the /apps/ and select other endpoints if enabled.Data Marketplace Advanced Filter SettingsEnable this setting to try out personal saved filters and recommended filters for user groups in Data Marketplace. True: The advanced filters can be used in Data Marketplace.Data consumers can save a set of filters that they use frequently as a personal saved filter.Data Marketplace administrators can save a set of filters and make it available only to a specific user group (recommended filters) or to all user groups (filter tabs). False: (default): The beta feature is not enabled.SettingDescriptionThrottling enabledThis setting requires the SUPER role. True: REST API v1 throttling is enabled. False (default): REST API v1 throttling is disabled.Number of requestsThis setting requires the SUPER role.The number of allowed request for the configured number of seconds.Number of secondsThis setting requires the SUPER role.The number of seconds during which the configured number of requests can be performed.SettingDescriptionThrottling enabledThis setting requires the SUPER role. True: REST API v2 throttling is enabled. False (default): REST API v2 throttling is disabled.Number of requestsThis setting requires the SUPER role.The number of allowed request for the configured number of seconds.Number of secondsThis setting requires the SUPER role.The number of seconds during which the configured number of requests can be performed.SettingDescriptionThrottling enabledThis setting requires the SUPER role. True: GraphQL throttling is enabled. False (default): GraphQL throttling is disabled.Number of requestsThis setting requires the SUPER role.The number of allowed request for the configured number of seconds.Number of secondsThis setting requires the SUPER role.The number of seconds during which the configured number of requests can be performed.Graph query The configuration of the Graph query engine which is used to retrieve data from the repository. For the general Graph query settings in a cloud environment, you need the SUPER role. Contact Collibra support if you want to edit these settings.. For on-premises environments, you can edit the settings yourself.The Graph query settings are not available in on-premises environments.Graph query limitsSettingDescriptionEnables limiting of the number of root nodes in result True: Enable limiting the number of root elements as result of a Graph query. False (default): Disable limiting the number of root elements as result of a Graph query.Maximum number of root nodes that can be requested with graph query APIThe maximum number of root nodes that you can request in the view configuration of an API call (REST or workflow). If you exceed this value in the view configuration, an exception is shown. If no value is defined in the view configuration, then the default value is taken. The default value is 100,000.If the number of asset types or domain types exceeds the set number, the hierarchy will be incomplete. Make sure that the limit is always higher than the actual number of asset and domain types.Maximum number of nodes that can be requested with the graph query API in a single pageThe maximum number of both root and children nodes that can be requested through Output API in a single data page. If the value is outside of the allowed range an exception is thrown. The default value is 1 million.Graph query timeoutsSettingDescriptionMaximum number of minutes a graph query can runThe maximum number of minutes that the graph query runs before it will time out. The maximum is 1,440 minutes (1 day). The default value is 480.TableThe configuration of tables.SettingDescriptionTime limit for loading data in tables in secondsThe time limit after which a table stops loading on a page. A value of 600 means that if a table hasn’t loaded within 600 seconds, the task is canceled and a timeout error is shown. The default value is 60, the maximum value is 720 seconds.Multi-column sortThe configuration of multi-column sorting.SettingDescriptionMulti-column sorting on tables True: Tables can be sorted on multiple columns. False (default): Tables can be sorted on one column.Number of columns available for multi-sortType the maximum number of columns that can be used to simultaneously sort tables.The default value is 3, the minimum is 1, the maximum is 9.This setting is only relevant is Multi-column sorting on tables is True.Inherited responsibilitiesSettingDescriptionEnable Inherited Responsibilities True: Show inherited responsibilities on asset views. False (default): Do not show inherited responsibilities on asset views.This setting only affects asset views and tile sets. It does not affect the Responsibilities tab page of asset pages.Purge configurationThe configuration of the automatic purging of data from the repository database. Purging means to delete data of a specified age. This helps to keep your data relevant and keep the database from growing infinitely.SettingDescriptionPurge schedule (Requires restart) A Cron expression specifying the timing and frequency of purge cycles. The default scheduled time is 002 * *, which equates to 02:00 every day.If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops responding.Maximum time for each purge cycle (Requires restart)Maximum amount of time (in seconds) allowed for each purge cycle. The default value is 7,200, which is two hours. Any qualifying data that is not purged in the allowed time will be addressed in a subsequent purge cycle, which picks up where the previous cycle left off.List of data elements and age at which each will be purged (Requires restart)The data elements that will be purged at the specified age, in a key-value format:The data elements to be purged (Field key). Possible data elements:Statistics: Data that has been used to calculate data quality.Authentication events: Data about authentication in your environment.Validation results: Information about data validation.Jobs: Data about all jobs that are created in your environment.Workflows: Data about completed workflow instances and tasks.License usage: Data about how licenses are used in your environment.The age (in months) at which each individual data element will be purged (Field value).Enable removal of orphaned tags(Requires restart)Option to enable the automatic deletion of tags that are not assigned to any assets. True (default): Orphan tags are deleted according to the timing and frequency that you specify. False: Orphan tags are not deleted.Orphaned tags removal schedule (Requires restart)A Cron expression specifying the timing and frequency of the deletion of orphan tags. The default scheduled time is 001* *, which equates to 01:00 every day.If you create an invalid Cron pattern, Collibra Data Intelligence Cloud stops responding.Cloud Data Classification configurationWith data classification you can automatically assign data classes to ingested data. In a Collibra Data Intelligence Cloud environment, you have to create a support ticket to configure this feature.SettingDescriptionEnable Data Classification True: Enable Collibra's data classification technology. False (default): Do not use Collibra's data classification technology are not accepted.Classification thresholdsSettingDescriptionEnable automatic classification acceptance and rejection True: The automatic acceptance and rejection of data classification suggestions is active. False (default): Data classification suggestions are not automatically accepted or rejected.Start using the Automatic Data Classification tool by manually accepting and rejecting the data classification suggestions. Only activate the automatic acceptance and rejection feature if you are comfortable with the results the tool provides.Automatic acceptance thresholdThe percentage from which data classification suggestions must be accepted automatically. If you set this value to 75, then the classification suggestions with a confidence level of 75% or higher are automatically accepted.If multiple classification suggestions meet the threshold condition for a column, the classification suggestion with the highest confidence level percentage is accepted automatically if this classification suggestion is the only one to have that confidence level percentage.You set the automatic acceptance threshold to 85%. You classify a table with 2 columns.For column A, three classification suggestions are possible, one with confidence level 93%, one with 92%, and one with 90%. For column B, two classification suggestions are possible. Their confidence level is the same, 86%.The results of the automatic acceptance will be:For column A, the classification suggestion with 93% will be accepted automatically. For column B, nothing is done, both suggestions will be visible.The default acceptance threshold is 90.Automatic rejection thresholdThe percentage from which data classification suggestions must be rejected automatically. If you set this value to 49, then all data classification suggestions with a confidence level of 49% or lower are automatically rejected.The default rejection threshold is 10. If the acceptance threshold and rejection threshold are set to the same value, and a data classification suggestion has this confidence level percentage, the classification suggestion will be rejected.ReportingFor more information about these settings, see Introduction to the Reporting Data Layer.SettingDescriptionCloud ProviderCloud provider - AWS or GCP Customer GUIDThe GUID of your Collibra environment.This field is configured by Collibra Cloud Ops.Insights download bucket nameThe name of the AWS S3 bucket in which your reporting data is stored.This field is configured by Collibra Cloud Ops.Insights AWS S3 RegionThe AWS S3 region in which your data is processed.This field is configured by Collibra Cloud Ops. Insights zip location patternA pattern with the format /zip/insights_%s.zip, where %s is replaced by the Collibra Insights snapshot date.This field is configured by Collibra Cloud Ops.Tableau report URL patternThe Tableau URL pattern, which should contain {reportName}.You can paste the URL from the Link field in Tableau, as described in Generate the dashboard reports you configured in Collibra Data Intelligence Cloud Settings.Reports definitions Report view nameThe report name, as you want it to appear on the report button in the Usage Analytics widget, for example Data Maturity Dashboard. Report nameThe report name, as it appears in the URL of the Tableau report, for example DataMaturityDashboard.Catalog ExperienceData Catalog Experience improves the layout of Data Catalog's asset pages.SettingDescriptionEnable Catalog experience True: Catalog experience is enabled. This will improve the layout of Data Catalog's asset pages, such as those of Data Set, Schema, Table and Column assets. False: Catalog experience is disabled.Catalog Experience Titlebar themeThe theme for the Catalog experience. You can choose between the LIGHT and DARK.This option is only applicable if the Enable Catalog experience option is enabled.DiagramsThese settings determine dialog loading time and size limits.SettingDescriptionMaximum loading time for the back endThe time limit, in seconds, after which a diagram stops fetching data.The value must be a positive integer and cannot be greater than 3,600 (one hour).The default value is 300.A value of 300 means that if a diagram hasn’t fetched all data within 300 seconds, the diagram stops fetching data and an empty diagram with a notification is shown.Size limit for the backendThe maximum number of nodes plus edges that will be fetched by the backend, to build a diagram.The value must be a positive integer and cannot be greater than 100,000.The default value is 10,000.A value of 10,000 means that if the total number of nodes plus edges is greater than 10,000, the diagram does not load and a notification is shown.Size limit for the frontendThe maximum number of visible nodes plus edges that can be shown on the page.The value must be a positive integer and cannot be greater than 10,000.The default value is 2,000.A value of 2,000 means that if the total number of visible nodes and edges is greater than 2,000, the diagram does not load and a notification is shown.Maximum flow depthThe system-wide maximum number of flow relations between the start node and any other diagram node.The value must be an integer between 1 and 100.The default value is 50.If the maximum flow depth is specified in the selected diagram view, that value supersedes the maximum you specify here.You can also manually adjust the flow depth in the diagram.Diagrams Business Qualifier Filter (*) True: Users can filter diagrams by a specified Business Qualifier asset. False (default): Users are unable to filter diagrams by Business Qualifier.Everywhere Desktop configurationThese settings determine some of the ways in which Collibra for Desktopinteracts with Collibra Data Intelligence Cloud.These settings are only applied in Collibra for Desktop if you have Collibra 2021.01 or newer in combination with Collibra for Desktop 1.2.1 and newer.SettingDescriptionDefault search filterThe filter that is applied, by default, to search results. The value must be the UUID of the filter.To find the UUID, open the Collibra environment and click in the Search box. Click the name of a search filter. In the address bar you will see the UUID of the filter.Specifying a default search filter in the application will override the default filter that you specify here.            Custom Search box placeholderPlaceholder text that appears in the Search field before a user enters search text.The default text is Search in Collibra.Shortcut SearchEnable or disable the use of a keyboard shortcut to search for selected text in Collibra Data Intelligence Cloud from within your browser or another application. True (default): Users can use the keyboard shortcut you specify in the following setting to search in Collibra Everywhere. False: Keyboard shortcut is disabled.Custom Shortcut SearchThe keyboard shortcut to search for selected text in Collibra Data Intelligence Cloud from within your browser or another application.The keyboard shortcut has to be a combination of Control, Alt or Shift with one letter or number. On macOS you can also use the Command key.To make available the keyboard shortcut, you have to enable the feature in the previous setting.Specifying a keyboard shortcut in the application will override the shortcut that you specify here.Enable Auto HyperlinkingOption to enable automatic hyperlinking within Collibra for Desktop. With this option enabled, the name of an asset automatically becomes a hyperlink when you fill out a text attribute.This option only works if the Enable hyperlinking option in Collibra Console is also enabled.Enable WorkflowsOption to enable workflows in Collibra Everywhere.This allows you to complete tasks or start a workflow in the app. The available workflows depend on the ones that you add to the Global workflows and Asset workflow configuration.RecommenderThe Recommender helps users by suggesting relevant business assets and data sets, based on certain relation types and the past actions of similar users. True: Recommender is enabled. False (default): Recommender is disabled.This feature only works if Analytics is enabled. You can enable Analytics in section 1 General of the DGC service configuration.Auto-updaterOption to automatically upgrade Collibra Everywhere when a new version is available. True (default): Collibra Everywhere is automatically upgraded when a new version is available. False: You need to manually upgrade Collibra Everywhere when a new version is available.If you enable automatic updates, you have to whitelist the S3 bucket collibra-otg-desktop-installers in the region eu-west-1.Allow User ConfigurationOption to allow users to edit personal settings in Collibra Everywhere. True (default): Users can edit personal settings. False: Users cannot edit personal settings.Global workflowsThe list of workflows that is available in the app's main menu.Enter the UUIDs of the workflows. An example workflow could be Create issue.Asset workflowThe list of workflows that is available on an asset page in the app.Enter the UUIDs of the workflows. An example workflow could be Ask the expert.No search result workflowsThe workflows that are available if there are no search results found. Enter the UUIDs of the workflows. An example workflow could be Propose new business term.Enable autostartOption to automatically start Collibra for Desktop when signing in to your operating system. True: The app starts automatically when signing in to your operating system. False (default): The app does not start automatically.If you have set this option in the Collibra for Desktop settings, this option is neglected.Everywhere Mobile configurationThese settings determine some of the ways in which Collibra for Mobileinteracts with Collibra Data Intelligence Cloud.SettingDescriptionDefault search filterThe filter that is applied, by default, to your search results. The value must be the UUID of the filter.This filter overrules any search filter that is set in the app.To find the UUID, open the Collibra environment and click in the Search box. Click the name of a search filter. In the address bar you will see the UUID of the filter.Custom Search box placeholderThe text that is shown in the search box of Collibra for Mobile before a user enters search text.Enable WorkflowsOption to enable workflows in Collibra for Mobile.This allows you to complete tasks or start a workflow in the app. The available workflows depend on the ones that you add to the Global workflows and Asset workflow configuration.Global workflowsThe list of workflows that is available in the app's main menu.Enter the UUIDs of the workflows. An example workflow could be Create issue.Asset workflowThe list of workflows that is available on an asset page in the app.Enter the UUIDs of the workflows. An example workflow could be Ask the expert.No search result workflowsThe workflows that are available if there are no search results found. Enter the UUIDs of the workflows. An example workflow could be Propose new business term.Collibra Browser ExtensionThe settings determine how and where you can use the Everywhere Chrome Extension.SettingDescriptionDomainsAdd a web domain, for example of a web application such as Power BI or Tableau, on which the Browser Extension automatically appears as overlay.EdgeEdge configuration options, when changing an option, you only have to refresh the page that runs your Collibra environment.SettingDescriptionEnable Edge jobs feature (beta) True: Enable the Edge jobs page, this page gives you a overview of all jobs and their status. False (default): Disable the Edge jobs page.Tableau Metadata APIYou need the Tableau metadata API to ingest Tableau 2020.2 and newer.If you upgrade to Tableau version 2020.2 or newer, but previously synchronized an older Tableau version via the REST API and XML mapping, you have to prepare the migration procedure to prevent losing manually added relations, attributes, tags, comments and stitching results.SettingDescriptionEnable Tableau metadata API True: Tableau metadata API is enabled. This enables you to ingest Tableau 2020.2 or newer into Data Catalog. False: Tableau metadata API is disabled. If you ingest Tableau 2020.2 or newer, the ingestion will fail. This prevents data loss of manually added relations and attributes.Job Service (Activities)SettingDescriptionNumber of executor threads for the Job ServiceThe maximum number of threads, or jobs, that the Job Service can run in parallel. Generally speaking, increasingly the number of jobs running in parallel reduces overall processing time. Conversely, it requires more system resources, which can negatively impact performance. It also increases the risk of job conflicts.Lineage on EdgeSettingDescriptionDGC user nameThe DGC user that is used to ingest technical lineage data into the environment via the technical lineage servers.DGC user passwordPassword of the DGC user that is used to ingest technical lineage data into the environment via the technical lineage servers.Collibra system name flagEnable this option if Lineage uses a Collibra system name.Collibra ProtectSettingDescriptionProtect scheduler fixed delayThe number of minutes in between synchronizations.The default value is 60 minutes.License configurationSettingDescriptionLicense usage snapshot cron job scheduleThis sets how often the license usage snapshot is refreshed. This cannot run at an interval smaller than 60 minutes. Data Marketplace configurationThe configuration of the Data Marketplace.SettingDescriptionData Marketplace True (default): Data Marketplace is enabled. Anyone with the required permissions can use or configure the Data Marketplace application from the Applications icon .When Data Marketplace is enabled and you reindex Collibra completely, the relations are also reindexed automatically. You don't need to start it manually. However, reindexing the relations will not reindex Collibra completely. False: Data Marketplace is not enabled.After you enable this setting, reindex Data Marketplace relations or reindex Collibra completely.In new Collibra environments, this setting is enabled by default. In upgraded Collibra environments, the previous status of this setting is retained.Data PrivacyThe configuration of the Data Privacy landing page.SettingDescriptionPrivacy landing page True: Enables the Privacy landing page. False: Disables the Privacy landing page.MigrationThe Migration feature allows you to migrate the operating model and views from one Collibra Data Intelligence Cloud environment to another environment. This makes it easier to migrate changes between development environments, testing environments and the actual production environment.Migration is not meant to be used for backups, or to migrate instance data, such as assets and domains. You can use the import and export features to move assets to another environment. You can use backups for disaster recovery.Exporting and importing CMA files is restricted by the file upload settings, which determine the maximum file size, allowed file extensions and maximum amount of uploads and downloads per day. Contact Collibra support if you want to change the file upload settings.The versions of the source and target environment have to be the same. Migrating between different versions may lead to unexpected behavior.For example, migrating does not work correctly if you import a CMA file in an environment of version 2021.07 or older if the CMA file includes assignments of any of the following asset types:BI Report AttributeBusiness QualifierColumnFieldLooker Report AttributeReport AttributeTableTableau Report AttributeOverview of the migration procedureExport objects from a source environment.Choose the objects that you want to migrate.Download the summary and the archive file.Review the summary.Create a backup of your target environment.This is technically not mandatory, but highly recommended.Import the archive file.You are guided through the import process. This process consists of the following main steps: upload the archive file, review the changes via a simulation, and start the import.Once the import is completed, the model objects are created, edited, or removed as necessary. You can also download an import report.Best practiceIt is highly recommended not to make risky changes to the metamodel of your Production environment. Instead, we recommend you use a separate Development environment and Testing environment:Create a backup of your production environment.Restore the backup in your Development and Testing environments.Make the necessary changes in the Development environment.Use the migration feature to re-apply the changes from the Development environment to the Testing environment.Thoroughly test the changes in the Testing environment.If required, repeat steps 3 to 5.If you are satisfied with the changes, use the migration feature to re-apply the changes from the Testing environment to the Production environment.Since migration moves the operating model, the existing instance data in the Production environment is not changed.Export model objectsUsing the Migration feature, you can export the model objects of a Collibra environment, for example if you want to import them later in another environment.Exporting and importing CMA files is restricted by the file upload settings, which determine the maximum file size, allowed file extensions and maximum amount of uploads and downloads per day. Contact Collibra support if you want to change the file upload settings.PrerequisitesYou have a global role that has the System administration global permission.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    Click Migration.The migration page appears on the Export tab page.Select the model objects that you want to export.If you want to export...Do the following:AssignmentsAt the top of the page, click Asset type assignments.Select one or more assignments.Click Select all to export all assignments, or click the name of a scope to export all assignments in that scope.Global rolesAt the top of the page, click Global roles.Select one or more roles.Click Select all to export all roles.Resource rolesAt the top of the page, click Resource roles.Select one or more roles.Click Select all to export all roles.WorkflowsAt the top of the page, click Workflows.Select one or more workflows.Click Select all to export all workflows.ViewsYou can export different types of views, including asset views, dashboards, diagram views and search filters.You can only export views that are public or shared with a global role.Dashboard viewsAt the top of the page, click Views.In the filter pane to the left, click the type of view that you want to export.The views that are public or shared with a global role appear in the table.Select one or more views.To export all available views of a certain type, you can select the checkbox in front of the view type in the filter pane.Diagram viewsSearch filtersGlobal asset viewsAsset views in application pages At the top of the page, click Views.In the filter pane to the left, click Asset views - in Applications.The applications pages appear in the table.Perform one of the following steps:If you want to export all available views in all application pages, select the checkbox in front of Asset views - in Applications in the filter pane.If you want to export all views of a specific application page, select the checkbox in front of the name of the application page.If you want to export specific views, do the following:Click the name of an application page.The available views appear in the right column.Select one or more views.Asset views in communities and domains pages Click Views.In the filter pane to the left, click Asset views - in Communities and Domains.The organization browser appears in the table.Perform one of the following steps:If you want to export all available views in all community and domain pages, select the checkbox in front of Asset views - in Communities and Domains in the filter pane.If you want to export all views of an community or domain, select the checkbox in front of the name of the community or domain.If you want to export specific views, do the following:Click the name of an community or domain.The available views appear in the right column.Select one or more views.Referenced model objects are also exported based on the export logic. For example, if you export a workflow, all roles to which the workflow refers are also exported.In the upper-right corner, click Export.The Provide file name and description dialog box appears.Enter the required information.FieldDescriptionArchive file nameThe name of the exported archive file. The extension is always CMA, which is short for Collibra Migration Archive.Report file nameThe name of the report file, which contains a summary of the exported model objects.You cannot edit the name of the report file.DescriptionThe description of the archive.Click Export.The report and the archive are downloaded.Click Close.Migration export logicThe export logic of the migration feature determines how an object is exported: which fields it needs and which other objects it requires.If you export an object, Collibra Data Intelligence Cloud automatically exports all referenced objects. For example, if you export a workflow, Collibra will also all export roles, asset types and status to which the workflow refers. For that reason, the migration feature differentiates between primary objects and secondary objects:Primary objects are objects that you choose to migrate.Secondary objects are objects that are needed for the correct behavior of a primary object or another secondary object.Primary objectsYou can migrate most of the model objects and navigation artifacts:Model objects:AssignmentsGlobal rolesResource rolesWorkflowsNavigation artifacts that are public or shared with a role:Table viewsDashboardsDiagram viewsSearch filtersFor navigation artifacts, you cannot choose specific artifacts to migrate. All navigation artifacts that are public or shared with a role are migrated. Navigation artifacts that are private or only shared with specific users are not migrated.For model objects, you can choose specific objects to migrate. For example, you can migrate one specific workflow.You cannot choose to migrate anything else. Keep in mind that other objects might be migrated as secondary objects.Secondary objectsSecondary objects are objects that are referenced by a primary object or by another secondary object. These could also be instance data.These include the following objects:AssetsAsset typesAssets referenced by a filter clause on a relation type filterCharacteristic typesAttribute typesComplex relation typesRelation typesCommunitiesData quality rulesDomain typesDomainsRolesStatusValidation rulesObjects that cannot be migratedSome objects will never be migrated. This is a non-exhaustive list: AttachmentsCommentsData quality scoresRatingsTagsTasksUser groupsUsersExport logic by objectThe following table shows an overview of all objects, their exported fields and the secondary objects to which they can refer.ObjectMigrated fields and secondary objectsAsset NameIDStatusIDNameDescriptionParent domainID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionAsset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledAsset type IDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledAssignmentIDAsset types referenced in the assignmentIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledArticulation rulesFields referenced in the assignmentAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricRelation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledComplex relation typesIDNameDescriptionDisplay optionsColorSymbol (none, Icon or Code)CodeIcon referenceAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricMinimum cardinalityMaximum cardinalityLeg types (relation types)RoleCo-roleAsset types that are head or tail of the relation typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledMinimum cardinalityMaximum cardinalityData quality rules referenced in the assignmentsIDNameDescriptionAggregation pathRelation trace entries (path): The sequence of relation types and their directionIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledCategorization relation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledData Quality Metrics: attribute types of the Metric attribute type kindIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricDomain types referenced in the assignmentParent domain types up to rootIDNameDescriptionIf it is a scoped assignment: the scope of the assignmentIDNameDescriptionCommunitiesIDNameDescriptionParent communities, up to the root levelIDNameDescriptionIf the scope contains an entire community that contains subcommunities and domains, the subcommunities and domains are not included.If domains or communities are included in the scope, their parent communities will be included too. Other children of its parent community will not be included, unless they are also in the scope.The domain type of the included domains are also included.DomainsID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionIf it is a scoped assignment: the global assignment.Statuses referenced in the assignmentIDNameDescriptionValidation rules referenced in the assignmentCharacteristic types that are referenced in the validation scriptAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricRelation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledComplex relation typesIDNameDescriptionDisplay optionsColorSymbol (none, Icon or Code)CodeIcon referenceAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricMinimum cardinalityMaximum cardinalityLeg types (relation types)RoleCo-roleAsset types that are head or tail of the relation typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledMinimum cardinalityMaximum cardinalityThe domain of the validation rule assetIDNameDescriptionThe Validation Rule Domain typeParent domain types up to rootIDNameDescriptionThe Validation Rule asset typeParent asset types, up to the root asset type (for example Business asset)The status of the validation ruleIDNameDescriptionAttribute IDParent assetNameIDStatusIDNameDescriptionParent domainID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionAsset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledAttribute typeIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricValue(s) Attribute type IDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricCommunity IDNameDescriptionParent communities, up to the root levelIDNameDescriptionComplex relation type IDNameDescriptionDisplay optionsColorSymbol (none, Icon or Code)CodeIcon referenceAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricMinimum cardinalityMaximum cardinalityLeg types (relation types)RoleCo-roleAsset types that are head or tail of the relation typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledMinimum cardinalityMaximum cardinalityData quality ruleIDNameDescriptionAggregation pathRelation trace entries (path): The sequence of relation types and their directionIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledCategorization relation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledData Quality Metrics: attribute types of the Metric attribute type kindIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricDomainID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionRelation typeIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledRolesNo secondary objectsIDNameDescriptionGlobalPermissionsScopeIDNameDescriptionCommunitiesIDNameDescriptionParent communities, up to the root levelIDNameDescriptionIf the scope contains an entire community that contains subcommunities and domains, the subcommunities and domains are not included.If domains or communities are included in the scope, their parent communities will be included too. Other children of its parent community will not be included, unless they are also in the scope.The domain type of the included domains are also included.DomainsID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionStatusIDNameDescriptionValidation ruleNameIDCharacteristic types that are referenced in the validation scriptAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricRelation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledComplex relation typesIDNameDescriptionDisplay optionsColorSymbol (none, Icon or Code)CodeIcon referenceAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricMinimum cardinalityMaximum cardinalityLeg types (relation types)RoleCo-roleAsset types that are head or tail of the relation typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledMinimum cardinalityMaximum cardinalityThe parent domain of the validation rule assetIDNameDescriptionThe Validation Rule Domain typeParent domain types up to rootIDNameDescriptionThe Validation Rule asset typeParent asset types, up to the root asset type (for example Business asset)The status of the validation ruleIDNameDescriptionWorkflowNameDescriptionStatusAssignment rules (Applies To section)Asset typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledCommunitiesIDNameDescriptionParent communities, up to the root levelIDNameDescriptionDomainsID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionIs Global Create Start label Configuration variablesAsset typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledCharacteristic typesAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricRelation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledComplex relation typesIDNameDescriptionDisplay optionsColorSymbol (none, Icon or Code)CodeIcon referenceAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricMinimum cardinalityMaximum cardinalityLeg types (relation types)RoleCo-roleAsset types that are head or tail of the relation typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledMinimum cardinalityMaximum cardinalityCommunitiesIDNameDescriptionParent communities, up to the root levelIDNameDescriptionDomainsID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionRolesStatusIDNameDescriptionBusiness Item object type (i.e. Global vs Asset) Roles allowed to start Roles allowed to stop Roles allowed to reassign Start eventsExclusivity Candidate user check disabled Guest user accessibility Registered user accessibility Process IDWorkflow XMLFlowable formsNavigation objects Table viewID NameDescriptionConfigurationIs preferredIs defaultSharing rulesAssignment rulesDashboardAny field referenced in a template of a widget:IDNameAsset typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledCommunitiesIDNameDescriptionParent communities, up to the root levelIDNameDescriptionDomainsID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionRolesStatusIDNameDescriptionDiagram viewAny object referenced in the diagram view or its filter:IDNameAsset typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledCharacteristic types , for example in an overlay.Attribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricRelation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledComplex relation typesIDNameDescriptionDisplay optionsColorSymbol (none, Icon or Code)CodeIcon referenceAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricMinimum cardinalityMaximum cardinalityLeg types (relation types)RoleCo-roleAsset types that are head or tail of the relation typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledMinimum cardinalityMaximum cardinalityCommunitiesIDNameDescriptionParent communities, up to the root levelIDNameDescriptionDomainsID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionRolesSearch filterAny object referenced in the search filter:Asset typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledCharacteristic typesAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricRelation typesIDDescriptionRoleCo-roleHead asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledTail asset typeIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledComplex relation typesIDNameDescriptionDisplay optionsColorSymbol (none, Icon or Code)CodeIcon referenceAttribute typesIDNameDescriptionAttribute type kind and its propertiesKindPropertiesDateNoneMultiple selection(Multi value list)Allowed valuesThe list of allowed values is overwritten in the target environment, so it may remove values.NumericOnly integersMetricScriptLanguage. This field is only used for validation rule assets.Selection (single value list)Allowed values (adding values, AND removals) TextPlain textTrue/False(boolean)MetricMinimum cardinalityMaximum cardinalityLeg types (relation types)RoleCo-roleAsset types that are head or tail of the relation typesIDNameDescriptionParent asset types, up to the root asset type (for example Business asset)Display optionsColorSymbol (none, Icon or Code)CodeIcon referencedisplayNameEnabledratingsEnabledMinimum cardinalityMaximum cardinalityCommentsCommunitiesIDNameDescriptionParent communities, up to the root levelIDNameDescriptionDomainsID NameDescriptionExclude from AutohyperlinkingDomain typeIDNameDescriptionParent domain types up to rootIDNameDescriptionParent communities, up to the root levelIDNameDescriptionRolesStatusIDNameDescriptionUnderstanding the migration export reportAfter exporting model objects from a Collibra Data Intelligence Cloud environment, a report is created and downloaded alongside the migration file itself. The report is an XLSX file containing a summary of what has been exported.Structure of the reportThe report consists of three worksheets, each containing specific information:Worksheet nameContentsSummaryA table that shows the amount of objects of each type that were exported.Primary ResourcesA table in which each row contains a primary object that you exported and the objects that it requires.Associated DependenciesA table in which each row contains a secondary object that was exported to support a primary or another secondary object. Its columns is identical to the Primary Resources worksheet.Columns on the Primary Resources and Associated Dependencies worksheetsThe tables on the Primary Resources and the Associated Dependencies worksheets contain information about the exported objects and the objects they require. Each column contains specific information:Column nameContentsResourceTypeThe type of the object that was exported. For the primary resources, the available values are:AssignmentRoleView:ASSETTABLEView:DASHBOARDView:DIAGRAMView:DOMAINTABLEWorkflowFor the associated dependencies, the available values are:AssetTypeAttributeType:BooleanAttributeTypeAttributeType:DateAttributeTypeAttributeType:NumericAttributeTypeAttributeType:ScriptAttributeTypeAttributeType:SingleValueListAttributeTypeAttributeType:StringAttributeTypeCommunityComplexRelationTypeDomainDomainTypeRelationTypeRoleStatus ID: The unique identifier of the object that was exported.Name: The name of the object. In most cases, the name is a clickable link that opens Collibra in your browser and shows you the object. The main exceptions are objects of the View:DIAGRAM type and objects of the View:ASSETTABLE type which are asset views containing a relation type on asset pages.For most object types, this column contains only the name of the exported object. However, there are some exceptions:Assignments are exported by asset type. As a consequence, the name is built up accordingly: <asset type> : <assignment>. Business Asset : Global Assignment.View:ASSETTABLE objects which represent an asset view containing a relation type on asset pages have a name which is built up by several elements: assetType-<asset type ID>|relation type-<relation type ID>. In some cases, the name is followed by true|catalog.assetType-00000000-0000-0000-0001-000400000001|relationType-00000000-0000-0000-0000-000000007062|true|catalogRelationType objects represent a relation type, which doesn't have a specific name. Their name is built up as follows: [<head asset type>] <role> / <co-role> [<tail asset type>].[Business Asset] represents / represented by [Data Asset]Dependencies: Overview of the secondary objects that are required by the object. They are ordered by type and show the ID and the name of the secondary object. IDThe unique identifier of the object that was exported.NameThe name of the object. In most cases, the name is a clickable link that opens Collibra in your browser and shows you the object. The main exceptions are objects of the View:DIAGRAM type and objects of the View:ASSETTABLE type which are asset views containing a relation type on asset pages.For most object types, this column contains only the name of the exported object. However, there are some exceptions:Assignments are exported by asset type. As a consequence, the name is built up accordingly: <asset type> : <assignment>. Business Asset : Global Assignment.View:ASSETTABLE objects which represent an asset view containing a relation type on asset pages have a name which is built up by several elements: assetType-<asset type ID>|relation type-<relation type ID>. In some cases, the name is followed by true|catalog.assetType-00000000-0000-0000-0001-000400000001|relationType-00000000-0000-0000-0000-000000007062|true|catalogRelationType objects represent a relation type, which doesn't have a specific name. Their name is built up as follows: [<head asset type>] <role> / <co-role> [<tail asset type>].[Business Asset] represents / represented by [Data Asset]Dependencies: Overview of the secondary objects that are required by the object. They are ordered by type and show the ID and the name of the secondary object. DependenciesOverview of the secondary objects that are required by the object. They are ordered by type and show the ID and the name of the secondary object. Tracing dependents and precedentsFor each object, you can trace whether it is required by another object and which secondary objects it requires. Though this is not visually represented in the XLSX file, you can identify the dependencies by means of the ID.Learn more about the export logic of migration.You can easily see which objects require which objects in the Dependencies column. A quick way to trace dependents and precedents is to copy the ID of a dependent object, and search for it in the entire workbook. All objects in the Associated Dependencies worksheet can be traced back to one or more primary objects.You can let MS Excel find all matches in the entire workbook, which will give you a quick overview of all occurrences of the ID on all worksheets of the workbook.Example 1: PrecedentsYou exported a number of workflows. You notice in the report that the Acronym asset type was also exported. You want to know why that asset type was exported. You search for all occurrences of the ID of the asset type in the entire workbook. You find concurrences on the Associated Dependencies and/or Primary Resources worksheets, where you can see which objects require the Acronym asset type.Example 2: DependentsYou exported the Issue Creation Workflow. In the Dependencies column, you see that it requires the [Issue] impacts / impacted by [Asset] relation type. You want to see whether that relation type in turn also requires other objects to be exported. You search for all occurrences of the ID of the relation type in the entire workbook. You find the row on the Associated Dependencies worksheet, where you can check its dependencies.Import model objectsUsing the Migration feature, you can import an archive file containing model objects of a Collibra Data Intelligence Cloud environment. Exporting and importing CMA files is restricted by the file upload settings, which determine the maximum file size, allowed file extensions and maximum amount of uploads and downloads per day. Contact Collibra support if you want to change the file upload settings.Importing model objects cannot be undone. Make sure that there is a recent backup available before doing this.The versions of the source and target environment have to be the same. Migrating between different versions may lead to unexpected behavior. PrerequisitesYou have a global role that has the System administration global permission.An archive file that was exported from an environment that has the same Collibra version.A backup of the environment.Steps    On the main menu, click   , and then click   Settings.The Collibra settings page opens.    Click Migration.The migration page appears on the Export tab page.    In the tab pane, click   Migration → Import.The Migration Import page appears.Upload an archive file in one of the following ways:        Drag and drop the file in the upload area.Click Upload a file, browse to the location of the file and click Open.An overview of the model objects that will be added, edited, or removed appears.NumberDescriptionDetails about the uploaded archive file.A table that shows, for each type, the number of model objects that will be added, edited, or removed.When you select a specific type, the list of model objects appears. For each model object, you can see what will happen.When you select a specific model object, details about change appear.Review the import simulation by verifying the model objects that will be added, edited, and removed.Click Import.The Confirm import dialog appears.Select I have an up-to-date backup containing the data and history of this Collibra platform.Click Import.The archive file is imported, meaning that model objects are created, edited, or removed as necessary. This can take some time. Once the import is completed, you can download an import report.Migration import logicThe import logic determines how migrated objects are matched to objects in the target environment, and what happens if a match is found.Import matchingDuring import, Collibra Data Governance Center tries to match each migrated object with an object in the target. In most cases, matching is done first based on the ID of the object. If the target environment does not have an object matching the ID, the matching algorithm will try to use a logical key. This logical key may be different depending of the type of object. By IDBy logical key   In most cases, the logical key is the Name field, within the same type of object. For others, it is usually a combination of properties. For example:For relation types, the logical key is the combination of the source (head) asset type, the role, the co-role and the target (tail) asset type.For assignment, the logical key is the combination of the asset type ID and scope ID.Outcome of importing an objectDepending on the similarity of the objects in the archive and the target environment, importing an archive may create or edit objects.Migration will never delete objects, but it may reduce assignments, rename assets and so on. The table below contains the general import logic.OutcomeWhenDescriptionA matched object is not edited.A match is found based on the matching logic.The matched object has the same properties as the migrated object.If the migrated object and the object in the target environment have the same properties, nothing happens.A matched object is edited.A match is found based on the matching logic.The matched object has different properties than the migrated object.The matched object will be edited with the properties from the migrated object. Migration will never delete objects, but it may reduce assignments, rename assets and so on.If you migrate an assignment that includes fewer characteristic types than in the target, Collibra removes those characteristic types from the assignments, but does not delete the actual characteristic types.If you migrate a view with a filter on a community that has a different name in the target, Collibra renames the community in the target. An unmatched object is updated.A match is found based on the ID of the objects, but they have different names.In the target environment, another object has the same name as the migrated object.The name of the existing object with the same name will be changed to <original name>-Migration-YYYYMMDD hh:mm:ss.The matched object will be edited with the properties from the migrated object, including the name.Before the import:The target environment contains an asset type with the following information: Name: Crawler, ID: 0000.The target environment contains a second asset type with the following information: Name: AWS Crawler, ID: 1111.The archive contains an asset type with the following information: Name: AWS Crawler, ID: 0000.After the import:The target environment contains an asset type with the following information: Name: AWS Crawler, ID: 0000.The target environment contains a second asset type with the following information: Name: AWS Crawler-Migration-20210101 13:15:12, ID: 1111.A new object is created.If no match is found.A new object is created with all properties from the migrated object, including the ID.Import logic by objectDepending on the migrated object, different fields and secondary objects are exported along with it. This also affects the matching logic when these objects are imported in the target environment. The table below gives further information about how primary and secondary objects are imported.ObjectImport logicAsset Matching logic based on:IDFull name and parent domainThe following table contains the possible cases and results.CaseMatched asset 1Matched asset 2Result1IDn/aMatched asset 1 is updated.2Full name and parent domainn/aMatched asset 1 is updated.3Nonen/aA new asset is created.Assets in system-owned domains (for example Issues) cannot be migrated.Asset type Matching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched asset type 1Matched asset type 2Result1ID and namen/aMatched asset type 1 is updated.2IDNameMatched asset type 1 is updated.Matched asset type 2 is renamed.3Namen/aMatched asset type 1 is updated.4IDn/aMatched asset type 1 is updated.5Nonen/aA new asset type is created.If for an asset type, ratings are disabled in the archive file, but the matched asset type in the target environment has ratings enabled, the import will fail. This is because migration cannot delete the ratings of assets of that type.Asset types are imported using the depth-first order.AssignmentMatching logic based on:IDAsset type and scopeThe following table contains the possible cases and results.CaseMatched assignment 1Matched assignment 2Result1IDn/aMatched assignment 1 is updated.2Asset type and scopen/aMatched assignment 1 is updated.3Nonen/aA new assignment is created.Assignments are imported in a specific order:      Global assignmentsScoped assignmentsAttribute Matching logic based on:IDCombination of parent asset, attribute type and valueThe following table contains the possible cases and results.CaseMatched object 1Matched object 2Result1IDn/aMatched object 1 is updated.2Combination of parent asset, attribute type and valuen/aMatched object 1 is updated.3Nonen/aA new object is created.Attributes in system-owned domains (for example Issues) cannot be migrated.The only fields that you can migrate are validation scripts of validation rule assets and description fields of any resource.Attribute type Matching logic based on:ID, name and kindName and kindID and kindThe following table contains the possible cases and results. CaseMatched attribute type 1Matched attribute type 2Result1ID, name and kindn/aMatched attribute type 1 is updated. 2ID and namen/aMatched attribute type 1 is renamed.A new attribute type is created.Because you cannot edit the attribute type kind through Collibra's UI, this can only be done if:An attribute type is deleted. Using the Java/REST API, a new attribute type is created with the same name and ID as the deleted attribute type, but with a different kind.3Namen/aMatched attribute type 1 is renamed.A new attribute type is created.4Name and kindn/aThe ID of matched attribute type 1 is updated.5ID and kindn/aMatched attribute type 1 is renamed and updated.6IDn/aA new attribute type is created with a new ID.Because you cannot edit the attribute type kind through Collibra's UI, this can only be done if:An attribute type is deleted. Using the Java/REST API, a new attribute type is created with the same name and ID as the deleted attribute type, but with a different kind.7ID and kindName and kindMatched attribute type 2 is updated.8ID and kindNameMatched attribute type 1 is renamed and updated.Matched attribute type 2 is renamed.9IDName and kindMatched attribute type 2 is updated.10IDNameMatched attribute type 2 is renamed.A new attribute type is created with a new ID.11Nonen/aA new attribute type is created.If you import an attribute type of the kind Selection or Multiple Selection via the Solution install, allowed values from the CMA file are added to the list of allowed values in the target environment.If you know that fundamental changes were made to attribute types, you can avoid import problems by deleting attribute types in the target migration before importing the archive.Community Matching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched community 1Matched community 2Result1ID and namen/aMatched community 1 is updated.2IDNameMatched community 1 is updated.Matched community 2 is renamed.3Namen/aMatched community 1 is updated.4IDn/aMatched community 1 is updated.5Nonen/aA new community is created.Communities are imported using the depth-first order.Complex relation type Matching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched complex relation type 1Matched complex relation type 2Result1ID and namen/aMatched complex relation type 1 is updated.2IDNameMatched complex relation type 1 is updated.Matched complex relation type 2 is renamed.3IDn/aMatched complex relation type 1 is updated.4Namen/aMatched complex relation type 1 is updated.5Nonen/aA new complex relation type is created.When a complex relation leg type has the same role, co-role and target asset type than an existing one in the matched complex relation type, the existing one will be updated, even when the ID is different. Adding a second relation type with the same properties would result in an error.Updating the assignment of a complex relation type which impacts leg types and attribute types can remove a leg type if it is no longer included in the migration archive. If the leg type has instance data, the import will fail.Migration does not update leg types when source, target, role, co-role are identical. Data quality ruleMatching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched data quality rule 1Matched data quality rule 2Result1ID and namen/aMatched data quality rule 1 is updated.2IDNameMatched data quality rule 1 is updated.Matched data quality rule 2 is renamed.3Namen/aMatched data quality rule 1 is updated.4IDn/aMatched data quality rule 1 is updated.5Nonen/aA new data quality rule is created.DomainMatching logic based on:ID and nameName and parent communityIDThe following table contains the possible cases and results.CaseMatched domain 1Matched domain 2Result1ID and namen/aMatched domain 1 is updated.2IDName and parent communityMatched domain 1 is updated.Matched domain 2 is renamed.3Name and parent communityn/aMatched domain 1 is updated.4IDn/aMatched domain 1 is updated.5Nonen/aA new domain is created.Issue domains cannot be migratedDomain typeMatching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched domain type 1Matched domain type 2Result1ID and namen/aMatched domain type 1 is updated.2IDNameMatched domain type 1 is updated.Matched domain type 2 is renamed.3Namen/aMatched domain type 1 is updated.4IDn/aMatched domain type 1 is updated.5Nonen/aA new domain type is created.Domain types are imported using the depth-first order.Relation typeMatching logic based on:ID, source asset type and target asset typeSource asset type, target asset type, role and co-roleThe following table contains the possible cases and results.CaseMatched relation type 1Matched relation type 2Result1ID, source asset type and target asset typen/aMatched relation type 1 is updated.2IDSource asset type, target asset type, role and co-roleMatched relation type 2 is updated.3Source asset type, target asset type, role and co-rolen/aMatched relation type 1 is updated.4Nonen/aA new relation type is created. RolesMatching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched role 1Matched role 2Result1ID and namen/aMatched role 1 is updated.2IDNameMatched role 1 is updated.Matched role 2 is renamed.3Namen/aMatched role 1 is updated.4IDn/aMatched role 1 is updated.5Nonen/aA new role is created.ScopeMatching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched scope 1Matched scope 2Result1ID and namen/aMatched scope 1 is updated.2IDNameMatched scope 1 is updated.Matched scope 2 is renamed.3Namen/aMatched scope 1 is updated.4IDn/aMatched scope 1 is updated.5Nonen/aA new scope is created.The global scope cannot be migrated.StatusMatching logic based on:ID and nameNameIDThe following table contains the possible cases and results.CaseMatched status 1Matched status 2Result1ID and namen/aMatched status 1 is updated.2IDNameMatched status 1 is updated.Matched status 2 is renamed.3Namen/aMatched status 1 is updated.4IDn/aMatched status 1 is updated.5Nonen/aA new status is created.Validation ruleMatching logic based on:IDFull name and parent domainThe following table contains the possible cases and results.CaseMatched validation rule 1Matched validation rule 2Result1IDn/aMatched validation rule 1 is updated.2Full name and parent domainn/aMatched validation rule 1 is updated.3Nonen/aA new validation rule is created.If there is a match, only the Description and Validation script are changed. Other characteristics are not changed.WorkflowMatching logic based on:Workflow process IDWorkflow nameThe following table contains the possible cases and results.CaseMatched workflow 1Matched workflow 2Result1Process ID and workflow namen/aMatched workflow 1 is updated.2Process IDWorkflow nameMatched workflow 1 is updated.Matched workflow 2 is renamed with a suffix of - $processId.3Nonen/aA new workflow is created.Navigation objects Table viewMatching logic based on:IDName, type, location and common assigned resourcesThe following table contains the possible cases and results.CaseMatched table view 1Matched table view 2Result1IDn/aMatched table view 1 is updated.2Name, type, location and at least 1 common assigned resourcen/aMatched table view 1 is updated.3Nonen/aA new table view is created.DashboardMatching logic based on:IDName, type, location and common assigned resourcesThe following table contains the possible cases and results.CaseMatched dashboard 1Matched dashboard 2Result1IDn/aMatched dashboard 1 is updated.2Name, type, location and at least 1 common assigned resourcen/aMatched dashboard 1 is updated.3Nonen/aA new dashboard is created.Diagram viewMatching logic based on:IDName, type, location and common assigned resourcesThe following table contains the possible cases and results.CaseMatched diagram view 1Matched diagram view 2Result1IDn/aMatched diagram view 1 is updated.2Name, type, location and at least 1 common assigned resourcen/aMatched diagram view 1 is updated.3Nonen/aA new diagram view is created.Search filterMatching logic based on:IDName, type, location and common assigned resourcesThe following table contains the possible cases and results.CaseMatched search filter 1Matched search filter 2Result1IDn/aMatched search filter 1 is updated.2Name, type, location and at least 1 common assigned resourcen/aMatched search filter 1 is updated.3Nonen/aA new search filter is created.Migration import troubleshootingIn some very specific situations, the Migration feature has some limitations which may lead to undesired effects. This topic describes a situation in which objects seem to disappear during the import.Import logicFor each object in the migration file, the Migration feature tries to find a match in the target environment. First, it looks for objects of the same object type and with the same ID. If no matches are found, it looks for objects of the same object type with the same logical key. For most objects, this is the name. For more information about the import logic see Migration import logic.SummaryThe same object exists in your source and target environment. You renamed the object in your source environment, and created an object of the same type and gave it the original name of the first object. This may cause the import feature to overwrite the first object when importing in the target environment.Detailed explanation              In the beginning, the source and the target environment are the same.You edit the name of an existing source object, and optionally other properties.This has no effect on the ID of the first source object.You create an object of the same type and gave it the original name of the first object.You export both source objects to a migration file.You import the migration file in the target environment.When importing the migration file in the target environment, two scenarios can take place.Scenario 1: The older object is processed first.The import logic looks for the first target object based on the ID.The import logic finds the first target object.The import logic overwrites the first target object with the first source object.This does not affect the ID, but it does change the name of the first target object.             The import logic looks for the second object based on the ID.The import logic does not find the second target object.The import logic looks for an object based on the name.The import logic does not find the second target object.              The import logic creates a new object with the properties of the second source object, including its name.              The two objects in the two environments are identical.Scenario 2: The newer object is processed first.The import logic looks for the second target object based on the ID.The import logic does not find a target object.The import logic looks for the second object based on the name.The import logic finds the target object of the first source object.The import logic overwrites the first source object with the second target object.This has no effect on the ID.The import logic looks for the first target object based on the ID.The import logic finds the first target object, which was overwritten by the second source object.The import logic overwrites the first source object again, this time with the first target object.This does not affect the ID, but it does change the name of the first target object.The second target object does not exist in the target environment.Replace the Collibra logoBy default, Collibra Data Intelligence Cloud has the Collibra logo on the sign-in page and in the top-left corner.You can use your own images:As the logo in the upper-left corner.On the sign-in page and while opening Collibra.From version 2022.11 onwards, you can no longer edit the user interface configuration of new features. This includes Usage Analytics, Data Marketplace and the Homepage.PrerequisitesYou have the SUPER role in Collibra Console.You need knowledge of the JSON syntax.You need images with the following properties:The recommended image format is SVG, but JPG and PNG are also supported.The dimensions of the image on the sign-in page must be 310 x 85 px (w x h).The dimensions of the logo in Collibra must be 50 x 45 px (w x h).If the custom image is larger, it will be resized to the mentioned dimensions, so make sure that the custom logo has the same width/height ratio.StepsAdd your images to the Collibra folder structure:Open Collibra Console with a user profile that has at least the ADMIN role.Collibra Console opens the Infrastructure page.Create a backup of your cloud environment that only includes the customizations and configuration.Download the backup.A ZIP file is downloaded to your hard disk.Edit the backup:Extract the ZIP file on your local computer.A folder with the name of the ZIP file is created.In the created folder structure, go to <backup-dir>/dgc/images.If any of these folders do not exist, create them.Copy your images to this folder.In your file browser, open the extracted backup folder with the new logos.Create a ZIP file of all the contents in this folder.Do not create a ZIP file from the extracted directory itself. Doing so will result in an invalid backup file.Restore the new backup file:Upload the new ZIP file to Collibra Console.Restore the customizations and configuration of the new ZIP file.Wait until your environment is up and running again.Contact Collibra support to edit the user interface configuration to use the images.What's next?Sign in to Collibra to see the new images. If you signed in before, you may have to clear your browser cache.You can also change the loading message by editing the ui.core.loadingapplication key of the interface text.Use a custom faviconBy default, Collibra Data Intelligence Cloud has the Collibra logo as favicon. You can also upload the favicon of your own organization.From version 2022.11 onwards, you can no longer edit the user interface configuration of new features. This includes Usage Analytics, Data Marketplace and the Homepage.PrerequisitesYou have the ADMIN or SUPER role in Collibra Console.Your favicon has the name favicon.ico.StepsCreate a backup of your cloud environment that only includes the customizations and configuration.Download the backup.Edit the backup:Extract the backup somewhere on your local computer.A folder with the name of the ZIP file is created.In the created folder structure, go to <backup-dir>/dgc/images/icons.If any of these folders do not exist, create them.Copy your favicon.ico in this folder.Create a ZIP file of all the content inside the backup folder.Do not create a ZIP file from the extracted directory itself, this would result in an invalid backup file.Restore the new backup file:Upload the new ZIP file to Collibra Console.Restore only the customizations and configuration of the new ZIP file.Wait until your environment is up and running again.Clear the cache of your browser and go to your environment.Your own favicon will appear.
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